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Mark of the Unicom License
Agreement and Limited

Warranty

TO PERSONS WHO PURCHASE OR USETH1S PRODUCT:
Carefully read al the terms and condtrons of this agreement before using this software package. Using this software package indicates
your acceptance of the terms and conditions of this license agreement

Mark of the Unicom, Inc. (MOTU) owns both ths program and its documentaton. Both the program and the documentation are
protected under applicable copyright laws. Your right to use the program and the documentaton are limited to the terms and condtons
described herein.

License
YOU MAY: (a) use the enclosed program on a single computer (b) physically transfer the program from one computer to another provided
that the program is used on only one computer at a time and that you remove any copies of the program from the computer from which

the program is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the
copyright noice on a label on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant subtenses or other nghts to

the program; (c) provide use of the program in a computer service business, network, time-shanng, mutpte CPU or multiple user

arrangement without the prior written consent of MOTU; (d) translate or otherwise after the program or related documentation without the
prior written consent of MOTU.

Term
Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement If

this license is terminated you agree to destroy all copies of the program and documentation.

Limited Warranty
MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and

workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt If failure
of the disk has resulted from accident abuse or misapplication of the product then MOTU shall have no responsibility to replace the dsk(s)

under this Limited Warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WANE, ANY AND ALL OTHER

WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY

AND FITNESS FOR A PARTICULAR PURPOSE THE LIABILITY OF MOTU PURSUANTTOTHIS UMfTED WARRANTY SHALL

BE LIMITED TO THE REPLACEMENT OFTHE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT UMFTED TO LOSS OF USE LOSS OF PROFITS, LOSS

OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BYTHIRD PARTIES EVEN IF MOTU HAS

BEEN ADVISED OFTHE POSSIBILTTY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH
MAY VARY FROM STATE TO STATE SOME STATES DO NOT ALLOW THE UMTAT1ON OR EXCLUSION OF LIABILITY FOR

CONSEQUENTIAL DAMAGES, SO THE ABOVE UMTAT1ON MAY NOT APPLY TO YOU.

Update Policy
In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicom Purchaser

Registration Card to MOTU.

General
This License Agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall innure to the benefit of MOTU.

its successors, administrators, heirs and assigns.

Copyright Notice
Copyright ©1994,1993,1992,1991,1990,1989,1988,1987,1986,1985 Mark of the Unicom, Inc. and its licensors. Al rights reserved.

No part of this pubEcaton may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or
computer language, in any form or by any means whatsoever, without express written permission of Mark of the Unicom, Inc., 1280

Massachusetts Avenue, Cambridge, MA, 02138, U.S A

The Macintosh operating system portions are copyrighted programs of Apple Computer, Inc., Ccensed to Mark of the Unicom, Inc., to

distribute for use only in combination with Performer. Apple Software shall not be copied onto another diskette (except for archive
purposes) or into memory unless as part of the execution of Performer. When Performer has completed execution, Apple Software shall

not be used by any other program.

Performer, Digital Performer, Professional Composer, Composer's Mosaic, Unisyn, MIDITime Piece, MIDITrme Piece II, VdeoTime
Piece, Video Distribution Amplifier, MIDI Mixer 7s, MIDI Express, MIDI Express PC and Mark of the Unicom are trademarks of Mark of the

Unicom, Inc.

Macintosh™ is a trademark tensed to Apple Computer, Inc. Apple ®) The Finder ™, MuHRnder1 M, and Rate!nBay™ are trademarks of

Apple Computer, Inc.

MacPioteus™, SampieCetl1M, ProToois™, Audfomecfa™, Audiomedia II™, Sound Accelerator™, Sound Accelerator If™, and Sound

Designer IPHare trademarks of Digidesign, Inc. • 1360Willow Road, Suite 101, Menb Park, CA 94025.

Vision'M, Studio 5™ and QMS ™ are trademarks of Opcode Systems, Inc.3950 Fabian Way' Suite 100, Palo Ato, CA 94303.

Alchemy™ is a trademark of Passport, Inc., 100 Stone Pine Rd., Haff Moon Bay, CA 94019.
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Chapter 1 About Performer

Performer™

Mail in the Registration
Card

Performer is a powerful MIDI sequencer designed for the music
professional. It provides a comprehensive MIDI recording, playback.
and editing environment for a large variety of applications. Its speed,
accuracy and flexibility make it the sequencer of choice for working
musicians the world over.

Take a moment now to fill in and mail the registration card found at
the very beginning of this manual. Doing so entitles you to:

b A free backup master disk

□ Free, unlimited technical support

h Free newsletters and software updates

□ Announcements about major software upgrades and new
products

Leave the rest of the cardboard page in the manual for your future
reference. Since Mark of the Unicorn can provide customer service
only to registered users, please be sure to send the card in
immediately after purchase.

To use Performer, you must have a Macintosh computer, a MIDI
interface and a MIDI instrument (most probably a synthesizer). This
is the minimal setup you will need, although Performer can support
any configuration of MIDI instruments, including NuBus devices such
as the MacProteus™, SampleCell™, and SampleCell II™. Performer
works well with all MIDI instruments and is capable of handling the
most complex MIDI situations. It is compatible with any
MIDI-equipped device, such as synthesizers, drum machines,
hardware sequencers, synchronization devices and more.

A MIDI sequencer is like a cross between a tape recorder and a
player piano: the physical actions you make when playing the
keyboard or other MIDI controller instruments are stored not as audio
signals (as your tape machine would record) but as numerical
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information that represents music (pitches, attacks, releases, pitch
bends and more). The nuances in your musical performance are
analyzed and its components encoded and stored. When played
back, the synthesizer recreates your original performance. In this
way, the recorded sequence is more like a player piano roll, telling
the instrument exactly how to play itself. One nice thing about MIDI
is that you can use any compatible instrument for playback. You can
also edit the individual elements of your sequence, such as a single
bad note in an otherwise flawless performance. MIDI sequencing
provides you with a way to manipulate virtually any parameter of a
musical performance.

Performer is loaded with features, structured in a layered fashion
such that you can use the ones you want and not worry' about the
others. This is helpful for those of you who are new to the program,
as well as experienced users who need functional power without
unnecessary complexity. The rest of this chapter provides a brief
description of some of Performer’s salient features.

The basic recording and playback functions are very' straightforward,
modeled after tape deck functions. They are located in Performer’s
main control panel:

Music recorded with Performer is played back exactly as entered: the
resolution of 480 ticks per quarter note assures accuracy. As many'
tracks as you need for recording and playback are available to you.
Several tracks can be recorded onto simultaneously from multiple
MIDI channels. Both the modem and printer ports can be used simul­
taneously for input and output of data as well as timing information.
Performer’s Patch Thru utility' allows y'ou to either echo incoming
data directly or channelize it. Any track can be assigned to play' back
from one or more of sixteen channels on either port, giving you 32
separate channels for playback. If you have a multi-port interface
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such as the MIDI Time Piece II or MIDI Express, Performer provides
as many channels as the interface allows (128 or 96, respectively).
Since many of Performer’s operations can be done while the
sequence is playing back or recording, you don’t have to stop the
music to get things done.

A flexible step-recording mode precisely enters passages too fast or
complex to be recorded in real time, plus there are several auto­
locator features such as punch-in/out and auto stop/rewind to make
real-time recording easier.

Once you’ve recorded, there is a great deal of editing power at your
fingertips — you can change anything in your sequence, from a
single event to a whole region of data. Single events or entire regions
of data can be edited or inserted anywhere in the sequence. The
basic cut and paste operations and the region editing commands
allow you to edit and create data: you can transpose whole sections,
change controller values smoothly, create new pitch bend data,
control velocity to create dynamic effects, create echo effects and
more, each in only a few steps. State-of-the-art quantizing features
such as Humanize and Groove Quantize help you perfect the
rhythmic nuance in your sequences.

To access the data that makes up your sequence, Performer offers
three powerful event-editing environments on top of standard Event
List window editing: the Graphic Editing window, the Notation
Editing window, and the QuickScribe Notation window. All windows
support single-event and region editing as described above, and
every track in your sequence can be viewed and edited in either
window at any time.

The Graphic Editing window plots the elements of your sequence on
a scrolling, piano-roll graph that makes melodies, chords, dynamics
and tempo changes easy to recognize and adjust. As in the Event List
window, you can choose from measure, real, or SMPTE time display,
and edit any visible event from your Macintosh or MIDI controller.
Unlike the Event List, however, to edit events or groups of events you
simply drag them to a new location in time, pitch (or controller
value), or both. You can even create continuous data by drawing the
desired curve on screen.
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The QuickScribe Notation Editing window displays as many tracks as
you want together in one window, formatted on a page exactly as it
will print. The notation can be edited with all of Performer's powerful
editing commands. You can drag notes vertically and horizontally to
change pitch, location and duration. You can also step-enter notes
directly in the notation window.

Performer has extensive synchronization capabilities, including Tap
tempo. This type of sync allows you not only to control the tempo of
an existing sequence as it plays back, but to create a tempo map in
real time before, during, or after recording—all by simply tapping
the tempo on your MIDI controller. For example, you can tap along
to a prerecorded acoustic performance, creating a precise tempo map
complete with accelerandos, ritards, and rubato passages, then sync
your Performer sequence to the recording. Once you’ve got a tempo
map, the powerful Scale Tempos command provides you with every
conceivable way of tweaking your tempo map, including scaling
tempos to fit time.

Since its inception, Performer has supported standard MIDI clock
signals, allowing you to sync to FSK or SMPTE time code. SMPTE
locations can be referenced and displayed directly on screen, and
lockup is simple and clean. Performer can serve as an intelligent
master or slave because it sends and receives Song Position Pointer.
Coupled with its flexible tempo features, Performer's synchronization
capabilities make it the sequencer of choice for musicians working in
the film/video medium.

Performer has expanded the art of sequencing with powerful
Chunking™ and cueing functions. The Chunks window introduces a
whole new type of sequence: the song. Songs allows you to create
simple or complex arrangements of multiple Chunks (sequences and
other songs). Chunks can be graphically arranged in any order,
vertically and horizontally to quickly build entire songs with other
sequences and songs.

Sequences and songs can be automatically chained, cued up, or
skipped to in real time using the Chain Chunks, Cue Chunks, and
Skip buttons. These convenient controls come in handy—especially
during live performance, where you need quick response and
complete flexibility in choosing the next song.
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| To further enhance Performer's Chunking capabilities, the Remote
Controls window allows you to trigger any Performer transport
function or song select procedure, such as play, pause, stop, etc.,
from your MIDI controller. Now you can control Performer from your
MIDI instrument—without ever going near your Macintosh!

Performer’s Create Console feature instantly produces a mixing
console customized for the track layout in your Tracks window. Use
knobs and faders to automate your entire mix, including volume and
panning. Best of all, Performer’s consoles are can be completely
customized to fit your sequencing needs. You can build a console
from scratch, adding buttons, knobs, sliders, LCD readouts, and more.
And you can program them to generate any type of MIDI data,
including sysex. Other professional mixing console features include
flexible grouped and master controls, as well as adjustable fader null
points.

Performer offers sophisticated rhythmic correction (quantizing)
features. It is possible to vary the degree of effectiveness of
quantization, allowing you to preserve the “free” quality of your
performance while putting the critical notes on the beat. In addition,
special metric effects such as beat shifting and doubling attacks can
be done. The powerful Humanize command can produce more
human feel in a part that may have been over-quantized. In fact, most
of Performer’s powerful editing commands provide humanization
options that can loosen up the feel just right.

Performer takes full advantage of Mark of the Unicorn’s MIDI
operating system, FreeMIDI. FreeMIDI provides an intuitive,
convenient, and consistent way for you to interact with the hardware
in your MIDI studio. Together, Performer and FreeMIDI provide you
with many benefits, such as intuitive pop-up menus for device
selection, and the ability to select patches on your synths by name
from within Performer, as well as other FreeMIDI-compatible
applications. Perhaps the most important benefit is sound
management: FreeMIDI provides built-in librarian support for many
popular synths. FreeMIDI’s PatchList Manager™ program can get a
bulk dump and automatically display the patch names that are
currently available in the synth. The patch names appear as a
convenient pop-up menu directly in Performer, and it all happens
automatically.
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I For more powerful sound management. Performer provides full
integration with Mark of the Unicorn’s new, state-of-the-art universal
editor and librarian software, Unisyn™. Performer can play back in
the background when you switch into Unisyn to select sounds, edit a
patch, etc. Also. Unisyn automatically provides up-to-date patch lists
for FreeMIDI, so that patch names in Performer are always accurate.

Performer also provides convenient printing capabilities for both list
windows and music notation. The Print command prints the contents
of Performer's list windows, such as the Tracks List, Markers window,
and Event Lists. The QuickScribe notation window displays any
combination of tracks as music notation on screen exactly as it will
print out. Select any region to display, from a single measure to an
entire piece. QuickScribe is ideal for lead sheets, instrument parts, or
scores, which can be printed on any Macintosh-compatible printer.

If you want to transfer your sequence to a dedicated notation
program, such as Mark of the Unicorn’s Mosaic® software, simply
save your work as a standard MIDI file. The process transferring is
simple and fast.

Performer can be customized to fit your needs more than ever before.
In the Tracks window, each track has a bar-graph style meter that
indicates MIDI activity during playback and recording. Configure the
meters to display either data density or note velocities. You can drag
tracks window columns left or right to place them in any order you
wish. Double-click (or option-click) the column headings to show/
hide any column. Even basic features like soloing can be customized
to fit your exact needs. For example, Partial Solo mode brings muted
tracks down part way instead of total muting them, so you can focus
on a certain musical element while still referencing others.

Version 5, as with its predecessors, is filled with our obsessive
attention to detail. You’ll enjoy features like pop-up menus in title
bars to quickly switch tracks, a customizable Tracks window, a
scrolling highlight in tracks overview to indicate the current playback
location, double-clicking in any time ruler to auto-locate, and more.

We hope you enjoy using Performer’s state-of-the-art sequencing
environment!
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About this manual This manual provides a complete explanation for all of Performer's
features. For an introduction to Performer, refer to the Getting Started
booklet that accompanies this manual.

Each section of this reference manual contains a step-by-step
procedural description and an in-depth explanation of each aspect of
Performer's operation. Each feature description is self-contained,
enabling you to learn about Performer one piece at a time, at your
own rate.

We strongly recommend that you read the section on Performer’s
user interface thoroughly. The standard Macintosh user interface is
extended in Performer to provide a more streamlined and functional
working environment. This knowledge is essential when working
with Performer: otherwise you may overlook some of the program’s
features.

Because Performer has extensive synchronization abilities, we’ve
marked those sections pertaining to the film and video mediums with
a film icon.
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Chapter 2 On-Line Help

About the Performer
Help file

Performer™ Help

Using the Help cursor

Performer's On-Line Help provides you with brief, on-screen
explanations of each feature in the program. You can get help on any
item in Performer, including menu items, greyed out (unavailable)
menu items, mini-menus, windows, and buttons simply by clicking
the item with Performer's Help cursor.

The Help information in Performer is stored separately in a special
file called the Performer Help file. This file is automatically installed
in the same folder as Performer, and no further preparation is
necessary on your part.

•"The Performer Help file must be present on your hard
disk in order for you to be able to get help when
running Performer. If it is not present for some reason,
you can run the installer on the Performer master disk
to make a copy of it on your hard disk.

When you are running Performer, you can get help on anything on
Performer’s screen with the Help cursor. To turn the arrow cursor into
Performer’s Help cursor, hold down the command, option, and shift
keys together. When you release the keys, the cursor will turn back
into an arrow.

To get help on something, just click it with the Help cursor. If it's a
menu item, select it from the menu with the Help cursor. When you
release the mouse button, a help window will appear that briefly
explains the item.

To make the help window disappear, click anywhere.
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What should you click
on to get help?

Getting help on menu
commands and dialog
boxes

Loading the Help file

All major features in Performer have a help item. Some specific items
do not and are explained within the description of a corresponding
feature. If you can't get help on something, consult the index in this
manual.

In general, click directly on the item you wish to get help on. For
things like buttons, pop-up menus, and text boxes, click directly on
the button itself rather than its label or associated text. If you don't get
a help window the first time, try a few more times, as you might miss
the “hot spot” the first time.

'•* The basic rule of thumb is: click all over the place with
the help balloon cursor. You are bound to get a useful
help balloon eventually, and it doesn’t hurt to click as
many times as you are inclined to.

For mini-menus in windows, click anywhere in the title bar of the
window.

For general information about menu commands, choose the
command from the menu with the help cursor. For specific
information about the menu command, choose it with the arrow
cursor first to open its dialog box, and then click specific buttons, text
boxes, pop-up menus, and other items in the dialog box with the
help balloon cursor.

If you click with the Help cursor, you may get the dialog box shown
below:

|g| Music Folder |

Please Locate the Performer’" Help File

□ Mg Performer Files <>

<>
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The Help menu

This means that the Performer Help file is not in the same folder as
Performer, and Performer is asking you to locate and open the Help
File. To do so:

1. Press the directory pop-up menu to open the folder that you
installed the Help file in.

The directory pop-up menu is the button labelled “Music Folder"
in the picture above. The window below shows the contents of
the Folder listed on that button. Select the bottom item in the
menu to work your way back to the top level of your hard disk. If
you are working with floppy disks, click the Drive button to look
on another disk.

2. If you can’t find the Help file or have not installed it yet, click
Cancel, Quit Performer, and follow the procedure above for
installing the Help File.

3. If you can find the Help file, click its name in the list to highlight the
name and click the Open button.

Performer will remember the location of the Help file so that you
won’t have to find it each time you click the Help cursor.
However, in some cases Performer may forget the location, so we
recommend that you place the Help file icon in the same Folder
as Performer so that Performer can always find it.

The Help menu contains two items: About Help and Show Balloons.

Choosing About Help opens a help window that describes how to use
the On-line Help feature. You can choose About Help anytime—even
when the Help file or a Performer file is not currently open.

Choosing Show Balloons makes the arrow cursor turn into the Help
cursor without holding down any keys. This is convenient when you
would like to browse several features. In Show Balloons mode, any
item that you click on or select from a menu will open a help
window.

In Show Balloons mode, you can temporarily turn the cursor back
into the arrow by holding down the conunand-option-sbift key
combination.
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I To permanently turn the cursor back into the arrow, choose Hide
| Balloons from the Help menu.

Getting help on greyed
menu items

A word to the wise

To toggle the Show/Hide Balloons command from the Macintosh
extended keyboard, press the Help key.

Greyed menu items are commands that are not currently available for
one reason or another. For example, Region menu items are greyed
unless a region has been selected. If a region is selected, they
become black.

To get help on a greyed menu item, simply hold down the command­
option-shift key combination while selecting the item from the menu.
The item will not highlight as you select it, but a help window will
appear anyway.

Please note that it is not possible to get help on greyed menu items
when you are running Performer on a Macintosh with a 68000-based
CPU such as the Macintosh Plus, SE or Classic.

Help descriptions do not take the place of the Performer manual.
Unfortunately, there is not enough space to cover all the intricacies of
eve^ Performer feature in the space of a Help window. Therefore, ice
strongly recommend that you refer to your Performer manual and
update documentation fora complete explanation of features that you
would like to learn more about. Then you won't miss things that the
Help window doesn’t cover, and you will get the most out of
Performer.
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chapter 3 Performer’s User Interface

The user interface encompasses everything that you do to interact
with the program: what you see on the screen and how you use the
mouse, keyboard and peripheral devices. In this section you’ll find
information about Performer's windows, dialog boxes, mouse and
keyboard actions and how to specify and locate regions using units
of time. This section also describes Performer’s enhancements to the
standard Macintosh user interface.

The examples of Performer’s windows that you see in
this manual are what you see when you are running
Performer on a Macintosh with a color monitor (in
either 16-level greyscale or 256-colors). If you have a
black and white monitor, what appears on your screen
will be somewhat different than what you see printed
in this book.

Before using Performer, please review the standard Macintosh user
interface conventions. If any of them seem unfamiliar, please refer to
the Macintosh owner’s manual for a full explanation. Be sure you are
familiar with the following:

□ How to use the mouse and keyboard

■ How to open, copy and delete files from the Finder

■ How to choose commands from menus

■ How to select options using push buttons, radio buttons
and check boxes

■ How to respond to dialog boxes

■ How to use Command key shortcuts for menu commands

■ How to enter and edit text
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Windows To start with, here's an example of a Performer window:

Window mini-menu

Close button

Pushdown button Zoom button

Scroll tab

Scroll bar

Grow box

The Close button is shaped differently from the standard one but works
just the same: click in it to close the window.

The Scroll Bar works exactly the same as the standard one: to move
directly to a desired location in the window, drag the Scroll tab to the
desired location. Press on the arrows to scroll continuously, or click
once on them to scroll one line at a time; click in the grey region to
scroll a screenful at a time.

The Window Mini-Menu resembles the standard menus on the top of
the screen. It contains commands pertinent to that particular window.
To pull it down, press on the menu icon and then select a menu
option as you would on a standard menu at the top of the screen.
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Mini-menu button

Set Console Name...
Duplicate
Snap to Grid
Set Grid Spacing...
Align Controls...
Background Pattern...

Goto Zero
Goto Null Point

V Auto Punch-In
Set Punch-Out...

Group...
Ungroup
Control Assignment...
Name Item...

Delete Control
Delete Console

A Performer mini-menu

Window title shows the name of the window, and often the track or
sequence that it pertains to. Command-click the title to switch to a
different track, sequence, etc.

Conductor Command-click the window
title to switch to a different

track or sequence.

The Pushdown Button will put the window behind all other windows
on the screen. This is useful when you are finished with a window
but don’t want to close it.
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The active window

Closing all edit windows

The Zoom Button will enlarge or shrink the window. Clicking in the
zoom box w'ill enlarge a window to a larger size; clicking in the zoom
box a second time will return it to its original size.

The Grow Box lets you adjust the size of the window. Dragging the
grow box will continuously adjust the size of the window. Note that
it is possible to have names or other information extend past the right
edge of the window; if you need to see this information use the grow
box to expand the window appropriately.

Most of the time, the window in which you are currently working is
the active window. The active window is indicated by fully detailed
borders; when a window is inactive its top border and scroll bar are
blank. To activate a window so that you can work in it, simply click
anywhere on it. The main control panel is always active; it is not
necessary to click on it before using it.

A single click on an inactive window makes that window active, and
in addition, the item in the window that was clicked responds, except
for clicking the title bar, scroll bar or re-size button. This speeds up
working with Performer because less clicks are necessary'.

Performer provides several shortcuts for closing all open edit
windows (Event Lists, Graphic Editing windows, and QuickScribe
notation window):

□ Press command-option-W.

■ Option-click the close triangle in any edit window.

■ Press the option key and the Close command in the
Windows menu changes to Close All Edit windows.
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Dialog boxes Performer’s dialog boxes look more three dimensional than the
standard Macintosh ones:

Three dimensional radio

buttons and check boxes.

Clicking shortcuts

Mouse techniques

Even though these buttons look different, the act like standard
Macintosh check boxes, radio buttons, and push buttons. For
example, the text labels for radio button and check box options can
be clicked to check the box or push the button. In addition, if you
type in a text box, its corresponding radio button selects automati­
cally.

Option-dick: If you hold down the option key and click on a check
box, all check boxes will be unchecked except for the one you
Option-clicked on.

Command-click: If you hold down the command key and click on
a check box, all check boxes will be checked except for the one you
clicked.

Here are the mouse actions you'll use in Performer:

To click, move the mouse to position the arrow cursor on the object
then press and quickly release the mouse button. Single clicks are
generally used to select an action, confirm a selection or to select
something for editing.
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Keyboard and mouse
actions

To double-click, move the mouse to position the arrow cursor on the
object then click the mouse button twice in quick succession. The
interval between the two mouse clicks can be set on the Control
Panel on the Apple menu (refer to your Macintosh owner’s manual
about this). Double-clicking is generally used for opening things such
as windows.

To press, move the mouse to position the arrow cursor on the object,
press the mouse button and hold it down.

To drag, move the mouse to position the arrow cursor on the object,
press the mouse button and, holding it down, move the mouse in the
desired direction. Dragging is used to increase the size of a window,
to move indicators (such as the tempo slider in the Metronome
panel), to select multiple names, events or objects, or to select a
region.

To scroll, press on the scroll box in the scroll bar and drag it in the
desired direction. Scrolling can also be done by clicking or pressing
on the arrows on the top and bottom of the scroll bar.

To learn more about mouse actions, consult the Macintosh Owner's
manual.

Some actions are done with the mouse and keyboard in conjunction:

To Sbift-click, hold down the shift key, move the mouse to position
the arrow cursor on the object and click the mouse. Shift-clicking is
used for selecting noncontiguous items; for example, you would use
Shift-click to select several independent events in an Event Editing
window.

To Option-click, hold down the option key, move the mouse to
position the arrow cursor on the object and click the mouse. Option­
click is used to select the name of a track, sequence, song or marker
for editing. After editing, the new entry can be confirmed by pressing
the Return key.

To Command-click, hold down the command key, move the mouse
to position the arrow cursor on the object and click the mouse.
Command-click is used for selecting regions larger than can be 
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Keyboard commands

Qeturn

Cut
Copy 3SC
Paste 8€U
Erase 38B
Repeat...
Merge 9€M

displayed on the screen. To do so, highlight an item or event at the
start of the region, scroll with the scroll bars until the end of the
region is visible, then Command-click at the end of the region.

The following keyboard commands are applicable to dialog boxes
and pop-up boxes.

Pressing on the return key is the same as clicking on OK: it confirms
the selection in the dialog box.

Pressing on the enter key will also OK a dialog box. It is.also used
when editing a list of names or data, confirming the current one and
moving to the next.

Pressing the command and period keys together is the same as
clicking on the Cancel button: it cancels the selection and leaves the
previous settings/values unchanged.

Pressing the escape key is the same as clicking a Cancel button and
pressing command-period ( . ).

Pressing the tab key will confirm the current entry field, then move to
the next field in the box or list and highlight it.

The up arrow will move through a list of names or events, confirming
the current selection and moving to the previous one.

The down arrow will move through a list of names or events,
confirming the current selection and advancing to the next one.

The left and right arrows move from field to field in the event list,
confirming the current selection and advancing to the next one in the
arrow direction.

In addition to these, there are many shortcut keyboard commands
that will allow you to choose commands from menus very quickly.
They are indicated on the menus to the right of the commands
themselves and can be used instead of pulling down the menu and
selecting the command. To use a shortcut command, hold down the
Command key and press the indicated key. For example, command-X
is the shortcut for the Cut command. Instead of pulling down the Edit
menu and selecting Cut, hold down the Command key and press the
X key.
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Specification of time
units

is the shortcut for the Cut command. Instead of pulling down the Edit
menu and selecting Cut, hold down the Command key and press the
X key.

In Performer, you will always be dealing with time specifications.
Performer gives you the option of using measure time
(measure I beat I tick), real time (minutes:seconds.hundredths) and
frame /m?e(hours:minutes:seconds:frames). Full understanding of the
time specifications you are using is essential. Below is a concise
explanation of each of them:

Measure time (measurelbcatltick): A specification of measure-oriented
musical location. The number of beats in the measure depends on the
specified meter: 4/4 will define 4 beats per measure, for example.
Subdivisions of the beat vary, according to the 480-ticks-per-quarter
note constant. Thus, a beat in 6/8 time (an eighth note) will have 240
tick subdivisions, a beat in 2/2 time (a half note) will have 960 tick
subdivisions and so forth. Measure time is useful since it is the most
musical.

1 I Mb
Real time (minutes:seconds.hundredtlis): Measurement in standard clock
time. This is a simple, already familiar method for location.

I
Frame time (hours:minutes:second:frames): Frame time is a special type
of real-time measurement. With it, you can synchronize Performer
(via a SMPTE to MIDI converter) to a device that uses SMPTE time
code as a time reference. Unlike measure time, frame time is used
when absolute time location is necessary.

Lmmmo a
SMPTE stands for Society of Motion Picture and Television Engineers.
Although SMPTE time code is used mostly in film and video work, it
is increasingly used for audio applications. One SMPTE frame 
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Durations used in
specifying note lengths

corresponds to one film or video frame. The number of frames per
second depends on the equipment you are working with; Performer
supports 24, 25, 30 drop frame, and 30 frames per second. SMPTE is
useful as a standardized location scheme when synchronizing to
production devices such as a tape deck or video deck. See the
chapters called Receive Sync and the appendix Synchronization
Specifications for a more detailed explanation.

Times used in Event Editing windows and elsewhere to specify
durations are displayed in quarter notes and ticks. Since Performer
allows different meters in a sequence, it is necessary to use a compre­
hensible, easily divisible format to insure clarity and a lack of
confusion. The quarters I ticks format fulfills this requirement, making
it easy to understand durations without having to specify a measure
value. For instance, a whole note is 4 1000 (four quarter notes and no
ticks), and a dotted quarter note is 11240 (one quarter and 240 ticks).

Quarter note

Sixteenth

Editing the Counter The current playback location can be changed at any time by editing
the Counter. You can edit the counter even while the sequence is
playing back. To edit the current Counter location in Performer:

1. Click on the field in the time display to highlight it.
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2. Type in a new time value.

While a field is highlighted, just type in a new value. Use the
backspace key to erase an incorrect entry.

Pressing the Tab or the decimal key on the keypad will cycle through
each field of a time display, highlighting each so that you can type in
a value. For example, to enter the time 0:07.13 as shown in the
example above:

1. Click on the minute field to highlight it.

2. Press 0.

3. Press the Tab or decimal key.

4. Press 0 and 7.

5. Press the Tab or decimal key.

6. Press 1 and 3.

7. Press the Return key.

As a shortcut, you can press the decimal key on the Macintosh
keypad. To cancel the edit, press command-period.

Editing during playback Many of Performer’s features, such as windows, dialog boxes, edit
region selection, edit commands, and other features can be used
during playback. For example, you can open another window or use
the Transpose command while the music is playing back; you do not
have to press the stop button beforehand. So, the next time you are
listening to your music and would like to make a change, don’t reach
for the stop button. Just execute the command while the music is
playing.

Here are some examples of things you can do during playback:

■ Select a region for editing (in an Event List, Tracks
Window, etc.).

■ Edit a region with the Edit or Region menu commands

■ Rearrange Chunks in the Song window
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s Cut, copy, drag, option-drag (copy), etc. notes and data in
Graphic Editing and QuickScribe notation windows

■ Reassign the playback channel for a track

□ Add, delete, rename, or reposition a track

□ Access a mini-menu command such as Set View Filter

During playback and recording, the Counter and other displays may
become irregular and seem to skip beats. This is due to Performer's
primary obligation which is to receive and output MIDI data on time.
Performer may have to devote all of the computer’s resources
towards this end and thus may not be able to keep the screen display
completely smooth and current. The Click and Flash will provide an
accurate determination of the tempo. In addition, editing commands
may sometimes take longer due to the amount of processor time
required to deal with playback.

Some features, because of their nature, cannot be accessed during
playback. These features are either greyed out (unaccessible) during
playback or will have no effect unless you press the Stop button
before using them. Examples are:

□ Using the MIDI Interface dialog box

■ Save or close a file
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Chapter 4 Working With Files

A single Performer file can contain one or more sequences and songs.
It is represented in the Macintosh Finder by the Performer file icon.

Opening a new file To open a new file, you must first start Performer.

1. Double-click on the Performer program icon.

You can also click once on the Performer icon and choose Open
from the File menu.

2. If you see a new file appear on the screen, with the tape-deck style
control panel and Tracks window, you are ready to go.

3. If you see the standard Macintosh dialog box for opening files,
click the New button (or press command-N).
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If you are already in Performer:

1. Select Close from the File menu.

This closes the file that is currently open. If you have modified the
data in the file, Performer asks if you would like to save changes.
The various windows will disappear and the file will close.

2. Select New from the File menu.

A new file will be created and the main control panel appears,
along with the Tracks window. (You can customize the New
command using Save as ‘New’ Template, described later in this
chapter).

Opening a new file automatically opens a new sequence. This
sequence is ready to record into right away. You can create other
new sequences by choosing Acid Sequence from the Chunks window
mini-menu.

Opening an existing file To open an existing file from the Finder:

1. Double-click on the file icon.

You can also click once on the file and choose Open from the File
menu. This will start Performer and bring up the selected file.

To open an existing file from within Performer:

1. If a file is already open, close it by selecting Close from the File
menu.

You are given the option of saving changes in this file. The
Performer windows will all disappear and the file will close.

2. Select Open from the File menu.

A dialog box will appear, containing a list of files on the selected
disk. To see the files on a disk in a different drive, click on the
Desktop button. To view files on another disk which is not
currently in a drive, click on the Eject button and insert the other
disk.
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|Q Performer Files ▼ |

^help.foo
□ Home
j^House Grooue

House Grooue.MIDI
®Jgc

Jim’s file
^Kimon Grooue

Opening files in other
formats

3. Click on the name of the file you wish to open.

4. Click on the Open button.

The file you selected will be opened. Double-clicking on the
name of the file will also open the file.

Performer can open files in the Professional Composer® and MIDI
file formats. To open a file in one of these formats, simply select it
from the Open dialog box as normal. A message will appear
informing you that Performer is converting file formats. The file will
open as a Performer file; if you want to save it back into the
Professional Composer or MIDI file format you must use the
procedure described later in this chapter.

In addition, files created in older versions of Performer can be
opened in the new version; simply select the old file from the Open
dialog box as normal.

Performer cannot open Mosaic files directly. To open a Mosaic file,
save it as a MIDI file from within Mosaic using the Save As command
in Mosaic’s File menu. Once the file is saved in the MIDI file format,
you can then open it in Performer.
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Loading a chunk from
another file

Once you have opened a file, the Load command in the File menu
lets you load Chunks (sequences and songs) from other files directly
into the open file without closing it.

Your Macintosh must have enough RAM available to support the load
operation. Be sure to open and watch the Memory window, available
in the Windows menu, whenever you load Chunks or Remote
Controls. Try to have at least 100K available at all times.

To load a Chunk into an open file:

1. Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2. Click the file containing the Chunk you wish to load, then click
Open.

Alternately, you can double-click the file name. Performer’s Load
dialog box appears, displaying the file name at the top.

® Load Chunks
@ Data
O Link

'S’ Seq-3
hd Song-1
“X] Song-2
's’ Seq-4

— Chunks list

® Remote Controls
® Consoles
® Device Groups
® Transpose Maps

® Custom Scales
® Humanize Styles
® Random Pitch Maps

3. Make sure the Load Chunks option is checked.

If it is not, click its check box. The Chunks list displays all Chunks
in the selected file.

4. Choose the Data sub-option.
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5. Select the Chunk(s) you wish to load.

Linking sequence
chunks from another file

Click the Chunk name to select it. If you wish to load more than
one Chunk, drag to select contiguous Chunks and shift-click to
select discontiguous Chunks.

6. Optional: If you wish to load any other items from the selected file,
select the appropriate option.

7. Click OK to confirm your choice or Cancel to withdraw the Load
command.

Clicking OK causes the selected Chunk(s) to be placed in the
Chunks window. You can change each Chunk's position in the
Chunks list by dragging its Type icon.

Loading a song Chunk automatically loads its component Chunks.
For example, you choose to load Song-1, which contains Seq-1, Seq-
2, and Song-2. Song 2 contains Seq-3 and Seq-4. When you execute
the Load command, all six Chunks (two songs and four sequences)
will be loaded in and added to the Chunks list of the open file.

A memory-saving option in the Load command is to Link a sequence
Chunk instead of actually loading it. A Link serves as a reference to a
Chunk in a different file. Since a Link requires far less memory than
the Chunk it references, you can build an extensive list of Chunks
without running out of memory in your Macintosh.

Because a song in Performer is a collection of Chunks, song Chunks
cannot be linked. Instead, just load the song using the procedure
described in the previous section. Performer will automatically load
the song's component Chunks. Alternately, you could open that
song’s file and use the Merge Chunks to Sequence command to
transform the song into a sequence. The new sequence could then be
linked. For more information about converting a song into a
sequence, please refer to the chapter The Song Window.

For successful playback of links, the linked Chunk’s file must reside in
a folder with Performer or, if Performer is on the desktop, the file must
also he on the desktop.
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To link a Chunk from another file:

1. Choose Loadfrom the File menu.

The .standard Macintosh Open dialog box appears. If necessary,
click the Drive button repeatedly to view each drive present.

2. Click the file containing the sequence you wish to link, then click
Open.

Alternately, you can double-click the file name. Performer’s Load
dialog box appears, displaying the file name at the top.

3. Make sure the Load Chunks option is checked.

If it is not, click its check box. The Chunks list displays all Chunks
in the selected file.

4. Choose the Link sub-option.

Any song Chunks in the window become italicized, indicating that
they cannot be linked.

5. Click the sequence(s) you wish to link.

If you wish to Link more than one sequence, you can drag to
select contiguous Chunks and shift-click to select discontiguous
sequences.

6. Optional: If you wish the Chunk’s Remote Controls assignments to
be loaded with the Chunk, choose the Load Remote Controls
option.

Deselecting this option loads only the Chunk’s song or sequence
data.

7. Click OK to confirm your choice(s) or Cancel to withdraw the Load
command.

Clicking OK places a Link to each selected Chunk in the Chunks
window and a corresponding Chunk Select control in the Remote
Controls window.
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Saving files

After you have linked a Chunk, its name appears italieized in the
Chunks window of the current file. The Link s Comment field displays
the file from which the Linked Chunk will be loaded. When the Link
is play-enabled, Performer will take a few moments to load it; the
amount of time this takes depends on the size of the Chunk.

•"Please remember: for successful playback of links, the
linked Chunk’s file must reside in a folder with
Performer or, if Performer is on the desktop, the file
must also be on the desktop.

Please read this section carefully! When you open a file from a disk,
Performer makes a copy of that file and puts it in the Macintosh's
temporary memory (called Random Access Memory', or RAM). When
you work with the file, you are actually working with the copy that is
in RAM, not the original file on the disk. If you choose Save from the
File menu, Performer writes the changes you have made into the
original file on the disk. If you do not save, the changes you have
made are never written to the disk. For example, if you quit without
saving changes, the work you have done is not saved on the disk and
is permanently deleted from the computer's memory.

This is why files should be saved frequently. If Performer or your
Macintosh should malfunction, all of the work you have
accomplished since you last saved may be lost! However, if the file
was recently saved, you can retrieve the latest version from the disk
and proceed without having lost much work.

Always be sure that the disk you are saving the file on has enough
room! Files can be saved to any disk with sufficient space for the file.
They can also be saved with different names.

Here’s the basic procedure to save a file:

1. Choose the Save command from the File menu.

Your file is saved on the disk in its current state, replacing the old
version with the same name. If you want to keep the old version,
use the Save As command on the File menu (see below) instead
to save the current version under a different name.

If you are saving the file for the first time, a dialog box will appear
prompting you for a name:
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Saving a file under a
different name

|q Performer™ Folder^' |
O Demo Files
□ Misty
D My sony
<A Performer Printer
O> Performer'-
D Performer'" Help

Saue the current state as
Untitled

(S) Normal QStandard MIDI File
O Performer 2.41 O Professional Composer™

2. Type in the name of your file.

You can’t use a colon in the name; all other characters are
permitted, including spaces. If you enter a name that is already in
use, a dialog box will ask you to confirm your choice.

3. Click on the Save button.

Pressing the Return key will do the same as clicking on the Save
button. If you want to save the file to a different disk, click on the
Eject button, insert a new disk and, after typing in the name, press
the Save button. Pressing Cancel withdraws the Save command.

The Save As command is used to save a file under a different name
or to a different disk:

1. Choose Save As from the File menu.

The Save As dialog box will appear.

2. Type in the new name for the file.

You can’t use a colon in the name; all other characters are
permitted, including spaces. If you enter a name that is already in
use, a dialog box will ask you to confirm your choice.
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3. Click on the Save button.

Saving a file to a disk not
currently in a drive

Saving a sequence in
another format

Your file is saved on the disk in its current state under the new
name.

To save a file to a disk not currently in a drive:

1. Choose the Save As command from the File menu.

2. The Save As dialog box will appear.

3. Click on Eject.

The disk that is currently displayed in the dialog box window will
be ejected. If you want to use the other drive, click on Drive
before clicking on Eject.

4. Insert the disk you wish to save the file on.

5. Click on the Save button.

The file is saved on the disk you selected.

Performer saves almost every attribute of your file, including open
windows and their screen positions, the on/off status of such features
as Audible Mode and Patch Thru, your current choice of Event
Editing display, your Chunk Start Times, and many others. If you find
that your files often have very similar setups, use the Save As ‘New’
Template command, described later in this chapter, to customize your
new files.

Performer can save sequences in several other file formats:

■ Standard MIDI file

■ Performer Version 2.41 file

■ Professional Composer™ file

Only sequences can be saved in these other file formats. If you wish
to save a song, you can do so by converting it into a sequence
beforehand. Please refer to the Chunks Window chapter later in this
manual for information about converting a song into a sequence.
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To save a Performer sequence in a different file format:

1. Play-enable the sequence that you wish to save.

Do so by clicking the play-enable button next to the sequence in
the Chunks window.

2. If you are saving a MIDI file, and you want the tempo and meter map
of the sequence to be saved with the MIDI data, choose Conductor
Trackfrom the Metronome tempo control pop-up menu in the main
control panel.

Do so by choosing Conductor Track in the Tempo Control pop-up
menu in the Metronome.

3. Choose Save As from the File menu.

The Save As dialog box appears with four options: Normal,
Performer 2.41, Standard MIDI File, and Professional Composer.

|Q Performer Files v |
D Betht>ueea$ 9 th
D
D Harpsichord Concerts

<r

Sane the current state as
Harpsichord Concerto

©Normal O Standard MIDI File
O Performer 2.41 Q Professional Composer™

4. Click the desired file format.

5. Click Save to activate the conversion.
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Saving as a standard
MIDI file

6. If you are saving a standard MIDI file, the MIDI File Options dialog
box appears.

See "Saving as a standard MIDI file" on page 53 for more
information about these options.

Use the procedure explained in “Saving a sequence in another
format” on page 51. Music saved in the MIDI file format can be
opened with any program that also reads and writes MIDI files—even
programs that run on other types of computers.

MIDI File Format options
When you save a file as a standard MIDI file, the following dialog box
appears:

■ Format 1: separate tracks with tempo and meter
information as the first track

■ Format 0: one multi-channel track with tempo/meter
information at the beginning

■ Format 0: tempo/meter map only

Save track names as plain text
When selected, the Save track names as plain text option causes only
plain text events, such as track names, to be saved. No special text
events, such as track comments, are saved. This option is necessary 

Working With Files 53



My Song

Saving as a
Performer 2.41 file

Saving as a Professional
Composer file

when transferring files to programs that do not support special text
events. If you discover inconsistencies when transferring text in MIDI
files, try using this option.

Expand Loops
Standard MIDI files cannot contain loops. The Expand loops option
addresses this problem by converting each loop into a region of
repeated data in the same way as Performer’s Repeat command. The
End file at time option allows you to specify the end time of the
sequence in the box provided. For convenience, the box appears
with the sequence’s current end time.

Performer automatically opens MIDI files. For more information, see
the Open section earlier in this chapter.

Performer’s file format is constantly developing as new features are
added. Due to these changes, files saved in the current format cannot
be loaded into earlier versions of Performer. If for some reason you
need to work with a file in an earlier version of Performer (2.41 or
later), Performer lets you save sequences in the version 2.41 format:

To save a file in the 2.41 format, use the procedure described in
“Saving a sequence in another format” on page 51.

When you Save As 2.41, songs in the file will not be saved. This is
because Version 2.41 does not support songs. Therefore, any songs in
the file you save will not be present in the 2.41 version of the file. If
you don’t want to lose the song when converting to the 2.41 format,
you can easily convert it into a sequence, which H’/7/get saved in the
2.41 file. To do so, open the song’s Song window. Select All, and
choose Merge Chunks to sequence from the mini-menu. A new
sequence, which is identical to the song, will appear at the bottom of
the Chunks window list and get saved in the 2.41 file.

A Performer sequence can be converted into a formal that is readable
by Professional Composer®, an earlier score editing software
package from Mark of the Unicorn.

To save a file in the Professional Composer file format, use the
procedure described in “Saving a sequence in another format" on
page 51. Make sure that you quantize both attacks and releases of all
the notes in the sequence beforehand. Otherwise, the transcription in 

54 Working With Files



Transferring a sequence
to Mosaic™

Reverting to a
previously saved
version o f the file

Saving a file as a ‘New’
template

Professional Composer will be filled with unwanted 32nd and 64th
notes and rests. See the section on quantization for further
information.

Once you have converted the file, quit Performer, start up
Professional Composer, and open the newly created Composer file.

To transfer a sequence to Mosaic, Mark of the Unicorn’s latest
notation software package, save it as a Format 1 MIDI file. No
quantization or other preparation is necessary because Mosaic does
its own quantizing when you open the MIDI file in Mosaic. See
“Saving as a standard MIDI file” on page 53 for information about
saving standard MIDI files.

If you’ve made unwanted changes to a file, you can undo the
changes you’ve made by returning to the last saved version. This
operation is identical to closing the file and opening it from the disk
again.

1. Choose Revert to Saved from the File menu.

A dialog box asks you to confirm this choice.

2. Click on OK to confirm the action, Cancel to withdraw it.

Reverting to the last saved version of the file means that all
changes you’ve made since you opened or last saved the file will
be lost.

Reverting to a previously saved version is useful when experimenting
with a file. You can quickly remove any changes by using this
command. Make sure that you save the file in the state you want it
before beginning to experiment.

The Save As ‘New’ Template command, found in the File menu,
allows you to customize your copy of Performer. You control what
appears on the screen when you open a new file, by creating your
own New file template. A template is a “skeleton" file, a framework
designed to save you time when building your files.
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For example, lei’s say you typically work in files with one sequence,
the same number of tracks. Auto Channelize, measure time and
SMPTE displays in the Counter window, and a Sequence Start Time
of-1. In addition, you arrange Performer's windows to suit your
screen size and style of working.

You can use the Save As ‘New’ Tempkite command to give your
‘New’ files all of these characteristics automatically.

When you choose Save As ‘New’ Template from the File menu.
Performer remembers the exact state of the file and reproduces it
next time you request a new file. The New command, also in the File
menu, will produce an untitled, empty new file identical to the source
file.

To use the Save As ’New’ Template command:

1. If you aren’t already in a Performer file, open one or choose New
from the File menu.

2. Configure Performer’s windows, their contents, and any other
features as you find most useful.

This file will be your template source file: Performer will
remember your exact track setup, window layout. Patch Thru
setting, and so on.

3. Choose Save As ‘New’ Template from the File menu.

A dialog box will ask you to confirm or cancel your request.

4. Click OK to confirm the command, Cancel to withdraw it.

If you confirm the command, Performer redefines your ‘New’
template based on the current file. All attributes specific to the
current file, except for MIDI and Conductor track data, now
comprise a New file in the copy of Performer you are using.

To see the effects of Save as ’New’ Template, close the current file
and choose New from the File menu. A new, empty, untitled file will
appear, identical to the last file you saved as ’New’.

56 Working With Files



Hints for using Save As
‘New’ Template

Remember that the Save As ‘New' Template command customizes only
the copy of Performer in which it is used. Every copy of the program
has its own template; a fresh copy of Performer will yield the default
New file setup.

For this reason, make a spare copy of your template source file using
the Save As command described earlier in this chapter. Pick a suitably
descriptive name for the file, like “Perf Template”. This way you can
retrieve your preferred setup into any copy of Performer by opening
“Perf Template” and immediately choosing Save As ‘New’ Template
from the File menu.

Redefining your New file template is easy. For example, you’ve used
the Save As ‘New’ Template command in a file that contains only one
track.

To quickly add more tracks to your template:

1. If you are in a Performer file, choose Close from the File menu to
close it.

If you’ve made any changes to the file, you’ll be prompted to save
them.

2. Choose New from the File menu.

A new file will open, identical to the file you saved as New.

3. Activate the Tracks window if it is not already active.

Click anywhere in the window to activate it.

4. Hold down the Option key on your Macintosh keyboard and choose
Add from the Tracks window mini-menu.

A small dialog box will prompt you for the number of tracks to be
added. Type in the desired number.

5. Choose Save As ‘New’ Template from the File menu.

The existing file will become the new template.

Quitting Performer Quitting Performer returns you to the Finder.

Choose Quit from the File menu.
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Setting Performer’s
startup preferences

A dialog box may appear asking you if you want to save changes
made to the file. To save the changes, press Yes. If you don’t want to
save changes, press No. To withdraw the Quit command and return
to your Performer file, press Cancel.

When Performer first opens, you have three choices for what it can
do:

n Open a new file

□ Present you with the Open file dialog box, which lets you
open either an existing file or a new file with the “New"
button

□ Neither of the above, which lets you either choose Open
or New from the file menu

To set this preference, choose Preferences from the File menu and
choose the desired setting. This setting is remembered in the
Performer Preferences file in the Preferences Folder inside the System
Folder on your hard disk.

Startup options
O New file
® "Open..." dialog
O None

Pitch Representation
® Standard pitch (middle C = 'C3‘)
O Alternate pitch (middle C = 'C4')
O MIDI key number (middle C = '60')

Default Editing Vindow
® Event List
O Graphic Editing
O Notation Editing
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File and disk errors The following are a few file and disk errors that commonly occur.
Always keep plenty of up-to-date backups of your important files as
you work. Almost any software problem is survivable as long as you
have kept backups of your work. See Appendix 13: Troubleshooting
and Customer Support for more information about problems you may
encounter with Performer files.

There isn’t enough room on the disk. Your disk is too full. Eject the
disk and insert one with plenty of free space on it. Note: If Performer
runs out of disk space while saving a file, the file on disk will be
damaged. If this happens, immediately use the Save As command to
save the file to a disk with more space available. If you fail to do this,
and you have not made a backup file, you will have lost an entire file.
As a rule, before opening an existing file, be sure the disk on which
it is stored has enough free memory to hold the information you
expect to add.

An error occurred while writing the file. This is a dangerous situation.
In all probability, the existing copy of the file on the disk has already
been erased so that the new copy could be saved. Because of the
error, any partial file that has been saved cannot be read. At this
point, the only good copy of the file is in memory. Immediately' try' to
save the file on another disk. Do not attempt to use the Revert to
Saved command on the File menu; the saved copy' is damaged and
you will lose the file in memory.

You tried to open a Professional Composerfile made by using the Save
as Composer command in Performer and didn 't get what you
expected. If the file has all sorts of very' small note values, try
quantizing the Performer file to a larger note value. Make sure that
you quantize both attacks and release of all the notes. To confirm that
you have successfully quantized, check attack times and durations of
notes in the Event Editing window of each track. If correctly'
quantized, all durations will be rounded values such as 1/000 (quarter
note), or 0/240 (eighth note). See the section on quantization for
more details. Once you have successfully' quantized the sequence,
save it as a Professional Composer file and try opening it in
Professional Composer again.

The computer ran out of memory’. Either the data you were recording
filled up memory or you edited the file quite a bit. Try recording
smaller segments and saving the file more often.
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Helpful file and disk
hints

The disk is locked. Unlock the disk by sliding the small tab on the
back of the disk in the upper left-hand corner down so that it covers
the small hole.

The disk can't be read. The disk itself may be damaged. Return to the
Finder and try inserting the disk again. If it still can’t be read, it may
be irretrievable.

File menu commands cannot be used during playback. To use a
command in the File menu, press the stop button beforehand.

Save your file as often as possible. You should use the Save command
after every significant change to your file.

Always keep backup copies of your important files. We cannot
emphasize enough the importance of this. At the end of a working
session, copy to a backup disk all of the files you recorded and
edited. This way, if anything should happen to your original, you will
have fully updated backup of the file.

If you are working with floppy disks, you should store your files on
a disk separate from Performer. This gives you lots of room for saving
files.

Saving a file under a different name while working can be useful
when you want to keep a record of earlier versions.

When saving files during a working session, it is a good idea to save
alternately under different file names; if something should happen to
one of the files, the other will be a recent version. For example, a file
can first be saved under the name “Sessionl”. The next time it is
saved, choose the Save As command from the File menu and save it
as “Session2”. The following lime, it is saved as “Sessionl" again, then
“Session2” and so forth. To be even more careful, save a file to
different disks during a working session.

Hard disk users should make sure to backup their files to floppy
disks. This should be done as often as is bearable, at least at the end
of every working session and several times during the session if
possible. The consequences of not making floppy backups are
severe: if your hard disk is damaged, some or all of the files may be
lost forever.
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Using System 7’s
stationery feature

Performer supports System 7’s “Stationery pad" feature in the Get Info
window for a file as shown below:

My Performer File Info

l.yM My Performer File

Kind: Performer
Size: 44K on disk (41,317 bytes used)

Vhere: Centris 650 HD: Performer™:

Created: Tue, Dec 28, 1993, 3:48 PM
Modified: Tue, Dec 28, 1993, 3:48 PM
Version: n/a

Comments:

□ Locked | | Stationery pad

Stationery pad option in the Get Info window.

When this option is checked, the file can be opened, but System 7
will prevent you from modifying the original file by forcing you to
Save As when you attempt to save the file. This option is great for
preserving files that you do not want to modify and that you use
regularly as a “template” from which to build other files. For more
information about the Stationery pad option, consult your System 7
documentation.
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Chapter 5 The Consolidated Controls Panel

Quick reference

Performer's Consolidated Controls panel contains all the functions
that make Performer “go": buttons to record, play, rewind, set tempo,
and more. The main transport controls look and act much like the
transport controls for a tape recorder. Additional buttons provide
immediate access to many of Performer’s significant features. The
panel can be opened by choosing Consolidated Controls from the
Windows menu.

To conserve screen space, the Consolidated Controls panel does not
have a title bar. To move the panel, hold down the shift key and drag.
If the panel is behind other windows, choose Consolidated Controls
from the windows menu to bring it to the front.

Main Position bar Main Counter Time format

Set loopWaitCustom

control

consoles

Tracks

window

Graphic

editing

Opens

Free
MIDI

Auto
Stop

Metronome

click

Cue Auto

Chunks Record

Current Current Current Tempo

Setup

Tempo Slider: Displays the current tempo in beats per minute. When
the Tempo Control pop-up menu is set to Metronome, drag the
triangular indicator or press on the plus/minus buttons to change the
tempo (+ to increase the tempo, — to decrease it).

63



Current Meier: Displays the meter at the current location in the Chunk.
To change the meter, you must use the Change Meter command on
the Change menu or insert a Meter change event in the Conductor
track.

Current Beat Value: Displays which note value gets the beat in the
beats-per-minute tempo indicator. Click on it to change it.

Current Tempo: Displays the current tempo in beats per minute. Click
on it and type in a new tempo or drag the Tempo slider.

Tempo Control: Selects the current source of the tempo from a pop-up
menu. Tempo can be controlled from the Tempo slider, the
Conductor track, or remotely from a MIDI controller such as a mod
wheel.

Skip buttons: If you have more than one sequence or song in the file,
these buttons skip to the next or previous one, much like the skip
buttons on a CD player. To view sequences and songs, open the
Chunks window.

Main Transport Controls: These are Performer’s main controls for
playback, recording, etc. The Skip buttons change the currently play-
enabled sequence to the next or previous Chunk in the list. The
Position Bar indicates the current playback position of the currently
play-enabled sequence. Use the Position Bar arrows to quickly
advance or rewind the current location while in playback.

Position bar: Indicates the current playback location with a scrolling
arrow. Scroll buttons on either side of the bar provide fast forwarding
and rewinding.

Start time button: Opens a dialog box which allows you to set the start
time for the Main Counter’s three time formats: measure time, SMPTE
time, and real time.

Main Counter: Displays the current playback position in one of
Performer’s three time formats: measures I beats I ticks, real time, or
SMPTE time. Click the lime format icon to the right to cycle through
the three formats. Click the numbers and type to change the playback
location. For more information about editing times in the Main
Counter, refer to the Counter Window chapter.
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Time format buttons: Cycles the display in the counter through
Performer’s three time formats: measures I beats I ticks, real time, or
SMPTE time.

Set Loop button: Creates a loop over the selected region in the Tracks
List or Tracks Overview. Select a region and click this button to create
a loop. At least one track name or track segment must be highlighted
to create a loop with this button.

QuickScribe Notation Window button: Opens the QuickScribe Notation
window for the currently selected track(s) in the Tracks List or Tracks
Overview. At least one track name or track segment must be
highlighted to open Notation Editing with this button. Provides
notation editing and printing.

Graphic Editing Window button: Opens the Graphic Editing window for
the currently selected track(s) in the Tracks List or Tracks Ovendew.
At least one track name or track segment must be highlighted to open
Graphic Editing with this button.

Event List Window button: Opens the Event List window for the
currently selected track(s) in the Tracks List or Tracks Overview. At
least one track name or track segment must be highlighted to open
Event List with this button.

Tracks Window button: Opens the Tracks window or brings it to the
front if it is already open.

Overdub record button: Toggles overdub record mode, in which newly
recorded data merges with existing data instead of replacing it.

Wait button: Causes Performer to wait for a keystroke from a MIDI or
Macintosh keyboard as a signal to start playing back or recording.

Countoff button: Causes a number of measures to countoff before
playback or recording. The button denotes the number of measures,
which can be set by double-clicking the button.

Auto-Record button: Causes automatic punch in and punch out during
recording at the start and end times specified in the Auto Record Bar. 
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i Chain Chunks button: When highlighted, starts playback of the next
Chunk in the list after the current playback Chunk reaches its End
time.

Cue Chunks button: When highlighted, it play-enables the next Chunk
in the Chunks list after the current playback Chunk reaches its End
time and stops. To begin playback of the next Chunk, press the Play
button, or a remote control for the Play button.

Memory-cycle button: Causes the region between the Memory' Start and
Stop points to seamlessly' repeat. In the Tracks overview, repeat
barlines appear in the time ruler to indicate the repeat points.

Auto-Rewind button: Causes automatic rewinding to the Memory' Start
location any time playback is stopped (for any reason).

Auto-Stop button: Causes playback or recording to automatically stop
at the Stop location in the Memory Bar.

FreeMIDI button: Opens the FreeMIDI setup program, in which you
can make changes to FreeMIDI’s representation of your current MIDI
studio setup.

Markers Window button: Opens the Markers window for the currently
play-enabled Chunk or brings it to the front if it is already' open.

Custom Consoles Window button: Opens the Sliders window or brings it
to the front if it is already open.

Chunks Window button: Opens the Chunks window, which displays all
of the sequences and songs currently' stored in the file.

Metronome click button: Turns the audible metronome click on or off.

Main Transport
Controls

Status Strip: Displays the name of the currently' open file and currently'
play-enabled Chunk. Also displays the Memory' bar, which allows you
to set start and stop times for the Auto-Stop, Auto-Rewind, and
Memory-cycle functions.

The Main Transport Controls are the buttons that make Performer
“go": with them you can record, play, rewind and more. The Main
Transport Controls are enabled by clicking on them. When a button
is enabled, it is highlighted and its function is active: the Record 
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The Play button and
playback

button records, the Pause button pauses, etc. Most buttons can be
disabled by clicking a second time. To disable the Play and Record
buttons, press the Stop button. In some situations (when in external
sync, for instance) buttons may turn grey signifying that they cannot
be used.

Think of Performer’s motion controls as similar to tape recorder
transport controls. But Performer’s motion controls are more flexible
than their hardware counterparts in that they are programmable via
the Memory buttons (on the left of the window), utility buttons (on
the right) and menu commands.

Clicking on the Play button starts playback of the currently play-
enabled sequence or song. Playback will begin from the current time
specified in the Counter. Playback can be delayed by the Countoff
button and held by the Pause and Wait buttons.

The Play button is highlighted while the sequence is playing. It
flashes (or turns gray on a black and white display) when waiting for
synchronization in the External Sync mode or when the wait button
is on.

The Position Bar arrows can be used to quickly advance or rewind
the current location while in playback.

If you start playback in the middle of a sequence, you may not hear
exactly what you expect. This is because Performer moves forward
through the stream of data stored in each track, sending each event
that it encounters, such as note-on and note-off commands. If you
start playback in the middle of a sequence, notes which are
sustaining at that point will not sound because their note-on occurred
before the point at which playback began. Performer has a specially
designed feature called Event Chasing to avoid this problem. To learn
how to enable Event Chasing, see the section called Event Chasing at
the end of the Playback chapter.

During playback, some Performer features become unaccessible,
such as the Save command in the File menu. Many other features.
however, including all editing commands, can be used even during
playback. As a general rule, commands that cannot be used will
either appear greyed out during playback or they will have no effect.
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The Rewind button

The Stop button

The Pause button

Clicking on the Rewind button sets the current location to the start of
the sequence. If the Memory Bar is showing, clicking on the Rewind
button will rewind to the Memory Start location. Double-clicking the
button will always rewind to the start of the sequence or song.

If the Rewind button is clicked during playback, playback is held for
a moment while the sequence rewinds. Playback then resumes from
the rewind location.

If the Rewind button is clicked during recording, the record button is
turned off. The sequence rewinds normally and resumes in playback
mode.

Although Performer rewinds much faster than a tape deck, long
sequences may take one or two seconds to rewind.

Using the Auto-Rewind function is a fast way of locating a frequent
rewind location. See The Auto-Rewind button below.

Clicking on the Stop button stops playback and recording. It also
turns off the Pause button. All notes sounding when the Stop button
is clicked will cease.

The Stop button turns off all notes currently on. If the Auto-Rewind
feature is on, Performer will rewind to the Memory Start location
when the Stop button is clicked.

Clicking on the Pause button once turns it on; clicking on it a second
time turns it off. The Pause button is highlighted when it is on.

Turning the Pause button on during playback will cause playback to
be suspended without turning any notes off. Turning it off will cause
playback to resume.

If the Pause button is turned on before playback, playback will be
suspended until the Pause button is turned off.

While the Pause button is on, you can use the Rewind button,
Position Bar, and Counter window to adjust the current playback
location. You may also set times in the Edit, Memory, and Auto­
Record bars.
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The Record button and
recording

Overdub record mode

s.

Clicking on the Record button turns it on and begins recording in the
currently play-enabled sequence from the current location in the
counter. When it is on, the Record button is highlighted and can be
turned off by clicking on it again. This disables the record function
while continuing playback. You can also turn on and off the record
button during playback for manual punch-in and punch-out. A more
general way to think of the Record button is as an on/off toggle
switch that you control manually.

At least one track must be record-enabled before the record button is
pressed. This is done by clicking on the Record-Enable button for the
desired track (or tracks). Record-enabling a track makes it the
destination for incoming recorded data.

If the Auto-Record button is enabled, the Record button will flash
when clicked on (or turn grey on a black and white display). It will
then turn red (or black on a black and white display) when the Punch
In location is reached. When the Punch Out location is reached, the
Record button returns to “record-ready” mode.

If the Record button is enabled and grey due to Auto Record, clicking
on it will turn it off, cancelling the punch-in.

When slaved to external sync, stopping or rewinding the master
device will turn off the record button except in the case of Tap tempo
sync, which requires that you click the Stop button.

If you click the Overdub button, Performer goes into Overdub record
mode. Overdub mode causes all recorded data to merge with, instead
of replace, pre-existing data on the record-selected track. The pre­
existing data on the track is not erased.

The word overdub is used in a very specific sense in Performer: real­
time merging of incoming data with data already on a track. It works
as if you recorded one track, recorded a second track to go along
with it and then merged the two. You should turn off Overdub when
you are finished using it since it can produce unwanted effects if left
on by mistake. You can use the Overdub mode in conjunction with
memory cycle to build patterns in multiple passes over a region. This
method is similar to that used with many drum machines. (Overdub
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does not function on the Conductor Track; specifically, recording on
the Conductor Track while slaved to Tap tempo sync always erases
existing tempo events.)

Undo Record By choosing Undo Record from the File menu, the track you recorded
into will be restored to its state before recording. The Redo command
returns the track to its state after recording. Going back and forth
between the two states allows you to do A/B comparisons. Note that
only the last command can be undone; if you edit your data after
recording you will no longer be able to undo the Record command.

The Position bar The Position Bar indicates the current position in the sequence. The
indicator can be moved to change the location: left to rewind, right to
advance. The far left is the beginning of the sequence, the far right is
the end.

_________ -J-d

To change the current position in the sequence, drag the scroll
triangle to the desired location. If you press on the grey bar, the scroll
triangle will move to that spot. If you keep pressing, you can drag it
to a new location.

The position bar can be used during playback as well as when the
sequence is stopped.

The same applies to the Position Bar Arrows. Using them during
playback is called “cueing”. The right set of arrows cues forward in
time, the left set cues backwards. The smaller arrows cue slowly, the
larger ones cue faster. The left arrows cause playback to pause while
cueing backwards until the arrow is released. If used during
recording, the Record button will be turned off before cueing. The
Position Bar can also be used while the Pause button is on during
playback.

The Position Bar can be used to find a relative location in a sequence.
It may not be useful for finding exact locations (use the Counter or
Markers instead) but is perfectly suited for finding the beginning and
end of a sequence: simply drag the scroll triangle to the far left or
right.
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The Memory
buttons

The Auto-Stop button

The Auto-Rewind button

1^1

The Memory­
cycle button

Use the Position Bar to move short distances quickly in a sequence.
Since forward cueing is audible, you can use it to accurately locate a
particular note event or region.

The Memory buttons (Auto-Rewind, Auto-Stop and Memory-cycle)
allow you to automate the primary motion controls. By using the
Memory buttons, you can program the motion controls to activate at
times specified in the Status Strip.

Enabling the Auto-Stop button causes playback of the sequence to
automatically stop at the Stop location on the Memory Bar. Clicking
on the Auto-Stop button enables it; when enabled, it is highlighted.

Clicking on the Auto-Stop button causes the Memory' Bar to appear if
it is not already present.

The Memory-cycle button and the Auto-Stop button cannot be
enabled at the same time.

Enabling the Auto-Rewind button causes the sequence to
automatically rewind to the Start location on the Memory Bar. This
occurs when the Stop button is pressed or when playback reaches
the end position in the Memory Bar in Auto-stop mode. Clicking on
the Auto-Rewind button enables and highlights it.

Clicking on the Auto-Rewind button causes the Memory Bar to
appear if it is not already present.

Auto-Rewind is useful for returning to a particular location after
stopping. It saves you from having to stop and rewind manually.

The memory-cycle button is a cycle-playback and cycle-recording
feature that causes a region of the entire sequence to be played
repeatedly until the stop button is pressed, just like drum machines
and hardware sequencers. Cyclic playback begins when the
sequence reaches the specified Memory-cycle region. When the
Counter reaches the end of the region, it seamlessly returns to the
beginning and will continue to do so until you press the stop button,
unhighlight the Memory-cycle button, or cue past the end time.
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Viewing Memory-Cycle
points graphically

Use Memory-cycle for multiple consecutive playbacks of a particular
region. This can be very useful for cycle-recording a loop section or
drum pattern, mixdowns, rehearsing a part that you plan to record, or
for scrutinizing a particular region of a performance.

When cycle-recording, you add a new part to the loop with each
consecutive pass. Before doing so, be sure Performer is in overdub
record mode so that each new pass doesn’t erase the last one.

If you want to permanently loop a region in one or more tracks and
specify the number of times the loop will repeat, insert a loop as
described in chapter 13, “Looping".

Click on the Memory-cycle button to enable it. This highlights it, and
causes the Start and Stop times to appear in the Memory' Bar if they
are not already present. The next section discusses several ways to set
the start and stop times.

The Memory-cycle button and the Auto-Stop button cannot be
enabled at the same time.

When Memory Cycle is enabled, the start and stop times appear
numerically in the Memory bar just below the Memory' buttons. They
also appear graphically as repeat barlines in the Time Ruler of the
Tracks Overview and Graphic Editing windows at the Start and Stop
time as shown below:
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--------- Edit resolution

Repeat barlines are displayed in all time rulers. They can
be dragged left and right; when you drag them in the

Graphic Editing, they snap to the current edit resolution.

Memory bar start and stop
times are displayed here. You

can change them by typing or
by clicking the Start and Stop

buttons on the fly during

playback.

slider

)O bpm

... Uerse 1

Memory | Start ||2|1|000 Stop ||4|11000

,____> Cyl __
_

_

p IS h? Ti £<
-■
1 t yy y ■ mfi '

[TBK-2 !Memory-cycle

button is activated. —

* Bass (Uerse 1)
|D 11J Unit = J 11000 beats’1

■l.i.i i.Li.'.iO^ 11111 iJj ■ 11 ■ -, 111 ■ 1 ■ t ■ 111 • 11 ■ /IM i1 ■»• 1.11.i 1 1-lj ,l.~

Setting Memory-cycle
points

Playback cycles between these points seamlessly. You can drag the
repeat barlines left and right with the mouse to change the cycle
points. If the edit resolution check box is checked, the barlines snap
to the current resolution setting (such as Sth notes, for example) as
you drag them. For an explanation of edit resolution, see “The Edit
Resolution Box” on page 292.

You can adjust the cycle points at any time, even during playback.
This lets you build patterns and other tasks without ever having to
stop the music.

The Memory-cycle region is defined by the Start and Stop times in the
Memory' Bar. You can set these points by typing them into the
memory bar. You can also set them by selecting a region in the time
ruler of the Tracks overview or any Graphic Editing window. To do
so:
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1. Set the Edit resolution in the time ruler.

Selecting the Memory­
cycle region for editing

The Countoff
button

If you want the encl points to land directly on beat or measure
boundaries, the easiest way to do so is to set the edit resolution to
an appropriate value, such as eighth notes or quarter notes. If you
want to be able to set the loop points with no constraints
whatsoever, uncheck the edit resolution box.

2. Drag over the desired region in any time ruler.

3. Choose Remember Times from the Basics menu, or press
command-R.

Doing so causes Performer to store the end-points of the region
you have selected.

4. Highlight the Memory-cycle button if it is not already highlighted.

5. Click the word “Memory” in the memory bar.

The region is loaded into the Memory' Start and Stop times. In
addition, the Memory-cycle repeat barlines appear in the time
rulers at the beginning and end of the region you highlighted.
Now Performer will cycle between them during playback and
recording.

If you would like to quickly select the region within the Memory­
cycle repeat barlines to insert a loop, quantize, or any other editing
operation, double-click one of the two repeat barlines.

ft H'S | ............ ....... . /u Bass-HI
[□Start: 2111000 End: 4111000 |  Unit = J

Enabling the Countoff button causes a countoff of a specified number
of measures before playback or recording. The Counter does not
move forward until after the countoff. Clicking on the Countoff
button enables and highlights it. You must enable the Click or Flash
(in the Basics menu) to hear or see the countoff.
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2

The Wait button

~s

To set the number of countoff measures, either double-click or
Option-click on the Countoff button. A dialog box appears in which
you can enter the number of measures and specify whether the
countoff should occur only when recording. If the Countoff only
when recording option is chosen, there will be a countoff before
recording, but not before playback or any other function.

The countoff bars are in the same meter as the first measure of the
sequence. See the Change Meter chapter for information on changing
meters.

Use the Countoff button to give yourself time to adjust to the current
tempo and prepare for recording. Using the Countoff and Wait
buttons allows ample preparation for a recording pass; this is
particularly useful in situations where the computer and keyboard are
not adjacent.

Enabling the Wait button causes Performer to wait until it receives a
keystroke from a MIDI or Macintosh keyboard before playback or
recording.

To enable the Wait button, click on it; it will highlight. Then, press
either the Record or Play buttons. The wait button will then begin to
flash, signaling that it is waiting for a keystroke. To start playback or
recording, press a key on the Macintosh keyboard or your MIDI
controller instrument. If recording is enabled, the MIDI event you
send to turn off Wait will be recorded.

The Wait button will remain enabled until it is clicked off. Thus, it will
be in effect every time the Record or Play button is clicked on.

Use Wait to give yourself a moment to ready yourself at your
keyboard or other input instrument before recording. Using Countoff
and Wait together allow you as much time as you need to prepare for
recording.

While the Wait button is on, you can use the Rewind button. Position
Bar, and Counter window to adjust the current playback location.
You may also set times in the Edit, Memory, and Auto-Record bars.
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The Auto­
Record button

Auto-Record causes recording to automatically turn on and off in a
specific region. This allows you to record without having to manually
enable and disable the Record button.

Clicking on the Auto-Record button enables and highlights it.
Clicking on the Auto-Record button also causes the Auto Record
punch in and punch out times to appear in the Status Strip. Punch in
and punch out times are specified in the Auto Record Bar: Punch in
is the time where recording begins; Punch out is where recording
ends. Auto-Record can be used while Performer is slaved to external
sync; see the chapter Receive Sync for details on recording while
slaved to each type of sync.

The Auto-Record button will remain on until you click on it again to
disable it. Remember to disable it when you finish using it.

To use Auto-Record:

1. Activate the Tracks window by clicking in it.

2. Click on the Record-Enable button of a track.

3. Press the Auto-Record button, which is located below the
transport controls.

The button highlights to signify that Auto-Record is on.

4. Enter the Punch In and Punch Out locations.

The Punch In location is where Recording will begin. The Punch
Out location is where Recording will end. You can enter them in
numerically in the Auto Record Bar. You can also set them up
graphically. See “The Memory and Auto Record Bars” on page 81
and “Setting the punch-in and punch-out points graphically" on
page 77.

5. Move to a location in the sequence before the Punch In point.

This location should be a spot that will give you plenty of time to
prepare to enter the new material, anywhere from a whole section
to a few bars before the Punch In point.

6. Get ready to record.
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7. Press the Record button.

The sequence plays from the current location in the Counter. The
Record button is initially flashing (or greyed out on a black and
while screen). When the Punch In time is reached, the button
becomes highlighted. When this happens. Performer is recording
and you can enter the new material. When the Punch Out time is
reached, the Record button will revert to flashing or (being gray
on a black and white screen).

8. Press the Stop button when you are finished.

If Performer starts recording while a pre-existing note is sustaining, it
does not cut off that note. Only notes with attack times after the
punch in time are erased. For example, the two notes represented by
light grey bars begin within the punch in region, but the sustained
note represented by the dark grey bar begins before the punch in
point:

Punch-in Punch-out

□=□ I

~ I

After recording, the notes that began before punch in remain, but the
notes that begin within the recorded region are replaced by the new
material:

Setting the punch-in and
punch-out points
graphically

VZZZZZZZZZZZZZ1
| | ------------------- recorded

material

I ' I

Anything you play while the Record button is grey is not recorded.
This allows you to play along with the sequence and only record
between the Punch In and Out times.

When Auto-Record is enabled, the punch-in and punch-out times are
displayed graphically as arrows in the time ruler of the Tracks
Overview, as well as the time ruler in any Graphic Editing window.
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Auto Record | In] 13)11000 Out 117|1|000

E"

Auto-record bar start and stop

times are displayed here. You

can change them by typing or
by clicking the Start and Stop

Auto-record button
is activated. 

Quickly selecting what
you have recorded

The Chunk
Control buttons

You can drag the arrows left and right with the mouse to change the
punch-in and punch-out points. If the edit resolution check box is
checked, the arrows snap to the current resolution setting (such as
8th notes, for example) as you drag them. For an explanation of edit
resolution, see “The Edit Resolution Box" on page 292.

You can adjust the arrows at any time, even during playback or
recording. This lets you adjust punch-in and punch-out on the fly
without having to stop the music.

You can quickly select the region between the punch points by
double-clicking one of the arrows. This is a handy shortcut for editing
what you have just recorded with auto-record.

The Skip Forward and Backwards buttons play-enable the next or
previous Chunk (sequence or song) listed in the Chunks window.
The Cue Chunks button play-enables the next Chunk in the list after
the current Chunk plays to its end time and stops. The Chain Chunks
button causes the next Chunk in the list to automatically begin
playing when the current Chunk finishes playback.
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Chaining using the
Controls window

The Chunk cueing buttons in the Controls window allow automatic
and real-time cueing of Chunks, and automatic playback of cued
Chunks. The Cue Chunks, Chain Chunks, and Skip Forward and
Backwards buttons let you play Chunks from the Chunks window,
moving up or down the list at your command.

Chunk cueing does not yield seamless transitions between Chunks.
Use them for cueing situations where a pause between Chunks—
either brief or indefinite—is acceptable or preferred.

For example, the Chunk Controls buttons are perfect for live
performance. Before a set, you could organize the Chunks list in the
order you wish for the set. Then, before you begin, you could enable
the Wait button. To begin the set, you simply press play. When the
first song ends, the next song automatically cues up, and you can
trigger it at your leisure from your MIDI keyboard. Or, without the
Wait button, you can have Performer go right into the next song
without waiting.

It is also possible to cue and play Chunks remotely from your MIDI
controller. For more information, please refer to 77?e Remote Controls
Window chapter.

Clicking either the Cue Chunks or Chain Chunks button causes the
Memory Bar to appear in the Status Strip. The Stop time displayed in
the Memory Bar indicates the measure time at which the current
Chunk will stop playing and the next Chunk will be cued. This time
appears automatically when a Chunk is cued; it corresponds to the
Chunk’s End time in the Chunks window.

You can edit the Memory' Bar time by clicking it, but this change lasts
only until the next Chunk is enabled. If you wish a different End time
to appear in the Memory Bar automatically for a particular Chunk,
pop-edit the End time in the Chunks window. Simply click the Chunk
name and choose Auto/manual end time from the Chunks window
mini-menu. The time becomes bold and editable. Remember that the
End time only affects a sequence’s playback length when using the
Chunk control buttons, not when the Chunk is played as part of a
song.

The Consolidated Controls Panel 79



The Cue Chunks button

The Chain Chunks
button

Viewing the Chunk End
Time

The Cue Chunks button, when highlighted, play-enables the next
Chunk in the Chunks list after the current playback Chunk reaches its
End time and stops.

To begin playback of the next Chunk, press the Play button, or a
remote control for the Play button.

The Chain Chunks button, when highlighted, starts playback of the
next Chunk in the list after the current playback Chunk reaches its
End time. This is a simple way of automatically chaining Chunks in
their Chunks list order.

Chaining with this button does not yield seamless transitions between
Chunks. Use it for cueing situations where a brief pause between
Chunks is acceptable or preferred. For seamless chaining, assemble
Chunks in a Song window. For more information, please refer to the
Song window chapter.

When the Cue Chunks or Chain Chunks button is highlighted, the
end time of the sequence is graphically displayed as a final barline in
the time ruler of the Tracks Overview or any Graphic Editing
window.

Chain Chunks (or Cue

Chunks) button is activated.

□ Unit = J 11000 beats

A barline is displayed in all time

rulers to indicate the end time of

the sequence. This is the point al

which it will stop before the next

sequence will be cued.

'oreen’s Nocturne (Noreen's Nocturne)

“ Nor een's Noctur ne
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The Skip Forward and
Backwards buttons

The Status Strip

The Memory and Auto
Record Bars

The Memory Bar

The Skip buttons enable the next or previous Chunk for playback.
Clicking these buttons is similar to pressing the skip buttons on a
typical compact disc player: Performer stops playback of the current
Chunk and starts playback of the next or previous Chunk. Chaining
Chunks in this manner does not yield seamless transitions between
Chunks. To chain Chunks seamlessly, chain them inside a song as
described in the Song Window chapter.

The Status Strip has three segments that display information. The left­
hand segment displays the name of the file. The middle segment
contains the Memory and Auto record bars, which contain locations
for Memory functions and Auto-Record. The right-hand segment
displays the currently play-enabled Chunk.

The Memory and Auto-Record bars appear in the Status Strip when
you click one of the memory buttons or the Auto-Record button.

Clicking directly on the measure-time fields (measure I beat I tick) in
either bar will highlight them for editing as shown below.

Memory | Start |Bl|OOO Stop 115|11000

Click on the desired field and type in a number. The Tab key
advances to the next field to the right. The Return key confirms the
entry. It is important to remember that these bars are displayed only
when their respective function is enabled. For example, the Auto­
Record bar is only visible when Auto-Record is enabled. If both are
enabled, both bars will appear in the Status Strip.

The Memory Bar displays the start and stop times for Auto-Stop,
Auto-Rewind, and Memory-cycle (see above). To deactivate the
Memory Bar, turn off the currently enabled Memorj’ button by­
clicking it.

Edit | Start:|Illi 1000 . End:||5|1 lOOQ
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Each of the words in the Memory Bar can be clicked on as a shortcut
for entering times:

The Auto Record Bar

Clicking on the word "Start”or “Stop” ■will load them with the current
play location in the Counter.

Double-clicking on the word "Star/"will load it with the start time of
the current sequence.

Double-clicking on the word “Stop” will load it with the end time of
the current sequence.

Clicking on the word “Memory” will set both the Start and Stop times
to the remembered times. Remembered times are Start and Stop times
stored with the Remember Times command in the Basics menu. For
more information, see Remember Times in the Event List Window
chapter.

Double-clicking on the word “Memory” is a shortcut for double­
clicking on both the Start and Stop times: it loads them with the start
and end times of the current sequence.

The Rewind button works differently when the Memory' Bar is visible:
clicking on the Rewind button once will rewind to the Start time in
the Memory Bar; clicking on it again will rewind to the beginning of
the sequence.

Memory bar times can also be loaded by selecting the region
graphically. See “Setting Memory-cycle points” on page 73.

The Auto Record Bar will appear when the Auto Record button is
enabled. When it is visible, Auto Record is in effect.

Auto Record] ln| gl |000 Out 115|11000

Each of the words in the Auto Record Bar can be clicked on as a
shortcut for entering times:

Clicking on the words “In”or “Out’’w'M load them with the current
play location in the Counter.
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Double-clicking on the word "In "will load it with the start time of the
current sequence.

Macintosh
keyboard
controls

Double-clicking on the word "Out” will load it with the end time of
the current sequence.

Clicking on the words "Auto Record" will set both the In and Out
times to the remembered times. For more information about
remembered times, see the Event List Window chapter section on
Remember Times.

Double-clicking on the words “Auto Record" is a shortcut for double­
clicking on both the In and Out times: it loads them with the start and
end times of the current sequence.

Auto Record bar times can also be loaded by selecting the region
graphically. See “Setting the punch-in and punch-out points
graphically” on page 77.

The main Controls window functions can be operated from the
numeric keypad on the Macintosh extended keyboard.

In addition, the space bar acts as a play/stop toggle. These key
assignments are provided for your convenience. However, you can
create your own customize key assignments using the Remote
Controls window. Please refer to the chapter called The Remote
Controls Window for more information.
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The Metronome
panel

The Tempo Control
button

! The Metronome panel displays the tempo and meter of the currently
play-enabled Chunk (sequence or song).

Current

meter

beat value Tempo control

button

Tempo control: Tempo slider |

tl~ 4 — * I I 13-±>.12 bpm Tempo

i<=? '■ ' S'

Tempo slider

Tempo can be controlled by one of three possible sources:

□ The Tempo slider

□ The Conductor track

0 By remote control from an external MIDI controller, such
as a modulation wheel

The Tempo Control button displays the current tempo source. Click
it to change it. You can change the tempo source at any time, and the
tempos you set in each mode are remembered. In addition, the
tempo control settings saved with each Chunk.

Tempo slider
When the Tempo Control is set to Tempo Slider, you can change
tempo by entering a value in the tempo box in the Metronome
window or by dragging the slider with the mouse or by pressing the
+ and - buttons. Tempo is expressed in beats per minute (bpm). Any
programmed tempo changes (the tempo map) are ignored. You
control the tempo directly with the tempo box and slider. This mode
is useful for Chunks with one constant tempo or for temporarily
adjusting tempos when working on a Chunk.

Conductor Track
When the Tempo Control is set to Conductor Track, you cannot use
the tempo box or slider to set the tempo. Instead, the tempo map in
the Conductor track takes control of the Chunk. In this mode, the 
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tempo slider is merely an indicator of the current tempo; the plus/
minus buttons become disabled and you cannot change the tempo or
beat value directly.

To hear tempo changes that you create with the Change Tempo
command or by using Tap tempo sync, set the Tempt; Control to
Conductor Track, where programmed tempo changes and tempo
maps are stored.

Remote control of the tempo
When the Tempo Control is set to Remote Control, the tempo slider
can be controlled from an external MIDI source such as a modulation
wheel on a MIDI keyboard, or any other source of continuous
controller data.

To set up the Tempo slider for external MIDI control:

1. Choose Remote Control from the Tempo Control pop-up menu.

2. Choose Set Remote Source from the Tempo Control pop-up menu.

A dialog box appears.

onoi

MIDI Source: PC-200

Metronome slider will receive...
O " Pitch bend ® A Controller I UM]

O ± Mono pressure
O J1 Notes
O i Velocities 77

Cancel

3. Select the MIDI device from which the external control data will be
received from the pop-up menu provided.

4. Select which type of MIDI data will be used to control the slider.

Modulation wheels send controller *1.
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The current meter
display

The beat value

The tempo slider

The current tempo

5. Click OK to confirm your choice or Cancel to withdraw the
command.

'l’he meter at the current location is displayed for your reference. To
change meter, you must use the Change Meter command on the
Change menu.

The beat value is the note duration that "gets the beat” in a given
meter. In 4/4, for example, the quarter note usually gets the beat: in
this case, the beat value is a quarter note. In 6/8, the beat generally
falls on the first and fourth eighth notes in the measure, thus the
dotted quarter is the beat value.

The beat value you set does not necessarily correspond to the value
you set for the metronome click. The metronome click value is set
when specifying the meter with the Change Meter command on the
Change menu. For example, in 6/8 meter, you may set a tempo of an
eighth note = 220, but, set the metronome click to a dotted quarter
note (standard in 6/8 time). Quite often though, the beat value will
be the same as the meter denominator (the lower number of the
meter marking).

When the Tempo Control pop-up menu is set to Tempo Slider, the
tempo slider is used to display and change the tempo. To change
tempo, drag the triangular indicator along the slider: to the left
decreases the tempo, to the right increases it. You can also use the
plus/minus buttons at either end of the slider: the + (plus) button
increases the tempo and the — (minus) button decreases it.

When the Tempo Control pop-up menu is set to Conductor track, the
tempo slider serves only as an indicator of the current programmed
tempo; it cannot be dragged with the mouse.

Tempos are displayed in beats per minute (bpm). The beat value can
be any standard musical duration between a sixteenth and whole
note. All beat values can be dotted. A dotted value is equivalent to
one and a half times the value of the duration. (A dotted quarter note
is equivalent to one and a half quarter notes, for example.) Tempos
are displayed and entered with an accuracy of a hundredth of a beat
per minute. This allows you to specify tempos with two numbers to
the right of the decimal point, e.g. 104.78 beats per minute. In 
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Tempo Control during
external synchronization

addition to providing yon with a high degree of resolution, this also
allows you to easily enter tempos that match standard frame click
metronome values.

When the tempo slider is controlling tempo, you can enter the tempo
directly into the Current tempo box. To change the tempo, click the
current tempo box to edit the tempo. If necessary, click the current
beat value to change it.

When Performer is slaved to external sync using the Standard MIDI
beat clocks mode, the master device generates the tempo. The tempo
slider acts solely as an indicator in this case: the master device (drum
machine, a hardware sequencer, etc.) has complete control over
Performer’s tempo, and the tempo control displays the phrase MIDI
Sync to remind you that the Tempo slider is disabled because tempos
are being generated externally by the master device:

Tempo control: MIDI Sync
^4= J I “ I ■" bPm

0 ■:--------------- . -

When synchronizing to time code (such as SMPTE) using the Indirect
or Direct lock modes, Performer follows its own internal tempo. Set
the desired tempo in the normal fashion, or set the Tempo Control
pop-up menu to Conductor track to use a tempo map you have
programmed into the Conductor track.

When synchronizing to Tap tempo sync, you control the tempo in
real time by tapping (sending a MIDI event to Performer), using any
MIDI controller. For details on creating a tempo map using Tap
tempo sync, refer to the chapter Receive Sync. When you choose Tap
tempo and check the Slave to external sync command in the Basics
menu, the Tempo slider is disabled and it reminds you why:

’•3» <

Tempo control: Tap Tempo
IF 4 = Jl = I ~ bpm
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The Counter

Measure Time

Real Time

Performer automatically adjusts real time and frame locations when
the current tempo is changed.

The Counter displays the current playback position in the currently
play-enabled Chunk (sequence or song), expressed in three different
forms: measure lime (measure I beat I tick), real time (minutes:second-
s.hundredths) and frame lime (hours:minutes:seconds:frames). Two
of these formats can be displayed at the same time: one as a main
counter and the other as an auxiliary counter. These time standards
are explained in detail in the next few sections.

You can edit the counter fields to change the current location. You
can change which time formats are displayed by clicking the time
format icons.

Measure time is the most musical of the time formats. Locations are
displayed in standard measures and beats, with an additional unit
called the tick. Unless you are doing film or video work, it is probably
the only time representation you will need (though you may want to
use real time for an objective measurement of the length of your
sequence). The three units are separated by vertical bars. The
example shown below shows measure 4, beat 3, tick 130.

[ZWM
Performer uses a resolution of 480 ticks per quarter note. Events can
thus be recorded and played back with an accuracy of 1/480 of a
quarter note.

Real time is clock time, i.e. time expressed in minutes:seconds.hun­
dredths of a second. Real time is useful to measure elapsed time for
your sequence. By default, the sequence begins al time 0:00.00; this
can be changed with the Set Sequence Start command described later
in this chapter.

rTSSBEh
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Frame Time

Using the Counter to
change the current
playback location

Frame lime is a visual display of SMPTE (Society of Motion Picture
and Television Engineers) time code. It is generally used in film and
video work, but is increasingly used for synchronization in audio
production. It is displayed similarly to real time, in hours, minutes,
seconds, and frames. Frames are subdivisions of a second. The first
frame number in a second is zero. Performer supports four frame
formats: 24 frames per second (fps), 25 fps, 30 fps, and 30 drop
frame.

I D:DG:DD:DDa
When synchronizing to an external time code source, the counter will
always display the same frame time that is being received from the
external source. You may specify the SMPTE location at which the
first measure of the sequence or song starts.

The current playback location is the position where the Chunk will
next play or record from. You can edit the counter fields to change
the current location.

You can change the current location in the currently play-enabled
Chunk (sequence or song) by editing the counter numbers. This can
be done while the Chunk is stopped or playing. If you edit the
counter while the Chunk is playing, it will continue to play while you
enter the values and will cue to the new location after you confirm
your edit. To edit the counter:

1. Click on the time value you wish to change.

The number field will highlight.

2. Enter the number you want.

You can only enter valid values (e.g. you can't enter 27 frames if
you’ve chosen a 25-frame standard). Use the Tab key to move
from one value field to the next. The decimal point on the keypad
can also be used to cycle through fields. If you make a mistake in
entering a value, press the Backspace key or click on the field
again and re-enter the value.

3. Click outside the highlighted number field or hit the Return key.
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Using the decimal key or
Command-T to edit
SMPTE main counter

Setting the Counter
Display

Setting the start time

The decimal key on the Mac keypad will now highlight the main
counter, even if it is SMPTE time or Real time.

There is a shortcut for setting the measure time: using command-T or
the decimal point on the keypad will select the measure field and set
the beat field to 1 and the tick field to 000. You may then enter the
number of the measure you want to move to. As soon as you click
outside the highlighted field or press the Return key, the specified
value will be entered.

These keys will always edit main the counter, even when it is set to
SMPTE time or Real time.

To change which time format is shown in the Main or Auxiliary
Counter, click the time format button in the right-hand side of the
Counter.

Format buttons

The Counter displays dashes when no sequence or song is play-
enabled in the file. To display numbers, play-enable a Chunk in the
Chunks window.

During playback, the measure time counter is updated each time a
metronome click would occur. If the click value is set to a half note
in 4/4 time, only beats 1 and 3 will display in each measure. The click
value can be set with the Change Meter command on the Change
menu.

The start time of the sequence is what you see in the counter when
you rewind to the very beginning. Normally, the default start time for
a sequence or song is measure time 1111000, real time 0:00.00 and
frame time 0:00:00:00.

You can, however, use the Start Time button to change these start
times to anything you want.
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Start time button

UM □
E M O| [c

If you are synchronizing Performer to SMPTE time code, you'll need
to set the SMPTE start time according to SMPTE frame at which you
want the Performer to begin playing. For example, you may want the
downbeat of the first measure in the sequence to begin playing when
the time code reaches 1:00:20:00.

The following are other examples of situations in which you might
want to change the sequence start time:

■ You would like to create one or more pickup measures
before measure 1 (1111000).

n Your sequence should begin with a measure time other
than measure 1 to match its location in a song. (For more
information, see “Matching chunk start times with their
location in a song" on page 230.)

The start times you enter for measure and real time are arbitrary and
only affect the display of time locations. The SMPTE time code start
time, however, determines the frame at which the sequence will
actually begin playing while Performer is slaved to external time
code.

To set the start times of a sequence or song:

1. If you have more than one sequence or song in the file, make sure
it is the currently play-enabled chunk.

To do so, look at the current chunk indicator in the main control
panel. If you need to switch sequences, use the Skip buttons.
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i | Chunk: Seq-1-*------------ Current sequence or song

2. Click the Start Time button in the main counter.

A dialog box appears. The current Chunk name is displayed near
the top of the dialog box.

Current sequence... Seq-1
Assign times to the start of the sequence...

| 0:00:00:001 ■■ Frames
plus | o| timecode bits . ——

| 11 tsi Measures
| 0:00.001 Q Real time

Using SMPTE timecode
bits

3. Click on the value(s) you wish to change.

4. Enter the new value(s).

You may enter a value for each of the three time formats. Measure
values range from -9999 to 9999. Real time ranges from 0:00.00 to
59:59.99. Frame time ranges from 0:00:00:00 to 23:59:59:30.

5. Click on OK to confirm your choice or Cancel to cancel it.

In addition to the start frame, you may offset the SMPTE start time by
a number of bits. There are 80 bits per frame. Although Performer
does not have single bit time resolution, it does offer sub-frame time
resolution. Use the bit offset to finely adjust the start time.
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Setting the SMPTE
frame rate

The SMPTE frame rate can be set with Receive Sync command in the
Basics menu. See "Slaving to SMPTE with MTC, DTL, or DTLe" on
page 609.

Creating pickup
measures before 1111000

Normally, when you rewind Performer back ter the beginning of the
sequence, the measure counter reads 1111000. But sometimes you
may have several pickup beats (or measures) in your music, and you
may still want the music at measure 1 to remain at measure 1. If so,
you can create as many pickup measures before 1111000 as you
need.

To create a pickup measure:

1. As described in the previous section, set the measure start time of
the sequence to 0 to create 1 pickup measure.

If you need two pickup measures, set the Measure start time to -1.
If you need 4 bars, set it to -3.

2. Now, when you press Rewind back to the beginning of the
sequence, the Counter window will read 0111000.

If you set up two or four pickup measures instead of only one, the
counter would read -1111000 or -3111000 respectively.

3. If you already had data recorded in the sequence, shift the data
back to its original location.

When you change the Measure start time, data that used to be at
1111000 is now at 0111000, and so on. All data has changed to
match the new start time. To restore all data to its original position
before you changed the start time, use the Shift command to shift
it back to where it was before.

4. Highlight all track names in the Tracks window and double-click
the word “Edit” in the Edit bar.

This selects the entire sequence.

5. Choose Shift from the Edit menu.
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The accuracy of the
counter display

Controlling how often
the counter updates

6. Choose the Delay option and type in the number of pickup
measures that you previously added.

If you added 1 pickup measure by setting the start time to
Olli 000, shift by 1 measure here.

O Advance
® Delay

'?< |—111 O|OOO|Ei
O | 0:00,001 (D

O | o 00 :00 001

7. Click OK.

You have now successfully restored all data back to its original
location before changing the measure start time, and you also have
several empty pickup measures in which to record.

Performer’s first priority is to keep up with the flow of MIDI data. If
it encounters a great deal of data, it selectively ignores its graphic
display until the microprocessor load decreases. This may keep the
counters from updating and they may skip beats during these times.
This is Performer’s way of keeping up, and does not necessarily mean
that MIDI data is being transmitted inaccurately.

A side effect of this is that the counter may not always be accurate. It
should therefore not be used as a metronome. In general, the counter
display should not be used as a visual indication of tempo. Use the
Flash on the Basics menu instead.

During playback, the measure time counter is updated each time a
metronome click would occur. For example, if the click value of the
current meter in the sequence is set to a half note in 4/4 time, only
beats 1 and 3 will display in each measure. The click value can be set
with the Change Meter command on the Change menu.
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Negative numbers in the
counter display

When using an external sync source, Performer may run for a little
while before the sequence actually starts. During this time, you may
see negative bar numbers. These increase in value (towards zero)
until the start measure is reached.
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Chapter 6 The Remote Controls Window

The Remote Controls window lets yon access all of Performer's
transport functions, such as play, stop, rewind, and so on from a
MIDI controller. For example, a note value of CO could operate the
Stop button in the Controls window; controller 64 On could operate
the Skip Forward button. In addition, each Performer function has a
reassignable Macintosh keyboard equivalent.

The Remote Controls window also allows you to cue sequence and
song Chunks for playback from your MIDI controller. Each Chunk in
the file appears as a Function in the Remote Control window with a
MIDI and Macintosh key to play-enable that Chunk.
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Quick Reference

Remote Master

Group Master control­

individual control

Master status icon

“■ Remote Controls
FUNCTION EVENT 1 SOURCE CH MRC RET

r°»~i

£§)|

Remote Master
Cycle Rec. Controls

____
J'EbO i

any any
any any

Opt - Esc
Opt [-] g

a

Cycle On/Off /CO i any any [-1
Spot Erase J-DO i any any *
Transport Controls /F»O i any any Tab
Play/Stop toqqle J'EO i any any Spacebar

<KJI> 1
<w

Play
Stop

/FO i
J-GO i

any any
any any

[Enter]
[0]

Pause /AO i any any [2]
Rewind J'BO i any any [11

<100 Record /C1 i any any [3]
O Auto Record any any Opt [3]
<mt> Memory Stop any any [8]
<10> Memory Rewind any any [9]

Count Off any any [=1o Wait any any [/]o Overdub any any [*]<D> Slow Forward any any | [6]
<JD> Fast Forward ____________ any any [+]
O Slow Reverse any any [5]
<D[> Fast Reverse any any [4]
<m>i
<1DI>

Click On/Off
Memory On/Off

__ any any
any any

[Clear]
[7]

Set Times any any [.]
O Cue Chunks any any Opt-q
<Ml> Chain Chunks any any Opt - c
O Skip Forward ____________ any any Opt - f

Skip Backward any any Opt-b<or> Next Record Track any any i
O Prev. Record Track ____________ any any t

Step Record Controls /AbO i any any Lock - Return
Backstep any any Lock [0]

a.. Step any any Loot: [Enter]
Beat anu any Lock [+]
Measure any any Lock [-]
Tuplet On/Off
128th note

_______ __J any any
anu anu

Lock [/]
Lock [9]

a., 64th note ____________ any any 1 Loci: [81

The Remote Controls window is opened by choosing it from the
Windows menu. For your convenience, new Performer files contain
both the Transport and Chunk Select controls with default MIDI and
Macintosh key assignments ready to use.

Remote Master: Enables or disables all MIDI Remote Controls and
Master Controls. It remains at the top of the list and cannot be moved
or deleted.
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Group Master Control: Enables or disables an entire group of MIDI
Remote Controls with a single MIDI or Macintosh keystroke. Master
controls can be moved, added, deleted, and renamed.

Individual Control: Displays a specific Performer function, and the
MIDI event and Macintosh key assigned to trigger the function. An
individual control is available when the Master above it is On; if a
control has no Master, it is always on.

Master Control Status Icon: Indicates the Master’s current status, either
On or Off. The current mode is indicated by the text and color of the
status icon: On and highlighted, or Off and white.

Function: Defines the Performer function to be triggered.

Event: Defines the MIDI event that will trigger the Performer function.
To edit the event, click the field and play the new event, then press
the Return, Enter, or arrow keys.

MIDI Controller: This is the MIDI device in your studio from which
you would like to trigger the remote controls. A pop-up menu of
devices is provided in this column by FreeMIDI.

Mac Key: Defines the Macintosh key (or keys) that will trigger the
Performer function. To change the key, click it, press the new key(s),
and click outside the box to confirm your choice.

The Remote Controls
Window Mini-menu

The Remote Controls window mini-menu contains the following
items.

Add Defaults: Adds the Transport Master and group members, and the
Chunk Select Master with a control for each Chunk in the file.

Add Master: Adds a Master control to the bottom of the functions list.
This new Master can be moved and assigned MIDI and Macintosh
triggers.

Duplicate: Add a duplicate of the selected item(s) to the bottom of the
Remote Controls function list.

Delete: Deletes the highlighted Masters and controls. Select functions
by clicking them. Select contiguous functions by dragging. Select
discontiguous functions by shift-clicking.
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Basics The Remote Controls window lists each Performer function along
with its assignments, and allows you to edit these assignments to
completely customize your Remote Controls. Further, you can load
the assignments you make into any other Performer file, or even
make them part of every new file using the Save As ‘New’ Template
command.

There are two types of controls: individual, for example Play or Stop,
and Master, such as the Transport Controls Master. Individual controls
are grouped under Master controls, which enable and disable their
group when toggled with a MIDI event or a key on your Macintosh
keyboard. Individual controls actually operate Performer functions,
whereas Master controls make a group of individual controls
available or unavailable.

Master Controls Every new Performer file automatically contains several Master
controls: the Remote Master, the Transport Controls Master, the Step
Record Controls Master, and the Chunk Select Master. Each one
serves as a toggle, rendering its sub-group of controls available or
unavailable. To customize Remote Controls, you can add your own
Masters and change their assignments whenever you wish.

A Master’s control group is displayed as an indented list beneath that
Master. Each indented control can be moved into another indented
group, thereby redefining which Master will affect it. by simply
dragging the control’s icon up or down in the window. Likewise a
Master can be dragged to a different position to redefine its control
group.

At any given time, a Master control is either On or Off. Correspond­
ingly, the Master’s status icon displays On and is highlighted, or Off
and is dark.

On and inverted means that the functions under that Master are
available. When the Master icon is Off and highlighted, the MIDI
controls of the group under that Master are unavailable; each
function’s trigger acts as a normal MIDI event. Macintosh controls are
always available, regardless of the On/Off status.

The combinations of Master status and individual control status make
Performer’s Remote Controls extremely flexible. Here are some
typical Remote Controls setups:
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■ The controls occupy an infrequently used range of your
MIDI controller, and are always on. You don't typically use
this octave in your sequences.

Enabling and Disabling
Remote Controls

h The controls occupy several keys of a MIDI controller
transmitting on one channel, and on another channel you
have a second controller for recording.

□ The controls occupy the entire span of keys on your
controller, and you can toggle them on and off with a
single key at the very top of the keyboard. The entire
keyboard can switch instantly between remote controls
and MIDI notes.

You can turn on and off the MIDI Remote Controls in the following
ways:

□ Press option-escape (esc)

□ Click the Remote Master icon in the Remote Controls
window

Changing a Control’s
Remote Assignments

n Play the MIDI event you have assigned to it

Performer comes with a pre-defined set of Remote Controls for the
Transport and Chunk Select functions. You might find these defaults
suitable for your working style. But should you wish to completely
customize your Remote Controls, Performer makes it easy.

To change the event assignments of a Performer function or Chunk
select control:

1. Choose Remote Controls from the Windows menu.

The Remote Controls window opens or, if already open, becomes
active.

2. Click the MIDI assignment that you wish to change.

The field pops up. If you wish to enter a note-off event, you must
play and hold the note, then click the assignment.
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Disabling a Single
Control

Creating Custom
Control Groups

; 3. Play the MIDI event on the instrument you plan to use as the remote
control device.

Any MIDI event from any connected MIDI controller is suitable.
although notes and switch controllers are easiest to use. The
highlighted field updates to display the event you just played.

4. Type Return or click anywhere outside the pop-up box to confirm
the change.

Typing the up or down arrow confirms the change and pops up
the previous or next event, respectively.

5. Choose the Mil DI device and channel that you will be triggering the
remote from.

6. Click the Macintosh keyboard equivalent that you wish to change.

The field highlights.

7. Type the new key combination on your Macintosh keyboard.

Any key or combination of normal and modifier keys is suitable.

8. Click anywhere else on the screen.

Because of its unique function, this pop-up box cannot be
confirmed using the Enter or Return key. The box can be exited
only by clicking and cannot be canceled.

To turn off an individual control click the MIDI assignment for a
remote control and then backspace in the pop-up box.

This is especially helpful with the Remote Master to avoid enabling
the remote controls by accident over MIDI. Also, having lots of MIDI
assignments in the Remote Controls window can sometimes cause
delays when using Patch Thru. If you delete unused MIDI
assignments from remote controls, you can prevent delays.

Performer lets you add your own Master controls, which you can use
to toggle on and off whole groups of individual controls. Just like the
default Masters that Performer provides (Remote. Transport, and
Chunk Select), the Master you add governs all controls indented
beneath it. You can drag both Master and individual controls up or
down in the Remote Controls window to determine their grouping.
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Deleting Controls

To add a new Master control:

1. Click anywhere in the Remote Controls window to activate it.

2. Choose Add Master from the Remote Controls window mini-menu.

The added Master control appears at the bottom of the Function
list.

3. Option-click the name of the added Master to change it.

Type Return to confirm the change.

4. Click the Event field of the new Master to assign a MIDI event.

The field pops up.

5. Assign MIDI and Macintosh key events to the new Master.

Refer to the section called Changing a control’s remote
assignments for details.

6. As mentioned, the position of a Master determines what group of
controls it will affect. Since a newly added Master appears at the
bottom of the Functions list, you will need to reposition the added
Master using its icon. You can also drag individual controls from
Master to Master.

To reposition a Master or individual control:

1. Drag the control’s icon to the desired group.

2. Release a Master just above the group; release an individual
control beneath the Master that should control it.

An individual control dragged above the first group’s Master will
be controlled by the Remote Master.

To delete a control or group of controls:

1. Click the name of the control to select it.

Drag to select several contiguous controls; shift-click and shift­
drag to select discontiguous controls.
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2. Choose Delete from the Remote Controls window mini-menu.

Restoring Deleted
Controls

Loading Remote
Controls Assignments
From Another File

The selected controls disappear from the list. Their MIDI and
Macintosh keyboard assignments cannot be retrieved.

In the event that you delete controls during a session and then decide
you’d like to retrieve them. Performer provides a quick mini-menu
command to regenerate both sets of default controls. Choosing Add
Defaults places the Transport and Chunk controls at the bottom of the
functions list; you can arrange, reassign, and delete them to your
satisfaction.

The MIDI and Macintosh key event assignments of controls that you
delete are not held in memory. Once you delete a control, restoring
it using Add Defaults will produce the default controls with the
default assignments. If you wish to save your custom event
assignments, just make sure they are present when you close the file.
The next time you open the file, your customized controls will be
intact.

Remote Controls assignments from one Performer file can be
imported into any other Performer file using the Load command,
found in the File menu. This means you can set up the Controls the
way you like them, once, and they’ll be available for importing into
any of your files.

The Remote Controls assignments that you make in a file are
automatically saved as part of that file. The Load dialog box,
however, enables you to extract assignments from an unopened file,
then load them into the file in which you are working.

To load Remote Controls assignments into an open file:

1. Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2. Click the file containing the assignments you wish to load, then
click Open.

Alternately, you can double-click the file name. Performer’s Load
dialog box appears, displaying the file name at top.

3. Choose the Load Remote Controls option.
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Remote
Controls Hints

Customizing Controls in
New Files

Spot-erase

4. Optional: If you wish to load any Chunks from the selected file,
choose the Load Chunks option and the Data or Link sub-option.

If you wish to load more than one Chunk, you can drag to select
contiguous Chunks and shift-click to select discontiguous Chunks.
Deselecting this option loads only the file’s Remote Controls
assignments.

5. Click OK to confirm your choice(s) or Cancel to withdraw the Load
command.

Clicking OK causes the selected file’s Remote Controls
assignments, as well as any selected Chunks, to be loaded into the
open file. The imported assignments appear at the bottom of the
Remote Controls window.

Performer has a default New file format that contains the Remote
Master, the Transport Controls Master and functions, and the Chunk
Select Master and individual functions. However, the Save as ‘New’
Template command in the File menu lets you define Performer’s New
file as you like.

To customize your New files:

1. Configure Performer’s windows, their contents, and any other
features as you find most useful.

This file will be your template source file: Performer will
remember your exact track setup and layout as well as many other
features. MIDI and Conductor track data will not be included in
the New template.

2. Choose Save as ‘New’ Template from the File menu.

3. Click OK to confirm the command, Cancel to withdraw it.

If you confirm the command, the New template of the open copy
of Performer is redefined based on the current file.

Performer’s spot-erase feature consists of the spot-erase remote
control. Spot-erasing works like most conventional drum machines:
you hold down the spot-erase key and then hold down the pitch of
the note(s) you want to erase.
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Switching MIDI devices,
channels and patches

To spot-erase:

1. Start playback or overdub recording.

You can spot-erase while playing or overdub recording. You can
spot-erase while using memory-cycle and while looping.

2. Record-enable the track in which you want to spot-erase.

3. Hold down the tilde key (') and, while holding it down, hold down
the notes you want to erase.

If you like, you can reassign spot-erase to a different key.
Alternately, you can hold down the spot-erase MIDI remote,
which is DO (D-zero). Notice that you can spot-erase several notes
at the same time-—as many as you can manage, in fact.

4. As Performer continues to play (or overdub record), keep holding
down the note(s) you want to erase for as long as you want to erase
them.

If you want, you can release the spot erase key, even while you
continue to hold down the notes you are erasing. The spot-erase
key only needs to be held down when you first hold down the
pitch(es) you want to erase. Once you’ve held down a pitch, you
can release the spot-erase key.

5. Release the key(s) when you want to finish spot-erasing.

You can freely “punch-in” and out of spot-erase mode. Spot-erase is
undoable.

Notice that you can spot-erase directly from your MIDI controller
using the MIDI event assignment for it. If you don’t normally use
Performer’s Remote Controls feature, you can still use spot-erase
without using any other remote controls because spot erase has its
own group master. You can even trigger the spot erase using a foot
switch, a data slider or wheel on your MIDI controller, or anything
that can send MIDI data. That way, you can configure spot-erase as
conveniently as possible.

The Sound Selection group of remote controls lets you choose the
next or previous device, MIDI channel, or default patch for the
currently selected track. If no track is selected, these commands affect 
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Creating Remote
Control Macros

Remote Chunk Cueing
with MIDI Song Select
Messages

the currently record-enabled track. Along with the “record next/
previous track" remote, you can easily change tracks, devices,
channels and sounds, all from your controller keyboard while
recording.

Sound Selection J'BbO i •any any §g Shift Opt - i
Next Device any any Shift - i
Previous Device any any Shift -1
Next Channel any any Opt-t

_5Ll Previous Channel any any Opt - i
Next Patch any any IS -?
Previous Patch any any

Several commands can be triggered in succession with one keystroke
by assigning them to the same MIDI event. For example, you can
create the following three-step sequence of remote controls: Stop,
Chunk select, and Play. If you place them in that order in the Remote
Controls List and assign them to the same key, Performer will execute
the topmost control first. The current sequence will stop, and the
specified Chunk will cue up and begin playing—all with one
keystroke!

Similarly, you can assign all of your Master controls to the same MIDI
or Mac key event — that event now turns on and off your MIDI
Remote Controls.

In addition to Chunk select Remote Controls, Performer also allows
you to cue Chunks for playback by sending a Song Select message
from a MIDI controller. The Chunks window column 5# displays the
Song Select number that, when received, will cue the corresponding
Chunk for playback. If a Chunk has no Song number assigned, the 5#
column displays a single dash (-).

Most hardware sequencers and some MIDI keyboard controllers can
send and receive Song Select messages. Simply send a Song Select
message as instructed in that module's documentation. If the open
file contains a Chunk assigned to the Song number in the message,
that Chunk will be play-enabled. If more than one Chunk has the
same Song number assigned, the one highest in the Chunks list will
be cued.
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j When used in combination with the Chunk Chaining buttons in the
: Controls window, a Song Select message cues the corresponding

Chunk to be play-enabled or played back. The information bar in the
Consolidated Control panel indicates which Chunk has been cued.
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Chapter 7 Playback

When Performer is “playing” music, it is sending out stored MIDI data
at specified times to MIDI-equipped instruments. These instruments
use the data as instructions for when to turn notes on and off, etc.
Conceptually, it is similar to a player piano which uses a set of
recorded data (the piano roll) to control its “instrument" (the piano
mechanism). The synthesizer or sound module produces the actual
sound, and Performer tells it when and how to do so.

To play a sequence or a song:

1. Open a Performer file.

Choose Open from the File menu. A dialog box will appear. Select
the file you wish to open by clicking on it and pressing the Open
button.

2. Choose Chunks from the Windows menu.

The Chunks window will open or, if it is already open, come to
the front.

3. Play-enable the Chunk you wish to play back.

Since a file can contain several Chunks (sequences or songs), you
must play-enable the one you want.

4. Set the location from which you want playback to begin.

To simply rewind to the beginning of the sequence, click the
Rewind button. To choose a general location, drag the Position
Bar below the main transport controls; to start at a specific
location other than the beginning, type in the location in the main
counter. Or double-click at the desired playback location inside
the time ruler in a Graphic Editing window. You can double-click
in the Tracks overview time ruler as well.
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5. Play-enable the tracks you wish to play back.

If you are playing a sequence, double-click its name to open its
Tracks window and click the Play-enable button to the left of the
track name(s) you wish to hear. If the track is not play enabled,
you will hear nothing from the track. If you are playing a song,
play-enable the tracks in each sequence that the song contains.

6. Choose a MIDI playback device for each track.

A track can be assigned to one channel on a single MIDI device.
It can also be assigned to several different MIDI devices simulta­
neously. Devices can be set by clicking on the play destination in
the Tracks window next to the track name. A pop-up menu
appears. The devices in the list are provided by FreeMIDI. If a
device you want is not present in the list, use the FreeMIDI Setup
program to add the device to your MIDI configuration.

Current device assignment

FreeMIDI Devices

Device groups

New device group command

HUE, EEC] LEV | PL

EllflE3E
k

-TG100

7 I fell___ l_5 Video Time Piece

tProteus/2

End

Proteus /2-1
Proteus/2-2

String Pad
Brass stack

►Deep Bass Combo
Big Ben Belts
Rich Orchestra

►Nev/ Device Group...

Proteus/2-5
Proteus/2-6 -
Proteus 72-7
Proteus/2-8
Proteus/2-9
Proteus/2-10
Proteus/2-11
Proteus/2-12
Proteus/2-13
Proteus/2-14
Proteus/2-15
Proteus/2-16

1111000
None
BRC
CBX-D5

►K2000R
MIDI Mixer 7s
Modem All cables

Patch 40

| DFLT. PATCH f.
I

Nocturne|
E

Figure 7-1: Selecting a playback device from the pop-up menu in the Device column next to the track name.

You can change a track's playback channel or Device at any time-
-even while the sequence is playing back.
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7. Choose a sound from the track’s patch list by clicking in the Patch
column next to the track name as shown below.

HB>|SIF|3P3I| $Pq-1

jiy i'! iLi rrh woo_____ C.-.4J rni 1001 3

] Conductor]-
■j >.“'>T|05R/V-8J Track-1" i'CM Kit

SEE

Click in the Patch column

next to the track to choose a

153 Hoil K«IUm
134 Auto Percussion
135 Soon

h 136 0hB<??!!
”2] 137 Sisternal

138AKordim
139 Industrial Komp
140 Clock S&H Lead
141 Multi-Texture
142 Quillsichord
143 Toto Brass
144 Belles
145Koto1in
146 Walking Bass

- 147Vibratone

> l~05RA/-6 j Track-6 |
J*J Q5R/WE7 J.Trjckr-7. J.

i 05R/W-8"; Track-8 |GMK

ICO Bahrirr.ba
101 Ethereal Strings
102 Piano / S.String
103 5 Bve Percussion
104 Lauer Ktt
105 Guitar Mutes 2
106 Too Bad Bass
107 Pipes 1
108 Jethro's Flute
109 Pinger
110 DigThat DC Lead
111 Klakran
112DXChv
113 Baroque Strings
115 Clean Lead Guitar

j_-j Ou?! Tr;&!.-4
167 Organarimba
163 AM Square Synth
169 Through The Blue
170 Pulsar
171 Sweeper
173 Ensemble Pizz
174 Organellica
175 Classical Gtr
176 Talk Talk
177 Vater flute
178 Lonely Fifths
179 RainforestCrunch
180 Native Drum
181 Stratosphere
132 Guitar / Flute

sound for the track. For many

popular MIDI devices,

Performer provides a pop-up
list of the factory-default

sounds in the instrument.

116 WonderSynth Bass
117 Stackoid
118 Orient Wind
119 40 Something
120 Dyno Synbrass
121 Lunar Dance
122 Ballad Organ
123 Glockenspiel
124 Bel1Tree>BigBell
125 HelterSkellerGtr
126 Alaska

148 Analog Brazz
149 The Night Shift
150 7th World String
151 Tranquility
152 B-2000
153 Trombone
154 Wave Bells
155 AcousGtr&Strings
156 Mogue Bass
157 Orchestral Pad
159 In Th? Well

183 Klarinet
164 Press Evolution
185 Rockin' Lead
186 The Buzz
187 Wood Bars
188 Poly Analog 5ths
189 Northern Winds
190 Doomsday
191 Ethereal Echoes
192 Harp On It
193 Solo Bass Horn

127 Touch Down
128 Almost Muted
129 PressForThunder!
130 Hi Ros Sv/eeper
131 Deep Atmospheres
132 Pipes 2

160 Synth Wood Flute
161 Shimmer ling
162 Toy Box
164 Glassy Eyes
165 Syncro Taps
166 Metallica

194 Alien Industry
195 Slo FlangeStrngs
196 Riding The Rails
197 Heavee Metal
198 Click
199 Default Program

Patch 0
Patch I
Patch 2
Patch 3
Patch 4
Patch 5
Patch 6
Patch 7
Patch 8
Patch 9
Patch 10
Patch 11
Patch 12
Patch 13
Patch 14
Patch 15
Patch 16
Patch 17
Patch 18
Patch 19
Patch 20
Patch 21
Patch 22
Patch 23
Patch 24
Patch 25
Patch 26
Patch 27
Patch 23
Patch 29
Patch 30
Patch 31

Patch 32
Patch 33
Patch 34
Patch 35
Patch 36
Patch 37
Patch 38
Patch 39
Patch 40
Patch 41
Patch 42
Patch 43
Patch 44
Patch 45
Patch 46
Patch 47
Patch 48
Patch 49
Patch 50
Patch 51
Patch 52
Patch 53
Patch 54
Patch 55
Patch 56
Patch 57
Patch. 53
Patch 59
Patch 60
Patch 61
Patch 62
Patch 63

Patch 64
Patch 65
Patch 66
Patch 67
Patch 68
Patch 69
Patch 70
Patch 71
Patch 72
Patch 73
Patch 74
Patch 75
Patch 76
Patch 77
Patch 78
Patch 79
Patch 80
Patch 81
Patch 82
Patch 83
Patch 84
Patch 85
Patch 86
Patch 87
Patch 83
Patch 89
Patch 90
Patch 91
Patch 92
Patch 93
Patch 94
Patch 95

Patch 96
Patch 97
Patch 93
Patch 99
Patch 1 CO
Patch 101
Patch 102
Patch 103
Patch 104
Patch 105
Patch 106
Patch 107
Patch 108
Patch 109
Patch 110
Patch 111
Patch 112
Patch 113
Patch 114
Patch 115
Patch 116
Patch 117
Patch 118
Patch 119
Patch 120
Patch 121
Patch 122
Patch 123
Patch 124
Patch 125
Patch 126
Patch 127

If you see generic names like this, you can

go ahead and use them anyway, as long
as you know what sounds correspond with

each patch change number. Or you can

modify the list so that it shows the actual

sound names. For details, see chapter 48,

“Using PatchList Manager” (page 725).

Choosing a device for
playback

8. Press the Play button.

The sequence will begin to play. The Counter advances.

9. When finished playing back, press the Stop button.

When the sequence is finished, Performer will keep playing
indefinitely until you press the Stop button. (This doesn’t
endanger your sequence, though it is best to stop playback when
the sequence is done.)

To choose a playback device, choose it from the pop-up menu
provided in the Device column next to the track name as shown in
Figure 7-1 on page 110. You can also do so from your Mac keyboard.
See “Switching MIDI devices, channels and patches” on page 106.
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Choosing multiple
playback devices fora
single track

Creating a device group

To assign a track to multiple playback devices, you need to assign it
to a device group. You can either choose an existing device group as
shown in Figure 7-1 on page 110, or create a new one by choosing
New Device Group, which opens the Device Groups window
(described in the next section). A device group can contain up to ten
MIDI channels from any combination of devices in your MIDI setup.
To create a device group, read the next section.

'*■ Hint: if a track is currently assigned to a device group,
and you want to make changes to the device group,
option-click the device group name in the Tracks
window next to the track and the Device Groups
window will automatically open and scroll to the
group. You can then make whatever changes you
want.

A device group is a collection of individual FreeMIDI devices—or
more specifically, MIDI channels from FreeMIDI devices. For
example, a device group called Massive String Pad might include the
following device channels: Kurzweil K2000 channel 1, Korg 01/W
channel 5, Akai S1000 channel 3, and Proteus/2 channel 13- As a
result, the device group produces a combination of the sounds
currently playing on each of these MIDI channels. A device group can
contain up to 10 MIDI channels.

Devices groups appear in the same pop-up list as all the rest of your
FreeMIDI configuration devices, and they are used to assign multiple
MIDI channels to a single track in the Tracks window.

To create a device group:

1. Choose Device Groups from the Windows menu to open the Device
Groups window.
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Click this expand/

compress icon to
toggle the check box

display shown here.

Click the checkboxes

to quickly add MIDI —

channels to the

device group.

Click the expand/compress

icon again to return to the

normal display, which allows
you to a default patch for

each channel.

2. Choose Add Device Group from the mini-menu.

If you would like to add more than one at a time, hold down the
option key while selecting the command from the mini-menu.
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Here is a summary what you can do in this window:

Changing your playback
device list

To do this:

Change the device group name

Add a device to the group

Add several devices quickly

Close the check box display

Remove a device

Set a default patch for a device

Clear a default patch

Remove a device or device group
from the list

Duplicate a device group

Do this:

Option-click the name to pop-edit it.

Click the pop-up menu arrow
beneath the device group name and
choose the desired device and MIDI
channel from the pop-up menu.

Click the Expand/Compress icon
below the device group name to
open up a display of all the devices in
you studio. Then click the check
boxes that corresponds to the MIDI
channels you want to add to the
group.

Click the Expand/Compress icon
below the device group name again.

Click the device and choose None
from the pop-up menu.

If the device is currently expanded,
close it first by clicking the Expand/
Compress icon below the device
group name. Then click in the default
patch column to the right of the
device and choose the desired patch
from the pop-up menu.

Click the device name to select it and
choose Clear Default Patch from the
mini-menu.

Click the name to select it and choose
Delete from the mini-menu.

Click the name to select it and choose
Duplicate from the mini-menu.

Performer relies on FreeMIDI for an up-to-date list of the MIDI
devices connected to your Macintosh. If a device is connected to the
MIDI OUT of your MIDI interface, and the connection is accurately
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reflected in your FreeMIDI configuration, then the device shows up
in the pop-up list with the same name it has been given in FreeMIDI.
To make any changes to the playback device list, choose Edit
FreeMIDI Configuration from the Basics menu. This command
automatically opens FreeMIDI Setup, which lets you make changes to
your device configuration.

Editing during playback Many of Performer’s features, such as windows, dialog boxes, edit
region selection, edit commands, and other features can be used
during playback. For example, you can open another window or use
the Transpose command while the music is playing back; you do not
have to press the stop button beforehand. So, the next time you are
listening to your music and would like to make a change, don't reach
for the stop button. Just execute the command while the music is
playing.

Here are some examples of things you can do during playback:

a Select a region for editing (in an Event List, Tracks
Window, etc.)

□ Edit a region with the Edit or Region menu commands

■ Rearrange Chunks in the Song window

■ Cut, copy, drag, option-drag (copy), etc. notes and data in
Graphic Editing and QuickScribe notation windows

■ Reassign the playback channel for a track

■ Add, delete, rename, or reposition a track

■ Access a mini-menu command such as Set View Filter

During playback and recording, the Counter and other displays may
become irregular and seem to skip beats. This is due to Performer’s
primary obligation which is to receive and output MIDI data on time.
Performer may have to devote all of the computer’s resources
towards this end and thus may not be able to keep the screen display
completely smooth and current. The click and flash will provide an
accurate determination of the tempo. In addition, editing commands
may sometimes take longer due to the amount of processor lime
required to deal playback.

Playback 115



Soloing tracks

Looping playback

Event Chasing

Enabling Event Chasing

Some features, because of their nature, cannot be accessed during
playback. These features are either greyed out (unaccessible) during
playback or will have no effect unless you press the Stop button
before using them. Examples are:

□ Using the MIDI Interface dialog box

□ Save or close a file

Using Solo allows you to easily select a subgroup of tracks to be
heard during playback. This allows you to focus your attention on
one or more tracks without disrupting playback in any way. The solo
tracks group can be changed during playback, making it possible to
hear many combinations of tracks without having to stop playback.
The procedure for soloing tracks is described in detail in The Tracks
Window chapter.

Playback of the entire sequence can be looped seamlessly between
any two points. For information see ‘ The Memory-cycle button" on
page 71.

Event chasing addresses a common problem with playback: hearing
the wrong patch (sound) when you begin playback in the middle of
your sequence. This happens because MIDI data consists of a stream
of single events. If a patch change occurs early in the stream, say at
measure five, but you start playback later on, say at measure twenty,
the patch change will not be played and your synth will not be set to
the proper sound.

Here’s how event chasing fixes this problem. Every time you click
Play, Performer searches backward in each track for the last patch
change, volume controller, and so on. If it finds one, it transmits the
event before playback begins, setting the synth to the correct patch,
volume, etc. Performer can chase all types of data, including notes
which may be playing at the current location.

Performer allows you to choose which types of MIDI data will be
chased. To enable Event Chasing:

1. Choose Set Event Chasing from the Basics menu.

The Set Event Chasing dialog appears.
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2. Select the types of data you wish Performer to chase.

Click Set All to enable chasing of all MIDI events. Deselecting
unnecessary types reduces chase time after the Play button is
clicked.

3. Click OK to confirm your choice or Cancel to cancel it.

To disable Event Chasing, click Clear to deselect all data types for
chasing.

In general, it is best to chase only types of data that need to be
chased. In particular, notes add considerably to the time it takes
Performer to chase.

Event chasing and loops Event chasing cannot recognize loops in a track. If you have loops in
a track, and the loops contain patch changes or other data that you
are chasing, you may get unexpected results when you begin
playback during or after the loop.

With the Auto-Scroll command in the Basics menu, windows with the
ability to scroll will update during playback or recording. You can
choose whether all windows on the screen will scroll, or only the top
window. In addition, you can choose what kinds of Performer
windows will scroll.
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When Performer windows scroll, they “page” along with the music.
That is, when playback reaches the last measure or event in the
current window, the window jumps to the next windowful of data,
just like clicking in the grey area of a scroll bar.

With Auto-Scrolling enabled, windows will update any time you
change playback location, even when Performer is not playing back
or recording. For example, if Performer is slopped and you press
Rewind, all Auto-Scrolling windows will scroll to the new location
indicated in the Counter window. Auto-Scrolling occurs when
pressing the cueing buttons, dragging the arrow in the position bar,
typing a new location into the Counter window, or cueing to a
marker in the Markers window.

When Auto-Scroll is enabled, Graphic Editing, QuickScribe notation,
and Event List windows open to the current playback location.

Auto-scrolling will only occur in windows related to the currently
play-enabled Chunk. For example, if a Song window is open, it will
not Auto-Scroll unless the song is play-enabled in the Chunks
window. Windows associated with Chunks inside the song will not
scroll when the song is play-enabled. Only the Song window and its
Markers window will scroll.

To enable Auto-Scrolling:

1. Choose Auto-Scroll from the Basics menu.

The Auto-Scroll dialog box will appear.
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All windows O Top window only

Window: Cursor:
® Event Lists
® Graphic Editing windows ®
® Song windows
® Markers window
® Notation Editing windows ®.
® Tracks windows ®

2. If you would only like the top window to scroll, click the Top
window only option.

This option causes only the top window to scroll when you have
more than one window open on the screen. This option also
reduces Performer’s processing load. If your Macintosh has a
68000-based CPU, or if your sequences tend to contain large
amounts of dense MIDI data, this option will ensure accurate
playback and responsive scrolling.

3. Choose which types of windows you prefer to Auto-Scroll.

Click the check box next to the window type to select it. Use the
Set All and Clear buttons to select or deselect all window types.
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4. If you would like a scrolling cursor, select the cursor option(s).

The scrolling cursors display the current playback location as
shown in the main counter. They can also be dragged left or right
to change the current playback location. They can be dragged
when Performer is stopped or while it is playing back.

With the Cursor option checked, a

‘wiper'’ appears in the Graphic Editing

and Tracks Overview windows to

show the currently playback location -
of the sequence. This wiper scrolls

during playback and can be dragged

to change the playback location. You
can also double-click inside the time

ruler at any location to make the
cursor jump to that location.

5. Click OK.

To disable Auto-Scrolling:

1. Choose Auto-Scroll from the Basics menu.

The Auto-Scroll dialog box will appear.

2. Click the Clear button.

This deselects all window types.

3. Click OK.

120 Playback



Chapter 8 Patch Thru

Patch Thru allows you to hear incoming MIDI data from your MIDI
controller instrument played back on your output synthesizers. More
technically, Patch Thru echoes MIDI data received by Performer to
any MIDI device in your studio that you choose. You’ll want to use
Patch Thru when most of the time because it allows you to hear what
you are playing on your MIDI sound modules while recording. Patch
Thru also provides an easy way to experiment with different
playback synthesizers without having to manually reconnect patch
cords and change MIDI channels on the instruments.

Here is an overview of how Patch Thru works. You press a key on your controller keyboard.

The note gets sent to Performer. Performer determines which device (MIDI channel) the note

will be echoed to by the track is currently record-enabled in the Tracks window. It then sends

the note to the device assigned to that track, which plays the note using whatever sound

(patch) is currently selected on that channel.

Patch Thru works whether you are recording or not. However, MIDI
data will only be patched through tracks which are record-enabled. If
you don’t hear anything on your synthesizer modules when playing
your controller, check to be sure that the correct track or tracks are
record-enabled.

Timing and synchronization data are not echoed in Patch Thru.
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Turning on Patch Thru

Direct Echo

Auto Channelize

Auto Channelizing in a
Sequence

122

To turn on Patch Thru, choose it from the Basics menu and select
either Direct Echo or Auto Channelize.

^.PatchThru

Select patchThru mode:
O Off
O Direct echo
® Auto channelize

Direct Echo causes incoming MIDI data from your controller to be
echoed back out on the same channel it was received. For example,
if your MIDI controller is transmitting on channel 3, MIDI data is
echoed back out on channel 3 by Performer. The Input Filter settings
do not affect direct-echoed data; information is simply echoed
straight through, by-passing most of Performer’s MIDI processing.

Direct Echo is useful in situations where you want to be able to
change the channel you are echoing to from your MIDI controller
keyboard by simply changing its transmit channel.

Auto Channelize causes incoming MIDI data from your controller to be
echoed back out to the device and channel for the currently record-
enabled track in the Tracks window. The following sections discuss
several scenarios that affect Auto Channelize.

When a sequence is play-enabled in the Chunks window, here is
how Auto Channelize Patch Thru works. In normal recording mode
(MultiRecord off), incoming data is echoed to the device specified for
the record-enabled track in the currently play-enabled sequence. In
the example shown below, any incoming data received by Performer
will be sent to the Kurzweil K2000R channel one. This is because the
Funk Bass track is record-enabled, and its play destination is channel
one on theK2000R:

Patch Thru



Auto Channelizing with
Multi-record turned on

Every time you change the record-enable track. Patch Thru repatches
your controller instrument to echo out to the specified device for that
track. Thus you always hear your incoming data as it would be
played back.

If the record-enabled track is assigned to several playback devices at
the same time, all of the devices will receive the patched thru data.

If MultiRecord is on, only MIDI data received on the specified
recording Device for a track will be echoed to the corresponding
playback channels for that track. In the following example, notes
played on the Korg 01/W will be heard on the K2000R, channel 5.
Notes played from the DrumKat will be heard on the K2000R channel
10.

.EdiiJSjartdl 1111000 End: 115111000 lh 12r-f’/E LOOP LEV |F;EC/SOUP.CE CH |PLAY DEVICE TRACK NAME

- r~lst. _____ I - Conductor I__ J_
- i—J- 1^ K2000R-1 Funk bass ____ I
- ______ I - Proteus/2-1 - Chords 2 I____ f

r~|>oi/w i| K2000R-5 - Strings r~ i ■
r—J .. _ i ' K2000R-9 Brass r~~

-
_____

1 | > DrumKat 101 > K2000R-10 - Drurns i
.21

_____

1ZZI-___________ L<J T6100-4 Lush pjd _ L i

In the above example, the two controller instruments will be
rechannelized separately. If two different tracks had the same input
recording channel and had a common output channel, the incoming
data will be echoed twice to that output channel. This may cause
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problems with some synthesizers; caution is advised. Note that when
in MultiRecord mode, the recording channel specified in the Input
Filter will be ignored.

Since Patch Thru works even when you're not recording, you can use
Performer as a sophisticated MIDI merger, mapper, or rechannelizer
when in playback or when stopped (as well as during recording).
Patch Thru allows you to route MIDI information from your controller
instrument to any combination of synthesizer modules. By adding a
group of tracks, each assigned to a different MIDI channel or set of
channels, you can change the module configuration used for
playback by simply clicking on the record-enable button for the track
or tracks with the desired channel configuration. This allows you to
experiment with channelization freely.

Auto Channelizing in a
Song

If a song is play-enabled in the Chunks window instead of a
sequence, the following two conditions are necessary for Auto
Channelizing to occur: Da sequence within the song must be record-
enabled, and 2) a track within that sequence must also be record-
enabled. If both are true, then Patch Thru will operate in the same
manner as described above. For information about record-enabling
sequences in a song, please refer to the Chunks Window chapter.

Auto Channelizing and
the Input Filter

The Input Filter affects incoming data in Patch Thru mode. All data
selected to be filtered out will not be echoed to the outputs. For
example, if the pitch bend box is not checked in the Input Filter
dialog box, pitch bend information will not be echoed through in
Patch Thru.

Be Careful If you use Patch Thru with a drum machine or any device that
outputs timing information, the timing information will not be echoed
through. To echo timing information, see the chapter called Transmit
Sync chapter.

Using Patch Thru will cause a small delay (up to three milliseconds)
since Performer must read all incoming data before sending it out
again.

Some MIDI interfaces, such as the MIDI Time Piece II, have a patch
thru option built into them. The MIDI delay factor will be smaller
when using this option since it is closer to the MIDI signals. If you
choose to use the echo feature, turn off Patch Thru on Performer or
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incoming data will be echoed twice. If yon choose to use Patch Thru
■ in Performer, turn off the echo feature on the interface for the same

reason.
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Chapter 9 Recording

Real-time
Recording

Performer records very much like a multi-track tape deck: you make
the right connections, specify the tracks onto which to record and
push the record button. Performer, however, has a great deal more
flexibility than a tape deck. There are many options you can use
while recording that affect which types of data are recorded and the
time span in which recording takes place.

Recording is the main method by which MIDI data is input into the
sequence. There are two types of recording: real-time recording and
step recording. This chapter describes the basics of both methods and
discusses real-time recording; the next chapter describes step
recording in detail.

Real-time recording has two modes: standard and MultiRecord. In
standard mode you can record on one track at a time. Data incoming
on all channels (or the one you specify) is sent to this track.
MultiRecord mode allows you to record on several tracks simulta­
neously, each receiving data from a different incoming MIDI channel.

Before recording in either mode, you should do the following things:

1. Make sure your MIDI instruments are connected and configured
the way you want them.

Set the correct patches on your controller and playback
instruments.

2. (Optional) Check to make sure that Patch Thru is turned on so that
you’ll record the track with the same sound as it will play back with.

Patch Thru echoes incoming data to any device you choose in
your MIDI studio. This is essential when using a separate MIDI
controller instrument: it allows you to hear what you are playing
while it is being recorded. Patch Thru is also useful to check
whether your instruments are working and connected correctly.
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3. (Optional) Set the Input Filter if needed.

If you wish to filter out some MIDI data when recording or record
only from one specific channel, use the Input Filter from the
Basics menu. The Input Filter defaults to notes, velocities, pitch
bend, patch and song changes, and controller data checked.

4. If you have more than one sequence or song in the file, make sure
it is the currently play-enabled chunk.

To do so, look at the current chunk indicator in the main control
panel. If you need to switch sequences, use the Skip buttons.

100:00:00:00

i | Chunk :Seq-1

, tRH-l! J'C4! d>
j ITKK-Z

■

Current sequence or song

If the sequence is inside a song, open the song's window by
double-clicking on the song, highlight the sequence, and choose
Set Record Sequence from the Song window mini-menu.

5. (Optional) Choose the starting meter or set up a meter map.

A meter map is the layout of meters for the entire sequence. If you
have a number of meter changes in your sequence, it is a good
idea to set these up beforehand; it will make recording much
smoother and more musical. A meter map can be made with the
Change Meter command on the Change menu. Consult the
Change Meter chapter for more on this command.

6. (Optional) Set the tempo with the metronome in the main control
panel.

To set the tempo manually, choose Tempo Sliderftom the Tempo
Control pop-up menu and drag the tempo slider to the desired
tempo. Using the tempo slider is handy for quickly setting a
straight tempo. A tempo map is the layout of all tempo changes
for the entire sequence. If you have a number of tempos in your
sequence, especially ones that change over time (such as an
accelerando), you may prefer to set these up before actually 
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recording any MIDI data. A tempo map can be made with the
Change Tempo command on the Change menu. Consult the
Change Tempo chapter for more on this command. Tap Tempo is
a way to tap the tempo manually while you record, such as with
a foot pedal. For more information, please refer to the Tap Tempo
section in the chapter called Receive Sync.

7. Record-enable the track(s) you wish to record on.

To do this, open the Tracks window of the sequence you are
recording into by double-clicking its name. In the Tracks window,
click the Record-Enable button next to the track. If the button is
red (or black on a black and white screen), the track is record-
enabled. In standard record mode, only one track can be record-
enabled. In MultiRecord mode, several may be record-enabled
(more on this below).

8. Select the playback device(s) for the track being recorded.

See “Choosing a device for playback” on page 111 for details.

9. Select a location at which to begin recording.

If you are recording into a new sequence, you'll probably want to
start at the beginning of the sequence. To do so, click the Rewind
button. To start at a specific location other than the beginning,
type in the location in the Counter window.

10.(Optional) Select the Wait and Countoff features if desired.

The Wait feature holds recording until you hit a key on your MIDI
keyboard or the Macintosh keyboard. Countoff gives you a
number of measures of countoff in the starting tempo before
recording begins. Wait and Countoff can be activated in the
Consolidated Controls window. See the Consolidated Controls
Panel chapter for specific details.

11. To begin recording, press the Record button in the main transport
controls.

The Record button will turn solid black, signalling that Performer
is recording in real-time. You can also trigger recording by
pressing the 3 key on the Macintosh keypad or, if you have
already set up a MIDI remote control, by sending a MIDI event 
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Cycle-recording

from your controller. For more information about setting up MIDI
remote controls, please refer to the chapter called The Remote
Controls Window.

12.To stop recording, press the Stop button.

Or, press the zero key on the Macintosh keypad. Stop can also be
mapped to a MIDI remote control. To hold recording, you can
press the Wait or Pause button.

The above steps are used for standard recording mode. MultiRecord
mode requires a few additional steps.

Several of Performer’s features can be combined to provide
comprehensive cycle-recording, complete with spot-erase and
erasing the last pass. To get basic cycle-recording going:

1. Click the Memory-cycle and Overdub record buttons in the
Consolidated Controls panel.

The memory-cycle button causes Performer to loop a section
indefinitely. Overdub prevents each new pass from erasing the
last one.

Memory-cycle Overdub

2. Set the start and end times of the region you want to loop in the
Memory bar.

For a two bar loop, make the stop time 3111000. For a four bar
loop, make the stop time 5111000. Stop time is always the
downbeat of the measure after the last one in the loop. You can
set the loop points graphically by dragging the loop repeat
barlines in the Tracks overview as shown below.
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Loop points (can be dragged)

MIDI data appears
immediately during
recording

Erasing the last pass
and spot-erasing

3. Check Auto Scroll in the Basics menu to make sure that the cursor
option is checked for the Tracks Overview.

This option provides a scrolling “wiper” to show you where
playback is during looping.

4. Set the tempo in the tempo slider.

5. If needed, make sure that the Click is enabled in the Basics menu.

6. Cue Performer to the beginning of the loop region.

7. Click the record button in the main transport controls and begin
recording.

In Performer, recorded data appears immediately as you record it,
before you press the Stop button. This allows you to edit the data
(erase, transpose, quantize, etc.) without stopping cycle-recording.

You can easily accomplish common cycle-recording tasks such as
erasing the last pass and spot-erasing by opening an event editing
window while cycle-recording. As you record, notes appear in the
window right away, so you can do whatever you want to them
without having to press the stop button. You can even insert notes by
hand in the looped region, as well as continuous controllers such as
volume controllers.

To quickly erase the last pass while recording a drum track, open the
Graphic Editing window and double-click the key on the pitch ruler
that corresponds to the note you just recorded. Doing so selects all
the notes of that pitch in the track. Then hit the delete key.

To spot-erase graphically, click the note and hit delete.
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Spot-erasing from your
MIDI controller

Changing the MIDI
channel or patch on the
fiy

A set of cycle-record remote controls, including a a spot-erase
function, is included in the Remote Controls window. These controls
help further provide drum-machine style loop recording by providing
the ability to spot erase from your MIDI controller while cycle­
recording. See “Spot-erase" on page 105 for more information.

While you are cycle-recording, you can change the device, MIDI
channel, or current default patch on the fly while recording as
follows:

Next/Prevous item

Device

MIDI channel

Default patch (sound)

Key to press

Shift up-arrow
Shift down-arrow

Option up-arrow
Option down-aiTow

Command up-arrow
Command down-arrow

Creating a permanent
loop

MultiRecord
Mode

You can also map these remote controls to MIDI keys on your MIDI
controller, so that you can do everything from your MIDI controller
during recording. See chapter 6, “The Remote Controls Window" for
details.

Once you are satisfied with the loop, you can make.it permanent by
inserting a loop into one or more tracks. To insert a loop over all the
tracks, double-click one of the two repeat barline loop points in the
Tracks Overview to select the loop region and choose Set Loop from
the Change menu. To insert a loop over only one track, select the
appropriate track segments in the Tracks Overview before choosing
Set Loop.

MultiRecord mode is used to record from several devices simulta­
neously; each channel may be recorded on a separate track. This is
very useful in transferring data from another sequencer or when
recording from several MIDI instruments simultaneously. MultiRecord
is also useful for recording music while slaved to Tap tempo. Refer to
the chapter Receive Sync for more information on Tap tempo
synchronization.
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I In addition to the steps listed in Real-time recording above, you need
to do the following to prepare for recording in MultiRecord mode:

1. Find out what the current transmit channel is on your controller
keyboard(s) or devices.

If you are recording from multiple sources, you may want to set
each instrument or source sequencer track to transmit on a
different channel. This helps avoid accidently merging them.

2. Choose MultiRecord from the Tracks window mini-menu to check
the menu item.

The Rec/Source column appears.

3. Record-Enable the tracks that you wish to record on.

Click on the Record-Enable button next to the track.

4. Select the input device and channel for each track from the pop-up
menus provided in the Rec/Source column.
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Step Recording

The Input Filter

5. Get ready to record.

If you are sending data from another sequencer or a time-based MIDI
device, you will probably want Performer to synchronize with it. To
put Performer in External Sync mode, see the Receive Sync chapter.
Also refer to the Receive Sync chapter for information on recording
while slaved to Tap tempo sync.

In step recording, MIDI note events are input one at a time, not in
real-time. Step recording is done with the Step Record command on
the Basics menu. Step recording is very useful for entering music
which is too fast or complex to play accurately in real time. It is also
useful when entering a score to be converted to music notation
programs. For details about step recording, see the Step Record
chapter.

The Input Filter allows you to specify what types of MIDI information
are recorded.

To use the Input Filter:

1. Choose Set Input Filter from the Basics menu.

A dialog box appears.
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Specifying Controller
Numbers in the Input
Filter

2. Choose the types of data to be input by clicking on the
corresponding check box(es).

You can choose multiple types of data. You can choose all types
of data at once by clicking on the Set All button. You can uncheck
all the check boxes by clicking on the Clear button. Use Option­
click to check only the check box you click on, unchecking all
others; use Command-click to check all boxes except the one you
click on.

3. Press OK to confirm your choice or Cancel to cancel it.

<•* Caution! The types of data you select will stay in effect
until you change the filter setting. The Input Filter
setting will affect all data recorded. Be especially
careful when muting types of data that you normally
don’t filter. If you don’t remember to turn them back
on afterwards, you may loose valuable data in the
future during recording.

The buttons under the Controllers check box in the Input Filter allow
you to quickly choose which controller data to record. Click in the
Controllers check box, click on the type of option you wish, and then
enter the controller numbers if necessary.

All: Information from all controllers will be recorded.

All except: Information from all controllers except the controller
numbers you enter will be recorded.

Only: Only information from the controller numbers you enter will be
recorded.

To enter controller numbers for the All except and Only options, click
in the text boxes next to the option and type in the numbers. You can
use the Tab key to move between boxes in the same option.
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Auto-Record

Recording in
External Sync

Recording while still­
framed

Auto-Record automatically turns on and off the record function at
locations you specify. This allows you to record without having to
manually click the Record button on and off.

In audio recording, this process in called "punching in” and
“punching out”. A recording engineer is relied upon to listen for
musical cues or watch for tape counter numbers to know exactly
when to enable and disable recording. Performer allows you to pre­
program these actions.

Typically, Auto-Record is used to re-record, overdub or "drop in” a
part to an existing sequence. Recording is automatically enabled at
the designated “Punch In” location, and disabled at the “Punch Out”
location. You can play along with the sequence up until punch in
without recording. Likewise, anything you play after the punch out
location will not be recorded. This feature is useful for correcting
notes or passages without affecting the surrounding MIDI data. Auto­
Record can also be used in combination with Tap tempo synchroni­
zation, to “punch-in” a discrete passage of tempo information on the
Conductor Track.

To use Auto-Record, see “The Auto-Record button” on page 76
detailed information about how to use Auto-record. Consult the
Receive Sync chapter for information on the use of Auto-Record while
slaved to Tap tempo sync.

When recording in external sync other than Tap tempo, the Record
button is turned off every time the master device stops or rewinds.
This is a safety precaution, to prevent accidental erasure of previously
recorded data. To record in external sync, start the master device,
wait for Performer to lock up, and then press the record button. Refer
to the Receive Sync chapter for details on recording while slaved to
each type of external sync.

If you are slaving to video with a VITC converter such as Mark of the
Unicorn’s Video Time Piece, Performer allows you to remain in
record mode while the video parked on a SMPTE frame. To do so,
check the Record while still framed option in the Receive Sync dialog
box in the Basics menu.
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Input Quantize Performer’s Input Quantize feature quantizes notes during recording
in the same fashion as a standard drum machine. Notes get quantized
immediately as they are being received and appear quantized in the
track afterwards. If you are loop recording, the notes will play back
quantized the next time through the loop.

For more information, please refer to the Input Quantize section in
the Region Commands 1 chapter.
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Chapter 10 Step Record

Quick Reference

Step Record, available in the Basics menu, is an alternative to real­
time recording: it waits for you to enter notes one at a time and
allows you to specify the duration of each. With it, you can enter
passages too complex for real-time entry'. Whatever you enter in Step
Record will be rhythmically accurate (it won’t need quantizing). This
is particularly useful for entering music for conversion to music
notation by' Mosaic or other music notation software.

Tick box

Tuplet boxStep-record

Mini-menu

Motion
‘ buttons

Step Duration

Buttons
Speaker click Main transport

button lock button

Current record­

track

duration

Current step

Dot and double-c

duration buttons

The Current record track is selected from this pop-up menu and
displayed for reference. This is the track that is being recorded into.

The Step Duration buttons allow you to set the duration for the step.

The Dot and Double Dot buttons extend the duration chosen with the
step duration boxes by one half or three quarters of the selected
value, respectively.
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The Tick box displays the duration in ticks for the step. You can enter
the duration for the step directly by clicking in this box and typing in
the number of ticks.

The 'hiplet duration box allows you to enter any kind of tuplet: triplets.
quintuplets, etc.

The Backstop button erases the previous step.

The Step button records the current step with the chosen duration.

The Beat button records the current step and advances you to the next
beat.

The Measure button records the current step and advances you to the
next measure.

Checking the Auto Step check box causes the current step to be
recorded each time a key is let up on the MIDI controller.

Checking the Speaker click button causes a click to sound when a step
is recorded.

The Transport lock button connects or disconnects the Step Record
window to or from the main transport controls and counter. When
connected, Performer plays all tracks as you step, and the main
Counter follows the current step. When disconnected, the Step
Record window steps independently of the main Counter. While
disconnected, you can step record while Performer is playing back.

The Duration box sets the duration of the notes being entered, where
100% is the length of the current step.

The Offset box shifts the attack time of the note being entered earlier
or later than the current step.

The Solo Playback check box option solos the track being step-
recorded into. When unchecked, all play-enabled tracks will play as
you step.

Step Record Mini-menu Note Durations: lets you assign a MIDI controller such as a modulation
wheel to control note durations as you enter them.

140 Step Record



Note Offset: Lets you assign a MIDI controller such as a pitch bend
wheel to control the note offset as you enter notes.

Clear MID! Events: Clears any events that are currently shown in the
step bar.

Basics Step Record is primarily used to enter notes and rests. For information
about how to step record controllers, pitch bend, and patch changes,
see “Step Recording Controllers, Patch Changes, or Pitch Bend” on
page 153 in this chapter.

Step Recording Notes
and Rests

A step consists of a particular duration (an eighth note, for example).
In addition, a step can contain one or more notes that are being held
over from previous steps. All notes in a step last for the complete
duration of that step.

A step recorded passage contains a series of adjacent steps. Each step
has a duration specified by the user. A step can contain:

□ nothing: i.e. a rest

□ struck notes: Notes with attacks at the beginning of the
step. Unless held into the next step, these will be released
at the end of the step.

0 held notes: Notes with attacks in a previous step. Unless
held into the next step, these will be released at the end of
the current step.

In Step Record, the time at the beginning of a step is represented in
measure time. In 4/4 time, a quarter note beginning at 1121000 will
last for 480 ticks, ending just before 1131000. If a second quarter note
directly follows the first, it will begin on 1131000. Two eighth notes
following just after will begin on 1141000 and 1141240, respectively.

A rest is a step containing no notes. It is an “empty" duration.
Although rests are registered in the Step Record window, they do not
appear in the Event Editing windows: they are the spaces between
note events.

Velocity information is recorded in Step Record unless specifically
disabled by the Input Filter available from the Basics menu.
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Getting Ready Before selecting Step Record, you should do the following:

1. Select a sequence to record into.

Play-enable the sequence in the Chunks window. If the sequence
is inside a song, open the song’s window by double-clicking on
the song, highlight the sequence, and choose Set Record Sequence
from the Song window mini-menu.

2. Select the track you wish to record on just as you would for real­
time recording.

To do this, open the Tracks window of the sequence you are
recording into by double-clicking its name. In the Tracks window,
click the Record-enable button next to the track. When the button
is highlighted (solid black), the track is record-enabled. In
MultiRecord mode, the first record-enabled track in the track list
will receive incoming data. You cannot step-record into the
Conductor Track.

3. (Optional) Open the Event List, Graphic Editing, or QuickScribe
notation window for the track on which you are recording.

You can open all three, if you like. We highly recommend doing
so because it allows you to see what you are step recording as you
go-

4. If you are using the Graphic Editing or QuickScribe notation
windows, choose Auto Scroll from the Basics menu.

Select the appropriate option. We also recommend that you
choose the cursor option, which produces a scrolling cursor in the
window, which clearly indicates the current step location.

5. Set the Counter to the time you wish to start recording.

If you want to start at the beginning of the sequence, set the
Counter to 1111000.

6. If you don’t want to erase pre-existing music on the track and want
to merge new material with old, click the Overdub record mode
button located just below the main transport controls.

If there are meter changes in the passage you are about to record,
create them with the Change Meter command.
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7. If you want to include key signatures in the passage you are about
to record, create them with the Change Key command.

Note that key signatures do not affect the actual data: they only
affect the display in the Event List window and while step
recording.

8. Select Step Record from the Basics menu.

The Step Record window appears.

The current step indicator in the Step Record window displays the
starting location for the first step; this is automatically set to the
current Counter location.

When you are finished setting up, you will see the Step Record
window, along with one or more of the event editing windows for
the track. The notes that you step record will appear in the event
editing windows as you proceed with step recording.
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Figure 10-1: The Step Record window, along with the Event List, Graphic Editing,
and QuickScribe notation windows for the track being step recorded into. Notice
that since Auto Scroll has been enabled in the Basics menu, the windows are
scrolling as notes are entered. Also notice that the Graphic and QuickScribe
notation windows have the scrolling cursor to indicate the current step location.

_£

A
Track-1

Setting Step Durations The duration buttons are used to set step durations. Clicking on a
duration button will highlight it and assign that duration to the step.
Durations remain set until changed, allowing you to enter a stream of
notes with the same duration very quickly.
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Setting Dotted Durations

Entering a Tuplet
Duration

To select more than one duration box at once, hold down the shift
key while clicking on the desired duration box(es). When more than
one box is selected, the step duration is equal to the sum of the
selected values.

You can also select durations using the Macintosh extended keypad.
To do so, press the caps lock key to toggle the keypad from its
standard transport functions to the step-record note-duration
functions. (You can customize how this is done in the Remote
Controls window if you like.) Press one of the number keys to select
a duration. It remains selected until you deselect it. To deselect it,
press it again.

The dot and double dot boxes can be used to modify the selected
step duration. If the dot box is selected, it signifies a dotted step
duration, i.e. one and one half the value of the highlighted
duration(s). If an eighth note and dot are selected, the step duration
will be a dotted eighth note, i.e. a metrical value of an eighth plus a
sixteenth. If the double-dot box is selected, it signifies a double­
dotted step duration, i.e. one and three quarters the value of the
highlighted durations. If a quarter note and double dot are selected,
the step duration will be a double-dotted quarter note, i.e. a metrical
value of a quarter plus an eighth plus a sixteenth. Only one of the dot
boxes may be active at a time.

The tuplet box can be used to set the step duration to a tuplet value,
allowing you to enter triplets, quintuplets, septuplets, etc. These
values are expressed in the standard way, xin the time of y durations.
The tuplet box, when active, actually modifies the duration you
choose in the duration boxes (including the dot and double dot
modifiers). For example, an eighth note duration is equivalent to 240
ticks. If the tuplet box is set to “3 in the time of 2”, step duration
(displayed in the tick box) becomes 160 ticks, one third of a quarter
note.

To set the tuplet value:

1. Click on the Tuplet check box next to the word “Tuplet”.

2. Enter the number of tuplet notes to be entered in the first box.

3. This is the box to the left of the words “in the time of”.
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Specifying an Exact
Number of Ticks for a
Step

Choosing a Note
Duration

Generating Random
Note Durations within a
Range

4. Enter the number of regular notes the tuplet replaces in the second
box.

Eighth note triplets, for example, are three equal duration notes in the
time of two eighth notes. Quintuplet sixteenth notes are five equal
notes in the time of four sixteenth notes.

The tuplet box is active when the check box next to the word
“Tuplet” is highlighted: make sure to deselect it when you have
finished entering the tuplet values. You may enter any number of
notes in the space of any other number. Performer does all the
necessary calculations for the proper durations; you needn’t worry
about the exact number of ticks a single tuplet duration will require.

Performer computes the number of ticks for each duration
automatically when you click on the boxes. You can directly specify
the exact number of ticks for a step by clicking on the tick box. The
equals sign will disappear and all duration boxes will be deselected
to indicate that you are entering the number of ticks directly. At this
time, you can type in a new duration value. Click on any duration
box to return to specifying durations as note values.

Normally, the duration of the note being step-entered is 100%, which
makes it exactly as long as the step itself. For example, if the step was
a quarter note, the note would be 480 ticks long.

Often, however, you might want to choose a different duration than
the length of the step. For example, you might want to enter staccato
quarter notes: the step duration is 480 ticks, but the duration of the
notes should be much shorter—say around 60 ticks.

To set a duration that is longer or shorter than the current step
duration, type in a percentage below or above 100%.

The duration can be controlled on the fly using a pitch bend or
modulation wheel. For more information, see the remote control
section at the end of this chapter.

Note durations can be generated randomly within a range. To do so:

1. Choose Note Durations from the Step Record mini-menu.
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Setting Default
Step-Record Durations

I 2. In the duration range, enter the lowest and highest percentage that
you would like to use.

100% equals the current step duration, so if you'd like to be able
to enter notes longer than the step duration, make the top value
be above 100%.

3. Check the “Randomize Durations within a range” option.

4. Click OK.

Performer allows you to control the duration of the notes that you are
step-entering independently of the step duration. For example, if you
are entering quarter notes, the step duration is 480 ticks. However, if
you would like the quarter notes to be played in a staccato fashion,
you would probably set the duration to approximately 120 ticks or
some other value less than 480 ticks.

One way to control the duration is with the duration option described
in the section called “Choosing a Note Duration” on page 146.

Often, however, you might like to select a different duration for each
type of note (quarter note, half note, whole note, sixteenth, etc.). For
example, you might want quarter notes to be 80% of their step
duration, half notes to be 100%, and sixteenth notes to be 65%, where
each duration has an independent duration.

You can set up default durations for each note duration as follows:

1. Double-click the duration button that you would like to set.

A dialog box appears in which you can set the default duration for
that note.
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Choosing a Note Offset

Generating Random
Note Offsets within a
Range

2. Type in the desired duration.

You can either type a percentage or a number of ticks. In either
case, the other text box will update to reflect the value you enter.
For example, if you entered 50% in the box above, the tick value
box would change automatically to 240.

3. Click OK.

4. Repeat this procedure for each desired duration.

Normally, step entered notes are inserted exactly at the tick location
of the current step. The offset option allows you shift their entry a
few ticks before or after the current step location. Offset is ideal for
passages in which you’d like to push or lay back the feel.

To place notes a certain number of ticks before the current step
location, type in a negative number of ticks in the offset text box.

To place the notes a certain number of ticks after the current step
location, type in a positive number of ticks.

The offset can be controlled on the fly using a pitch bend or
modulation wheel. For more information, see the remote control
section at the end of this chapter.

Note offsets can be generated randomly within a range. To do so:

1. Choose Note Offsets from the Step Record mini-menu.
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Soloing the Record
Track

Performing Step
Entry

Stepping Automatically

1 2. In the offset range, enter the earliest and latest offset that you
would like to use.

Use a negative number to indicate the earliest offset, such as -15.

3. Check the “Randomize Durations within a range” option.

4. Click OK.

Normally, all play-enabled tracks play along with you as you step
record. However, if you want to mute all other tracks in order to solo
the one being recorded into, click the Solo Playback check box.

After setting the step duration, you are ready to enter notes. When
entering them, you can proceed to each next step automatically (with
the Auto Step option checked) or manually (with the option
unchecked).

Enter one or more enter notes with Auto Step in the following
manner:

1. Hold down one or more notes on your MIDI controller.

2. Release the note(s) to enter the step.

When Auto Step is enabled, a step is automatically recorded when
you release a key on your MIDI input keyboard, just as if you had
pressed the Step button. This makes entry quick and easy.

For example, using Auto Step, you could enter an eighth note scale
without using the step button: just set the duration to an eighth note
and play the scale on your MIDI keyboard.

When using Auto Step, be aware of the following things:

Play staccato-, make sure that the notes for each step are attacked and
released crisply, with clean gaps between the notes. If the release of
a note overlaps with the attack of the next one. you may get two
notes in a step in which only one was intended. Don’t worry' about
the duration. Remember, it is determined by the duration option.

Wronp notes will be recorded automatically. If you hit a wrong note,
you must use the Backstop button to erase it and re-enter the note or
chord. This differs from manual step mode in which you can replay 
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Stepping Manually

Entering Rests

Hearing a Click After
Each Step

*
Listening to What You
Have Recorded

the notes as many times as you like before you click on the Step
button, and only those notes being played at the moment you click
on the button are recorded.

At times, you may wish to choose when to proceed to the next step.
such as when you are holding a note or chord through several steps.
To do so:

1. Hold down one or more notes on your MIDI input keyboard.

2. Click on the Step button.

3. Release the note(s).

This will cause one step to be recorded containing the notes you
played. Clicking on the Step button will record those notes which are
being held down on the controller keyboard. The step will not be
completed until you press the Step button. If you continue to hold the
same notes down and press the Step button again, the notes will be
recorded as “held” since they were not released in the previous step.

You can use the space bar on the Macintosh keyboard instead of
pressing the Step button.

If you play a wrong note, simply play the correct one before pressing
the Step button.

Rests are entered by pressing the step, beat, or measure buttons with
no notes held down. This records a step with no notes for the chosen
duration.

Click the speaker click button to highlight it. When highlighted, it
causes a click to sound every time a step is entered. This is highly
recommended when using Auto Step, as it is a useful indicator of step
completions. The volume of this click can be adjusted with the
Speaker Volume feature on the Control Panel desk accessory; any
adjustment to the click volume must be made from the Finder.

When you are finished step recording, and you’d like to hear what
you have done, press Rewind, or cue to the desired start measure.
Then press Play.
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Disconnecting the
Counter From Step
Record

--------------*■ ’'ia

A * 'fa'

Connecting the Main
Counter to Step Record

Changing the Current
Step Location

Notice that when yon rewind and play back, or do just about
anything else besides step-recording, the Transport Lock button in
the title bar of the Step Record window unhighlights. (You can also
unhighlight it by clicking it.) This indicates that the main Counter in
the Controls Window is no longer locked to the current step location
in the Step Record window.

In this mode, the Step Record window acts entirely independently of
Performer’s main transports (play, stop, rewind, etc.), as well as the
main Counter. Thus, you can play, rewind, fast forward, stop, and
otherwise cue around in the sequence completely independently of
where you are step recording.

In this mode, other tracks do not play along with the track that you
are step recording into. To get them to play along, click the Transport
Lock button again to highlight it. Doing so locks the transports to Step
Record.

If, as you Step Record, you would like other tracks to step along with
you, highlight the Transport Lock button before you begin. Doing so
causes Performer’s main Counter to follow the current step indicator
in the Step Record window. All play-enabled tracks will play as you
step through the sequence.

To change the current step location:

1. Click the Current Step location to edit it.

Current Step: E3I240

2. Type in the desired location.

3. Press the return key.
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Displaying Notes as You
Step Enter

Erasing the Last Step
with the Backstep
Button

Stepping to the Next
Beat or Measure

Changing the Current
Record Track

4. If you wish to connect the main Counter to the new Step Record
location, highlight the Transport Lock button.

Doing so causes the main Counter to follow you as you step, and
all play-enabled tracks will play with you as you step.

Notes that you step enter appear in the event editing windows of the
track as you enter them. To view them either during or after entry,
open the Event List, Graphic Editing, and/or QuickScribe notation
window for the track on which you are recording. See Figure 10-1 on
page 144.

Pressing the Backstep button will erase the step you just entered (the
one displayed just above the current step bar). After pressing the
Backstep button, the time in the current step bar will be the exact
starting time of the step erased with the Backstep button.

The Beat and Measure buttons are special step advance buttons. They
compute the duration necessary to get to the next beat or measure:
the step is recorded using that duration and you are advanced to the
next beat or measure for the next step. For example, if the current
step is on 2111212 and the meter is 4/4, when the Beat button is
pressed, a step of 268 ticks will be recorded and the next step will be
entered at 21 21000. If the Measure button is pressed, a step of 21268
(2 quarter notes and 268 ticks) will be entered and the next step will
be entered at 3111000.

To change the current record track, click the “Recording on...” pop­
up menu and select a different track.
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Adding to Existing
Material in a Track

Step Recording
Controllers, Patch
Changes, or Pitch Bend

Step Recording
During Playback

I You can add to existing material in a track as long as you first turn on
■ Overdub record mode with the Overdube record button in below th
; main transport controls. Otherwise, the newly step recorded data will

replace existing data in the track.

To step record a controller event, patch change, or pitch bend event:

1. Play the event.

The event appears in the current step bar.

Current Step: 113|240 " 0

2. Press the Step button or any other motion button to record the
event.

Events, such as patch changes, controllers, and pitch bend do not
trigger auto step. In these cases, play the event and proceed to the
next step by pressing the Step button (or any other motion control
button.)

Step recording can be done during playback. For example, you can
step record notes into a loop and have Performer play back the loop
in real time as you build the loop. This can be ideal for building drum
loops with Step Record.

To Step Record into a loop during playback:

1. Choose Step Record from the Basics menu and unhighlight the
Transport Lock button in the title bar of the Step Record window.

This disconnects the main Counter from Step Record.

2. Set up a loop in a track.

If necessary, you can initially make the loop repeat infinitely while
you are building it and later on change it to the desired number of
repetitions.

3. Choose the track with the loop from the “Recording on” pop-up
menu in the Step Record window.
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Using the Step
Record Remote
Controls

4. Click the Overdub record button located just below the main
transport controls to enable Overdub record mode.

This allows you to step record over the same region in the loop
without erasing existing material in the region.

5. Set up any other Step Record options as desired, such as Solo
Playback and Auto Step.

6. Press the Play button to begin Playback.

As the sequence plays, notice that the Current Step in the Step
Record window remains where you begin.

7. Pop-edit the current step counter to set it to the location where you
want to begin step-recording.

8. Begin Step Recording as desired.

9. When you reach the end of the loop, pop-edit the current step
indicator to step record the next pass through the loop.

As Performer keeps playing, you can repeat this step as many
times as necessary as you build the loop. As you build it, you will
continue to hear it playback.

10. When you are finished, press Stop.

All of the functions in the Step Record window are available as
remote controls in the Remote Controls window. This allows you to
map them to your MIDI controller so that you can perform the entire
step recording process from in front of your MIDI instrument, rather
than in front of your computer screen.
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Controlling Duration
with a MIDI Controller

Important note! Be careful about the other Remote
Controls, such as the Transport controls or the Chunk
Select controls. Be sure that you have either disabled
them (with their group master) or remapped them so
that they do not interfere with the notes that you are
step recording. See the Remote Controls chapter for
information about how to remap and disable groups of
remote controls.

You can set up Step Recording such that a mod wheel or other
continuous controller controls the duration of the notes being
inserted.

To assign a pitch bend wheel, mod wheel, or data slider to the
duration:

1. Choose Note Durations from the Step Record window mini-menu.
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Duration Range: |J____ | to |1OO
tan*

MIDI Remote Control
|A«1 | Range[0____ | to |127 I

□ Use MIDI Remote Control
O Randomize durations vzithin range

2. For duration range, enter the lowest and highest percentage that
you would like to use.

100% equals the current step duration, so if you’d like to be able
to enter notes longer than the step duration, make the top value
be above 100%. The maximum value you can enter is 200%.

3. For the MIDI Remote Control, enter the controller type, and enter a
range of controller values that will be mapped to the duration range
you specified above.

For example, if you specify a duration range of 50% to 150%, and
you specify a controller range of 0 to 100, when you move the
mod wheel (pitch bend wheel, or data slider) to 100, the duration
will be set to 150%. Likewise, if you move the controller to 0, the
duration value will be set to 50%. You can enter any of the above
values by highlighting the text box with the tab key and moving
the controller wheel or slider.

4. To enable MIDI Remote Control, click the MIDI Remote Control
check box.

5. If you wish notes to be assigned a random duration within the
duration range you’ve chosen, click the “Random Duration within
range” check box.

6. Click OK to confirm your choices.

Now you can control the duration with your mod wheel. As you
move the wheel, notice that the duration value changes in the Step
Record window.
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Controlling the Offset
with a MIDI Controller

You can set up Step Recording such that a mod wheel or other
continuous controller controls the offset of the notes being inserted.

To assign a pitch bend wheel, mod wheel, or data slider to the offset:

1. Choose Note Offset from the Step Record window mini-menu.

Offset Range: | — 15 | to 115 | ticks

MIDI Remote Control "* 
|~» | Range[-8192 | to |8191 |

@ Subtract offset from durations
□ Use MIDI Remote Control

2. For the offset range, enter the earliest and latest value over which
you would like to set the offset.

Type a negative tick value in the first text box for the earliest
value; type a positive tick value in the second box for the latest
value.

3. For the MIDI Remote Control, enter the controller type, and enter a
range of controller values that will be mapped to the offset range
you specified above.

For example, if you specify an offset range of -15 to 15, and you
specify a controller range of 0 to 100, when you move the mod
wheel (pitch bend wheel, or data slider) to 100. the offset will be
set to 15. Likewise, if you move the controller to 0. the offset value
will be set to -15. You can enter any of the above values by
highlighting the text box with the tab key and moving the
controller wheel or slider. The minimum is -240 ticks and the
maximum is 240 ticks.

4. If you would like the note’s duration to be maintained, check the
“Subtract offset from durations” option. 
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Using the Macintosh
Keypad

Be Careful

i 5. To enable MIDI Remote Control, click the “Use MIDI Remote
Control” check box.

6. If you wish notes to be assigned a random offset within the range
you’ve chosen, click the “Randomize offset within range” check
box.

7. Click OK to confirm your choices.

In addition, the step record commands are mapped to the Macintosh
keypad as shown below. The caps lock key must be down to use
these key assignments. Pressing the key performs the same actions as
pushing the buttons in the Step Record window, with one exception:
a duration remains selected until you press it again; pressing a
different duration does not deselect currently selected durations. This
allows you to easily specify a composite duration (such as an eighth
and a quarter). To clear all durations, use the Clear Note Grid key. the
Clear key on the keypad.

AutoStep

Measure

Beat

Step

Clear
Note
Grid

Tuplet

.. 1
Ji Ji J
J JI Ji
H 0 J
Backstep

Step recording will record over previously recorded material in the
same time span in the track. Use Overdub record in the Consolidated
Controls Panel if you want to merge your step recorded material with
what is already on the track in that time span.

If you enter notes or backstop quickly, the display might temporarily
be suspended in order to accurately process the events. Don’t worry':
as soon as you slow down or stop entering or backstepping, the
display will catch up.

You may find that velocities recorded in step record are uneven. If
this occurs, you can edit them by selecting the step recorded region
and using the Change Velocity command in the Region menu to set
all velocities to the desired values.
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Hints

Be sure to uncheck the triplet box as soon as you are through with it:
otherwise, subsequent durations will be incorrect.

If you discover that you've left out a note after step recording, use the
Shift command on the Edit menu to remove or add extra space to
avoid having to re-enter the entire passage again.

To enter a chord with staggered releases, use manual stepping.

You can enter chords with more than five notes (one hand’s worth)
by making two or more recording passes, for instance, one for each
hand of a piano part. This can be done by recording on separate
tracks or by using overdub record to merge in the second part.

If there are a number of duration changes in a step record passage, it
may be easier to choose the smallest common duration value and
hold notes through steps to create longer durations. For example, a
half note can be entered by holding an eighth note over four steps. If
the passage you are entering is rhythmically complex, it may be best
to use manual stepping (Auto Step off) in order to keep track of each
step entered.
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Chapter 11 The Counter Window

Setting the Counter
window display

The Counter Window is identical to the main counter in the
Consolidated Controls Panel, except that it is a large, separate
window, and it can display all three time formats at once. For
complete information about using either counter, see "The Counter''
on page 88.

The counter window can display one or more of the three time
formats in any combination. One format is designated as the Main
Counter. It will appear at the top of the window. You can also specify
two “Aux” (auxiliary) Counters which appear below the Main display.
The format is identified by a small icon positioned just to the right of
it in the Counter window:

Counters can continuously display the current location of the
sequence or song or can update the location only after the stop
button is pressed. The former mode requires some microprocessor
overhead; turning off the continuous update option will improve the
program’s responsiveness during recording and playback.
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To set the counter display:

Counter window mini­
menu

1. Choose the Set Display command from the Counter window mini­
menu.

2. Choose the time display for the main counter by pressing the
desired button in the Main Counter column.

3. Choose zero, one, or two other time formats by clicking on the
desired box(es) in the Aux Counter column.

4. Specify which of the displays will be continuously updated by
clicking in the desired box in the Running Update column.

If the Running Update box is not checked, the corresponding time
display will change to dashes while the sequence is playing or
recording.

5. Press the OK button to confirm your choice or the Cancel button to
cancel it.

In addition to the Set Display command mentioned in the previous
section, the Counter window mini-menu has two other commands.

Set Frame Rate
For complete information about setting the SMPTE frame rate, see
“Slaving to SMPTE with MTC, DTL, or DTLe" on page 609.

Set Chunk Start
For complete information about setting the start time of a sequence
or song (chunk), see “Setting the start time” on page 90.
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Chapter 12 The Tracks Window

The Tracks window is one of the most important features in
Performer: it allows you to define and organize the contents of each
sequence in your Performer file. It is also perhaps the most powerful
and flexible window in Performer. The Tracks List portion of the
window allows you to create tracks, assign MIDI channels for
recording and playback, set regions for editing, customize track
names, add comments, and more. The Tracks Overview portion
allows you to view, select, and edit the data in each track.

Quick Reference
Tracks OverviewTracks List

Move Loop MIDI Activity Record­

handle Indicator meters enable

buttons

Playback

devices

Track Current Window Empty Track High-density Time

names patch divider segment track segment zoom

(sound) buttons
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Tracks List: Displays the track names and important information about
each track: the play channel or device assignment, the play and
record buttons, the current patch setting, and comments. Option-click
the track name to pop-edit it.

Tracks Overview: Displays each track in equal-length segments, which
can be zoomed to show as much as 16 measures per segment or as
little as 30 ticks. Each segment displays how much data is present in
that segment. To view the data in a segment, double-click, command-
double-click, or option/command-double-click to open the Event
List, Graphic Editing, or QuickScribe notation window.

Solo Button: Enabling this button by clicking it puts Performer into
Solo mode—the same as using the Solo command in the Tracks
window mini-menu. Highlighted tracks play; unhighlighted tracks are
muted.

Playback device: Each track has a playback device (or a combination of
several devices), which can be selected from a pop-up menu by
clicking in this column next to the track. Devices in the menu are
provided by FreeMIDI.

Edit Bar: Determines the start and end times of the current selection
region in any tracks whose names are currently highlighted. Click the
values to edit them. Click the words “Start” or “End” to load the
current Counter location. Double-click the word “Start" to
automatically load the beginning of the sequence; double-click the
word “End” to automatically load the end. Double-click the word
“Edit” to automatically select the entire length of the sequence.
Single-click the word “Edit” to load remembered times.

Loop Indicator: Shows whether a loop exists in the track.

Time Ruler: Displays the location of each segment in any combination
of Performer’s three time formats: measures I beats I ticks, SMPTE time,
or real time.

Memory-cycle loop points: These repeat barline icons indicate the
points where the entire sequence will loop when the Memory-cycle
button is highlighted.
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Sequence Name: Displays the name of the sequence. A Performer file
can contain any number of sequences, each with their own Tracks
window. Command-click to switch between sequences.

Tune Zoom Buttons: Zooms in the Time Ruler so that each segment
represents a smaller or larger duration. For example, in the Quick
Reference diagram, each segment currently represents one measure
of music. Clicking the Zoom In button will cause each segment to
represent one quarter note (480 ticks). Other zoom-in levels are: 240,
120, 60, and 30 ticks per segment. Other zoom-out levels are: 4, 8,
and 16 measures per segment.

High-Density Track Segment: Indicates that the segment contains more
than 10 MIDI events. Segments can display several degrees of data
density. The threshold between density levels can be adjusted with
the Set Density Threshold mini-menu command.

Empty' Track Segment: Indicates that the segment contains no MIDI
data.

Window Divider: Separates the Tracks list from the Tracks Overview.
Drag the divider left to see more of the Tracks Overview or right to
see more of the Tracks List, comments, etc.

Track Comments: Display remarks that you can type in for the track. To
enter or change a comment, simply click on it and enter or edit the
text. Press OK or the Enter key' to confirm your entry, or press the up
or down arrow keys to confirm your entry' and move to adjacent
tracks, or press Cancel or command-period to cancel it.

Current Patch: Displays the name of the currently selected patch
(sound) for the Device.

Default patch: Displays the name of the patch that will initially be
called up when the sequence starts playing. This is saved with the
file.

Conductor Track: A special track that contains the tempo map, meter
changes, and key signatures for the sequence. The Conductor track
also contains Markers. Data in the Conductor track can be edited just
like MIDI data in regular tracks.
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Tracks Window Mini­
menu

Playback Device: Displays the playback assignment for the track. The
j list of devices matches your MIDI studio. Device names are set up in
I the FreeMIDI Setup software.

Play-Enable button: Enables or disables a track for playback. To toggle
its play status, simply' click the button. Any' number of tracks may be
play-enabled. Most commonly, all tracks will be play-enabled. When
solid black, the track is play-enabled and will be audible. If hollow,
the track will be muted or silent. If muted, the data for the track is still
there; you are just "turning off the track during playback.

Record-Enable button: Selects a track for recording. In normal
recording mode (MultiRecord off), only one track may' be recorded
into at once; when you record-enable a track, the previous record-
enabled track will be automatically disabled. Record-Enable buttons
are only' present if the sequence is selected for playback in the
Chunks window or it is record-enabled in a Song window.

Move Handle: Drag up or down to change the position of a track in the
tracks list.

MIDI Activity Meters: Indicate the intensity' of MIDI playback coming
from the track. They monitor either note-on velocities or amount of
data. When monitoring amount of data, level meters monitor any' type
of data.

Add: Adds a track to the track list. There is no limit to the number of
tracks you can add. Hold down the option key' while choosing Add
to add more than one track at a time. New tracks are added to the
bottom of the list or just below the currently highlighted track name.

Duplicate track layout: Selecting a track or multiple tracks and choosing
this command duplicates the selected tracks and their playback
assignments. The word copy is appended to each new tracks name.
This command does not copy7 the data in the track; instead, it copies
only the track’s name and playback assignment. Use the option key'
while selecting the command to make more than one duplicate copy.

Solo: Enables Solo mode. In Solo mode, only tracks whose names are
highlighted will play. To disable Solo mode, choose Solo again to
uncheck it.
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H____________
Add
Duplicate Track Layout
Solo
Solo Setup-
Level Meter Setup...
Columns Setup...
Edit
MultiRecord

Set View Filter...
Set Density Threshold...
Set Rulers...

Goto Counter
Goto...

Create Chunk...
Create Console...
Clear Default Patch

Delete

Solo Setup: Calls up a dialog box that lets you configure solo mode.
Solo mode can be configured so that muted tracks are not muted all
the way. Instead, their volume is brought down part way by reducing
their note-on velocities by a percentage that you choose.

Level Meter Setup: Provides several different ways to configure the
level meters. See “Configuring the MIDI level meters" on page 193.

Columns setup: Lets you choose which columns to show and hide in
the Tracks list.

Edit: Opens the Event List for the currently highlighted tracks.

MultiRecord: Enables MultiRecord mode. In MultiRecord, more than
one track can be record enabled at a time with a separate record
channel for each one. To disable MultiRecord mode, choose the
MultiRecord menu item to uncheck it.

Set View Filter: Calls up a dialog box in which you specify types of
events to be visible in the Tracks Ovendew window. The View Filter
applies to all tracks and the Event List, Graphic Editing, and
QuickScribe notation windows.

Set Density Threshold: Calls up a dialog box in which you specify the
difference between low-density and high-density track segments. The
default value is 10 MIDI events. You can set the threshold to any
value between 1 and 999.

Set Rulers: Allows you to configure the Time Ruler in any combination
of Performer’s three time formats: measures I beats I ticks, SMPTE time,
or real time. The main ruler is displayed lowest.

Goto Counter: Scrolls the graphic display to the time currently
displayed in the Counter. The counter location will appear at the left­
most position in the window.

Goto: Scrolls the graphic display to a time you specify, which will
appear at the left-most position in the window.

Create Chunk: Creates a sequence chunk made up of the currently
selected segments and places it at the end of the list in the Chunks
window. In the new sequence, the earliest selected segment will be
placed at measure one.
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Tracks Window
Basics

Opening a New Tracks
Window

Create Console: Creates a Slider console for the currently selected
tracks. A dialog box will appear asking what type of console, e.g.
volume, pan, etc.

Clear default patch: Removes the default patch assignment in the
Default patch column for the currently selected tracks.

Delete: Removes the currently selected tracks from the Tracks
window.

A track in Performer stores a series of MIDI events within a sequence.
Each sequence contains its own set of tracks. Performer allows you
create as many tracks as you like, each holding a separate stream of
MIDI events. The only limitation to the number of tracks is the
amount of random access memory in your computer. (We've seen
some sequences with over 300 tracks!)

The Conductor Track is the exception; it stores meter, key, tempo,
and marker information. For more information, see the chapter The
Conductor Track.

In Performer, MIDI data is stored in the track without channel
information. Instead, each track in Performer can be assigned to one
or more MIDI channels. During playback, or while recording using
the auto-channelize Patch Thru feature, the MIDI data in the track is
sent out through the assigned channels. Any MIDI instrument that is
listening to (receiving on) that same channel will respond to the MIDI
information it receives.

In summary, each sequence in a file has its own Tracks window,
which lists all of the tracks in the sequence. Each track has a MIDI
channel assignment consisting of one or more channels. The data in
the track is played on whatever the playback channels the track is
assigned to.

When you select New from the File menu, a new file containing a
single sequence is created. (See the Working with Files and Chunks
Window chapters for more information.) The Tracks window for this
new sequence is already open by default.
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If you wish lo add another sequence and display its track window:

1. Open the Chunks window by choosing Chunks from the Windows
menu.

The Chunks window appears:

2. Choose Add Sequence from the Chunks window mini-menu.

fT. Chunks
TUFE Add Sequence I NAME j COMMENTS

Add Song L\ J Seqr!____ |

Duplicate Track Layout
Open Chunks
Auto/manual End Time
Set Chunk Start...

Delete

A new sequence appears in the Chunks list.

3. Double-click the name of the new sequence.

A new Tracks window will appear for that sequence. The name of
the sequence will appear in the title bar of the window.

To open a new file with a new, empty sequence:

1. If a file is open, close it by choosing Close from the File menu.

2. Choose New from the File menu.

A new file opens with one sequence and a Tracks window for that
sequence.

The Tracks Window 169



The Tracks List
& Overview

The Tracks window is divided into two portions: the Tracks List on
the left and the Tracks Overview on the right. This section discusses
the Tracks List. The Tracks Overview is discussed later in the chapter.

Tracks List Tracks Overview

I
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Tracks List Quick
Reference

The Tracks List provides a list of all the tracks in the sequence. In
addition, it provides useful information about each track, such as
what MIDI devices the track is playing on. This information is shown
in the same row as the track.

Record enable Edit Bar

button

Loop indicator

Move

handle

Play-enable

buttons

Playback

device

Conductor

Track

Track

Comments

Record

device and
channel (only

appears when
Multi-record is

enabled)

Window divider -

(Dragged all the way

to the right to cover

up the Tracks

overview)

Default Patch

(The sound

the track starts

with)

Tracks List Current patch

(sound)
MIDI Activity

meters

Hiding Columns in the
Tracks List

Even though The Tracks List has a lot of columns of information in it,
you can completely customize the display to suit your tastes. You can
hide columns you don’t need to look at, and you can rearrange the
order of the columns. For example, if you don’t have any comments,
you don’t need to display the column.

To hide or show columns in the Tracks List:

1. Choose Columns Setup from the Tracks window mini-menu.

As a shortcut, you can double-click any column heading instead.
The column Setup window appears.
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2. Uncheck the columns you want to hide, and check the ones you
want to see.

3. Click OK.

Rearranging the order of
the columns

You can rearrange the order of the columns simply by dragging the
title of the column left or right.

&£ £1 & fS":
_________________ ________......... i'

Edit| Start111111000 End]15| 11000
MUE|LOOP| LEV |RECIFLftV DEUI-EE | TRUCK NAME | PftTC

___ \^\ | Conductor|
!> K2000R-1 j Funk B-

.11—1

The Move Handle

See "Customizing the Tracks Window" on page 192 for an example of
a more compact, customized Tracks List.

The Move Handle allows you to shift the position of a track in the
tracks list. Use it to rearrange the tracks in an order that is most useful
to you. To use the Move Handle, press on it and drag the track where
you want it to go. A dotted outline of the track will follow your
mouse movements. The track will be moved to the position in the
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The Loop Indicator

MIDI Activity Meters

The Record-Enable
Button

The Record Device

I tracks list where yon release the mouse. If you drag the track above
I the top or below the bottom of the Tracks List, it will scroll until it
i reaches the top or bottom of the list.

This column displays a loop icon if the track contains one or more
loops.

The MIDI Activity Meters act very much like the level meters on a
tape deck: when there is signal on the channel, the level meter
registers the signal. Similarly, at the moment the track is playing MIDI
data, the MIDI activity meter registers the outgoing MIDI data.

You can configure how the level meters operate. For details, see
"Configuring the MIDI level meters" on page 193.

The Record-Enable button selects a track for recording. In normal
recording mode (MultiRecord off), only one track may be recorded
into at once; when you record-enable a track, the previous record-
enabled track will be automatically disabled. Record-Enable buttons
are only present if the sequence is selected for playback in the
Chunks window or it is record-enabled in a Song window.

The Conductor Track has a record-enable button, which is used to
record tempo information while slaved to Tap tempo synchroni­
zation. See the chapter Receive Sync and Tap Tempo While Slaved to
Tape for details on using Tap tempo to record a tempo map in real
time.

Normally, the record-enabled track will record data from all channels.
In MultiRecord mode (set in the Tracks window mini-menu), you can
record from individual MIDI device on a particular MIDI channel into
a particular track. This lets you record into several independent tracks
from several independent sources all at once. Each track has its own
incoming MIDI device and channel number displayed next to its
Record-Enable button. Recording channel assignments are only
present in MultiRecord mode. See the Recording section for details
about using MultiRecord.
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The Play-Enable Button

The Playback Device(s)

The Track Name

The Recording Channels display consists of a device name followed
by a channel number. Click them to change them. If the record device
is blank, click in the blank space next to the record button to open a
pop-up menu of devices. You can select only one device and channel
for each track.

The Play-Enable button readies a track for playback. To toggle its
play status, simply click the button. Any number of tracks may be
play-enabled. Most commonly, all tracks will be play-enabled. When
blue (or solid black on a black and white screen), the track is play-
enabled and will be audible. If gray (or hollow on a black and white
screen), the track will be muted or silent. If muted, the data for the
track is still there; you are just "turning off" the track during playback.
The Play-Enable button turns grey when the track is temporarily
muted due to Solo mode. The Conductor track contains no standard
MIDI data, therefore it has no Play-Enable button.

To Play-enable all tracks except for one, command click its play­
enable button. To play-enable only one track and unplay-enable all
others, option-click the track’s play-enable button. This convention
also applies to track record-enable buttons in Multi-record mode, the
Sliders window record-enable buttons, and the Lock icons in the
Markers window.

The Playback device consists of the name of one of the MIDI devices
in your studio followed by a dash and a MIDI channel number
(between 1 and 16). It can also consist of several devices.

For information about how to change playback assignments, see
“Choosing a device for playback" on page 111.

For information about how to assign a track to more than once device
at a time, see “Choosing multiple playback devices for a single track”
on page 112.

For information about how to add, remove, or rename devices in the
list, see “Changing your playback device list” on page 114.

To change the name of a track, click it while holding down the
Option key. A box will pop up: click in it and use the Macintosh
keyboard to edit the name. To confirm your change, press the Return
key. To cancel the change, press the Command and period keys. You 
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The Conductor Track

The Current Patch

must do one of these two things to terminate track name editing
(otherwise, the pop up box will remain.) Use the Enter or down
arrow key to OK the name change and move to the next track in the
list. Use the up arrow key to OK the name change and move to the
previous name in the list. The Conductor Track's name cannot be
changed.

The conductor track contains meter changes, tempo changes, key
changes, and markers. See the Conductor track chapter for more
information.

This column displays the name of the currently selected patch for the
Device that is assigned to the track. If a patch has not been selected,
no patch name appears in the column.

**The FreeMIDI option called Monitor Patch Changes in
the FreeMIDI Setup Preferences command affects this
column. When the option is turned on, this column
will show the current patch change sent by any
FreeMIDI application. If it is unchecked, it will not
give you a running update of the current patch, even
with patch changes sent from Performer.

To select a patch for a track, click in the patch column next to the
track and select the desired patch from the pop-up menu provided.
Its name then appears in the column.

If you have patch changes in the track, the Device Patch column will
update during playback to show the current patch (and the Monitor
Patch Changes command is turned on in FreeMIDI Setup).

The list of patches you see in the pop-up menu in this column is
provided by FreeMIDI. By default, the factory default sounds names
for most popular synths are provided. In some cases, patches are
given the generic name “Patch-1”, “Patch-2”, etc. However, you can
use the PatchList Manager program, Unisyn, or any other FreeMIDI
compatible librarian software to provide the actual names of the
sounds in each one of your MIDI instruments. See chapter 48, "Using
PatchList Manager” (page 725) for details.
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The Default Patch

The Comment

The Scroll Bar

The Default patch is the patch the track always begins with. It is
remembered when you save the Performer file so that the next time
you open the file and press play, the default patch is called up from
the synthesizer before playback begins so that the track will play with
the correct sound.

To select a default patch for a track, click in the default patch column
next to the track and select the desired patch from the pop-up menu
provided. Ils name then appears in the default patch column.

The list of patches in the pop-up menu is provided by FreeMIDI. As
mentioned in the previous section, this list can display the actual
sound names in the synth if you use PatchList Manager, Unisyn. or
any other FreeMIDI-compatible librarian software.

The Comment is a remark that you can display for the track. It is
simply a space for text that you can use for whatever purposes you
wish. To enter or change a comment, click on it and enter or edit the
text. Press OK or the Enter key to confirm your entry, or press Cancel
or command-period to cancel it. As much of the comment as possible
is displayed in the Tracks window. If you wish to see the entire
comment, click on it. The comment box will appear. Press the Enter
key to get rid of the box. When entering or editing a comment, the
Return key starts a new line of text instead of approving the changes
as usual in Performer’s user interface.

You can edit the comments for each track in succession: after
bringing up a comment box, press the down arrow key to approve
the changes you’ve made and move to the comment for the next
track. The up arrow key likewise moves to the comment for the
previous track.

The horizontal scroll bar allows you to scroll the Track List display
when part of it is obscured by the Tracks Overview.

The vertical scroll bar allows you to scroll up and down through the
Tracks List. Clicking or pressing the Scroll Arrows scrolls by single
tracks. Clicking the grey part of the bar scrolls by several tracks at
once. Use the scroll box to move to a particular location in the track
list.
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The Window Divider

The Grow Box

Soloing Tracks

: The Window Divider separates the Tracks List from the Tracks
; Overview. You can then drag the divider handle (at the bottom) left

or right to resize each portion of the window proportionally. If you
drag all the way to the right, the scroll bar disappears (the divider
remains).

The Grow Box allows you to resize the Tracks window. It works just
like a regular Macintosh window grow box: press and drag it to
change the size of the window.

Soloing tracks allows you to isolate tracks for playback. Only selected
tracks (i.e. those that are highlighted) will be audible when Solo is
on. This is a quick way to temporarily mute or unmute many tracks
at once without having to click on the Play-Enable buttons of each.
Solo is turned on and off from the Tracks window mini-menu or by
pressing the solo button in the Tracks window title bar: its status can
be changed during playback. You may also select and deselect tracks
during playback to change the solo group.

Individual tracks can be soloed when their edit window is open
(Event List, Graphic Editing, or QuickScribe notation window) by
pressing the solo button in the title bar.

Tracks chosen for soloing must be play-enabled. If the current Tracks
window is deactivated (for instance, if another window such as the
Counter window is activated), the solo tracks remain in effect during
playback even though the tracks lose their highlighting (unless a
track edit window becomes active, in which case it becomes soloed).
The highlighting will return when the Tracks window is activated
again. If the Tracks window is closed, solo is automatically turned off.
Tracks which are temporarily muted due to soloing have orange Play-
Enable buttons (or grayed-out buttons on a black and white screen).

When tracks are muted during soloing, Performer continues to
process the MIDI data contained in them. This allows tracks to be
soloed and unsoloed during playback without pauses or glitching. If
you want to entirely turn off tracks during playback, deselect their
Play-Enable buttons. To solo tracks:
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1. Select the tracks you wish to solo by clicking on their names.

“Partial-solo” mode

You can change track selection during playback. Use Shift-click to
select non-contiguous tracks.

2. Press the Solo button in the Tracks window title bar.

The Solo button becomes highlighted.

3. To turn Solo off, click the Solo button again.

You can turn Solo on and off during playback.

The solo command (and button) provides an additional capability:
' partial solo mode". In this mode, tracks that are being muted are not
muted all the way. Instead, their volume is brought down part way
by reducing their note-on velocities by a percentage that you choose.

To enable partial-solo mode:

1. Option-click the “S” button in any Edit window title bar, or choose
“Solo Setup” from the Tracks window mini-menu.

The Solo Setup dialog appears.

2. Choose a percentage from the pop-up menu.

The value you choose is the percent that note velocities in each
muted track will be reduced to when muted. (Velocities are not
permanently changed; they are only modified temporarily during
playback.)
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3. If desired, check the “Solo tracks selected in Tracks window”
option.

This option determines what is soloed when you are editing a
track in an event editing window (i.e. an Event List, Graphic
Editing, or QuickScribe notation window is open and active).
When this check box is unchecked, the solo button in event edit
window title bar solos the track you are editing. When this option
is checked, the solo button in the event edit window solos the
tracks that are currently selected in the Tracks window (instead of
just the one track you are editing).

4. Click OK.

Now, when you click the solo button, muted tracks will be
lowered in volume instead of being totally silenced. To bring them
back up, just unmute.

To disable “partial-solo” mode, option-click the solo button and set
the pop-up menu to “Off.

Adding Tracks You can add as many tracks as you wish to the track list. When a
track is added, its name will be “Track- n”, n being a number.

To add a new, empty track, simply choose Add from the Tracks
window mini-menu and the new track will appear on the track list.
To add several tracks at once, hold down the Option key while
choosing Add. You will be prompted for the number of tracks to add.

When you use the Add mini-menu command in the Tracks, Chunks,
or Sliders windows, Performer adds the new item to the bottom of the
list. However, if you would like to add an item to a spot in the middle
of the list, simply highlight an item in the list first. When you use Add,
the new item will be added just beneath the highlighted item.

This can also be done with the Duplicate mini-menu command in the
Sliders window.

Duplicating Tracks You can add new, empty tracks by duplicating existing tracks. To
duplicate one or more tracks:

1. Select the desired track(s).

See “Selecting Tracks” on page 180.

The Tracks Window 179



2. Choose Duplicate track layout from the Tracks window mini-menu.

The duplicate track appears in the Tracks window with the word
copy is appended to its name. This command does not copy the
data in the track; instead, it copies only the track’s name and
playback assignment.

If you would like to make more than one duplicate, hold down the
option key while choosing Duplicate Track Layout from the mini­
menu. A dialog asks you how many duplicates you would like. Enter
the desired number and click OK (or press return).

Selecting Tracks If you want to select a region in a track, change a track name, or
delete a track, you must first select the track. There are several
methods for selecting tracks:

To select ci single track, click on its name. It will highlight.

To select several adjacent tracks, press on a track name and drag over
the desired names. All tracks dragged over will highlight.

To select several non-adjacent tracks, hold down the Shift key and
click on the names of the tracks you wish to select. They will
highlight.

To deselect tracks when more than one are highlighted, hold down
the Shift key and click on the tracks you wish to deselect. They will
unhighlight.

To select an extended number of tracks, click on a track name, press
and drag over the tracks you want to select. The track list will scroll,
selecting all tracks dragged over.

Deleting Tracks To delete a track, select it by clicking on its name and choose Delete
from the Tracks window mini-menu. The track will disappear from
the track list. Delete several tracks at once by selecting them all
before choosing the Delete command. When a track is deleted, all of
its data is gone. You can undo the Delete command.

Looping Tracks Each track can be looped independently. If there are loops in a track,
the looping indicator is visible in the Tracks Overview. For a detailed
discussion of loops, see the Looping chapter.
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Opening an Event
Editing Window for a
Track

Using the Edit Bar

The Event Editing windows contain a display of all events in a track.
Each track has four event editing environments to choose from: the
Event List window, the Graphic Editing window, the Notation Editing
window, and the QuickScribe notation window. In these windows
the time, event type and specific event information (on and off
velocities, controller values, duration, etc.) for each event are
expressed numerically, graphically, or as music notation. You can
edit, add and delete events in these windows as well as select regions
of events to be modified by commands from the Region menu.

To open an Event Editing window from the Consolidated Controls
window: highlight the track name and click the Event List, Graphic
Editing, or QuickScribe notation button in the Consolidated Controls
Panel to open the desired window. Or click a track name or track 
segment as follows:

Do this

Double-click

Command double-click

Option-command double-click

To open this

The event list (or whatever you have
set in the Preferences command—see
below)

Graphic Editing window

Notation Editing window

For your convenience, the Preferences command in the File menu
lets you decide which window opens when you double-click a track.
For more information, see “Preferences" on page 680.

For a detailed explanation of event editing in the Event List, Graphic
Editing, and QuickScribe notation windows, see the Event List
Window, Graphic Editing, and Notation Editing chapters.

The Edit Bar holds the starting and ending locations for a region. To
enter a starting location, click in a field in the Start time and enter a
value; to enter an ending location, click in a field in the End time and
enter a value. You can use the Tab key (or decimal point key on the
keypad) to cycle through the measure I beat I tick fields.
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There are several quick ways to load times into the Edit Bar.

Selecting a Region
Using the Tracks List

| 1111000 ErjdJ ,5111000

Clicking on the word “Edit” loads remembered times into the Edit
Bar. To “remember” a pair of Start and End times, activate the
window containing the times and choose Remember Times from the
Basics menu (or press command-R). Times are remembered for each
type of window as follows:

e in a Markers window, the times of the first and last
highlighted markers are remembered.

q in an Event Editing window, the times of the first and last
highlighted events are remembered.

□ in a Tracks window, the times in the Edit Bar are
remembered.

■ in the Consolidated Controls panel, the times in either the
Memory or Auto Record bar are remembered, whichever is
visible.

Clicking on the word “Start” enters the current time as displayed in
the Counter window as the Start time. Clicking on the word "End"
enters the current time as displayed in the Counter window as the
End time.

Double-clicking on the word “Start” enters the beginning time of the
sequence as the Start time. Double clicking on the word "End” enters
the end time of the sequence as the End time.

Double-clicking on the word “Edit" set the Start and End times to the
beginning and end of the sequence. This is equivalent to double
clicking on both the “Start” and “End” words.

This method of region selection allows you to select a region
containing several tracks at once.

1. Click the Tracks window of the sequence you wish to modify to
activate it.
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The Conductor Track

Creating a Slider
Console from the Tracks
List

2. Enter the Start time of the region in the Edit bar.

See the preceding section. Using the Edit Bar for details on
entering the Start time in the Edit Bar.

3. Enter the End time of the region in the Edit Bar.

See the preceding section. Using the Edit Bar for details on
entering the End time in the Edit Bar.

4. Select the track or tracks that contain the region.

Consult the Selecting Tracks section above for the details about
track selection. The region is now selected in all the highlighted
tracks.

Events occurring on or after the Start time and before the End time
will be affected by a region command. For example, in 4/4 time, if
the Start time is 9111000 and the End time is 13111000 all events
starting on the very' first tick of the first beat of bar 9 through the very
last tick of the fourth beat of bar 12 (12141479) will be modified. An
event occurring directly on 13111000 (the very first tick of the first
beat of measure 13) will not be modified.

The Conductor track is a special track containing markers, meter,
tempo and key change information. Every sequence always has a
Conductor track; it cannot be deleted. In the Tracks window, the
Conductor track has a Move Handle and Comments. The Conductor
track cannot be looped. Certain editing commands can be used on
the Conductor track. For more information, see the chapter called The
Conductor Track.

A convenient way to create consoles is with the Create Consoles
command in the Tracks window mini-menu. This command can
automatically create volume, pan, modulation, and other consoles all
at once for the tracks you select.

To create one or more consoles from the Tracks window:

1. Highlight the Track(s) for which you wish to make consoles.

Click each track name to highlight it. Shift-click to select tracks not
next to one another.

The Tracks Window 183



2. Choose Create Consoles from the Sliders window mini-menu.

Tracks List Hints

The Create Consoles dialog box appears.

Create console for Verse 1

Size: Orientation:
© small O horizontal
O large ® vertical

@ Volume |? |
® Pan 11 0 |
□ Modulation wheel 11 J

□ Pitch bend
□ Other...

Name: | |

Controller: | |

Source:
® MIDI Source: 01 /W

O Track: Funk Bass^~|

Source data type for sliders:
O “ Pitch bend O Notes
O ± Mono pressure O i Velocities
© A Controller! 1

3. Select the dimensions, type, and (optionally) the source setup of
the sliders for each console.

You can create more than one type of console. You can even enter
a custom console name and data type using the Other option.

4. Click OK to create the console.

The Console is created and its name is added to the Windows
menu.

There is a difference between using Solo and the Play-Enable Button
to turn off a track. If a track is muted with Solo, Performer continues
to scan through the data for that track so that it may resume playback
of the track at any moment. If the Play-Enable Button for a track is
disabled, the data for that track is not scanned during playback,
resulting in slightly less overhead for the computer. Disabling tracks
may thus result in slightly better performance in playback. If one or
more tracks are not needed for a particular playback pass, it is best to 
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The Tracks
Overview

Basics

Scrolling During
Playback

disable them. A pertinent example is transferring tracks to a multi­
track tape recorder erne at a time: rather than using Solo to mute the
other tracks, use the Play-Enable buttons to enable one at a time.
There may be an audible glitch if you re-enable a track during
playback.

It is easier to split drum and percussion parts into separate tracks
because you can quickly and easily select them individually. If all the
drums are in one track, you have to go into the Graphic Editing
window to select individual drum parts (snare, bass, high hat, etc.) By
splitting them into separate tracks, you can simply highlight the track
name and do your editing. You can split them easily either during
recording or afterwards with the Split Notes command.

The Tracks Overview portion of the Tracks window provides you
with a global view of the MIDI data in a sequence. It is useful for
arranging parts among tracks, using edit commands such as Cut and
Paste, and other region operations that affect more than one track at
a time. It allows you to view and edit the data in your sequence all at
once instead of one track at a time.

The Tracks Overview divides each track into equal-length segments,
which can be zoomed to show as much as 16 measures per segment
or as little as 30 ticks. Each segment displays how much data is
present in that segment. Blank segments contain no data. Purple
segments (or gray ones on a black and white screen) contain
between 1 and 9 MIDI events, and dark purple (or black) segments
contain 10 or more events. The threshold between low-density and
high-density segments (10 events) can be adjusted with the Set
Density Threshold mini-menu command.

The Time Ruler shows the time span of each segment.

Segments can be selected for editing by commands from the Edit and
Region menus. In addition, Event Editing windows can be opened
from the segment by clicking as described in the next section.

The Auto-Scroll command in the Basics menu can make the Tracks
Overview window scroll during playback. In addition, the window
will automatically open to the current playback location of the 
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Opening an Event
Editing Window From a
Segment

sequence. A scrolling “wiper" can be displayed as well to indicate the
current playback location. Please refer to the Auto-Scrolling section in
the Playback chapter for more information.

The contents of a track segment can be view with any of Performer's
three Event Editing windows. To open a window double-click the
segment as shown below:

To open this:

Event List

Graphic editing

Notation editing

Do this:

Double-click (depending on how
you’ve set the preferences—see
below)

Command double-click

Option-command double-click

The Time Ruler

Using the time ruler to
select a playback point

Zooming

For your convenience, the Preferences command in the File menu
lets you decide which window opens when you double-click a track.
For more information, see “Preferences” on page 680.

The Time Ruler displays the time of each segment in any one of
Performer’s three time formats. To change time formats, choose Set
Rulers from the mini-menu.

You can double-click a segment in the time ruler to make Performer
jump to that location for playback. You can do so when Performer is
stopped or during playback. This is an ideal way to quickly locate to
a desired point with the mouse.

Zooming the Time Ruler in the Tracks Overview changes the amount
of time shown in each segment. If you zoom out, each segment
represents a longer duration, resulting in a more global view of the
sequence. If you zoom in, each segment represents a shorter
duration, allowing for more detailed work.

The Tracks Overview window defaults to showing one measure per
segment. Zoom-Out levels zoom up to 2, 4, 8, and 16 measures per
segment (regardless of meter). Zoom-In levels zoom from 1 measure
down to a quarter note (480 ticks), an eighth note (240 ticks), a
sixteenth note (120 ticks), a thirty-second note (60 ticks), and a sixty­
fourth note (30 ticks).
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Selecting Segments for
Editing

To zoom in, click once for repeatedly) on the magnifying glass with
the plus sign ( + ). To zoom out, click once (or repeatedly) on the
magnifying glass with the minus sign ( - ).

To edit the data in a segment, you must first select the segment. When
a segment is selected, it highlights, and its contents can be edited
with any Edit menu or Region menu command.

Segment selection is exclusive from track name selection in the
Tracks List. If you select segments, any highlighted track names will
deselect.

Below are several convenient shortcuts for selecting segments:

To select a single segment, click it.

To select several adjacent segments, drag over them. If the segments
are in several adjacent tracks, drag over them in a diagonal fashion.

To select several non-adjacent segments, hold down the Shift key and
click the segments you wish to select. They will highlight.

To deselect segments when more than one are highlighted, hold
down the Shift key and click the segments you wish to deselect. They
will unhighlight.

To select a segment in all tracks, click the segment in the Time Ruler.
All segments beneath will highlight.

To select one or more segments in all tracks, drag in the Time Ruler.

After you select one or more segments, Performer loads the start and
end times of the region into the Edit bar for convenient selection in
the Tracks List.
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Clicking anywhere below the tracks in the Tracks Overview deselects
all currently selected segments.

KMIUI'

7 '-i r- 05R/W-10 Drums |
'-i> r- - 05R/W-2 Chords |

> r~ 05R/V-2 Chords copy |
", X. -J 05R/V-3 Bass

Using the View Filter The View Filter allows you to choose what types of MIDI events are
displayed in the Tracks Overview window. For example, if you
would momentarily like to see which segments contain patch
changes, you can open the View Filter and option-click the patch
change check box (to select it and deselect all others). With only
patch changes selected, only segments that contain a patch change
will become grey. As you can see, the View Filter can be an effective
tool for working with only a few types of data at a time. The View
Filter affects all Event Editing windows as well as the Tracks
Overview window.

The View Filter also determines which types of events are affected by
Edit menu commands when the data is selected in the Tracks
Overview window. Here’s a simple rule to remember: if you can see
data in the Tracks Overview window, it will be affected by edit
commands.

Please note that Conductor track data such as Markers and Meter
changes, which are displayed in the Event Edit windows of regular
tracks, are displayed only in the Conductor track in the Tracks
Overview.

To use the View Filter from an Event List window:

1. Choose Set View Filter from the Event List mini-menu.

A dialog box will appear.
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Setting the Density
Threshold

Setting a Loop in the
Tracks Overview

2. Choose the data types to be displayed by checking the box for
each.

You can choose all types of data at once by clicking on the "Set
All” button. You can uncheck all the check boxes by clicking on
the “Clear” button. Option-click to check only the check box you
click on, unchecking all others; command-click to check all boxes
except the one you click on. Use the Controllers option to specify
which controller information is displayed.

3. Press OK to confirm your choice or Cancel to cancel it.

When using the View Filter, keep these rules in mind: The View Filter
settings you select will stay in effect until you change them. They
affect all open Event Editing windows. The View Filter settings will
affect all edit operations done in the Event Editing windows.

The Set Density Threshold mini-menu command allows you to specify
the difference between low-density and high-density track segments.
The default value is 10 MIDI events, so that a segment containing
between 1 and 10 MIDI events will appear purple (or gray on a black
and white screen), and a segment containing 10 or more will appear
dark purple (or black). You can change the 10-event threshold to any
value between 1 and 999 events.

In general, the lower the threshold value, the easier it is for Performer
to count events and display segments. Higher thresholds may cause
Performer to redraw the segments a little more slowly. However, if
you have a fast Macintosh (68020 or 68030 CPU), you probably won't
notice much of a difference between low and high thresholds.

To set a loop in the Tracks Overview:

1. Select the segments that you wish to loop.

Drag over them. You can select segments in more than one track
if you like. If you select different time regions in more than one
track, the loop region will in every track will be the earliest
selected time to the latest selected time.

2. Choose Set Loop from the Change menu or click the Loop button
in the Consolidated Controls window.

The Set Loop dialog box will appear.

The Tracks Window 189



3. Choose the number of times that you would like the loop to repeat.

Creating Sequence
Chunks

4. Click OK to create the loop or Cancel to withdraw the loop
command.

The Create Chunk mini-menu command in the Tracks Overview
window takes selected segments in the Tracks Overview window and
turns them into their own sequence Chunk in the Chunks List
window.

The Create Chunk command makes it easy to break up a sequence
into separate pieces (Chunks) in order to rearrange them more freely
in a Song window. For example, let’s say that you have built several
phrases that are a few bars long in a Sequence. But now you want to
rearrange them and try' different combinations. To do so, you can
select the segments of a phrase and choose Create Chunk from the
mini-menu for each one. Then, you can drag the resulting sequence
Chunks from the Chunks list window into an empty' Song window to
try different orders and combinations.

Once you have arranged the Song as you like, you can even convert
it back into a sequence using the Song window mini-menu command
called Merge Chunks to Sequence. This command takes the separate
Chunks inside the Song window and reduces them to a single
sequence Chunk.

At any time, you can take your music freely back and forth from
Sequence form to Song form with these two commands to help you
create your music.

To create a sequence Chunk from the Tracks Overview window:

1. Select the Segments that you wish to be in the Chunk.

Alternately, you can select the region from the Tracks List by
highlighting track names and setting a region in the Edit bar. See
the section earlier for information about selecting segments. You
can even select non-adjacent segments.

2. Choose Create Chunk from the Tracks Overview window mini­
menu.

A dialog box appears.
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Name: [untitled |

Set End time:
<?' Auto (downbeat of next measure)
O Manual: | 11UOO1 |

Song select number: |- |

Assign times to the
start of the sequence...

| 11 Eii Measures
| 0:00.001 Q Real time
| 0:00:00:001 aii' Frames

plus| 0| timecode bits

3. Type in a name for the Chunk.

4. Type in an End Time to determine the length of the Chunk.

By default, the end time is determined by the length of the
selected region.

5. (Optional) Type in any other information you wish about the Chunk.

6. Press OK to confirm your choice or Cancel to withdraw the
command.
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Customizing the
Tracks Window

: The Tracks window can be completely customized. This allows you
I to set it up in the way that best suits the way you work. The diagram
; below summarizes what you can do.

Window:

lit] Record

None

Level Decay Time (0-99):

I 05R/V

.euel Meter Setup

These Auto Scroll options (Basics menu) produce

this scrolling highlight, which clearly indicates

track playback position in the Tracks Overview.

For details about these

options, see "Configuring

the MIDI level meters” on

page 193.

MIDI level meters display

degree of MIDI activity or

note-on velocities in each

track during playback. To
configure the meters in the

setup dialog shown to the
right, choose “Level Meter

Setup” from the mini-menu,

or double-click any level

meter.

(21 Phy-enable
Device

ci) Name
□ Patch

Default Patch
□ Comment

Double-click the column headings

to open the dialog box shown to the

left (or choose “Columns Setup”

from the mini-menu), which lets you

choose the columns you want to

see. Below, only the record-enable

buttons, playback assignment, track

names, and MIDI level meters are

displayed. The rest of the columns

are being hidden. Reorder the

columns by dragging the column

heading left or right.

String Pad
Brass Stack
Huge Bass Combo
Big Ben Bells
Rich Orchestra
New Device Group...

The devices that appear in this list are provided by FreeMIDI.

You can customize your FreeMIDI device configuration to

exactly match your MIDI studio. You can even make custom­

ized device groups.

BRC
DrumKat
K2000R
MIDI Mixer 7s
Modem All cables
Proteus/2
TG100
TG500
Video Time Piece

® Graphic Editiny windows
(a) Song windows
■2) Markers window

[?] Tracks windows

Show
© MIDI Activity
Q Velocity

Monitor During:
111 Playback
[9i Recording

Uncheck the columns you want to hide:
&•) Move track

| SH All | | OK

■ 05R/W-1 ■
05R/Y/-2 JI
05R/Y/-3
05R/W-4

05R/W-6 'V
05R/W-7
05R/W-8

’ 05R/W-9
05R10

' 05R/W-11
05R/W-12
05R/W-13
05R/W-14
05R/W-15
05R/W-16

All | [ Clear j | OKf | Cancel

Uerse 1
.Edit] Start 113|1|000 End] 14,11000 Wl If If IfJ fAUE|P>EC|PLAY DEVICE TRACK NAME LEV DFLT. PATCH
-2J^1 Conductor j I iji

K2000R-1 Funk Bass Funk Me t (■MiiMMBlIaBM mm:
05R/W-2 Chords 2 1“ HarnmerF

jd_iJ > K2000R-5 Strings Grand Sti ■■IiBMriiBaHI aanor
-i-d > TG100-3 Brass n— Slov/Stri [■■■iLlHBdl____ laMi
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Configuring the MIDI
level meters

The MIDI level meters in the Tracks window can be configured in
several ways. To set these options, double-click any level meter (or
choose Level Meters Setup from the mini-menu) to open the Level
Meters Setup dialog box shown below. Settings in this dialog box are
global across files and are automatically saved in the Performer
Preferences file in the System Folder.

Show
O Midi Activity
@ Velocity

Level Decay Time (0-99):

IS—I

Monitor During:
0 Playback
0 Recording

Showing MIDI activity or velocity
Level meters can show either MIDI activity or velocity. With MIDI
activity, the meter is triggered every time a MIDI event is played back
from the track. It can be any type of MIDI data, including notes.
controllers, pitch bend, sysex data, etc. With velocity, the level meter
reflects the note-on velocity of each note at the instant the note is
triggered during playback.

•“MIDI level meters do not function like audio level
meters. For both MIDI activity and velocity, the MIDI
level meter is triggered by a MIDI data byte, such as a
note-on event or controller, at the time it is played
back. The level does not sustain during the duration of
the note.

Monitoring
Level meters can monitor MIDI data being played back, recorded, or
both. With both options checked, the meters monitor playback when
you are playing back, and they monitor recorded material on the 
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Hiding level meters to
reduce overhead

current record-enabled track during recording. If you are in overdub
record mode, both recording and playback are monitored at the same
time for the record-enabled track.

We recommend using both options because this gives you the
greatest amount of feedback about what is going on in your tracks.

Level Decay Time
Level Decay Time refers to how quickly the meters return to zero. The
decay amount is expressed as an arbitrary value between zero and
99. For music that consists mostly of sixteenth notes, eighth notes,
quarter notes, and longer, try level decay time values between 5 and
20 at tempos between approximately 80 and 160 bpm. If the tempos
are extreme, or if notes are particularly dense or sparse, you might
find it helpful to use level decay times below 5 or above 20.

In general, shorter decay times are better for fast tempos and/or
dense passages of notes. Longer decay times are better for slower
tempos and/or sparse passages. If you find that the meters don't stay
up long enough for you to see them, try a higher value; lower the
decay time if levels go up and then don't change very much. Decay
times above 30 are very slow and would probably only be useful in
extreme cases (very slow music, lighting control sequences, etc.)

Performer goes to great lengths to preserve the integrity of MIDI
playback. Screen display takes a back seat to the more important
function of playing back the sequence with as accurate timing as
possible. However, the level meters do require some effort from
Performer. In some situations, such as running Performer on a slower
Macintosh, it may be desirable to hide the level meters to ensure the
highest playback performance. The Performer installation guide
booklet has a chart that ranks Macintoshes by power and speed. If
you have the equivalent of a Mac Ilsi or above, you shouldn't need
to hide the meters, unless you have an unusually large number of
tracks—more than a hundred.

To hide the level meters, double-click the track column heading
above the level meters (labelled "LEV") to open the Track Columns
Setup dialog box as shown on page 192. Uncheck the Levels option.
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Switching to a different
sequence within the
same window

If you'd rather not hide the meters, another overhead-reducing tactic
is to monitor MIDI activity instead of velocities because MIDI activity
monitoring requires less effort. Open the Level Meters Setup dialog as
explained on page 192 and select the MIDI Activity option.

If you are working with multiple sequences in a file, you can switch
between them in the same Tracks window by command-clicking the
sequence name in the title bar. A pop-up menu appears from which
you can choose the sequence you’d like to see.
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Chapter 13 Looping

Basics

A loop is a region of data in a track that is played repeatedly. The
result is similar to using the Repeat command on the Edit menu to
insert multiple copies of a region. Instead of actually copying the
data, however, the loop feature simply replays the region over and
over. Looping is thus more memory-efficient than making repeated
copies of a region. Also, making a change in a looped section is easy:
instead of changing every repeat of the data as you would if you had
copied and pasted it, you simply change the data in the looped
region. Tracks or sections of tracks can be looped independently; it is
thus possible to build a complex sequence out of a small number of
events.

A loop is different from the Memory-cycle button because a loop is a
permanent addition to a track. In addition, the loop only loops one
track, whereas Memory-cycle loops the entire sequence. For
information about Memory-cycle looping, see ‘ The Memory-cycle
button” on page 71.

A loop has three components: a start point, an end point and a
number of repetitions. When a loop starts, it plays through its data
normally. When the end point is reached, the region is played again
from the start point. This cycle repeats for the specified number of
repetitions, or indefinitely if an infinite loop is specified.

When the loop finishes its number of repetitions, the next data played
will correspond to the location on the Counter. For example, the
region from measure fill 000 to 4111000 is looped four times. After
the loop finishes, the Counter will be at measure 13 (four times three
measures is twelve: measure 13 comes after measure 12). The data in
the track continues playing from measure 13, not from measure 4. If
there is any data in measures 4 through 12, it is skipped. The loop
takes precedence over any intervening data.

The reason that the data is skipped is so that there is no ambiguity
about the current location being played. If the Counter were to
display 20111000 and three tracks are playing back data at that spot
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and another has finished its looping and is playing back at 15131000
and another at 12121240 and another at 3 14 1000... things could get
very confusing. Therefore, the location in the Counter applies to all
tracks; it is not affected by loops.

When moving to a location in a sequence, Performer figures out
whether any tracks are in the middle of a loop and keeps count of
where in the looping process these tracks are. This allows you to
begin playing or recording from any location and be sure that the
loops will all play correctly.

Notes can be sustained across loop boundaries: if a note is inside a
loop, it will always sound for its specified duration.

Tracks and Looping Each track has its own set of loops. This means that each track can
be looped independently of others. The Conductor track cannot be
looped. (You can, however, temporarily loop the entire sequence
using the Memory-cycle button.)

A loop starts right on its Start time and ends just before its End time.
For example, a loop set from 1111000 to 4111000 would play the
data from 1111000 to 3141479; the next repetition would play the
same data immediately at 4111000. The number of repetitions equals
the total number of times you want the region to play; this includes
the first pass.

A loop need not be set on measure boundaries (i.e. on beat one, tick
zero of the measure). They can start anywhere in a measure. We'll use
loops starting on measure boundaries as examples to keep things
clear. In practice, any location is fine.

If you want to set a loop in several tracks at once, just highlight all of
the desired tracks at once before you set the loop.

If a track contains loops, a looping indicator appears in the Loop
column next to the track name and in the track segment in which it
begins This indicator can't be used to change anything: it is merely a
reminder that the track contains loops.

Each track may can contain multiple loops. You can even have nested
loops in a track, i.e. loops within loops. Here’s an example of nested
loops, all in the same track:
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When Loops Conflict

□ Bars 1 to 3 played 8 times (lasting from bar 1 to 17)

□ Bars 17 to 19 played 4 times (lasting from bar 17 to 25)

n Bars 25 to 27 played 4 times (lasting from bar 25 to 33)

□ Then the whole 32 bar section is looped:

□ Bars 1 to 33 played 4 times (lasting from bar 1 to 129)

When bar 33 is reached, bars 1 to 3 will be played another 8 times,
bars 17 to 19 another 4 times, and bars 25 to 27 another four times.
Then this whole process will repeat twice more until bar 129 is
reached.

It is possible to set up loops such that they overlap with each other
or otherwise conflict in the same track. When this happens, the first
loop in the track takes precedence. When two conflicting loops start
at the same time, the one that has a later ending time takes
precedence.

Here are some examples of the effects of conflicting loops:

■ Bars 1 to 9 played four times, bars 5 to 13 played four
times.

The first loop takes precedence. Bars 1 to 9 are played and the
loop repeats back to bar 1. The second loop is ignored.

■ Bars 1 to 17 played four times, bars 1 to 3 looped infinitely.

Bars 1 to 3 are played eight times, lasting until bar 17. Then the
“outer” loop (the one with the later end time) takes over,
terminating the “inner” loop. This returns to bar 1, playing the
inner loop eight times again. This cycle repeats four times until the
outer loop is finished. At that point, the sequence is at bar 65 and
it continues playing from there, all previous loops done.
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Creating a Loop

Setting a Loop

□ Bars 1 to 5 played four times, bars 5 to 7 played eight
times.

The second loop is completely ignored since its time is skipped
while executing the first loop. When a loop begins at a time that
is skipped after executing a previous loop, that loop is ignored
(like all other data in the skipped region).

There are two ways to create loops: the Set Loop command, and the
Insert button in the title bar of Event Editing windows.

To use the Set Loop Command:

1. Activate the Tracks window for the sequence in which you wish to
set the loop.

Double-click the name of the sequence in the Chunks window or,
if it is already open, click the window once.

2. Select the track(s) or track segments in which you wish to set the
loop.

Highlight the desired track names, or drag over the desired track
segments. If several tracks are selected, each will have the same
loop set for it. You may not loop the Conductor track.

3. Optional: Enter the Start and End times of the loop region in the
Edit Bar.

Remember Times, documented in the Event List Window chapter.
is useful for entering times in the Edit Bar. The loop boundaries
can also be entered in the Set Loop dialog box.

4. Choose Set Loop from the Change menu.

A dialog box appears.
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Inserting Loops in the
Event Editing Windows

5. Edit the Start and End times if necessary, then enter the number of
times you want the loop region to be played.

The number you enter will be the total number of times the region
is played. If you want it to play indefinitely, choose the Infinite
loop option.

6. Press the OK button to confirm your entry or the Cancel button to
cancel it.

Loops can be inserted directly into a track from either the Event List
window or the Graphic Editing window.

To insert a loop into a track using the Event List window:

1. Open the Event List containing the passage you’d like to loop.

2. Press the Insert button in the title bar and choose Loop from the
menu.

A new loop event pops up.

lilllOOO ">2111000 ■2 times 1

3. Enter the start and end locations and the number of repetitions for
the loop.

Use the Tab key to move from field to field. If you type “i” in the
repetitions field, Performer will fill in the word "infinite".

Looping 201



Viewing and Editing
Loops in an Event
Editing Window

4. To enter the loop, press Return. To cancel, click anywhere with the
mouse.

If you’d like to insert another loop, press the Enter key. This enters
your loop and produces another new loop event.

To insert a loop in a track’s Graphic Editing window:

1. Press on the Insert button in the title bar of the Graphic Editing
window and choose Loop from the menu.

The menu will disappear and the mouse pointer will turn into a
cross-hair.

2. Click at the desired start location in the Marker Strip, drag to the
right to draw the desired length, and release the mouse at the end
location.

A loop will appear. Use the dotted hairlines in the Time Ruler to
align the beginning and end of the loop while inserting it.
Information about the loop will appear in the Information bar.

Loops can be viewed and edited in the Event List window for the
track that contains them. Viewing loops in event lists is a good way
to see them in context. This will help you to see when they occur,
what data they cause to be skipped, etc.

“2|TiOOCf until 5|1|000 i2 time's" 
<d>_until 3I3I240 .infinite ------- ------------- Nested loop

_ 2I1I256 >F3 “fSS.OIISS’ ___ ____
!______  2111429 >03 ~iS5 01142_______________ j A
|  2121252 >A3 >85 01172 

2131'60 >03 i?5 0|i35" _____ I
!---------------2|?.|4_59_ Jrs—iss [QI125 ,—I.------------ ; Looped events

2141259 >65 i?6 01149 Z H
tgigoo >as _>S5_ 01211 __________

| ' 3I2I02J_>G3_ 48B_ 01245
3121516 >F3 195 01226 )

I___' 3131052>G3_"i'96 01231_________
L OlITT _______ J|

oH2f _______________ ■
j____J8S O1&S _________________ ____________ .

■i/f&M ------------------- ----- ----------------Skipped loop events
• c > z-._ .■ ■■ Tfe-1 ___ __________j

•40027 0^22 _ ________ J
ZZ / ' /,'/ ____ j

[_ _______________j

Events in a loop are indented to the right in the Event List window.
Events in nested loops are indented further to the right. Events that
are skipped due to loops are displayed in italics. These display 
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Editing Loops with the
Edit Menu

Removing Loops Using
the Clear Loops
Command

features will let you see immediately which events are within loops,
what level of loop nesting is happening at any given location and
what the effect of the loop is, i.e. what data will be skipped.

You can edit loops in the Event List window just like any other
parameter. Simply click on the data in the loop you wish to change
and enter a new value. To clear a loop or loops from an event list,
simply highlight the loop event(s) and select Erase from the Edit
menu.

Loops can also be edited in the Graphic Editing window for each
track. For more information, see the chapter The Graphic Editing
Window.

Loops can be edited like any other event with the commands on the
Edit menu. If you Cut, Paste, or otherwise edit a region that contains
loops, the loops will be edited along with the other events.

To edit loops using the Tracks window and the Edit menu, first make
sure Loops are checked in the Edit Filter. Then select the track(s) to
be edited, define the region using the Edit Bar Start and End times,
and choose the desired command from the Edit menu. Checking only
Loops in the Filter is useful for editing loops without altering the
MIDI data in the selected region; this is similar to using the Clear
Loops command. Note that by default, loops are unchecked in the
Edit Filter.

To remove a loop or loops, select a region that contains the loops and
select Erase from the Edit menu, or use the Clear Loops command.

The Clear Loops command in the Changes menu is used with the
Tracks window Edit Bar, and is a handy shortcut for removing loops.

To remove a loop or loops, select a region that contains the loops
using the Edit Bar Start and End times, and choose the Clear Loops
command from the Change menu. Loops that begin inside the
specified region are erased; MIDI data is unaffected.

For example, Track-1 contains loops at measures 1 to 4 and measures
3 to 9. If the Edit Bar Start and End times are 2111000 and 9111000,
only the second loop will be cleared.
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Loop Recording "Loop recording" is the process of overdub recording into a region
over and over again to build up a pattern. This is best done with the
Memory-cycle feature in Performer. See "The Memory-cycle button"
on page 71 for detailed information. Once you have built a pattern
using Memory-cycle, you can insert a permanent loop over the
region. See “Quickly selecting what you have recorded" on page 78.

By using Memory-cycle with overdub recording, Performer can
function in a manner very similar to the way most commercial drum
machine sequencers work: by building up patterns in multiple passes
through a section.
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Chapter 14 The Chunks Window

The Chunks window displays the Chunks in a Performer file. A
Chunk is either a sequence (a collection of tracks) or a song (a
collection of sequences and other songs). A Performer file can
contain as many Chunks as memory' in your Macintosh will allow.
Chunks can be cued for playback, either automatically or manually,
in order or at random. You can also build an entire song out of other
sequences and songs by chaining and stacking Chunks in the Song
window, which provides seamless, simultaneous playback of Chunks
in any order and combination.

Quick Reference

Sequence Song
iype: Displays each Chunk’s type by icon, either Song or Sequence.
This icon is used to drag Chunks into Song windows and to change
the order of Chunks in the Chunks window.

Play: Shows the play-enable button for each Chunk. When a Chunk’s
play-enable button is black, the Chunk is play-enabled. Only one
Chunk can be play-enabled at a time.

S# (Song Select Number): Displays the song select number that will
play-enable the Chunk when received from a MIDI controller. Song
select numbers range from 0-127. If a Chunk has no song number
assigned, the column displays a single dash (-).
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The Chunks Window
Mini-menu

Add Sequence
Add Song
Duplicate Track Layout
Open Chunks
Auto/manual End Time
Set Chunk Start...

Delete

; If Performer receives a song select number that is assigned to two or
more Chunks, Performer will cue the Chunk that appears highest in
the list. For this reason, it is best to assign a unique Song Select
number to each Chunk.

End time: Displays each Chunk s End time. In automatic mode, End
time is the downbeat of the measure following the last complete
measure in the Chunk. When a Chunk's End time is in manual mode,
it is bold and can be pop-edited to any length.

Name: Displays the name of the Chunk. Click the name to select the
Chunk. Option-click the name to change it. Double-click the name to
open the Tracks or Song window belonging to the Chunk.

Because Chunks can be imported into other files, dragged without
limit into Song windows, and duplicated very easily, always use the
most descriptive Chunk name possible to avoid confusion.

Comments: Displays as much as possible of your comments for each
Chunk. View and edit the comments by clicking them.

The Chunks window mini-menu contains the following commands:

Add Sequence: Adds a sequence to the Chunk list. To add several
sequences at once, press the Option key while choosing Add.

Add Song: Adds a song to the Chunk list. To add several songs at once,
press the Option key while choosing Add.

Duplicate Track Layout: Creates a new, empty sequence with the same
track layout as the selected sequence. Select an existing sequence
before choosing this command.

Open Chunks: Opens a Song window for each highlighted song and a
Tracks window for each highlighted sequence.

Auto/manual end time: Toggles the Auto/manual status of the selected
Chunks. Automatic mode locks the Chunk’s End time at the
downbeat of the measure following the last complete measure in the
Chunk. Manual mode changes the time to boldface and allows it to
be pop-edited.
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Basics

Opening the Chunks
Window

Sequences

Q

Set Chunk Start: Establishes the start times of the currently selected
Chunk(s) in each of Performer’s three time formats: measures, real
time, and SMPTE time. The start times are what you see in the
Counter window when you rewind back to the beginning of the
Chunk. This is the same window that appears when you click the
Start Time button in the main counter.

Delete: Deletes the selected Chunks. If you attempt to delete a Chunk
that is part of a song in the open file, a dialog box appears,
prompting you to confirm your decision.

The Chunks window lists the Chunks in a file and provides useful
features to manage them, such as adding, deleting, and other
operations. In addition, Chunks can be dragged from the Chunks
window into a Song window to build a song. For more information,
see the chapter The Song Window. Chunks can also be automatically
cued to playback in the order in which they are listed in the Chunks
window. For more information about cueing, see “The Chunk Control
buttons” on page 78. Chunks can also be cued remotely from your
MIDI controller. For more information, refer to The Remote Controls
Window chapter.

To open the Chunks window, choose Chunks from the Windows
menu. The Chunks window will appear, displaying a list of all
sequences and songs in the open file. Within the Chunks window,
songs and sequences have different icons but behave identically.

A sequence is a complete MIDI performance consisting of any
number of tracks, which are listed in that sequence's Tracks window.
Each track contains MIDI data which may be assigned to any
combination of channels. A sequence also has a Conductor track,
which contains meter, key, and tempo information.

Many essential operations on tracks are done in the Tracks window:
tracks are added and deleted, editing regions within tracks are
specified, Event Editing windows for tracks are opened and much
more. See The Tracks Window chapter for complete details about its
operation.

Each sequence also has its own Markers window. See The Markers
Window section for details about it.
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Songs

Selecting Chunks

Creating New Chunks

i\ song is a collection of Chunks that you organize to play back in the
preferred order and combination. Each song has its own Conductor
track. End time, and markers. Each song has its own Song window,
where you arrange the Chunks that comprise the song. The Song
window is described later in this manual.

There are several methods of selecting Chunks:

To select a single Chunk, click on its name. The name will highlight.

To select several adjacent Chunks, click a Chunk name and drag over
the desired names. All Chunks dragged over will highlight.

To select several non-adjacent Chunks, hold down the Shift key and
click on the names of the Chunks you wish to select. They will
highlight.

To deselect Chunks when more than one are highlighted, hold down
the Shift key and click on the Chunks you wish to deselect. They will
unhighlight.

To create a new, empty sequence, choose Add Sequence from the
Chunks window mini-menu. To add several new sequences at once,
hold down the Option key while choosing Add Sequence. You will be
prompted for the number of sequences to add.

To create a new sequence with the same track layout as an existing
sequence, highlight the existing sequence and select Duplicate Track
Layout from the Chunks window mini-menu. A new sequence will be
added with the same name as the sequence you highlighted
preceded by the words Copy of. It will have the same track layout as
the highlighted sequence: the number of tracks, the track names, and
the track playback channel assignments will be identical to the
original.

To create a new, empty song, choose Add Song from the Chunks
window mini-menu. To add several new songs at once, hold down
the Option key while choosing Add Song. You will be prompted for
the number of songs to add.
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Duplicating Existing
Sequences

Loading and Linking
Chunks from Another
File

Splitting Up an Existing
Sequence into Separate
Chunks

! Sometimes you may want to duplicate a sequence to experiment with
I changes or for some other reason. Be sure that the Memory window
I shows plenty of free memory before you duplicate. To duplicate a

sequence:

1. Highlight the sequence’s name in the Chunks window.

2. Choose Copy from the Edit menu.

3. Choose Paste from the Edit menu.

An exact copy of the sequence, including all the data in the tracks,
will be placed at the end of the list in the Chunks window.
Rename it immediately so that you do not get the copy and the
original mixed up.

Performer's Load command allows you to quickly import Chunks into
an open file from another, unopened Performer file.

It’s easy to run low on memory when working with several
sequences and songs. So that you aren’t restricted by memory7 when
loading Chunks, Performer lets you load either a Chunk's actual data,
or just a Link to that data. The Data and Link sub-options determine
which will be loaded. Loading a link to a Chunk instead of the Chunk
itself saves a great deal of memory', allowing even a two Megabyte
Macintosh to support a long list of Chunks.

For step-by-step instructions to load and link Chunks, please refer to
the chapter Working With Files.

The Create Chunk mini-menu command in the Tracks Overview
window takes selected segments in the Tracks Overview window and
turns them into their own sequence Chunk in the Chunks List
window.

The Create Chunk command makes it easy to break up a sequence
into separate pieces (Chunks) in order to rearrange them more freely'
in a Song window. For example, let’s say' that you have built several
phrases that are a few bars long in a Sequence. But now you want to
rearrange them and try different combinations. To do so, you can
select the segments of a phrase and choose Create Chunk from the 
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mini-menu for each one. Then, you can drag the resulting sequence
Chunks from the Chunks list window into an empty Song window to
try different orders and combinations.

Once you have arranged the Song as you like, you can even convert
it back into a sequence using the Song window mini-menu command
called Merge Chunks to Sequence. This command takes the separate
Chunks inside the Song window and reduces them to a single
sequence Chunk.

At any time, you can take your music freely back and forth from
Sequence form to Song form with these two commands to help you
create your music.

To create a sequence Chunk from the Tracks Overview window:

1. Select the Segments that you wish to be in the Chunk.

Alternately, you can select the region from the Tracks List by
highlighting track names and setting a region in the Edit bar. See
the section earlier for information about selecting segments. You
can even select non-adjacent segments.

2. Choose Create Chunk from the Tracks Overview window mini­
menu.

A dialog box appears.

Name: | Untitled

1HI0011

Song select number:

Set End time:
® Auto (downbeat of next measure)
O Manual: [ | 0:00:00:001 

plus |~p| timecode bits

assign times to the
start of the sequence...

I 11 Measures
I 0:00.001 (T'< Real time

Frames

Cancel

3. Type in a name for the Chunk.
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Deleting Chunks

Choosing the Current
Playback Chunk

4. Type in an End Time to determine the length of the Chunk.

By default, the end time is determined by the length of the
selected region.

5. (Optional) Type in any other information you wish about the Chunk.

6. Press OK to confirm your choice or Cancel to withdraw the
command.

To delete a Chunk, click its name to highlight it and choose Delete
from the Chunks window mini-menu. To delete several Chunks at
once, highlight the name of each one as described in the Selecting
Chunks section above. You can Undo this command.

At any given time, one Chunk is designated as the current playback
Chunk. This Chunk is the only one you can play and record into.
Certain functions, such as recording, are available only to the
currently play-enabled Chunk. For example, if a sequence is play-
enabled, its Tracks window has record-enable buttons by its tracks. If
a song is play-enabled, one of its component sequences can be
record-enabled. Only that sequence’s Tracks window will have
record-enable buttons.

You may edit any Chunk in the file at any time regardless of whether
it is play-enabled or not.

To play-enable a Chunk:

■ Click the play-enable button to the left of the Chunk name.
It will turn solid black. The play-enable buttons of the
other Chunks will be hollow.

OR

■ Click the Skip buttons as needed until the chunk’s name is
displayed in the Info bar in the Consolidated Controls
panel
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Opening Chunks

| Chunk: Seq-1

100:00:00:00 g

ITFiK-Z
J'C4
A#7

Current sequence or song

Performer also provides two different methods of play-enabling
Chunks from a remote device.

The first method is with the Chunk select remote controls found in
the Remote Controls window, where each Chunk is assigned a
Macintosh key and MIDI event. You play-enable a Chunk by pressing
its corresponding Macintosh key or sending its corresponding MIDI
event from your MIDI keyboard (or controller). Please refer to the
chapter The Remote Controls Window for more information.

The second method is Chunk Select, which allows you to cue Chunks
for playback by sending a MIDI Song Select message from a MIDI
controller. The Chunks window column S’# displays the Song Select
number that, when received, will cue the corresponding Chunk for
playback. If a Chunk has no Song number assigned, the S~ column
displays a single dash (-).

Most hardware sequencers and some MIDI keyboard controllers can
send and receive Song Select messages. Simply send a Song Select
message as instructed in that module’s documentation. If the open
file contains a Chunk assigned to the Song number in the message,
that Chunk will be play-enabled. If more than one Chunk has the
same Song number assigned, the one highest in the Chunks list will
be cued.

When used in combination with the Chunk Chaining buttons in the
Consolidated Controls panel, a Song Select message cues the
corresponding Chunk to be play-enabled or played back.

Each sequence Chunk has its own Tracks window, and each song
Chunk has its own Song window. To see a Chunk’s Tracks or Song
window, click the Chunk’s name to highlight it and choose Open
Chunks from the Chunk window mini-menu. Or just double-click the
Chunk name.
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Rearranging the Order
of Chunks

You may rearrange the Chunks in whatever order is most meaningful
to you. To change the position of a Chunk in the Chunks list:

1. Press the type icon of the Chunk you want to move.

A grey outline appears delineating the Chunk.

2. Drag the mouse to the position where you want the Chunk.

You can use the grey outline to determine the position of the
Chunk.

3. Release the mouse button.

The Chunk will appear in its new position.

Rearranging the order of the Chunks is a useful organizational tool. In
addition, it lets you determine the Chunks’ default cueing order when
using the Skip, Cue Chunks, and Chain Chunks buttons described
later in this chapter.

Changing the Name of a
Chunk

To change the name of a Chunk:

4. Option-click the name of the Chunk.

A small box will pop up.

5. Type the Chunk name in the box.

6. Press the Return key to confirm the name or Command-period to
cancel it.

You can use the Enter or down arrow key to approve the change
and edit the next Chunk name in the list. You can also use the up
arrow key to approve the change and edit the previous Chunk
name in the list.

Entering Comments To enter or modify comments for a Chunk:

1. Click in the comments field to the right of the Chunk name.

A box appears. If you’ve already entered a comment for the
Chunk, the entire comment appears highlighted in the box.

2. Enter or edit the comment.
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Auto Versus Manual End
Time

3. Click OK to confirm the changes you’ve made and close the
comments box, or click Cancel to discard the changes.

Press the down arrow key or the Enter key to approve the changes
you've made and move to the comment for the next Chunk. The
up arrow key likewise moves to the comment for the previous
Chunk.

When entering or editing a comment, the Return key starts a new line
of text instead of approving the changes as usual in Performer’s user
interface.

The Chunks window field Encl Time displays either the automatic,
Performer-generated ending time of the Chunk, or a time that you
have entered manually. It’s important to understand how this time
affects your music.

Performer offers two ways of playing Chunks sequentially: by
arranging Chunks vertically and horizontally in the Song window,
and by Chunk Chaining using the Cue Chunks, Chain Chunks, and
Skip buttons in the Consolidated Controls panel. The End time shown
for each Chunk in the Chunks window affects these two types of
chaining differently.

When a Chunk is in a Song window, the Chunks window End time
does not affect the playback length of the Chunk. Within a song, a
Chunk will play every note it contains, regardless of its Chunks
window End time. What it does affect is column placement. Columns
appear automatically at the End time of each Chunk dragged into the
Song window. This makes it easy to place Chunks end to end.

For example, a Chunk whose last attack is at 4141322 will have an
automatic End time of 5111000. When this Chunk is dragged into a
Song window at time 1111000, a column will appear at 5111000,
making it very easy for you to place the next Chunk in a metrically
logical location. If you prefer a 5-bar phrase, just change the End time
to 6111000. The end column will appear at 6111000, even though the
Chunk only plays through four measures.

Again, remember that the Chunk End time does not affect playback
in the Song window, only the column placement.
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Building a Song with
Chunks

When using the Chunk controls in the Consolidated Controls panel,
you'll find that each Chunk’s End time does affect its playback length.
For example, clicking Play with the Chain Chunks button enabled
causes playback of one Chunk after another, each Chunk playing
until the Counter reaches that Chunk’s End time. Phrases, even notes
that normally would last through the End time will be cut off. You can
avoid this by setting a Chunk’s End time to be later, thereby building
sustain into the Chunk’s play length.

In summary: regardless of auto/manual status, in the Song window
the End time determines the Chunk’s ending column location but not
its playback length. During Chunk Chaining, playback actually stops
at the End time.

For more information about the Song window and Chunk cueing,
please refer to the chapter, The Song Window and "The Chunk
Control buttons” on page 78, respectively.

To build a Song out of Chunks in the Chunks window, drag their type
icon into a Song Window. For complete information, please refer to
the next chapter, The Song Window.
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Copying tracks From
One Sequence Chunk to
Another

Use the following procedure to copy between sequences that have
the same track layout (i.e. the same number of tracks, preferably with
the same MIDI channel assignments). If the sequences have different
track layouts, this procedure trill not work correctly. See the chapter
The Tracks Window for more information.

To copy from sequence A and paste into sequence B:

1. Activate the Tracks window of sequence A.

Click anywhere in it to activate it.

2. Set the start and end times in the Edit bar to define the region you
wish to copy.

To select the entire sequence, simply double-click the word Edit
in the Edit bar.

3. Highlight all the track names in Sequence A.

Either click and drag over them, or choose Select All from the Edit
menu.

4. Select Copy from the Edit menu.

As a short cut, press command-C.

5. Activate the Tracks window of Sequence B.

6. Set the Start Time in the Edit bar to the time at which you want to
paste the material into sequence B.

7. Highlight all the track names in Sequence B.

8. Select Paste from the Edit menu.

The information from Sequence A is pasted into Sequence B at the
Edit Bar Start Time of Sequence B.
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Chapter 15 The Song Window

In Performer, a song is a collection of Chunks. The Chunks that make
up a song are displayed in that song's window, plotted on a grid
beneath a horizontal, non-linear time ruler. The Song window is the
work space in which you arrange the Chunks in time and in relation
to other Chunks.

Qusck Reference

By dragging and using standard Edit commands on the Chunks, you
can arrange them to graphically represent the order and
combinations in which you want them to play back. What you see is
what you will hear: adjacent Chunks will play one after the other, and
stacked (vertically aligned) Chunks will play simultaneously.
Arranging in the Song window can done in real time while the song
is playing back.

Chunk Grid: Serves as a workspace in which you arrange Chunks. The
grid will not scroll when you drag a Chunk to one of the borders; this
allows you to delete a Chunk by dragging it out of the window, or to
drag a Chunk to another Song window.
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Song Chunks and Sequence Chunks: Represent songs and sequences that
have been dragged into the Song window. Click a Chunk once to
select it, twice to open its Song or Tracks window. Change a Chunk’s
name by option-clicking it in the Chunks window. If a Chunk's name
is longer than its Chunk icon, the first several letters will be followed
by an ellipsis.

A Chunk’s size in the Song window is relative to that of the other
Chunks in the window, rather than absolute. Chunks shorten and
lengthen so that within a region, the longest Chunk always appears
longest in the Song window. A Chunk’s length can be changed in the
Chunks window by setting the Chunk’s End time to manual mode
and typing in the new value.

The standard Edit commands (Cut, Copy, Paste, Erase, and Undo)
and dragging operations can be used on Chunks in the Song window.

Marker Strip: Displays the Markers associated with the open song.
Every' marker in a song automatically produces a column at the same
time location in the Song window.

Time Ruler: Indicates the position of each Chunk in any combination
of measure I beat I tick, real, and SMPTE time formats. The Ruler is
non-linear, meaning the ruler markings denote Chunk Start and End
times rather than regular time units. Choose which time formats are
displayed using the Song window mini-menu selections Measures,
Rea! time, and Frames.

Insert button: Produces a dialog box prompting for a
measure I beat I tick, real, or SMPTE time at which a column should be
inserted. Clicking this button is a shortcut for choosing Insert Column
from the Song window mini-menu.

Song name: Displays the name of the song to which the window
belongs. The song name can be changed by option-clicking it in the
Chunks window.

Record-enabled Chunk: Displays a record-enable button in its handle.
indicating that if the Song is play-enabled and the Record button is
pressed, it will begin to record data at its start time. Only sequence
Chunks can be record-enabled.
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The Song Window Mini­
menu

Copy Conductor Tracks
Edit Conductor Track
Record Enable Conductor Track

Insert Column
Set Record Sequence
Merge Markers
Delete Markers
Merge Chunks to Sequence...

v Eli Measures
©Real time
■"■Frames

Column: Serves as a placement guide for Chunks. Columns appear
automatically at the end of each Chunk, and can be inserted manually
by choosing Insert from the Song window mini-menu or by clicking
the Insert button in the Song window title bar.

Selected Chunk: Appears inverted to indicate that it has been selected.
Selected Chunks are subject to Edit commands as well as several
Song window mini-menu commands.

The Song window has the following mini-menu items:

Copy Conductor Tracks: Copies the Conductor tracks of the selected
Chunks into the song’s Conductor track. In time regions where two
or more Chunks are selected, the information from the uppermost
Chunk is used. Markers are not included in the copy; use the Merge
markers command to copy Chunk markers into a song.

Edit Conductor Track: Opens a Graphic or Event list editing window of
the song’s Conductor track.

Record-enable Conductor: Enables the Conductor track of the song for
recording Tap Tempo information.

Insert Column: Produces a dialog box prompting for a measure, real,
or SMPTE time at which to insert a new column. Clicking the Insert
button in the Song window title bar is a shortcut for choosing this
item.

Set Record Sequence: Enables or disables the selected sequence for
recording within the song. Only one sequence can be record-enabled
at a time. Choosing this item with more than one Chunk selected, or
with a Song selected, produces a warning message.

Merge Markers: Merges the markers of all selected Chunks into the
song’s marker list. Locked markers are not included in the merge.

Delete Markers: Deletes from the song's marker list any markers that
are identical to markers in the selected Chunks.
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Merge Chunks to Sequence...: Produces the Merge Chunks dialog box,
which contains the following options:

Columns

Inserting Columns

&

Copy all trades creates a sequence containing all tracks of the
selected Chunks, and places this new sequence in the Chunks
window.

Merge tracks with identical names creates a sequence containing all
tracks in the selected Chunks, merges any tracks with identical
names, and places this new sequence in the Chunks window.

Measures/Real time/Franies: Determine which time formats should be
displayed in the Song window Time ruler. Choosing a format checks
or unchecks it; the checked formats are displayed.

When you place a Chunk in the Song window, its Start and End times
are marked with columns. Columns serve as Chunk placement guides.
A column following a Chunk does not necessarily mean that the
Chunk will stop playing back at that point.

For example, Sequence-1 is four measures long and has an End time
of 5111000. Dragging it into a Song window produces a column at
the End time, and playback stops there as well.

Now let’s say that Sequence-1 contains ten bars of music, but the End
time has been manually set to 5111000. Dragging the sequence into
a Song window still produces a 4-bar Chunk and a column at
5111000, but the Chunk plays back all the way to measure ten.

Before you can place a Chunk at a time location in the Song window,
there must be a column at that location. Columns appear
automatically at the Song’s Start time, at each marker in the Song, and
at the end of each Chunk dragged into the Song window. You can
also insert columns manually.

To insert a column manually:

1. Click the Insert button in the Song window title bar.

You can also choose Insert Column from the Song window mini­
menu. A dialog box appears, prompting you for a location in
measure I beat I tick, real, or SMPTE time.
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2. Click the radio button next to the time format you wish to use, and
enter the time.

3. Click OK to confirm your entry or Cancel to cancel the Insert.

If you click OK, the dialog box disappears and a column appears
at the time you specified. If you click Cancel, the dialog box
disappears and the Song window is unchanged.

4. Place a Chunk at the new column location.

Performer automatically eliminates columns that do not have an
associated Chunk or marker. So, if you don’t place a Chunk at the
new column you have just inserted, the column will disappear
when the grid redraws.

Creating a Song Songs are created by dragging Chunk icons from the Chunks window
into a Song window, then arranging the Chunks in any playback
order and combination you wish. This can be done before or during
playback of the Song. To create a song:

1. Choose Add Song from the Chunks window mini-menu.

A new, empty song is added to the Chunks list.

2. If necessary, add other songs and sequences to the Chunks list.

For this example we’ll assume you have at least two Chunks in
addition to the song just added.

3. Open the Song window by double-clicking the song’s name in the
Chunks window.

The song’s window opens. Alternately, you can open the Song
window by clicking its name, then choosing Open Chunks from
the Chunks window mini-menu.

4. Grab a Chunk by clicking the icon to the left of its name in the
Chunks window.

Release the Chunk in the Chunk Grid beneath the ruler. The
Chunk left-justifies to the column at 1111000, and a new column
appears to the right of the Chunk. Note that you cannot drag the
song into its own Song window.
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5. Continue dragging, option-dragging, and editing Chunks in the
Song window to arrange them as desired.

Chunks that you place end to end will play sequentially; stacked
Chunks will play simultaneously.

When placing Chunks into songs, keep the following in mind. Every
Chunk has its own Chunk Start time. Every copy of the Chunk uses
this time and will reflect any changes made to the original.
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Specifically, a Chunk's Event List window times relate to its own start
time, say 1111000, even if that Chunk has been dragged into a song
to start playing at measure 300.

Similarly, each sequence Chunk has its own Tracks and Event Editing
windows, and each song Chunk has its own Song window. Every
copy of a Chunk is affected by the edits performed in these windows.

Playing Back a Song To play a song:

1. Click the title bar of the Chunks window to activate it.

2. Click the play-enable button of the song you wish to play.

3. In the Consolidated Controls panel, click Play.

Adjacent Chunks in the song play sequentially; stacked Chunks
play simultaneously.

For another method of playing Chunks one after the other, see “The
Chunk Control buttons” on page 78.

Scrolling During
Playback

The Auto-Scroll command in the Basics menu can make the Song
window scroll during playback. In addition, the window will
automatically open to the current playback location of the sequence.
Please refer to the Auto-Scrolling section in the Playback chapter for
more information.

Editing in the Song
Window

Once you’ve placed a few Chunks into a song, the Song window­
offers powerful editing capabilities to help you arrange your music.
These operations can be done before or during playback.

Select the Chunk by clicking it, or by dragging a marquee around it.

Open a Chunk’s Song or Tracks window- by double-clicking its icon.

The standard Macintosh Edit commands (Cut, Copy, Paste, Erase, and
Undo) can all be used on Chunks selected in a Song window, with
the following results.

Cut: Removes each selected Chunk from the Chunk Grid and places a
copy on the Clipboard.

Copy: Places a copy of each selected Chunk on the Clipboard.
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Recording MIDI
into a Song

Paste: Makes the cursor change to a mini-likeness of the chunk to be
pasted. Click at the desired column location in a Song window to
complete the paste operation.

Erase: Removes each selected Chunk from the Chunk Grid; nothing is
placed on the Clipboard. You can also delete a Chunk from a Song
window by dragging it out of the window.

Undo: Returns the Song window to its state prior to the last Edit or
dragging operation. For example, dragging a Chunk to a different
column enables the Undo command and updates it to Undo Drag.
Choosing Undo Drag returns the dragged Chunk to its original
position.

Dragging the Chunk to a different column changes its playback start
time. Dragging a Chunk out of the Song window deletes it from the
Song. You can drag a Chunk from one Song window to another.

Option-dragging, consistent with Performer’s graphic track editing,
leaves a copy of the Chunk at its original location. Option-dragging a
Chunk out of the Song window does not affect that Song window;
you can option-drag a Chunk into another Song window, resulting in
a copy in each window.

Dragging and Option-dragging do not cause the Song window to
scroll. This allows you to drag a Chunk out of a Song window, either
to delete it or to move it to another song. If you need to place a
Chunk at a time location not displayed in the Song window, Cut or
Copy the Chunk, use the scroll bars to move to the desired location,
insert a column if necessary, and Paste.

Performer lets you record both MIDI and tempo information into a
song. MIDI information can be recorded into any sequence Chunk
contained in the song, and tempo information can be recorded into
the song’s Conductor track.

To record MIDI information into a song's component sequence;

1. In the Chunks window, play-enable the Song into which you wish
to record.
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2. Double-click the song’s name to open its Song window.

If the song's window was already open, the window activates.

3. In the Song window, click the sequence Chunk into which you wish
to record.

The Chunk highlights; any Chunks that were selected are
deselected.

4. Choose Set Record Sequence from the Song window mini-menu.

The highlighted sequence now has a record-enable indicator in its
handle. If you change your mind, choose Set Record Sequence
again to disable the Chunk.

5. Double-click the record-enabled Chunk.

The Tracks window for the Chunk opens. Each track has a record­
enable button.

6. Record-enable one of the sequence’s tracks by clicking its record­
enable button.

If you wish to record on several tracks, use Multi-Record as
described in the Recording chapter.

7. Locate the point in the song at which you want to begin recording.

Use the motion controls in the transport controls or set the
Counter directly.
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8. Click Record.

Recording Tempo
Information into a Song

The song begins to playback. Performer starts recording at the
record-enabled Chunk’s starting lime or the Auto-Record In time
and continues indefinitely or until the Auto-Record Out time.

9. When you are finished, click Stop.

To hear the recorded material, rewind as necessary and click Play.

Performer also lets you record tempo information into a song. Say
you’ve created a song in which you'd like to have several tempo
changes, even rubato passages. Tap Tempo is the most musical way
to add these changes to your song — you don’t need to guess at the
beats per minute, or even the measure numbers where the changes
should occur.

Each Chunk has its own Conductor track, containing the tempo, key,
and meter information for that Chunk. Instead of recording MIDI
events, the Conductor track records tempo information while slaved
to Tap Tempo. Tap Tempo lets you control the beat by simply playing
a MIDI event like a metronome that Performer follows and can
record. If recorded, the information becomes a tempo map that can
be edited in the Conductor track and that Performer will follow
during subsequent playbacks of the sequence.

You can even record tempo information into the song's Conductor
track while recording music into one of the song's component
sequences.

To record tempo information into a song's Conductor track:

1. In the Chunks window, play-enable the Song into which you wish
to record.

2. Double-click the song’s name to open its Song window.

If the song’s window was already open, the window activates.

3. Choose Record-Enable Conductor from the Song window mini­
menu.

The song’s Conductor track is now record-enabled; this is
indicated by a check mark in the mini-menu next to Record-
Enable Conductor.
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4. Choose Receive Sync from the Basics menu.

The Receive Sync dialog box appears.

5. Click the radio button next to Tap Tempo, then choose the port,
MIDI channel, MIDI event, and countoff beats you wish to use.

Choose an event/channel combination that you are not using as a
Remote Control. Refer to the Remote Controls chapter for
information on Remote Controls assignments, and to the Receive
Sync chapter for specific information on Tap Tempo.

6. Optional: Click the sequence Chunk into which you wish to record.

If you wish to record MIDI data while recording tempo
information, you must record-enable the desired sequence within
the song, and track(s) within that sequence.

7. Choose Set Record Sequence from the Song Window mini-menu.

The highlighted sequence now has a record-enable indicator in its
handle. If you change your mind, choose Set Record Sequence
again to disable the Chunk.

8. Double-click the record-enabled Chunk.

The Tracks window for the Chunk opens. Each track has a record­
enable button.

9. Record-enable one of the sequence’s tracks by clicking its record­
enable button.

If you wish to record on several tracks, use Multi-Record as
described in the Recording chapter.

10. Choose Slave to External Sync from the Basics menu.
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11. Click Record and begin tapping the specified tap event at the
desired tempo.

The Play button remains grey until you have tapped the specified
number of countoff beats. Performer starts recording at the record-
enabled Chunk’s starting time and continues indefinitely or until
the Auto-Record Out time, whichever is sooner.

12.When you are finished, click Stop.

To hear the recorded material, rewind as necessary and click Play.

Chunking Hints The Song window can be used to quickly create special effects. Try'
some of the suggestions here to get started.

Creating an Echo Effect To add an echo effect to part of a song, try the following.

1. Find the Chunk(s) that you wish to echo.

Note the starting time of each according to the Song window Time
Ruler.

2. Click the Insert button in the Song window title bar.

The Insert Column dialog box appears, prompting you for the
measure, real, or frame time at which a column should be
inserted.

3. Enter a measure time about 50 ticks after the original Chunk’s
starting time within the Song.

To create an echo that plays in rhythm with the original Chunk,
use divisions of the beat (for example, a quarter note=480 ticks so
try 60, 120, or 240). A column will appear in the Song window at
the time you specify.

4. While holding down the Option key on your Macintosh keyboard,
drag the Chunk to the new column.

A copy of the Chunk remains at the original location.

5. Play back the song to hear the result.

Experiment with different amounts of delay to achieve the best
effect.
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Exporting a song to
other music software
programs

Managing Markers in a
Song

Chunking and
Synchronization

Song Chunks cannot be directly converted to other file formats, but
you can use the Merge Chunks to sequence command in the Song
window mini-menu to convert the song into a sequence. The
resulting sequence can be converted to any alternative file format
available in the Save As command dialog box. See “Saving a
sequence in another format” on page 51.

Every Chunk has its own Markers list. (See “The Markers Window” on
page 245 for an introduction to markers.) Markers sen e many
functions, from simple references to auto-locators. You'll often find
when you place a Chunk into a song that it would be useful to see
the Chunk’s markers in the context of the whole song. The Merge
Markers command in the Song window mini-menu lets you do just
that. Simply select all the component Chunks whose markers you’d
like to copy into the song, and choose Merge Markers. All unlocked
markers in the selected Chunks now exist in the Song, and are
displayed in the Song’s marker strip and Markers window.

You can just as easily delete a Chunk’s markers from a song. Select
the Chunks whose markers should be removed from the song and
choose Delete Markets. Performer compares the song's markers to
those of the selected Chunks, and removes any that match up. The
marker list of the Chunk is not affected. Keep in mind that once you
merge markers of a Chunk into a song, dragging the Chunk to a
different location will not move the markers. Further, selecting the
relocated Chunk and choosing Delete Markets will not have any
effect, as the markers are no longer associated with the Chunk.

Markers can be of great help when building a song or score because
Performer automatically generates a column in the Song window for
each marker. You can use the Song’s Markers window to create a list
of section markers, which will become Chunk placement columns in
the Song window. Marker-generated columns are particularly useful
for placing Chunks at hit points, which can be created during
playback using the Record Hits command found in the Markers
window mini-menu for each Chunk.

Chunking (arranging Chunks in the Song window) is the ideal
method of playing multiple Chunks while slaved to external sync.
Firstly, Chunking allows seamless transitions between Chunks within
a song. What’s more, these Chunks can be edited independently even
after they have been dragged into a song.
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Matching chunk start
times with their location
in a song

Secondly, rather than having a different Start time and tempo map for
each Chunk within a song, the song itself has one Start time and one
Conductor track to govern all component Chunks. In fact, when
placing Chunks into a song you could use Set Chunk Start, found in
the Chunks window mini-menu, to change each Chunk s start time to
correspond with its playback location in the song. The Chunk’s
SMPTE start times will shift accordingly, matching those in the Song
window Time Ruler. If a Chunk contains tempo changes, you can use
the Copy Conductor tracks mini-menu command to make every
SMPTE time of a component Chunk match those of the song that
contains it.

Finally, film scoring applications benefit greatly from the Song
window. Using the Record Hits feature in the Markers window, you
can create a series of SMPTE hit points associated with a song. Each
hit point becomes a marker. Because Performer inserts a column in
the Song window for each Marker, you automatically have a Chunk
placement guide at each hit point in the song.

When Chunks are placed in a song, the song itself has one Start time
and one Conductor track to govern all component Chunks. When
placing Chunks into a song, you may want to change each
component Chunk’s start time to match its playback location in the
song. Then, the SMPTE start time of the component Chunk will be the
same as its SMPTE location with respect to the song.

To match a component Chunk’s SMPTE start time with the song that
contains it, look at the column where the Chunk starts in the Song
window and make a note of the SMPTE time of the column. Then, set
the Chunk’s start time to be the same SMPTE time location. For
information about how to set the start time, see “Setting the start time"
on page 90.

If the component Chunk contains tempo changes, you can use the
Copy Conductor tracks mini-menu command to copy all of its tempo
changes into the song’s Conductor track, making every SMPTE hit
point of a component Chunk match its SMPTE time in the song that
contains it.
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Auto Versus Manual End
Time

The Chunks window field End lime displays either the automatic.
Performer-generated ending time of the Chunk, or a time that you
have entered manually. It’s important to understand how this time
affects your music.

Performer offers two ways of playing Chunks sequentially: by
arranging Chunks vertically and horizontally in the Song window.
and by Chunk Chaining using the Cue Chunks, Chain Chunks, and
Skip buttons in the Consolidated Controls panel. The End time shown
for each Chunk in the Chunks window affects these two types of
chaining differently.

When a Chunk is in a Song window, the Chunks window End time
does not affect the playback length of the Chunk. Within a song, a
Chunk will play every note it contains, regardless of its Chunks
window End time. What it does affect is column placement. Columns
appear automatically at the End time of each Chunk dragged into the
Song window. This makes it easy to place Chunks end to end.

For example, a Chunk whose last attack is at 4141322 will have an
automatic End time of 5111000. When this Chunk is dragged into a
Song window at time 1111000, a column will appear at 5111000.
making it very easy for you to place the next Chunk in a metrically
logical location. If you prefer a 5-bar phrase, just change the End time
to 6111000. The end column will appear at 6111000, even though the
Chunk only plays through four measures.

Again, remember that the Chunk End time does not affect playback
in the Song window, only the column placement.

When using the Chunk controls in the Consolidated Controls panel.
you’ll find that each Chunk’s End time does affect its playback length.
For example, clicking Play with the Chain Chunks button enabled
causes playback of one Chunk after another, each Chunk playing
until the Counter reaches that Chunk’s End time. Phrases, even notes
that normally would last through the End time will be cut off. You can
avoid this by setting a Chunk's End time to be later, thereby building
sustain into the Chunk’s play length.

In summary: regardless of auto/manual status, in the Song window
the End time determines the Chunk's ending column location but not
its playback length. During Chunk Chaining, playback actually stops
at the End time.
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chapter 16 Click and Flash

The Click

Enabling the Click

The Click is the audible indication of the Metronome beat; the Flash
is the visible indication. The Click is produced on the Macintosh's
internal speaker or through MIDI on a drum machine or other sound
module; the Flash appears in a small box on the screen. Both are
accessible via commands on the Basics menu. The Click & Countoff
Options feature in the Basics Menu allows you to control the click s
source and volume. In addition, it provides options for when the
click occurs e.g. only while recording or only during the countoff.

The Click “clicks” on the beat. The beat is determined by each meter
change in the Conductor track. If the Click is on, Performer will click
at the beginning of every measure. The first beat of every' measure is
slightly accented. The subsequent clicks in the measure depend on
how the metronome click value is set in the current meter. To learn
more about setting meters, see chapter 33, “Change Meter”.

To turn on the Click, choose Click from the Basics menu or press
command-5. To turn off the Click, choose it again. When the Click is
on, the Click menu item will be checked.

To adjust the Click volume independently of the Macintosh beep
sound, use the Click & Countoff Options dialog box described in the
next section. You can also amplify the Click by routing the audio
output from the speaker jack on the rear of your Macintosh to your
sound system. See the following two sections for more information.
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Click & Countoff
Options

The Click & Countoff Options dialog box, chosen from the Basics
menu, provides several options for controlling the click.

Source of Click

You can also open this dialog by double-clicking the Count-off
button.

Source of click specifies how the click is generated. Select one or both
options.

The Internal speaker option produces a click sound from the
computer’s internal speaker.

(Note: the internal speaker click does not work on
some Macintosh models with certain system configura­
tions.)

The MIDI option will send a MIDI note for every click. For this option,
you must set up an instrument to receive these notes and play a ‘click'
sound of your choosing. For example, a drum machine could play
rim shots, or a synthesizer could play short beeps.
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Click options

Countoff options

Data for MIDI Click

Always click makes the click audible whenever Performer is counting
off, playing or recording.

Only during countoff makes the click audible only during countoff
measures. When playback or recording begins, the click will fall
silent. See "The Countoff button” on page 74 for more information
about the countoff.

Only when recording makes the click audible only when Performer is
in record mode. If the Countoff button is enabled, Performer will also
click during the countoff in this mode.

No accent removes the accent from the first click in each measure. This
option affects both the internal speaker click and the MIDI click.

Countoff n measures lets you type in the number of measures you want
for the countoff. The countoff will be in the same meter as the current
playback location in the main counter.

Countoff only when recording causes the countoff to occur only before
recording, not before playback or any other function.

These options define what notes are played if the MIDI option is
selected. The Accented note is played on the first beat of each
measure; the Normal note is played at all other times. Each note has
four parameters:

First, you specify the device that will play the accented and
unaccented click by choosing it from the pop-up menu provided. The
list of devices in the menu is provided by7 FreeMIDI.

Pitch is the pitch of the note, expressed as a scale letter (A-G) (use the
number sign # to represent a sharp, or a small letter ‘b’ to represent a
flat) and an octave number. For example, 03 means middle C.

Velocity is the attack (on) velocity, expressed as a number from 0-127.

Gate specifies the length of the note in milliseconds (thousandths of a
second).
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Internal Speaker Click
Volume

The Internal speaker click volume slider controls the volume of the
Macintosh speaker click. To increase the click volume, drag the slider
to the right; to reduce volume, drag to the left. Or, press the + or -
buttons at each end of the slider.

Setting Click & Countoff
Options

Performer’s click volume is not affected by the volume slider in the
Control Panel. This allows you to attenuate (or turn off) the warning
‘beep’ sound and turn up the click. See the section later in this
chapter called Routing the Internal Speaker Click to Your Sound
System for information about how to set the system beep and speaker
click to different volumes.

ic3~ On some models of the Macintosh, this slider has no
effect.

To set the Click & Countoff Options dialog box:

1. Select Click & Countoff Options... from the Basics menu.

2. Select Internal speaker and/or MIDI mode.

Click in the corresponding check box to select a mode. Both
modes can be selected simultaneously. If both modes are turned
off, no click will be generated, even if Click is selected from the
Basics menu.

3. Select a preference for when the click occurs.

Refer to the beginning of the Click & Countoff Options section for
an explanation of each option.

4. Adjust the Internal speaker click volume, if necessary.

Drag the slider to the right to increase the click volume; drag it to
the left to decrease volume. This slider controls the click volume
and is independent of the speaker volume setting in the Control
Panel.
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5. Set the MIDI click parameters, if necessary.

Routing the Internal
Speaker Click to Your
Sound System

To change a parameter, click in its box, then type in the new
values. You can also set the value over MIDI from your controller
keyboard.

6. Click on the OK button to confirm your settings, or on the Cancel
button to cancel the changes.

You can amplify the Internal speaker click by routing the audio
output from the speaker jack on the rear of your Macintosh to your
sound system. When this is done, the Macintosh warning beep
sound, which is much louder than the click, will also become
amplified. To avoid an over-amplified beep, you can turn down (or
turn off) the beep sound using the Macintosh speaker volume slider
in the Control Panel in the Apple menu.

To turn down the system beep sound:

1. If you are currently running Performer, save your work and choose
Quit from the File menu.

The Macintosh will return to the Finder.

2. Choose Control Panels from the Apple menu.

Important-, this must be done before you start up Performer. The
Control Panel volume cannot be adjusted when Performer is
running.

3. Open the Sound control panel.

4. Drag the Speaker volume slider down as low as you wish.

If you drag the volume to zero, the system beep will be turned off,
and the menu bar will flash in its place.

5. Close the Control Panel by clicking in the close box in the upper
left corner.

After the above procedure, re-start Performer and turn up the speaker
click volume slider in the Click & Countoff Options dialog box.
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The Flash The Flash is the visual counterpart to the Click: it "flashes" on the
beat. This is a silent way of giving you the current tempo.

Placing the Flash on Top
of Windows

To turn on the Flash, choose Flash from the Basics menu or press
command 6. The Flash window will appear.

The Flash gives you the tempo by alternating the highlighting (the
black rectangle) from side to side. When the Flash is on, the
command will be checked on the Basics menu.

The Flash only works when the computer screen is set
to black and white.

The Flash feature may not work on some models of
the Macintosh. If this is true for the Macintosh you are
currently running Performer on, the Flash menu item
will be grayed out.

The Flash window is different than other windows in Performer:
when enabled, it will always appear on top of all other windows.
This is necessary to keep the Flash window timing completely
accurate.

To move the Flash window, press the mouse anywhere in the
window and drag the window to a new location. Performer will
remember where you place it when you save the file.

Sometimes when the Flash is in front of another window, it will not
move when you try to grab it with the mouse. In this situation, click
on the push down box of each window behind the flash. It will then
move freely.

To close the Flash window, choose Flash on the Basics menu again.
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Chapter 17 The Memory Window

Basics

Using the Memory
Window

As you record and edit music in Performer, more and more of the
Macintosh’s RAM (random access memory) is required to store it. If a
great deal of recording or editing is done in a file, or if you are
loading sequences from other files, it is possible to run out of
memory. It is therefore desirable to monitor how much memory is
being used to keep this from occurring.

The Memory7 window displays the current amount of free memory. It
is constantly updated to supply you with a running status of available
memory.

The Macintosh’s memory usage is dynamic: it changes according to
the current task. The memory profile will vary widely with different
activities. For instance, if you use a section of the program for the first
time, you may find that you suddenly have 30K less of memory. This
is the space that the program utilizes for that particular part of the
program.

For these reasons, it is a good idea to keep a watchful eye on the
Memory window. If you have 150K or less memory7 free, save often;
a long recording or editing pass may use up all your free memory7.
Also, avoid editing and recording large regions; instead, work with
smaller sections. Performer does its best when memory7 is low but in
such circumstances there is a possibility of a system crash and the
loss of any work you haven’t saved.

To open the Memory window, choose Memory from the Windows
menu. The window appears.

720K free

Memory
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i To move the window, click in any part of it except the close button
| and drag it to the desired location. 'Ib save space, the Memory

window has no title bar.

To close the Memory window, click in the window’s close button.
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Chapter 18 The MIDI Monitor Window

Opening the MIDI
Monitor Window

Basics

The MIDI Monitor window displays incoming MIDI activity, broken
down by input device, MIDI channel, and type of data. This feature
is handy when testing hardware, tracing problems in your MIDI
system, or monitoring time codes or other special MIDI data. The
MIDI Monitor window will function whether active or inactive.

Choose MIDI Monitor from the Windows menu; the window will
appear. To move it, click in the title bar and drag to the desired
location. To close the MIDI Monitor window, click in the window’s
close button.

The MIDI Monitor window consists of one panel for each FreeMIDI
system device that has its MIDI OUT connected to the MIDI interface
in your current FreeMIDI configuration. It therefore displays any
devices that have the ability to send MIDI data to Performer. Each
panel contains 16 MIDI channel indicators that are normally
unhighlighted; they highlight to indicate incoming MIDI data.

data from the

MIDI channel 5.

FreeMIDI devices appear

here in the MIDI monitor.

MIDI channel

ity indicators
Modem and printer port

- -------------real-time data lights.

Displays incoming sync.

MIDI system common data indicator. Lights up when

system exclusive data is being received from the device.
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The window includes real-time indicators for the modem port and
printer port.

Reordering Devices in
the MIDI Monitor

MIDI Monitor window
mini-menu

•"The Input Filter has no impact on the MIDI Monitor
window’s display.

The MIDI Monitor window only displays incoming
MIDI activity—only data being received by Performer
from somewhere else—not outgoing data being sent
by Performer.

Channel Activity indicators display MIDI activity by MIDI channel.
Most normal MIDI data will cause one of these indicators to light up;
for example, pressing a key or moving the pitch bend wheel on a
controller keyboard will cause the corresponding Channel Activity
Indicator to turn black.

The System Common indicator, labelled “Co ”, indicates incoming
system common data, such as system exclusive data, tune request,
Song Position Pointer, and Song Select commands.

The System Real-Time indicator, labelled “Rt”, includes MIDI beat
clocks, DTL (Direct Time Lock), DTLe (Direct Time Lock enhanced),
and System Reset commands. This type of data is used to synchronize
devices, and is generated by most sequencers, drum machines, and
SMPTE-to-MIDI converters. System real-time data is not assigned to a
particular channel and therefore has just one indicator per port.

Active sensing messages, which are sent by some brands of MIDI
equipment, are ignored by the MIDI Monitor window. To see if your
equipment is “on-line” and working correctly, send note data and
observe the Channel Activity indicators, or test it in the FreeMIDI
Setup application.

To rearrange the order of the devices in the MIDI Monitor, just drag
the panels up or down.

The MIDI Monitor window has the following mini-menu commands:

Show all input devices
This command makes the MIDI Monitor display all devices in your
FreeMIDI configuration file that have a MIDI OUT connected to a
MIDI IN on the interface.
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Show controllers only
This menu command makes the MIDI Monitor display only those
devices in your FreeMIDI configuration file that have the Controller
device property assigned to them.

Clear all devices
Removes all devices from the MIDI Monitor display so you can start
from scratch again.

Individual Device names
The mini-menu also displays the name of each device in your studio.
Select the name to individually display it. Select it again to hide it.
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Chapter 19 The Markers Window

Quick Reference

The Markers window allows yon to display and edit the markers for
a Chunk (sequence or song). A marker is a name attached to a
particular location in a Chunk. The Markers window can be used as
a sophisticated autolocator, allowing you to move to a location
instantly. The Markers window provides an easy way to organize
your music; markers are visible in the Event Editing windows for each
track, and are useful in quickly specifying editing regions. Markers
are particularly useful when working with film and video; you can
record them in real time to mark hit points, then use the Markers
window as an intelligent cue sheet. With the commands in the
Change menu you can then adjust meters and tempos to
automatically align musical cues to the hit points.

Position indicator

Locked indicatorMarker location FreeMIDI seek point

Marker name

Time display: Displays the marker locations in your choice of measure,
real or frame time. Click on a location to change it. Select the formats
you wish to use from the bottom of the mini-menu.

Locked indicator: Indicates that the marker is locked to real/ frame
time. Toggle from locked to unlocked and back by clicking in the
lock column next to the marker name.
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Mini-menu

Add
Lock
Unlock
Record hits
Shift locked markers
Generate VTP streamers

Eh Measures
©Real time
■■Frames

Delete

Basics

I FreeMIDI Seek point: FreeMIDI provides eight seek points to which it
I will cue all FreeMIDI applications. You can designate up to eight

markers as FreeMIDI seek points. Type in the desired seek point
number in this column.

Names: Click on a marker’s name to select it. Option-click on the
name to change it. Drag over several names to select several markers.
Use Shift-click to select or deselect several non-contiguous markers.

Position indicator: Displays the current location in the Chunk. Drag on
the indicator to move it. Click anywhere in the grey region to move
the indicator to a marker. Moving the indicator changes the current
location in the Chunk.

Add: Adds a new marker at the current location. Hold down the
Option key while choosing Add to add several markers at once. A
dialog box will appear, prompting you for the number of markers to
be added.

Delete: Deletes the highlighted markers.

Lock: Locks the highlighted markers to real/frame time. A small lock
icon appears by the marker’s location to indicate that it is locked.

Unlock: Unlocks the highlighted markers.

Record hits: Enables a special mode such that during playback, every'
time you hit a key on your controller instrument, a marker will be
added at that location.

Shift locked markers: Shifts all highlighted locked markers by a time
offset.

Generate VTP Streamers: Causes Performer to trigger a Video Time
Piece streamer for each designated marker in the Markers list.

Measures/real time/frames: Choosing these will determine what type of
time will be displayed in the marker list. When chosen, the menu
entry becomes checked. Choosing it again unchecks it.

The Markers window is used to display and manipulate markers.
Each Chunk listed in the Chunks window has its own set of markers.
The title bar of the Markers window displays the sequence or song to 
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Opening a Markers
Window

which the markers belong. Each marker consists of a name and a
time location it is associated with. Markers are listed in chronological
order. You can display the location of a marker in any combination of
measure time, real time and frame time.

Normally a marker remains at the same measure time location when
you change the tempo of the sequence. In this case, changes in
tempo or structure will affect the real and frame time location of the
marker. However, when working with film or video, it is useful to
assign a marker to a certain event in the action (termed a “hit point").
Such markers are necessarily attached to real or frame time locations.
Since the location of the event in the film or video will not change,
the location of the marker must not either, even if you change the
tempo of the music. Performer lets you ‘lock’ markers to real/frame
time locations. When you change tempos or edit your Chunk, the
real/frame time location of locked markers will stay the same and the
measure location will change to reflect the new tempo or structure.

Each Chunk has its own set of markers in the Markers window. To
open the Markers window for a Chunk:

1. Open the Chunks window.

Do so by choosing Chunks from the Windows menu.

2. Make sure no Chunks are highlighted.

To unhighlight them, briefly click a type icon in the left column. If
a Chunk is highlighted, a Markers window will be opened for that
Chunk.

3. Play-enable the Chunk whose Markers window you wish to open.

Do so by clicking the play-enable button to the left of the Chunk
name.

4. Choose Markers from the Windows menu.

The title bar displays the name of the Chunk to which the markers
belong.
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Switching between
sequences and songs

The Markers window shows the markers for an individual sequence
or song. If you are working with multiple sequences and songs in a
file, you can easily switch between them by command-clicking the
name of the sequence in the Marker window title bar as shown
below:

Scrolling During
Playback

Adding Markers

Changing the Name of a
Marker

The Auto-Scroll command in the Basics menu can make the Markers
window scroll during playback. In addition, the window will
automatically open to the current playback location of the sequence.

To add a marker, choose Add from the Markers window mini-menu.
The marker’s location will be the same as that showing in the
Counter. To add several markers at once, hold down the Option key
while choosing Add from the mini-menu. A dialog box will appear
prompting you for the number of markers to be added.

The size of the name box is limited by the size of the Markers
window. If you wish to enter a lot of text for a marker name, resize
the window first.

To change the name of a marker:

1. Option-click on the marker name.

A small box will pop up.

2. Type in the name for the marker.

3. Press the Return key to approve the change or the Command and
period keys to cancel it.

You can use the Enter or the down arrow key to approve the entry
and move to the next marker name, or the up arrow key to
approve the entry and move to the previous marker name.
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Changing a Marker Time
Location

To change the time location of a marker:

1. Click the time location you wish to change to pop-edit the value.

2. Enter the new values.

Setting the Counter to a
Marker Location

Use the Tab key to move between time fields.

3. Press the Return key to enter the time or the Command and period
keys to cancel your change.

You can use the Enter or down arrow key to approve the change
and move to the time location of the next marker; use the up
arrow key to approve the change and move to the lime location
of the previous marker.

If you change the measure time of a marker, even a locked marker,
the real and frame times will also change. Changing the real or frame
time of a marker will cause the measure time location to change.

Since the markers are listed in chronological order, a marker may
seem to vanish when you edit its location. In such cases, the marker
has simply been moved out of the visible portion of the marker list.

You can easily set the current location displayed in the Counter
window to the location of a marker. This lets you to move to a
location by its name instead of time, making it unnecessary for you to
keep track of a number of arbitrary measures and times.

To move to the location of a marker:

*■ Press on the position indicator and drag it to the
marker you want. You can scroll the list up or down by
dragging the position indicator slightly past the top or
bottom of the marker list.

Or

<*" Click in the grey area of the position bar to the left of
the desired marker. The indicator will appear at that
position. The position indicator will appear under the
pointer and you can drag it to the desired marker. This
saves you having to scroll around to find the position
indicator.
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Selecting Markers To select a marker, highlight it by clicking on its name. There are
several methods for selecting several markers at once:

To select several adjacent markers, press on a marker name and drag
over the desired names. All markers dragged over will highlight.

To select several non-adjacent markers, hold down the Shift key and
click on the names of the markers you wish to select. They will
highlight.

To deselect markets when more than one are highlighted, hold down
the Shift key and click on the markers you wish to deselect. They will
unhighlight.

To extend the currently selected region, shift-drag over the desired
end location.

Using Markers to Define
an Edit Region

You can use markers to define a region to be edited: instead of typing
the Start and End locations in the Edit Bar of the Tracks window, you
can use the Markers window and Remember Times command on the
Basics menu.

To define a region using the Markers window:

1. Select a group of markers such that the beginning and end marker
of the group are at the starting and end times of the region to be
edited.

If the marker with the start time you want for the edit region and
the marker with the end time for the region are not adjacent, you
must select all markers in between. Click on the starting marker
and drag down until you reach the ending one.

2. Choose Remember Times from the Basics menu.

Pressing Command-R is the keyboard equivalent for Remember
Times. The locations of the starting and ending marker are
remembered.

3. Activate the Tracks window.

Click once on it.
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4. Click once on the word Edit in the Edit Bar.

Markers in the Event
Editing Window

Markers in the Song
Window

Merging Markers in the
Song Window

Removing Merged
Markers from a Song

The location of the first highlighted marker will be entered into
the Start time and the location of the last highlighted marker will
be entered into the End time in the Edit Bar.

Yon can now use one of the commands from the Edit or Region
menus. You can also use this procedure to transfer marker times to
tile Memory and Auto Record bars in the Consolidated Controls
panel.

Markers appear in the Event Editing windows for each track in a
sequence. The name and location may not be edited in any of the
Event Editing windows. Flowever, commands on the Edit menu may
be applied to markers only in the Conductor track Event Editing
windows.

You can use the View Filter to determine whether or not markers are
displayed in the Event Editing windows.

Markers in a song are displayed in the Markers Strip in the song
window. Performer automatically generates a column in the Song
window for each marker.

Markers can be of great help when building a song or score because
you can use the Song’s Markers window to create a list of section
markers, which will become Chunk placement columns in the Song
window. Marker-generated columns are particularly useful for
placing Chunks at hit points, which can be created during playback
using the Record Hits command.

You’ll often find when you place a Chunk into a song that it would
be useful to see the Chunk’s markers in the context of the whole
song. The Merge Markers command in the Song window mini-menu
lets you do just that. Simply select all the component Chunks whose
markers you’d like to copy into the song, and choose Merge Markers.
All unlocked markers in the selected Chunks now exist in the Song.
and are displayed in the Song’s marker strip and Markers window.

You can just as easily delete a Chunk’s markers from a song. Select
the Chunks whose markers should be removed from the song and
choose Delete Markers. Performer compares the song's markers to
those of the selected Chunks, and removes any that match up by both 
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Editing Markers in the
Conductor Track

Locking and Unlocking
Markers

Shifting Locked Markers
in Time

name and location. The marker list of the Chunk is not affected. Keep
in mind that once you merge markers of a Chunk into a song.
dragging the Chunk to a different location will not move the markers.
Further, selecting the relocated Chunk and choosing Delete Markers
will not have any effect, as the markers in the song no longer match
the markers in the Chunk.

You may apply any of the Edit menu commands (Cut, Copy, Paste,
etc.) to markers only in the Conductor track for the Chunk. Select the
Conductor track in the Tracks window and set the Start and End times
in the Edit bar before invoking one of the Edit commands. Locked
markers cannot be edited in the Conductor track. See the TIk
Conductor Track and Edit Commands chapters for more information.

Markers can be connected to a real or frame time location such that
they will retain that location if the tempo is changed: they can be
“locked” to the location. If the tempo is changed, the measure time
location of the marker will change.

When a marker is unlocked, it sticks to a specific measure/beat/tick,
and its real time location is flexible. When a marker is locked, it sticks
to a specific real/SMPTE time, and its measure location is flexible.

To lock a marker, click on it to select it and choose Lock from the
Markers window mini-menu. You can lock several markers at once.
To unlock a marker, select it and choose Unlock from the Markers
window mini-menu. To toggle a single marker between locked and
unlocked states, click in the lock column next to the marker’s name.

The Shift Locked Markers command on the Markers window mini­
menu lets you shift the times of highlighted locked markers by the
amount you specify. Unlocked markers which are selected are
unaffected by this command.

This feature can be useful if the film or video you are working with
has been recut and the locations of the events have moved slightly. It
is generally useful when changing the real/frame time locations of
markers by a uniform amount.
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To shift the times of locked markers:

Recording Hits

1. Select the markers you wish to shift.

Unlocked markers will not be affected by this command. Yon can
include them in your selected markers group without affecting
them.

2. Choose Shift Locked Markers from the Markers window mini­
menu.

A dialog box will appear.

3. Specify whether to advance or delay the markers.

Advancing markers moves them to earlier times, delaying them
moves them to later times. Click on the radio button next to the
desired option.

4. Choose whether to enter the shift amount in real or frame time.

Click on the radio button next to the desired option.

5. Enter the amount of time by which you wish to shift.

Click in the text box and type in the number.

6. Click on OK to confirm your entry or Cancel to ignore it.

You can use the Enter or Return key to confirm the entry or the
Command and period keys to cancel it.

New markers can be entered in a sequence during playback by
striking a key on your MIDI controller instrument. The time location
of each marker corresponds with the time in the Counter when the
key is struck. This is a very useful feature for recording cue points or
hits while viewing film or video.

To create markers during playback:

1. Move to the location at which you wish to start playback.

If slaved to an external master device, this step is not necessary:
Performer will locate automatically when you start the master.
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i 2. Choose Record Hits from the Markers window mini-menu.

A dialog box will appear.

3. Specify whether you want the markers to be locked or unlocked.

4. Press OK to confirm your choice or Cancel to cancel it.

Once you press OK. Performer will start playback. If in external
sync mode, the Play button will turn grey until the master device
is started.

5. Press a key on your MIDI controller every time you wish to enter a
marker.

A marker will be entered at the current time in the Counter.

6. To stop entering markers in this way, press the Stop button in the
main transport controls.

Using the Auto Stop feature in the Consolidated Controls panel
will also stop this type of marker entry. If you are in external sync,
note that stopping the master device does not take Performer out
of the Record Hits mode; you must press stop in Performer to end
recording hits.

Hints Below are some helpful hints for using Markers.

Composing and
Arranging

Markers provide a useful tool for labeling structural sections of a
piece of music. The music can be recorded first and markers added
afterwards or markers can be entered first to lay out the structure of
the sequence before recording. In the latter case, markers can be
used as a kind of musical outline for the structure of the piece.

Markers can be used to quickly rewind to the beginning of a section.
They can also be used as structural place holders to mark the ends of
unfinished sections.

Since markers can be cut, pasted, merged, etc., in the Conductor
Track, they can be moved around with the rest of the data as a
sequence grows and changes. You can move them separately from
the rest of the data if you wish.
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Film and Video Scoring

Streamers and the Video
Time Piece™

Use the Edit Filter to specify if markers can be affected by Edit menu
commands. In general, it is best to keep the markers box unchecked
in the Edit Filter. Check the box only when you know you will be
cutting, pasting, etc. markers; uncheck it after you have finished to
prevent unwanted changes.

If you are not working with time code, you will probably not need to
display real or frame time in the Markers window.

Markers make an excellent cue sheet for planning out or displaying
the structure of your score. They can show you the relationship
between time locations in the film and measure locations in the
music. You can adjust meters and tempos until the metrical beats of
the sequence line up satisfactorily with important visual events. This
can all be done before recording a note of music.

In addition to using markers to define the structure of your score, you
may want to add markers for visual cues and hit points. The Record
Hits feature is especially suited for this. These markers should be
locked since their time location corresponds to a frame location.
Once locked, the measure time location of the marker will be
updated if you change the tempo and meter. The frame location will
not change.

If the time code on the film or video should change due to restriping
after assembly or editing, you can use the Shift Locked Markers
command on the Markers window mini-menu to adjust the times of
the hit points you’ve already labeled with markers.

If you have Mark of the Unicorn's Video Time Piece, you will
definitely want to read the next section, which explains how markers
can be used to trigger streamers.

The Markers window has an additional capability designed for Mark
of the Unicorn’s video post-production device, the Video Time Piece.
The Video Time Piece is a hardware device that can superimpose
graphic images on a video picture, including streamers. A streamer is
a solid white bar that travels across a video screen from left to right
to reach the right-hand side of the screen at an exact hit point.
Streamers help studio musicians and sound effects engineers to
anticipate hit points during video post-production.
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For more information, please refer to the chapter called Performer
and the Video Time Piece.
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Chapter 20 The Event List Window

Performer provides four ways to display and edit the data in each
track of a sequence: the Event List window, the Graphic Editing
window, the Notation Editing window, and the QuickScribe notation
window, together referred to as the Event Editing windows. All of
these windows can be open at the same time for a track, and any
number of tracks can have windows open at any time. This chapter
describes the Event List window. See the next two chapters for
information on the Graphic Editing and QuickScribe notation
windows.

The Event List window displays the MIDI data and other information
in a track as a chronological list of “events”. Examples of events are
notes, controller data, and program (patch) changes. Other
information that occurs in specific time locations can be displayed in
an Event List as well: markers, meter changes, key changes, tempo
changes, and loop points. The Event List window can be used to edit
individual events or select a region of events for editing with menu
commands. Event List windows for different tracks can be open at
one time. Event List windows can be opened, scrolled, and edited
during playback.
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Quick Reference

Track-;! (Seq-lTl

Event--------- > 2111429 /G3

-rlT!nc?*‘

Mini-menu.. Audible Mode Insert button Solo button
\ speaker button -s /

2|3|00b >03 185 164 0|135
_______ «T-F3 185 164 0|125
2|4|259 J’G3 198 t64 [01149
3111300 A3 185 !64 0|211
3|2|021 J'G3 188 164 0|245
3121316 >r~ t64 01'’-- Pop-up box

2|1|256 >F3 ‘ J S5 !64 01135
185 !64 01142

■|2|252 /A3__ £85 164 01172

tl £1 ft&

Event: A row of information concerning a single MIDI message or
Performer command. Events at different locations are separated by a
dotted line. The information displayed for an event depends on its
type; see the section The Event List Display below for more
information.

Mini-menu: Choose items from the mini-menu in the same way as
regular menus. The Event List mini-menu contains commands for
inserting, controlling the display, and more. See the section called
Mini-menu for more information.

Audible Mode speaker icon: Click on this button to activate Audible
Mode. Audible Mode plays back notes one at a time as you click on
them in the Event List. An entire phrase can be played back by
highlighting a region and option-clicking on the speaker icon.

Insert button: Inserts MIDI events into the Event List. Pressing this
button produces a menu of items the can be inserted.

Solo Button: Mutes all other tracks during playback.

Pop-up box: A box that appears when you double-click or option-click
on a field of an event. You can enter a new value for the field.
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Mini-menu Quick
Reference

w___
Set View Filter...
Goto Counter
Goto...
Reinsert...
Legend...

Graphic Editing
Notation Editing
QuickScribe Notation

Ei; Measures
® Real time

Frames

Opening an Event List
Window

I Grow box: Drag this box to resize the Event List window.

Set View Filter: Calls up a dialog box from which you select the types
of events which are visible in the Event List window. The View Filter
applies to all open Event Editing windows.

Goto Counter: Automatically scrolls to the time currently displayed in
the Counter.

Goto: Automatically scrolls the Event List display to a time you specify.

Reinsert: Inserts an event of the same type that you last inserted.

Legend: Opens a window that shows what each kind of MIDI event
looks like in the Event List.

Graphic Editing: Opens the Graphic Editing window for the track.

Notation Editing: Opens the notation editing window for the track.

QuickScribe Notation: Opens the QuickScribe notation window for the
track.

Measures/Real time/Frames: These checkable entries control the types
of time displayed in the Event List.

If the Event List is already open for a track, you can simply click on
it to activate it. If not, you'll want to open one.

To open an Event List window for a track:

1. Open or activate the Tracks list window containing the track you
wish to edit.

To open a Tracks window', choose Tracks from the Windows
menu. To activate a window already open, click on it.

2. Double-click on the track name.

The track’s Event List window will appear.

You can also open the Event List window by choosing Event List from
the Graphic or Notation Editing window mini-menus.
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Switching to a Different
Track Using the Title Bar
Pop-up Menu

If you have an event list window open for a track, you can switch to
a different track in the same window. To do so:

1. Command-click the track name in the title bar.

A pop-up menu appears as shown below.

Command-click the track name in the title bar to use the pop­

up menu to move from track to track within the same editing

window.

Conductor!
pBass K

f1IH000 J'F»1 4110T64 0,095
J‘Db1 1112164 DIOW’'

Chorus 2
Strings
Brass
Drums
Lush Pad
Moans

/C1 *114164 0|120
1111005 7^52^185 164 01113
1111445” J*F**1 179 164 01096
1111240 J'F»1 177 164 01010
1111247 7F«2 188 164 OH 12
1,11387 J'Ab2 179 164 01001

J>F«1 181 164 01001
1 '21001J- Ab2 1118t A4 -

The Event List
Display

2. Choose the desired track.

The contents of the window changes to the track you select.

The Event List window displays MIDI data and other events
sequentially. There is one event per line in the display. Events which
occur at the same time (such as notes in a chord) will be grouped
together between horizontal dotted lines. The starting time is listed
only for the first event of these groups. Each note is defined by its
attack time, pitch, on velocity, off velocity, and duration.
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This example shows nine notes:

Attack time Velocity

I
Pitch Duration

V T V V
34|4|468 J'EbS 158 *64 01095
35|11000 <f'Db4 160 164 01080

/'Bb3 165 164 01103
J'Bb3 159 *64 01083

________/F**3 163 T64 0|117
35|3[462 J'EbS 166 164 01100
35I4I228 J'AbS 167 !64 0|092
35|4|462 /Eb3 169 *64~ 01120
36111222 J-Eb4 170 *64 0|100

Chord

In addition to MIDI note events, there are other types of events that
are displayed in the Event List as well. These events include other
MIDI commands, like patch changes, and events unique to
Performer, like markers and tempo changes.

The next example shows several different types of events. Some are
MIDI data, like the patch change event, notes, and pitch bend. Others
are Performer-related events, like the marker, key change, and meter
change.

Marker-----------------

Key change————

Meter change-----------------

Patch change-----------------

Mode change-----------------

Notes-----------------

Pitch bend

-1|1|000 9 Prelude
C Minor

--------------6/8 click J.
----------- - #60 60 French Horn
— - Omni off

12141000 /G3 177 190 01240
12151000 /G3 177 190 01240

-12161000 J'G3 177 !90 0|240
13|1|000 /G3 177 190 1 looo
13|5|000 <hEb3 177 190 11000

/•Eb2 177 *90 11000
14|3|000 /G3 177 190 11000

J>G2 177 190 11000
- 14I3I002 * 0

i Rlolnnn h art tan ________
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Scrolling During
Playback

Looping points are also displayed on the Event List. Events within
loop boundaries are indented. Events that will not be played due to
the duration of a previous loop are in italics. See the Looping chapter
for details.

H4iuuu <rb’6 iyy ryij U|24U 
1151000 Mb3 199 +90 2|000

Loop---------------- »-2111000 until 3|1|000 114 times
2)41000 J'F3 199+90 0|240

Notes in the loop-----------------» 2151000 J'F3 199 +90 01240
2161000 JT3 199 +90 0|240

Notes that

won’t play--------------------- »- 499 ys>vy

JEM $24$
a"Zx»wj?7 Jn-g rQQ xtnnri

Event locations can be displayed in measure I beat I tick, real time, or
frame time formats. Any combination of the three types of times can
be displayed simultaneously. To display a certain type of time, simply
check its menu entry on the Event List window mini-menu. To turn
off a format, reselect it from the mini-menu.

zinjuuu : «j jjz.jd : u .uz .to «rro + ! 7U uiznu
2|5]000 \ 0:02.70 = 0:00:02:21 J'F3 155 +90 01240
2161000 i 0:02.87 = 0:00:02:26 J'F3 155 +90 0|240
12141000 = 0:13.03 = 0:00:13:01 /B2

J-G2
155 +90
155 +90

01240
0|240

12|5|000 = 0:13.19 = 0:00:13:05 J'03 155 +90 0(240
12161000 = 0:13.38 = 0:00:13:1 1 J-G3 155 + 90 01240
13111000 = 0:13.57 = 0:00:13:17 /G3

J'EbS
155 +90
155 +90

11000
1 looo

13151000 = 0:14.37 = 0:00:14:11 JT«3 155 +90 1 looo
14|3|000 = 0:15.31 = 0:00:15:09 J'D3 155 +90 1|000
i FlQlnnn = n-t 7 ix = n nn t7 -i z j>akz ; w t on nl?j.n

The Auto-Scroll command in the Basics menu can make the Event List
window scroll during playback. In addition, the window will
automatically open to the current playback location of the sequence.
Please refer to the Auto-Scrolling section in the Playback chapter for
more information.

262 The Event List Window



Selecting Events in the
Event List Window

The following -actions select events:

To select a single event, click once on it.

To select several adjacent events, drag over the desired events. All
events dragged over will highlight.

To select several non-adjacent events, hold down the Shift key and
click on the events you wish to select. They will highlight.

To deselect events, hold down the Shift key and click on the event(s)
you wish to deselect. They will unhighlight.

To extend the currently selected region, Command-click or Command­
drag at the desired end location.

To edit an event, double-click or Option-click on the field you want
to modify. A pop-up box appears in which you can edit the value in
the field.

Tab approves the change you made and moves to the next field in
the same event.

Return approves and completes the changes you made.

Enter approves the changes you make and moves to the same field
in the next event.

the up or down arrow keys approve the changes you make and move
to the same field in the next or previous event.

the left or right arrow keys move from field to field in the event box.

The View Filter The View Filter allows you to specify what types of MIDI information
are displayed in the Event Editing windows. You can open the View
Filter dialog box from the mini-menu in any Event Editing window.
The View Filter affects all Event Editing windows.

The View Filter also determines which types of events are affected by
Edit menu commands when the data is selected in the Event Editing
window. Here’s a simple rule to remember: if you can see an event
in the Event Editing window, it will be affected by edit commands.
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To use the View Filter from an Event List window:

Specifying Controller
Numbers in the View
Filter

1. Choose View Filter from the Event List mini-menu.

A dialog box appears.

® J> Notes
® i On velocities
® t Off velocities

® " Pitch bend

® i Mono pressure ® Markers
® if Poly pressure ® Tempo changes

® S System exclusive ® Meter changes
® Tune request ® Key changes

® A Controllers

® 1 Patch/song changes ® Mode changes

2. Choose the types of data to be displayed by checking the check
box for each.

You can choose all types of data at once by clicking on the “Set
All” button. You can uncheck all the check boxes by clicking on
the “Clear” button. Option-click to check only the check box you
click on, unchecking all others; command-click to check all boxes
except the one you click on. Use the Controllers option to specify
which controller information is displayed.

3. Press OK to confirm your choice or Cancel to cancel it.

When using the View Filter, keep these rules in mind: The View Filter
settings you select will stay in effect until you change them. They affect
all open Event Editing windows. The View Filter settings will ajfect all
edit operations done in the Event Editing windows.

The buttons under the Controller check box in the View Filter allow
you to quickly choose which controller data to be displayed. Click in
the Controllers check box, click on the type of option you wish and
then enter the controller numbers if necessary.
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All: displays all controllers.

■ All except: displays all controllers except the numbers you
enter.

a Only, displays only the controller numbers you enter.

To enter controller numbers for the All except and Only options, click
in the text boxes next to the option and type in the numbers. You can
use the Tab key to move between boxes in the same option.

Goto Counter Choosing Goto Counter automatically scrolls the Event List to the
location currently displayed in the Counter window. This command
is a quick and useful tool for locating specific events in an Event List.
For example, if you hear a wrong note in your music during
playback, stop playback at that point, and then select Goto Counter
in the Event List for the track. This immediately scrolls the Event List
to the point where you stopped, allowing you to find and correct the
mistake quickly.

To use the Goto Counter command:

1. Activate the Event List window for the desired track by clicking on
it.

2. Choose Goto Counter from the Event List window mini-menu.

The list will automatically scroll to the event closest to the time in
the Counter window.

Goto The Goto command on the Event List window mini-menu scrolls the
Event List display to the specified location. It is a quick way to locate
a region of events without having to manually scroll through the
Event List.

To use the Goto command:

1. Activate the Event List window for the desired track by clicking on
it.

2. Choose Goto from the Event List window mini-menu.

You will be prompted for a location to scroll to.

3. Enter a time location to scroll to.
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4. Press OK.

Reinsert

Legend

Graphic and Notation
Editing

The list will automatically scroll so that the event closest to the
time you entered will be at the top.

The Reinsert command inserts an event of the type last chosen with
the Insert command. It works exactly like the Insert button except
that you don’t need to select a type of event from a menu. For
example, if you insert a patch change with the Insert button, the next
Reinsert command will insert a patch change as well. For more
information, see the section called “Inserting events with the insert
button" on page 272. As a shortcut for choosing Reinsert from the
mini-menu, option-click the Insert button.

The legend window can be opened by choosing Legend from the
Event List mini-menu. The legend window defines each icon found in
the Event List.

The Graphic Editing and Notation Editing commands open the
Graphic Editing or QuickScribe notation windows. Data in the track
can be viewed in any one of these three windows. Editing in a
window will affect the data in the track, regardless of which window
you have activated. For example, if you edit a note while in the Event
List window, the change will be displayed in the Graphic Editing
window as well.
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Types of Events There are several types of events displayed in the Event List window.
Most are MIDI data; some are events internal to Performer such as
tempo and meter changes. The type of each event is identified by a
small icon. The following section describes the appearance and
parameters of each type of event.

Notes A note event comprises a start time, a pitch, an on velocity, an off
velocity and a duration. The pilch is expressed as a note name and

J>C3
an octave, e.g. C#4. C3 is middle C on a keyboard, although with
some patches it might sound in another octave. The spelling of the
note name is determined by the key signature you choose.

On velocity is a value that represents how hard a note is struck. The
harder you strike a note, the faster you are pressing it down, hence
the term “velocity". Off velocity is a value that represents the speed
at which a note is released. Many synthesizers don't respond to off
velocities, but some use this information to determine envelope
decay parameters or other effects. Values of on and off velocities
range from zero to 127. You can omit on and off velocities from the
Event List display by unchecking them in the View Filter.

Duration is the time between the attack and release of the note. It is
displayed in quarter notes and ticks, e.g. 31240. Note that this is
different from measure time, displayed in measures, beats and ticks.
There are 480 ticks per quarter note. A note must have a minimum
duration of one tick (01001).

Pitch Bend A pitch bend event comprises a start time and a value. Pitch bend
data causes the pitch of notes being played to change. When a stream

*1132 of pitch bend data occurs, a smooth pitch change can be
approximated. A value of zero signifies no bend, increasing values
bend the pitch up, and decreasing values bend it down. Values are in
the range -8192 to 8191.

There is no specific MIDI standard for how much of a bend specific
pitch bend data causes: each synthesizer may be different. Also, some
synthesizers do not respond to all 16,384 values; adjacent values may
produce the same result.

Patch Change A patch change event has a start time and a patch change number.
When a synthesizer receives a patch change, it changes to the patch

■j 39 specified by that number.
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Song Change

1|1|000 Song *127

Mono Key Pressure

± 56

Patch changes are generally in the range 0 to 127. Some MIDI devices
use the range 1 to 128. In such cases, the patch number displayed in
Performer may be one less than the number on the MIDI module.'
Performer thus would display a zero when a 1 was sent, a 9 when a
10 was sent, etc. Some units have more than 128 patches. Since MIDI
only allows for 128 different patch values to be sent, there is no direct
way to access patches above the 127th one. In this case, there is
usually some way to set up banks (groups) of patches and switch
banks via a “bank select” MIDI command. If this is the case, and the
device has been set up with bank select messages in FreeMIDI, patch
change messages for the device appear with the appropriate bank
select number as shown below. The bank number automatically
appears in tracks assigned to a device that was given the bank select
property in FreeMIDI Setup. (See “Setting up bank select devices in
FreeMIDI” on page 749.) If the track is assigned to a non-bank select
device, no bank number is shown.

(Could be one or two numbers, pop-up list

depending on the MIDI device.)

2111000 1#56 4-0 0 56 TechnoBass

Song changes, also called song select, select songs (a collection of
rhythmic patterns) on drum machines. They have a value range of
zero to 127. Song changes have no channel number when sent over
MIDI: all connected instruments receive them.

Also known as aftertouch or channel pressure, this is actually a
special kind of controller. A mono key pressure event has a start time
and a value between zero and 127. If you continue to press down a
key after you play a note, mono key pressure information is sent. The
harder you press, the higher the value. Mono key pressure can be
used for such things as changing the timbre (tone quality) of a sound
or controlling the amount and depth of vibrato.

Mono key pressure data can be voluminous, filling up memory very
quickly. If you aren’t using mono key pressure information, it is best
to use the Input Filter to filter it out while recording. Because of its 
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i great volume, mono key pressure data can sometimes cause the
I playback speed to slow down when output with a fair amount of

other MIDI data.

Poly Key Pressure

£1119

Controllers

A #64

System Exclusive

□ FO 43 01 05 70 28 32 F7

Tune Request

Tune request

This is similar to mono key pressure except that each key can
generate its own pressure information instead of one pressure level
for the whole instrument. This allows for much more subtle and
complicated effects using aftertouch. A poly key pressure event has a
start time, a pitch and a value between zero and 127.

A controller event has a start time, a controller number which
identifies the device being used (on the MIDI input keyboard), and a
value. Continuous controllers (such as wheels and sliders) are
generally' numbered in the range zero to 63- These have value ranges
from zero to 127. Switch controllers (on/off types like a sustain pedal)
are numbered from 64 to 93 and have values of either On or Off.
Controllers from 93 to 127 are reserved for future definitions.

Each MIDI device can interpret controller data differently. Thus, data
from the same controller might be used differently on two different
synthesizers. To determine how a controller behaves on a particular
unit, consult the owner’s manual, and see the Hints section below.

System exclusive data can be used for a variety of purposes. Each
musical instrument manufacturer defines special kinds of data that
are particular to specific instruments: patch dumps, drum machine
patterns, tuning information, sample data and so forth. System
exclusive data begins with an ID code specifying the manufacturer
followed by the actual data.

Performer lets you view and edit system exclusive data in
hexadecimal (base 16) notation. See the System Erc/zzsVt’e chapter for
more information.

The tune request is used for analog synthesizers, prompting them to
tune their oscillators. It has no value and does not have a channel
number when sent over MIDI: all connected MIDI instruments will
respond to it if applicable.
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Mode Changes MIDI inodes are used to set synthesizers to respond to MIDI data in
different ways. Not all synthesizers respond to all MIDI inodes.

Omni on
Omni off
Mono mode
Poly mode
Local control on
Local control off
All notes off

Omni Mode
A synthesizer is always in either omni on or omni off mode. In omni
on, a synthesizer responds to all data on any channel, i.e. all 16
channels at once. In omni off, a synthesizer responds to data only on
its assigned channel. Usually, you can change this mode on the
synthesizer’s front panel. Some synthesizers allow you to change this
mode via MIDI.

Mono Mode
In mono mode with omni off, a synthesizer splits itself into a number
of independent monophonic synthesizers, each responding to one
channel. The assigned channel number of the synthesizer determines
the channels it responds to. If you had an eight-voice synthesizer
assigned to channel 2, it would respond to data on channels 2, 3, 4,
5, 6, 7, 8, and 9.

In mono mode with omni on, a synthesizer receives data from all
channels but acts as a single voice synthesizer. This combination is
not very useful.

Local Control
A synthesizer is always in either local control on or local control off
mode. In local control on mode, the synthesizer works normally;
notes pressed on the keyboard are played by the synthesizer unit. In
local control off mode, the keyboard is disconnected from the
synthesizer unit. The keyboard sends out data directly through MIDI;
the synthesizer only plays data received over MIDI. This allows you
to use a synthesizer as a controller while simultaneously using its
synthesizer unit to play something else.
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Markers

Bridge

Meter Changes

4/4 click J

Tempo Changes

1121000 J = 172.66

Key Changes

111 lOOO C Minor

Loops

1 All Notes Off
The all notes off message causes all notes that are currently sustaining
to be shut off.

Markers are displayed for reference in the Event Editing windows for
all tracks in a sequence. They cannot be edited in the Event Editing
windows for normal tracks. Unlocked markers can be edited in the
Conductor track. Locked markers can only be edited in the Markers
window.

Meter changes are displayed for reference in the Event Editing
windows for all tracks in a sequence. They can only be edited in the
Event Editing windows for the Conductor track. Meter change events
display the time signature (the number of beats per bar, over the
duration value which gets the beat) and the click value (the duration
value between metronome clicks). See the Change Meter chapter for
more information.

Tempo changes can be displayed and edited in the Event Editing
windows for the Conductor track. Tempo change events display the
duration value for the tempo marking, i.e. which value the tempo is
measured in (quarter note = 90 for example), and the tempo value
itself, which signifies the number of beats per minute. See the Change
Tempo chapter for more information.

Key changes are displayed for reference in the Event Editing
windows for all tracks in a sequence. They can only be edited in the
Event Editing windows for the Conductor track. Key change events
display the name of the key. See the Change Key chapter for more
information.

The loops for each track are displayed in the Event Editing windows
for that track. A loop event displays the start and end lime of the loop
and the number of times the loop is played. A loop event can be
edited in the Event Editing windows for the track that contains it.
Events within loops are indented to the right for clarity. See the
chapter Looping for more details.

2| 11ODO until 4|11000 iinfinite
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Editing in an
Event List

Inserting events with the
insert button

; Commands in the Edit and Region menus work on events in Event
List windows. This gives you the ability to precisely specify which
events to modify. Using the Event List window to edit events allows
you to work with one track at a time.

To edit events in an Event List window, you must first select them,
and then execute an edit or region command. For information on
selecting events, refer to the Quick Reference section at beginning of
this chapter. Selected events turn black to indicate that they arc-
selected. Here are a few important things to remember when editing
in the Event List.

□ Only highlighted events will be affected by the command. Also,
events not visible due to the View Filter setting will not be
affected.

□ The Edit Filter has no effect on highlighted events. Use the View
Filter to display and edit only those events which you wish
to edit. If you wish to use the Edit Filter, select events using
the Edit bar in the Tracks window.

□ The Paste and Merge commands on the Edit menu work as
follows: If one or more events are highlighted, the contents
of the Clipboard are pasted at the time of the first
highlighted event. If no events are highlighted, you will be
asked for the time at which the contents of the Clipboard
should be inserted.

□ The Snip, Repeat, and Retrograde commands do not affect
highlighted events. When using these commands, you must
use the Edit bar in the Tracks window to select events.

13 Markers, key changes, meter changes, and tempo changes can be
edited only in the Conductor track. They' are not affected
when highlighted or when you attempt to edit them
directly in normal Event Lists. This allows you to select
large regions of events without having to worry about
excluding these events.

The Insert button on the Event List window title bar inserts an event
of the specified type. To insert an event:

1. Activate the Event List window for the desired track by clicking on
it.

272 The Event List Window



2. Press the insert button in the title bar.

A menu will appear containing the different types of events you
can insert.

3. Choose the type of event you wish to insert.

(r |rsf ’ . Track-1 (Seq-1)
Note
Pitch bend
Patch change
Controller
Mono pressure
Poly pressure
System exclusive
Mode changes...
Song change
Tune request
Loop

Qj

An event will pop up in front of the Event List.

4. Specify the time at which the event is to be inserted.

If you wish to change other values for the event, use the Tab or
the left and right arrow keys to move between the value fields. For
example, tabbing 3 times in the above example moves the active
field as shown below.

1|1|000 J'C3 |i64 |64 11000
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5. To enter the event, press Return.

Editing Individual
Events

The event will be inserted into the Event List. If you will be
inserting another event of the same kind, press the Enter key
instead of Return. This will insert the event and present you with
another to be inserted. Click outside of the event to cancel the
Insert.

When inserting Mode changes, or System Exclusive data, extra steps
are required. To insert a Mode change, select Mode changes from the
pop-up Insert menu. The pop-up menu will change to display the
options for Mode changes; select the desired command and continue
as described above.

See the System Exclusive chapter for information on inserting this type
of data. See the chapter Change Key for information on inserting key
changes.

To edit any parameter field of an event in the Event List window, hold
down the Option key and click on the field. You can also double­
click on the field. In most cases, a pop-up box will appear
surrounding that field in which you can enter the value you want;
some events display a dialog box.

22111240 J'Ab4 155 190 0|240
22121000 J'Ab4 155 !90 0|240
22121240 J Ab4 155 !90 |0|240
23|11000 JF4 155 t90 41000
XC'H j.ra ‘ iK=; tqn moan

Once you begin to edit events by using pop-up boxes, you can use
the Tab, Enter, and arrow keys to move between fields and events.

Here is a list of the keys you can use when a pop-up box is present:

■ Return enters the value and closes the pop-up box.

■ Command-period cancels the entry.

■ The Enter and Down Arrow keys enter the value and
highlight the same field in the next event.

■ The Up Arrow key enters the value and highlights same
field in the previous event.
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h Tab anil the Right and Left Arrow keys move through each
field of an event.

Changing Event Values
from a MIDI Controller

Remember Times

You can use your MIDI input keyboard to enter values for events.
When a pop-up box is present for a parameter field, if you send an
event over MIDI of the same type as the parameter, it will be entered
into the field. For example, if the pitch field of a note event is
highlighted, playing a note on your MIDI controller will set the
corresponding pitch for the event in Performer.

This technique is particularly useful when you are uncertain of a
value. For example, you can set an on velocity for a note by double­
clicking on the on velocity field so that it pops up, then hitting a key-
on your controller until the note velocity sounds correct. Each time
you hit the key, the new velocity appears in the pop up box; when
you hear the one you want, simply press the Return key to save the
value in the Event List.

The Remember Times command is used to remember the beginning
and end times of selected regions in the Tracks, Event Editing, and
Markers windows.

To remember the beginning and end times of a selected region:

1. Activate the window with the times you wish to be remembered.

2. Select the region whose beginning and end times are to be
remembered.

In a Tracks window, specify' the Start and End times of the region
in the Edit bar; these will be remembered. In an Event Editing
window, select a region of events (see the section earlier in this
chapter on how to select a region of events in the Event List
window; also see the chapter The Graphic Editing Window}: the
times of the first and last events in the selected region will be
remembered. In a Markers window, select a region of markers
(see the chapter The Markers Window): the times of the first and
last markers in the selected region will be remembered.

3. Choose Remember Times from the Basics menu.

The beginning and end times are now remembered.
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Audible Mode

Enabling Audible Mode

4. To insert the remembered times into the Edit, Memory, or Auto
Record Bars, click on the Edit button in the Tracks window edit bar,
or clock on the Memory or Auto Record button in the Consolidated
Control Panel.

Memory | Start: [| 1|i|000 Stop: j| 1111000

*5
Edit | Start: [11 HIPPO End: l|l|1 lOOO

The remembered times will be loaded into the Edit Bar of the Tracks
window if the word “Edit” is clicked on; they will be loaded into the
Memory Bar in the Consolidated Controls panel if the word “Memory”
is clicked on; they will be loaded into the Auto Record Bar in the
Tracks window if the words “Auto Record” are clicked on.

Audible Mode allows you to listen to notes one at a time, or phrase
by phrase, as you highlight them in a Performer track. This feature
appears as a speaker icon in the title bar of each track’s Event Editing
windows. Audible Mode provides an easy, intuitive way to see and
bear an individual note or phrase while you are working in
Performer’s editing windows. Notes can be played back one at a time
by clicking on them individually or as a phrase by highlighting a
region.

Audible Mode playback is similar to pressing the Play button in the
Consolidated Controls panel, including MIDI channel assignment and
velocity information. If you click on a note and don't hear anything
when Audible Mode is activated, make sure that your MIDI
connections are set up properly and that your synthesizer is ready to
receive MIDI data. If MIDI data in a track plays back correctly when
you press the Play button in the Consolidated Controls panel, it will
play back properly in Audible Mode as well.

To enable Audible Mode:

1. Open the Event List or Graphic Editing window for a track.

Either double-click on the track name in the Tracks window, or
click on the track name once and chose Edit from the mini-menu.
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Playing Individual Notes

Playing Phrases

2. To turn on Audible Mode, click once on the speaker icon in the title
bar.

The icon will highlight to indicate that Audible Mode is activated.
When Audible Mode is activated, it affects al! Event Editing
windows.

3. To turn off Audible Mode, click on the speaker icon again.

The icon will deselect to indicate that Audible Mode is turned off.

When Audible Mode is enabled and you click on a note in the Event
Editing Window, the note will simultaneously select and play back on
your MIDI instrument. The note will sustain for as long as you hold
down the mouse button. When you release the mouse, the note will
stop. If you click on a note and drag up or down to highlight adjacent
notes, each note will play individually as it highlights. Notes will play
in the same fashion when you shift-click to highlight discontiguous
(non-adjacent) notes. If you shift-click to deselect an already
highlighted note, the note will play when it unhighlights. In general,
when you highlight or unhighlight a note, it will play back for as long
as you hold down the mouse.

Using the Audible Mode speaker icon, it is also possible to play a
group of notes that are highlighted in the Event List.

To play a phrase:

1. Highlight one or more MIDI events in the Event List window.

You can highlight the events by clicking and dragging, or by shift­
clicking on discontiguous events.

2. Option-click on the speaker icon on the Event List title bar.

The speaker icon does not have to be highlighted. Option­
clicking—even if Audible Mode is not currently enabled—will
cause the highlighted events to play back.

When you option-click on the speaker icon, all MIDI data that are
currently highlighted will play back with the proper duration and
velocities. The tempo of the phrase is determined by the current 
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Playing Chords

tempo slider setting in the Metronome panel. Playback can be
stopped at any time by clicking the mouse or striking a key on the
Macintosh keyboard.

The phrase can be a contiguous (adjacent) group of notes that you
have highlighted by clicking and dragging or a discontiguous group
of notes that you have selected by shift-clicking. Notes that are not
highlighted will not play.

Audible Mode allows you to hear chords one note at a time, all at
once, or only with selected notes. To listen to a chord one note at a
time, enable Audible Mode by clicking on the speaker icon. Click on
the first note of the chord and drag downward while holding down
the mouse button. Or you can start on the last note and drag upward.
Each note in the chord will play as it highlights.

J-C3 193 *64 0|120
177 *64 01120
189 *64 01120
183 *64 01120

1131240 «hA3
/F3
/C3

1141000 /A3 183 *64 0|120
J-F3 190 *64 0|120

Playing MIDI Data Other
Than Notes

To hear the entire chord at once, highlight all of the notes and option­
click on the speaker icon. To hear only selected notes within the
chord, highlight only the notes you wish to hear and option-click on
the speaker icon.

Only notes will play back when you highlight them in Audible Mode.
Other MIDI events such as controllers or pitch bend can be played
with the play-phrase feature. For example, to send a patch change to
a synthesizer directly from the Event List, highlight the patch change
and option-click on the Audible Mode speaker icon. System exclusive
data cannot be played back in Audible Mode. To play back a system
exclusive event, press the Play button in the Consolidated Controls
panel.
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Hints You can use the Event List to find out useful information about the
way your MIDI instruments output data. For example, you can use
the Event List window to determine the controller number for a
wheel, slider, foot pedal, etc. Make sure that the MIDI output from
the device in question connects to the MIDI input of your interface;
then:

1. Locate a controller event in an Event Edit window.

If you can’t find one, insert one.

2. Option-click on the controller number field to make a pop-up box
appear.

3. Move the controller on your input keyboard.

The controller number will be displayed in the pop-up box.

4. Press the Return key to save the event, or the Command and
period keys to close the pop-up box without making any changes.

You can use a similar technique to find the patch numbers that
correspond to each preset on a MIDI module. Make sure that the
MIDI output from the device in question connects to the MIDI input
of your interface; then:

1. Find a Patch Change event in an Event List window.

If you can’t find one, insert one.

2. Option-click on the patch number field to make a pop-up box
appear.

3. Select the preset or patch on the MIDI module.

The patch number box in Performer will display the MIDI patch
number corresponding to the preset.

4. Press the Return key to save the event, or the Command and
period keys to close the pop-up box without making any changes.

You can insert multiple events of the same type quickly by first
inserting the event, selecting a region including the event by setting
the Edit bar in the Tracks window, and then choosing Repeat from

The Event List Window 279



I the Edit menu. This will effectively duplicate the event the specified
i number of times. You can then go back and edit the locations and

values of each event.
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Chapter 21 The Graphic Editing Window

Each track in a Performer sequence can be viewed with the Graphic
Editing window. The Graphic Editing window plots notes, velocities.
and MIDI controller data on a scrolling, piano-roll graph that makes
melodies, chords, dynamics, and tempo changes easy to recognize.
Graphic editing is provided as a visual alternative to the numeric
display in Performer’s Event List window. All tracks can be viewed
with either window at any time.

The Graphic Editing window clearly organizes information by
displaying MIDI data in the center of the window and then
surrounding the data with descriptive information such as loop
indicators, markers, key changes, and meter changes. MIDI data is
placed on two grids flanked by rulers that precisely measure location
and value. Best of all, Performer’s Graphic Editing window lets you
see all types of data—notes, controllers, and pitch bend—in one
window.
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Quick Reference j The diagram below and the following Quick’ Reference section
j describe the basic features of the Graphic Editing window:

Time zoom

Time ruler---------- ►

Pitch zoom

Pitch ruler

Note grid —

Median strip-------- >

Info bar---------- 1

Pitch ruler

scroll bar

Median strip­

move handle

Pointer

coordinates
Event Infor­

mation

Edit

Resolution

Continuous data
grid ruler’

Insert - . Reshape Solo Scrolling

wiper

Continuous Volume controller Selected
data grid events velocity note

Information bar: Displays precise information about mouse pointer
location, currently selected MIDI data, and editing resolution. The bar
is divided into three boxes: the Pointer Coordinates Box, the Event
Information Box, and the Edit Resolution Box.

Pointer Coordinates Box: Displays the mouse pointer's current location
with respect to the Time, Pitch and Continuous Data rulers.

Insert Button: Pops up the Insert menu when clicked, from which any
type of MIDI event can be chosen for insertion.
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Reshape Button: Changes the mouse pointer to a cross hair that
reshapes continuous data curves when you drag over them in the
Continuous Data Grid.

Solo button: Mutes all other tracks during playback.

Event Information Box: Displays the currently selected note as it would
appear in the Event List window. If a region is selected by dragging
in the Time Ruler, this box shows the region’s start and end time. If a
group of events is selected, this box displays information about the
last event that was selected. If a continuous data event is selected.
events of that data type can be viewed alone by clicking the
accompanying Quick-Filter check box.

Edit Resolution Box: Displays the current time resolution for editing.
When the check box is selected, notes and data will ‘snap’ to
locations that correspond to the resolution displayed. If the check
box is deselected, data will not ‘snap to grid’. Edit resolution can be
changed by typing in a different number of beats I ticks, or by clicking
on the note and selecting a duration from the resulting pop-up menu.

Time Ruler: Measures time in any combination of Performer’s three
time formats: measures I beats I ticks, SMPTE time, and real time. The
Time Ruler can zoom in and out to enlarge or reduce the Note Grid
and Continuous Data Grid.

Main Ruler Selector: Changes an auxiliary ruler into the main ruler. The
main ruler is the lowest ruler displayed and determines the time
format for editing. Auxiliary rulers are for visual reference only.

Marker Strip: Displays markers, meter changes, key changes, and
loops. Loops can be edited in this strip. Markers and meter changes
must be edited in the Conductor track or Markers window. No MIDI
data appears in the Marker Strip.

Note Grid: Displays notes as horizontal bars on a time vs. pitch grid.
Only notes are displayed on this grid. Pitch is determined vertically
by the pitch ruler on the left. Location and duration are measured by
the Time Ruler above, with duration determined by the length of the
bar. Notes can be edited with the mouse one at a time, in a group, or
by region.

The Graphic Editing Window 283



Selected Note: When a note is selected, it highlights. Complete
information about the selected note will automatically appear in the
Event Information box at the top of the window. Drag the end of the
note to change its duration.

Median Strip: Displays discrete MIDI events such as patch changes,
mode changes, switch controllers like #64 (sustain), and system
exclusive events. Each type is displayed as an icon, defined by the
Legend window. The Median Strip serves as a border between the
Note Grid and the Continuous Data grid; it can be dragged up and
down with the handles at either end to proportionally resize the
grids.

Median Strip Move Handle: Moves the Median Strip up or down.
Dragging up will shrink the Note Grid and enlarge the Continuous
Data Grid; dragging down will enlarge the Note Grid and shrink the
Continuous Data Grid.

Continuous Data Grid: Displays continuous data as small icons on a
time vs. value grid. Pitch bend, key pressure, controllers, and note
velocities are displayed simultaneously on this grid. An event’s
location is measured by the Time Ruler at the top of the window.
Value is determined by the Continuous Data Ruler on the left. Each
type of continuous data has a unique icon.

Continuous Data Ruler: Measures continuous data events. This ruler can
be toggled between three scales: a controller scale from 0 to 127,
whose origin rests at the bottom of the window; a pitch bend scale
from -8192 to 8191, whose origin appears in the middle of the grid;
and a combination scale that shows both pitch bend and controller
data at once on a -80 to 127 scale. Toggle among the three scales by
clicking on the ruler.

Pitch Ruler: Measures pitch along the vertical axis with a standard
keyboard format. Each C-natural indicates the octave. For clarity,
dotted lines extend to the right from each key: a heavy dotted line for
black keys and a light dotted line for white keys. With the Pitch Zoom
icon, this ruler can zoom in or out to increase or decrease the number
of visible octaves.
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Pitch Zoom Icon: Zooms the pitch ruler in or out. Click on the large
keys to zoom in; click on the smaller keys to zoom out. Four pitch
zoom settings are available. Zooming out allows you to see more
octaves at once. Zooming in allows you to focus on a particular pitch
range.

lime Zoom Icon: Zooms the Time Ruler in or out. Click on the ‘in­
pointing’ arrows in the upper half to zoom in; click on the ‘out­
pointing’ arrows in the lower half to zoom out. Eight time-zoom
levels are available. Zooming out gives you an overview; zooming in
focuses on a shorter period of time at higher resolution. Editing can
be done at any zoom level.

Basics Graphic Editing is available in all tracks, including the Conductor
Track. The piano-roll display of notes and die Continuous Data Grid
allows you to manipulate MIDI data using many of the conventions
established by Macintosh paint programs. For example, you can drag
a note to change its location; you can lengthen the note by dragging
its handle. If the Edit Resolution feature is enabled, the note, when
moved, will ‘snap’ to a time grid. You can select a group of notes by
dragging a selection box over them. When you release the mouse,
notes inside the box will become selected. Most of the features
described in this chapter can be used during playback.

Viewing Data three
different ways

Each track in a Performer sequence contains MIDI data. This data can
be viewed with the Event List window, the Graphic Editing window,
or the QuickScribe notation window. The data in the track is the
same regardless of which window you use. For example, if you edit
data in the Graphic Editing window, the changes you make will be
immediately reflected in the track’s Event List window.

Opening the Graphic
Editing Window

To open the Graphic Editing window for a track:

1. Activate the Tracks window that contains the track you wish to edit.

Click once on the Track window to activate it.

2. Command-double-click the track name.

The Graphic Editing window will appear.

You can also open the Graphic Editing window by choosing Graphic
Editing from the Event List window mini-menu.
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Displaying More Than
One Event Editing
Window at a Time

All three types of Event Editing windows for a single track can be
open at the same time. Changes in one window are immediately
reflected in the other. The current position of each window is
remembered when you save the file.

Clarinet (Seq-

3121120 J'D3 *64 164 01360
3131120 4'03 *64 164 01360

3111000 until 4|1|000 12 times
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Scrolling During
Playback

The Auto-Scroll command in the Basics menu can make the Graphic
Editing window scroll during playback. In addition, the window will
automatically open to the current playback location of the sequence.
Please refer to the Auto-Scrolling section in the Playback chapter for
more information.
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Switching to a Different
Track Using the Title Bar
Pop-up Menu

If you have an event editing window open for a track, you can switch
to a different track in the same window. To do so:

1. Command-click the track name in the title bar.

A pop-up menu appears as shown below.

a

L. Clarinet (Seq-1)------- -------------------------ilk------
| |j Unit = Ji 01120 oVats

Command-click the track name in the title bar to use the pop-up

menu to move from track to track within the same editing window.

------—►
Conductor
Flute
Oboe

h/Clarinet K -1)
Bassoon ~ beats

i . , , I ■ ■ . i ■ , .rti , ■ i ■
Horns
Trumpets
Timpani
LIiolin I
Uiolin II
Uiola
Cello
Bass

The Graphic
Editing Window
Mini-menu

2. Choose the desired track.

The contents of the window changes to the track you select.

This menu is available in the title bar of every' track’s Graphic Editing
window.

Set View Filter: Calls up a dialog box in which you specify types of
events to be visible in the Graphic Editing window. The View Filter
applies to all tracks and affects both the Graphic Editing and Event
List windows.

Goto Counter: Automatically scrolls the graphic display to the time
currently displayed in the Counter. The counter location will appear
at the left-most position in the window.
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Set View Filter...
Goto Counter
Goto...
Reinsert...
Reshape
Legend...
Set Rulers...
Cont. Data Icons...
Set Ptr. Coords...

MIDI Edit
Switches Are Cont. Data

’/Selections use Edit Resolution

Event List
Notation Editing
QuickScribe Notation

Eli Measures
® Real time
■■ Frames

Goto: Automatically .scrolls the graphic display to a time you specify.
which will appear at the left-most position in the window.

Reinsert: Inserts an event of the same type that you last inserted. This
is the same as the Insert command but you are not prompted for the
type of event. This command can also be invoked by option-clicking
on the Insert (I) button on the Graphic Editing window title bar.

Reshape: Changes the mouse pointer to a cross hair that reshapes
selected continuous data curves when you drag over them in the
Continuous Data Grid. This command can also be invoked by
clicking the Reshape button in the title bar.

Legend: Produces a window that shows the icon representing each
type of MIDI event.

Set Rulers: Allows you to configure the Time Ruler in any combination
of Performer’s three time formats: measures I beats I ticks, SMPTE time,
and real time. The main ruler is displayed lowest and determines the
time format for editing.

Cont. Data Icons: Opens the Continuous Data Icons window, which
displays icons for each type of continuous data. This window also
allows you to reassign controller icons.

Set Ptr. Coords...(Set Pointer Coordinates): Allows you to choose what
time and pitch formats will be displayed in the Pointer Coordinates
Box.

MIDI Edit: Allows data in the graphic editing window to be edited
from a MIDI controller.

Switches tire Cont. Data: Causes all controllers, including switch
controllers #64 and above, to be displayed and edited as continuous
controllers. This is useful for MIDI devices, such as MIDI-controlled
lighting consoles, that use all MIDI controllers as continuous
controllers.

Selections use Edit Resolution: Causes the cursor to snap to the edit
resolution when dragging to make selections in the note grid, time
ruler, and continuous data grid.

Event List: Opens the track’s Event List window. 
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i Notation Editing: Opens the track s Notation Editing window.

The Insert
Button

The Reshape
Button

The Information
Bar

QuickScribe Notation: Opens the QuickScribe notation window with
the track displayed in it by itself.

MeasureslReal timelFranies: These checkable entries control which time
formats are displayed in the Information Bar and Event List.

The Insert button appears in the title bar of the Graphic Editing
window. It only appears when the window is in Graphic Editing
mode. When the Insert button is clicked, the Insert menu appears,
from which you can choose the desired event to be inserted by
clicking once on the event type. An event will pop up to be inserted.

Option-clicking the Insert button is just like choosing Reinsert from
the mini-menu.

The Reshape button appears next to the Insert button. When the
Reshape button is clicked, the mouse pointer changes to a cross hair.
When you drag the cross hair over a selected curve in the Continuous
Data Grid, the curve will reshape as you drag. For more information
about reshaping continuous data, see the section later in this chapter
called Reshaping a Continuous Data Curve.

The Information Bar at the top of the Graphic Editing window
appears just below the title bar and is divided into three sections
separated by doubled lines. The sections display precise, numeric
information about mouse location, currently selected data, and
minimum editing resolution. MIDI data in the bar is displayed as it
would appear in the Event List window.

Clarinet (Seq~11
1141280 C3 • 60 I |j 3|2|000 J>Eb3 «55t90 0|240 I QUmt = J 11000 beats

Sometimes, information in each box may extend beyond the space
provided and will be clipped on the right side of the box. If so,
enlarge the Information Bar by dragging the window's grow box to
the right.
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The Pointer Coordinates
Box

The Pointer Coordinates box is the left-most section in the
Information Bar. It displays the current location of the mouse pointer
with respect to the Time, Pitch and Continuous Data rulers. Values in
this box are continually updated as the mouse pointer moves over the
Note Grid and Continuous Data grid, giving you immediate,
numerical accuracy when manipulating data with the mouse.

The pointer’s horizontal coordinate can be expressed in
measures I beats I ticks, SMPTE time, or real time. Which time formats
are shown is determined by the Set Pointer Coordinates menu item in
the Graphic Editing window mini-menu.

To set the Pointer Coordinates box display:

1. Choose Set Ptr. Coords... from the Graphic Editing window mini­
menu.

A dialog box appears.

2. Check the time and pitch formats you prefer.

You can select any time format combination, independent of the
Time rulers that are displayed.

' 77

3. Click OK to confirm your choice or Cancel to cancel it.

13 ,£l ,'r< '-r '■‘s'
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The Event Information
Box

The pointer's time and pitch coordinates will be expressed in each
selected format. For example, if both Measures and Frames are
checked in the mini-menu, the mouse position will be displayed in
both measures and SMPTE time.

The pointer’s vertical coordinate depends on its location: if it is in the
Note Grid, the vertical coordinate may be expressed as a pitch, such
as C3, and its MIDI note number, 60.

If the pointer is in the Continuous Data Grid, the vertical coordinate
is expressed as a continuous data value on one of three scales: 0 to
127, -8192 to 8191, or -80 to 127, depending which is currently
displayed by the Continuous Data Ruler.

If the pointer is in the Median Strip, no vertical coordinate is shown.

The Event Information box displays numerical information about a
single event or region that has been selected. This box displays data
in the same way as it appears in the Event List window. For example,
a selected note will appear with its measures I beats I ticks location,
pitch, on and off velocity, and duration.

11; _

|j 3121000 J'EbS 155 190 0|240 |

If a region is selected by dragging in the Time Ruler, the Event
Information box displays the start and end locations of the selected
region.

£ ,.. __Clarinet k
• 60 |j Start: 2111000 End: 4111000 |jUr,it = J 1

If more than one event is selected by shift-clicking or dragging, the
box displays information about the event that was last clicked.
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When a continuous data event is selected in the Continuous Data

| [jp 1|2|080 A#1 i 100
I . 9 if

Grid, the Quick-Filter check box appears next to the event's data.
When clicked, the check box causes all other data types to
temporarily disappear from the Continuous Data Grid; the selected
type remains visible. For example, if you select a controller -3 event

Quick Filter

check box
and click the Quick-Filter check box, all controller -3’s will remain
visible and other data types, such as pitch bend and velocities, will
disappear. To make the other data types reappear, deselect the check
box.

Information displayed in the Event Information box can be pop-
edited by clicking an item. As normal, the Tab key and arrow keys
move from field to field. Press Return to confirm any changes you
have made, and the event's graphic display will change to reflect the
modifications.

Sometimes, information in this box may extend beyond the space
provided and will be clipped on the right side of the box. If so,
enlarge the Information Bar by dragging the window’s grow box to
the right.

The Edit Resolution Box The Edit Resolution box determines the minimum time unit for
editing. The minimum time unit consists of a duration, such as 240
ticks, or one eighth note. MIDI events, note durations, loops, region
boundaries, Memory-cycle repeat barlines, or any object that can be
dragged horizontally will only move in time increments equal to the
value of the edit resolution unit. Edit resolution only affects MIDI data
when the data is moved horizontally with the mouse.

The Edit Resolution box can be enabled or disabled with the check
box provided. When the check box is selected, the current resolution
unit is shown as a note duration accompanied by a number of beats
and ticks. When disabled, the Unit = and beats indicators become
greyed out and editing occurs at maximum resolution, which is either
one tick, one f rame, or one screen pixel depending on the time zoom
setting.

You can change the edit resolution at any time. To change the edit
resolution:

1. Click on the note displayed in the Edit Resolution box.

A pop-up menu will appear that displays note durations.
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The Time Ruler

2. Select a note duration from the pop-up menu and release the
mouse.

The duration you chose will now be displayed in the box. Note
also that the number of beats and ticks now equals the note
duration.

OR

3. Click on the beatslticks values.

A pop-up box will appear.

4. Type in a number of beats and ticks in the box provided and press
Return to confirm your choice.

Note that when you type in a number of beats and/or ticks, the note
displayed next to the ticks box will grey out if the tick value does not
equal a standard duration, such as 120 or 240 ticks.

Also note that when you zoom in the Time ruler. Edit Resolution may
cause data to seem like it is "stuck”; that is, data will not move when
you try to drag it. This is because the Edit Resolution is larger than the
distance you are dragging. To “unstick" the data, deselect the Edit
Resolution check box. Or hold down the option key while dragging.
Doing so overrides the edit resolution temporarily. The option key
temporarily overrides the current setting of the Edit Resolution check
box.

The Edit Resolution box affects all Graphic Editing windows. It does
not affect the Event List window.

The Time Ruler measures time horizontally for all MIDI data in the
Note Grid, the Median Strip, and the Continuous Data Grid.

Clarinet i
• 60 [j Start: 2|1|000 End: 4111000 |[jUnit=Jl|
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Using the time ruler to
select a playback point

Choosing Time Formats

The Time Ruler consists of a main ruler, which appears just above the
Marker Strip. Auxiliary rulers that display other time formats can also
be displayed above the main ruler.

To help line up MIDI events with the ruler, vertical grid lines extend
downwards from the main ruler, through both grids and the Median
Strip, to the bottom of the window. These hairlines are placed at
regular intervals such that they remain a similar distance apart
between zoom levels.

To help align the mouse pointer with the Time Ruler, a dotted hairline
inside the Time Ruler indicates the current position of the mouse.

You can double-click a segment in the time ruler to make Performer
jump to that location for playback. You can do so when Performer is
stopped or during playback. This is an ideal way to quickly locate to
a desired point with the mouse.

The Time Ruler can display time in any combination of Performer's
three time formats: measures I beats I ticks, SMPTE, and real time. You
can choose which formats to display with the Set Rulers dialog box.

To choose the time format(s) for the Time Ruler:

1. Choose Set Rulers from the Graphic Editing window mini-menu.

The Set Rulers dialog box will appear.
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2. Choose a main ruler and any auxiliary rulers that you prefer.

Changing an Auxiliary
Ruler into the Main Ruler

Zooming the Time Ruler

Zooming

The main ruler appears lowest and determines the time format for
editing. Auxiliary' rulers appear above the main ruler. If the Tempo
Control setting is currently set to the Conductor track, only
Measures can be displayed as the main time ruler.

3. Click OK to confirm your choice or Cancel to cancel it.

To quickly switch an auxiliary ruler into the Main Ruler:

□ Click the auxiliary ruler’s time format icon in the Main
Ruler Selector.

The ruler will become the main ruler and appear at the bottom. If the
Tempo Control setting is currently set to the Conductor track, only
Measures can be displayed as the main time ruler.

The Time Ruler can be zoomed in or out with the Time Ruler Zoom
icon to the left of the ruler. Zooming out gives you an overview by
compressing greater amounts of time into the window; zooming in
focuses on a shorter period of time at higher resolution. See the
following section called Zooming for more information.

The Time Zoom and Pitch Zoom icons allow you to ‘zoom’ the time
and pitch rulers in and out. Zooming in Performer is similar to the
magnification feature found in most Macintosh graphics programs.
When zooming in, objects become larger as the display magnifies a
portion of the screen. When zooming out, objects shrink as the
display encompasses a larger region.

Performer’s zoom feature is based on the same idea; however, the
Time and Pitch Zoom icons allow the time and pitch axes to zoom
independently. For example, you can zoom onl the Time Ruler to see
more measures at one time, and zoom in the Pitch Ruler to focus on
a specific pitch range.

Because pitch and time zooming are exclusive from one another,
notes on the Note Grid will not magnify or shrink in the same manner
as a standard zoom feature. In addition, the grid lines remain
approximately the same distance apart, regardless of the zoom
setting.
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Zooming the Time Ruler

Zooming the Pitch Ruler

The Time Zoom icons zooms the Time Ruler. They appear just to the
left of the Time Ruler. Zooming out gives you an overview by
compressing more measures into the window; zooming in focuses on
a shorter period of time at a higher viewing resolution. The dotted
hairlines extending from the Time Ruler remain approximately the
same distance apart, regardless of the zoom setting.

The Time Ruler provides 8 zoom levels if the main ruler is displaying
measures and beats or real time. It provides 7 zoom levels when the
main ruler displays SMPTE time. When zooming out, notes with
extremely short durations will remain visible.

Editing is allowed at any time zoom setting. However, the current
zoom level may affect the resolution at which events can be edited.
For example, let's say that the edit resolution unit is set to 20 ticks in
the Edit Resolution box. If you zoom the Time Ruler out as far as it
can go, you will not be able to drag a note by only 20 ticks because
one screen pixel, which is the smallest unit of movement on the
Macintosh screen, will equal a time value greater than 20 ticks. So,
even if you move the note as little as possible, you will still have
moved it more than 20 ticks.

In the example above, Performer handles the situation by
constraining location to multiples of 20 ticks. When you move the
note, its new location will become the nearest multiple of 20 ticks,
such as 80, 140, or 420 ticks.

Zoom out
— Zoom in

To zoom out, click once (or repeatedly) on the magnifying glass icon
with the minus sign ( -). To zoom in, click once (or repeatedly) on
the magnifying glass icon with the plus sign ( + ).

The Pitch Zoom icon zooms the pitch ruler and provides four zoom
settings. Zooming out reduces the size of the keys on the ruler,
allowing you to see more octaves at once; zooming in enlarges the
keys, allowing you to focus on a particular pitch range.
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When the Pitch Ruler is zoomed in, notes become larger and the grid
displays a smaller pitch range:

When the Pitch Ruler is zoomed out, notes become slightly smaller
and the grid displays several octaves:

To see smaller notes and larger pitch range, click once (or repeatedly )
on the small keys in the icon. To see larger notes (and a smaller pitch
range), click once (or repeatedly) on the large keys in the icon.

Smaller notes

(larger pitch range)
u is: Larger notes
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Zooming shortcuts

Graphic Editing
Basics

Using the Shift Key to
Constrain Dragging

Here are some zooming shortcuts:

Do this: To zoom as follows:

Command-drag To fill the window with the region
you select

Command-click To zoom out to the next standard
zoom level

Option-click the zoom out button To zoom all the way out

Option-click the zoom in button To zoom all the way in

The time ruler zoom buttons in the Graphic Editing and Notation
Editing window, as well as the pitch ruler zoom buttons, have the
keyboard shortcuts as shown below.

All of Performer’s powerful editing features are available in the
Graphic Editing window. Most editing can be done with the mouse
using familiar actions like clicking, dragging, and shift-dragging. Such
actions can shift data, change note pitch and duration, reshape
continuous data curves, and more.

The sections below describe basic features that you will find helpful
when working in Performer’s graphic environment.

If you hold down the Shift key just before you begin to drag the
mouse, the pointer’s movement on the screen will be constrained to
either the horizontal or vertical axis, depending on the initial
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Option-dragging to
Make Copies

Shift-clicking to Select
Non-adjacent Events

Dragging Multiple Data
Types

' direction of movement. For example, if you click the mouse, hold
I down the shift key, and drag upwards, the mouse will only move up

or down: it will not stray left or right.

Constraining mouse movement in this way is often extremely helpful.
For example, if you want to modify just the pitch of a note without
changing its location, the Shift key allows you to do so by preventing
the mouse from moving left or right.

To constrain the movement of the mouse:

1. Press on an event without moving the mouse.

2. Press the Shift key.

It is very important to press the mouse /in? and then press the shift
key. If you press the Shift key first, you will Shift-click, which
produces a different action (described in the next section).

3. Drag in the direction you wish.

If you drag up or down, the mouse will only move on a vertical
axis. If you drag left or right, the mouse will only move on a
horizontal axis. Movement will be constrained until you release
the mouse.

Similar to Macintosh graphics programs, option-dragging in the
Graphic Editing window leaves the original data unchanged and
places a copy of the data at the destination. Option-dragging is a
convenient shortcut for copying and pasting.

Holding down the Shift key before you click serves as a useful way to
select more than one event. For example, if you have already selected
a note and you want to select another, scroll to the other note (if
necessary) and shift-click on it. It will highlight, and the first note will
remain highlighted.

The shift-click method of selection allows you to simultaneously
select and drag multiple data types horizontally in the Note grid,
Continuous Data grid, Median strip, and Marker strip.

For example, to move a loop containing notes, pitch bend data, and
a patch change, select all four data types by shift-clicking and drag
them to a new location.
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Using Edit Resolution

Selecting a Region
Using the Time Ruler

When the Edit Resolution check box is selected, MIDI data that is
moved or inserted will ‘snap' to positions corresponding to the edit
resolution unit shown in the box. For example, if the current edit
resolution unit is 240 ticks, events that are moved with the mouse will
snap to eighth note positions (every 240 ticks) on the grid. If the Edit
Resolution check box is not checked, events will move freely. For
more information about the Edit Resolution box, please refer to the
section earlier in this chapter called The Edit Resolution Box.

In the Graphic Editing window, a region can be selected by dragging
to the left or right in the Main Time Ruler. The region inside the ruler
highlights, as well as the entire grid beneath, and all visible data
within the region becomes selected. In addition, the start and end
locations of the region are displayed in the Information Bar. Selecting
a region in this fashion is similar to setting the Start and End times in
the Tracks window Edit Bar.

Highlighting a region in this way allows the following commands to
function from the Graphic Editing window: Set Loop, Repeat, Snip and
Retrograde.

Dragging in the Time Ruler is constrained by the current editing
resolution.

To select a region with the Time Ruler:

1. Select the desired edit resolution.

2. Click and drag on the Main Time Ruler.

The start and end locations of the region are constrained by the
current edit resolution. You can drag to the left or right.

• 60 | [j Start: 2|1|000 End: 4111000 | [j Unit = J 1
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Using the Undo
Command

The View Filter

The Undo command in the Edit menu will undo the last action you
executed in the Graphic Editing window. For example, if you move
a note and then change your mind, you can choose Undo More from
the Edit menu and the note will pop back to its original position. The
Undo command is also useful when drawing or redrawing
continuous data curves. If you modify a curve and are not satisfied
with the results, simply choose Undo from the Edit menu or press
command-Z and try again.

In the Graphic Editing window, the View Filter serves two useful
functions. It allows you to control what types of data you can see and
edit in the window. In essence, the View Filter acts like an edit filter:
if a type of data, such as pitch bend, is visible in the window, it will
be affected by editing commands. If the data type is not visible in the
window, it cannot be edited.

The View Filter consists of a dialog box with each type of data listed
next to a check box. If the check box is highlighted, the type of data
will be visible. If the check box is not highlighted, the data type will
not be visible.

To use the View Filter:

1. Choose Set View Filter from the Graphic Editing window mini­
menu.

The View Filter dialog box will appear.

2. Select the check box next to the data types you wish to see.

If you wish to see all data types, click the Set All button. If you
option-click a check box, it will highlight and all other boxes will
deselect. If you command-click a check box. it will deselect and
all other boxes will highlight. If you press the clear button, all
check boxes will deselect.

3. Click Okay to confirm your choice or click Cancel to cancel.

You can change the View Filter at any time.
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The Marker Strip The Marker Strip appears just below the Time Ruler. It displays
markers, meter changes, key changes and loops. It is always visible
and is not affected by vertical scrolling.

nii2/8i |lj Marker-3]

I? Marker-3
12/8 click J)

Markers

The Marker Strip shares the Time Ruler with the Note Grid, the
Median Strip, and the Continuous Data Grid. Therefore, the location
of items in the Marker Strip will correspond with MIDI data displayed
below.

Markers, meter changes, and key changes often occur very close
together or at the same location. In the first example to the left, the
meter change is preceded by a marker, which appears as a bar just to
its left. If you would like to see the entire marker, press it, and the
marker will highlight and pop to the front. If the marker and meter
change occur exactly at the same tick, they are displayed with a list
icon, shown in the second example. If you would like to see the list,
press the list icon, drag downwards and a pull-down menu will pop
open.

In the Marker Strip, a marker appears as a pointer, followed by the
marker’s name. The pointer indicates the marker’s exact location. If
the marker is locked, a lock icon will appear between the pointer and
the marker name.

Markers cannot be edited in the Marker Strip; instead, they can be
edited in the Conductor track or the Markers window. Please refer to
the chapter on the Markers window for more information about
editing markers.

In the Conductor track, markers are displayed in the Median Strip.
Please refer to the section later in this chapter called Graphic Editing
in the Conductor Track for more information.

302 The Graphic Editing Window



Meter and Key
Changes

Loops

Meter and key changes appear in the Marker Strip in much the same
way as they do in the event list window. (Tempo changes are not
displayed in the Marker Strip.) Similarly, they can only be edited in
the Conductor track. Please refer to the section later in this chapter
called Graphic Editing in the Conductor Track for more information.

Loops appear in the Marker Strip as a loop icon followed by a line
that ends in a bracket. The loop icon indicates the beginning of the
loop; the line and bracket represent the duration and end of the loop.

Following the loop, the Marker Strip contains a greyed-out region that
represents the time during which the loop plays. Just like italicized
notes in the Event List display, MIDI data within the greyed-out
region will not play back because data inside the loop plays instead.
Data within the greyed-out region can, however, be edited normally.

Working with
Loops *

To insert a Loop
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When a loop is selected, the Marker Strip area inside of the loop will
highlight, indicating that the loop is selected. Numerical data about
the loop will be displayed in the Event Information bar. When loops
are nested inside one another, the outer-most loop appears above the
loops nested inside it.

Loops can be edited by dragging the loop icon in the Marker Strip
with the mouse or by editing the numbers displayed in the
Information Bar.

To insert a loop:

1. Press on the Insert button in the title bar of the Graphic Editing
window and choose Loop from the menu.

The mouse pointer turns into a cross hair.
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2. Click at the desired start location in the Marker Strip, drag to the
right to draw the desired length, and release the mouse at the end
location.

A loop will appear. Use the dotted hairlines in the Time Ruler to
align the beginning and end of the loop while inserting it.
Information about the loop will appear in the Information bar.

To Edit a Loop To change the location of a loop:

1. Click the loop icon in the Marker Strip and drag left or right to
advance or delay the loop.

The entire loop, from beginning to end, will move when you drag
the loop icon in this fashion. You can align the start or end point
of the loop by watching the hairlines provided in the ruler.

To change the length of a loop:

1. Select the loop by clicking on its loop icon in the Marker Strip.

The loop will highlight.

2. Click the end bracket of the loop and drag left or right to shorten or
lengthen the loop.

Align the end bracket by watching the hairline provided in the
ruler.

The Note Grid The Note Grid is the region in the Graphic Editing window between
the Marker Strip and the Median Strip. It is flanked by the Pitch Ruler
on the left and a vertical scroll bar on the right.

Basics The Note Grid functions like a standard graph. Time extends
horizontally from left to right and pitch stands vertically. Thus, the
higher the pitch of a note is, the higher it will appear on the grid. The
later a note occurs, the farther to the right it will appear on the grid.

The time and pitch axes are measured with a Time Ruler above the
grid and a Pitch Ruler to the left of the grid. The rulers indicate the
exact location and pitch of notes. Grid hairlines extend from each
ruler to aid you in determining a note’s position.
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Scrolling in the Note
Grid

Controlling the
Dimensions of the Note
Grid

Because the size of the Graphic Editing window is restricted, the Note
Grid usually displays only a portion of the track at one time. The
horizontal scroll bar at the bottom of the window moves the Note
Grid to the left and right. The vertical scroll bar just to the right of the
Note Grid moves the pitch axis up and down over the entire MIDI
note range. By scrolling, you can view any region of the track at any
pitch range.

The size of the Note Grid is controlled by the Graphic Editing
window grow box in the lower right hand corner of the window, and
by the Median Strip just below the Note Grid. Drag the grow box to
resize the entire window. Drag the Median Strip up or down with the
move handles provided at either end to decrease or increase the size
of the Note Grid and Continuous Data Grid respectively. For
example, if you drag the Median Strip down as far as it will go. you
will see just the Note Grid:

Displaying Notes Only notes are displayed on the Note Grid, and they appear as
horizontal bars. The vertical position of the bar indicates pitch. The
left end of the bar indicates where the note begins, and the right end
indicates where the note releases. The length of the bar represents
the note’s duration. All of these characteristics can be determined by
the Time Ruler above the grid and the Pitch Ruler to the left.
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When the Pitch Ruler is zoomed in, each bar tapers at the ends to
distinguish it from adjacent notes. When the Pitch Ruler is zoomed
out, notes become smaller and do not taper. Sometimes, adjacent
notes of the same pitch will look like one long note. The example
below shows two adjacent notes when the Pitch Ruler is zoomed out.
When zoomed in, the notes are easily distinguished, as shown to the
right:

Two notes, zoomed out The same notes, zoomed in

Note-on velocity

Note-off velocity

Selected velocity-

The on and off velocities of notes are not displayed in the Note Grid.
Instead, they are displayed in the Continuous Data Grid directly
below the note. An on velocity appears as a small “v” directly below
the beginning of the note bar, and an off velocity appears as a small
“a” directly below the release. If a note is selected, its velocity icons
will be selected with the note.

Displaying On and Off
Velocities

Selected note
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Controlling the Display
of Notes with the View
Filter

The Pitch Ruler

Listening to the Pitch
Ruler

Displaying on-velocities in this manner allows you to edit them in the
same ways as continuous data. For example, you can create a
crescendo or decrescendo simply by editing on-velocities in the
Continuous Data Grid. See Editing Continuous Data later in this
chapter called for more information.

Off-velocities are displayed in the continuous data grid for reference
only; they cannot be graphically edited. On-velocities can be fully
edited.

The View Filter, found in the Graphic Window mini-menu, allows
you to choose whether or not notes are displayed in the Note Grid.
If you have MIDI data in a track, but you cannot see the notes in the
Note Grid, check the View Filter and make sure that the Notes check
box is selected.

The View Filter also controls whether on and off velocities will be
displayed. For example, if the On Velocities check box is deselected
in the View Filter, the “V” icons will not appear on the Continuous
Data Grid.

The Pitch Ruler lies vertically to the left of the Note Grid and
measures pitch. It resembles a standard piano keyboard. Because the
entire ruler cannot fit in the window at once, a vertical scroll bar is
provided to the right of the note grid to allow you to scroll up and
down through the entire MIDI pitch range. Octaves are indicated on
each C-natural key.

To help align notes to the ruler, hairlines extend to the right from
each note, a heavier line for black keys and a lighter line for white
keys.

To help align the mouse pointer with the Pitch Ruler, a moving dotted
hairline inside the Pitch Ruler follows the current position of the
mouse.

When the Audible Mode button (labelled with the speaker icon.) is
pressed in the title bar of the Graphic Editing window, the keys on
the pitch ruler play their pitch over MIDI when you click on them.
When you click on a Pitch Ruler key, a MIDI note with that pitch is
transmitted from Performer to the MIDI channel(s) that the track is
assigned to.
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Zooming the Pitch Ruler

sim

Lengthening the Pitch
Ruler

Inserting Notes

Playback from a track's Pitch Ruler has the same requirements as
regular playback: the track must be assigned to a MIDI channel and
a synthesizer must be set up to receive MIDI on that channel. If you
click on a Pitch Ruler key and don't hear anything, make sure that
your MIDI connections are set up properly and that your synthesizer
is ready to receive MIDI data. If MIDI data in the track plays back
properly when you press the Play button in the Consolidated
Controls panel, the Pitch Ruler keys will play back properly as well.

If you are having trouble getting the Pitch Ruler keys to play, refer to
the Getting Started booklet that accompanies this reference guide.

The Pitch Ruler can be zoomed in or out with the Pitch Zoom icon,
which provides four zoom settings. Zooming out reduces the size of
the keys on the pitch ruler, allowing you to see more octaves at once.
Zooming in enlarges the keys, allowing you to focus on a particular
pitch range.

For more information about zooming the Note Grid with the Pitch
Ruler, please refer to the section earlier in this chapter called
Zooming.

The pitch ruler only displays as many keys as will fit in the window
at the current zoom setting. If you wish to see more keys, resize the
Graphic Editing window and drag the Median Strip down.

You can also view more keys at a time by zooming out the pitch ruler
as described in the previous section.

To insert a note:

1. If you’d like to be able to hear the pitch as you insert the note, make
sure Audible mode is turned on in the title bar.
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2. If desired, set the edit resolution.

Inserting a Note Using a
MIDI Controller

Track-1 (Seq-1)
!□ Unit = 01120 beats------------- ---- >__

'___ LLJ___ Lu
Edit resolution

3. From the insert menu in the title bar, choose Note.

4. Press on the grid at the desired location, and then drag up and
down to specify the pitch and drag to the right to specify the
duration.

Keep dragging until you get the pitch and duration you want,

5. When you have got the pitch and duration you want, release the
mouse to insert the note.

Note insertion always starts with the last duration you inserted.

If you want to insert multiple notes quickly, hold down the shift key
when you first click on the grid each time. This preserves the note
insertion cross-hair cursor rather than switching back to the arrow
cursor.

To determine the pitch of a note by playing the note when you insert
it:

1. Make sure that MIDI Edit is checked in the Graphic Editing Window
mini-menu.

If it is not checked, choose it.

2. Press on the Insert button in the title bar of the Graphic Editing
window,

3. Choose Note from the menu.

The menu will disappear and the pointer will turn into a cross
hair.
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4. Click at the desired time location on the Note Grid, drag to the right
to draw the desired duration, and release the mouse.

You do not need to be careful about pitch location, which is taken
care of in the next step.

5. With the inserted note still selected, press any key on your MIDI
controller.

The inserted note will pop to the pitch that you choose. The
inserted note must still be selected from the previous step for this
step to work. If you press the wrong note, tryr again. You can keep
changing the note’s pitch in this fashion as long as the note
remains selected.

Inserting a Chord Using
a MIDI Controller

To insert a chord:

1. Press the Insert button in the Graphic Editing window title bar.

2. Choose Note from the menu.

The Cursor will turn into a cross-hair.

3. If you would like to insert more than one chord, either hold down
the shift key, or push down the caps lock key.

This will keep Performer in insertion mode after you insert the
chord.

4. Play the chord you wish to insert on your MIDI controller and, while
holding the chord, click where you want the chord to begin and
drag from left to right to the appropriate duration.

The vertical position of your click is not important; the notes are
determined by what you play on your controller. Only the attack
and release of the chord is affect by the cross-hair.

As long as you remain in insertion mode, you can enter chords in this
fashion for as long as you like. You can even alternate between
entering notes with the mouse only or the mouse with a MIDI
controller.
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Selecting Notes

Selecting a Single Note

This section describes how to select notes on the Note Grid. To learn
how to select an entire region by dragging in the Time Ruler, refer the
section earlier in this chapter called Selecting a Region Using the Time
Ruler.

To select a note on the Note Grid:

1. Click once on the note to select it.

Selecting a Group of
Notes

The note becomes highlighted to indicate that it is selected.

To select a group of events:

1. Drag out a selection box over the events to be selected.

A highlighted box indicates the selection area.

2. Release the mouse.

Only events whose attack occurs inside the selection box will
select.
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Selecting all Notes of a
Single Pitch

Editing Notes

Changing a Note’s Pitch
or Location

You can quickly .select all notes of a specific pitch in the note grid by
double-clicking a key on the Pitch ruler. Shift-double-click multiple
keys to select discontiguous pitches. Shift-double-clicking selects or
deselects without deselecting other events.

This feature is extremely handy when working with drum tracks. For
example, if you would like to select all snare drum notes in a track:

1. Click the Audible Mode button.

2. Click the pitch keys on the Pitch Ruler to locate the key that
corresponds to the snare drum.

3. Once you find the snare drum sound, double-click the key.

All the snare drum notes will highlight in the track. You can then
delete them, copy them, drag them up or down to a different note
(sound), etc.

The pitch, duration, and location of notes can be modified on the
Note Grid in much the same way as objects in a graphics program.
Note velocities can be edited in the Continuous Data Grid.

To change a note’s pitch or location:

1. Click the note.

2. Drag the note to a different position and release the mouse.

When you begin dragging, an outline of the note will appear in
place of the mouse pointer. Dragging the note vertically changes
its pitch. Dragging the note horizontally changes its time location.
Duration is not affected when dragging the entire note. When you
release the mouse, the note will pop to the new location.

To help position the note in time, hairlines appear in the Time Ruler
that show the attack and release of the selected note. In addition, the
Pitch Ruler key that corresponds to the note's current pitch highlights
as you move.

If you hold down the shift key before you drag, the mouse will be
constrained either vertically or horizontally, depending on which way
you drag first. This allows you to change the note's pitch without
changing its time location, for example.
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Changing a Note’s
Duration

To change the duration of a note:

1. Click the note once to select it.

2. Position the cursor near the right-hand tip of the note.

! '

3. Drag left or right to shorten or lengthen the note.

Changing a Note’s Pitch
Using a MIDI Controller

To change the pitch of a note with your MIDI controller:

1. Make sure that MIDI Edit is checked in the Graphic Editing Window
mini-menu.

If it is not checked, choose it.

2. Click the note once to select it.

A handle appears at the end of the note to indicate that it is
selected.

3. Press any note on your MIDI controller.

The selected note will change to the pitch you play. This can also
be done with more than one note selected. This is a quick way to
convert a group of different notes to the same pitch.

Editing a Group of Notes Editing a group of notes is similar to editing a single note.

1. Select the notes that you wish to edit.

To select them, drag out a selection box or shift-click each note.
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2. Click one of the notes and drag it to a new position.

Converting More Than
One Note to the Same
Pitch

Using Audible
Mode

All of the notes will move together. When you begin dragging, an
outline of the notes will appear in place of the mouse pointer.
Dragging notes vertically changes their pitch. Dragging notes
horizontally changes their time location. When you release the
mouse, the notes will pop to their new locations.

To help position the notes in time, hairlines appear in the Time Ruler
to indicate the attack of the first selected note and the release of the
last selected note. In addition, the Pitch Ruler key corresponding to
the note you click highlights. If notes of more than one pitch are
selected, the Pitch Ruler keys that correspond to the highest and
lowest selected notes appear greyed.

To convert a group of selected notes to the same pitch:

1. Make sure that MIDI Edit is checked in the Graphic Editing Window
mini-menu.

If it is not checked, choose it.

2. Select the notes.

You can select a group of notes by shift-clicking each one or by
dragging out a selection box. A square handle will appear at the
end of each note to indicate that it is highlighted.

3. Press any note on your MIDI controller.

The selected notes will change to the pitch you play.

In the Graphic Editing window, Audible Mode functions similarly to
the Event List Window: if the speaker icon is highlighted and you
click a note, the note will play back over MIDI.

If you select a group of notes or other MIDI data and option-click the
Audible Mode button, the selected data will play back as a phrase.

For more information about Audible Mode, see the section called
Audible Mode in the Event List Window chapter.
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The Continuous
Data Grid

Basics

The Continuous Data Grid is the region at the bottom of the Graphic
Editing window below the Median Strip and above the horizontal
scroll bar. It is flanked by the Continuous Data Ruler on the left and
an empty margin on the right.

The Continuous Data Grid displays MIDI controllers, pitch bend.
mono and poly key pressure, and note-on/off velocities. The grid
functions like a standard Xand Ecoordinate graph, in which time lies
on the horizontal axis and value along the vertical axis. The higher
the value of a continuous data event is, the higher it will appear on
the grid. The later the event occurs, the farther to the right it will
appear on the grid.

Location and value are measured with the Time Ruler and the
Continuous Data Ruler respectively. Grid lines extend from the Time
ruler to help in determining an event’s position.

The Continuous Data Grid has no vertical scroll bar. Instead, the grid
automatically compresses or expands to fit in the current space
between the Median Strip and the bottom of the window. The grid
can be stretched (or compressed) vertically by dragging the Median
Strip up (or down). To make more room for both the Continuous
Data Grid and Note Grid, simply enlarge the entire window with the
grow box.
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Viewing Continuous
Data Types One at a
Time

j A continuous data event is displayed on the grid as a small icon, such
I as a square or a circle. Pitch bend data, aftertouch, velocities, and

controllers each have a unique icon. The icons are defined in the
Continuous Data Icons window, which can be opened from the
Graphic Editing window mini-menu.

Eight different icons are available for the display of Controllers.
Controllers can be assigned to icons in the Continuous Data Icons
window. For more information, see the section later in this chapter
called The Continuous Data Icons Window.

The expression continuous data type refers to a kind of continuous
data. For example, pitch bend is one kind of continuous data. MIDI
controllers between 0 and 63 are each considered a continuous data
type.

Continuous data types can be viewed simultaneously in the
Continuous Data Grid. Sometimes, however, you may wish to see
only one type (or several) at a time. Performer offers several ways to
temporarily isolate continuous data types for viewing and editing.

To view pitch bend data by itself, click on the Continuous Data Ruler.
Doing so toggles the ruler among three displays, one which displays
pitch bend data by itself. For more information about this feature.
refer to the next section called The Continuous Data Ruler.

To view a controller data type by itself, click an event of that type and
click the Quick-Filter check box that appears in the Information Bar
next to the event’s numerical data. Clicking the Quick-Filter box
causes all other data types to temporarily disappear until you click it
again. For more information, refer to the section later in this chapter
called Editing Continuous Data.

The Quick-Filter is useful for temporarily isolating continuous data
types. However, data types can also be filtered with the View Filter in
the Graphic Editing window mini-menu. Data types that are selected
in the View Filter will be displayed; ones that are not selected will not
be displayed. To view all data types, click the Set All button in the
View Filter.
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The Continuous Data
Ruler

Controller scale

Like the Quick-Filter, the View Filter affects selecting and editing. For
example, if note velocity data has been filtered from the display, it
cannot be selected for editing. All visible data types can be selected
for editing.

For information about editing continuous data, see the section later in
this chapter called Editing Continuous Data.

All continuous MIDI data has a value range from 0 to 127 except pitch
bend, which has a value range from -8192 to 8191. Because of these
two separate scales, the Continuous Data Ruler provides three
different scales:

1. a controller scale from 0 to 127, whose origin rests at the
bottom of the window:

2. a pitch bend scale from -8192 to 8191, whose origin
appears in the middle of the window:

3. a combination scale from -80 to 127, which combines the
above two scales and whose origin appears just below the
middle of the window.

Combination scale

;-----------
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To switch from one scale to another, click in the ruler. Doing so
toggles from the currenQt scale to the next. Each scale displays data
appropriate to that scale. The controller scale (0 to 127) displays
controller data only. The pitch bend scale (-8192 to 8191) displays 
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Controlling the Length
of the Continuous Data
Ruler

pitch bend only. The combination scale (-80 to 127) displays
controller data and pitch bend together. Note velocities, if selected in
the View Filter, appear in the controller and combination scales. The
pitch bend scale displays pitch bend even if it is deselected in the
View Filter.

All three scales provide numbered marks in the ruler and an origin
line extending to the right that indicates where zero is on the ruler.

The entire Continuous Data Ruler is always visible. If you resize the
grid using the Median Strip or the Graphic Editing window’s grow
box, the Continuous Data Ruler will compress or expand to fit in the
available space. The data within the grid will also compress or
expand to conform to the ruler.

Zooming the
Continuous Data Grid

the Graphic Editing window and drag up the Median Strip. If you
move the Median Strip rz//the way up, the Continuous Data Grid will
occupy the entire window.

The Continuous Data Grid can be zoomed along the time (horizontal)
axis. Time zooming has the visual effect of expanding or compressing
a continuous data curve in the window. If you zoom in, the curve
spreads out:
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If you zoom out, the same curve compresses:

Editing Continuous Data

The data that comprises the curve does not change between these
two views: only its appearance changes. Time zooming allows up to
eight different settings. For more information about zooming the
Time Ruler, refer to the section earlier in this chapter called Zooming.

The Continuous Data Grid displays more than one type of continuous
data at a time. For example, the grid can display pitch bend,
controller #7, and mono key pressure all at once. Each type is
distinguished by the shape of its icon.

Because data types are displayed simultaneously, they can be
selected and edited together. Sometimes, however, you may wish to
edit only one type (or several) at a time. Performer provides two
ways to isolate continuous data types for viewing and editing. For
example, if the Continuous Data Grid currently displays the three
types of data mentioned above, you can filter out pitch bend and key
pressure to view controller #7 data by itself.

The most convenient way to filter data is with the Quick-Filter check
box. To view controller number #7’s only, click any controller =7
event to select it and click the Quick-Filter check box next to the
event’s numerical data in the Information Bar. All other data types
will temporarily disappear, and you can then easily select controller
#7’s without inadvertently selecting other data types. To make other
data types reappear, click the Quick-Filter check box again.

The regular View Filter, found in the mini-menu, also filters data
types. In the View Filter dialog box, select the continuous data type(s)
you wish to see and deselect all others. Only visible data can be
selected for editing.
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When a continuous data event is selected, a line extends from the
icon to the origin line on the continuous data grid. Once events are
selected, they can be edited.

The diagram below shows three deselected controller events on the
left. To the right the events are selected: a line extends to the origin
line; selected events can be edited.

Deselected

Quick-Filtering Data
Types

Selected

Events selected in this fashion can be edited with the following
commands in the Edit menu: Cut, Copy, Paste, Erase, Merge, Splice,
and Shift. To Snip or Repeat, you must select a region by dragging in
the Time Ruler.

To view certain continuous data types and quickly filter the rest:

1. Select an event of each data type that you want to see.

check

Click the event, or drag a selection box over it. To select more
than one data type, shift-click an event of each type.

2. Click the Quick-Filter check box that appears next to the numerical
data in the Information Bar.

All data types will disappear except those that you selected. To
make all data types reappear, click the Quick-Filter check box
again. You can toggle freely between filtered and unfiltered mode.
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Selecting a Single
Continuous Data Event

; 'lb select an event:

i 1. Click the event.

The event will become selected. The selected event displays a
vertical line extending from its icon to the origin line.

Selecting a Group of
Continuous Data Events

To select a group of continuous data events:

1. Drag a selection box over the events and release the mouse.

When you release, any events inside the dotted selection box will
be selected. All other highlighted events will deselect. If other
events are selected before you drag and you want them to remain
selected, hold down the shift key before you drag out the
selection box.

To select all events of a single data type:

1. Double-click an event of that type.

All events of that type will become selected. All events of other
types will deselect. If events of other types are selected
beforehand and you want them to remain selected, shift-double­
click and the other events will remain selected.

To deselect all events of a single data type:

1. Shift-double-click a selected event of that type.

All events of that type will deselect.
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Inserting a Single
Continuous Data Event

To insert an event on the Continuous Data Grid:

1. Press the Insert button in the title bar of the Graphic Editing
window,

2. Choose the type of event you wish to insert from the menu.

The mouse pointer will turn into a cross hair. For some types of
data, an additional box may appear requesting further
information.

3. Click the cross hair once at the desired time location and value.

The event will appear where you click, and the mouse will switch
back to an arrow. If you wish to insert multiple events, press the
shift key before you click and the cursor will remain a cross hair.

Editing a Single
Continuous Data Event

To change the value or location of a single continuous data event:

1. Click the event and drag it to a different position or value.

Drag vertically to change its value. Drag horizontally to change its
location. Press the shift key after you click to constrain the mouse
vertically or horizontally. For exact positioning, refer to the Pointer
Coordinates Box and the rulers.

Editing the Value of an
Event Using a MIDI
Controller

To change the value of an event with your MIDI controller:

1. Make sure that MIDI Edit is checked in the Graphic Editing Window
mini-menu.

If it is not checked, choose it.

2. Click the event to select it.

3. Transmit a corresponding event from your MIDI controller.

For example, if you have selected pitch bend event, move the
pitch bend wheel on your controller and the event will change to
the new value you set with the wheel.

4. When you have entered the value you wish, press the Return key or
the mouse to confirm the new value.
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Working With
Continuous Data Curves

A continuous data curve is a group of many individual events. Events
that form a curve can be edited together in much the same way as a
single event. The only difference is that more than one event is
selected.

Selecting a Continuous
Data Curve

To select a continuous data curve:

1. Filter other data types, if necessary.

Click an event in the curve you wish to select and click the Quick-
Filter check box in the Information Bar. Filtering is only necessary
if the region that the curve occupies contains other data types that
you do not want to select.

2. Drag a selection box over the curve and release the mouse.

The portion of the curve inside the selection box will become
selected. All other events will deselect. If you want other events to
remain selected, press the shift key while you drag out the
selection box.

To select all events of a continuous data type:

1. Double-click an event of the desired type.

To deselect all, shift-double-click a selected event.

Shift-double-clicking selects or deselects all without affecting the
status of other types.

Inserting a Continuous
Data Curve

To insert a curve of continuous data:

1. Press the Insert button in the title bar of the Graphic Editing
window.

2. Choose the type of event you wish to insert from the menu.

The mouse pointer will turn into a cross hair. For some types of
data, an additional box may appear requesting further
information.

The Graphic Editing Window 323



Reshaping a Continuous
Data Curve

3. Click on the grid where you want the curve to begin and drag the
desired shape of the curve over the region.

Events will appear at regular intervals as you drag the mouse. The
events will be spaced according to the current edit resolution. The
value of events is determined by the vertical position of the
mouse. If you wish to insert multiple curves, press the shift key
before you drag; the cross hair will remain, indicating that you are
still in Insert mode.

OR

4. Option-drag from the start point to the end point of the curve.

A straight line will appear with handles on either end and a handle
at its midpoint. This line represents a curve to which continuous
data events will be fitted. You can adjust the location and shape
of the line by dragging its handles. The end-point handles can be
dragged both vertically and horizontally to position the start and
end point of the curve. The middle handle sets the curvature.

5. Once you have adjusted the line as you wish, click anywhere else
on the screen or press the Return key.

The line will disappear and events creating a curve with the same
shape as the line will appear.

To reshape a continuous data curve:

1. Select the curve you wish to reshape.

You can either double-click an event of that type to select all or
drag out a selection box over a portion of the curve. If the curve
intermingles with other visible data types, use the Quick-Filter
before selecting to avoid inadvertently selecting events of other
types.

2. Click the Reshape button in the title bar of the Graphic Editing
window or choose Reshape from the Graphic Editing window mini­
menu.

In both cases, the mouse pointer will turn into a cross hair.
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3. Drag above or below the selected events to change their values to
the position of the mouse.

Each event will snap to the position of the mouse as the mouse
passes over it. The location of events will not change. If you like.
you can deselect the Quick-Filter before dragging to view other
data types while dragging. If you wish to remain in Reshape
mode, press the shift key before you drag; the cross hair will
remain when you finish dragging, indicating that you are still in
Reshape mode.

OR

4. Option-drag along the selected region of the curve.

A straight line will appear with handles on either end and a handle
at its midpoint. This line represents a curve to which continuous
data events will be fitted. You can adjust the location and shape
of the line by dragging its handles. The end-point handles can be
dragged both vertically and horizontally to position the start and
end point of the curve. The middle handle can be dragged to set
the curvature.
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Offsetting or Scaling a
Continuous Data Curve

5. Once you have adjusted the line as you wish, click anywhere else
on the screen or press the Return key.

The line will disappear and selected events above or below the
line will adjust their values to match the shape of the line.

You can offset a continuous data curve by dragging it in any direction.
Offsetting modifies events in the curve by a constant amount:
dragging up or down changes events’ values; dragging left or right
changes their location. For example, dragging a curve up by a value
of 30 will add that amount to all events in the curve.

You can scale a continuous data curve by command-dragging it in
any direction. Scaling modifies events in the curve proportionally:
dragging up or down scales values proportionally; dragging left or
right scales time. For example, when a bell-shaped curve is scaled up,
the start and end points of the curve remain at zero, and the slopes
become steeper as the top of the curve rises. Scaling is a useful way
to exaggerate or diminish a curve’s musical effect without changing
its fundamental nature. For example, you can scale an existing
crescendo so that it swells in the same manner but ends at a softer
volume.

To offset or scale a continuous data curve:

1. Select the curve you wish to modify.

You can either double-click an event of that type to select all or
drag a selection box over a portion of the curve.
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2. Click (to offset) or command-click (to scale) a selected event and
drag in the direction you wish.

Press the shift key before dragging if you wish to constrain motion
horizontally or vertically. As usual, horizontal position (location) is
constrained by the current edit resolution.

Cancelling Lengthy
Editing Operations

A wristwatch icon may appear when Performer executes a
continuous data edit operation. To cancel an operation in progress,
press command-period (command-.). The operation will abort. Data
modification that occurred before cancelling will not be undone
unless you choose Undo from the Edit menu.

Summary of Continuous
Data Editing Features

This section summarizes features available when working with the
Continuous Data Grid.

Selecting Select a single event by clicking it.

Select several events by dragging a selection box over them.

Select all events of a single data type by double-clicking an event of
that type.

Select all events of several types by shift-double-clicking an event of
each type.

Select all continuous data by choosing Select All from the Edit menu
or pressing command-A. All other MIDI events in the track will
become selected as well, including notes and data in the Median
Strip.

Deselecting Deselect a single event by shift-clicking it.

Deselect al! events of a single data type by shift-double-clicking a
selected event.

Deselect all continuous data by clicking in an empty area on the
Continuous Data Grid.
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Quick-Filtering

Offsetting

Scaling

Constraining

Inserting and Reshaping

The Continuous Data
Icons Window

Quickly isolate a data type by clicking an event of that type and then
clicking the Quick-Filter check box in the Information Bar. Isolate
more than one type by shift-clicking an event of each type before
clicking the Quick-Filter check box. To unfilter, deselect the Quick-
Filter check box.

Offset the location or value of selected events by dragging
horizontally or vertically.

OJfset the location of a copy of all selected events by pressing the
option key and dragging horizontally.

Scale the time or value of selected events by pressing the command
key and dragging horizontally or vertically.

Constrain the movement of the mouse vertically or horizontally while
scaling or offsetting by pressing the shift key after clicking and before
dragging.

Click the Insert and Reshape buttons (or choose Insert or Reshape
from the mini-menu) to change the mouse cursor to a cross hair.

Insert events or Reshape existing selected events in any shape you
wish by dragging the cross hair.

Insert or Reshape events against an adjustable curve outline by
pressing the option key before dragging the cross hair. A straight line
with moveable handles will appear to which events will be fitted
when you click elsewhere on the grid.

Remain in Insert or Reshape mode by pressing the shift key before
dragging the cross hair.

The Continuous Data Icons window serves as a legend for the icons
you see in the Continuous Data Grid. In addition, it allows you to
assign controller data types to eight unique icons to help differentiate
between them on the grid.

To open the Continuous Data Icons window, choose Cont. Data
Icons from the Graphic Editing window mini-menu. The window
remains until you click its close box and serves as a handy reference
when working with continuous data.
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Assigning Icons to
Controllers

The Continuous Data Icons window oilers eight different icons to
represent controllers. Because more than eight types of controllers
exist, the most commonly used controllers have been assigned to
icons by default. However, you can change which controller an icon
represents. For example, a square can represent controller -7 or
controller -38. All controllers that have not been assigned to one of
the first seven icons are automatically assigned to the last “u "-shaped
icon. The icons for pitch bend, velocity, and key pressure cannot be
changed and are displayed for reference.

To assign a controller to an icon:

1. Open the Continuous Data Icons window.

Select Cont. Data Icons from the Graphic Editing window mini­
menu.

2. Click in the box to the right of the icon of your choice.

The box will highlight.

3. Type in the controller number that you wish to assign to that icon.

The number you type must be between 0 and 63. Controllers 64
through 127 are switch controllers and will appear in the Median
Strip.

4. Press the Return key or click anywhere to confirm your choice.

The Continuous Data Grid will reflect any changes you have
made.

The Median Strip The Median Strip separates the Note Grid from the Continuous Data
Grid. It contains only the following discrete MIDI events: patch
changes, mode changes, switch controllers like -64 (sustain pedal),
tune requests, song changes, and system exclusive events. Notes and
continuous data do not appear in the Median Strip.

Tp--- I 1
;— [■u#7l| i A*64) [Omni off)
120- I
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Moving the Median Strip

l±L_Z
;------------̂ #71]

120-

j The Median Strip serves as the border between the Note Grid and the
! Continuous Data Grid. It can be dragged up and down by grabbing

the handles at either end. Moving the Median Strip resizes the Note
Grid and the Continuous Data Grid proportionally. For example, if
you drag the Median Strip down as far as it will go, you will see only
the Note Grid. If you drag the Median Strip all the way up, you will
see only the Continuous Data Grid.

Working with Discrete
MIDI Events in The
Median Strip

The Median Strip is a convenient way to quickly adjust the size of one
grid or the other to suit your immediate needs.

Events in the Median Strip do not have durations. Each event is
therefore displayed as a single item inside a small box. Patch
changes, system exclusive events, and controllers are displayed with
their event list icon; mode changes are displayed as text, such as
“Poly” or “Omni on". An event may be pop-edited in the Information
bar in the same fashion as in the event list window. Location is
determined by the Main Time Ruler. To indicate time location, the
vertical grid lines from the Main Ruler extend through the Median
Strip.

Inserting an Event in the
Median Strip

Discrete MIDI events that are not continuous data, such as patch
changes, mode changes, swatch controllers like *64 (sustain pedal),
and system exclusive events, appear in the Median Strip. To insert
such an event:

1. Press the Insert button in the title bar of the Graphic Editing
window.

2. Choose the type of event you wish to insert from the menu.

The mouse pointer will turn into a cross hair. For system exclusive
events, an additional box will appear requesting further
information.

3. Click once at the desired time location in the Median Strip.

The event wall appear where you clicked.
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Editing an Event in the
Median Strip

Events in the Median Strip can be pop-edited in the Information bar.
For example, to select such an event, click it and the event will
highlight. Click the event in the Information bar and a pop-up box
will appear that you can type in. When system exclusive events are
pop-edited in this manner, a dialog box will appear.

Dragging an event in the Median Strip left or right will change its
location.

If two or more events occur at the same time, they will overlap in the
Median Strip. Overlapping events are displayed as shown in the
example below:

In this example, the Omni on message occurs near two other events.
The other events are indicated by boxes preceding the Omni on box.
To see the other events, click their box. To select the second event
displayed in the example above, click the second rectangle. The
event will pop to the front and become highlighted:

If two or more events occur at the exact same location, a list icon
appears. If you press on it and drag downwards, a small pull-down
menu shows all events at that location. Events in the pull-down menu
can be selected and then edited. For example, if you select the third
item in the menu, the list icon becomes highlighted. If you then drag
the list icon left or right, you will only drag the third item that you had
selected. To select more than one item in the menu, shift click to
select each item.
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Graphic Editing
in the Conductor
Track

The Conductor Track
Median Strip

The Conductor Track Graphic Editing window is similar to a regular
track but has several differences. It does not have a Note Grid
because the Conductor Track cannot contain notes. In addition, the
Median Strip is wider and fixed at the top of the window just below
the Time Ruler. Finally, the Conductor Track has a Tempo Change
Grid similar to the Continuous Data Grid that displays tempo changes
only.

Meter changes, key changes, and markers are displayed in the
Median Strip.

The Median Strip in the Conductor Track functions much like the
Median Strip in a regular track. Each meter change, key change, and
marker is displayed as a single item. The Conductor Track Median
Strip is wide enough to accommodate all three kinds of events
without overlapping them.

Editing in the Conductor Track Median Strip works the same as
editing MIDI data in a regular track’s median strip: click an item to
make it appear in the Information bar and click in the Information bar
to pop-edit its value(s); drag the item left or right to change its
location.

Inserting a Meter/Key
Change or Marker

Note that only unlocked markers can be edited in the Conductor
Track window; to unlock a marker, do so in the Markers window.

To insert a meter change, key change, or marker:

1. Press the Insert button in the ConductorTrack title bar,

2. Choose the item you wish to enter.

The pointer will turn into a cross hair.

3. Click in the median strip at the location you desire.

The event will appear at the location.
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Editing the Location of a
Meter Change, Key
Change, or Marker

The Tempo Change Grid

Zooming the Tempo
Ruler

To change the location of an item in the median strip:

1. Click the item you wish to move and drag left to advance it or drag
right to delay it.

The event will move to the new location when you release the
mouse.

Tempo changes are displayed and edited on the Tempo Change grid
in the same fashion as continuous data. Each tempo change event is
displayed on the grid as a small icon. When the tempo change event
is selected, a line extends from its icon to the origin at the bottom of
the grid. A tempo change ruler on the left measures events on the
grid. Tempo changes can be selected and edited in the same way as
an active continuous data type. For more information, see Editing
Continuous Data earlier in this chapter.

The Tempo ruler in the Conductor track can be zoomed in for more
precise tempo editing. Clicking the Tempo ruler toggles quickly
between your custom zoom scale and the normal scale.

To zoom the Tempo ruler:

1. Highlight the range of values you wish to zoom to by dragging in
the Tempo ruler.

The Tempo ruler will zoom in on the range that you select.
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, 2. Click theTempo ruler to toggle between your custom zoom scale
and the normal scale.

I
At the zoomed in scale, dragging tempos up or down can be done
to a higher degree of resolution.

‘c3' The resolution at which you can insert and edit tempo
events is one screen pixel (72 dots per inch).
Therefore, you have a higher degree of resolution
when you zoom in.
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Chapter 22 The Notation Editing Window

Performer offers four windows in which to edit data in a track: the
Event List, Graphic Editing, Notation Editing, and QuickScribe
notation. To open the Notation Editing window, hold down the
command and option keys and double-click the track name. Or
choose Notation Editing from the Event List or Graphic Editing
window mini-menus. You can also option-click the Notation button
in the main control panel.

The Notation Editing window provides a scrolling window of a single
track, very similar to the Graphic Editing window. This chapter covers
features unique to the Notation Editing window. To display several
tracks, use QuickScribe notation as described in chapter 23,
“QuickScribe Notation” (page 345).

Quick Reference
Grand Display resolution

Octave

Staff margin

Continuous

data grid

le zoom
buttons

Octave Up/

t>wn buttons
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Notation Editing
Window Mini-menu

Display Resolution: Determines the shortest duration that will be used
to display note data on the Grand Staff. Actual attack and release
times are not affected by Display Resolution.

Selected Note: Glick once to select the note. While the note is selected,
its information will appear in the Information Box above. Shift-click
or drag a selection box to select more than one. Drag the note up or
down to change pitch; drag left or right to change time location.

Grand Staff: Displays notes on standard treble and bass clef staves. By
default, middle C between the staves is C3. Click the Octave Up/
Down buttons to change middle C to a different octave to place notes
in higher or lower octaves on the staff.

Time Zoom Buttons: Contract or expand the Time Ruler, Grand Staff,
and Continuous Data Grid to display more or less measures at a time.
The left button zooms out (more measures), and the right button
zooms in closer (less measures).

Octave Up/Down Buttons: Transpose the display of notes on the Grand
Staff by octaves. When untransposed, middle C on the Grand Staff is
C3- For example, in a bass track, low notes are displayed many ledger
lines below the staff. To distinguish the pitches, click the Octave
Down button; middle C will become C2 and the bass notes will be
displayed an octave higher on the grand staff. The octave indicator in
the Staff Margin indicates the degree of transposition.

Octave Indicator: Indicates the octave being displayed on the Grand
Staff.

Staff Margin: A non-scrolling region of the Grand Staff that displays
clefs, key signature, and meter.

Continuous Data Grid: Displays continuous data in the same manner as
the Graphic Editing window.

Set View Filter: Calls up a dialog box in which you specify types of
events to be visible in the Notation Editing window. The View Filter
applies to all tracks and affects the Graphic Editing, Notation Editing,
and Event List windows.
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■ Goto Counter: Automatically scrolls the graphic display to the time
I currently displayed in the Counter. The counter location will appear

at the left-most position in the window.

Goto: Automatically scrolls the graphic display to a time you specify.
which will appear at the left-most position in the window.

Reinsert: Inserts an event of the same type that you last inserted. This
is the same as the Insert command hut you are not prompted for the
type of event. This command can also be invoked by option-clicking
the Insert (I) button in the Notation Editing window title bar.

Reshape: Changes the mouse pointer to a cross hair that reshapes
selected continuous data curves when you drag over them in the
Continuous Data Grid. This command can also be invoked by
clicking the Reshape button in the title bar.

Legend: Produces a window that shows the icon representing each
type of MIDI event.

Set Rulers: Allows you to configure the Time Ruler in any combination
of Performer’s three time formats: measures | beats | ticks, SMPTE time,
and real time. The main ruler is displayed lowest and determines the
time format for editing.

Cont. Data Icons: Opens the Continuous Data Icons window, which
displays icons for each type of continuous data. This window also
allows you to reassign controller icons.

SetPtr. Coords...(Set Pointer Coordinates): Allows you to choose what
time and pitch formats will be displayed in the Pointer Coordinates
Box.

MIDI Edit: Allows data in the graphic editing window' to be edited
from a MIDI controller.

Switches are Cont. Data: Causes all controllers, including switch
controllers #64 and above, to be displayed and edited as continuous
controllers. This is useful for MIDI devices, such as MIDI-controlled
lighting consoles, that use all MIDI controllers as continuous
controllers.
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Bassos

Display Resolution

Selections use Edit Resolution: Causes the cursor to snap to the edit
resolution when dragging to make selections in the note grid, time
ruler, and continuous data grid.

Event List: Opens the track’s Event List window.

Graphic Editing: Opens the track's Graphic Editing window.

QuickScribe Notation: Opens the QuickScribe Notation window.

MeasureslReal timelFrames: These checkable entries control which time
formats are displayed in the Information Bar and Event List.

The Notation Window is similar to the Graphic Editing window. It has
a Time Ruler, a Markers Strip, a Median Strip, and a Continuous Data
Grid, features that are identical to those found in the Graphic Editing
window. Instead of a pitch ruler and note grid, however, the Notation
Editing window displays notes on a grand staff in standard music
notation. Octave Up/Down buttons are provided to center any octave
on the grand staff, and a non-scrolling staff margin on the left displays
clefs, key signature, and meter.

For further information about the Time Ruler, Markers Strip. Median
Strip, and Continuous Data grid, refer to chapter 21, “The Graphic
Editing Window" (page 281) in the Reference Manual.

Features that are unique to the Notation Editing window are
discussed below.

Internally, Performer accurately records the attack and release times
of notes at a resolution of 480 ticks per quarter note. For example, a
quarter note that you attempted to play on beat two of measure three,
3121000, may have actually occurred a split second after the beat at
3121073, which is 73 ticks after the downbeat:

| 3|2|073 J*G3 164 164 11000 ~

Even though the note is a little late, it may sound like it is right on the
beat because of the sound used, the nature of the music, etc.
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Octave Up/Down
Buttons

| Instead. Performer internally sets up an evenly spaced grid of note
! durations, finds the nearest grid location, and displays the note as if

it began at the grid location. For example, at a quarter-note grid
resolution, the above note at 3121073 is displayed on the nearest
downbeat at 3121000 (as a much more recognizable quarter note!)

Even though the note actually occurs after the downbeat, it gets
displayed on the downbeat, which is the nearest grid location.

The Display Resolution box allows you to choose at which grid
resolution notes will be displayed. If the note above is displayed with
a sixteenth note display resolution, which sets up a grid every 120
ticks, the note will be notated as a sixteenth rest followed by a dotted
eighth note because its attack is closer to 3121120 than it is to
3121000:

As you can see, the Display Resolution box determines the shortest
duration that will be used to display notes and rests in the track. In
general, a shorter duration produces a more accurate (but maybe not
as conventional) notational display of the notes in the track.

Display Resolut ion does not affect the actual location or playback of
the notes. Don't worry about affecting the notes in the track when
using the Display Resolution: it only affects their display. If you
would like to make the note data more rhythmically accurate, use the
Quantize or Smart Quantize commands.

The Octave Up and Octave Down buttons change the octave of
middle C, the pitch directly between the treble and bass staves. By
default, middle C is MIDI note number 60, or C3. If the notes in the
track fall well below middle C, they will be displayed on ledger lines
below the grand staff. To raise the display of the notes and make
them more legible, click the Octave Down button:
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The result is that the entire Grand Staff display is transposed, as
indicated above the treble clef, and the notes are displayed within the
staff. Only the display gets transposed; the actual notes maintain their
original pitches.
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Basics

Inserting Notes

The following sections describe basic procedures in the Notation
Editing window.

To insert a note on the grand staff:

1. Choose a Display Resolution.

To do so, click the Display Resolution note and choose the desired
duration. The Display resolution affects the resolution at which
you can insert the note.

Track-1 (Seq-1)
J J ofe
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2. Click the Insert button in the title bar or choose Insert from the
mini-menu.

In both cases, the Insert menu will appear.

3. Choose Note from the menu.

The menu will disappear and the mouse pointer will turn into a
cross hair.

4. (Optional) Press the Shift key.

This is only necessary if you wish to insert more than one note.

5. Click at the desired pitch and location on the Grand Staff, drag to
the right to draw the desired duration, and release the mouse.

The note’s attack will begin at the nearest grid location. The
duration is shown as a grey bar extending to the right. As you drag
to the right, the duration of the note increases in increments of the 

The Notation Editing Window 341



Inserting a Chord Using
a MIDI Controller

Selecting Notes for
Editing

display resolution. For example, to enter a half-note with 16th
note resolution, drag eight increments to the right as shown

...and a note will be inserted.

If you press the shift key to insert multiple notes, simply click on the
desired pitch to insert another note of the same duration. To insert a
note with a different duration, click and drag a new duration. You
will remain in insert mode as long as you hold down the Shift key.

To insert a chord:

1. Choose “Note” from the Insert button pop-up menu in the title bar.

The Cursor will turn into a cross-hair.

2. If you would like to insert more than one chord, either hold down
the shift key, or push down the caps lock key.

This will keep Performer in insertion mode after you insert the
chord.

3. Play the chord you wish to insert on your MIDI controller and, while
holding the chord, click where you want the chord to begin and
drag from left to right to the appropriate duration.

The vertical position of your click is not important; the notes are
determined by what you play on your controller. Only the attack
and release of the chord is affect by the cross-hair.

As long as you remain in insertion mode, you can enter chords in this
fashion for as long as you like. You can even alternate between
entering notes with the mouse only or the mouse with a MIDI
controller.

Selecting notes on the Grand Staff works the same way as selecting
notes in the Graphic Editing window. To select a single note for
editing, just click the note. The notehead will invert to indicate that 
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Dragging Notes

Editing Durations

the note is selected. To select several notes, shift-click each one. Or,
drag a selection box over them. Shift-click to select non-contiguous
notes. To select all notes in the track, double-click any note.

To change the location or the pitch of a note, simply drag the note to
the desired pitch or location. This can also be done with more than
one note selected. As usual, option-dragging will produce a copy of
the originally selected notes, which can be used to quickly generate
repeated phrases or chords.

To copy notes, option-drag... ...and a copy of the notes will result.

If a note is displayed as several tied notes, you must click the first of
the tied notes.

To change the duration of a note:

1. Command-click the note.

If the note consists of several tied notes, you must click the first of
the tied notes. A grey bar will appear to indicate the current
duration of the note with respect to the Time Ruler.
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Scrolling During
Playback

Zooming Shortcuts

2. Drag the handle of the grey bar to the left to shorten the note or to
the right to lengthen it.

The grey bar will show you the change in duration.

To change the duration of more than one note, select them first and
command-drag any one of them.

When changing a duration in the Notation Editing window, the new
duration maintains any differences between its actual length and its
displayed length. For example, if a quarter note ends 17 ticks after
beat 2, and you lengthen it by one beat to beat 3, the release will still
be 17 ticks after beat 3.

The Auto-Scroll command in the Basics menu can make the Notation
Editing window scroll during playback. In addition, the window will
automatically open to the current playback location of the sequence.
Please refer to the Auto-Scrolling section in the Playback chapter for
more information.

Here are some zooming shortcuts:

Do this:

Command-drag in the Time Ruler

Option-click the zoom out button

Option-click the zoom in button

To zoom as follows:

To fill the window with the region
you select

To zoom all the way out

To zoom all the way in
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Chapter 23 QuickScribe Notation

QuickScribe
window basics

This chapter explains how to use Performer’s QuickScribe™ notation
window. The notation window allows you to view and edit any
number of tracks as standard music notation.

Performer interprets unquantized MIDI data, notating it in a readable
fashion without permanently quantizing the data, so your original
performance is always preserved. Music is displayed and edited on a
page on the screen exactly as it will print on your
Macintosh-compatible printer.

Notes can be inserted with the mouse, Macintosh keyboard, or via
MIDI step entry'. You can also transpose and edit using all of
Performer’s powerful commands in the Edit and Region menus.

The QuickScribe window provides intuitive text entry for preparing
title pages, headers, footers, and page numbers. It lets you adjust
system margins, staff spacing, measure spacing, and other aspects of
formatting.

Performer provides one QuickScribe notation window per sequence
(and you can have an unlimited number of sequences in a Performer
file). The QuickScribe window can display any combination of tracks
in the sequence, and you can easily change what is displayed. Page
formatting is preserved, even if you decide to change what is
displayed in the window. The QuickScribe window is ideal for
quickly printing scores and parts. Best of all, you can choose to
display any region, from a single measure to the entire sequence. In
either case, Performer quickly formats the music.

Unlike the Notation Editing window, the QuickScribe notation
window uses engraver spacing so that the notation looks more
natural for printing. The contents of the QuickScribe notation
window can be printed at any time. This chapter explains all about
preparing the appearance of the score. For information about printing
it, see chapter 43, “Printing” (page 665) in the Reference Manual.
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Notation window Quick
Reference

Below is a brief overview of the QuickScribe window.

Status strip: displays current cursor coordinates and

information about the currently selected note.

* ■ Score (IPhaI rise f .in I Pot

What: Else Can I Do?

Vocals

Piano

Notes being selected

Insertion cursor

for Macintosh

keyboard entry

and MIDI step

recording.

Words and music by
Joe Geiger

2I5BC0

TF
0

Tool palette: lets you insert notes,

triplets, and text.

Page number box: click in this box and type in

a number to go the desired page
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Choosing what tracks to
display

The QuickScribe notation window can display any region of time in
any combination of tracks. To choose what to display in the
QuickScribe notation window:

1. Select one or more tracks in the Tracks window, and set the time
region in the Tracks window Edit bar (to the nearest measure).

Actually, you can use any of the many selection methods that are
available in Performer, which are fully explained in chapter 25,
“Selecting Regions” (page 387) in the Reference Manual. For your
convenience, several common selection methods are suggested
on the following page. If nothing is currently selected. Performer
displays the entire contents of the sequence (i.e., the currently
play-enabled sequence in the Chunks window).

2. Click the QuickScribe notation window button in the Consolidated
Control panel or choose QuickScribe from the Windows menu.

Alternately, you can choose the QuickScribe Notation mini-menu
command from any edit window.

*>|100:00:00:00 [i

| Chunk: Seq-1

FtH-i
TRH-2 A#7

«■» <s>
------ .

QuickScribe notation window button

3. The Notation window appears.

4. To make adjustments to the formatting, use the Score Options,
Tracks options, and other mini-menu commands.

In particular, you may want to change the way the music is
spaced, which has a large impact on the efficiency of editing, as
well as how good the music looks. For details, see “Measure
spacing” on page 356.

5. To add a title, use the Text tool in the palette.

For more information, see “Working with text” on page 367.
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The selection methods below are interchangeable, and not every
method is covered here. For more information, see chapter 25,
“Selecting Regions" (page 387) in the Reference Manual.

To display this: Select this:

A few notes or mea­
sures in a track

Drag over them in the Event List, Graphic
Editing or Notation Editing window.

Several measures in a
single track

Drag over the measures in the Tracks over­
view. Or, click the track name to highlight it
and type in the start and end time of the
region in the Edit bar.

One or more measures
in several tracks

Drag over the region in the Tracks overview.
Be sure to highlight a track segment region
only for the tracks you want to include. Or
you can highlight the track names and set the
region with the Edit bar start and end times.
When you select more than one track using
either method, the resulting staves are placed
together in the same staff system.

An entire track Double-click the word "Edit" in the Tracks
window Edit Bar to select the entire length of
the sequence and then click the track name to
highlight it. Or, open an event editing window
for the track and choose Select All from the
Edit menu.

All tracks for the entire Double-click the word "Edit" in the Tracks
sequence window Edit Bar to select the entire sequence

and choose Select All from the Edit menu to
highlight all the track names. Or. as a shortcut,
don’t select anything.

(<* The Remember Times command in the Basics menu is
a time-saving tool for selecting with the Edit bar. See
“Remember Times” on page 275 of the Reference
Manual.

348 QuickScribe Notation



Changing what is
displayed

You don’t need to
quantize tracks to get
good-looking notation

To change what tracks are displayed in the QuickScribe notation
window, or to change the region of time:

1. Close the QuickScribe window.

Click its close button at the far left of the title bar.

2. Select the tracks and time region you wish to display.

3. Click the QuickScribe notation window button in the Consolidated
Control panel or choose QuickScribe from the Windows menu.

Performer does an admirable job of notating music, even though the
music may not be quantized. Performer accurately records the attack
and release times of notes at a resolution of 480 ticks per quarter
note. For example, a note that you attempted to play on beat two of
measure three, 3121000, may have actually occurred a split second
after the beat at 3121073, which is 73 ticks after the downbeat:

3|2|073 J’GS 164 !64 1)000

Even though the note is a little late, it may sound like it is right on the
beat because of the sound used, the tempo, and so on.

If Performer tried to take into account the 73 ticks when displaying
the note in standard music notation, the result would be many 64th
and 128th rests followed by lots of tied 64th and 128th notes—
certainly not a recognizable quarter note!

Instead, Performer internally sets up an evenly spaced grid of note
durations, finds the nearest grid location, and displays the note as if
it began at the grid location. For example, the above note at 3121073
is displayed on the nearest downbeat at 3121000 (as a much more
recognizable quarter note!)

3
Even though the note actually occurs slightly after the downbeat in
the track, it gets displayed on the downbeat, which is the nearest grid
location. As a result, you get the best of both worlds: your original
performance of the music is preserved, and Performer makes the
notation display look readable.
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Displaying triplets and
tuplets

The scrolling playback
wiper

In -addition to being able to properly display unquantized data.
Performer automatically detects triplets and tuplets and displays them
with the appropriate bracket and note spacing. In some cases, the
placement of the notes in the tuplet may not be accurate enough for
Performer to properly detect the tuplet. If you'd like to see the tuplet
properly displayed, try quantizing the data with the tuplet option in
the Quantize command. Try experimenting with Strength settings less
that 100%, as the tuplet does not need to be fully quantized for
Performer to recognize it.

A playback wiper is provided in the QuickScribe window to indicate
the current playback location. This wiper can be dragged as well to
change Performer’s current playback location in the main counter.
You can drag it left or right; you can also drag it up and down to
jump from system to system.

Double-clicking anywhere on a staff to make the playback wiper
jump immediately to that location. To turn off the wiper, uncheck it
in the Auto Scroll command in the Basics menu.

350 QuickScribe Notation



Getting around in the
QuickScribe window

Use the commands in the QuickScribe notation window mini-menu
to scroll through each page and go to the first or last page.

The mini-menu commands have the following keyboard shortcuts:

Mini-menu command: Keyboard shortcut:

Next page n

Previous page p

First page f

Last page I

You can also jump to a particular page by using the page number box
at the bottom of the window.

To scroll up and down by one windowful (instead of an entire page),
use option-page up and option-page down.
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Setting the Score
Options

Choose Score Options from the QuickScribe window mini-menu to
open the Score Options dialog box:

Pages:

® First Page is Title Page

OK Cancel

_____

@ Show Tempo above
first measure

>120 

® Grand Staff
brace s

® System bracket ® Show rest in
rf empty measures

Extra Spacing:
| o| ledgers between staves

| O| ledgers between systems

0 Show Markers Q Measure time

ledgers:  Real time
® above system Q Frame tjme
O below system

Part Names:

® Full name before first system

® Abbreviated names before other systems
| 4| Abbreviation maximum length

All print option settings are saved with the file, and they can be
included in your New file template.

Starting page number
This option allows you to enter the starting page number for the
piece. Its default value is page 1.

Creating a title page
The “First page is title page” option allows the first page of music to
be formatted differently from the rest of the body pages. Its system
margins can be adjusted separately from other pages to allow for a
title, subtitle, composer, and other text. Text can be inserted on the
title page without having it be displayed on other pages.

Full part names/Abbreviated part names
Two options are provided for displaying staff names, which appear
between left margin and the left edge of the staff. In both cases, the
staff name is derived from the track name. Check the first option,
called “Show Full Part Names before first System”, to display the full 
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track name to the left of the first staff. Check the second option,
called “Show abbreviated part names before other systems", if yon
would like an abbreviated name to appear next to each staff after the
first one. The abbreviation is the first four letters of the staff name. If
you don’t want staff names, uncheck both options.

The Abbreviation maximum length option lets you choose the
maximum length of abbreviated staff names.

To set the font, style, size, etc. of all staff names, click any staff name
and choose the desired text settings from the Text menu. The settings
you choose will affect all staff names and abbreviations.

Making more space between staves and staff systems
In addition to the space created above and below individual staves by
their ledger line settings, you can make more space between staves
and staff systems globally with the “Extra spacing" options. When you
are printing a single track, use either option to increase the amount
of space between the staves. If you are printing several tracks at the
same time, they are grouped together into a staff system. Use the staff
spacing option to increase space within the system; use the system
spacing option to increase space between systems.
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Markers
Markers can be displayed in the score at their location in the
sequence. The marker text can appear above or below the staff, and
you can control the distance from the staff by typing in a number of
ledger lines in the box provided.

You can also choose to show the exact location of markers along
with their name in any combination of Performer’s three time formats.
Just check the box next to the time format you wish.

To set the font, style, size, etc. of all markers, click any marker name
and choose the desired text settings from the Text menu. The settings
you choose will affect all markers.

System Bracket/Grand Staff Brace options
These two options let you choose whether to show a system bracket
and grand staff braces.
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Measure numbers

Show rests in empty measures
You may choose whether or not to show a whole rest in empty
measures (measures with no note data in them).

Show tempo marking above first measure
Performer takes the tempo for the metronome marking from the
tempo setting in the first measure displayed in the score. The tempo
number is taken from the current settings in the metronome panel.
For example, if the tempo control is set to the tempo slider, the
current tempo slider setting is used. If tempo control is set to the
Conductor track, the current tempo setting in the Conductor track is
used.

The Measure numbers mini-menu command, shown below, sets the
frequency and position of measure numbers in the score.

@ Show Measure Numbers

ledgers O above system
® below system

O Every system

® Every measure
O Every |5 [measures
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Measure spacing The measure spacing mini-menu command lets you determine the
number of measures per line or the overall spacing of notes.

Space measures per line
This option lets you choose a certain number of measures per line,
such as 4 or 5. You can type in the desired number. With this option.
each bar is the same size no matter what notes are in the measures.

Performer can format pages much faster when measure spacing is
fixed. As a result, fixed measure spacing is preferable over natural
spacing if you plan to do a lot of cutting and pasting in the
QuickScribe notation window because pages need to be reformatted
every time you cut or paste data. On the other hand, if measures have
lots of notes in them, use automatic spacing for best results.

Space measures automatically
This option lets Performer decide how many measures to put on each
line, depending on how many notes are in them. You can tighten or
expand the overall spacing of measures by adjusting the slider. Its
range depends on the music: don’t hesitate to experiment with its full
range.

In many cases (depending on the music itself), automatic spacing
produces the best-looking results. It can. however, make cut and
paste operations slow because these operations require page
reformatting, and page reformatting takes longer with automatic
spacing. In addition, you’ll often need to manually repaginate the
score after cutting and pasting to properly format the music. If you
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The effect measure
spacing has on scrolling

Track options

plan to use the QuickScribe notation window for cut and paste
editing, you'll find it to be much faster to use fixed measure spacing
(discussed in the previous section).

Another thing you may notice when using automatic measure spacing
is that a progress window may appear when you are scrolling around
in the file. This happens when Performer has not yet calculated the
pagination for all of the pages. Once the pagination has been
calculated, scrolling from page to page is virtually instantaneous and
you will no longer see the “Preparing to display page” progress
window. If you make changes to your music that change the
pagination, Performer will need to recalculate the page breaks again.
If you would like to avoid this process entirely, and you would
always like to be able to jump around instantaneously, use fixed
measure spacing.

When displaying a track in the QuickScribe notation window, the
Track options mini-menu command lets you specify how you want it
to be displayed, such as whether to display the track on a single staff
or a grand staff.

Staff3| ledgers below

® Automatic

Put notes
lower than |C3
in left hand

Inter-Staff Spacing:

O Custom: leave space for

Track:

□ Use Default
Type of Staff:

O Single Staff
® Grand Staff
O Use Single Staff unless it requires

ledgers between
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Track pop-up menu
Choose each track one at a time from this pop-up menu and, below,
give it the settings you want. Each track can have its own settings,
and the settings are remembered. You can change them at any time.
The “Default’' item in this pop-up menu has its own settings, too; they
are applied to any track for which you have checked the Use Default
option (see below).

Use Default
This check box causes the track to use the default settings. To change
the default settings, choose Default from the Track pop-up menu at
the top of the dialog box.

Type of staff
The Single staff option causes the track to be displayed on its own
staff, regardless of what notes are in the track. When using a single
staff, Performer automatically chooses either a bass clef or treble clef
in an effort to place most of the notes inside the staff and to avoid lots
of ledger lines.

The grand staff option causes each track to be displayed on a grand
staff, regardless of the notes in the track. To set the split point
between the staves, see the “Put notes lower than in left hand"
section below.

Put notes lower than in left hand
When a track is displayed on a grand staff, this option lets you specify
what notes will be displayed on the treble staff and what notes will
be displayed on the bass staff. For example, traditionally, notes are
split at middle C (C3). If you would like to follow this convention,
leave the value set to C3. The Split pitch itself always gets included in
top staff.

Use single staff unless it requires more than ledgers
This option causes Performer to use a grand staff for the track if notes
exist more than the specified number of ledger lines above or below
a single staff. Use the ledger line option to control when a grand staff
will be used instead of a single staff. Raise the number if you want to
avoid using the grand staff very often.
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Controlling page size

Adjusting system
margins

Setting the score length

Setting the cursor
coordinates

Inter-staff spacing
These options give you control over the amount of space above and
below the staff. This spacing is specific to the one track you are
making settings for. To change the spacing of all staves, see “Making
more space between staves and staff systems" on page 353.

The size of the page in the QuickScribe notation window is
controlled by the Page Setup command in the File menu. Custom
page sizes are not supported.

System margins can be adjusted graphically by choosing the Show
System margins mini-menu command in the QuickScribe notation
window. Doing so causes system margins to appear on each page.
The adjustments you make on any page will automatically be
reflected on all other pages, except for the title page if there is one.
If the “First page is title page” option is checked under the Score
options mini-menu command, the title page margins can be adjusted
separately from the rest of the pages to allow for title text. In this
case, you can adjust the system margins of the other pages by
scrolling to any page besides the title page.

The Set Score Length mini-menu command lets you show or hide
measures at the end of the score by increasing or decreasing the total
number of measures shown. Choose the command and enter the
desired number of measures.

The Set Pointer Coordinates mini-menu command lets you set the
display for the cursor coordinates shown in the status bar at the top
of the QuickScribe notation window. Choose the desired time
formats and pitch representation.

Repaginating The Repaginate mini-menu command completely reformats the music
on each page to achieve the most appropriate-looking layout of the
measures. If you have made any changes to the music that require it 
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to be re-spaced or reformatted in any way on the page, the
reformatting takes place when you choose this command for close
and then reopen the window).

Repaginate is especially useful after you copy and paste sections of
music to restore appropriate measure spacing. If you plan to do a lot
of cutting and pasting in the QuickScribe notation window, you may
want to try using the fixed measure spacing option instead of natural
spacing. Cutting and pasting can be much faster with fixed spacing.
When you are done editing, you can return to using natural spacing.

The tool palette The QuickScribe window tool palette allows you to insert notes, text.
and triplets. The Tools in this palette are explained at length in the
rest of this chapter.
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Working with
notes

Rests are automatic

Inserting notes with the
mouse

The QuickScribe notation window allows you to do basic sequencing
tasks, including inserting, step-recording, transposing, and editing
notes. The following sections describe what you can do in this
window.

In the QuickScribe notation window, you can insert notes with:

s The mouse

0 The Macintosh keyboard

■ A MIDI keyboard

All three methods involve using the tool palette.

Rests are handled automatically by Performer’s transcription
algorithms. You do not need to enter them.

Insert notes and other symbols with the mouse as follows:

To insert this: Do this:

A note Click the desired note duration in
the tool palette. Press anywhere in
the measure where you want to
insert the note. With the mouse still
held down, drag to the desired pitch
and location. Watch the cursor
coordinates to help determine the
beat location.

A note with an accidental Same as above.

A dotted note Click both the desired note duration
and the dot in the palette. Then
insert the same as above.

A chord Insert the first note as described
above. Click directly above or
below the first note to add more
notes to the chord.
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Inserting notes with the
Macintosh keyboard

A triplet Click a note duration in the tool pal­
ette and click the triplet tool. Both
are now selected. Insert each note
in the triplet as described above.

To add a dot to a note Click the dot tool and then click on
the notehead you want to add it to.

To change the duration of a note Click the desired duration in the
palette and click the note.

To change several notes to the
same duration

Select the notes with the arrow cur­
sor. Command-click the desired
duration or dot in the tool palette.
Note: to scale durations (to double
or halve them, for example) use the
Scale Time command in the Region
menu.

To change the location or pitch of
one or more existing notes

Click the arrow cursor and then
drag tire note as desired. To drag
multiple notes, select them before
dragging.

To insert notes and other symbols with the Macintosh keyboard:

1. Click the arrow cursor tool in the palette.

2. Click on the staff at the desired pitch and location for the symbol.

A blinking insertion cursor appears on the staff.
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3. Once you have a blinking insertion cursor on the staff, refer to the
following table:

To do this: Do this:

To move the cursor Use the arrow keys.

To determine the exact beat loca­
tion and pitch of the insertion
cursor

Use the cursor coordinates display
in the status bar at the top of the
window.

To select a duration Use the open bracket ( [ ) and
closed bracket ( ] ) keys to choose
the next highest and lowest dura­
tion. Or use the extended keypad
(see "Selecting durations with the
extended keypad" on page 364). Or
click the desired duration in the pal­
ette.

To insert a note Press return.

To insert a note with an acciden­
tal

Press the + or - key on the extended
keypad.

To insert the first note of a chord Press the enter key. (Enter inserts
the note without advancing the
insertion cursor.)

To insert the second, third,
fourth, etc. note in a chord

Press the enter key.

To insert a tuplet Press the t key to turn on the tuplet
tool, and use the bracket keys as
described above to select any note
duration. Press t again to toggle off
the tuplet tool.

To delete a note or chord Position the insertion cursor to the
right of the note and press the
delete (backspace) key.
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Selecting durations with
the extended keypad

Using the keyboard
when the QuickScribe
window is active

Hearing notes while
inserting them with the
mouse

Step Recording notes
with a MIDI controller

The following keys can be used on the Macintosh extended keypad
to select durations in the QuickScribe tool palette. These are the same
duration keys used for the Step Record command in the Basics menu.

The QuickScribe duration selection keys on the Macintosh extended keypad.

When the QuickScribe window is active (the front-most window),
several keys on the Macintosh keyboard change their function to
features that are specific to the QuickScribe window.

For example, the up and down arrow keys, which normally change
the currently record-enabled track in the Tracks window (unless you
programmed them for something else in the Remote Controls
window), move the note insertion cursor up and down instead.

To temporarily suspend the QuickScribe key bindings and return to
the normal bindings (in the Remote Controls window), hold down
the shift key, or press caps lock. If you use caps lock, the shift key
temporarily switches back to the QuickScribe key bindings.

To hear notes played back on a MIDI device as you insert them, click
the Audible mode button in the title bar of the QuickScribe notation
window. Notes are played on the instrument that the staff (track) is
currently assigned to in the Tracks window.

To insert notes with a MIDI controller:

1. Click the arrow cursor tool in the palette.
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I 2. Click on the staff at the location where you would like to begin
entering notes.

A blinking insertion cursor appears on the staff. Use the cursor
coordinates to determine the exact location in the measure. If
necessary, use the left and right arrow keys to move the cursor.

1111240 C5 • 84Cursor coordinates----------1
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3. Select a note duration.

There are several ways to select a duration: 1) click the desired
note duration in the tool palette, 2) press the open bracket ( [ )
and closed bracket ( ] ) keys on the Macintosh keyboard
repeatedly, or 3) use the extended keypad as described in
“Selecting durations with the extended keypad” on page 364. The
currently selected duration is displayed in the tool palette.

4. Play the desired note or chord on your MIDI controller.

Notes appear when you release the keys, so be careful not to slur
notes together. It’s best to play in a staccato fashion to avoid
accidentally inserting two notes when you only want to enter one.
If you would like to hold one note while inserting others, just
keep holding it down while inserting the other notes.

5. Play in as many notes and chords as you’d like.

Change durations as needed. Step Recording uses many of the
same keyboard actions as Macintosh keyboard entry, so you may
want to review the section “Inserting notes with the Macintosh
keyboard” on page 362.

Getting the arrow cursor
temporarily

While working with the tools in the palette, you may want to
temporarily restore the arrow cursor for selecting or some other
purpose. To do so, press the option key. While you hold it down, the
cursor turns into an arrow. When you release the option key, the
cursor switches back to whatever it was.
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Selecting notes for
editing

Cutting, copying &
pasting notes

Below is a summary of how to select notes for editing in the
QuickScribe notation window. Notes are selected with the arrow
cursor.

To select this: Do this:

A single note Click the item once.

Several notes that are not next to Shift-click each item.
one another

The notes in several measures Drag a selection box over the mea­
sures.

A region of notes Drag a selection box over them.

'*■ If a note is displayed as several tied notes, you can
click any notehead to select the entire note.

Selected notes 

When a single note is selected, its information appears in the info bar.
This information can be edited as usual.

aEal^alM......... ........ .....
91|2|240________F4«77| 91|2|260 JG4 195 ?64 01101

\] ....  ■■■ ' ==:-

Once notes are selected as described in the previous section, they can
be cut, copied, and pasted using the commands in the Edit menu. To
paste notes you have either cut or copied, click the staff with the
arrow cursor on the location at which you would like to paste the
material. Watch the cursor coordinates box (see “Notation window
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Using Region menu
commands

Changing note
durations

Working with
text

Inserting text

1|1|120 E3 • 64

T| .....
ff] <——Text Tool

s
0

Quick Reference" on page 346) to specify the exact beat location at
which you will paste. You can copy and paste between other editing
windows as well.

Cutting and pasting can be slow if you are using
natural measure spacing. You can used fixed measure
spacing to speed things up. See “Measure spacing" on
page 356 for more information.

After cutting and pasting, you can reformat the pages using the
Repaginate mini-menu command to clean up the display.

Similar to the Edit menu commands mentioned above, Any Region
menu command can be applied to notes you have selected. This
includes quantizing, transposing, and any other command from the
Region menu.

To change a note duration, click the desired duration from the tool
palette and click on the note you wish to change. To change several
notes at once, select them and then command-click the desired
duration in the tool palette.

The QuickScribe window Tool palette has several text items that let
you enter titles and other text on the page, including page numbers
and metronome markings.

Text is handled in a similar fashion to standard Macintosh graphics
programs. Text is placed on the page inside text boxes, which can be
cut, copied, pasted, and otherwise edited. A text box is a resizable,
transparent box in which you can type and edit text. If you have
worked with MacDraw, SuperPaint, or similar graphics software, you
are already familiar with how to use text boxes in Performer.

To insert text:

1. Scroll to the page on which you’d like to insert the text.

If you are inserting title page text, scroll to the title page. If you’d
like the text to appear on body pages, scroll to any body page.

2. Click the Text tool in the Tool palette.
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3. Drag out a text box on the page.

Making titles, headers,
and footers

1. Choose the desired text attributes from the Text menu.

Choose the desired font, point size, style, justification, and display­
properties from the Text menu. For details about the Display text
attribute, see “Making titles, headers, and footers” on page 368.

2. Type the desired text.

3. Click anywhere outside the text box to complete the text entry.

Titles, headers, and footers are inserted in the manner described in
the previous section. Just choose the appropriate Display attribute in
the Text menu as shown below.

Size
Tent

Style
Justify

►►
Display ► This page only >

Auant Garde
B fiuant Garde Demi
B Clearface Bold

✓ Title page only I
Body pages only
Both title & body pages

B Future Bold
B Garamond Bold

If the Title page only and Body pages only menu items are greyed out,
check the First page is title page option in the Score options command
located in the notation view mini-menu. For more information about
this option, see “Creating a title page" on page 352.
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Making page numbers

Displaying the current
date

Selecting text

Page numbers are inserted using the page number tool in the tool
palette.

X___ -_____ j
s
fii] -«—------------------ Page number tool

Ta
Using this tool, insert them in the same manner as described in
“Inserting text" on page 367. The page number automatically appears
in the text box. Be sure to choose the appropriate Display attribute
(Body pages only or Both title & body pages'). See “Making titles,
headers, and footers" on page 368 for more information.

The current date can be inserted using the Date Tool in the Tool
palette.

Using this tool, insert the date in the same manner as described in
“Inserting text” on page 367. The current date (as specified by your
Macintosh) automatically appears in the text box. Be sure to choose
the appropriate Display attribute (Bodypages only or Both title & body
pages).

To select an entire block of text, click it once. Handles appear to
indicate that it is selected.

Title
□
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To select individual words within a text box:

Typing and editing text
inside a text box

Pasting text into
Performer from other
programs

1. Double-click the text box to edit it.

2. Select the desired text by dragging over it

Play very fast

Once text is selected, it can be cut, copied, or deleted. You can also
change the font, style, and other attributes of the text.

To edit text, double-click it to get an insertion cursor inside the text
box. Once you have an insertion cursor inside the text box, use the
following actions to edit the text:

To do this:

Move the text cursor within the text
box

Delete a character

Select a word

Select several words or sentences

Change the font, point size or style
of some text in the text box

Justify the text to the left margin, to
the right margin or to the center

Finish inserting or editing the text

Cancel text editing

Cut, copy, and paste text within the
text box

Do this:

Press the arrow keys

Position the cursor to the right of it
and press the delete key

Double-click the word

Drag over them inside the text box

Select the text and choose the desired
font, size, and style in the Text menu

Choose Justify from the Text menu
and select the desired justification

Click anywhere outside the text box

Type command-period

Select the text and choose the desired
command from the Edit menu.

You can copy text from a text editing program such as Microsoft
Word and then paste it into a text box in the QuickScribe notation
window. Just copy the text from the other program, switch into
Performer, double-click or insert a text box, and then paste.
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Changing text attributes Text attributes like point size, style (bold, italic, etc.), justification
! (left, center, or right), and display properties (title page only, etc.) can
I be changed after text has been entered.

To change the attributes of an entire text box, click the text once to
select all of the text in the box. Then choose the desired attributes in
the Text menu. This works for staff names, staff abbreviations, and
marker text as well.

To change the attributes of individual words within a text box:

1. Double-click the text box to edit it.

2. Select the desired text by dragging over it

Play yety fast

3. Choose the desired text attribute from the Text menu.

4. Click anywhere outside the text box to complete the text entry.

Play very fast

Installing fonts in the
Text menu

The fonts that you see in the Text menu are the fonts that you have
installed in your Macintosh system. If you are not familiar with how
to install text fonts in your Macintosh system, refer to your Macintosh
documentation.

<•* When troubleshooting font problems in Performer,
determine if the problem occurs in your word­
processing software, or other programs that deal with
text. For example, if you can’t find a font that should
be in the list, check the font list in your word
processor. Most likely, it will be missing there, too, and
you know that the problem lies somewhere in the
Macintosh system.

Printing a track as a
single instrument part

To print a track as a single instrument part:

1. Select the entire track.

If you need help with this, see “Choosing what tracks to display”
on page 347.
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2. Click the QuickScribe notation button to open the notation window.

3. As described in this chapter, add text to the title page and set the
Score Options in the mini-menu as desired.

4. To display the track name in front of the staff as the instrument
name, use the Part Names option in the Score Options mini-menu
command.

5. If you are printing several instrument parts, repeat this procedure
for each track.

You won’t need to change the Score options because the
formatting is remembered when you change tracks. Just close the
current part, select the next track and click the QuickScribe
notation window button to view and print the next part.

If you want to preserve the notation window separately for each
track, you can do so by copying each track into its own separate
sequence. Since each sequence has its own separate QuickScribe
notation window, each part will be preserved.

Printing a keyboard part
on a piano staff

Use the procedure in the previous section to print a keyboard part
(which is in a single track). To display the track on a grand staff:

1. Choose Track Options in the QuickScribe notation window mini­
menu).

2. Choose the track that contains the keyboard part from the pop-up
list.

3. Uncheck the Use Default check box, if necessary.

4. Choose the Grand Staff option.

5. Set the spacing options as desired.

6. Click OK.

Printing a score When you select multiple tracks, Performer places them together in
the same staff system. So, to print a score, select all the tracks you
want to include in the staff system for the score, and then open the
QuickScribe notation window. To adjust the spacing between the
staves in the system, as well as the spacing between systems, choose
Score Options (score window mini-menu) and set the spacing
options as needed.
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Creating blank staff
paper

Controlling note
spellings

j To create blank" staff paper:

i 1. Select empty tracks.

Select as many empty tracks as you’d like staves in the systems on
the page.

2. Open QuickScribe notation window.

3. Use the Measure spacing and Set Score Length mini-menu
commands to determine the number of empty measures.

Accidentals in the QuickScribe window are governed by the curr
key signature in the Conductor track. To change the way notes a
spelled, use the Change Key command in the Change menu. Fo
more information, see chapter 32, “Change Key" (page 547).
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chapter 24 System Exclusive

Basics

Performer allows you to record, playback, and edit MIDI System
Exclusive messages. Common types of System Exclusive messages
include patch dumps, preset selections, editing parameters, etc.
Performer can thus store patches, samples, and other important
information from your MIDI equipment in system exclusive form.
Patches, edit parameters, and other special commands can be
incorporated into musical sequences, greatly expanding the resources
of your MIDI sound modules.

System Exclusive messages are a special type of MIDI data. A System
Exclusive message consists of a header, body, and an ‘end of
message’ byte. (A byte is a unit of digital information, roughly
equivalent to a single character or letter.)

The header labels the following data as System Exclusive information,
and includes a code identifying the manufacturer of the equipment
transmitting the data.

The body of the message contains the actual data being sent. This
data may take any form the manufacturer desires. While there are
some standards for the formal of System Exclusive information, for
the most part a System Exclusive message is only understood by the
type of equipment that generated it. As a result, recording a patch
dump from one synthesizer and sending it to another will generally
not produce useful results. Performer does not respond to or interpret
System Exclusive data; any analysis or editing of the body of the
message is the user’s responsibility.

Finally, the end of message byte, F7, marks the end of the System
Exclusive data, and signals Performer to interpret subsequent
information as standard MIDI data.

As defined in the MIDI specification, a System Exclusive message
must begin and end with an FO and F7 byte, respectively. In addition,
only hexadecimal values of 7F (127 in base ten) or less are allowed.
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Recording and Playing
System Exclusive
Messages

When yon click the OK button after inserting or editing the contents
of a System Exclusive event, Performer will scroll to and highlight any
bytes that violate the conditions just stated.

System Exclusive messages are recorded and played back like any
other MIDI data. These messages vary in size; information for a bank
of patches, for instance, may be 10-20K or more. No matter how long
a message is, it is treated as a single event by Performer. Note that a
long System Exclusive message can briefly halt recording or playback
as Performer processes the data; it is best to place larger System
Exclusive events like patch or bank dumps in separate sequences, or
at the start of a sequence before the actual music begins.

Because System Exclusive messages have no channel assignment,
they are sent to every' MIDI device connected to a port. If you have
several devices of the same model or brand connected to the same
port they may all respond to a message sent to or from just one of
them. Conversely, some manufacturers encode channel assignments
into the body of the System Exclusive message. Performer is unable
to access or rechannelize such an assignment.

For example, if the playback assignment for a track is channel 1, but
a System Exclusive message full of patches intended for that synth
includes an encoded assignment to channel 16, the synth won't
receive the patches.

Find out if any of your equipment encodes channel assignments in its
System Exclusive messages, and be careful about changing channel
assignments on equipment to which you intend to send System
Exclusive. If you encounter difficulty when working with System
Exclusive data, try' patching the MIDI device directly' to the Macintosh
MIDI interface, to prevent interaction with other equipment.

Note that the Input Filter, found in Performer's Basics menu, defaults
to System Exclusive unchecked. Unless you explicitly' check the box
next to System Exclusive, you will be unable to record System
Exclusive messages.
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Viewing & Editing
System Exclusive Data

System Exclusive data can be viewed and edited in the Event Editing
window for the track on which it is recorded. In an Event List, a
System Exclusive message will consist of the System Exclusive symbol
and as much data as can fit on one line:

□ FO 43 01 05 7C 28 32 F7

To see the entire message, option-click or double-click on the System
Exclusive event. A window appears:

Insertion Mode Button Transmit Button Replacement Mode Button

\ ;--------- :---------\
\ Length: 8 t Trauaam J
\ 0: FO 00 00 03 33 00 01 |F7 ... .3/. .
\ 8: /

kJ__
H

Length: 77 ' - | |F01 00 | UZ ( f

0: FO 00 03 00 02 10 01 21 ..............
8: 00 12 10 13 20 11 02 01 ..............

10: 01 23 01 20 12 01 0E 01 ......
18: 20 12 OF 01 02 10 20 12 .........
20: 01 20 10 20 12 01 20 10 ....
28: 20 12 01 21 00 10 21 02 ..!..!
30: 10 20 E0 F0 12 10 21 02 ............I
38: 10 21 02 10 20 10 21 02 .I.. .I Q-,

Position

A
I

A A
I

Hexadecimal System Exclusive data Alphanumeric

(hexadecimal) Translation

The window is divided into a top and bottom portion. The bottom
portion displays the system exclusive data contained in the event.
The top portion is used to type in and transmit short system exclusive
“request” messages, which can be sent to a synthesizer that requires
a short system exclusive bulk dump request message to initiate a bulk
dump to be recorded into the lower portion of the window.

The System Exclusive data is displayed in hexadecimal (base 16)
numbering. Each pair of hexadecimal digits, which include the
numerals 0-9 and the letters A-F, represents a byte of data. Each line
contains eight pairs of digits. To the left of each line of data is a two-
digit hexadecimal number indicating the position of the first byte of
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Editing Data in the
System Exclusive
Window

|fo So

|F0 03

data in that row. The first row starts at position 00, the next at 08. the
third at 10 (this equals 16 in hexadecimal), and so forth. To the right
of each row of data is its translation into alphanumeric characters
(using the ASCII standard). Most of the time this translation will be
garbled and useless, but patch names and other text in the System
Exclusive message may be visible.

The length of the System Exclusive message is displayed at the top
left. This is the number of bytes of data in the message.

The scroll bars let you scroll through long messages. The Grow box
in the lower right corner lets you adjust the size of the window. When
you press the OK button, Performer checks the changes you have
made to the data and will scroll to and highlight any byte that does
not conform to the MIDI specification. After confirming your
changes, Performer closes the window. Pressing the Cancel button
closes the window without making any changes to the data.

You can directly edit the hexadecimal data in the System Exclusive
window using the mouse and Macintosh keyboard. There are two
basic editing modes: Insertion mode and Replacement mode. The
editing mode is selected by clicking on the appropriate button at the
top center of the window; the currently selected mode is indicated
with a darkened border.

Insertion mode: This mode is similar to standard Macintosh text entry.
To insert new values, click the mouse to position the insertion point.
and type in new values. Use the delete key to delete previous digits.
You may edit only in the hexadecimal portion of the display.

Replacement mode: In this mode, one character is always highlighted.
Typing a new character replaces the current highlighted character,
and then highlights the next character. Use this mode if you are just
changing a few bytes in a system exclusive message, as the display
requires less updating while typing new values.
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Cutting, Copying, and
Pasting

To edit a System Exclusive event:

1. Activate the Event Editing window that contains the System
Exclusive event.

If neither Event Editing window for the track is open, double-click
on the track name and an editing window' will appear. If one is
open, simply click on it.

2. Double-click on the System Exclusive event.

The System Exclusive window' appears.

3. Select the editing mode.

Click on the appropriate button. If just a few' bytes need to be
edited, use Replacement mode. Otherwise, use Insertion mode.

4. Edit the data.

In Insertion mode, delete the incorrect bytes and type in new' data.
In Replacement mode, click on the first digit of data to be replaced
and type in the new' data. The old data is written over.

5. Press OK to confirm your changes and close the window, or
Cancel to close the window without making any changes to the
data.

If you press OK, Performer will scroll to and highlight any byte
that does not conform to MIDI specification requirements.

To Cut, Copy, or Paste a region of hex data in replacement mode:

1. Select the data.

To do so, drag over it with the mouse.
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Inserting System
Exclusive Data in an
Event Editing Window

2. Cut, copy, or replace the selected region.

To Cut or Copy, press command-X or command-C respectively.
The selected data will be placed in the Clipboard. To replace the
selected data, type in or paste new data, which will replace the
highlighted data.

You can insert system exclusive data into an Event Editing window.
This is handy for inserting a short system exclusive message, like a
parameter change or dump request, without having to record it. The
following steps apply to System Exclusive insertion in an Event List
window. Refer also to the chapter The Graphic Editing Window.

To insert a System Exclusive event into an Event List window:

1. Activate the Event List window into which you want to insert the
System Exclusive event.

If the Event List window is not open, double-click on the track
name to open it. If it is open, simply click on it.

2. Press the Insert button in the title bar of the Event List window.

3. Select System Exclusive from the menu.

A new system exclusive event pops up.

4. Enter the location for the system exclusive event.
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Editing System
Exclusive Data With the
Edit Menu

Transmitting a System
Exclusive Message

Recording Sysex into
the Editor Window

1 5. Press the Tab key to move to the data field.

The System Exclusive window appears.

6. Select Insertion mode.

Click on the left button at the top center of the window.

7. Type in the data.

In Insertion mode, you can delete the incorrect bytes and type in
new data. See the above section on editing System Exclusive data
for more information.

8. Press OK to confirm the insert and close the window, or Cancel to
cancel the insert and close the window.

When confirming your insert, Performer will scroll to and
highlight any byte that does not conform to MIDI specification
requirements.

The commands on the Edit menu work as normal on System
Exclusive events; these events can be cut, pasted, shifted, etc. within
a file or between files just like any other Performer event. The only
way to alter the body of a System Exclusive message is to use the
System Exclusive window as described above. In all other cases,
Performer treats the message as a single event.

To transmit a system exclusive message from the system exclusive
editor window:

1. Click the insertion mode button.

2. Click between the FO and F7 in the top portion of the window.

3. Type in the system exclusive data.

4. Click Transmit.

To record system exclusive into the system exclusive editor window:

1. Be sure that your MIDI hardware and cables are set up properly.

Make sure there is a MIDI cable from the MIDI OUT on the device
you will be recording from to the MIDI IN on your interface. 

System Exclusive 381



i 2. If Performer is in MultiRecord mode, switch to regular record mode
to avoid problems.

To do so, select MulliRecord in the Tracks window mini-menu to
uncheck it.

3. Open an Event Editing window for a track and press the Insert
button in the title bar.

4. Choose System Exclusive from the menu.

A system exclusive pop-up event will appear.

5. Type in the measure, beat and tick location for the event, using the
tab key to move from one field to the next.

6. Press tab one more time to open the System Exclusive Editor
window.

The system exclusive editor window will appear.

7. If necessary, type in a bulk dump request message in the top
portion of the window.

This is only necessary if your synth requires it. Many synths allow
you to initiate the transfer by pressing a button on the synth itself.

8. Initiate the system exclusive data transfer from your MIDI device.

To do so, press the button on the device—or whatever is needed-
-to cause it to transmit the desired system exclusive dump. If you
typed in a bulk dump request message, click the Transmit button.
If all is well, the system exclusive data will appear in the lower
portion of the window.

9. Click OK to save the system exclusive data or cancel to discard it.

It is not necessary to enable system exclusive data in the Input Filter
when recording data into the system exclusive editor window.
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Recording System
Exclusive into a Track

As with earlier versions of Performer, you can also record system
exclusive data into a track. To record a system exclusive message into
a track:

1. Be sure that your MIDI hardware and cables are set up properly.

Make sure there is a MIDI cable from the MIDI OUT on the device
you will be recording from to the MIDI IN on your interface.

2. Choose Set Input Filter from the Basics menu in Performer and
check the System Exclusive option.

If the System Exclusive option is not checked, system exclusive
data will be filtered on input and will not be recorded.

3. If Performer is in MultiRecord mode, switch to regular record mode
to avoid problems.

To do so, select MultiRecord in the Tracks window mini-menu to
uncheck it.

4. Record-enable a track in the Tracks window.

5. Start recording.

6. Send the system exclusive data from your MIDI device.

To do so, press the button on the device—or whatever is needed-
-to cause it to transmit the desired system exclusive dump. It you
have the MIDI Monitor window open, you will see the MIDI
System Common light (labelled Co) turn black while the data is
being received by Performer.

7. Wait a few seconds, longer if it is a large bulk dump, and then stop
recording.

8. Open the Event List window to view the System Exclusive event in
the track.

What you should see is something like this:
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Hints

If the Event List window is empty, or you do not see a System
Exclusive event, check the Input Filter and cable connections and try7
again. You may also want to open the MIDI Monitor window to see
if the data is actually being received by the Macintosh. If the Co light
doesn’t turn black when you send the data from the device, then
there is a problem with the MIDI connections or with the device that
is transmitting the system exclusive.

Most synthesizers and many other MIDI devices allow you to dump
patch settings as System Exclusive messages. You can use Performer
to store and organize these messages, creating a library' of patches
and presets. Store each patch or bank of patches as a separate­
sequence in one or more files. This way you can use the name and
comment fields to label your presets, and use the Load command to
quickly access them. To restore a patch or bank, load the desired
sequence and play it.

You can paste System Exclusive dumps of sounds and settings at the
start of a sequence. This lets you use patches or settings that can t fit
into your MIDI devices’ preset storage, and ensures that the right
sounds are loaded for the sequence. Use the standard Copy and Paste
commands to place the system exclusive events at the start of the
sequence. It is best to leave a measure or two of space after the
system exclusive messages and the start of the music, to allow your
equipment to process the data. Use the comments fields in the
Chunks and Tracks windows to describe the system exclusive data
you’ve pasted into your sequence; system exclusive messages are
hard to identify from their appearance.

Some manufacturers allow you to edit patch parameters over MIDI.
using short system exclusive messages. This can add a great deal of
expression to a sequence. For example, the attack of a filter envelope
could be controlled with system exclusive and controller data.
creating different bowing effects with a violin patch.

Some instruments must receive a handshake message before they will
transmit a System Exclusive message. If this is the case with one of
your MIDI instruments, first consult the user’s manual for the
instrument (or if necessary, the manufacturer) to find out the
hexadecimal string that comprises the handshake message. Type- this
message into a Performer track using the System Exclusive editing
window as described above, then copy the track and paste it to a
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Be Careful

‘library’ sequence for backup purposes. Back in the original
sequence, play-enable the track containing the handshake message
and record-enable an empty track. Upon playback, the handshake
will be transmitted to the instrument, which will respond by dumping
to the record-enabled track.

System exclusive data is not associated with a channel, as defined in
the MIDI specification. System exclusive data in a track is merely sent
to the port you specify for playback; no channel number can be
attached. Some manufacturers have decided to include a channel
number in some of their system exclusive messages. This number
cannot be changed. Therefore, even if data is being sent to channel
3, for example, system exclusive messages contained in that data
might be sent to a channel other than 3-

System exclusive data is complex, and varies greatly from device to
device. If you are uncertain about your equipment’s system exclusive
implementation, you should be very careful in using or editing
system exclusive data. Most of the time, turning a piece of equipment
off and then on again will clear any strange behavior caused by
incorrect system exclusive data; however, incorrect use of system
exclusive data could permanently erase presets from a synthesizer or
other MIDI device.
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Chapter 25 Selecting Regions

Selecting a Region to
Edit

Selecting a Region
Using the Tracks List
and the Edit Bar

This chapter explains how to unleash Performer’s powerful Edit
menu and Region menu commands. Specifically, it tells you how to
select regions of data. Once selected, the region can be modified with
any command in the Edit menu or Region menu.

The commands in the Region menu and Edit menu change data in a
selected region of a single sequence. This region must be specified
before selecting a command from one of these two menus.
Otherwise, Performer won’t know where to make the changes to the
data. We’ll refer to this area as the “selected region ”.

A region can be selected in the Tracks List, the Tracks Overview, or
in the Event Editing window for a track. Each track has three
available Event Editing windows: the Event List window, the Graphic-
Editing window, the Notation Editing window, and the QuickScribe
notation window.

Once you have selected a region in one of these
windows, the window must remain active when you
choose the desired Edit menu or Region menu
command. If the window containing the selected
region is not activated, either no data will be changed
or unwanted data will be changed. To activate a
window, click its title bar anywhere.

This method of region selection allows you to select a region
containing any combination of tracks. It lets you specify the region
numerically, which gives you a high degree of precision. It works
with all Edit menu and Region menu commands.

Another advantage of this method is that the region remains selected
after you choose an edit command. This allows you to do multiple
operations on the same region without resetting its Start and End
times.
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i 1. Activate the Tracks window for the sequence you wish to modify by
clicking on it.

The title bar of the window will activate.

Shortcuts for using the
Edit Bar

2. Enter the Start time of the region in the Edit Bar.

See the preceding section, Using the Edit Barter details on
entering the Start time in the Edit Bar.

3. Enter the End time of the region in the Edit Bar.

See the next section, “Shortcuts for using the Edit Bar" for details
on entering the End time in the Edit Bar.

4. Select the track or tracks that contain the region.

Click on a track name to select a track, or drag over a set of tracks.
Use Shift-click to select non-contiguous tracks.

The region is now selected.

Events occurring on or after the Start time and before the End time
will be affected by a region command. For example, in 4/4 time, if
the Start time is 9111000 and the End time is 13111000, all events
starting on the very first tick of the first beat of bar 9 through the very
last tick of the fourth beat of bar 12 (12141479) will be modified. An
event occurring directly on 13111000 (the very first tick of the first
beat of measure 13) will not be modified.

The Edit Bar holds the beginning and end times for the selected
region in the Tracks List. To enter a beginning time, click in a field in
the Start time and enter a value; to enter the end time, click in a field 
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i in the End time and enter a value. You can use the Tab key (or
decimal point key on the keypad) to cycle through the
measure I beat I lick fields.

Clicking on the word ‘ Start" enters the current lime displayed in the
Counter as the Start time. Clicking on the word “End” enters the
current time as displayed in the Counter window as the End time.

Double-clicking on the word ‘Start" enters the beginning time of the
sequence as the Start time. Double-clicking on the word “End" enters
the end time of the sequence as the End lime.

Double-clicking on the word Edit sets the Start and End times to the
beginning and end of the sequence. This is equivalent to double­
clicking on both the Start and End words. There are several quick
ways to load times into the Edit Bar.

Edit I Start:|| 1111000 End: | |5l1l000

The Remember Times command is a powerful way to set the edit bar.
If you have a region selected in another window besides the Tracks
window, and you want to load that region’s start and end time into
the Edit bar in the Tracks window, use Remember Times. To
“remember" a pair of Start and End times, activate the window
containing the times and choose Remember Times from the Basics
menu (or press command-R).

Times are remembered for each type of window as follows:

■ Markers window: the times of the first and last highlighted
markers are remembered.

■ Event Editing windows: the times of the first and last
highlighted events are remembered.

■ Tracks window: the times in the Edit Bar are remembered.

■ Consolidated Controls panel: the times in either the
Memory Bar or Auto Record Bar are remembered.
whichever is visible. If both are, the Memory Bar times are
remembered.
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Selecting a Region in the
Tracks Overview

■ Once you have used Remember Times, click the word “Edit" in the
I Edit bar. The remembered times are loaded into the Edit Bar.

: To edit the data in a segment, you must first select it. When a segment
is selected, it highlights. Segment selection is exclusive from track
name selection in the Tracks List. If you select segments, any
highlighted track names will deselect.
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Selecting a Region
Using Event Editing
Windows

Selecting a Region
Using the Event List
Window

Below are several convenient shortcuts for selecting segments:

To select this:

/X single segment

Several adjacent segments

Several non-adjacent segments

A segment in all tracks

One or more segments in all
tracks

Deselect segments when more
than one are highlighted

Do this:

Click it.

Drag over them. If the segments
are in several adjacent tracks,
drag over them in a diagonal
fashion.

Hold down the Shift key and click
the segments you wish to select.
They will highlight.

Click the segment in the Time
Ruler. All segments beneath will
highlight.

Drag in the Time Ruler.

Hold down the Shift key and click
the segments you wish to dese­
lect. They will unhighlight.

After you select one or more segments, Performer loads the start and
end times of the region into the Edit bar for convenient selection in
the Tracks List.

Selecting data in an Event Editing window allows you to precisely
specify the region’s boundaries; you can even select a single event if
you want.

Each track has four available Event Editing windows: the Event List
window, the Graphic Editing window, the Notation Editing window,
or the QuickScribe notation window. The data in the track is the
same regardless of which window you use. For example, if you edit
data in the Graphic Editing window, the changes you make will be
immediately reflected in the track's Event List window.

This method of region selection allows you to precisely specify the
region’s boundaries; you can even select a single event if you want.
The Snip, Repeat, and Retrograde commands do not affect events
highlighted in the event list. All other edit and region commands do. 
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if the Event List window for the track you wish to modify isn’t already
open:

1. Click on the track name containing the region to highlight it.

This selects the track.

2. Choose Edit from the Tracks window mini- menu.

An Event Editing window for that track will appear. If the Graphic
Editing window appears, go to the mini-menu on its title bar and
choose Event List. The Event List window for the track will appear.
Alternatively, you can just double-click on the name of the track
you wish to modify. If the Event List window is open but not
active (i.e. its title bar isn’t visible), simply click on the Event List
window to activate it.

3. Select the region of events you wish to change.

Below is a summary of how to select events in the Event List.

To select this: Do this:

A single event Click on it.

Several adjacent events Drag over the desired events. All
events dragged over will highlight.

Several non-adjacent events Hold down the Shift key and click on
the events you wish to select. They
will highlight.

Deselect events Hold down the Shift key and click on
the event(s) you wish to deselect.
They will unhighlight.

Extend the currently selected
region

Command-click or Command-drag at
the desired end location.

This defines a region of events which will be affected by the next
command on the Edit or Region menus.
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Selecting a Region
Using the Graphic
Editing window

There are two ways to select data in the Graphic Editing window:

1. Drag a selection box over the desired notes (or other
data)

2. Drag horizontally in the Time ruler at the top of the
window

'S’ ________ _______ ___2 h Cl a ri n e t \
• 60 [j Start: 2|1|000 End: 4|11000 | |j Unit = J 1

For more information about selecting a region using the Graphic-
Editing window, see “Selecting Notes" on page 311.
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Selecting a region using
the Memory-cycle repeat
barlines

Selecting Chunks in the
Song Window

Selecting in the
QuickScribe notation
window

If you would like to quickly select the region within the Memory­
cycle repeat barlines to insert a loop, quantize, or any other editing
operation, double-click one of the two repeat barlines in the Tracks
Overview or Graphic Editing windows.

Bass(Uerse 1)
!□ Unit = J 11000 beats

i_________________
1000 End: 5111000

A Chunk in a song window can be selected by clicking it once. To
select several adjacent Chunks, either drag over them or shift-click
each one. To select non-adjacent Chunks, shift-click each one.

For information about selecting notes in the QuickScribe notation
window, see “Selecting notes for editing” on page 366.
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Chapter 26 Edit Commands

Editing During Playback

Selecting a Region

Editing Commands and
the Song Window

Setting the Edit Filter

After you’ve recorded your music, Performer’s powerful editing
commands are at your disposal to add, remove, and otherwise
rearrange data in a sequence or song. You can edit any amount of
data from single events to large regions.

Almost all of the editing operations discussed in this chapter can be
done while the music is playing back so that you don't have to stop
and start the music to hear the result. For example, you could
Transpose while the sequence is playing and then use the Undo/
Redo command as the music continues playing to compare the
original and modified data.

The commands in this chapter act on the a selected region in the
Tracks List, the Tracks Overview, or one of Performer’s track edit
windows. Without a selected region, the commands in this chapter
do nothing. So be sure to learn how to select a region by reading
chapter 25, “Selecting Regions ”. It contains many powerful shortcuts
that will speed up your work.

The following Edit commands can be used in the Song window: Cut.
Copy, Paste, Erase, and Select All. Other Edit commands such as Snip,
Splice and Repeat have no effect on Chunks in the Song window.

The Edit Filter allows you to specify what types of MIDI information
are affected by commands from the Edit menu. It is in effect only
when you select a region from the Tracks window. (When editing a
region in an Event Editing window, use the View Filter instead.)
Using this feature, you can extract different types of information from
a region without having to laboriously edit out events that you don't
want. For example, if you wanted to copy only patch changes and
aftertouch from a track, you could select only those items in the Edit
Filter. Only the selected data would be copied to the clipboard. As
another example, if you were editing Tempo changes in the
Conductor track, you could set the Edit Filter for Tempo changes
only. You could then cut and paste Tempo changes without erasing
or in any way affecting meter and key changes in the same region.
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Remember, the Edit Filter setting you make will affect all the
commands from the Edit menu, and all editing from the tracks
window. You should therefore make sure to change it back after
doing a specific editing task since it may cause unwanted effects the
next time you use the Edit commands.

To set the Edit Filter:

1. Choose Set Edit Filter from the Edit menu, or press command-F.

A dialog box appears.

® Notes ® ± Mono pressure ® T Markers
® o' Pitch bend ® i± Poly pressure ® Tempo changes
® “b Patch/song changes ® □ System exclusive ® Meter changes

® Tune request ® Key changes
® Mode changes ® Loops

® A Controllers

2. Choose the types of data to be edited by checking the check box
for each.

You can choose multiple types of data. You can choose all types
of data at once by clicking on the “Set All" button. You can
uncheck all the check boxes by clicking on the “Clear" button.
Using option-click will check only the check box you click on,
unchecking all others; using command-click will check all boxes
except the one you click on. Use the Controllers box and its
options buttons to select which controllers are affected by Edit
operations.

3. Press OK to confirm your choice or Cancel to cancel it.
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Specifying Controller
Numbers in the Edit
Filter

The Clipboard

Undo/Redo

The types of data you select will stay hi effect until you change the Edit
Filter setting. When you are clone using the Edit Filter, you should
reset it.

The buttons under the Controllers check box in the Edit Filter allow
you to quickly choose which controller data to include in Edit
operations. Click in the Controllers check box, click on the type of
option you wish and then enter the controller numbers if necessary.

□ All: All controllers will be affected by Edit operations.

□ All except: All controllers except the controller numbers
you enter will be affected by Edit operations.

0 Only: Only the controller numbers you enter will be
affected by Edit operations.

To enter controller numbers for the All except and Only options, click
in the text boxes next to the option and type in the numbers. You can
use the Tab key to move between boxes in the same option.

The Clipboard is a temporary storage place that holds data that is cut
or copied. All data that is cut or copied is put on the Clipboard. When
you paste, the data to be pasted comes from the Clipboard.

The Clipboard retains data until a new cut or copy action is made.
This means that you can cut or copy a region of data once and paste
this same information as many times as you like. 77?e Clipboard
retains its data between files. You can therefore copy data from one
file and paste it into another.

To view the Clipboard, choose the Show Clipboard command from
the Edit menu. To close the Clipboard, choose the Hide Clipboard
command from the Edit menu.

The Undo command will undo the effects of both real-time and step
recording. Undo will also undo the effects of most commands and
actions that add, delete, move, or otherwise modify data.

The Undo command will change to reflect the name of the command
just invoked. For example, if Transpose were chosen from the Region
menu, Undo Transpose would be displayed on the Edit menu when
next pulled down.
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Cut

Before measure 3 is cut:

Copy

Before measure 3 is copied:

I When the Undo command is used, it will generally change to Redo.
\ Redo will reinstate the recording or changes to the data you have
, made. This allows you to effectively undo the Undo, that is, return

the sequence to its state before the Undo command was invoked.

You can go back and forth between the Undo and Redo commands
as many times as you like. This allows you to make A/B comparisons
between the original and modified versions of the region.

The Cut command removes data in the selected region and places it
on the Clipboard. This does not remove the lime region specified;
instead, it leaves the measures blank (silent), without MIDI events.
The type of information that is cut is determined by the Edit Filter.
The Cut command is undoable.

After measure 3 is cut:

(The length of the music is the same.)

The Copy command copies the data from the selected region and
places it on the Clipboard. The original data is not affected at all. The
type of information that is copied is determined by the Edit Filter. The
Copy command is undoable.

After measure 3 is copied:
(The length of the music is the same.)
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Paste

Measure 3 from Track-1 is

copied into the clipboard:

The Paste command inserts the contents of the Clipboard (i.e.
whatever was most recently cut or copied) at the Start point in the
Tracks window, replacing what was previously there. The End time
in the Edit bar has no effect. The length of the pasted region is exactly
that of the data in the Clipboard (including any blank space at the
beginning and end of the region that was placed on the Clipboard).
The types of information pasted from the Clipboard are determined
by the Edit Filter. In addition, only the types of data selected in the
Edit Filter are replaced; all other data is unaffected. The Paste
command is undoable.

Clipboard

3

Track-1 | i I !
12 3 4 5

Track-2 K\\\\\X\\\]
8 9 10 11 12

Track-2 before measure 3 is pasted:

Track-2 after measure 3 is pasted: Track-2 kWHWXKWI______l\\\]
8 9 10 11 12

Erase The Erase command works like the Cut command except that no data
is put on the Clipboard: all data in the selected region is removed and
the region is left blank. The types of data erased are determined by
the Edit Filter setting. The Erase command is undoable.

Before measure 3 is erased:

After measure 3 is erased:

(The clipboard remains empty.)

Repeat The Repeat command makes an internal copy (which does not go on
the Clipboard) of the data in the selected region, then pastes, splices
or merges this data repetitively immediately following the selected
region. For example, repeating bars 1-3 three times places a copy of
bars 1-3 in bars 4-6, 7-9, and 10-12. Regardless of the events in the
region, the entire selected region is repeated. In the above example,
the start and end locations in the Edit bar would be set to 1111000
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Merge

| and ill 1000. respectively. The entire three bar region is repeated,
with each repetition starting on the down beat of the following
measure. In most cases, it is best to select entire measures or groups
of measures to repeat; this ensures that the repetitions will line up
correctly with measure boundaries.

You must select a region with the Tracks window and Edit bar to use
the Repeat command; this command will have no effect on a region
selected within an Event Editing window.

Using the Paste option in the Repeat dialog box, the repeated data
replaces the data in the repeated region: the pre-existing data is
erased. Using the Merge option in the Repeat dialog box, the
repeated data is merged with the data in the repeated region. Using
the Splice option in the Repeat dialog box, the repeated data moves
the pre-existing data to a later time in order to make room for the
data in the repeated region. The types of data repeated are
determined by the Edit Filter setting, as are the types replaced by the
Paste option and shifted by the Shift option.

The Merge command combines the contents of the clipboard with
pre-existing data in the selected tracks. The new data is inserted at
the Start time in the Tracks window, mixing together the data already
in the region and the new material. You need only specify a Start time
in the Edit Bar of the Tracks window; the End time has no effect. The
types of data merged from the Clipboard are determined by the Edit
Filter setting. The Merge command is undoable.

Since Performer allows unlimited tracks assigned to one channel, the
Merge command isn’t always necessary. You should use it only when
you are certain that data in two tracks should be merged together
(this is often true when you create a track during editing for the
express purpose of merging it with another track later). Once tracks
are merged, they cannot be separated later.

Track-1 
1 2 3 4 5

Track-2 ZZZZZZXZZZZZZZZZ2
1 2 3 4 5

Merged Track 
1 2 3 4 5

400 Edit Commands



Snip The Snip command removes data in the selected region and places it
on the Clipboard. The time region containing the data is removed as
well, closing up the gap between the beginning and end of the
region: events at the End time are moved to the Start lime. The types
of data snipped are determined by the Edit Filter setting. The Snip
command is undoable.

Before measure 3 is snipped: Track-1 iBPMSWilll
12 3 4

ZU
5

After measure 3 is snipped:
(Measures 4 & 5 are shifted to 3 & 4.)

Track-1 K\\\\\\| I I
1 2 3 4 5

Splice The Splice command inserts data on the Clipboard in the selected
region, making a gap for the new data and moving pre-existing data
later in time to make room for the new material. The event just after
the Start time moves forward the amount of time of the region on the
Clipboard. Thus, if a one-measure section is copied to the Clipboard
and spliced at measure 3, the old events starting at measure 3 shift to
measure 4. The types of data spliced from the Clipboard are
determined by the Edit Filter setting, as are the types shifted to make
room. The Splice command is undoable.

Before measure A is spliced:

After measure A is spliced:

(Measures 3 & 4 are shifted to 4 & 5.)

Track-1 I  I
1 2 3 4 5

Track-1 KWXWXIIHIIII I I
1 2 3 (A) 4 5

Shift The Shift command moves the selected region ahead or back in time.
The shift distance is specified by a number of measures and/or a
quarter notes I ticks duration, entered into a dialog box. Measures are
computed based upon the meter marking at the start point of the
selected region. To move the region ahead, select the Advance
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option; to move it back, select the Delay option. The region will be
shifted in time by the amount yon enter. The types of data shifted are
determined by the Edit filter setting. The Shift command is undoable.

Show/Hide
Clipboard

Select All

Editing Between
Several Tracks

Choosing Show Clipboard from the Edit menu brings up a window
which describes the contents of the Clipboard (in text). When the
Clipboard is showing, the menu entry changes to Hide Clipboard.
When you choose this, the Clipboard window is closed. For a
description of the Clipboard, see the section The Clipboard earlier in
this chapter.

This command generally selects all items in the active window. If a
Tracks window is active, choosing Select All will select all the tracks
(thus highlighting all track names). If an Event List window is active,
choosing Select All will select all events in it.

You can use the Edit commands to move or change data from one or
more original tracks to one or more target tracks (even in another
file). The number of original and target tracks doesn’t have to be the
same. If they are unequal, Performer will cycle through the target
tracks, pasting and merging from the original to the target tracks until
all original material is placed. Three examples are given. In the first
there is one original track and several destination tracks. In the
second the number of original tracks is less than the number of target
tracks. In the third the number of original tracks is greater than the
number of target tracks.
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Example one: You have copied data from one track and paste or
merge it to four destination tracks:

1 J

2 j

3

If pasted or merged, the data from the one original track is placed in
each destination track.

Example two: You have cut information from two tracks and paste or
merge it to five destination tracks:

I A |

I B |

1=A
2=B
3=A
4=B
5=A

If pasted or merged, track A’s information goes to track 1. then track
B’s goes to track 2. The process proceeds in the same manner until
track 5: track A goes to 3, B to 4, and A to 5.
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Example three: You have copied information from five tracks and
paste or merge it to two destination tracks:

Paste: 1=E, 2=D
Merge: 1=A+C+E

2=B+D

Hints

Removing a Specific
Type of Data From a
Track

If pasted, track A’s data will go to track 1, track B’s data will go to
track 2, track C’s data will go to track 1, etc. This will result in track 1
containing data from track E, and track 2 containing data from track
D. If merged, track 1 will end up with data from tracks A, C, and E,
and track 2 will have data from tracks B and D.

The following examples illustrate some creative uses of the Edit
commands.

This works for removing one or more particular kinds of data from a
track such a mono key pressure, patch changes, etc.

1. Choose Edit Filter from the Edit menu, or press command-F.

2. Check only the check box for the type of data you wish to remove.

Option-click on the check box for the type of data to be removed;
all other check boxes will uncheck.

3. Select the track with the data to be removed.

Click on the track name; it will highlight.

4. Enter the Start and End times of the region in the Edit bar.

5. Choose Erase from the Edit menu.

If you want to save this information for possible future use, cut it
instead of erasing it, and paste the information into a new and
separate storage track. You can later merge it back into the
original track if you like.
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Creating an Echo Effect
with a Track

Here's an alternate method for removing a specific kind of data using
the Event List window:

1. Open the Event List window for the track with the data to be
removed.

This is done by clicking on the track name and choosing Edit from
the Tracks window mini-menu.

2. Choose View Filter from the Event List window mini-menu.

3. Check only the check box for the type of data you wish to remove.

This will display only that type of data in the Event List window.
Option-click on the check box for the type of data to be removed;
all other check boxes will uncheck.

4. Select a region of events.

Click on the first event and drag over the rest of them.

5. Choose Erase from the Edit menu.

Here’s a method for “echoing" a track: all of the data in a track is
copied to another track and shifted just slightly in time. The effect is
a slight delay or echo.

1. Activate the Tracks window for the sequence that contains the
track to be echoed.

Click anywhere in the Tracks window.

2. Choose Add from the Tracks window mini-menu.

A new track appears in the track list.

3. Name the new track.

Option-click on the name. A pop-up box will appear into which
you can type the new name.

4. Select the original track by clicking on it.

The track name will highlight.

5. Enter the Start and End times of the region in the Edit bar.

Edit Commands 405



6. Choose Copy from the Edit menu.

The data in the selected region is placed on the Clipboard.

! 7. Select the new track by clicking on it.

The track name will highlight.

8. Choose Paste from the Edit menu.

The contents of the Clipboard are pasted into the new track. It
now contains a copy of the original track.

9. Choose Shift from the Edit menu.

10. Select the Delay option and enter zero bars and 0I240 duration.

This will delay the data in the new track by an eighth note.

A few variations on the above:

Before selecting Paste to paste the data into the new track, you could
set the Start time in the Edit bar in the Tracks window to 240 ticks
later. This would save you having to use the Shift command to shift
the data by 240 ticks. You could use the Change Velocity command
on the Region menu to decrease the velocities on the echo part to
make it softer than the original. You could assign the echo part to
another synthesizer or voice with a different patch or the same patch,
panned in stereo.

The Repeat Command
vs. Looping

The Repeat command is useful for repeating sections of music,
creating the same effect as looping. The advantage of using the
Repeat command over looping is that you can make each of the
repeats slightly different. Loops take less memory (which is an
advantage on their side) and each copy is exactly the same. Choose
between them according to your needs at the time.

Repeat can also be used to create trills (by repeating just two very
short notes) or drum rolls (by repeating just one drum note).

The Shift Command and
Attack Times

You may find that certain patches on your synthesizers have quicker
attack times than others. You can play two notes at exactly the same 
time on two different synthesizers (with two different patches) and
hear them not sounding together: one seems to “play" first and the

406 Edit Commands



Shift, Paste, Merge, &
Splice Using Real Time
and SMPTE Time

Place data at:

© ItBMKailOOQ] Eii
O I 0:00.00] (9
O I 0:00:00:00] ■■

( OK ) (Cancel)

second lakes a longer time to come to full volume. The Shift
command is useful for lining up attacks in situations like this one. By
shifting a track forward or backwards just slightly (try a value of less
than 100 ticks to start with), you can make all instruments sound as if
they are attacking notes at the same time. You may want to leave
some of the disparity between attack times: let your ear guide you.

The Shift, Paste, Merge, and Splice commands allow you to specify
Real Time, SMPTE time, or Measure/Beat/Tick time as the time unit
used to perform the operation. Just click the radio button
corresponding to the time unit you wish to use in the dialog box that
appears when any of these commands are selected.

The dialog box shown to the left appears when you are working in
an Event Editing (Graphic, Event List, or QuickScribe notation)
window, no events are currently selected, and you choose Paste,
Merge, or Splice.
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chapter 27 Region Commands 1

Editing During Playback Almost all of the editing operations discussed in this chapter and the
next can be done while the music is playing back so that you don’t
have to stop and start the music to hear the result. For example, you
could change note velocities in a track while the music is playing and
then use the Undo/Redo command as the music continues playing to
compare the original and modified data.

Selecting a Region The commands in this chapter act on the a selected region in the
Tracks List, the Tracks Overview, or one of Performer’s three track
edit windows. Without a selected region, the commands in this
chapter do nothing. So be sure to learn how to select a region by
reading chapter 25, “Selecting Regions”. It contains many powerful
shortcuts that will speed up your work.

Transpose The Transpose command transposes all notes in the selected region.
For information about the Transpose command, see the chapter
called Transpose.

Quantize Quantizing changes the attack and release times of note events to
make them more rhythmically precise. Attacks and releases are
aligned with a grid, a set of locations that occur on the beat and its
subdivisions. Quantize is useful in correcting perceived rhythmic
inaccuracies after your sequence is recorded. It does a rhythmic
“cleaning up” based upon your specifications.

Some Inaccuracy is
Good

Quantizing is, in its simplest form, a way to make all note events in
your sequence occur on a beat or one of its subdivisions, eliminating
inaccuracies. But inaccuracy is far from undesirable. In fact,
inaccuracy is what gives a piece of music its “feel”, its particular
rhythmic profile. If you always aligned all attacks and releases with
grid locations, your music might have a mechanical, inhuman quality
to it. You’ll find that you'll often want to preserve some of the
rhythmic nuances of your playing. Therefore, Performer allows you
to quantize selectively and specify the degree of quantizing you want.
The Sensitivity and Strength options accomplish this. In addition, you
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might want to .shift the occurrences of the beat slightly ahead or
behind the metronome beats in a particular track or section. The Grid
Offset option allows you to do this.

Basics Quantize will only alter the locations and durations of note events. All
other data in the selected region will be unmodified.

Quantizing a region sets up a grid of equally spaced locations. Notes
are then moved from their original locations to the nearest grid
location.

3 Attacks  Releases
111 Don't change durations

0 Attacks 3 Releases
O Don't change durations

You can choose to change the attack times and/or release times of
notes. There is an added option to leave the note durations unaltered.
Choosing to change attack times causes them to be moved to the
nearest grid location; release times are left unchanged. Choosing to
change release times causes them to be moved to the nearest grid
location; attack times are left unchanged. Both of these operations
cause an automatic change in note durations.

You can choose not to change the original durations. This prevents
durations from being truncated, which may cause the notes to sound
chopped.
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To Quantize

Note that if you choose to change both the attack and release times,
the Don’t Change Duration option is automatically disabled. This is
due to the nature of the operation: if you change both the attack and
release times of a note, the durations will automatically be modified.

To Quantize a region:

1. Select the region you wish to quantize.

See the section Selecting a Region at the beginning of this chapter
for instructions selecting a region.

2. Choose Quantize from the Region menu.

The Quantize dialog box will appear.

.Iju-Jiniza U.

What to quantize:
® Attacks  Releases

 Don’t change durations

Grid
j j o P.

 Tuplet:in time of |2 |

 Offset grid by | | ticks
 Swing: |

3. Select Attacks, Releases or both to be quantized.

If you selected Attacks or Releases (not both), select the Don 't
change durations option if you wish to keep the original durations
the same. If you did select both Attacks and Releases, this option
will be disabled.
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Choosing the Grid’s
Duration Value

4. Select a grid value.

Select any note value from a 128th note to a breve (a double
whole note). Select the dot or Tuplet option if necessary.

5. Set Offset, Sensitivity or Strength options.

Optional: see the descriptions below on these features.

6. Press OK to confirm your choice, or Cancel to cancel it.

The grid value is the distance between grid locations. For example, if
you select an eighth note as the grid value, each grid location is an
eighth note apart. This means that the note attacks and/or releases
will be moved to the nearest eighth note location.

The grid is aligned such that it begins on the first beat of the first
measure of the selected region. If a meter change occurs in the
selected region, the grid is realigned at the point of the meter change
to begin on the first beat of the meter change.

Generally, you should choose a grid value that is the smallest note
value in the region. For instance, if you are quantizing a region with
lots of sixteenth notes and a few quarter notes, choose a grid value
of a sixteenth note.

The grid value can be modified with the dot and/or tuplet boxes.
When the dot is selected, it adds one half of the selected duration to
the grid value. For example, if the quarter note and dot are selected,
the grid value is a dotted quarter, equivalent to three eighths. If the
tuplet box is selected, the tuplet specification is applied to the
selected duration. This is similar to the way the tuplet box works in
the Step Record window. Example: you have three eighth notes in
the time of two specified and the tuplet box is checked.

The quantize grid will be set to triplet eighth notes. Each triplet grid
location will have a duration of 160 ticks, which is equal to a third of
a quarter note (480 ticks). To specify a tuplet grid value:

1. Select the base duration you want.

Click on one of the note symbols.

2. Check the tuplet check box.
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3. Enter the number of tuplets in the left text box.

Grid Offset

After quantizing using

positive grid offset of 20 ticks

After quantizing using negative
grid offset of -20 ticks

4. Enter the number of regular note values that the tuplet replaces in
the right text box.

The start of the grid may be offset from its standard position on the
first beat of the selected region by a number of ticks. This is done by
clicking in the check box next to Offset by n ticks and entering a
number of ticks to offset the grid by. Positive values offset the grid
forward in time (after the beat), negative values offset it backward
(before the beat).

Original music

I 2|1|000 I 2|2|000
i,..I,,,i,, ,i,,,

I 2|3|000
I,., I.,, I-!■

I 2|4|000
••J-. ■!. I.,

i 3|11(
■ I ■ ■ ■ I

-

-......i............. —......
. . . ....................

.. i......

If you enter an offset greater than the distance (in ticks) between grid
locations, the number will be scaled down to be less than the
distance of the grid value. For example, if you are using a grid value
of a quarter note (480 ticks) and you enter an offset of 500 ticks, it
will be reduced to an offset of 20 ticks, that is 500 minus 480. Offset
values range from -9999 to 9999.
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Swing The Swing option delays every other grid point to create a sw ing, or
“jazz”, feel.

□ Offset grid by | | ticks

® Swing: |11O

The Swing option defaults to 100%, which produces straight swing.
For example, an eighth note grid produces a grid point every 240
ticks. The swing option, at 100%, will delay every' other grid point 80
ticks to 320, which is the attack time of the third eighth note in an
eighth note triplet.

A larger percentage such as 120% would delay every' other grid point
to 336 ticks, creating a "loose" swing feel. A smaller percentage such
as 80% would advance every’ other grid point to 304 ticks, creating
more of a straight swing feel. The percentage can be any value
between 0% and 300%. 0% does nothing and is the same as
quantizing without the swing option. 300% delays every' other offbeat
all the way to the next grid point.
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Sensitivity Each grid location has a “field of effectiveness" in which note events
can be moved by the Quantize command. Normally, this field
extends from one grid location halfway to the next, affecting all note
events. The center of each field is the grid location: each field actually
extends out in either direction from the grid location.

100% Sensitivity

Sensitivity is the size of this field. The default sensitivity (without the
Sensitivity options selected) is 100%. i.e. extending continuously
between grid locations. This field is actually split into 50% before the
grid location and 50% after the grid location. If you select Sensitivity
and enter a value of 50%, the quantizing field will be reduced:

50% Sensitivity

Note that 50% means 25% before the grid location and 25% after it
(i.e. 50% of the way to the midpoint between grid locations). Any
notes not in the field would not be quantized.

As illustrated, a positive Sensitivity value quantizes notes surrounding
a grid location. In contrast, negative Sensitivity values quantize notes
surrounding the midpoints between grid locations.

With positive Sensitivity values, the field of effectiveness extends
outward from the grid location. In the case of negative sensitivity, the
field extends inward from the midpoints on either side of the grid
location. As with positive sensitivity, the field is split on either side of 
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i the midpoint. So if you enter a Sensitivity value of negative 20%,
notes from about 41 to 50% before the grid location and about 41 to
50% after would be moved to the grid location:

Original music

Gridpoints

Strength

What’s most important is the effect that different Sensitivity values
will have on your music. To summarize:

□ Positive sensitivities clean up the down beats without
affecting ‘swung’ or freely played notes in between.

□ Negative sensitivities catch major inaccuracies while
retaining the music’s ‘feel’.

To use the Sensitivity option:

1. Check the check box next to the Sensitivity option.

2. Enter a number between -100 and 100 for the Sensitivity value.

Another way to preserve some of the rhythmic character of your
music while making it more rhythmically accurate is to use the
Strength option. Without any options chosen, Quantize will move all
note events so that they align perfectly with grid locations. Since this
can result in an overly precise effect, you might want to leave some
of the original inaccuracy in the passage. The Strength option does
this by not moving the note events all the way to the grid locations.
Rather, they are moved a percentage of the way toward the grid
points. Use the Strength option to tighten up a passage without losing
its “feel”.
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Randomize

j 'file Strength value specifies the amount that note events move
toward grid locations when quantized. A Strength value of 100% (the
default) moves them all the way to the nearest grid locations. A value
of 0% leaves them where they are. A value of 50% moves them
halfway to the grid locations.

Original Music

Quantize Attacks
with 50% Strength

Consider this example: there is a note event occurring at 10131450.
The grid duration is a quarter note, the Strength option is selected
and a value of 40% is entered. When Quantize is okayed, the note
will move to 10131462. If no options were selected, it would have
moved to 10141000, a distance of 30 ticks. A Strength value of 40%
moved it that percentage of the distance (40% of 30 ticks = 12 ticks)
to 10131462.

To use the Strength option:

1. Click in the check box next to the Strength option.

2. Enter a number between 0 and 100 for the Strength value.

Unlike all of the other Quantize options, which try to make notes
more rhythmically precise, the Randomize option does just the
opposite: it modifies the quantization randomly to make the notes as
rhythmically imprecise as you like. 100% randomization causes note
attacks (and/or releases) to be placed entirely randomly. A value of
less that 100% reduces the range over which the notes will be
randomized, and the grid point sits in the middle of the range. For
example, if you choose a 16th note grid (a grid point every 120 ticks),
and a randomize value of 50%, the range is 60 ticks, extending 30
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ticks before and after each grid point. Thus, a note attack (and/or
release) would be randomly placed within 30 ticks of its nearest grid
point.

Hints

Grid points

50% Randomization on a 16th note grid produces a region of 30 ticks on either side of

each grid point: notes will be placed randomly within this region around each grid point.

Emphasis
This sub-option causes the tendency of the randomization to be
earlier or later within the specified range. Thus, if you wish to
randomize the note placement within a certain range, but you wish
to push the beat by tending to make the notes occur a little bit early.
use a negative emphasis; use a positive emphasis if you wish them to
tend to be laid back—that is, after the beat. A value of zero equals no
emphasis, which causes the randomization to occur evenly within the
range.

If you’re trying to simply line up all notes with the beat and its
subdivisions, selecting Attacks and Don 1 change duration will most
likely yield the results you want. If you select both Attacks and
Releases, all notes will begin and end at grid locations. This may
make them too precise, sounding chopped, inhuman, or just wrong.

If you are trying to get the notes of a chord to line up to make the
attack precise, consider using the DeFlam command on the Region
menu instead of Quantize. It will line up the attacks but will not move
the notes to a grid location.

If you want to quantize a region containing a mixture of sixteenth,
eighth, and quarter notes which contains just two or three thirty-
second notes, set the grid value to sixteenths for quantizing. You can 
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Smart Quantize

subsequently change the thirty-seconds back individually. Otherw ise,
if you choose too small a duration value, many notes may move to
undesirable locations. Choose a grid value that reflects the general
rhythmic profile of the region in its most active, complex areas.

Performer is very capable, but it can't read your mind; you'll find that
there are some notes that just don't get moved to the locations you
want them to be. This is due to the original location of the note not
being within the quantize field for the desired grid location. The
quickest way to fix this is to change them individually in the Event
Editing Window for the track they are in.

You can use the Offset command to do some very fancy quantizing
that may not, at first glance, even seem like quantizing. For example,
suppose you’ve just entered your sequence in 4/4 time and you
decided that you’d like to make notes that fall on the third beat of
every measure slightly late. First, set the grid value to the whole note.
Grid locations will occur only once per measure, on the first beat.
Choose the Offset option and enter a value of 980 ticks. Since 960
ticks constitute one half note, 980 ticks is 20 ticks after the third beat.
Now choose the Sensitivity option and enter a value of 20%. This
limits quantization to those notes near the third beat already (if you
didn’t use the Sensitivity option, all notes would end up quantized to
the third beat). You may have to experiment with the percentage. Use
a larger percentage if some notes don't get quantized that should; use
a smaller percentage if some notes get quantized that shouldn't.

The Offset option was not designed for the mass shifting of notes in
a region. If you want to move a section of your sequence forward or
backward in time, use the Shift command on the Edit menu.

Smart Quantize is especially designed for quantizing data that will be
transferred to music notation software, such as Mark of the Unicorn's
Professional Composer.

Performer’s built-in QuickScribe™ notation window
does not require quantization of any kind; it will
notate original, unquantized MIDI data.

<•" Our latest notation software package, Mosaic™, does
not require Smart Quantize because it uses its own
quantizing algorithms when transcribing MIDI data.
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i Smart Quantize greatly enhances the transcription of the music when
it is transferred to programs like Professional Composer, which do
not have sophisticated transcription algorithms like those employed
in Performer’s QuickScribe notation window. Using a specially-
designed, floating quantize grid, Smart Quantize quantizes both
attacks and releases to ensure that notes are notated on the correct
beat with the proper duration. Triplets and triplets will be properly
quantized, along with notes in straight time.

Smart Quantize also provides several options to optimize the
transcription of your musical performance.

Filter out notes with
® durations less than ;MU040~]
® velocities less than 115 |

@ Move releases of notes followed
by rests to the nearest beat

Swallow rests

O small
O medium small
® medium large

The first set of options helps to correct errors in your Performance.
Often when we play a keyboard or other MIDI controller, we will
accidentally tap a key next to the one we meant to play, causing an
extra, short note with a low velocity. Or, we may have held a chord
and not realized that we were accidentally holding down an extra
key, creating a long held note, barely audible, with a very low on-
velocity. Errors like these can interfere with the accurate transcription
of your music.

The Filter out notes with options delete unwanted notes when you
Smart Quantize. The durations less than option allows you to delete
notes shorter than the duration you specify. What value you choose 
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should depend on the tempo and nature of the music, and your
individual playing style. The velocities less than option deletes notes
with velocities shorter than the one specified.

The second option, Move releases of notes followed by rests to the
nearest beat, will help prevent dotted durations followed by a short
rest. Use this option if you do not intend for your music to have
offbeat releases. For example, if you tend to release notes a little bit
early when you play, the notes may be transcribed shorter than they
should, followed by a short rest. This option recognizes premature
and late releases and notates them properly with their full duration.
Use this option to reduce the number of rests, especially if you are
transcribing music with standard durations and very few rests. Don’t
use this option if your music contains precise, mid-beat releases that
you want transcribed precisely.

Smart Quantize tends to close gaps between attacks and releases. The
Swallow rests options allow you to adjust the size of gaps that will be
closed. There is no hard and fast rule for choosing these options. In
general, if you don’t want lots of short rests in the transcription, use
the larger options. If you want a more precise transcription of your
performance, which may contain dotted durations followed by rests
and so on, use the smaller options.

To use Smart Quantize:

1. Select the region that contains the music you will transcribe.

If you are transcribing an entire sequence, select all the tracks in
the tracks window and set the Edit Start and End times in the Edit
Bar to include the entire sequence.

2. Choose Smart Quantize from the Region menu.

The Smart Quantize dialog box will appear.

3. Set the Filter notes, Move releases, and Swallow rests options.

These options are discussed in detail above.

4. Click OK to confirm your choice or Cancel to withdraw the
command.
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Because Smart Quantize does so many things at once, it may take
longer than regular quantizing. Expect to wait for a moment if you
have quantized a large region.

input Quantize

Opening the Input
Quantize Window

Turning Input Quantize
On and Off

The Input Quantize feature quantizes notes during recording in the
same fashion as a standard drum machine. Notes get quantized
immediately as they are being received and appear quantized in the
track afterwards. If you are loop recording, the notes will play back
quantized the next time through the loop.

To open the Input Quantize window, choose Input Quantize from
the Windows menu:

This is a standard Performer window that can be left open while you
play back, record, edit, and use Performer's other windows and
features. This allows you to make changes to Input Quantize during
recording.

To turn on Input Quantize, check the Enable input quantization box.
When Input Quantize is turned on, all incoming notes are quantized
according to the options shown in the Input Quantize window. To
turn off Input Quantize, simply uncheck the box.
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Setting the Input
Quantize Options

Changing Options
During Recording

Loop Recording

Humanize

Input Quantize offers the same type of quantization as the regular
Quantize command in the Region menu. The only differences are that
1) the quantization occurs in real time as data is being recorded, and
2) the options for each type of input quantization are set in the Input
Quantize window rather than the Quantize dialog box. But Input
Quantize options behave the same way as their counterparts in the
Region menu.

For more information about the Input Quantize options, see the
section earlier in this chapter regarding the Quantize command in the
Region menu.

Any option in the Input Quantize window can be changed at any
time, even during recording. For example, you can record several
bars with quantization turned on and then turn it off on the fly as you
record the next several bars. As another example, you might check
the triplet check box while recording triplets and uncheck it as you
switch back to straight time.

For information about how to use input quantize while loop
recording, see the looping chapter.

The Humanize command lets you add a “random” element—or
“humanized" feel—to your music. With this command, you can
randomize any combination of the following elements of your music:

□ Note placement

■ Note durations

■ Velocities

■ Pitches

■ Tempo

In addition, you can create a unique blend of these randomization
elements and save it as a randomization style, which you can recall
and use at any time. You can use the Humanize command to create
arpeggiation effects, hi-hat (or other percussion instrument) grooves,
and other dramatic musical effects.
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What to humanize:

® Note placement
® by ± | 10 |$S of duration
O within ± | 0|0601

Emphasis: | o| (-9 to +9)

@ Durations
O by | 10 |?o of current value

® within ± | 0|060|
Emphasis: | 0| (-9 to +9)

@ Velocities ® iOn O tOff
O within ± | 12~z| of current value

® Within a range
from | 11 to | 1271
Emphasis: | o| (-9 to +9)

® Pitches C Mixoludian v|

□ Tempo
O by | 11% of current value
® within ± | 5.001 bpm

Emphasis: | 0| (-9 to +9)

Select a Humanize Style...
Hi Hat Groove

( cla-i u'ShulIluu Lpj.iuii udu p— )

Choosing What to
Humanize

Humanize Sub-options

The Humanize command combines the randomize options of the
following commands: Quantize, Change Duration, Change Velocity,
and Scale Tempo. And it adds the randomization of note pitches.

For even further control over the feel of your music, be sure to check
out chapter 30, “Groove Quantize”.

Each type of musical element is a check box option in the Humanize
dialog box. To randomize that element, check its box. If you don’t
want to randomize it, uncheck it. For example, if you want to
randomize velocities, but not note placement, uncheck note
placement.

Each element has sub-options which affect how it randomizes. These
sub-options are discussed briefly below. All of the elements have an
Emphasis sub-option, which is discussed in a separate section. The
last section explains how to save and recall Humanize styles.
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Note Placement

Durations

Velocities

Pitches

The Note Placement sub-option randomizes the attack times of notes
within a range (in ticks) of the note’s current location. You can
specify the range as a number of ticks, or as a percentage of the
note’s duration, in which case longer notes have a larger range and
shorter notes have a smaller range.

The Durations sub-option randomizes durations within a range of the
current duration, which you specify in the box provided. This range
can be specified as a absolute number of ticks, or by a percentage of
the current duration.

The Velocities sub-option lets you choose between on (attack) or off
(release) velocities. In addition, it lets you randomize the velocity
within a range of its current value, or within an absolute range.
Randomizing within a range of its current value lets you preserve the
overall contour of the velocities, while still mixing them up a little bit.
Randomizing within an absolute range lets you limit them to a certain
range of values.

The pitches sub-option allows you to randomize the pitch of each
note within the region. You can randomize to:

a Any pitch

■ A range of pitches

■ Certain pitches within a range

In addition, you can assign weight to each pitch within a range so
that it is used more or less often during the randomization process.
For example, if you are creating a humanize style that generates a
hi-hat part, you can assign more weight to the closed hi-hat pitch and
less weight to the open hi-hat pitch so that the result is mostly closed
hit with an occasional open one.
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The Set Random Pitch Map button lets you determine what pitches
notes can be randomized to:

if you like the random

by

Select what pitches can

be used here.

If desired, choose a

scale in which to

randomize here.
Customize the scale

creating your own wil

the Create Scale butt

pitch map you created,

and you’ll want to use it

again, name it and save
it here.

Choose what pitches

notes can be randomized

to and assign them weight
here in the random pitch

map. Weight can have a

value between 0 (not used

at all) and 99 (used a lot).

Recall saved random

pitch maps by select­

ing them from this pop­

up menu.

The Create Scale button
The create scale button opens the create scale dialog box. For
information about this dialog, see “Creating a Custom Scale” on
page 484.

Saving, Recalling, and Deleting a Random Pitch Map
To Save a Random Pitch Map:

1. Set up the pitch map as desired.

2. Type in a name for the Random Pitch Map.

3. Click Save.

To recall a random pitch map, select its name from the pop-up menu.

To delete a random pitch map:

1. Select the pitch map you wish to delete from the pop-up menu.
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2. Click Delete.

To rename a pitch map:

1. Select it from the pop-up menu.

2. Type in the new name.

3. Click Save.

4. Delete the original one.

Tempos The Tempos sub-option randomizes existing tempos within the
selected region. Note that it does not generate new tempo events. (To
do so, use the Change Tempo command in the Change menu.) Note
that this option only affects tempo events that already exist in the
Conductor track. If the region you select has no tempo events in it,
this option will have no effect. If so, use the Change Tempo
command in the Change menu to generate tempo events.

By__ % of current value
This option randomizes the tempo of each selected tempo event
within a range that is expressed as a percentage of the tempo value.
For example, if the tempo is 100 bpm, and you enter 10 percent, the
tempo will be randomized within a range between 90 to 110 bpm
(±10 bpm).

By±____ bpm
This option randomizes the tempo of each selected tempo event
within a range of beats per minute.

Emphasis Each Humanize element has an emphasis sub-option, which can be
any value between -9 and +9. The emphasis value causes the
tendency of the randomization to be higher or lower within the
specified range. Thus, if you wish to randomize within a certain
range, but you wish values to tend to be higher, use a positive
emphasis; use a negative emphasis if you wish them to tend to be
towards the lower end of the range. A value of zero equals no
emphasis, which causes the randomization to occur evenly within the
range.
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Saving, Recalling,
Deleting, and Renaming
a Humanize Style

To Save a Humanize style:

1. Set up the Humanize style as desired.

2. Type in a name for the style.

3. Click Save.

To recall a Humanize style, select its name from the pop-up menu.

To delete a Humanize style:

1. Select the pitch map you wish to delete from the pop-up menu.

2. Click Delete.

To rename a Humanize style:

1. Select it from the pop-up menu.

2. Type in the new name.

3. Click Save.

4. Delete the original one.

DeFlam The DeFlam command looks for groups of note that are very close
together. When such a group is found, the average attack time of the
group of notes is computed. All notes in the group are moved such
that their attack times are aligned exactly to the average time.

The group of notes that is deflammed is determined by the tick value
you specify. This creates a “window” of effectiveness. Groups of
notes within that window will be deflammed.
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Basics When chords are played in real time, the attacks of individual notes
are often splayed as in the example below, which shows two four-
note chords:

1141325 J'04 172 !64 1)254
1141331 <FG3 154 !64 1)204
1|4|336 J-G4 155 !64 1|192
1141343 J>A3 174 ! 64 1)209
2|4|422 J>E4 185 !64 1)120
214)432 J'G3 185 ! 64 11108
2I4I436 J-B4 159 !64 1)123
2|4|439 J'BS 179 !64 1)108

DeFlam is useful for consolidating the attacks of the notes in such
chords. The following is the result of using DeFlam with a tick value
of 20 on the above passage:

1141333 <FG4 155 T64 1|192
^■04 172 !64 11254
J'A3 i74 !64 1|209
J*G3 154 !64 11204

2|4|432 /B4 159 T64 11123
J*E4 185 !64 11120
J>B3 179 !64 1|108
J'GS 185 !64 1|108

The quarter notes are now grouped into two precise chords.

DeFlam averages the attack times of the groups of notes; there is no
grid involved as there is with the Quantize command. In the above
example, the resulting attack time of each chord is the average of the
attack times of the four original notes. The durations of the notes are
left unchanged.

DeFlam attempts to detect grace notes and rolled chords and, if
found, will leave them as such.
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Using DeFlam

Change Velocity

To use DeFlam:

1. Select the region you wish to modify.

See Selecting ci region al the beginning of this section. The region
should include only the notes to be deflammed.

2. Choose DeFlam from the Region menu.

A dialog box appears.

3. Enter a tick value.

The tick value sets the “window” for the command. Notes within
this window will be deflammed.

4. Press the OK button to confirm your choice, or the Cancel button
to cancel it.

If DeFlam leaves some notes out, try using a larger tick value; if it
includes too many notes, try decreasing the tick value. (Remember,
you can Undo and Redo the DeFlam command.) The correct tick
value depends greatly on the particular passage you are working
with. It may take several attempts to determine the correct value.

Change Velocity is a powerful command that lets you modify the
velocities of all notes in a region. You can remove irregularities, make
passages louder or softer and create crescendos, diminuendos and
other similar effects. Note that not all MIDI keyboards and sound
modules respond to velocity data, and those that do may need to be
set up to respond correctly to this information. Consult your owner’s
manuals for details.
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Using Change Velocity To use change velocity:

1. Select the region you wish to modify.

See Selecting a region at the beginning of this section.

2. Choose Change Velocity from the Region menu.

A dialog box appears.

® i On Velocities O t Off Velocities

® Set all velocities to |thC- >«a|
O Add | | to all velocities
O Change to | \%

of current value
O Limit to a range

from 11 | to 1127 |

 Randomize by ± | 1
Emphasis: |o | (-9 to +9)

O Change smoothly from:

O | |95 to r |%
of current value

® I I to I I

vzith curvature: |p 1
(0 to ±99)

3. Choose between modifying on (attack) velocities or off (release)
velocities.

4. Choose the desired option to alter the velocities.

Select from the Set all velocities to , Add to all velocities, etc.
options. Click on the radio button next to the option.

5. Enter the values required by the option.

Click in the box and type in the value. If there are additional
values to enter, use the Tab key to highlight each successive box
or click in each box directly and enter or edit the value.

6. Press the OK button to confirm your choice, or the Cancel button
to cancel it.

You can Undo/Redo the Change Velocity command.
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On Velocities or Off
Velocities

Set all velocities to

Add to all velocities

Limit to a maximum of

Limit to a minimum of

There are a number of options in the Change Velocity dialog box.
Each one allows you to modify velocity values in a different way.
Don't let this complexity confuse you; once you select an option, you
can ignore all information pertaining to other options.

On velocities control the speed at which a note is attacked. This
affects the note’s loudness most dramatically, but on velocities can
also affect other aspects of the note event such as its timbre (e.g. the
harder the note is struck, the brighter it sounds). Off velocities control
the speed of the release of the note and are sometimes used to
control its decay rate. At this time, very' few synthesizers utilize off
velocity information.

The Change Velocity command can be applied to either on or off
velocities: choose the type you wish at the top of the dialog box. The
default setting changes the on velocities.

This option sets all velocities in the selected region to a single value.
Enter a value between 1 and 127. A result of this option is that all note
events in the region will be played back at a constant volume.

This option adds the value you enter to all velocities in the selected
region. The value must be in the range -127 to 127. Velocities that end
up less than 0 or greater than 127 will be set to zero or 127,
respectively. A result of this option is a uniform increase or decrease
in volume of all notes in the region, within the zero to 127 range.

This option modifies all velocities in the selected region that have a
velocity greater than the value you enter, by changing them to that
value. Enter a value between 1 and 127. This option imposes a
maximum volume level on all notes in the region. You can use it to
change the velocities of notes that “stick out”.

This option modifies all velocities in the selected region that have a
velocity less than the value you enter, by changing them to that value.
Enter a value between 1 and 127. A result of this option is that there
will be a minimum volume level for all notes in the region. You can
use this option to assure that notes that may be inaudible have
sufficient velocity to be heard.
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Change to__ % of
current value

This option scales all velocities by the percentage value you enter.
Percentage values must be between 1 and 999- For example, if all
notes in the region have a velocity of 120 and you enter a percentage
value of 50%, the velocities will be set to 60. Thus, to halve velocities,
use a value of 50%. To double them, use 200%. Velocities that end up
less than 0 or greater than 127 will be set to zero or 127, respectively.

Scaling by a percentage may give you better results than using the
Add__ to all velocities option above since the original velocity
contours are preserved. Tty' both to discover which gives you the
results you want.

Change smoothly from This option has two basic sub-options:__ % to___ % of current value
and___to___ . Each gives you a different way to specify the smooth
velocity changes. The first changes by percentages, creating a smooth
velocity change for notes in the selected region while preserving
some of the original velocity characteristics (most notably the
accents); the second creates a smooth change with no fluctuations.
You can specify a curvature for the change, which determines its
contour.

___% to___ % of cu rrent value: This sub-option changes velocities
similarly to the Change to___°/o of current value option described
above. The difference is that the percentage value changes from the
first to the second entered value: the first value applies to the
beginning of the region, the second to the end. Enter a value from 1
to 999 in each box. The curvature (see below) controls the contour of
the change.

___to___ : This sub-option assigns the first entered value to the first
note velocity in the selected region and the second entered value to
the last note velocity in the region. All other velocities are calculated
to make a smooth transition between the first and last ones. The
curvature (see below) controls the contour of the change over the
region.

Curvature: This sub-option controls the contour of the smooth
change. With a curvature of zero, the change is linear from the first to
the second entered value. As you increase the value positively (with
values from 1 to 99), more of the change will take place towards the
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end of the region. As you increase the value negatively ( with values
from -1 to -99), more of the change will take place towards the
beginning of the region.

Here are a few examples to clarify this option:

Change smoothly from 1 to 90, curvature 0. This results in a linear
increase. One effect of this is a gradual, even crescendo.

Change smoothly from 10 to 90, curvature -50. This results in a
pronounced upward curve with most of the changes happening at
the beginning. One effect of this is a crescendo that occurs more
rapidly at the beginning.

Change smoothly from 96 to 5, curvature 45. This results in a
downward curve which is more pronounced at its end. e.g. a
diminuendo that speeds up toward its end.
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Change smoothly from 100% to 1%, curvature 0. When applied to a
region in which there are several notes accented, this results in a
downward “curve”, which retains the accent structure of the original.

Original velocities

120
100
80
60
40
20

0

******* YYYYYYY
* f *

120-
100
80
60
40
20

0

Changed smoothly from 100% to 1% with 0 curvature

Randomize

The Effect of Velocity Is
Synthesizer-dependent

The velocity values assigned to notes by this option are calculated
based on the distance of the note from the beginning or end of the
selected region. If the first note in the region is after the start time, for
instance, it will be assigned a velocity value somewhere between the
values entered. Notes in a chord (with simultaneous attacks) are
assigned the same velocity. If a specific change sounds too abrupt, it
is probably due to the position of the note in the region. For instance,
if notes occur at irregular times (e.g. bunched together followed by a
sparse section), velocities will be assigned on the basis of note
placement. The result may not seem smooth on a per-note basis.

The randomize option allows you to randomize the velocities within
a range of the current value, which you specify in the box provided.
The emphasis sub-option causes the tendency of the randomization
to be higher or lower within the specified range. Thus, if you wish to
randomize the velocities within a certain range, but you wish them to
tend to be higher, use a positive emphasis; use a negative emphasis
if you wish them to tend to be towards the lower end of the range. A
value of zero equals no emphasis, which causes the randomization to
occur evenly within the range.

Note that the randomize option is a check box, which means that it
can be selected together with one of the radio button options above.
This allows you to randomize at the same time as executing one of
the other Change Velocity options.

Synthesizers vary widely in their response to velocity information.
Some do not respond at all to any velocity information; most do not
respond to off velocities. Some patches sound very different when
large on velocity values are used. Some patches do not respond at all
to velocity information, even when the synthesizer as a whole does.
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Alternative Methods for
Volume Changes

Change
Duration

Basics

Most often, you can be assured that if your synthesizer does respond
to velocity information, you can control the loudness of note events.
You should be able to create effective crescendos and diminuendos.
This will work well for short-range dynamic effects. For longer effects
(a 30 second fade, for instance), you might notice a “staircase" effect,
i.e. discrete changes in the volume level.

Some synthesizers define one of the MIDI controllers as the volume
control. If so, you might be able to use the Create Continuous Data
command to create smooth volume changes with a controller. Some
synthesizers have only a few discrete volume levels, making it hard
to create smooth changes. Consult the Hints in the Event List Window
section for details about determining the limits of the controller
values on your instrument.

It is also possible with some synthesizers to control volume directly
from an assignable controller. A patch may use the breath controller
to control its volume, for instance. By sending this controller data
through Performer, you can control volume changes.

There is no single solution for making volume changes effectively
with every patch on every instrument. You must find the best way for
each given situation and use the appropriate command (Change
Velocity or Create Continuous Data) to create the kind of volume
changes you want.

The Change Duration command modifies the duration of all notes in
the selected region without changing the placement of attack times.
This means that the amount of time a note is “on” or sounding can be
changed without affecting its actual rhythmic placement in relation to
other notes and events. The Change Duration command is useful for
changing the articulation or space between notes. You can make note
events sound connected or separate in relation to each other, for
example. It also provides some useful utility functions.

Duration is the length of a note, i.e. the time between its attack and
release. Durations are specified in quarter notes and ticks (e.g. a half
note would be 21000 or two quarter notes). A note must have a
duration of at least one tick (01001).
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Using Change Duration

A note’s duration may be misleading in some cases: what you see
might not be what you hear. The actual duration of a note event is
dependent upon the synthesizer and patch used. The attack and
release sent by Performer are equivalent to manually pressing and
releasing a key on the synthesizer. Also, some synthesizers have a
sustain pedal that can be used to hold notes, extending the effective
duration of notes far beyond the time when the release has been sent
to the synthesizer.

To use Change Duration:

1. Select the region you wish to modify.

See the Selecting a region section above.

2. Choose Change Duration from the Region menu.

A dialog box appears.

3. Choose the option you want by clicking in the appropriate radio
button.

You can only choose one option.
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Set all to

Add to all

Subtract from all

Limit to a maximum
of

Limit to a minimum of

Change to % of
current value

Move releases to the
closest attack

4. Enter the value required by the option.

Click on the box and type in the value.

5. Press OK to confirm your choices or Cancel to abort the command.

You can Undo and Redo the Change Duration command.

The following options are available:

All durations in the selected region will be changed to the entered
value. The value entered must be between 01001 and 99991999.

The value entered will be added to all durations in the selected
region. The value entered must be between 01001 and 99991999.

The value entered will be subtracted from all durations in the selected
region. The value range is 01001 and 99991999. Notes which would
have a duration of less than one tick after the subtraction are given a
duration of one tick.

Any notes in the selected region which have a duration greater than
the value entered will be assigned to that value. The value entered
must be between 01001 and 99991999-

Any notes in the selected region which have a duration less than the
value entered will be assigned to that value. The value entered must
be between 01001 and 99991999-

The durations of notes in the selected region are scaled by the
entered percentage value. The relative lengths of the notes are
preserved and their overall length is modified. The percentage value
entered must be between 1 and 999- To halve durations, enter a
percentage value of 50%; to double durations, use 200%. Using this
option may yield more of the results you want than using the Add
to all option; durations are scaled proportionally instead of uniformly
lengthened. Try both to see which you like best.

The release of each note in the selected region is modified to occur
just before the attack of the nearest note following it in time. The
duration of the note may increase or diminish depending on when
the next note occurs. If the next note occurs before the release of the
current one, the release of the current note will be moved back in 
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Extend releases to the
closest attack

time, making the duration shorter. If the next note occurs after the
release of the current one, the release of the current one will be
moved forward in time, making the duration longer. If the note
release is after the end of the selected region, the note is left
unmodified. This option creates a legato effect, where the notes
follow each other smoothly and without a gap.

Move Releases to Closest Attack

Before

After

The duration of each note in the selected region is extended until it
ends at the same time as the next note begins. This is very similar to
the Move releases to the closest attack option but the durations of all
notes are guaranteed to increase since the release is always moved
forward in time. Any notes which end after the last note in the
selected region begins are left unmodified.

This option creates a legato effect, where the notes follow each other
smoothly and without a gap.

Extend Releases to closest Attack

Before

EZZJ [=1

Extend Releases sub­
options

Use these sub-options to extend releases and still preserve rests in a
region. If both sub-options are checked, each note in the region is
analyzed and the option that results in the smallest duration increase
is used. Try using these options after quantizing attacks and releases
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Randomize

Hints

to improve the notational display of the notes. Doing so adjusts the
durations of notes that were not played in a legato style. For best
results, experiment with different values. A good setting to start with
is 100%.

The randomize option allows you to randomize durations within a
range of the current duration, which you specify in the box provided.
This range can be specified as a absolute number of ticks, or by a
percentage of the current duration. The emphasis sub-option causes
the tendency of the randomization to be higher or lower within the
specified range. Thus, if you wish to randomize the durations within
a certain range, but you wish them to tend to be longer, use a positive
emphasis; use a negative emphasis if you wish them to tend to be
shorter. A value of zero equals no emphasis, which causes the
randomization to occur evenly within the range.

Note that the randomize option is a check box, which means that it
can be selected together with one of the radio button options above.
This allows you to randomize at the same time as executing one of
the other Change Duration options.

Some drum machines cannot receive dense bursts of MIDI data; they
will often miss data altogether, causing drop-outs and other
perplexing problems. Since the durations of drum machine events
tend to be very short, the note releases tend to follow the attacks very
quickly resulting in a very high data density. A problem also arises
with Step Record: the release for each note is sent immediately before
the attack of the next note. One way to improve the situation is to
delay the note releases (most drum machines ignore these anyway
since their note events have such short decays) by making the note
durations longer. Use the Change Duration command to set the
durations of these note events to a value somewhere around 10 to 20
ticks.

The Change Duration command is very good for adjusting the
articulation of note events. Rendering a passage legato or staccato is
simple: for a legato effect (each note releasing just before the next
one is attacked):

1. Select the region.

2. Choose Change Duration from the Region menu.
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3. Click on the Set all to __ option.

4. Enter a value of 1 tick (01001) and press OK.

This insures that durations are uniform for the next step.

5. Choose Change Duration from the Region menu.

6. Choose the Extend releases to the next attack option and press the
OK button.

This is useful for removing any rests or gaps between notes.

For a staccato effect (each note releasing well before the next, giving
the passage a rhythmically sharp, incisive character):

1. Select the region.

2. Choose Change Duration from the Region menu.

3. Click on the Change to__ % of current value option.

4. Enter a value of 50% and press the OK button.

If you enter a part in Step Record, all durations will be as long as
specified, rendering a legato effect. You can use the Change Duration
command to add the articulation you want to these parts.

Split Notes The Split Notes command lets you selectively cut or copy notes in the
selected region. The selection is based upon pitch, velocity and/or
duration. This means that only notes with specific pitches, ranges,
durations and velocities from the selected region are cut or copied.
For example, all notes between A3 and C#3 with velocities greater
than 100 and with durations above a half note can be extracted from
a region. Here are some additional things you can do with Split
Notes:

■ Use an on-screen graphic keyboard to specify the pitches
of notes you wish to split. This keyboard allows you to
pick a non-contiguous range of pitches for splitting.

■ Automatically Paste or Merge the split notes to a pre­
existing track.
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Basics

■ Automatically create a new track and Paste the split notes
to it.

■ Automatically create a set of new tracks and Paste the split
notes to each track according to their pitch.

Split Notes can be used to split a drum track into separate tracks,
extract or double a melody line, separate one keyboard part into two
to segregate right and left hand activity, pick out and double accented
or long tones, and much more. See the hints at the end of this section
for some unusual effects using the Split Notes command.

Split Notes is a highly specialized version of the Cut and Copy
commands on the Edit menu. Only notes in the specified region and
with specific properties are affected, other events are not affected.
Each note is tested to see if it meets the requirements you specify,
including velocity, pitch, and duration. They are then placed in a
destination you select, such as the Clipboard or a new track. If cut,
they are removed from the selected region.

The Split Notes dialog box remembers the settings you
last chose.

To use Split Notes:

1. Select the region you wish to modify.

See the Selecting a region section earlier in this chapter.

2. Choose Split Notes from the Region menu.

A dialog box appears.
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Get the notes using:
® Cut
O Copy

Send the notes to:
® Clipboard
O One track Track-1~ I

O One new track | Split Notes-1

O Separate tracks by pitch

■ ....../ Wi n

Place copies using:
® Paste

] O Merge

Pitch criterion:
O All notes
O Notes between |C3 |and |C3 |

O Top | |notes of each chord
O Bottom | [notes of each chord

® Selected notes: (’ ' )

l^jf5 * 7 . Eg ' c?

uimmmiMii;

Optional criteria:
O Durations between | O|OOO|and [

E] On velocities between | | and
O Off velocities between I |and

01000 |

3. Choose the Cut or Copy option at the top.

This determines whether notes are cut (removed from the
originally selected region) or copied by the Split Notes command.

4. Choose a destination for the notes to be split.

You have several choices here. Select the Clipboard option to
place notes on the Clipboard (for the purpose of pasting
afterwards). Select the One track option and select a track name
from the pop-up menu to send the notes to one existing track.
Select the One new track option and type in a name or use the
default name to send the notes to a new track that will be added
to the bottom of your tracks list. Select the Separate tracks by pitch
option to separate out the notes by pitch and place them into new,
separate tracks. Each new track will contain the pitch name in
parentheses after the track name. The track name used for this
option can be entered in the One new track option text entry box
above. This last option is ideal for splitting up a drum track into
separate tracks.

5. Choose whether you would like the split notes to be pasted at their
destination, which replaces what is already there, or merged
together with what is already there.
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6. Choose one of the five pitch selection options.

These options are discussed in detail in the next few sections.

7. Enter the data required by the option.

Type or play in the required values.

8. Click on the check box to the left of any desired options.

You can select a combination of pitch, velocity and duration
options.

9. Press OK to confirm your choices or Cancel to cancel.

You can Undo and Redo the Split Notes command.

You can enter pitch and velocity values directly from your MIDI
keyboard. The note you play will be entered directly into the value
box which contains the flashing text cursor or is highlighted.

Cut or Copy If you choose the Cut option, the Split Notes command will place the
selected notes on the Clipboard and remove them from the selected
region. If you choose the Copy option, the Split Notes command will
place the selected notes on the Clipboard without removing them
from the selected region.

All Notes All notes will be cut or copied unless excluded by velocity or
duration selections. Use this mode when you wish to cut or copy
notes based solely on velocity or duration criteria.

Range of Pitches All notes between the two entered pitch values will be cut or copied.
The pitch range is inclusive (it includes the two entered pitch values
and all notes between them). You must enter a pitch in each box for
this option.

Top notes The specified number of notes from the top of each chord are cut or
copied. A chord is defined as two or more notes which have the same
attack times. If single notes are encountered (i.e. not in chords), they
alone are copied to the Clipboard. It is useful to use the DeFlam
command on the Region menu to make sure that attack times of all
chords line up before using this option. Enter the number of notes to
be cut or copied from the top of each chord in the box for this option.
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Bottom notes

Select Notes

Durations

On velocities

Off velocities

Hints for Using Split
Notes

This option is similar to Top notes except that the notes are cut or
copied from the bottom of each chord.

Click keys on the keyboard to select and deselect specific pitches.
Click Clear Keyboard to clear the currently selected pitches on the
keyboard. Use the scroll bar and scroll arrows to select pitches that
are above or below those pitches which are currently displayed. You
can also play keys on your MIDI keyboard (or other controller) to
select and deselect specific pitches.

*■ The Select notes keyboard remembers the selected
notes even when those notes are scrolled to the left or
right and are not displaying. When you open the
dialog and want to select some pitches on the
keyboard and are not sure if there are selected notes
above or below the pitches that are currently
displayed, click Clear Keyboard to be sure that notes
that are not displayed are also not selected.

The following are velocity and duration options that can be selected
in addition to pitch options.

Notes in the selected region with durations within the specified range
are cut or copied. You must enter two durations in the boxes from
01001 to 99991999- The duration range is inclusive (it includes the
two entered duration values and all those between them).

This option, when selected, allows only notes with the specified
velocity range to be cut or copied from the selected region. You must
enter two velocities (between 1 and 127) in the two boxes. The
velocity range is inclusive (it includes the two entered values and all
those between them).

This mode is similar to the On velocities mode except that notes with
off velocities in the specified range are cut or copied.

The Split Notes command by itself is not always completely useful: it
can be used in conjunction with other region commands and
operations to fully accomplish an editing task. We therefore have
included some effective ways to use the Split Notes command as part
of more complex operations.
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Splitting up a drum part
into separate tracks

You can use the Separate tracks by pitch option in combination with
the Select notes option to quickly explode tracks such as drum parts
into separate tracks so that each pitch can be treated uniquely. This
is great for being able to shift, quantize and otherwise edit a certain
percussion instrument without affecting others.

Using a Temporary
Track

You can process data independently that is cut or copied with the
Split Notes by pasting it into another track. You can perform various
operations on the data in the temporary track (transpose, velocity
editing, etc.), then merge it back into the original track and delete the
extra track.

Extracting a Lead Line Extracting the lead line from a passage (perhaps from block chords
where the top notes of each chord form a melody) can be easily done
with the Split Notes command. After the lead line is separated from
the chords, it can be modified (doubled, accented or otherwise
enhanced) in an extra track.

To extract the lead line:

1. Select the region to extract the lead line from.

See chapter 25, “Selecting Regions" for more information.

2. Choose Split Notes from the Region menu.

The dialog box appears.

3. Choose the Cut option.

This will remove the top note of each chord and place it on the
Clipboard.

4. Choose the “One new track” option and type in a name for the new
track to be created.

5. Click the radio button next to the Top__ notes option.

6. Enter a value of 1 in the box for the option.

This specifies that only the top note of each chord will be cut or
copied.

7. Press OK to confirm your selections.
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The new track now contains the lead line. You can now use
commands from the Region menu to modify the lead line.

Enhancing a Lead Line Once you have the lead line separated out, you can change it in
useful ways. Two suggested enhancements are doubling it an octave
higher and increasing its velocity values. After you have made the
modifications, you can merge the enhanced lead line back with the
original material.

1. Extract the lead line as described above.

2. Select the extra track which contains only the lead line.

3. Enter Start and End times in the Edit bar of the Tracks window that
will contain all notes in the lead line.

These should be the same ones used with Split Notes above.

4. Choose a command from the Regions menu.

To double the lead line an octave higher, choose Transpose. To
give the lead line higher velocity values, choose Change Velocity.

5. Choose the options and values you want for the command and
Press OK.

For Transpose, enter an octave interval (C3 to C4). For Change
Velocity, choose the Add to all option and enter a value to
increase the velocities by (try' a value between 10 and 30).

6. Choose Copy from the Edit menu.

This puts the modified lead line on the Clipboard.

7. Select the original track from which you extracted the lead line.

Click on the track name to select the track.

8. Choose Merge from the Edit menu.

The modified lead line is now part of the original passage.

9. Select the extra track containing only the lead line by clicking on it.
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10-Choose Delete from the Tracks window mini-menu.

This gets rid of the extra track.

The enhancement is now complete.

A variation on the operation to double the lead line an octave higher
is to double the bass line an octave lower. Use the Bottom___notes
option and transpose it down an octave with the Transpose
command.

Some variations on the operation to increase the velocity values of
the lead line are as follows:

Make the notes of the chords softer (by decreasing their velocities)
instead of the making the lead line louder. This would involve
modifying the notes of the chords after you extracted the lead line
from them and merging the (unaltered) lead line back with the
modified chords.

Use the Change to.__ % of current value option in the Change
Velocity dialog box rather than adding a constant value to the lead
line. This better preserves the dynamic contour of the lead line.

Leave the lead line on a separate track and play it back through
another synthesizer as well as on the synthesizer playing back the
chords. This highlights the lead line through timbral or tone color
means.

Doubling Accented
Notes

This procedure allows you to split out only those notes which have a
higher velocity in order to accent them.

1. Select the region containing the lead line.

See Selecting a region above.

2. Choose Split Notes from the Region menu.

The dialog box appears.

3. Choose the Copy option.

This will place the selected notes on the Clipboard.
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Dividing a Keyboard
Part Into Its Right and
Left Hand Components

4. Choose the All notes option.

Click in the radio button next to the option.

5. Choose the On velocities option.

Enter a range of values that will separate out accented notes in the
region.

6. Press OK to confirm your choice or Cancel to cancel.

7. Paste the Clipboard into a new track.

See the chapters on Edit Commands and The Tracks Window for
help with this.

At this point, you can use other Region commands (such as
Transpose) to enhance the accented notes. Alternatively, you can
simply assign the track with only the accented notes to be played
back on a separate channel by another synthesizer.

Sometimes, it is useful to be able to treat the left-hand and right-hand
parts of a keyboard track separately. Performer does this
automatically in the QuickScribe notation window. If you want, you
can do it manually by following the earlier procedure for extracting a
lead line but use the Notes with pitches between and option.
The pitches you enter should correspond with the range of either the
right or left hand. Since this range is rarely consistent, you will
probably have to organize your sequence into sections according to
one hand’s pitch range and use Split Notes on each section. You can
then add a new track and paste the notes you’ve cut into it.
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Chapter 28 Region Cernmnds 2

Editing During Playback

Selecting a Region

The Continuous
Data Commands

Almost all of the editing operations discussed in this chapter and the
next can be done while the music is playing back so that you don't
have to stop and start the music to hear the result. For example, you
could change note velocities in a track while the music is playing and
then use the Undo/Redo command as the music continues playing to
compare the original and modified data.

The commands in this chapter act on the a selected region in the
Tracks List, the Tracks Overview, or one of Performer’s three track
edit windows. Without a selected region, the commands in this
chapter do nothing. So be sure to learn how to select a region by
reading chapter 25, “Selecting Regions”. It contains many powerful
shortcuts that will speed up your work.

Continuous data is data which changes smoothly over time. The
continuous MIDI data types include pitch bend, mono and poly key
pressure and controller information. These types of data are output
rather quickly, resulting in a large amount of data. Continuous data
events are closely spaced, each specifying a slightly different value
for the parameter which is changing. For instance, when you move a
pitch wheel, a different pitch bend value might be sent every 20 ticks,
resulting in 120 continuous data events per quarter note.

Continuous data is not really continuous at all: it is approximated by
large numbers of events, each of which contain a small value change.
When played back, they create a change that seems smooth and
continuous. The closer together in time successive values are, the
smoother the change will be. If the values are too close together,
delays can occur due to the baud rate (data transfer speed) limit of
MIDI transmission.

There are 16,384 different pitch bend values and 128 different
controller and aftertouch values. Some synthesizers do not respond to
every different pitch bend value: several successive values may
produce the same effect. The response to different controller values
may also be hard to hear. These facts may influence your decision
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Types of Continuous
Data

about how many continuous data events to store. Performer gives
you the option to decrease or increase the number of continuous data
events in a region.

The continuous data commands require you to specify the type of
continuous data to be modified. The following is a description of the
different types of continuous data and how they are produced.

Pitch Bend: On most synthesizers, this controller is a wheel, joystick
or ribbon controller. When moved, it “bends” or varies the pitch
either up or down depending on the direction of movement. Pitch
bend data indicates the movement of the pitch bend device; it does
not necessarily correspond to a musical interval. When played back,
this data controls the sound module’s pitch bend device. Most
synthesizers allow you to specify the interval by which a maximum
pitch bend value will alter a pitch. Thus, moving the pitch bend
device to its extreme high position can could cause a pitch to be
raised by an octave, a fifth or any other interval. All other pitch bend
values are scaled according to the interval the maximum value
produces.

Mono key pressure: Also known as aftertouch or channel pressure,
this is a special kind of controller, putting out values between zero
and 127. If you continue to press down a key after you play a note,
mono key pressure information is sent. The harder you press, the
higher the value. Mono key pressure is useful for things like changing
the tone quality of a sound or controlling the amount and depth of
vibrato.

Poly key pressure: This is similar to mono key pressure except that
each key can generate its own pressure information, instead of one
pressure level for the whole instrument based on the key most
recently pressed. Poly key pressure therefore allows for much more
subtle and complicated aftertouch effects. Since each key can have its
own set of key pressure data, you must specify the note name by
entering a pitch value when using the Poly key pressure option in the
continuous data commands. You can enter the pitch directly from
your MIDI keyboard. If you don’t specify a pitch, all keys will be
affected by the command.
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Thin Continuous
Data

Basics

Controller: Foot pedals, wheels, sliders and breath controllers are
common types of controller devices. Controllers are general purpose
devices used to control such effects as vibrato and tremolo. They are
identified by number; the number assigned to a specific controller
depends on the synthesizer you are using. Continuous controllers
(such as wheels and sliders) are generally numbered in the range
zero to 63. Switch controllers (on-off types like a sustain pedal) use
higher numbers. Synthesizers will often respond to more controllers
than they have physical controls for.

When using the continuous data commands on controller data, you
must specify the number of the controller whose data you wish to
modify. This can be done by clicking in the box next to the
controllers option and moving the correct controller on your MIDI
input keyboard.

Synthesizers tend to send continuous data as fast as they possibly
can. If you record several tracks of this and play them all back at
once, Performer, your synthesizers, or MIDI itself may bog down. The
Thin Continuous Data command selectively removes continuous data
events, “thinning out” the amount of continuous data while retaining
all of its essential characteristics. This allows you to transmit a
reasonable amount of continuous data that can be handled easily by
all components of your MIDI system.

The Thin Continuous Data command actually determines the contour
of the continuous data in the selected region. The continuous data in
this region is erased and new continuous data is generated. This new
data is more sparse, reconstructing the analyzed contour with fewer
events. Unless musically necessary, successive continuous data
events will not occur closer together than the minimum time change
and will not differ in value from adjacent events by less than the
minimum value change.

Since the continuous data is regenerated, it is possible that this
command will thicken the data instead of thinning it. You may find
this aspect of the command useful if you have thinned out the data
too much.
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Using Thin Continuous
Data

The appropriate minimum time change depends on the tempo of the
sequence and the controller device involved. Generally, a value of 10
to 20 will work well. The minimum value change should be 1 for
controllers and 4 to 8 for pitch bend. Experimentation is essential to
find the best values in each instance.

To use Thin Continuous Data:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Thin Continuous Data from the Region menu.

A dialog box appears.

3. Choose the type of data you wish to thin out.

Click in the radio button next to the type you want: Pitch Bend,
Mono Key Pressure, Poly Key Pressure or Controller. See The types
of continuous data above for an explanation of each type.

4. Specify a minimum time change.

Click in the box for this parameter and type in a value between
zero and 999.

5. Specify a minimum value change.

Click in the box for this parameter and type in a value.
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6. Press the OK button to confirm your entry or the Cancel button to
cancel it.

You can Undo and Redo the Thin Continuous Data command.

After you OK this command, it may take some time to carry out the
change. If you wish to terminate the command while it is working,
press the Command and period keys together.

Create
Continuous Data

The Create Continuous Data command creates a stream of
continuous data events that change smoothly over time. You can use
it to create pitch bends, crescendos and diminuendos, filter sweeps
and many other effects.

Basics This command creates continuous data events that change smoothly
between the starting and ending values. All values must be within the
range zero to 127, except for pitch bend data which is in the range -
8192 to 8191.

The contour of the changing values is controlled by the curvature
parameter. It allows you to “weight” the change. With a curvature of
zero, the change is linear from the first to the second entered value.
The more you increase the value positively (with values from 1 to
99), the more the change will take place towards the end of the
region. The more you increase the value negatively (with values from
-1 to -99), the more the change will take place towards the beginning
of the region.

The number of events generated are controlled by the minimum time
change and the minimum value specified: all events created will not
be any closer together than the minimum time change and they won’t
be separated by values smaller than the minimum value change.
Though Performer can create a perfectly smooth set of values, the
actual result may not be perfectly smooth due to the minimum time
and value changes you enter. Experimentation is the key to good
results.

You can Undo and Redo the Create Continuous Data command.
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Using Create
Continuous Data

To use Create Continuous Data:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Create Continuous Data from the Region menu.

A dialog box appears.

3. Choose the type of data you wish to create.

Click in the radio button next to the type you want: Pitch Bend,
Mono Key Pressure, Poly Key Pressure or Controller. See The types
of continuous data above for an explanation of each type.

4. Specify start and end values for the data.

The data created will have values ranging smoothly between the
start and end values.

5. Specify a minimum time change.

Click in the box for this parameter and type in a value between
zero and 999.
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6. Specify a minimum value change.

Using the Randomize
Option

Click in the box for this parameter and type in a value between
zero and 127.

7. Press the OK button to confirm your entry or the Cancel button to
cancel it.

After you OK this command, it may take some time to cany' out
the change. If you wish to terminate the command while it is
working, press the Command and period keys together.

Any existing data of the type being created in the selected region is
removed.

See the Basics section of the Thin Continuous Data command above
for suggestions on setting the minimum time and value change
parameters.

The Randomize option allows you to generate variability in
continuous data that you create, as apposed to a perfectly smooth
line or curve. Doing can introduce can add extra feel and depth to the
musical effect you are creating with the continuous data.

Notice that the Randomize option is a check box, which means that
it can be used with any of the radio button options above. Check the
box to randomize; uncheck it for no randomization.

Region Commands 2 457



When this command randomizes, it choose random values within the
range that you specify. Each continuous data event is first generated
by the rest of the parameters above, and then the event’s value is
randomized within the range you specify in the range box. The result
is a curve or line that is not perfectly straight:

Change
Continuous Data
Using Change
Continuous Data

The Emphasis sub-option causes the tendency of the randomization
to be higher or lower within the specified range. Thus, if you wish to
randomize the continuous data events within a certain range, but you
wish them to tend to be higher, use a positive emphasis; use a
negative emphasis if you wish them to tend to be towards the lower
end of the range. A value of zero equals no emphasis, which causes
the randomization to occur evenly within the range.

With the Change Continuous Data command, you can modify
existing continuous data by scaling it or limiting it to a specific range.

To use Change Continuous Data:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Change Continuous Data from the Region menu.

A dialog box appears.
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O *" Pitch bend ® A Controller |7 |
O ± Mono pressure O 11 Poly pressure | |

® Add 125| | to all values
O Limit to a range 

from | | to | |
O Change to | |%> of current value

I“1 Randomize by ± 110 |
Emphasis: | | (-9 to +9)

3. Choose the type of data you wish to change.

Click in the radio button next to the type you want: Pitch Bend,
Mono Key Pressure, Poly Key Pressure or Controller. See The types
of continuous data above for an explanation of each type. Only
the type of data you select will be changed.

4. Choose the change option you want.

Click in the radio button next to the option.

5. Enter the value required by the option.

Click in the box for the option and type in the value you want.
You may select only one option.

6. If you would like to randomize the data, check the Randomize
check box and enter a Randomization range and emphasis.

For more information about these options, see “Using the
Randomize Option" on page 457, as this option works the same as
the Randomize option in the Create Continuous data command,
except that it changes existing data rather than newly created data.

7. Press the OK button to confirm your entry or the Cancel button to
cancel it.
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You can Undo and Redo the Change Continuous Data command.

Add to all values

Limit to a maximum
of__

Limit to a minimum of

Set to % of current
value

Reassign
Continuous Data

Using Reassign
Continuous Data

The entered value is added to all continuous data in the selected
region. Enter a positive number if you wish to increase the values in
the region or a negative number if you wish to decrease them. If a
value exceeds the limit of its data type, it will be truncated at the limit
value (e.g. if a pitch bend value comes out to -10.150, it will become
-8192, the minimum limit for pitch bend values).

Events in the selected region whose values are greater than the
entered value are changed to the maximum value.

Events in the selected region whose values are less than the entered
value are changed to the minimum value.

The values of all events in the selected region are scaled by the
entered percentage value. Thus, specifying 50% halves the values,
while 200% doubles the values. If a value exceeds the limit of the its
data type, it will be truncated at the limit value (e.g. if a pitch bend
value comes out to -10,150, it will become -8192, the minimum limit
for pitch bend values).

With the Reassign Continuous Data command you can convert one
type of continuous data into another. For example, you can convert
pitch bend data into modulation wheel data. This command is very
useful for changing the controller number of continuous data when
playing back a sequence on a different synthesizer than the one it
was recorded with.

To use Reassign Continuous Data:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Reassign Continuous Data from the Region menu.

A dialog box appears.
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Invert Pitch

b Reassign Continuous Data

® Change O Copy

® " Pitch bend O A Controller | |
O ± Mono pressure O 11 Poly pressure | |

****** to ******

® " Pitch bend O A Controller | |
O ± Mono pressure O 11 Poly pressure | |

3. Choose either the Change or Copy option.

Click in the radio button next to the option. The Change option
changes data from one type to another. The Copy option makes a
copy of the data in the same track of the new type you specify.

4. Enter the type of continuous data to be changed.

Click on the appropriate radio button.

5. Enter the type of continuous data you wish it to be changed to.

Click on the appropriate radio button.

6. Press OK to confirm your entry or Cancel to cancel it.

You can Undo and Redo the Reassign Continuous Data command.

The Invert Pitch command inverts or flips notes around a specified
axis. The inversion is chromatic, that is, exact. For example, if the
following E major scale (starting on E3),
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Basics

Using Invert Pitch

is inverted around an axis of D3, the following will result:

Inversion is an operation in which the interval between a note and
the inversion axis pitch is measured and the note is transposed the
same interval on the opposite side of the axis pitch. Two examples
are shown below: If the note to be inverted is F4 and the axis pitch
is C4, the interval between them is a perfect fourth. Since F4 is above
C4, it will be transposed down by the same interval, a perfect fourth,
resulting in a G3- If the note to be inverted is 03 and the axis pitch
is A3, the resulting pitch would be F4. In the following picture, the
axis pitch in each measure is represented by a diamond:

The inversion is always exact, transposing the note the same
chromatic interval above or below the axis pitch.

To use Invert Pitch:

1. Select the region to be inverted.

See Selecting a region in the Region Commands 1 chapter.

2. Select Invert Pitch from the Region menu.

A dialog box appears.

Inuert Pitch
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3. Enter the axis pitch for the inversion.

Hints

Reverse Time
and Retrograde

You can use your MIDI keyboard for input. This is the center pitch
around which the inversion will take place.

4. Press OK to confirm your entry or Cancel to cancel it.

You can invert a region of notes around a pair of axis pitches. Follow
the above procedure for normal inversion specifying the lower of the
two pitches in the Invert Pitch dialog box. Then use the Transpose
command on the Region menu to transpose the region by the interval
between the two axis pitches.

Example: You wish to transpose the following passage around the
axis pitch pair C3 and E flat 3.

Use Invert Pitch on the passage specifying C3. The following is the
result:

Select the region containing the passage and use the Transpose
command on the Region menu transposing from C3 to E flat 3 (a
minor third, the interval between the two axis pitches).

This is the final result, inverted correctly around the pair of axis
pitches:

The Reverse Time and Retrograde commands reverse the order of
events in a selected region. However, each command reverses notes
in a slightly different way, producing much different results.
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Reverse Time

Retrograde

Reverse Time reverses the order of notes' attack times in a region. A
note whose attack occurs two beats from the beginning of the region
is moved so that its attack occurs two beats before the end of the
region. In doing so, Performer either maintains the note’s duration or
ends the duration just before the next attack. Notice in the example
below that Reverse Time places the attack of the first note exactly at
the end of the region, extending the duration into the next bar.

Retrograde inversion simply reverses the order of notes within the
region: the first note becomes the last note, the last note becomes the
first note, and so on. This is analogous to playing a tape backwards
and recording the result.

Reverse Time

Retrograde

Original phrase

Note: for clarity, we have shortened the durations in
the Reverse Time example so that they don’t extend
beyond the next attack. In actuality, the notes maintain
their original durations after being reversed.

To get an exact reversal of the notes, you have selected a region of
time, rather than specific events. In addition, the region of time must
include the duration of the last note in the region. In the example
above, the last note is the sixteenth note, G4. To obtain the results
shown on the bottom staff, you would have to select the region from
1111000 to 2111000, where 2111000 takes into account the duration
of the G4 sixteenth note.
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To specify a region of time that includes the final duration, select the
region using the Edit bar in the Tracks window, or by dragging in the
Time Ruler of the Graphic Editing window or Tracks Overview.
Selecting specific events won't work because the duration of the final
note is not included. (For example, if you selected the original phrase
above in the Event List, the end of the region would be
1141361 instead of 2111000.

Using Reverse Time To use Reverse Time, you can select the notes in any fashion:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Reverse Time from the Region menu.

You can Undo and Redo the Reverse Time command.

Using Retrograde When using the Retrograde command, you must select a region using
the edit bar in the Tracks window. The Retrograde command will
have no effect on data that has been highlighted in an Event Editing
window.

1. Select the region you wish to modify.

See Selecting a region using the Tracks window in the Region
Commands 1 chapter.

2. Choose Retrograde from the Region menu.

You can Undo and Redo the Retrograde command.

Scale Time The Scale Time command expands or compresses the duration of
events in the selected region by the specified ratio. This effectively
changes the distance between notes, making them closer together or
farther apart. Since the actual duration of events changes, the region
will become smaller or larger after this command is invoked.

Basics Scaling time allows you to double, halve or otherwise alter the
amount of time an event takes. A wide range of compression or
expansion of the duration of events is possible. The amount of
change to the duration is specified by an integer ratio, e.g. 3:2. If the
first number in the ratio is larger than the second, the region is
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Original selected region:

expanded; if the first number is smaller than the second, the region is
compressed. A ratio of 2:1 doubles the duration of all events in the
region (and doubles the length of the entire region as well); a ratio of
1:2 halves the duration of all events in the region.

Events at the Start time of the region will remain in place. Since the
overall length of the region changes, events at the end will be moved.
If the end of the region expands, events in it will be merged with data
already there.

<777777A ~ V7///ZZ1

Scale Time cuts the selected region... Y//////A 7777777

...and then compresses and merges...

7777777\ :

Blank space

<//77/7A

...or expands and merges.

Using Scale Time

7777777

All MIDI data events are scaled. The Scale Time command does not
affect loops or any event in the Conductor track.

To use Scale Time:

1. Select the region you wish to modify.

See Selecting a region in the Region Commands 1 chapter.

2. Choose Scale Time from the Region menu.

A dialog box appears.
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Examples

Scale Tempo

Scale time by a factor of:

(1 to 2 = compress to half as long)
(2 to 1 = expand to twice as long)

| OK  j | Cancel |

3. Enter the ratio values.

The values must be between 1 and 99.

4. Press the OK button to confirm your entry or the Cancel button to
cancel it.

Here are three examples to give you a better idea of the use of Scale
Time:

You ’ue entered a melody in eighths but decided it would sound better
in sixteenths. Select the region of the melody and use Scale Time with
a ratio of 1:2.

Your sequence is in 4/4 time with lots of triplets. You want to modify
it to be in 12/8, converting the triplets to regular eighths. Select the
entire sequence. Use Scale Time with a ratio of 3:2. Afterwards,
change the meter and tempo appropriately.

You’ve entered a melodic idea in quarter notes and decide that it
should actually be the bass line for the sequence. All notes should be
whole notes. Select the region with the melody and use Scale Time
with a ratio of 4:1. Then transpose it down to the correct octave.

The scale tempo command provides several ways to modify existing
tempos within a selected region in the Conductor track of a sequence
or song. It modifies existing tempo events within the region, but it
does not generate new tempo events. (To do so, use the Change
Tempo command in the Change menu.) The Scale Tempo command
is ideal for making global changes to an existing tempo map that you
have already created with the Change Tempo command. For 
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Selecting a Region to
Scale

example, you might have created an elaborate tempo map with many
tempo nuances, and you would like to increase the overall tempo
while maintaining the nuances.

Scale tempo of sequence Seq-1

O Add|0-00 | bpm to all tempos
O Subtract |0-00 ] bpm from all tempos

O Limit to a range 
from | |to | | bpm

O Change to | I ?5 of current value

O Change overall tempo
from 10-00 ] to |0-00 1 bpm
and scale all tempos accordingly

© Scale all tempos to fit nevz end time
From 1|1|000 at 0:00:00:00
To 5111000 at | 0:00:09iH|
O © Real time ® ■■ Frames

 Randomize O by 11 |%i of current value
® by ± |5.00 |bpm

Emphasis: |O | (-9 to+9), -

The Scale Tempo command requires that you select the tempo events
you wish to scale in the Conductor track before you select the
command from the Region menu.

«•* Note that the Scale Tempo command only affects
tempo events that already exist in the Conductor track.
If the region you select has no tempo events in it, this
command will have no effect. If so, use the Change
Tempo command in the Change menu to generate
tempo events.

There are several ways to select a region in the Conductor track. For
more information, see chapter 25, “Selecting Regions".

Once you have selected the tempo events you wish to scale:

1. Choose Scale Tempo from the Region menu.

468 Region Commands 2



2. Select the desired scaling option.

Add bpm to all
tempos

Subtract bpm from
all tempos

Limit to a range from
to__

Change to % of
current value

Change overall tempo
from to and
scale accordingly

Scale all tempos to fit
new end time

Each scaling option is discussed below.

3. Click OK to confirm your choice or Cancel to withdraw it.

This option adds the number of beats per minute (bpm) you enter to
each tempo event within the selected region.

This option subtracts the number of beats per minute (bpm) you
enter from each tempo event within the selected region.

This option searches for tempo events above or below the specified
range. When it finds one, it changes the tempo to fall within the
range. For example, if the tempo range is from 200 to 300, a tempo
of 351 would be changed to 300 and a tempo of 60 would be
changed to 200.

This option increases or decreases each tempo event by a percent of
its current value, where the current value is 100%. Use a percentage
lower than 100% to slow down the tempo; use a value above 100%
to raise it. Use this option when you wish to maintain the degree of
change between tempos within the tempo map when you raise or
lower it.

This option scales the tempo events by a percentage, just like the
option above it. However, it lets you specify the change in beats per
minute (bpm) rather than as a percentage. For example, suppose you
have a piece of music with varying tempos, but whose approximate
tempo is 80 bpm. You simply wish to change it’s overall tempo from
around 80 bpm to around 96 bpm. Rather than figuring out what
percent to type in the percentage option to achieve this change, you
can use this option to type in the original approximate tempo of 80
bpm and the desired increased tempo of 96 bpm, and let Performer
figure out the percent increase for you. All in all, this option provides
a more musical way of specifying a percent by which you wish to
scale the tempos, even though it accomplishes the same thing as the
“scale by percent” option.

This option scales all existing tempo events to increase or decrease
the overall elapsed time of the selected region. The start time of the
region is fixed, and the end time can be made earlier or later. Times
can be expressed in real time or SMPTE frame time. Flere is an 
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Randomize

example: suppose that you have created a sequence with many
tempo changes, and it is around 3 minutes long. But you would like
to make it 3 and a half minutes long. This option lets you select the
three minute region and scale all the tempos so that it stretches out
evenly to 3 1/2 minutes.

Here’s another example: suppose you are locking a sequence to
picture via SMPTE time code. You have composed a section of music,
and you’ve programmed all of the tempo changes. You’ve got the
section starting at the correct frame time, but it ends with a hit that is
off by several frames. With this scale tempo option, you can select the
region with the hit as the end time of the region, choose scale the
tempos, and type in the new end time where the hit should occur,
changing the elapsed time such that the hit lands at the correct frame.

The randomize option is a check box option that works in
conjunction with the radio button option selected above.

The randomize options are explained below.

By % of current value
This option randomizes the tempo of each selected tempo event
within a range that is expressed as a percentage of the tempo value.
For example, if the tempo is 100 bpm, and you enter 10 percent, the
tempo will be randomized within a range between 90 to 110 bpm
(±10 bpm).

By±bpm
This option randomizes the tempo of each selected tempo event
within a range of beats per minute.

Emphasis
This sub-option causes the tendency of the randomization to be
higher or lower within the specified range. Thus, if you wish to
randomize the tempos within a certain range, but you wish them to
tend to be higher, use a positive emphasis; use a negative emphasis
if you wish them to tend to be towards the lower end of the range. A
value of zero equals no emphasis, which causes the randomization to
occur evenly within the range.
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Chapter 29 Tiramspose

Performer’s Transpose command, found in the Region menu,
transposes the pitches of all notes in a selected region. With it you
can:

■ transpose by interval

■ transpose diatonically to create harmonies

■ change key from any root to any other

■ change key from any mode to any other

■ map each pitch to any other pitch for mapping drum track
note assignments from one drum machine to another

□ transpose using scale sizes larger or smaller than 12 notes

■ transpose up or down, by any number of octaves

■ create and save custom transpose maps

■ create and save custom scales or keys

When performing the above operations, you can:

■ play in pitches or entire scales from your MIDI keyboard
when setting up the transposition

■ Undo and Redo the Transpose command
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Quick Reference The Transpose dialog box provides several ways of transposing,
options for each type, a Transpose Map that shows you how each
pitch will be changed, and a Custom Maps list which can save
transposition maps.

octaves

Custom map name:

Transpogg^

Once you have set up a transposition,

you can save it by typing in a name

and clicking Save; it will then appear in

the list. You can use the transposition

map at any time by clicking its name.

Create your own types of

scales with the custom

scales command.

Interval
Diatonic
Key /Scale
Custom Map

® Up
O Down

o
o
®
o

® Transpose O Harmonize

( Save ) ( Delete)

This area presents options for the type of

transposition chosen to the left.

The Transpose Map changes dynamically to

reflect the transposition or custom map you

have chosen to the left. You can pop-edit

pitches in the To column to create a custom

map. Changes in one octave are reflected in

Transpose Map
FP.OM TO

C3 Db3
Db3 Eb3
D3 Eb3
Eb3 E3
E3 E3
F3 Gb3
F«3 Ab3 =
G3 Ab3
Ab3 A3
A3 A3
Bb3 C4
B3 C4
C4 1 Db4 &

From:
[c__ | tWbfh? ZE]Natural Minor

Harmonic Minor
Dorian
Phrygian

|Db | Major
Natural Minor |TT
Harmonic Minor
Dorian
Phrygian
® Constrain to scale

' Create Scale...}

Custom Maps

My map £RS to D4 map
Cross-octave
All notes to Bb3
C mai to C min p

all other octaves.

Harmonizing instead of
Transposing

The Transpose Map is discussed next, and the four types of
transposition are described in following sections.

The Transpose dialog box allows you to either transpose or
harmonize. The Harmonize option copies the original notes,
transposes the copied notes, and the merges them together with the
original notes. This allows you to build harmonies quickly.
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The Transpose Map The Transpose Map displays a scrolling list of all 128 MIDI notes in a
column on the left and the pitch to which each will be transposed in
a column on the right. Notes and spellings in the map change
dynamically according to the transposition options that you choose.
In addition, you can pop-edit values directly in the Transpose Map list
as shown below to further modify the map. Changes in one octave
are reflected in all other octaves.

When the Diatonic or Scale/

Key transpose option is

selected, scale steps in the

source key are displayed in

boldface.

Changes in each octave are reflected in

ail other octaves as well.

You can customize the transposition by

pop-editing destination pitches to

change them. Use the up/down arrow

keys to scroll through the list. You can
play pitches in the pop-up box from your

MIDI keyboard.

View other octaves by

using the scroll bar.

As soon as you pop-edit a pitch in the Transpose Map, thus
modifying it from they way it was originally set up by the transpose
options, the Custom Map transpose option will then become
automatically selected to indicate that the transpose map is now a
custom map.

Playing In Pitches From
Your MIDI Controller

When pop-editing the Transpose Map, you can play in individual
pitches or an entire scale from your MIDI controller. To play in a
scale, double-click the first pitch to pop-edit it and then play the
scale. As you play, each pitch gets entered into the current pop-up
box, which then automatically scrolls down to the next note in the list
and enters the next pitch you play. If you make a mistake, use the up
and down arrow keys to move the pop-edit box.
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Saving a Transpose Map

Using Transpose Maps

When you are using the Custom Map option. Performer provides
another intuitive way for you to play in pitches from your controller:

1. Select the Custom Map option.

2. Hold down the pitch you wish to transpose, and while holding it
down, play the pitch you wish to transpose it to.

You DO NOT need to pop-edit any values to do this.

If you would like to save a transpose map, type in a name for it and
click Save as shown below. Custom maps are saved with the file and
can be loaded into other files with the Load command in the File
menu.

i Save j i Delete.)

Custom Maps
My map
R8 to D4 map im

k>

Cross-octave —=

All notes to Bb3 :::::::

C maj to C min £

Custom map name:
[My Transpose Map|

To save a transpose map, type in

a name and click Save.

To recall the map, select its name in the list. To remove a Custom Map
from the list, click its name and click Delete.

To make changes to an existing map:

1. Select the existing map in the list.

2. Make your changes to the Transpose Map.

3. Click Save.

The changes you made will be saved to the map.
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To create a new map based on an existing map:

Transposing by Interval

1. Select the existing map in the list.

2. Type in a new name.

3. Click Save.

The new map will appear in the list.

4. Edit the Transpose Map to make your changes.

5. Click Save to save the changes you have made.

Transposing by Interval is chromatic, exact transposition: pitches are
shifted by the number of semitones in the interval that you choose.
Literally, it causes a mass shift of all pitch values in the selected
region, just like dragging notes up or down in the Graphic Editing or
QuickScribe notation windows. For example, chromatically
transposing from 03 to E3 causes all pitches to shift up a major third
(four semitones).

The only option for this type of transposition is the from and to
pitches that define the interval. The notes that you enter to define the
interval are not important: only the interval between them matters.
For example, instead of entering C3 to E3 to shift notes up a major
third, you could enter F3 to A3.

The two pitches entered also define the direction of transposition. If
the second pitch is above the first pitch, pitches will be transposed
up. If the second pitch is below the first, pitches will be transposed
down.
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Transposing
Diatonically

Having chosen an interval, you can pop-edit the transpose map to
make modifications to it if you like. As soon as you pop-edit a pitch
in the Transpose Map, thus modifying it from they way it was
originally set up by the Interval transpose options, the Custom Map
transpose option will then become automatically selected to indicate
that the transpose map is now a custom map.

Diatonic transposition transposes notes by a number of scale steps
within the type of scale that you choose. For example, if you
transpose up 2 scale steps in the key of C minor as shown in the
above example, all C naturals (the root) will be transposed up two
steps to E flat (a third). Notice that the number of scale degrees, 2 in
this example, refers to the number of scale steps to change by; it does
not refer to the destination scale step.

This is extremely useful for quickly creating harmonies. For example,
as shown above you can copy and paste a melody line into another
track and transpose it diatonically up a third (two scales degrees) to
harmonize with the melody. Scale tones in the key you choose are
displayed in boldface in the transpose map column.
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To Transpose diatonically:

1. Choose the Diatonic option.

2. Choose the direction (Up or Down) and number of octaves.

3. Type or play in the key root pitch and select a mode from the list.

This sets up the Transpose Map. You can play in the root pitch
horn your MIDI keyboard if you place the insertion point in the
From text box.

4. If you would like to transpose all non-scale pitches into the nearest
scale pitch, select the Constrain to scale option.

5. If you would like to customize the transposition, pop-edit values in
the Transpose map.

As soon as you pop-edit a pitch in the Transpose Map, thus
modifying it from they way it was originally set up by the Diatonic
transpose options, the Custom Map transpose option will then
become automatically selected to indicate that the transpose map
is now a custom map.

6. Click OK.

The Up and Down options determine the direction of transposition,
and the Plus n octaves option allows you to transpose by intervals
greater than one octave.

Remember that the key you choose is a way of setting up the diatonic
transposition in the Transpose Map. Performer doesn’t really “know”
what key the actual data is in. In fact, just about any musical phrase
can be described in musical terms as being in one of several different,
but related, keys. So, when transposing diatonically, it is up to you to
know which key to choose to get the results that you want.

The above also holds true for how notes get spelled. The key that you
choose only affects the spellings in the Transpose Map: it will not
change the spellings of the actual track data. Track note data spellings
are controlled by the current key signature in the Conductor track.
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The Constrain to Scale
Option

The Constrain to scale option is available with the Diatonic and Key/
Scale transpose options. If enabled, it causes all non-scale tones to be
transposed to the nearest appropriate scale tone, as shown below:

□ Constrain to scale @ Constrain to scale

Transposing by Key/
Scale

Natural Minor

i Save ) I. Delete)

Transpose Map

Harmonic Minor

Cancel

Custom map name:

® Transpose O Harmonize

O Interval ® Up
O Diatonic O Down
® Key/Scale Plus |0 |
O Custom Map octaves

Dorian
Phrygian
® Constrain to scale

iCreate Scale...)

FROM TO

C3 Db3 12
Db3 Eb3
D3 Eb3
Eb3 E3
E3 E3
F3 Gb3
F»3 Ab3
G3 Ab3 —
Ab3 A3
A3 A3
Bb3 C4
B3 C4
C4 Db4 £

From:
[c__ Major £

Natural Minor
Harmonic Minor —
Dorian
Phrygian 1

Custom Maps
My map 12R8 to D4 map c=
Cross-octave
All notes to Bb3 __
C maj to C min 2

Transposing by Key/Scale transposes notes from one key to another.
For example, you can change music that is currently in a major key
to its corresponding minor key. In the above example, notes in the
key of C major are being transposed down to a entirely different root
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and key: E Mixolydian. The Transpose Map shows each note in the
key of C Major on the left and the pitch each will be transposed to in
the key of Db Harmonic Minor.

To Transpose by key:

1. Choose the Key/Scale option.

2. Choose the direction (Up or Down) and number of octaves.

3. Type or play in the source key root pitch and select a mode from
the top list.

This sets up the From column in the Transpose Map. You can play
in the root pitch from your MIDI keyboard if you place the
insertion point in the From text box.

4. Type or play in the destination key root pitch and select a mode
from the bottom list.

This sets up the To column in the Transpose Map.

5. If you would like to transpose all non-scale pitches into the nearest
scale pitch, select the Constrain to scale option.

6. If you would like to customize the transposition, pop-edit values in
the Transpose map.

As soon as you pop-edit a pitch in the Transpose Map, thus
modifying it from they way it was originally set up by the Key/
Scale transpose options, the Custom Map transpose option will
then become automatically selected to indicate that the transpose
map is now a custom map.

7. Click OK.

The Up and Down options determine the direction of transposition,
and the Plus octaves option allows you to transpose by intervals
greater than one octave.

Remember that the source and destination keys that you choose are
a way of setting up the diatonic transposition in the Transpose Map.
Performer doesn’t really “know” what key the actual data is in. In fact,
just about any musical phrase can be described in musical terms as
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being in one of several different, but related, keys. So, when
transposing by key, it is up to you to know which key to choose to
get the results that you want.

The above also holds true for how notes get spelled. The key that you
choose only affects the spellings in the Transpose Map: it will not
change the spellings of the actual track data. Track note data spellings
are controlled by the current key signature in the Conductor track.

Transposing Using a
Custom Map

The Custom Map option allows you to do several things. You can:

■ create a customized map that is based on one of the other
transpose options

■ transpose using octave ranges other than 12 halftones

■ map each note to any other note

□ map all notes to a single pitch

Each of these operations are discussed below.

Custom Transposing
Based on Another
Transposition

Often you may want to slightly modify a transposition set up by one
of the first three transpose options. For example, you may want to
transpose diatonically up two scales steps except for each A-flat,
which you would like to maintain as an A-flat. In this case, you can
set up the Diatonic transposition and then pop-edit the destination
pitch for A-flat so that it doesn’t change pitch.

To create a customized map that is based on the Interval, Diatonic, or
Key/Scale Transpose options:

1. Choose the Transpose option you would like to base your custom
map on.

Set up the parameters for the option as necessary.

2. To customize the transposition, pop-edit values in the Transpose
map as needed.

As soon as you pop-edit a pitch in the Transpose Map, thus
modifying it from they way it was originally set up by the
transpose options, the Custom Map transpose option will then
become automatically selected to indicate that the transpose map
is now a custom map.
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3. If you would like to save the map, type in a name and click Save.

Custom Transposing
With a Non-standard
Octave Range

The map will appear in the Custom Maps list.

4. Click OK to execute the transposition.

Interval, Diatonic, and Key/Scale transpose options all set up the
transpose map in 12 note octaves. Changes in one octave are
reflected in all other octaves. The Custom Map option can set up the
transpose map in octaves that are more or less than 12 notes. For
example, if you have a sampler that has drum pitched drum sounds
like tom-tom drums every 6 notes, you can transpose that 6-note
range to the 10-note range of another sampler. Or, you can transpose
music from a 12-tone synth to a synth that is tuned in quarter-tones.

The Custom Transpose option frees you from the octave and diatonic
restrictions of the other transpose options.

To transpose using an custom octave range:

1. Select the Custom Map transpose option.

The Custom Transpose options will appear.

O Interval
O Diatonic
O Key/Scale
® Custom Map

From :
112 | notes starting at 

To:
|24 | notes starting at 

Transpose Map
FROM TO

C3 03 &
Db3 E3
D3 F«3 :
Eb3 Ab3

 E3Bb3
F3 C4
F«3 D4 =
Go E4 ~
Ab3 F«4
A3 Ab4
Bb3 Bb4
B3 C5 iiid
C4 D5 fl’

2. Type in the number of notes in the source and destination octaves
and a root pitch for the initial octave.

In the example above, a standard 12-note octave is being mapped
to a 24-note octave. The scale sizes can be any number between
1 and 128. The root pitches can be any note. Notice that the
source octave from C3 to C4 gets mapped to the destination two-
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Transposing All Notes to
a Single Pitch

octave range of D3 to D5. Also notice that the root pitches do not
need to be the same. All other octaves above and below become
mapped in the same fashion as the one you define. If notes in
other octaves get transposed to pitches outside the 128 note MIDI
range, they are substituted with pitches inside the range.

3. If you would like to save the map, type in a name and click Save.

The map will appear in the Custom Maps list.

4. Click OK to execute the transposition.

To map all 128 MIDI notes to a single pitch:

1. Select the Custom Map transpose option.

The Custom Transpose options will appear.

2. Type in 128 in the From: option.

This includes all notes into one, large octave.

3. Type in 1 in the To: option.

This maps all note in the 128-note octave to a single note.

O Interval
O Diatonic
O Key/Scale
® Custom Map

From: 
11281 notes starting at |c3 j

To:
11 | notes starting at |c 11 |

Transpose Map
FROM TO

C3 Cl &
Db3 Cl
D3 C1
Eb3 Cl
E3 Cl
F3 C1
F**3 Cl =
G3 Cl
Ab3 C1
A3 Cl
Bb3 C1
B3 Cl
C4 C1 £

4. Type in or play in a pitch in the To: option.

In the above example, all notes are being mapped to Cl.
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5. If you would like to save the map, type in a name and click Save.

Transposing Each Pitch
to Any Other Pitch

The map will appear in the Custom Maps list.

6. Click OK to execute the transposition.

The Custom Map option can also map each pitch to any other pitch,
completely independently from the same pitch in other octaves. This
allows you to create a transpose map to easily change drum tracks
from one drum machine to another.

To set up a drum machine transpose map:

1. Select the Custom Map transpose option.

The Custom Transpose options will appear.

2. Type in 128 in both the From: and To: options.

Since there is only one source and destination octave, each
change you make in the Transpose Map’s To column will not be
carried through to any other octaves.

O Interval
O Diatonic
O Key/Scale
® Custom Map

From: 
11281 notes starting at |c1 |

To:
11281 notes starting at |ci ]

Transpose Map
FROM TO

C3 C2
Db3 C4
D3 F**3
Eb3 D3
E3 Db3
F3 G2
F**3 Db3 —
G3 Db3
Ab3 F3
A3 Bb2
Bb3 G4
B3 C-1
C4 Bb5 &

3. Pop-edit the pitches in the Transpose Map’s To column.

Notice that each pitch treated individually and does not affect
surrounding pitches or octaves. Notice in the above example that
a same destination pitch, like Db3, can be used more than once,
such as when several pitched tom-tom sounds are being mapped
to a single tom sound.

Transpose 483



4. If you would like to save the map, type in a name and click Save.

Creating a
Custom Scale

The map will appear in the Custom Maps list.

5. Click OK to execute the transposition.

The Custom Scale option allows you to create your own scale. To do
so, you select which pitches are diatonic and which ones are not.

After you create a custom scale, it appears in the list of keys/scales
for the Diatonic and Key/Scale transposition options, allowing you to
transpose diatonically using your own scale and any root pitch.

To create a custom scale:

1. Click the Create Scale button.

The Create Scale dialog box appears.

Create Scale

2. Select the pitches you wish to be diatonic pitches.

You can have as many or as few diatonic notes as you wish. You
can also select the diatonic pitches by playing them on your MIDI
controller. A pitch turns into boldface to indicate that it is diatonic.

3. Click OK to create the scale.
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Your custom scale appears in the key/scale list for the Diatonic or
Key/Scale transpose options.
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Chapter 30 Groove Quantize

Performer’s Groove Quantize feature is powerful, easy to use, and—
from a creative standpoint—one of Performer’s most enjoyable
features.

This chapter tells you how you can do the following:

■ Use the Groove Quantize command to control the
rhythmic depth and “feel” of your music

■ Dynamically adjust the feel of grooves with faders while
applying them

■ Use Groove Quantize to apply the rhythmic feel of a track
to other tracks

■ Create your own grooves, of any length, from any music
you have recorded into Performer or loaded from a
standard MIDI file

■ Build a groove database from which you can instantly call
up any groove you have created

What is a groove? In musical terms, a groove is a unique rhythmic feel. Many artists are
famous for a certain feel—or groove—in their music that makes their
sound unique.

Performer’s powerful Groove Quantize feature gives you complete
reign over this important aspect of your music.

The effect of adding a groove to an otherwise mundane track can be
stunning: the music instantly feels like it has a third dimension, and
the sensation can be similar to that moment when you put on 3-D
glasses in an old 3-D movie. Sometimes, the effect is subtle. Often,
however, you’ll find that a groove completely transforms music,
making it sound totally different from its original form.
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The elements of a
groove

To master grooves, it is important to recognize the musical elements
of a groove. A groove is generated by variations in the timing, accent,
and duration of the notes being played. In Performer, a groove
consists of a combination of the following elements:

□ A quantize grid that affects the timing of notes (attacks
only)

■ A note-on velocity map

■ A note duration map

■ A meter

□ A length (in measures)

□ An overall beat subdivision

For example, a swing groove is usually based on a swung 8th note
beat subdivision. If it’s a hard swing, the eighth-note offbeats may be
played quite late. The durations of the notes in such a groove tend to
be longer, and the velocities emphasize the offbeats. The length of
the groove is usually two bars, and it is often in 4/4 time.

When you apply a groove to some MIDI data in a track, the selected
notes are modified according to these groove parameters.

Applying a
groove ~

To apply an existing groove:

1. Use Performer’s Memory-cycle feature to cycle playback over the
region you wish to apply the groove to.

2. Start playback.

3. Select the data you wish to apply the groove to.

Make sure that what you select is within the region Performer is
currently looping. If you don’t, you won’t be able to audition the
groove before applying it. Use any method of selection that you
prefer. You can select individual notes or an entire region of data.
The groove will be applied at the measure boundaries of the
region you select.
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4. Choose Groove Quantize from the Region menu, or press
command-G.

The Groove Quantize dialog box appears. If you get an error
message instead, then the Grooves folder is not in the same folder
as Performer. If so, switch into the Macintosh Finder and move the
Grooves folder into the same folder as Performer.

5. Open one of the Groove files (or folders) in the list by either double­
clicking its name or by clicking its name once and clicking the
open button.

You now see a list of grooves stored in that groove file.

6. Select the desired groove by clicking its name.

If the Instant Preview button is checked and Performer is playing
back the region you selected, you’ll hear the effect of the groove
right away. You can audition as many grooves as you want
without permanently applying one.
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Instant preview

The Recent Files pop-up
menu

The More Choices
button

Locating a groove

7. If you’d like to adjust the feel of the groove, click the More Choices
button.

This option is discussed further later on in this chapter.

8. To apply the groove, click OK.

When the Instant Preview button in the Groove Quantize dialog box
is checked, you can preview grooves without having to click OK to
apply them. This lets you quickly scan through a list of grooves,
auditioning each one until you find one you like. To apply it, click
OK. When Instant Preview is unchecked, you won’t hear the groove
until after you click OK.

The Recent Files pop-up menu is provided for your convenience. It
lets you go directly into recently opened groove files.

The More Choices button causes several sliders to appear in the
dialog box. A unique and powerful feature, these sliders let you
adjust the degree to which the groove is applied—in essence, they let
you “turn up” or “turn down” the groove. For more information, see
“Adjusting groove parameters when applying a groove” on page 492.

The groove list works like a standard Macintosh open dialog box. Use
it in the standard fashion to locate grooves.

Use this pop-up menu to

navigate through all of the

This pop-up menu lets you go

directly into recently opened
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Renaming grooves

Deleting, moving, and
duplicating grooves

To rename a groove:

1. Select any data or time region.

It doesn't matter what yon select.

2. Choose Groove Quantize from the Region menu.

3. Locate the groove.

4. Option-click its name to pop-edit the name, and press return to
enter the new name.

5. To exit the Groove Quantize dialog box, click either OK or Cancel.

Click Cancel if you don’t want to apply the groove. Click OK if
you do.

Grooves can be cut, copied, and pasted in the Groove Quantize
dialog box. This allows you to delete them, move them from one file
to another, and duplicate them.

Duplicating is useful because you can make a copy of a groove and
then make adjustments to the copy, which preserves the original.

To do any of these operations, you first open the Groove Quantize
dialog box. To do so, select some data or a region and choose
Groove Quantize from the Region menu. Locate the groove, and then
do one of the following desired operations:

Operation: How to do it:

To delete a groove Click it in tire list to select it and
choose Cut from the Edit menu.

To move a groove from one file to Cut it (as described above), open
another another groove file using the pop-up

menu above the list, and the choose
Paste from the Edit menu.

To duplicate a groove Click it to select it and choose Copy
from the Edit menu. Then choose
Paste from the Edit menu. After past­
ing, rename the copy to differentiate
them.
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Where grooves are
stored

Adjusting groove
parameters when
applying a groove

Grooves are stored in Performer groove files. Yon can store as many
grooves as you want in a groove file. You can create as many groove
files as you want. The only requirement is that groove files must be
placed in a folder called "Grooves”, and this folder must be placed in
the same folder as Performer. This is all taken care of for you when
you first install Performer, so unless you have moved the folder, you
don’t need to worry about it.

When you create your own groove files (discussed later), we
recommend that you organize them by category as shown above.
This will make it easier to locate grooves.

Notice that you can further organize your groove files by placing
them in folders (as long as they remain inside the Grooves folder).
You can even place System 7 aliases in the Grooves folder and place
the actual groove files somewhere else on your hard disk.

When you apply a groove, Performer allows you to adjust groove
parameters without permanently altering the groove itself. For
example, you can “turn up” the degree to which velocities are
affected without changing the original velocity map in the groove. To
permanently edit the groove see “Modifying grooves” on page 500.
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To adjust groove parameters while applying a groove:

1. Use Performer’s Memory-cycle feature to cycle playback over the
region you wish to apply the groove to.

2. Start playback.

3. Select the data you wish to apply the groove to.

Make sure that what you select is within the region Performer is
currently looping. If you don’t, you won’t be able to audition the
groove before applying it. Use any method of selection that you
prefer. You can select individual notes or an entire region of data.
The groove will be applied at the measure boundaries of the
region you select.

4. Choose Groove Quantize from the Region menu.

5. Click the More choices button.

Several sliders appear in the Groove Quantize dialog box, along
with several other options.

® Save slider and beat division
settings with groove

O Audition groove with current
settings (but don't save)

10035 76% Off

Beat Division:

DiSSii

2 measures of 4/4

ooue Quantize

Pick a groove to apply :

HU Hip Hop Grooves f | Recent Files " |

® Instant Preview

i_Fewer Choices )

6. Select the groove you wish to apply from the list.
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Fewer Choices button

Using the groove
adjustment sliders

7. Make sure the Instant Preview check box is checked so you get
instant feedback while adjusting the groove.

8. Adjust the groove as desired with the sliders.

These sliders are discussed in the following section.

9. If desired, try different beat divisions by choosing them from the
beat division pop-up menu.

Changing the beat division often has a dramatic effect on the feel
of the groove. This is discussed further in a following section.

10. Once you like the groove, click OK.

The Fewer Choices button in the Groove Quantize dialog box
removes the groove parameter sliders from the Groove Quantize
dialog box to simplify its appearance. Click this button if you do not
wish to adjust the groove with the sliders.

The three groove adjustment sliders give you complete control over
the feel of a groove. They let you dynamically control the degree to
which the timing, note-on velocities, and durations are affected.

'•* When you move a slider, the change occurs when you
let go of the slider (as long as the Instant Preview
check box is checked). No changes occur while you
move the slider.

In essence, these sliders let you control the extent to which you are
applying the original feel of the groove. You can either “turn up” or
“turn down” its effect. We urge you to experiment with them because
they produce interesting effects. The sliders perform as follows:

Groove slider setting:

Off (0%)

Full (100%)

Double (200%)

Result:

Velocities and durations are
unchanged. For timing, a straight grid
quantize is applied.

Applies the exact feeling of the
groove.

Groove feeling is exaggerated by a
factor of 2.
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Saving groove settings
with a groove

Auditioning groove
settings

Using different beat
divisions

You can clearly hear the effect of one slider by setting the other two
sliders to their off position and then trying different strengths on the
remaining slider.

One effective approach with these sliders is to set them all to off (0%)
and then increase each one in small increments. Use the up and
down arrow buttons to make small adjustments. This lets you
gradually apply the groove to a point that sounds best.

The option called Save slider and beat division settings with groove
causes the current slider and beat division settings to be saved with
the groove. In addition, when you first select the groove in the list,
the sliders will jump as necessary to reflect the currently saved slider
settings for that groove.

When this option is selected, slider settings are saved immediately
when you move the slider. If you want to try changing the setting
without losing the saved settings, use the option called Audition
groove with current slider settings (but don’t save), which is discussed
below.

The option called Audition groove with current settings (but don’t
save) lets you adjust the sliders without affecting the settings that are
currently saved with the slider. The same goes for the Beat Division
pop-up menu. In addition, this option lets you quickly audition a
number of different grooves with the same settings (because the
settings won’t change when you select a new groove). For example,
if you like the degree of groove you’ve set with the sliders, but you
aren’t quite satisfied with the type of groove yet, you can try several
other grooves with the same slider settings.

If you’ve auditioned sliders settings and wish to now save them, click
the Save slider settings with groove button.

The beat division pop-up menu lets you choose an underlying
quantize grid for the groove. Divisions range from eighth notes to
32nd notes in both straight and triplet time; several combination grids
are also provided. See “Choosing a beat division" on page 499 for
more information.
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This pop-up menu allows you to try different beat divisions without
losing the original beat division in the groove. For example, you can
try' applying an 8th-note division to a groove with a 16th triplet beat
division. The original beat division is displayed in outline format as
shown below:

J) Eighth Notes

J) 16th Notes

32nd Notes

Eighth Triplets

32nd Triplets

32nd Nonuplets

8th Triplet & 8th

Sth Triplet & 16th

16th Triplet & 16th

Original beat division

Notice that a groove can have more than one original beat division.
and each original beat division can have its own unique settings. This
can be accomplished by editing the groove. See "Adding an
additional default beat division to a groove" on page 502 for more
information.

The beat division pop-up menu is governed by the radio button
options at the top of the window. (See “Saving groove settings with a
groove” on page 495.) One option saves the beat division setting with
the groove. The other lets you audition different grooves with a
certain beat division. For example. If you have a bunch of grooves
that were created in 16th note divisions, but the particular section you
are applying the groove to right now is in triplets, you can set the
beat division menu to triplets, and leave it there as you audition
groove after groove.

The beat subdivision has a dramatic impact on the groove. Try'
experimenting with different choices.

Grooves usually' sound closest to their original feel with the beat
division at which they were created.
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Creating a
groove

The Create Groove command lets you create your own Grooves from
MIDI note data in any track. The source material can come from any
Performer file or any standard MIDI file. Grooves can be any length.

To create a groove:

1. Select the notes (or region of notes) you wish to use as source
material for the groove.

You may select them in the Track list, the Tracks Overview, or any
of Performer’s editing windows. The groove will start at the
beginning of the first measure of your selection, and its length will
be a whole number of measures.

•" When you choose source material for a groove, the
data must be aligned with Performer’s metronome
(main counter). For example, you can't use a rubato
passage, unless you first use the Record Beats feature
to align Performer’s measure and beat boundaries with
the music.

2. Choose Create Groove from the Region menu.

The Create Groove dialog box appears.
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3. Open a groove file in which to save the groove, or create a new
groove file with the New File button.

4. Type in a name for the groove.

5. If desired, change the meter for the groove.

This setting affects the overall length of the groove, and it also
affects how many beats are in each measure. Try to choose a
meter that most closely resembles the beat structure of the groove
you are creating.

6. Choose a default beat division for the groove from the pop-up
menu.

See “Choosing a beat division" on page 499 regarding this option.

7. Click OK to save the groove, or click Cancel to withdraw the
command.

The new groove gets added at the bottom of the groove list.
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Choosing a beat division The choice you make for a beat division when creating a groove is an
important one, for it governs the underlying resolution of the
quantization that occurs when you apply the groove. The choices
range from eighth notes to 32nd notes in both straight and triplet
time; several combination grids are also provided.

As a rule of thumb, when you choose a beat division, think of how
the music is notated, and use the shortest note duration that would
be used to notate it. For example, a swing feel is customarily written
as straight eighth notes. So when you are choosing a beat division for
a swing groove, use a straight eighth note grid.

If the groove style you are defining has both a straight and triplet feel,
use the appropriate combination grid (the straight and triplet options
at the bottom of the menu, as shown below). For example, swung
music often includes straight sixteenths, so you’d choose a triplet
eight/sixteenth combination.

Combination

beat divisions

J) Eighth Notes

16th Notes

Ji 32nd Notes

J) Eighth Triplets

J) 16th Triplets

32nd Triplets

Ji 32nd Nonuplets

Sth Triplet & Sth

Sth Triplet &. 16th

16th Triplet & 16th

Keep in mind, however, that the combination grid has beat divisions
for both straight time and triplet time, so there are more grid points.
If the music you apply the groove to is not rhythmically accurate to
begin with, there is more of a chance that notes will gravitate to the
wrong grid point. For this reason, use discretion when applying
combination grids. In some cases, it might be better to use a non­
combination grid. When in doubt, you can make two versions of the
groove: one with a combination grid and another with a straight or
triplet grid.
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Modifying grooves Performer provides you with the ability to modify' the timing, velocity,
and duration information in the groove itself. Fortunately, you can do
so quickly and easily, without having to switch files.

To modify a groove:

1. Select any data or time region.

It doesn't matter what you select.

2. Choose Groove Quantize from the Region menu.

3. Locate the groove.

4. Click the Edit button.

5. The Groove Editor dialog box appears.
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Information about the currently selected beat division.

Click on the timing, velocity, or duration values to edit

them. Clicking on the word “early" or “late” toggles it.

Groove information

entirely in the window division

6. Edit each beat division as desired.

If Instant Preview is enabled, and you are looping a section to
hear your changes, you’ll hear them right away as you make them.
Here is a summary of what to do in this window.

To do this:

Increase or decrease a velocity

Adjust note placement earlier or
later

Increase or decrease a duration

Do this:

Drag it up or down

Drag the note placement bar to the
left or right

Drag the right side of the duration
icon left or right (0 - 200%)
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Duplicating a groove
before modifying it to
preserve the original

Adding an additional
default beat division to a
groove

Obtaining grooves

7. Click OK to confirm your edits, or click cancel to withdraw the
command.

The groove editor makes permanent changes to the groove (unlike
adjusting the groove sliders, which doesn't affect the groove data
itself). As a result, if you want to modify a groove but preserve the
original, duplicate the groove and then edit the copy. To duplicate a
groove, see “Deleting, moving, and duplicating grooves" on
page 491.

A groove can have several default beat divisions (as shown in the
pop-up menu on page 496). This lets you produce several permanent
variations of the groove within the groove itself. To do so, select a
non-defauit beat division from the beat division pop-up menu in the
Groove Quantize dialog box right before you click the Edit button.
Doing so lets you modify the groove based on the newly selected
beat division. The modifications you make to the groove in the editor
will be unique to that beat division; you won't affect the groove with
its original beat division setting. When you click OK, the beat division
you chose will become outlined, and you’ll be able to freely change
between the two groove variations simply by selecting the outlined
beat divisions in the beat division pop-up menu.

There are many ways to obtain grooves. You cam

■ Use the stock grooves provided with Performer

■ Create new grooves from scratch in Performer

■ “Cop” grooves from any Performer file or standard MIDI
file

■ Purchase commercially available standard MIDI file
libraries and create grooves from the MIDI data in them

■ Purchase commercially available groove libraries

Commercially available MIDI groove libraries are similar to sample
libraries; they have been painstakingly produced in the recording
studio. For example, WC Research, Inc., the producers of DNA™
grooves, have pulled industry legends such as Clyde Stubblefield and
Bernard Purdie into the recording studio specifically for the purpose 
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Cubase grooves

Applying the groove
from one track to
another

of encoding their unique feel. The results are stunning, and we
strongly recommend that you check them out. A folder of sample
DNA grooves is included with Performer.

MIDI grooves are similar to digital sampling in the sense that they
present us with similar copyright issues. If you cop someone’s groove
using Performer’s Create Groove feature, consider handling it in the
same fashion as you would for samples.

Performer can read Cubase groove files if they are placed in
Performer’s Grooves folder. They appear in the Groove Quantize list
with a different icon along with all of your Performer groove files.
They can be used in the same fashion as Performer grooves.

Cubase grooves can be viewed in Performer’s Groove Editor, but they
cannot be edited directly. To edit them, first move them into a
Performer groove file using the Copy and Paste commands in the Edit
menu (see “Deleting, moving, and duplicating grooves" on
page 491).

To apply a groove from one track to another, create a new groove
based on the original track. Once you have created the groove, you
can apply it to any other track you wish using the Groove Quantize
command. The Groove you create can be of any length.
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chapter 31 Custom Control Consoles

Performer’s custom control consoles provide a host of control items,
including:

■ Sliders

■ Knobs

■ Buttons

□ Pop-up menus

Each control item can be used for virtually any musical purpose that
involves MIDI data. For example, a control item can:
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■ Act as a “virtual" MIDI instrument, generating continuous
data which can be sent to synthesizers and recorded into
tracks

■ Remap data, such as velocities into controllers

■ Modify velocities of notes as you play back

■ Generate system exclusive data to modify synth parameters
on the fly

You can build customized control consoles, such as:

■ Mixing consoles with sliders and knobs that control MIDI
volume and pan

□ Patch editing consoles that control and shape the sounds
in your synthesizers.

The sliders, knobs, and buttons can be controlled in real time, while
Performer is playing back or recording, to create musical effects. In
addition, they animate during playback to reflect what you have
recorded.

Basics Custom Control items serve two functions. First, they monitor MIDI
data being played from their target track or MIDI channel, animating
in real time to reflect the data’s current value. For example, let’s say
you have a track containing a stream of controller #7 (volume) data,
and the controllers increase in value (in the range from zero to 127),
making a crescendo. A control item assigned to monitor controller #7
in the track will move as the track is played back, reflecting the
changes in the values of the controller.

Secondly, control items generate new continuous MIDI controller data
in real time when you take control of them, and send the data to
either a FreeMIDI device or track. When you take control of a control
item, the new data that it generates overrides the data already in the
track.

To demonstrate this, let’s return to the volume example above with
the crescendo in the track. If you play back the track and grab the
control item with the mouse half way through the crescendo, you will
take over the volume of the track with the control item. The
crescendo still exists in the track, but it does not get played as long
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Creating a
Custom Console

Creating a MIDI Volume
and Pan Control
Console

as you are gripping the control item with the mouse. If you release
the control item, it will immediately begin monitoring the existing
data in the track again.

In summary, control items monitor continuous data being played
back from their target track or MIDI channel. Grabbing a control item
generates new data which overrides the data in its target track. The
new data does not modify the track; it only temporarily overrides the
continuous data in the track.

Custom controls are created and displayed in custom console
windows. You can create as many custom console windows as you
like. They save, close, and open like other Performer windows.

You can create control consoles automatically or by hand.

For basic MIDI controls, such as volume sliders, pan knobs, mod
wheel sliders, and pitch bend sliders, you can create them
automatically using the Create Console command in the Tracks
window.

To quickly create a control console with sliders and knobs for MIDI
volume and pan in the Tracks window:

1. Highlight the Track(s) for which you wish to make a console.

Click each track name to highlight it. Shift-click to select tracks not
next to one another.

2. Choose Create Console from the Tracks window mini-menu.

The Create Console dialog box appears.

Custom Control Consoles 507



iDrkuQ1? iLTOj&QOg

Create console for Seq-1

Size: Orientation:
® small ® horizontal
O large O vertical

0 Volume |7 |
® Pan 110 |
□ Modulation wheel 11 ~ |

□ Pitch bend
□ Other...

Name: | |

Controller: | |

Source:
® MIDI Source: 01 /W

O Track: Track-1

Source data type for sliders:
O “ Pitch bend O J‘ Notes
O ± Mono pressure O i Velocities
® A Controller] 1 ]

| OK j | Cancel

3. Select the dimensions of the sliders you will create in the console.

Pan control items are created as knobs. All of the other types of
items are created as sliders. The slider dimensions you choose can
be modified after the console is created.

4. Select the type of control items you want to create for each track
that you have selected.

The Other option allows you to choose a controller of your choice
and name it. If you select multiple items, they are placed together
in the same console. If you would like each type of item to be in
a separate console, select one type at a time and repeat this entire
procedure for each type. For example, if you want volume sliders
in one console, and pan sliders in a different console, choose only
volume, click OK and then repeat the procedure for pan.

5. If desired, choose a source for the control items.

The most common form of a source is an external MIDI controller.
such as the mod wheel or pitch bend wheel on your controller
keyboard. This allows you to move the slider or knob with your
mod wheel. If you do not need to do this, leave the source option
settings as they are.
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I~r’ Note that the control item doesn't not require a source
data type to record data and animate during playback!
Instead, it records and monitors the target data
(volume, pan, etc.) that you have selected.

6. If necessary, choose the source data type.

7. Click OK to create the console.

Building a
Custom Console

Quick Reference

Clicking OK creates the console and adds the Console’s name to
the Windows menu. The console that you created will appear in
the center of the screen.

If you would like to create your own customized console, you can
open a new, blank custom console. To do so, click the Custom
Consoles button in the Consolidated Controls panel.

Custom consoles button
creates a new, empty console

in which you can build controls.

A new, empty console window appears. It has a title bar, close box,
push down box, mini-menu and grow box like a standard Performer
window. Drag the title bar to move it. Click the close box to close it.
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Edit Mode button
Insert button—i —Snapshot button

r r

Insert button: inserts a slider, knob, button, or other control item.

Edit Mode button: Toggles between two modes in the console. When
Edit Mode is on (the button is highlighted), console items can be
moved, resized, deleted, and otherwise graphically manipulated.
When Edit mode is off, control items cannot be moved; instead,
sliders slide, knobs turn, buttons push, and so on.

Snapshot button: takes a snapshot of the current knob, slider, and
other control settings and records the current setting in the track at
the current counter location. This can be done while Performer is
stopped or playing back.

Control Items area: this is the area where you create and position the
knobs, sliders, buttons, etc.

Resize button: resizes the window.
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Mini-menu Quick
Reference

Set Console Name: Provides a dialog box in which you can change the
name that displays in the title bar of the console and in the Windows
menu.

Duplicate: Makes a copy of selected control items.

Snap to Grid: Toggles whether or not control items snap to an invisible
grid in the console when they are moved or resized. When checked,
Grid Snap is on. When not checked, Grid Snap is off.

Set Grid Spacing: determines the resolution of the snap grid when
snapping is turned on. The resolution is measured in screen pixels,
which are approximately 72 dots per inch (dpi).

Align controls: Lines up selected controls to one another in a
configuration that you choose. For example, you can line up the
centers of several control items by selecting them and choosing this
command.

Background pattern: Allows you to fill the control item area with a
standard Macintosh background pattern similar to the fill patterns
found in paint programs. Sliders, knobs, and buttons appear
superimposed on top of the background pattern.

Goto Zero: Sets the value of the highlighted control item(s) to zero.

Goto Null Point: Sets the value of a highlighted master control item to
its null point.

Auto Punch-In: A special record mode for control items which causes
them to record data into their target track only when the control item
is moved, either with the mouse or an external source.

Set Punch-Out: Opens the Set Punch-Out dialog box, which allows you
to adjust the delay before punch-out when you are in Auto Punch-In
mode and are controlling a control item from an external MIDI
source. The Punch-Out time is the amount of time (in tenths of a
second) between when the last event is received by a control item
from its external source and the time at which the control item drops
out of Record.
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Group: Opens the Grouping dialog box for the highlighted control
items. This command allows you to assign control items to a group
all at once rather than one at a time.

Ungroup: Removes the highlighted control items from their assigned
group.

Control Assignment: Opens the Control Assignment dialog box for the
currently selected control item in the console. This dialog contains all
of the settings for how the control item behaves.

Name item: Lets you type in a name for a currently selected control
item.

Delete Control: Removes the currently selected control item(s) from
the console.

Delete Console: removes the console from the screen and removes its
name from the windows menu.

Creating a Slider, Knob,
or Button

To create a control item:

1. (Optional) Select the Snap to Grid menu item to turn the snap grid
on or off.

This causes the control item to snap to an invisible grid in the
console window when you create it, which can be useful for
lining up multiple buttons and sliders.

1. Press the insert button in the title bar.

2. Choose the item you would like to insert.

The cursors turns into a cross-hair.

3. Drag across a blank portion of the console window.

As you drag, the item appears. You can choose any length or size
that you like. You can also resize the item at any time.
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4. When you release the mouse, the control Assignment dialog box
appears.

Assignment for Volume slider
Source

® MIDI: K2000

O Track: Track-1

Target

® MIDI: Morpheus-1

O Track: Track-1

Receive: Controller x-1

Cont. **| 1 | Modulation v/heel v |

Send: Controller

Cont. **|l7/ l| Volume

Minimum time change: |0 | ticks

Minimum value change: |O j

Minimum value: |o ~|

Maximum value: 1127 ]

Name:___________
[unnamed Slider^

Polarity :

® Positive
O Negative

Groups:
O Master Fl
® Slave □‘•A’2*

Relation to master:
O Match
O Offset . rri^Tlaz
~ , by 1100 F
® Scale --------

Type:
Slider

| Cancel |

5. (Optional) Choose a source data type for the control item.

See “Making the Source Assignment" on page 516 for more
information.
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6. Choose the Target data type for the control item.

See “Making the Target Assignment” on page 515 for more
information.

7. (Optional) Set the minimum and maximum time change.

These two options (on the left) control the density of the data that
the control item generates. The lower the values, the more dense
the data. Higher values thin out the data. Try to use as high a value
as you can while still maintaining the musical effect you wish to
achieve. If you use values that are too high, and the data is too
thinly generated, it may not sound good.

8. Choose the minimum and maximum values for the control item.

These are the absolute lowest and highest values that the control
item can have. For controllers, the maximum range is 0 to 127. For
pitch bend, the range is -8192 to +8191.

9. (Optional) Assign the control item to a group.

See “Grouping Control Items” on page 533 for more information.

lO.Type in a name for the control item.

11. If desired, change the type of item (slider, knob, button) by
choosing a different item type from the Type pop-up menu.

12. When you have set all of the parameters as desired, click OK.

The control item appears in the console. Notice that it has a box
around it. You can click the handle in the lower left of the box to
further reshape the item.
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Making the Target
Assignment

The target assignment is made in the Control Assignment dialog box
when you first create the slider, knob or button as shown in the
previous section. The target can changed at any time by double­
clicking the control item.

The target assignment consists of two things: the type of MIDI data
and the target, which is place where the data will be sent.

The target data type is the specific type of MIDI data that the control
item will send and monitor. A control item only monitors one track
and one data type at a time.

Sliders, knobs, and buttons in Performer can control just about any
type of MIDI data, including:
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■ Continuous controllers

Making the Source
Assignment

□ Switch controllers (either as switch controllers or as
continuous controllers)

■ System exclusive messages

■ Notes and velocities

For velocities, the slider or knob modifies the velocities of notes in
the target track as they play.

The Target is the place where the data will be sent by the slider, knob
or button. The target can be:

■ A track

■ A FreeMIDI device

When the target is a track, the data from the control item is sent to the
track, which then records and plays the data. In turn, the control item
monitors the material it recorded in the track, animating as it does so.
However, the control item only records into that one track in that one
sequence; it cannot control another track in another sequence, unless
you reassign it.

When the target is a FreeMIDI device, the data from the control item is
sent to the track in the current sequence which is assigned to that
device. This is the most flexible of the target assignments because it
doesn’t matter what sequence is playing at the time. As long as one
of its tracks is assigned to the device, the control item data will be
recorded and monitored in the track.

The source assignment is made in the Control Assignment dialog box
when you first create the slider, knob or button as described in
“Creating a Slider, Knob, or Button” on page 512. The source can
changed at any time by double-clicking the control item.

What is a source for the slider or knob? It is a device other than the
mouse which you can use to control the slider or knob. Normally,
you change the value of a slider or knob by dragging it with the
mouse. At times, however, it might be useful to move it from an
external controller, such as the modulation wheel or data entry slider 
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on your MIDI keyboard controller. To do so, set the Source
assignment to match the incoming MIDI channel and data type for
the controller you wish to use.

The source assignment consists of two things: a type of MIDI data and
the MIDI channel or track from which the data is being generated.

Changing the Source or
Target

Assignment for Volume slider
Source

©MIDI: K20G0 vj

O Track: Track-1 v|

Receive: Controller v|

Cont. **| 1 | Modulation wheel -r-1 |

Notice that the slider or knob can be controlled by notes, velocities,
pitch bend, controllers, or even mono pressure.

Set the MIDI channel to match the transmit channel of the controller,
pitch bend wheel, or whatever you are using.

Notice that the source can also be a track. Source data in the track
then controls the slider. This allows you to create interesting effects.
For example, you can assign the source of a slider to be the velocities
of notes in track 3. You can then assign the target to be controller
number 7 (volume) and assign it to the synth playing back the notes
in track three. When you play the track, the slider reads the velocities
and sends out a volume controllers to match the velocities, thus
enhancing the volume change effect from the velocities.

To change the source or target assignment:

1. Be sure the Edit mode button in the title bar of the console window
is unhighlighted (turned off).

2. Click the knob or slider to select it.

3. Choose Control Assignment from the mini-menu.

As a shortcut, double-click the control item.
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Adding Arrows to a
Slider or Knob

4. Set the source or target assignments as needed.

5. Click OK.

To connect a scroll arrow to a slider:

1. (Optional) Select “Snap to Grid” from the Console window
mini-menu to check it.

Doing so causes the arrow to be lined up with the slider or knob.
Otherwise, you may need to manually adjust the position of the
arrow to line it up with the slider. The arrow doesn’t have to be
lined up, however; it will control the slider no matter where you
place it.

2. Insert the slider or knob.

To do so, press the insert button, choose slider (or knob), and
drag out the slider. The Control Assignment dialog appears. Select
the desired settings and click OK.

3. Press the insert button again and choose “Arrow” from the menu.

Once you have chosen to insert an arrow, the cursor turns into a
cross-hair.

4. Click directly on top of the slider and drag in the direction to which
the arrow should point.

Don’t worry about the exact placement of the arrow yet. You can
take care of that after you have inserted it. Drag up or to the right
to create an increment button; drag down or to the left to create a
decrement button. Control the size of the arrow with the size of
the box that you drag out. Below, an increment arrow is being
inserted by dragging to the right. Notice that the cross-hair was
initially clicked on top of the slider.
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When adding arrows to a slider, click on top of the slider and drag

in the direction that the arrow should point.

Once inserted, you can adjust the size and placement by

dragging the arrow and its size handle. Use the Align

command in the mini-menu to quickly line things up.

Adding a Value Box to a
Slider, Knob, or Button

5. Adjust the size and placement of the arrow as needed.

Use the Align command in the mini-menu to automatically align
the arrow with the slider.

6. To use the arrow, click the edit button in the console title bar to
unhighlight it and click the arrow button.

A value box displays the current value of the slider, knob, or button,
and it will update continuously as you move the slider or knob.

If you want, you can add a value box to a button. However, buttons
can only send up to two values, so a value box might not be useful
since it will only display two different values. (On the other hand,
you might have a situation in which it would be useful, so that's why
we mentioned it.)
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To add a value box:

1. (Optional) Select “Snap to Grid” from the Console window
mini-menu to check it.

Doing so causes the value box to be lined up with the slider or
knob. Otherwise, you may need to manually adjust the position of
the value box to line it up with the slider. The value box doesn’t
have to be lined up, however; it will be connected to the slider no
matter where you place it.

1. Insert the slider, knob, or button.

To do so, press the insert button, choose slider, and drag out the
slider. The Control Assignment dialog appears. Select the desired
settings and click OK.

2. Press the Insert button again and choose “Value Box” from the
pop-up list.

3. Click on top of the item to which you wish to add the value box, and
drag diagonally to create the value box.

Click on top of the

knob or slider and

drag out a box for the

appropriate size.

Once inserted,

you can adjust the

size and place­

ment.

I~S1

If grid snapping is enabled,

click in the corner to line up

the value box with the knob

or slider.

Using Value Boxes You can enter a value into a value box just like Performer’s main
counter. To change the value inside an edit box:

1. Click inside the value box.

The numbers inside become highlighted.
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2. Type the desired value.

Use the arrow keys if necessary.

3. Press return to confirm your choice.

Labelling a Slider, Knob,
or Button

Often you will want to label the sliders, knobs, and buttons that you
create. If you didn’t set the name when you first created the control
item, set it as follows:

1. Click the border of the control item to select it.

Alternately, you can shift-click anywhere on the control item to
select it.

2. Choose “Name Item” from the mini-menu.

3. Type in the desired name.

4. Click OK to confirm your choice.

To add a label to the control item:

1. Press the insert button and choose “Label” from the menu.

2. Click directly on top of the control item.

The label appears.

3. If necessary, drag the label to the desired position.

You can do so with grid snapping enabled or disabled.

Changing a Label To change the text of a label:

1. Click the label to select it, or click the border of the control item.

2. Choose “Name Item” from the mini-menu.

3. Type in the new name and click OK.

Note: as a shortcut, you can option-click the label.

Creating a Button Buttons send one MIDI message at a time. For example, a button
might send a patch change to a synth or a MIDI patcher.
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To create a button:

1. Press the insert button and choose “Button” or “Text Button” from
the menu.

A text button displays its label inside the button.

2. Drag the cross-hair across the console to insert the button.

The Control Assignment dialog box appears.

3. Set the Source and Target items as desired.

See “Making the Target Assignment” on page 515 and “Making the
Source Assignment” on page 516.

4. Select the type of button you wish it to be.

There are three types of buttons:

Single-state Two-state On/off

■ Single state button: sends a single message only.

■ Two-state button: toggles between two messages, sending
the first when it is pressed and the second when it is
released. For example, you might want to create a
temporary mute button that mutes the track only while you
are holding down the button. If you choose this type of
button, you have two values to enter to the right of the
option.

■ On/off button: toggles between two messages, sending the
first when it is pressed and the second when it is pressed
again, and so on. For example, the button might toggle
between a volume controller of zero and 127 to mute and
unmute a track. If you choose this type of button, you have
two values to enter to the right of the option.
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5. If you want the button to act like a mute button, click the “M” next
to off value button as shown below.

When this setting is enabled, the button sends the current value of
its target controller type at the time the button is unmuted, instead
of sending a specific maximum value. This makes a button
assigned to controller #7 (volume) act just like a real mute button
by returning the track to the current volume at the moment it is
unmuted.

Values: |o | £of)

[m] (unmute) ^0FF
Figure 31-1

Selecting Control Items

Cutting, Copying, and
Pasting Console
Controls

6. If desired, choose a group for the button.

Buttons can be grouped, either by a master button or even by a
slider or knob.

7. If desired, type in a name for the button.

If it is a text button, the name will be displayed inside the button.

8. Click OK.

Shift-click anywhere on a control item to select it. You can also use
shift-clicking to select multiple items.

To select a group of items, drag a selection box over them.

To select all the items in the console, choose Select All from the Edit
menu, or press command-A.

Console controls can be cut, copied, and pasted. This greatly
facilitates the process of building a custom control console. For
example, if you are creating a number of items that are similar, make
one first and then copy and paste it as many times as needed. Then
make the necessary minor adjustments to each copy.

Custom Control Consoles 523



To cut or copy a control item:

Aligning Control Items

1. Select the desired item(s).

Note that you can select more than one at a time. For information
about selecting control items, see “Selecting Control Items" on
page 523.

2. Choose Cut or Copy from the Edit menu.

To paste a control item after cutting or copying, choose Paste from
the Edit menu.

There is an Align Controls command in the Console mini-menu to
help align selected console controls.

To use this command:

1. Select the items to be aligned.

2. Choose Align Controls from the console mini-menu.

The Align Controls dialog appears.
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Nudging Control Items

3. Choose the desired options.

In this example, we are aligning the centers of the objects left-to-
right.

4. Click OK.

Selected control items can be nudged using the arrow keys. Be sure
that the item you want to nudge is selected. (You can nudge several
at once, too.) Also make sure that the Edit Mode button in the title bar
of the console is highlighted as shown below. Items are nudged one
screen pixel each time you press an arrow key.
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Edit Mode button

y/|s|

Moving or Removing
Control Items

Duplicating a Control
Item

Changing the
Parameters of a Control
Item

Moving or Resizing a
Control Item

Setting a Background
Pattern for the Console

Once you have selected control items as described in the previous
section, you can drag them anywhere in the console window. You
can also remove them from the console by hitting the delete key or
by choosing Erase from the Edit menu.

To duplicate a control item:

1. Select the control item.

See “Selecting Control Items” on page 523.

2. Choose “Duplicate” from the Console mini-menu.

To change the source, target, grouping, and other parameters for a
control item, double-click it. The Control Assignment dialog box
appears. Change what you wish and then click OK.

To move or resize a control item, you need to be in edit mode. To
enter edit mode, click the Edit Mode button in the title bar so that it
becomes highlighted. When you are in edit mode, you can only edit
control items. You cannot use them, i.e. you cannot slide a slider, turn
a knob, press a button, etc. To use the control items again,
unhighlight the edit mode button.

As a shortcut, you can enter edit mode temporarily by holding down
the command key (instead of clicking the edit button) as you click
the control item. Doing so allows you to move it or resize it without
clicking the Edit Mode button in the title bar.

The Background Pattern command in the Console window
mini-menu opens a dialog from which you can choose a foreground
and background pattern for the console. Click the pattern you wish
for each, and the sliders, knobs, and buttons in the console will be
superimposed on top of that pattern.
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You can use this feature to visually differentiate different types of
consoles. For example, you could give your volume consoles a
different background pattern from your effects consoles.

Controlling
Knobs and
Sliders

Controlling a Slider or
Knob with the Mouse

The following sections explain how to control sliders and knobs.

Try moving the slider with the following mouse actions to familiarize
yourself with them.

Drag the handles to

change the slider’s

value smoothly.

Click anywhere on the bar to snap

the slider to that position.

Click the +/- buttons to 

move the slider by one.

Press the +/- buttons to

move the slider smoothly.

Pop-edit the slider

value directly.

To move a knob, simply click on it and drag horizontally or vertically.
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Controlling a Knob or
Slider with a Mod or
Pitch Bend Wheel

Once you have made the source assignment as described in “Making
the Source Assignment” on page 516, click the slider or knob name
to highlight it and move the mod wheel. You will see the slider
respond as you move the wheel.

Remember, the slider or knob must be selected for
external control to work.

When a slider or knob is being controlled externally, data from the
external source is exclusive to the slider; that is, the data is used
solely to control the slider and will not be accidentally recorded into
another track.

Remapping Data on the
Fly

External control is a very powerful feature because it allows you to
reassign continuous data in real time as you move the controller. For
example, a volume slider that is being controlled by a mod wheel is
actually receiving controller #1 data from the wheel and then
converting it into controller #7 data on-the-fly.

Performer also allows you to control sliders with several types of data
that you might not consider at first: notes, velocities, and aftertouch.

Moving a Slider or Knob
During Playback

To move the slider during playback, simply press the play button and
move the slider with the mouse or mod wheel, while the scale is
playing back. Notice that the volume changes as you move the slider.

Controlling a Slider or
Knob with Notes

MIDI notes are numbered from 0 to 127. C3 is note number 60, for
example. Note numbers correspond exactly to controller numbers, so
pressing a note on your keyboard will set the slider to its
corresponding value. This is useful for creating sudden, precise
changes in controller value rather than smooth changes. Keep in
mind while you do this that most keyboards do not have 127 keys
and therefore will not allow you to span the entire zero to 127 range
of the slider.

Controlling a Slider or
Knob with Velocity and
Aftertouch

Note velocities can also be used to control the slider, since they also
span the range from zero to 127. The harder you strike a key, the
higher (or lower) the slider will go. This might be useful for setting
up a slider to send a controller that, in turn, affects a synth in a certain
way: as you strike the key harder, the musical effect will become
stronger (or weaker).
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Recording a
Knob, Slider, or
Button

Record-enabling an
empty track

The same applies to aftertouch data. The harder you press on the
key, the higher (or lower) the control item will go.

Once a control item’s target and source parameters have been set up,
you can record data generated by it into its target track. Recording
with custom controls is specially designed so that the data from the
control item will not erase data that already exists in the track.
Instead, data generated by a knob, slider, or button is merged with
existing data. For example, you can record a crescendo (in the form
of controller #7 data) from the control item without erasing any of the
notes in the track.

On the other hand, data from the control item replaces any existing
data of the same type. If a track already contains controller #7 data
from measure 1 to measure 10, and you record briefly with the slider
in measure 5, the new data recorded from the slider will replace the
existing controller #7 data in measure 5.

With this in mind, sliders, knobs and buttons can be recorded in one
of three ways:

■ You can record a single “snapshot” of the current setting of
all the sliders and buttons in a console. To do so, set up the
console the way you wish, set the Main Counter to the
desired location, and then click the Snapshot button in the
title bar of the console. Or, click the Snapshot button
during playback or recording. For more information, see
“Taking a Snapshot of a Console” on page 532.

■ You can record without Punch-in mode (unchecked in the
console window mini-menu), which causes the slider or
knob to record continuously, even when you are not
moving the slider, so that it continually replaces its own
data type in the track.

■ You can record with Punch-in mode, which causes the
slider or knob to only record when you move it. Punch-in
mode is enabled by default.

When recording console controls, a track has to be record-enabled.
Note, however, that you do not need to record-enable the track
whose fader you want to record.
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Enabling Auto Punch-In
Mode

Punch-in Recording
Using an External
Control

To avoid accidentally erase notes and other data when recording
faders, do one of the following:

□ Record-enable an empty track

OR

■ Record-enable any track and turn on Overdub Record
mode

To enable Auto Punch-In mode, select it from the mini-menu. A
check appears next to it indicating that it is activated.

To record data when punching in, press the Record button in the
Consolidated Controls panel and move the control item. When the
control item moves, data in the track of the same type as what the
control item is sending will be replaced by the new control item data,
just like normal control item recording. When you release the control
item, recording will stop and it will return to monitoring the track.

Moving the control item from an external control while punching in
works much the same way: to punch in, the control item waits to
receive an event from its external controller. When it does, it punches
in. Punch out, however, is done automatically by Performer and is
determined by the amount of time after the last event was received
from the controller.

Since controllers send data with different degrees of sensitivity, you
may find that punch out occurs too frequently. To avoid stuttering
punch out, you can lengthen the delay before Performer punches out
with the Set Punch Out command in the console window mini-menu.
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The Set Punch Out dialog box allows you to determine the punch out
delay in tenths of a second. Usually, values between 5 and 15 work
well.

Summary Here are several situations and a description of what control items
will do in each case:

Performer is not playing or recording: When the current location of the
sequence is changed with the Controls or Counter Window, all
control items jump to the value of their assigned parameter on their
assigned track. They may then be moved; as they move they send out
MIDI data of the assigned data type on the channel(s) of their
assigned track.

Performer is playing back: As Performer plays, the control items
animate to reflect the values of their target data type from their target.
A control item may be grabbed and moved independently, either by
simply grabbing the handle or by' external control; it then transmits
MIDI data that takes the place of out-going data from its source track.
The data it generates does not get recorded. When the control item is
released, it returns to tracking the target track.

Performer is recording: When Performer is recording, a control item is
either in or out of Punch-in mode. Here is what happens in each
condition:

n With Punch-in mode, the control item simply' monitors its
target, just like playback. When you move it with the
mouse, it records your movement. Data in the target track
is replaced by data generated by the control item. (Only
data of the same type is replaced). When the control item
handle is released, the control item starts tracking the
target track again.

■ Without Punch-in mode, a MIDI event corresponding to the
current position of the control item is inserted into the
target track(s). As recording continues, old data is either
erased or replaced by new data of the same type generated
by control item motions. Only' data of the type assigned to
the control item is affected. For example, recording a pitch
bend control item would replace any' existing pitch bend
data with new data; notes, controller data, etc. would be
unaffected.
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Taking a
Snapshot of a
Console

V jj 'T

Editing a snapshot

Animation
During Playback

Once you have created your custom console, you can take a
snapshot of it. A snapshot captures all of the current slider and knob
settings. The snapshot is placed into the tracks of the currently play-
enabled sequence.

If you would like to record the snapshot, the target assignment of the
sliders and knobs must be either a track or a device (instead of a
MIDI channel).

To take a snapshot of the current position of the sliders, knobs, and
buttons in a console:

1. Set the main counter to the desired location at which you wish to
record the snapshot.

You can also take the snapshot during playback or recording.

2. Set up the sliders, knobs and other control items the way you
would like them to be in the snapshot.

3. Select the control items in the console that you want to include in
the snapshot.

See “Selecting Control Items” above.

4. Click the Snapshot button in the title bar.

When you click the snapshot button, each control item generates
a MIDI event at that instant. The value of the event, such as the
level of a volume controller, is determined by the control item’s
position at the time the snapshot is taken. The event is inserted
into the control item’s target track. If you have taken the snapshot
of many sliders, knobs, etc., each item places its data into its own
target track.

Once data has been inserted into one or more tracks by taking a
snapshot, the data can be edited in the standard fashion in the
track(s). For example, if you wanted to remove the snapshot, select
the data in the tracks window and delete it.

Unless the control item is being dragged, it monitors its target track,
animating during playback to reflect MIDI data that it has recorded
into the track.
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Using
Controllers
Above 63

Grouping
Control Items

Master and Slave control
items

In general, the control item always reflects the current value of its
target data type, even when cueing the sequence to a different
playback location. For example, press the rewind button of the
sequence. The volume control item will snap to zero. Now, type in
measure 5 into the Counter window and press the return key. This
sets the current playback position at measure 5. When you do so, the
volume control item will snap to whatever the value of controller *7
is at measure 5.

Only controllers 0 to 63 are considered to be “continuous” MIDI
controllers—ones that can express any value between 0 and 127.
Controllers 64 to 120 are defined by the MIDI specification as
“switch" controllers—ones that are either on or off. Controllers 121 to
127 are reserved for special purposes.

Some MIDI hardware, however, treats controllers 64 to 120 as
continuous controllers. Performer’s control items can generate any
controller from 0 to 120 as continuous data, providing you with
maximum flexibility with MIDI devices that treat controllers 64 to 120
as continuous controllers.

Performer’s custom consoles provide the ability to group control
items together and control them from a master control item.
Grouping allows you to control an entire bank of controls at the same
time from one control item. Up to 32 control items can be assigned to
a single group, and Performer allows up to 26 groups, identified by a
letter from A to Z. Any control item can be a master control item or a
grouped control item.

In addition, a master control item that controls a group can, in turn,
be a member of another group controlled by another master. This
allows you to create sub-groups of control items, and sub-groups
within sub-groups. There is no limit to the number of layers you can
create.

Each control item in the group can have its own, customized relation
to the group’s master control item. Grouping provides three ways in
which a control item (slave) responds to its group master: the
grouped control item can match, offset, or scale values received from
the master.
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Polarity

When matching the master, the slave simply goes to the same value as
the master. For example, if the master control item is set to 79, the
slave goes to 79 as well.

When offsetting the master, the slave can start at a different value than
the master. When the master moves, the slave moves by the same
amount, or by a percentage of the amount. For example, let’s say that
the master is at 0, the slave is at 20, and the slave is offsetting by
100%. If you move the master to 50, the slave will move to 70. If the
slave is offsetting by 50%, it will only move to 45, which is 20 plus
half of 50 (25).

When scaling the master, the slave can start at a different value than
the master. When the master moves, the slave moves by a percentage
of the distance that the master moves in its relation to the end of the
control item. For example, lets say that the master is at 0. the slave is
at 64, and the slave is scaling by 100%. When the master moves to 64,
which is half way to the top, the slave moves to 96. which is halfway
of its distance to the top. If the master goes to 96, which is 3/4ths of
its distance to the top, the slave goes to 112, which is 3/4ths of its
distance to the top. By the time the master has reached 127, so has
the slave.

Slaves can be offset or scaled by a percentage between 0 and 999%.

In addition to matching, offsetting, and scaling, a slave can react
positively or negatively to its master. Positive polarity causes the
control item to move in the same direction as its master. Negative
polarity causes the control item to move in the opposite direction
from its master.

Negative polarity is extremely useful for many musical effects, such as
cross-fading or panning. You can bring the volume of one track up at
the same time as you bring the volume of another track down.
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End Part I

Begin Part II

Null Points

Begin Part II

End Part I

In this example, “End Part I” is the master and is being faded down
from right to left. As it does, “Begin Part II” fades up from left to right.

In the grouping offset and scaling examples above, you may have
noticed that an important part of how masters and slaves work is their
initial values. In Performer, the master’s initial value is called the null
point and the slave’s initial value is called its reference value.

A master’s null point is the value of the master slider on which
changes to slaves are based. It is indicated on a slider as a bold hash
mark behind the slider bar.

The slave’s reference value is its value when the master is at its null
point. Whenever you would like to see the reference value of a slave,
move its master to its null point.

Null point
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Moving Slaves
Independently of Their
Master

Assigning a Control Item
to a Group

The slave responds to changes in the master slider's value, which are
measured from the master slider's null point, and it moves from its
reference point based on those changes. As the master moves from
its null point, the slave moves from its reference value.

Performer’s null point is similar to the null point on most recording
studio mixing consoles: it is a base value from which slaved sliders
are measured.

Hardware mixers usually have a fixed null point somewhere near the
middle of the slider’s range. The null point of Performer’s sliders,
however, can be set to any value on the slider, from zero to 127 (or
-8192 to 8191). This provides an added level of flexibility when
achieving the musical effects that you want.

Slaves always follow their master. However, a slave is not "locked" by
the master; it can be moved independently at any time, regardless of
the master’s current value (position). When you move a slave, you
are changing its reference point with respect to the master. In
addition, its relation to the master is temporarily severed. The only
way to reestablish the connection is to move the master, or reset the
master to its current value.

If you move both a master and a slave at the same time from the same
external source, you will sever the master/slave connection between
them and the slave will track the external source as if it was not
connected to the master.

To assign a control item to a group:

1. Select one or more control items.

2. Choose Group from the console window mini-menu.

The Grouping dialog box will appear.
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Grouping Information for Multiple controls

Group :[ai~| Polarity: ®Posrtive
O Negative

Relation to master:
O Match
O Offset
© Scale

Offset/Scale by 11QO |

Cancel

3. Type the group letter to which you want to assign the control item.

The only restriction here is that a control item cannot be the
member of a group if it is already the master of that group. Up to
32 control items can be included in one group.

4. Select the polarity.

5. Choose whether to match, offset, or scale from the master.

If you want the grouped control items to reach their highest and
lowest value at the same time as the master, choose scale at 100%,
which is perhaps the most intuitive way to group control items.

6. Click OK to confirm your choice or Cancel to withdraw it.

Assigning a Master
Control Item

To assign a master control item:

1. Unhighlight the Edit Mode button in the console title bar and select
the control item.

2. Choose Control Assignment from the mini-menu.

3. Type a letter in the Group text box.

You can enter any single letter. The only restriction is that the
control item cannot be a master of its own group.

4. Choose the Master option.

5. Click OK.
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Setting a Master Slider’s
Null Point

To change the mill point of a master slider:

1. Option-click anywhere on the slider.

The null point, which is indicated by a bold hash mark, will snap
to the location, and you can drag it freely from there.

The null point can also be changed more precisely as follows:

1. Select the master slider.

2. Choose Control Assignment from the console mini-menu.

3. Make sure the Master radio button option is selected.

4. Type in the desired null point in the box provided.

5. Click OK to confirm your choice or cancel to withdraw the
command.

Setting a Slave’s
Reference Value

To change the reference value of a slave, move the master back to its
null point, and then move the slave to the desired value. It is not
mandatory to move the master to its null point beforehand, but if you
do not, the value you are setting is the actual reference value and
does not reflect the current difference between the master and its null
point. As soon as you move the master again, reestablishing the
master/slave connection, the slave will pop to its new relative
position, often causing an unexpected result.

Moving a Master to its
Null Point

To move a master to its null point, either drag the master’s handle to
the bold hash mark, or highlight the slider and choose Goto Null
Point from the Slider window or Console mini-menu.

Sending Multiple MIDI
Messages At Once With
Grouped Buttons

You can group buttons to a master button to send various messages
to various destinations all at once. Just assign each button to the same
group. Make sure each button is of the same type. Then create a
master button that is also the same type. When you press the master
button, the slaved buttons will be pressed and released at the same
time.

•* Please note: if you group buttons, the slaved buttons
do not animate when you click the master button.
They do, however, transmit data.
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Generating
Sysex with a
Slider or Knob

Performer allows you to generate system exclusive data from a slider
or knob. The slider generates a continuous stream of messages, each
containing a range of bytes (up to four) that are changed
incrementally by the slider or knob.

Doing so allows you to control device-specific parameters of MIDI
hardware in ways that can not be achieved with continuous
controller data.

Please note! This section is not for the technically faint
of heart. You should have a firm knowledge of MIDI,
and you should be familiar with your hardware’s MIDI
implementation.

Before you begin this procedure, here’s what you need to know
about the sysex message:

h The message itself, or how to dump it into Performer

■ Whether or not the message contains a checksum, and if
so, how many bytes the checksum consists of

□ What the data bit format is (7-bit or 4-bit nibble)

■ Which comes first, the LSB or the MSB

■ The specific bytes within the message that will be the
variable bytes controlled by the control item (.up to 4
bytes)

To set up a control item that generates sysex, you must first enter the
sysex data into Performer, and you have two choices for how you can
do so. You can:

1. Type it in by hand

2. Type in a request message and record it from the synth

To set up a sysex slider or knob:

1. Create the slider or knob.

If the sysex message you’d like to control was recorded as a bulk
dump into a device, be sure to assign the target to the device.
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2. Select it and choose Control Assignment from the console mini­
menu.

3. Choose system exclusive from the Target data type pop-up menu.

4. Click the Sysex setup button.

The Assign Slider Sysex window appears.

Sysex message for: Slider
Checksum options...

r Transmit... )

0:
8:

16:
24:

F0 00 00 03 30 33 03 03
30 30 11 01 20 11 02 01
20 12 01 01 21 03 01

.... 03. .
00

Length: 24
□ Use checksum

© Straight sum
(CS = data bytes)

O Sum to zero
(data bytes + CS = 0)

Number of bytes in
checksum: | 11

Byte format: MIDI format (7-bit) s-1 <S) LSB-> MSB

O MSB -> LSB

I' Value J by te range: | | to | J

I Checksum ) first data byte: |

Choosing the Variable
Data Bytes

If you want to type in the sysex message, type the message into the
sysex editor. For more information about how to use this editor, see
the System Exclusive chapter.

If you would like to enter a bulk dump request message, click
Transmit. Performer’s standard sysex editor window appears, into
which you can type in the bulk dump message. See the System
Exclusive chapter if you need more information.

Once you have the sysex message you want in the sysex editor
display, you can now select which data bytes are to be the variables
that will be controlled by the slider.
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To select the variable data bytes:

Setting the Checksum

1. Choose replacement mode for the edit cursor so that you can
highlight the desired bytes.

2. Select the desired data bytes.

You can select up to four bytes.

3. Once the bytes are selected, click the Value button.

Notice that the bytes now turn into a slider.

Length: 24

0: F0 12 11 20 00 ... .0.
8: 00 01 21 02 03 03 33 03 . . ! . . .3

16: 30 30 30 33 03 03 03 00 0003...
24: 00 00 00 00 00 F7

>•“ Note: if the sysex message is a device bulk dump,
several sliders can edit the same bulk dump message.

To see the values of the bytes being covered up by the slider, use the
arrow keys to scroll the insertion cursor through the bytes. When it
passes through the slider, the slider disappears for a few seconds.

If the synth requires a checksum. Performer must generate the proper
checksum as well, and it needs to know an initial value to do so.

To set the initial checksum value:

1. Click the Use Checksum check box.

2. Select either the Straight sum or Sum to zero option.

3. Type in the number of bytes for the checksum value.
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4. Identify the first data byte that is checksummed.

To do so. type in the byte number next to the Checksum button.
or place the cursor at the first byte of checksummed data
(normally the first byte immediately after the sysex header) and
click the Checksum button.

Setting the Bit Formats Select the appropriate bit format from the pop-up menu and select
either LSB->MSB or MSB->LSB.

You are done! Click OK. The slider will now generate the sysex
message. If the synth does not respond, verify the checksum values.

Monitoring a Sysex
Slider During Playback

Sysex sliders cannot monitor the data they generate. This is due to the
amount of data processing that would be required in real time.

Here is a work-around for this problem:

1. Create two sliders.

2. Make one the master and the other a slave.

3. Make the Master slider generate an unused controller and assign
its target to a track.

4. Make the slaved slider read that unused controller from the same
track as its source.

5. Then make the slaved slider generate the sysex data.

In this scenario, you move the master slider. It generates controller
data at the same time that it is controlling the sysex slider, so that the
sysex slider matches its movement. On playback, the sysex slider
monitors the controller data and generates the sysex. Thus, the sysex
data never gets recorded in the track; only the controller data does.
But the controller data and sysex data match because the were slaved
when originally recorded. The end result is that the sysex slider
animates and plays back exactly as it was record.
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Hints

Remapping Continuous
Data

Improving Console
Animation

Control items can serve many purposes. Some suggestions are
discussed below.

Control items can be used for remapping continuous controller data
in real time. For example, you may have a synth module that
responds to controller #10 (MIDI Pan), but you may not have any
keyboards that can send this particular controller. A control item can
solve this problem by remapping a controller that your keyboard does
send into controller #10. To do so, assign the source of a control item
to be a controller that your keyboard can transmit, such as controller
#1 (mod wheel). Set the control item’s target to be the Device or track
that sends to the synth module. Set the target data type to controller
#10. Now, when you send controller #1 data from your keyboard by
moving the mod wheel, you will be controlling the Pan settings on
your synth module.

Control Items also offer a way to reassign continuous data in real time
instead of using the Reassign Continuous data command. For
example, you may have a track of controller #3 continuous data that
you wish to change to controller #7. You can set up the source of a
control item to be the track containing controller #3. In turn, you can
assign the target data type to be controller #7, and assign the control
item to send the data to a different target track. When you press
record, the control item will read in the controller #3’s and generate
controller #7’s, which in turn will be recorded into the target track.

Performer’s first priority is to keep up with the flow of MIDI data. If
it encounters a great deal of data, it selectively ignores its graphic
display until the microprocessor load decreases. This may affect the
animation of control items, and they may not move smoothly when
lots of data is being played—especially if there are many control
items on the screen. This is Performer's way of keeping up and does
not necessarily mean that MIDI data is being transmitted inaccurately.

Performer gives the currently active window highest priority when
animating control items. Therefore, whenever you want to watch
control items while Performer is playing back, make sure their
window is active. To activate the window, simply click anywhere on
the window.
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If the control items you want to watch are in different consoles, you
may want to create another single console that contains all of the
control items you wish to monitor during playback. You can then
make it the active window, and all of the control items in it will
animate as smoothly as possible. You will find that as long as the
console is active, Performer does a pretty good job of animating
control items accurately.

Another way to improve control item animation is to close as many
consoles as possible.

Loading Control Items
and Consoles From
Another File

Consoles from one Performer file can be imported into any other
Performer file using the Load command, found in the File menu. This
means you can set up control items the way you like them, once, and
they’ll be available for importing into any of your files.

The Consoles that you create in a file are automatically saved as part
of that file. The Load dialog box, however, enables you to extract
them from an unopened file, then load them into the file in which
you are working.

To load Consoles into an open file:

1. Choose Load from the File menu.

The standard Macintosh Open dialog box appears.

2. Click the file containing the assignments you wish to load, then
click Open.

Alternately, you can double-click the file name. Performer's Load
dialog box appears, displaying the file name at top.

3. Choose the Load Consoles option.

4. Optional: If you wish to load any Chunks from the selected file,
choose the Load Chunks option and either the Data or Link sub­
option.

If you wish to load more than one Chunk, you can drag to select
contiguous Chunks and shift-click to select discontiguous Chunks.
Deselecting this option loads only the file's Control Items.
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Sending note-ons and
note-offs with sliders,
knobs, or buttons

Creating a Mute Button

Automating a Fader
Group with a Master
Control

5. Click OK to confirm your choice(s) or Cancel to withdraw the Load
command.

Clicking OK causes the selected file's Consoles, as well as any
selected Chunks, to be loaded into the open file. The imported
consoles appear in the Windows menu.

When you program a button or slider to generate notes as shown
below by the “Send” pop-up menu, you have three possibilities:

1. Send notes (both note-ons and note-offs)

2. Send note-ons only

3. Send note-offs only

For option 1, leave both check boxes unchecked. In this case, the
slider, knob, or button will send a note-on when you click it, and it
will send a note off when you either release it or move it to another
note.

For options 2 and 3, click the appropriate check box. In this case, the
slider, knob, or button sends only a note on or a note off when you
click it or move it.

Please note: note-ons and note-offs by themselves do
not constitute an entire note. Therefore, they cannot
be recorded into a track.

To create a mute button, create a button as described in the section
“Creating a Button” on page 521. For the maximum value, click the
“unmute button” as shown in Figure 31-1 on page 523.

Master console controls can control their slaves while monitoring a
target track. This means you can automate the movement of many
slave controls at once by recording only the data of their master
control. For example, you can automate a master fade-out at the end
of a sequence by slaving multiple sliders (one for each track or device
in your sequence) to a master slider and then recording the master
slider. When you play back the result, the master slider monitors the
data you recorded in its target track and simultaneously drives the
volume sliders for all other tracks. To accomplish this, make sure that
the master slider target assignment is a track (or a device which is
assigned to a track).
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Remember that the master slider's track must be play-
enabled for this to work. (It can’t be muted.) As a
result, you might consider assigning the master slider's
track to a MIDI channel that you don’t use. Also, since
the target data type for the master slider doesn’t matter
(as long as it is some type of continuous controller),
you might consider using a target data type for the
master slider that is unlikely to affect anything else
(like controller number 45).
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Chapter 32 Change Key

Quick Reference

Key signatures provide a way to interpret MIDI note data. In music­
notation, there are several ways to write every pitch. For example,
although G sharp and A flat sound the same and describe the same
pitch, a G sharp would make less sense in the key of E flat than an A
flat would. Performer allows you to specify key signatures in your
sequences, making the display of notes in the Event Editing windows
clear and musically accurate. Key signatures are also extremely
important when viewing a sequence in music notation with
Performer’s QuickScribe notation window; setting the correct key­
signatures ensures that the music will be properly notated.

Key type

buttons ---------------

Key select

scroll bar

Keyname------------

------- Spelling table

-------- Spelling pop-up

menu

Start and end

locations

Start and End Locations: Displays the region over which the key' change
occurs. Click on a value to highlight it, and type the desired starting
and ending measure locations. After each change is made, the From
location is set to the previous To location. Click on the end of
sequence button to change key from the From location to the end of
the sequence.
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Key type: Click on the appropriate radio button to select a Major,
Minor, or user-defined Custom key.

Key Signature Scroll Box: Use the scroll bar and arrows to select the
desired key signature. Changing the key in this box automatically
updates the key name and spelling table.

Key Name: Displays the name of the key signature. The name appears
as the key change event in the Event Editing windows. The name is
set automatically when the Major or Minor key types are chosen.
Click the name and type to change it.

Spelling Table: Displays the spelling of the twelve chromatic notes for
the currently selected key. Change a spelling by pressing on the note
letter and selecting the desired spelling from the pop-up menu that
appears.

Basics Key signatures in the Conductor track of a sequence apply' to all the
tracks in the sequence. At any' given location, there can be only one
key signature for all tracks. You can have as many key' changes as
you like in a sequence.

Key changes appear for reference in all track Event Editing windows.
They may be edited only in the Conductor track, either directly in the
Conductor track Event Editing window or from the Tracks window.
Each key change affects the spelling of notes to just before the
beginning of the next key change. Key changes only affect the display
of note pitches; they do not change the actual MIDI data in your
sequence.

If there is no key signature entered at the beginning of the sequence,
the default key is C major (no sharps or flats).

It is possible to put key changes in the Conductor track of a song, but
they will have no effect on the spellings of notes in sequences
contained in the song. Only' key changes in the Conductor track of
the sequence will affect notes within that sequence.

Performer’s Key
Signatures

Key signatures in Performer actually have two components: the
standard key signature (up to seven sharps or seven flats), and note­
spelling assignments for non-diatonic notes (notes not in the basic
scale of the key). A key has five non-diatonic notes; Performer allows
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you to decide how each of them will be spelled. In the key of D, for
instance, you can name the note that lies between B and C sharp
either B sharp or C natural.

You can choose from three types of key signatures:

■ Major: Any key from C sharp major (7 sharps) to C flat
major (7 flats)

■ Minor: Any key from A sharp minor (7 sharps) to A flat
minor (7 flats)

h Custom: You can choose a signature with 7 sharps to 7 flats
and call it what you wish. This is useful for modal key
signatures: C Phrygian, for example, has 4 flats. The key
signature name is only for your reference: only the key
signature itself is displayed on the staff in the QuickScribe
notation window.

To set a key signature or add a key change:

1. Specify which sequence the key change affects.

If a Tracks window is active, the key insertion will apply to that
sequence. If the Chunks window is active, the key insertion will
apply to the highlighted Chunk or, if no Chunk is highlighted, to
the current play-enabled Chunk. If an Event Editing window is
active, the key insertion will apply to whatever sequence it
belongs to.

2. Choose Change Key from the Change menu.

A dialog box will appear. Notice that the name of the sequence in
which the key change will be placed is displayed at the top of the
dialog box.

3. Specify the From and To locations.

These locations specify the starting and ending locations for the
key change. Click on the fields and enter the desired
measure I beat I tick values. If you have just entered a key change,
the From location is automatically set to the previous To location.
Click on the end of sequence button to change key from the From
location to the end of the sequence.
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4. Specify the type of key signature to be inserted.

Click the options for major, minor, or custom, as explained above.

5. Use the Key Signature Scroll bar to select the key signature.

Use the scroll bar and arrows to choose the desired number of
sharps or flats. The key name and spelling table are automatically
updated as you scroll.

6. Enter a name for the key change.

Optional: If you have chosen a Major or Minor type, the name is
automatically set.

7. Choose the note spellings for each non-diatonic note in the key.

Click on each note to select it and choose the desired spelling
from the available ones displayed.

8. Press the Change button to enter the change.

The Change button enters the key change and leaves the dialog
box open so that you can insert more key changes.

You can repeat this procedure to enter as many key changes as you
wish. When you are done entering changes:

9. Click on the triangular Close box at the top left to close the dialog
box.

Viewing Key Changes Key changes in a sequence can be viewed in two places: in the Event
Editing windows for each track and in the Conductor track for that
sequence. Key changes can be edited only in the Conductor track:
they cannot be modified in the Event Editing windows for standard
tracks. Key changes can be omitted from the editing windows by
turning off their display with the View Filter.

Editing Key Changes in
the Conductor Track

Key changes can be edited directly in either Event Editing window
(Event List or Graphic Editing) for the Conductor track. This section
discusses the editing of key changes in the Event List window. See
the chapter The Graphic Editing Window for details on editing
Conductor Track information graphically.
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Using the Edit
Commands with Key
Changes

In the Event List for the Conductor Track, the location of a key
change can be edited by altering its starting time. The key change
itself may be modified by Option-clicking on it. The Change Key
dialog box appears in which you can enter the modification. The box
that appears is slightly different than the one chosen with the Change
Key command: the Change button is replaced by OK and Cancel
buttons, and the sequence name and From and To location fields are
missing. Otherwise, this box works exactly as described above.

To edit a key change in the Event List window for the Conductor
track:

1. Double-click on the Conductor track in the Tracks window.

An Event Editing window will open. If the Graphic Editing
window appears, go to the mini-menu on its title bar and choose
Event List. The Event List window for the Conductor track will
appear.

2. Option-click on the key change event that you wish to change.

If necessary, use the scroll bar to locate the desired key change
event. The Change Key dialog box appears.

3. Change the key type, signature, name, and spelling as desired.

See the section above on entering key changes for information on
these fields.

4. Press OK to confirm your changes or Cancel to cancel them.

You can apply the commands from the Edit menu to key changes in
the Conductor track: key signatures can be cut, copied, pasted,
spliced, etc., just like other events. The region to edit in the
Conductor track may be selected by highlighting events in its Event
Editing window or clicking on the Conductor track to highlight it and
specifying a region in the Edit bar. Key change information can be
included in an edit operation involving note and other MIDI events
by including the Conductor track along with the selected tracks.
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Chapter 33 Change Meier

Meters specify the way musical time is counted and measured. In
Performer, meters affect the way measure I beat I tick locations are
displayed in the Counter, dialog boxes, and Event Editing windows.
Meters also affect the Click and countoff. In addition, they impact the
way information is displayed in Performer’s QuickScribe notation
window. The Change Meter command allows you to enter any
number of meter changes in a sequence.

QuHcIk Reference

Meter

Options

Metronome
Click value

Start and end

locations

Meter Marking: Displays the meter in standard musical format. Click on
the numerator and/or denominator and type in new values to change
it.

Start and End Locations: Displays the region over which the meter
change takes effect. Click in the From box to set the starting location.
Click in the To box to set the ending location. Click on the end of
sequence button to extend the region to the end on the sequence.
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Basics

Options: Click on the appropriate radio buttons and/or check box to
select the desired options. The Only move barlines option does not
affect the actual events in the sequence. The Realign music
automatically and Adjust durations options erase or change events
to fit the meter.

Metronome Click value: Displays the duration between clicks and
between counter updates. Click on the desired note value. Click on
the dot for dotted durations (i.e. one and a half times the chosen note
value).

A meter consists of a beat value and the number of beats per
measure. The beat value is generally the rhythmic pulse or beat of the
music; a measure consists of a certain number of these beats.
Performer displays meters in the standard musical fashion as a
fraction, with the beat value in the denominator (on the bottom) and
the number of beats per measure in the numerator (on top). In
Performer, the numerator can be a value between 1 and 99. The
denominator must be a power of 2 (1, 2, 4, 8, 16, 32, or 64).

A Meter Change event in Performer consists of a meter displayed in
this way, along with a metronome click value. This value determines
the spacing between the sounds and MIDI events produced by the
Click feature. It also determines how often the Counter is updated
during playback or recording.

The meter’s denominator value, the beat value of the current tempo
and the metronome click value are all related, though they need not
be set to the same value. You may wish to have a meter of 4/4 with
a tempo of half note = 180 with the metronome clicking every eighth
note. The ability to use separate values allows a great deal of
flexibility and accuracy during recording.
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Using the
Change Meter
Dialog Box

: If a sequence or song contains several meters, the resulting
configuration of meters is termed a "meter map". This map is simply
the complete set of programmed meter changes for an entire
sequence. These changes are displayed in the Event Editing windows
for each track in the sequence. The meter changes for a given
sequence or song can only be altered in its Conductor track.

It is often useful to set up the meter map before recording the music,
this way the measure locations of the events you record will stay
consistent through the recording and editing process. If you change
meter after recording a track or tracks, the measure I beat I tick
locations of the events may change.

Inserting a new meter may or may not have an audible effect on the
music. Depending on the options you select for inserting a new
meter, note events may be excluded and durations may change.
These options are explained in detail below.

Performer starts a new bar at every meter change. Thus, if a meter
change is inserted in the middle of a measure, that measure will
terminate early, and a new one will begin with the meter change
event.

To enter a meter or meter change:

1. Specify which Chunk (sequence or song) the meter insertion
affects.

If a Tracks window is active, the meter insertion will apply to that
sequence. If the Chunks window is active, the meter insertion will
apply to the highlighted Chunk or. if no Chunk is highlighted, to
the current play-enabled Chunk. If an Event Editing window is
active, the meter insertion will apply to whatever sequence it
belongs to.

2. Choose Change Meter from the Changes menu.

The Change Meter dialog box will appear. The name of the Chunk
in which the meter insertion will be placed is displayed at the top
of the dialog box.
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3. Enter the numerator and denominator of the meter to be inserted in
the boxes next to the words Change meter to.

Click in each box and type in the numbers. The numerator must
be a value between 1 and 99. The denominator must be a standard
note value: 1, 2, 4, 8, 16, 32 or 64.

4. Choose the metronome click value.

Click on the note value you want the metronome to click on. If
you want a dotted note value, click on the dot in addition to the
note value.

5. Enter the beginning measure of the region which the meter change
should affect.

Click in the box under the word "From” and type in the beginning
measure number. When you press the Change button the From
value is automatically set to the previous To value.

6. If you are going to be entering a series of meter changes quickly,
choose the Next Measure option.

This option lets you press the enter key once for each measure. If
you have several measures in a row in the same meter, just press
the enter key once for each measure. The "from" measure is
automatically updated as you do so. This lets you enter meter
changes efficiently for an entire sequence by quickly pressing the
enter key repeatedly a’s many times as necessary for measures
with the same meter. When you need to the meter changes, type
in the new meter and press enter again as many times as necessary
for the new meter. Keep going as long as necessary.

7. If you are entering a meter change over a fairly long region, choose
either one of the two remaining options; if necessary type in the
end measure of the region.

There are two options here: you can either specify a particular
measure or the end of the sequence (or song). Click on the button
next to the option you want. If you choose the specific measure
option, click in the text box next to the word measure-and type in
a measure number.
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The Metronome Click
Value

The Measure Range

Realign Music
Automatically

8. Choose to realign music in the region and adjust durations if you
wish.

To realign the music, choose the Realign music automatically
option. If you wish to adjust the durations of notes in the region,
click in the Adjust durations box. If you wish to leave the music
unaltered, click in the Only move barlines button. A full
explanation of these options is given below.

9. Press the Change button to enter the change.

The Change button enters the meter insertion and leaves the
dialog box open so that you can insert more meters.

10.To close the Change Meter dialog box, click in its close box.

The metronome click value you specify will be associated with the
meter change you choose. You can specify a different metronome
click value for each meter change. See the chapter Click and Flash for
more on the Click feature.

When you enter a range of measures. Performer will change the
meter up to but not including the to measure. The to measure does
not change; it remains in the same meter as before the operation. This
is very similar to the way most edit/region operations work; events at
the end time are not affected. If you choose the end of sequence
option, the meter change will continue to the end of the sequence.
no matter how the sequence may change.

For example, assume a sequence is completely in 4/4. Entering a
change to 3/4 from measure 8 to measure 12 will place a 3/4 meter
change in measure 8, and a 4/4 meter change in measure 12. The
result is that measures 8 through 11 are now in 3/4, and measure 12
remains in 4/4.

This option allows you to maintain the metrical structure of each
measure by deleting some note events and changing the durations of
others. There is a sub-option. Adjust durations, which is discussed
below. The following assumes that the Adjust durations box is not
checked. When you change the meter of a measure that contains note
events with this option on, beats are either added or removed
according to the new meter you specify. If beats are added, rests are
inserted for the new beats. If beats are removed, any note event 
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occurring in the removed beat will be removed as well. The durations
of note events that start before the deleted beats are preserved. For
example, suppose you have the following two measure passage in 4/
4 time:

Graphically, the durations would be represented like this:

Changing the meter to 3/4 and using the Realign music automatically
without adjusting durations, the fourth beats would be removed. This
would remove the quarter note in the first measure but not the whole
note since it began before the deleted (fourth) beat:

The B-natural

that was on beat

four is removed.

The whole note is

not removed

because it began

before the fourth

beat. Notice that it

maintains its

duration (four

beats).

Adjust Durations The Adjust durations sub-option can only be used when the Realign
music automatically option is selected. The Adjust durations sub­
option alters the durations of notes that begin before the removed or
added beats. The durations are altered to conform to the new
measure boundaries. In the example above, the original version in 4/
4 has a note lasting the whole second measure. With the Adjust
durations option on, the duration of this note is altered such that the
note will last for the entire measure in the new meter:
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The duration of the

four-beat whole

note is truncated to
fit the new 3/4

measure.

Only Move Barlines This option does not change any durations. It imposes the new
barline structure over the music, keeping all durations the same. The
above original 4/4 passage would look like this with the Only move
barlines option-.

Original music Realigned using the Only Move Barlines option

Viewing Meters

Editing Meters in the
Conductor Track

The meters in a sequence can be viewed two places: in the Event
Editing windows for each track and in the Conductor track for that
sequence. Meters can be edited only in the Conductor track; they
cannot be modified in the Event Editing windows for standard tracks.

The meters in a sequence will appear in the Event Editing windows
for all tracks in that sequence. Meters can be omitted from the editing
windows by turning off their display with the View Filter. Conversely,
the entire meter map may be viewed alone by turning off the display
of all other types of events.

Meter changes can be edited directly in either Event Editing window
(Event List or Graphic Editing) for the Conductor track. This section
discusses the editing of meter changes in the Event List window. See
the chapter The Graphic Editing Window for details on editing
Conductor track information graphically.
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To edit a meter change in the Conductor track Event List window:

1. Double-click on the Meter Change event you wish to edit and enter
the new values.

Use the Tab key to move from field to field. The location and
meter marking fields are edited like standard event values. Editing
the metronome beat value field calls up a small pop-up box with
note symbols for the possible values. Click on the note
corresponding to the value you desire.

2. Press the Return key to confirm the changes, or Command-period
to cancel them.

Clicking anywhere else on the screen will also cancel the edit.

Using the Edit
Commands with Meter
Changes

You can apply any editing command to meters in the Conductor
track: they can be cut, copied, pasted, spliced, etc., just like other
events. The region to edit in the Conductor track may be selected by
highlighting events in its Event Editing window or clicking on the
Conductor track to highlight it and specifying a region in the Edit bar.
Meter information can be included in an edit operation involving
note and other MIDI events by including the Conductor track along
with the selected tracks.

Hints and
Examples

Editing meter changes can be confusing. If you feel that your meter
map has become too complicated, has errors that you can't easily
detect, or has somehow become excessively complex, you can delete
it and re-enter it correctly from the start.

To erase the current meter map:

1. Activate the Tracks window for the sequence with the meter map
you wish to erase.

Click in the window to activate it.

2. Double-click on the word “Edit” in the Edit Bar.

This loads the start and end times of the entire sequence in the
Edit Bar.

3. Select the Conductor track by clicking on it.

4. Choose Edit Filter from the Edit menu.
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5. Uncheck all check boxes except for meter changes.

Hold down the Option key and click on the meter change check
box. Now the Edit commands will only affect meter changes.

6. Choose Erase from the Edit menu.

This gets rid of all the meter changes for the sequence.

7. Choose Edit Filter from the Edit menu.

8. Restore your previous Edit Filter setting.

You should always reset the Edit Filter after using it.

Be careful when pasting into the Conductor track: pasting replaces
events of all types selected in the Edit Filter. This may be what you
want. If, however, you are just rearranging meters and wish to leave
the other data where it is, make sure to set the Edit Filter for meter
changes only.

Here’s a method for inserting a number of new bars with a different
meter into your sequence.

1. Shift over the sequence to make room for the new bars.

Enter the insertion point for the new bars in the Start time in the
Edit Bar and double-click on the End time to set it to the end of
the sequence. Then choose Shift from the Edit menu, and enter
the number of bars you want in the current meter.

2. Choose Change Meter from the Change menu.

3. Set the From and To locations for the meter change.

Enter the beginning location of the new bars in the From field.
Add the number of bars being inserted to the beginning time.
Enter this in the To field.

4. Click on the Realign Music Automatically option.

Leave the Adjust durations box unchecked. This option adds or
subtracts the necessary number of beats to ensure that new
measures line up with the new meter.

Change Meter 561



5. Click on the Change button.

This enters the meter change.

6. Click on the close button to close the dialog box.
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Chapter 34 Change Tempo

Tempo is very flexible in Performer. Not only can there be several
tempos in a Chunk (sequence or song) but they can change
dynamically, resulting in accelerandos, ritards other programmed
tempo effects.

In Performer, tempo is controlled by the Metronome panel in the
Consolidated Controls panel. The metronome provides three possible
settings for tempo control:

□ The Tempo slider

■ The Conductor track

■ An external device, such as a mod wheel on a keyboard
controller

Only one of these sources can be chosen at a time.

When Tempo Control is set to the Conductor track, you program all
the tempo changes into the Conductor track. Collectively, these
tempo changes are called the tempo map, and they occur
automatically when you play the Chunk under Conductor track
tempo control.

Tempo maps can be programmed using the Change Tempo
command as described in this chapter. Alternately, you can create a
tempo map in real time by slaving Performer to Tap tempo synchro­
nization. See the chapter called Receive Sync to learn more about
creating tempo maps in real time using Tap tempo sync.
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Quick Reference

Beat value Tempo Density Button

— Tempo curves

Start and end locations

—Tempo parameters

Randomization option:

Anchored tempo-

indicators

Time Display Button

Beat Value: Displays the note value on which the tempo is based. Click
on the desired note to choose it. Click on the dot to make the beat
value a dotted duration (i.e. one and one half of the chosen note's
duration).

Start and End locations: Displays the region over which the tempo
change will take effect. Click on the box and type in the desired
values. Use the Tab key to move from field to field.

Anchored Tempo Indicators: Click on the anchor icon to toggle a
starting or ending tempo between anchored and unanchored.
Anchored tempos are automatically set to the current tempo in the
region, preventing unwanted jumps in tempo.

Time Display Buttons: Click on the appropriate radio button to select
real or frame time for the tempo parameters.
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Tempo Density Buttons: Click on the appropriate radio button to choose
between Coarse and Fine tempo event densities. The Fine setting
generates 12 tempo events a beat; the Coarse setting generates far
fewer events.

Tempo Curves: Click on the desired curve button to select the type of
tempo change desired. Each curve has a set of parameters and
options which control the shape and range of the tempo change.

Tempo Parameters: The number and type of parameters depends on
the Tempo Curve selected. Parameters outlined by a box can be set
by the user; other parameters are computed and verified by'
Performer when the Compute or OK buttons are pressed. Values that
are incalculable or out of range will highlight and cause the
Macintosh to beep (or the menu bar to flash). Press the Option button
to change the parameters that can be edited.

Randomize tempos: Check this box to randomize tempos within a
specified range, expressed as a percent or as a number of beats per
minute (bpm).

Emphasis: Type a value between -9 and +9 to weight the
randomization either lower or higher.

The Options Button: Click on this button to select which parameters are
user-definable.

The Compute Button: Click on this button to compute the values for
parameters that are not user-definable.

The OK Button: Click on this button to enter the tempo change and
close the dialog box.

The Cancel Button: Click on this button to cancel the tempo change and
close the dialog box.

Basics The Change Tempo command is used to create tempo changes. You
can specify a static tempo change (i.e. a constant tempo) or a
dynamic one (a smooth change) via a curve. A constant tempo
contains no variation of the tempo for its duration; it is merely’ a
change from one teinpo to another. A smooth change contains
varying tempo values. The way’ that these values change is specified
by one of four curves. An accelerando, for example, is a smooth
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change with a linear curve in which the tempo gradually increases.
When a smooth change is specified with a curve, Performer
approximates the smooth change with a large number of discrete
tempo changes in quick succession.

When you use Change Tempo, any existing tempo data in the
specified region is erased and replaced by the new data generated by
the command.

A tempo map is simply the complete set of programmed tempo
changes for an entire sequence or song. These changes are displayed
in the Conductor track.

The tempo changes for a given Chunk can only be
edited in its Conductor track.

To get a clear picture of the tempo map of a Chunk, you can use the
View Filter to view only tempo changes in its Conductor track.

The tempo map specifies the relationship between real or frame time
and measure time. Each tempo map consists of tempo changes
occurring at measure time locations. Performer always maintains a
correlation between real and measure times according to the tempo
map. When you move to a measure time location, the corresponding
real time is computed and vice versa. The same measure will always
occur at the same real time location no matter where you start
playing.

When you change the tempo map, the real times of all markers and
events (viewed in Event Editing windows) are updated. The real time
locations of locked markers do not change in this case. Rather, their
measure times change.

Performer’s tempo capabilities were designed to be very effective in
film and video applications. Tempo calculations are very accurate
resulting in very precise location abilities. Finding a frame time
location will bring you to the exact measure time location
consistently. Real time locations of events and markers are
completely reliable and give an accurate representation of the timing
of the music.
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The Change
Tempo
Command

This precision is possible because Performer maintains a very' high
degree of internal tempo resolution, much greater than the two
decimal places that you can enter. This resolution allows you to set
the tempo for a region by specifying its length in real or frame time:
Performer will calculate the correct tempo to make the end of the
region occur at the time you specify.

When you set the tempo control in the metronome to the Metronome
slider, the programmed tempo map is temporarily disabled by the
current metronome slider tempo setting. When you switch back
tempo control to the Conductor track, the programmed tempo map is
re-enabled.

The Change Tempo command lets you create smooth tempo changes
in a defined region of time. The start and end of the region are
defined by measure locations. With this command, you can calculate
a tempo for a region by giving a real time length for it.

To use the Change Tempo command:

1. Choose the sequence or song in which you wish to insert a tempo
change.

If a Tracks window is active, the tempo change will apply to that
sequence. If the Chunks window is active, the tempo change will
apply to the highlighted Chunk or, if no Chunk is highlighted, to
the current play-enabled Chunk. If an Event Editing window is
active, the tempo change will apply to whatever sequence it
belongs to.

2. Choose Change Tempo from the Change menu.

The Change Tempo dialog box appears. The name of the selected
Chunk is displayed after the words “Change tempo of sequence
(or song)” at the top of the dialog box.

3. Choose the beat value of the tempo.

Click on the value to select it; click on the dot if you want a dotted
value. For example, a tempo of dotted eighth = 90 would require
you to click on the eighth note and the dot.

4. Choose between displaying times in real or frame time.
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Selecting a Tempo Beat
Value

5. Choose between coarse or fine tempo changes.

Click on the appropriate radio button.

6. Choose the curve you want for the tempo change.

The curve type you select is highlighted.

7. Enter the Start and End locations.

Type in the measure I beat I tick values for the start and end of the
region for the tempo change.

8. Press the Options button repeatedly until the desired combination
of Start/End tempo/times have boxes around them.

There are several combinations of tempos and times that can be
entered and computed. For each combination, the values you can
set are enclosed by boxes.

9. Enter all parameters enclosed in boxes.

Type in the desired values. To set a Start or Ending tempo to the
current tempo, click on the anchor icon for the parameter.

10. Press the Compute button to calculate the tempo and time values
based upon the parameters you entered.

If the computed values are not satisfactory, enter new parameters
and try again.

11. Press OK to enter the tempo changes or Cancel to terminate the
action without entering the changes.

Tempo calculations may take some time after you press the Compute
or OK button. To stop calculations in progress, press the Command
and period keys at the same time.

Tempos are measured in beats per minute. You can select any beat
value for the tempo from a sixteenth note to a whole note. The beat
value can be dotted. The number of beats per minute can be between
20 and 400. At very slow tempos, you may want to use smaller beat
values such as an eighth note. At fast tempos, you may want to use 

568 Change Tempo



larger values such as a half note. Your choice of beat value does not
affect the frequency of the Click. This is set separately with the
Change Meter command.

Selecting a Time Display

Setting the Start and End
Points

Using the Fine and
Coarse Options

Anchoring the Start and
End Tempos

When you type in a number of beats per minute in Performer (in the
Metronome, in a pop-edited tempo event, or in the Change Tempo
window), you can type in a timing resolution of up to a hundredth of
a beat per minute (136.45, for example). In addition to providing you
with a high degree of resolution, this also allows you to easily enter
tempos that match standard frame click metronome values.

You can choose whether to display start and end times in real or
frame time. This is ver)' useful for calculating timings in film and
video work.

The measure time locations entered in the Start and End boxes in the
Change Tempo dialog box delineate the region in which the tempo
change occurs. New tempo data will be inserted into this region
according to your specifications.

The Fine and Coarse options determine the density' of tempo change
data generated. Selecting the Fine option causes tempo changes to be
generated 12 times per beat. This creates the smoothest changes but
generates lots of data, taking up memory' and possibly slowing down
the display of real and frame times in the Markers or Event Editing
windows. This option is best used over regions of only a few
measures. With the Coarse option, fewer tempo changes per beat are
generated. This is the best option to use in a large region.

In most situations, the tempo changes generated by the Coarse option
will sound completely smooth. The rule of thumb here is to use the
Coarse option unless the tempo changes are not smooth enough: in
this case, the Fine option can be used.

The Start and End tempo parameters have an anchor icon next to
them. When the anchor icon is highlighted, the tempo is anchored. If
the anchor icon is unhighlighted, the tempo is not anchored.

[3]| 120.0| Start tempo
H 60.0 End tempo

To anchor or unanchor a tempo, click on the anchor icon next to it.
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Using Tempo Curves

When a tempo is anchored, the current tempo at that location in the
Chunk is used. For example, if you anchor the Start tempo parameter,
the value used for that parameter will be the pre-existing tempo at the
Start location.

The anchoring option is used to make sure that tempos just before
and just after the region are matched exactly. This insures that there
are no sudden jumps in tempo at the start or end of the region. It is
best to anchor tempos when you want this continuous tempo effect;
you cannot achieve the same degree of accuracy when entering
tempos manually.

The tempo curve buttons specify the values for the individual tempo
change events created by the Change Tempo dialog box. Rather than
inserting each tempo change manually, you can select a curve and set
a few parameters; Performer will calculate the tempo changes
necessary to create the desired effect. The flat, straight line (the
constant curve) generates just one tempo change at the beginning of
the region. The other curves — linear, logarithmic, exponential and
polynomial -- generate a number of tempo changes which
approximate the shape of chosen curve. These curve types are
described in detail below.

Regular
Linear
Curve

Flipped
Linear
Curve

To select a < urve, click on the button containing the picture of the
curve. The currently selected curve is highlighted. When a curve is
selected, the associated parameter fields are displayed in the lower
section of the dialog box.

The curves are all displayed as increasing values. However, if you
specify an End tempo that is less than the Stan tempo, the tempo
changes generated will decrease over time according to the chosen
curve. In effect, this flips the curve upside down. For example, if you 
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Curve Parameters

The Constant Curve

wanted to program a ritard (slowing down), you'd choose the linear
curve and enter a lower ending value. This would ‘ flip" the effect of
the curve from up to down, as shown to the left.

Each curve has unique parameters. These parameters are the specifi­
cations for the tempo change data to be generated: starting time,
ending time, etc. In addition, these parameters can be combined in
several different ways for each curve. For example, the linear curve
allows you to set different combinations of the Start tempo. End
tempo and End time. After selecting a curve, pressing the Options
button cycles through the various combinations of parameters
possible for that curve. Parameters that you can enter are in boldface
type and are enclosed in a box; parameters that Performer will
compute (and that you cannot enter) are in plain type without the
box.

After you enter the parameters for a curve, you must press the
Compute button for the other parameters to be calculated. These
calculations are not automatic: you must explicitly request them by
pressing the Compute button. These calculations can take time; if you
are certain about the values you have entered it is not necessary to
use the Compute button. To abort a calculation in progress, press the
Command and period keys at the same time.

Each curve displays its Start time parameter. This value is not user-
changeable; it is always computed from the starting measure time
location. It is provided as a reference for viewing the length of the
region.

The following paragraphs describe the effects of each curve on the
specified region and the parameter options for each.

The constant curve sets the region to a constant tempo by inserting
only one tempo change at the beginning of the region.

Parameters:

Tempo: This is the tempo for the entire region in beats per minute.
You can use one decimal place value if you wish, e.g. 89.7. If you
anchor the tempo, it will be the same as the pre-existing tempo at the
Start location of the region.
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End Time: This is the time at which the end measure Incation will 

The Linear Curve

The Logarithmic and
Exponential Curves

occur.

The linear curve creates a smooth tempo change with no fluctuations
in the specified region.

Parameters:

Start Tempo: This is the tempo at the Start location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the Start location.

End Tempo: This is the tempo at the End location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the End location.

End time: This is the time at which the End location occurs.

These two curves are similar: they both create a smooth change in the
specified region. The logarithmic curve changes tempo more rapidly
at the beginning of the region; the exponential curve changes tempo
more rapidly at the end.

[?t]| 120.00] Start tempo
[3|| 180.00] End tempo

10| Curvature
(1 to 99)

0:00:00:00 Start time
-------- End time

Parameters:

Start Tempo: This is the tempo at the Start location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the Start location.

End Tempo: This is the tempo at the End location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the End location.

End time: This is the time at which the End location occurs.
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Curvature: This is a value that controls the degree of curve in the
smooth change (i.e. its non-linearity). Enter a value between 1 and
99. Low curvature values flatten the curve and produce a more even
rate of change. For example, a value of 1 results in a near-linear
change that is similar to the linear curve. High curvature values round
out the curve and result in more change at the beginning or end of
the region depending on the button selected. For example, a value of
99 will cause much of the tempo change to occur at either the
beginning (for the logarithmic curve) or the end (for the exponential
curve). The higher the curvature value, the more pronounced the
curve shape.

The Polynomial Curve The polynomial curve creates a change in the specified region which
starts smoothly at the beginning of the region, changes most rapidly
in the middle and ends smoothly. Note that the unique parameter
Mid Beat is included with this curve, allowing you to control aspects
of the middle of the curve.

Parameters:

Start Tempo: This is the tempo at the Start location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the Start location.

End Tempo: This is the tempo at the End location of the curve in
beats per minute. If you anchor this value, it will be the same as the
pre-existing tempo at the End location.

Curvature: Allows values between 1 and 99- Low curvature values
flatten the curve; high values round it. Values of 30 to 60 work
particularly well with this curve.

Mid Beat: This is the measure time location at which the Mid Tempo
value occurs. This is the point at which the most rapid tempo change
occurs. This location can be any time between the Start and End
times and allows you to control where most of the changing will
occur.

End time: This is the time at which the End location occurs.

The Randomize Option The Randomize option causes the tempo or tempos being generated
by one of the selected curves to be randomized within a range for the
entire region over which the tempo change is being made. For
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example, if you are inserting a constant tempo of 120 bpm without
randomization, the result is a single tempo event at the beginning of
the region as shown below:

However, with the Randomize option checked and the range set to
±25 bpm, the result is a tempo map that constantly and randomly
changes between 95 and 145 bpm:
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Randomization can be used in conjunction with any
curve
Randomization option is a check box option, which means that it can
be used in conjunction with any of the tempo curves:

The same curve with randomization set to ±10 bpm.

Controlling the degree of randomization
The Randomize option is ideal for adding “human feel" to the tempos
of a sequence. By controlling the range over which the randomizing
occurs, you control the degree of that feel. You can specify’ the range
either as a percentage or as a range of bpm. In either case, each
tempo event generated is placed randomly' within the range.

Emphasis
This sub-option causes the tendency of the randomization to be
higher or lower within the specified range. Thus, if you wish to
randomize the tempos within a certain range, but you wish them to
tend to be higher, use a positive emphasis; use a negative emphasis
if you wish them to tend to be towards the lower end of the range. A
value of zero equals no emphasis, which causes the randomization to
occur evenly within the range.
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The Options Button

The Compute Button

The OK and Cancel
Buttons

Viewing and Editing
Tempo Changes

The effect of Density on randomization
A Fine density setting causes tempo events to be generated more
frequently than a Course density setting. Notice that these two
settings have an effect on the constant tempo curve, which normally
only produce a single tempo event.

Pressing the Options button cycles through the different
combinations of entered/computed parameters for the selected
curve. This allows you to specify the curve in a variety of manners.
For example, if you select a constant curve, you can specify just the
tempo or you can specify the End time, in which case the tempo will
be calculated to make the end measure location occur at the end
time.

If you are not working with externally imposed timings such as are
used in film and video work, you will probably not need to use the
Options button.

The Compute button calculates and displays computed parameters
(those which you cannot enter yourself) based upon the parameters
you enter. Traditionally, these calculations are done by the composer
or arranger either with arithmetic or by using a reference book.
Performer gives you a quick means to make these calculations with
the Compute button. Since computed parameters are not updated
automatically, you must use the Compute button to see their current
values. The Compute button doesn't make any internal alterations to
the tempo data; it is just a utility to let you see all the parameters.

Pressing the OK button computes the tempo changes and enters
them in the Conductor track. The computation may take a while. If
you want to terminate the computation, press the Command and
period keys together. Pressing the OK button automatically makes all
the calculations for all the parameters.

Pressing the Cancel button terminates the Change Tempo command
without entering any of the changes you made.

Tempo change data is stored in the Conductor track for the Chunk.
Tempo changes look like continuous MIDI data (such as pitch bend
or controller information) in the Conductor track Event Editing
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Tempo Editing
Resolution

I windows. Each tempo change has a time and a tempo value. The
: tempo has two parts, the tempo value in beats per minute and the

beat value (e.g. 1/4 note, 1/8 note, etc.)

Editing tempo changes can be done in either the Tracks window or
the Event Editing windows for the Conductor track. You can apply all
the commands on the Edit menu to tempo changes. Make sure that
tempo changes are selected in the Edit Filter, available from the Edit
menu.

Note that smooth tempo changes require a large number of discrete
tempo changes very close together. Also note that Performer’s
internal resolution of tempo events is much higher than that
displayed in the Event Editing windows. So, tempo events that seem
identical actually represent different tempos with higher resolutions
than can be shown.

To edit tempo changes using the Tracks window, set the Edit Bar
times and select the Conductor track. To edit tempo changes in one
of the Event Editing windows for the Conductor track, just highlight
one or more tempo change events as you normally would in any
other track’s editing window. Make sure that tempo changes are
selected in the View Filter. You can also insert single tempo changes
by using the Insert button in the title bar. See the chapter The
Conductor Track for more information.

Tempos can be manually edited to a resolution of a hundredth of a
beat per minute. When you use the Compute button in the Change
Tempo dialog box, tempos are calculated to a much higher degree ol
accuracy.
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Chapter 35 The Conductor Track

Basics

The Conductor track is a special track containing markers, meter,
tempo and key change information. Every sequence and song has a
Conductor track; it cannot be deleted. You may use the commands
from the Edit menu in the Conductor track to Cut, Paste, Repeat. Shift,
and otherwise edit tempo, meter, and key maps, as well as markers.
In addition, the Conductor track can be used to directly insen simple
tempo, meter, and key changes, as well as to ‘record’ a tempo map
entered in real time using Tap tempo synchronization.

The Conductor Track has two available Event Editing windows: the
Event List window and the Graphic Editing window. The examples in
this chapter refer to the Conductor track’s Event List window; see the
chapter The Graphic Editing Window to learn about editing the
Conductor track graphically.

The Conductor track automatically appears in the Tracks window for
each sequence. The Conductor track cannot be deleted or renamed;
it can be moved and given comments like a standard track. The
Conductor track has a record-enable button for use with Tap tempo
synchronization, described in the Receive Sync chapter. The
Conductor track cannot be looped.

A song’s Conductor track can be opened by choosing Edit Conductor
Track from the Song window mini-menu.

The Conductor track contains four types of events: Tempo changes,
Meter changes, Key changes, and Markers. These events are not MIDI
data; instead, they control or conduct your music’s performance
during playback. The tempo, meter, and key events can be edited like
standard MIDI events, either with the commands on the edit menu or
directly in the Conductor track Event List or Graphic Editing window.
Unlocked markers may be edited in the Conductor Track; locked
markers may only be edited in the Markers window.
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Key Changes

The following sections describe each type of event in some detail; for
more information on the Change Key, Change Meter, and Change
Tempo commands, or the Markers window, see the appropriate
chapters.

Key change events display the name of the key. User-defined key
signatures are displayed as ‘Custom'. See the Key chapter for
a full description of key signatures in Performer.

Also note that this section discusses the editing of key changes in the
Conductor track Event List window. See the chapter The Graphic
Editing Window for information on editing the Conductor track
graphically.

To insert a Key change event in the Conductor track Event List
window:

1. Press the Insert button in the Event List window title bar.

2. Select Key Change from the menu.

A new Key change event appears, with the location field
highlighted for editing.

3. Type in the measure, beat, and tick location and key for the event.

Use the Tab key to move from field to field. When you highlight
the key field, the Change Key dialog box will appear. See the
Change Key chapter for information on this dialog box. Click OK
to confirm the key; the key you specify will be in effect until the
next key change.
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Meter Changes

4/4 click J

4. Press the Return key to confirm your choice.

You can cancel the insertion by clicking anywhere else on the
screen.

To edit a Key change event in the Conductor track Event List window:

1. Option-click or double-click on the Key change event.

A pop-edit box will appear.

2. Change the location or key information.

Use the Tab key to move from field to field. When you highlight
the key field, the Change Key dialog box will appear. See the
Change Key chapter for information on this dialog box. Click the
OK button to confirm the key change; the key you specify will be
in effect until the next key change.

3. Press the Return key to confirm your edit.

You can cancel the edit by clicking anywhere else on the screen.

Meter change events display the time signature (the number of beats
per bar, over the duration value which gets the beat) and the click
value, (the duration value between metronome clicks). See the
Change Meter chapter for more information about these values.
Moving meter change events, or inserting them using the Insert
button, can cause unexpected results: please read the section later in
this chapter on Meter Changes and Partial Measures before
attempting to move or insert a meter change.

This section discusses the editing of meter changes in the Conductor
track Event List window. See the chapter The Graphic Editing
Window for information on editing the Conductor track graphically.

To insert a Meter change event in the Conductor track Event List
window:

1. Press the Insert button in the Event List window title bar.

2. Select Meter Change from the menu.

A new Meter change event will appear, with the location field
highlighted for editing.
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Tempo Changes

J> = 127.5

3. Type in the measure, beat, and tick location, meter, and metronome
click value for the event.

Use the Tab key to move from field to field, and type in the correct
values. Use the mouse to select your choice of click value.

4. Press the Return key to confirm your choice.

You can cancel the edit by clicking anywhere else on the screen.
Note that if you typed in a tick location other than 000, the meter
change will show 000 after you press return. This is because a
meter change always starts a new measure. See the section on
Meter changes and partial measures later in this chapter.

To edit a Meter change event in the Conductor track Event List
window:

1. Option-click or double-click on the Meter change event.

The event will be highlighted.

2. Change the location or meter information.

Use the Tab key to move from field to field, and type in the correct
values. Use the mouse to choose the click value from the pop up
box.

3. Press the Return key to confirm your edit.

You can cancel the insertion by clicking anywhere else on the
screen. Note that if you typed in a tick location other than 000, the
meter change will show 000 after you press return. This is because
a meter change always starts a new measure. See the section on
Meter changes and partial measures later in this chapter.

Tempo change events display the duration value for the tempo
marking, i.e. the note value of the basic beat, and the tempo value
itself, as a certain number of beats per minute. Tempo changes can
appear singly, indicating an abrupt change in tempo, or as a series of
events, approximating a smooth increase or decrease in tempo. In
this regard they resemble continuous controller or pitchbend
information. For more information on tempo events, see the Change
Tempo chapter.
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There are two ways to insert Tempo change invents in the Conductor
Track: by directly inserting them, and by recording them while slaved
to Tap tempo synchronization. The following procedures cover direct
insertion and editing in the Conductor Track.

For information on recording a tempo map in real time, refer to the
Tap tempo section in the chapter Receive Sync. Recording in Tap
tempo creates normal tempo events which can be edited as described
below.

Also see the chapter The Graphic Editing Window for information on
editing tempo changes graphically.

To insert a Tempo change event in the Conductor track Event List
window:

1. Press the Insert button in the Event List window title bar.

2. Select Tempo Change from the menu.

A new Tempo change event will appear, with the location field
highlighted for editing.

3. Type in the measure, beat, and tick location and tempo for the
event.

Use the Tab key to move from field to field, and type in the correct
values. Use the mouse to select your choice of beat value.

4. Press the Return key to confirm your choice.

You can cancel the insertion by clicking anywhere else on the
screen.

To edit a Tempo change event in the Conductor track Event List
window:

1. Option-click or double-click on the Tempo change event.

The event will be highlighted.
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2. Change the location or tempo information.

Markers

$ Bridgi

Editing in the
Conductor Track

Use the Tab key to move from field to field, and type in the correct
values. Use the mouse to choose the beat value from the pop up
box.

3. Press the Return key to confirm your edit.

You can cancel the edit by clicking anywhere else on the screen.

Markers are visible in all Event Editing windows, but they may only
be edited in the Conductor track editing windows. Markers cannot be
created directly in the Conductor track editing windows; use the
Markers window to insert or record new markers. In addition, locked
markers cannot be edited in the Conductor track. Unlocked markers
can be edited in the Conductor track with the Edit Menu commands.
For more information on pop-editing markers see The Markers
Window chapter.

The Edit commands Cut, Copy, Paste, Erase, Repeat, Merge, Snip.
Splice, and Shift all function on the events in the Conductor track.
You can use them to move tempo and meter changes together with
other tracks in a sequence, shift tempo maps for precise alignment
with synchronized video or audio, or to repeat tempo, meter, and key
changes in looped sections.

To use the Edit commands on the Conductor track of a sequence:

1. Highlight the Conductor track name in the Tracks window and set
the Start and End times in the Edit bar for the correct region,

OR

2. Open an Event Editing window (Event List or Graphic Editing) for
the Conductor track and highlight the correct events.

3. Select the desired command from the Edit menu.

To use the Edit commands on the Conductor track of a song:

1. Open the Song window.

Do so by double-clicking the Song name in the Chunks window. 
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i 2. Choose Edit Conductor track from the Song window mini-menu.

Using the Edit and View
Filters with the
Conductor Track

The Event Editing window for the song's Conductor track will
appear.

3. Highlight the events you wish to edit.

4. Select the desired command from the Edit window.

The Edit menu commands affect events in the Conductor track in the
same way as normal MIDI data. See the chapter Edit Commands for
more on how to select regions and use these commands.

When a region is cut or copied from the Conductor track, meter and
tempo events representing the current meter and tempo values are
automatically inserted at the beginning of the region in the clipboard.
This guarantees that the region will keep its original meter and tempo
when pasted elsewhere in the sequence or song. These automatically
created meter and tempo change events may be edited normally after
the region is pasted back into the Conductor track.

Note that editing meter changes can cause unexpected results. Read
the section on Meter Changes and Partial Measures below before
editing Meter change events.

To effectively edit events in the Conductor track it is important to
understand how the Edit and View Filters affect the commands on the
Edit menu. Please review the section Setting the Edit Filter in the
chapter Edit Com mauds and the section The View Filterin the chapter
The Event List Window before working extensively with the
Conductor track. Both filters affect the Conductor track the same way
as they do for regular tracks.

Here are some guidelines to remember when using the Edit and View-
Filters:

□ The Edit Filter selects which types of events are edited
from the Tracks window.

■ The View Filter selects which types of events are viewed
and edited in each Event Editing window.
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■ The Edit Filter does not affect editing in the event editing
windows; all visible, highlighted events in an editing
window are affected by the editing commands.

Both filters will affect all Edit commands used in the filters' respective
windows. For example, pasting over existing events will erase only
those types of events selected in the filters; other events are retained
and merged with the pasted data.

The Edit and View Filters are important when editing the Conductor
track because it is common to want to edit just one element, e.g.
tempo changes, without affecting the other events in the track. For
example, the tempo changes in measure two of this sequence can be
moved to measure one using the Edit Filter and Tracks window.

1. Select the Edit Filter from the Edit menu, or press command-F.

Conductor (Seq-P
1111000 4/4 click J)
2111000 6/8 click J.

J= 120.00
213I000 J= 110.00
2I5I000 J= 100.00

&
£

The Edit Filter dialog box appears.
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 A Controllers

 J' Notes  ± Mono pressure O I? Markers
 “ Pitch bend  ±1 Poly pressure S3 Tempo changes
 ’ll Patch/song changes  □ System exclusive CJ'Meter changes

Q Tune request O Key changes
 Mode changes  Loops

2. Option-click the check box for Tempo.

This is a easy way of deselecting everything but Tempo change
events.

3. Highlight the Conductor track in the Tracks window.

4. Set the Edit bar for the correct region.

In this case, the region starts at 2/1/000 and ends at 3/1/000.

5. Select Cut from the Edit menu.

The Tempo changes are removed; the Meter change is unaffected.

6. Change the Edit bar start time to 1/1/000.

7. Select Paste from the Edit Menu.

The Tempo changes appear in the first measure; the Meter
changes are unaffected.
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Meter Changes and
Partial Measures

8. Set the Edit Filter back to normal.

Select it from the Edit menu (or press command-F) and use the Set
All button to check all the boxes.

If the Edit Filter had not been set during this example, the Meter
change in the second measure would have been cut along with the
Tempo changes, and the Meter change in the first measure would
have been erased during the Paste command.

Performer lets you to place a Meter change event anywhere in a
sequence or song. This allows a great deal of flexibility in laying out
your music, but can produce unexpected results. For example, it is
possible to place a Meter change in the middle of a measure, but this
measure will be truncated at the location you specify for the new
meter. This location becomes the downbeat of the first measure in the
new meter.

The following simple rule should help clarify what happens in such
situations:

A Meter change event always starts a new measure.

For example, if the Insert button in the Event List title bar is used to
place a meter at 3111240, when you press the Return key to confirm
the insertion, the meter change location will change to 3111000. This
is because a meter must begin a new measure, and all measures
begin at zero (000) ticks.

588 The Conductor Track



Correcting Unwanted
Partial Measures

Looping and the
Conductor Track

Here's another example: if the Insert button is used to place a 3/4
meter at the third beat of a 4/4 measure, the result is a two beat
measure (still marked as 4/4!) followed by a whole 3/4 measure.
Inserting the Meter change results in a partial measure, that is, a
measure lacking its full duration.

While such partial measures are not always useful, they can be handy­
in lining up cues for film and video work, since they let you start a
measure precisely at a SMPTE time by creating a meter change at the
right spot.

Partial measures may also result from using the Edit commands to
Paste, Merge, or Repeat meter changes in the middle of existing
measures. Once again, each new meter change event will begin a
new measure.

It is important to remember that meter changes only affect the way­
data is displayed; they never affect the MIDI data itself or the way- it
sounds when it is played back. If the meter map for a sequence or
song becomes complex or confusing during editing, simply- erase the
meter changes and re-enter them from the start of the region.

Another way to avoid partial measures is to use the Change Meter
command found in the Change menu. The Change Meter dialog box
will never create partial measures.

The Conductor track cannot be looped. If you need to repeat tempo
or meter changes in a looped region, use the Repeat command from
the Edit menu to make consecutive copies of the Conductor track
over that region.

When using the Memory-cycle feature to play- a section repeatedly,
meter and tempo changes in the conductor track will play- as usual.
When doing so, it is often useful to switch tempo control in the
Metronome panel to the Metronome slider. Doing so temporarily
disables tempo changes so that they- don't complicate recording.
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Chapter 36 The Record Beats Command

The Record Beats command, found in the Change menu, allows you
to record music without listening to a metronome click and then
afterwards realign Performer’s internal beats and barlines with the
music you recorded.

Here’s a simple example. The Graphic Editing window below is the
tune Maty Had a Little Lamb recorded without Performer's
metronome click:

Mary Had a Little Lamb recorded in the Graphic Editing window without using
the metronome click. Notice that the first note is not on beat 1 and that none of

the downbeats in the music match the downbeats in the measure ruler above.

Notice that the music does not line up with the beats and barlines in
the measure I beat I tick ruler. This prevents many useful editing tasks,
such as quantizing and easy region selection.

After using the Record Beats command, Performer’s beats and
barlines have been realigned to match the beats in Mary Had a Little
Lamb:
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Using Record Beats

Mary Had a Little Lamb after using the Record Beats command.

Notice that the beats and barlines in the time ruler now match the

downbeats in the music. Also note that the music plays back exactly

the same way as the original recording (as long as the Tempo

Control in the Metronome is set to the Conductor track).

It is important to note that Performer’s beats have been realigned to
the music, not the other way around. The music plays back in the
same fashion as the original recording. When using Record Beats,
you are in no jeopardy of losing the original feel of your
performance. Performer accomplishes this by creating a tempo map
at the same time as realigning the beats. Thus, Performer’s beats
speed up and slow down to match the original performance.

Once beats and barlines have been realigned, many useful editing
commands can be employed that were not possible beforehand. For
example, the above tune can now be successfully quantized for
rhythmic accuracy and transcription:

After using Record Beats, music can be

quantized, groove quantized, and edited.

To use Record Beats:

1. Record music into a track.

You can play as freely as you like. Pay no attention to Performer's
Counter window. You can even turn off the Metronome click. 
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i 2. Open the Event List window and make note of the time of the first
event.

In the Maty Had a Little Lamb example above, the first note
occurred at 1121115:

,£l -rS' ilk Mary's Lamb (1
112111 5 J' E3 177 164 01158 kr!
112|262 J- D3 151 164 01173 pl
1|2|416 J'CS 145 164 0|188 j
1|3|082 J‘ D3 168 164 OH 70 ___ _______
<1-’1956 J'E3_ 177 nlQ81_______________—J

3. Set the Main Counter to the same time as the first event.

In this example, we enter 1121115 into the main Counter.

4. Choose Record Beats from the Change menu.

The Record Beats dialog box will appear.

The Record Beats Command 593



5. Use the OK is first beat option.

This option means that Performer will place the first downbeat
right at the current counter location, which is 1121115, the
location of the first note in this example.

6. Check the Shift data to option and type in the measure and beat at
which you want to place the first downbeat.

For example, if the first note of music should be at measure 1, beat
4, as a pickup note, type in measure 1, beat 4. Be sure that the
location you choose here is NOT before the sequence start.

7. Get ready to tap any note on your MIDI controller.

Get ready to tap along with the music you played.

8. When you are ready, click OK and begin tapping on the second
beat.

With the OK is first beat option, Performer begins playback and
taps the first beat for you at the starting location of the Counter. In
this example, Performer places the first tap at 1121115. You
should then begin tapping on the second beat. If you miss the
second beat, stop, Undo, and try again.

9. Keep tapping along with the beats in your music as accurately as
you can.

10. When you reach the end of the piece, click Stop.

Performer may take moment to realign the beats and enter the
newly generated tempo data in the Conductor track.

After Performer calculates the changes, the downbeat of your music
will now be at the measure and beat that you indicated with the Shift
data to option. In addition, the Counter will beat in 4/4 time on the
downbeats that you tapped. To change the meter, refer to the section
later in this chapter called Handling Odd Meters.
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Listening to What You
Have Done

Using a Countoff and the
Tap First Beat Option

To listen to the result of your tapping:

1. Choose Conductor track from the tempo control pop-up menu in
the Metronome panel.

Performer will now play back according to the new tempo map in
the Conductor track.

2. Press the Play button.

The music will sound the same, and the metronome and Counter
windows will line up with the music as accurately as you tapped
while Recording Beats.

The Tap first beat option in the Record Beats dialog box allows you
to tap the first beat when you recorded a countoff at the beginning of
your original performance, or a visual cue on film or video at which
to start tapping.

In this case, you have an aural or visual cue before the first tap that
allows you can prepare to hit the first tap accurately.

To use the Tap first beat option:

1. Set the counter to a position several seconds before the first tap.

This will give you enough time to prepare for the first tap. You can
have as much preroll time as you like to get ready for the first
beat.

2. Choose Record Beats and select the Tap first beat option.

3. Click OK to begin Recording Beats.

Performer will begin playing back. Listen carefully to the countoff
or music and get ready for your first tap. Performer will not begin
recording beats until your first tap.

4. Begin tapping on the downbeat where you would like to begin
realigning beats.

5. If you are punching out, click Stop immediately after your last tap.

This prevents music after the punch-out time from being realigned
inadvertently. Performer may take a moment to realign the beats.
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Handling Odd Meters

Handling Pick Up Beats
with the Shift Data To
Option

The Record Beals command realigns your original Performer into a
default meter of 4/4 time. However, if you would like the music to be
expressed in an odd meter or in changing meters, you can do so by
using the Change Meter command after using Record Beats.

For example, let’s say that you would like to bar your music in 6/8
time. After using Record Beats, it will be in 4/4 time. To convert it to
6/8, open the Change Meter dialog box, type in 6/8 as the meter, set
the beat value to a dotted quarter note, choose the measure range
you wish to convert to 6/8, select the Only move barlines option, and
click OK. This will re-bar the music in 6/8 time without changing the
playback of the music. For more information, please refer to the
Change Meter chapter.

Change Meter
Sequence Seq-1

Change meter to

Metronome click
E |J JBJ .fl

From
measure fl I ~l

To
O next measure
O measure) |
® end of sequence

Change

O Realign music automatically
□ Adjust durations .-------  

@ Only move barlines ■

The Shift data to option allows you to determine the placement of the
first downbeat of the re-recorded beats. The most important thing to
remember is this: do not choose a beat that occurs before the Chunk
Start Time. For example, let’s say that your music has two pickup
beats and that you would like the following downbeat to occur at
1111000. Before you use Record Beats, create a pickup measure from
Olli 000 to 1111000 to accommodate the two pickup beats at
0131000 and 0141000.

To create a pickup measure:

1. Click the Start Time button in the main counter to open the Set
Chunk Start dialog box.
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2. Set the Measure Start Time to 0.

If you need two measures of pickup, sei the Measure start time to
-1.

3. Click OK.

Now, when you press Rewind back to the beginning of the sequence,
the Counter window will read 0111000.

Once you have set up measure 0, you can set the Shift data to option
in the Record Beats dialog box to measure 0, beat 3 to accommodate
the two pickup beats in your music, and the first downbeat will occur
at 1111000.

Rprnrri hpatq 1

Recording Beats While
Slaved To Tape

Record Beats may also be used while Performer is slaved SMPTE time
code via Direct Time Lock or MIDI Time Code. This allows you to
freely record music while slaving Performer to film or video without
being concerned with Performer’s metronome. After recording, you
can then line up the beats and barlines afterwards with Record Beats.
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Here are a several important preparations yon will need to make to
Record Beats while slaved to tape:

□ Establish lockup to tape using Direct Time Lock or MIDI
Time Cbr/eand a SMPTE-to-MIDI converter such as Mark of
the Unicorn’s MIDI Time Piece™ or Video Time Piece™.
For more information, consult the chapters called Receive
Sync, Performer and MIDI Time Piece, and Performer and
Video Time Piece.

□ Either before or after you record you r music, make sure the
first downbeat of the music occurs at the veiy beginning of
the sequence and set the SMPTE Chunk Start Time at so the
music starts at the desired SMPTEframe. You can either
record the music this way, or shift the music after
recording. This makes it easy to play the first beat
accurately when you Record Beats.

a Set up a cou ntojf before the sequence start using
Performer’s click so that you can easily record the first
downbeat. To do so, enable Performer’s click and select
Only during Countoff in the Click & Countoff Options
dialog box. To set the number of measures for the
countoff, double-click the Countoff button in the
Consolidated Controls panel.

Once you have made the above preparations, you are ready to record
beats while slaved to tape:

1. Set Performer in Slave to external sync mode.

2. Rewind the tape to several seconds before the Chunk start time.

3. Choose Record Beats from the Change menu.

The Record Beats dialog box will appear.

4. Select the Tap first beat option, but don't click OK yet.

This option means that you will tap the first downbeat (in addition
to all subsequent beats).

5. While the Record Beats dialog box is still open, get ready to tap any
note on your MIDI controller.
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6. When you are ready, roll tape and immediately click OK.

Right after the Record Beats dialog box disappears, Performer's
play button should turn black, indicating that it is slaved to tape.
The Counter will be counting down negative measures before the
sequence start time.

7. Listen for Performer’s countoff and begin tapping on the first
downbeat of the sequence.

8. Keep tapping along with the beats in your music as accurately as
you can.

9. When you reach the end of the piece, click Performer’s Stop
button.

Performer may take moment to realign the beats and enter the
newly generated tempo data in the Conductor track.

Before you listen to the results, be sure that Tempo control in the
Metronome is set to the Conductor track so that the sequence will
play back with the tempo changes generated by the Record Beats
command.
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Chapter 37 Receive Sync

Basics

Basic Types of Sync

The Receive Sync dialog box, found in the Basics menu, allows you
to ‘slave’ Performer to a wide variety of ‘master’ timing sources.
Performer supports all standard MIDI synchronization formats,
including MIDI Time Code and MIDI beat clocks with Song Position
Pointer data for synchronization with drum machines, hardware
sequencers, and other MIDI devices. With an FSK or SMPTE to MIDI
converter such as Mark of the Unicorn’s MIDI Time Piece (MTP),
Performer can synchronize (or ‘sync’) to audio tape, video, or film.
ensuring that events in your sequence happen at exactly the same
spot on tape or film every time. For more information about
synchronizing Performer with the MTP, see the chapter called
Performer and the MIDI Time Piece. Performer also has a unique Tap
tempo feature for synchronizing to prerecorded music, conducting a
sequence as it plays back, or simply recording a tempo map in real
time. For a technical description of Performer's sync formats, see
Appendix A: Synchronization Specifications.

Performer supports all standard modes of synchronization: standard
MIDI beat clocks, Indirect Time Lock. Direct time lock/MIDI Time
Code for SMPTE time code sync, and Tap tempo. These modes are
selected in the Receive Sync dialog box. When Standard beat clocks,
Indirect time lock, or Tap tempo is selected, other parameters appear
in the Receive Sync dialog box and must be set correctly; the Direct
time lock/MIDI Time code mode has no other parameters. The mode
you use depends on the equipment to which you are synchronizing;
the following section describes the common forms of synchronization
and the corresponding modes in Performer.

MIDI Beat Clocks are produced by most MIDI compatible drum
machines and sequencers, and by some synthesizers (particularly
those with built-in sequencers).

MIDI beat clocks are transmitted 24 times a beat. If the master device
changes tempo, the MIDI beat clocks slow down or speed up
accordingly; any slave device will follow this tempo change. Most
devices that generate MIDI beat clocks also send Start, Stop, and
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Continue messages; slave devices will start playback, pause, rewind,
or play from the current location according to the combination of
these messages received. In addition, many devices send Song
Position Pointer data. These messages set the current location for
playback, much like setting the Counter in Performer. To sync
Performer to devices using these MIDI messages, use the Standard
Beat clock mode in the Receive Sync dialog box.

FSK is an audio signal which can be recorded on audio tape. Like
MIDI clock signals, it provides metrical timing information based
upon a certain frequency of oscillations per beat. FSK does not
include any positioning information; when using it, playback must
always begin from the beginning of the signal. If you are using
Performer with an FSK converter, you must rewind the sequence and
the tape each time to sync correctly. Performer does not read FSK
directly, a special device is needed to read the code and convert it to
MIDI clock signals. To sync Performer to FSK converters, use the
standard beat clocks mode in the Receive Sync dialog box.

SMPTE time code is an international standard that was developed for
film and video work but has proven to be very useful in normal audio
work as well. This is an absolute time code, expressing hours,
minutes, seconds and divisions of the second in digital form. It can
be recorded on tape or film and read by a special device to convert
it to MIDI. Since SMPTE has no intrinsic tempo information, the
sequencer or device converting SMPTE to MIDI must generate its
own tempi. Performer’s flexible tempo map and frame time display
make it ideal for work with SMPTE time code. Because of its accuracy
and wide-spread acceptance, SMPTE is the most powerful of the time
code formats. Depending on your converter, you can use the
Standard beat clock, Indirect time lock, or Direct time lock/MIDI
Time Code modes. Direct Time Lock/MIDI Time Code is the easiest
and most accurate mode. Indirect Time Lock, Direct Time Lock, and
MIDI Time Code allow the use of Performer’s tempo maps, and are
far superior to the Standard beat clocks mode.

Tap Tempo is Performer’s real-time tempo control facility. This form of
synchronization slaves Performer to a tap’ entered from your MIDI
controller. Performer receives a MIDI event for each tap and
computes a tempo based on the current meter, the click value, and
each event’s distance in time from the previous event. Any tempo
information in the sequence is ignored while Performer is slaved to
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Standard Beat
Clocks

i Tap tempo. Tap tempo supports both recording and playback, so
your tap can conduct or be recorded into any sequence, empty or
finished. When you record in Tap tempo, each tap becomes a tempo
event in the Conductor Track. Even if you have a minimum MIDI
setup, you have everything you need to use Tap tempo synchroni­
zation.

The following sections describe Performer's sync modes.

This is the standard form of synchronization between two MIDI
devices. When the Standard beat clocks option is selected. Performer
can sync to a master device that is generating MIDI clock signals. If
you want to slave Performer using a drum machine, external
sequencer, FSK converter, or other MIDI device as master, use this
mode. This mode may also be used with a SMPTE converter that
generates its own tempo map. In Standard beat clocks mode,
Performer’s tempo will match that of the master device; Performer’s
tempo features are disabled.

When you select the Standard beat clocks option, the Receive Sync
dialog box looks like this:

Receiue Sync 1

Sync to port: Modem ~s-|
□ Record while still-framed

□ Jambox

Type of sync:

-•-•fO MTC,DTL,or DTLe
....IO Indirect time lock

® Standard beat clocks
O Tap tempo

SMPTE Frame Format:
O 24 fps O 29.97 fps
O 25 fps ® 50 fps

□ Drop frame

O 24 clocks per metronome click
® 24 clocks per quarter note

□ Start on any clock
(no start/continue needed)

□ First clock is time 1
(not time 0)
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Default Settings

Implementations of MIDI have evolved over the years. As a result, not
all devices transmit and send MIDI clock signals in the same way.
Performer provides several options for maximum synchronization
compatibility with your master device:

24 clocks per metronome click/24 clocks per quarter note: Some
manufacturers have begun to make devices which send 24 clock
signals per beat (one click of the device’s metronome) instead of the
standard 24 clocks per quarter note. This new method is very useful
when there are meters which do not use the quarter note as the beat
unit: 3/8, 5/16, etc. In 6/8, for example, there might be a metronome­
click every three eighth notes; in 4/1, the metronome would click
once every whole note. If you were using a less common meter such
as 5/32 or 3/16 + 4/16, using the quarter note as the timing base
would not be very useful. Instead, use the 24 clocks per metronome­
click option.

Start on any clock: When this option is checked, Performer will
automatically start if it receives a time clock even if no start or
continue command was received. This option is necessary when
using some early MIDI devices which don't send start or continue
commands, only timing clocks.

First clock is time 1: When this option is checked. Performer interprets
the first MIDI clock signal it receives as the second timing clock of the
sequence, l/24th of a beat after the beginning. Devices manufactured
recently' send the first clock signal (time 0) after the start command
for the sequence. Some earlier devices assume the start command to
be the first clock signal. The first clock signal they’ send would be 1/
24th of a beat after the beginning. If you are using one of these
devices, you should check this option.

Since manufacturers rarely' explain this aspect in their documentation,
you may not know if your device behaves this way. The best way to
find out is to experiment: set the metronome to the slowest possible-
tempo, play' both devices (with Performer as slave) and listen for
discrepancies in attacks and beat alignment. The difference of l/24th
of a beat is very' audible at a slow tempo. If Performer seems slightly
behind the master device, try checking this option.

The default settings reflect the most commonly used MIDI standards.
It is best to set them this way before choosing to alter them:
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Using Standard Beat
Clocks Mode

□ 24 clocks per quarter note

□ start on any clock: unchecked

a first clock is time 1: unchecked

To put Performer into Standard beat clocks mode:

1. Select Receive Sync from the Basics menu.

2. Choose the port receiving the sync information.

Choose the port from the pop-up menu provided.

3. Click on the Standard Beat clocks button.

4. Choose between 24 clocks per metronome click or per quarter
note.

5. Select the timing options you want by checking their check boxes.

Selecting the Start on any clock will cause Performer to
automatically start upon receipt of any clock signals. Selecting the
First clock is time 1 option will interpret the Start signal as the first
timing clock.

6. Press OK to confirm your choice or Cancel to cancel it.

To slave Performer to an external source transmitting MIDI beat
clocks:

1. select Slave to External Sync from the Basics menu.

This puts Performer into slave mode, waiting for sync information
from an external device.

2. Click on the Play or Record button in the main transport controls.

The Play button will flash on and off, meaning that Performer is
waiting for sync information to start.

3. To start Performer, start the external device.

When Performer is locked and playing, the Play button will turn
to solid black. Once locked, Performer will follow, start, stop and
rewind under control of the master.
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4. To terminate the lock up with the master, click on the Stop button.

Indirect Time
Lock

Clicking on the Stop button will both stop Performer and remove
it from the master's control. This can be done at any time. To
return to normal operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

Indirect time lock allows Performer to lock to time code (such as
SMPTE) using standard MIDI clock signals. This requires a specific
method of setting your SMPTE to MIDI converter. Indirect time lock
works as follows: First, a steady tempo (60 BPM) and a starting
SMPTE frame are set in the SMPTE to MIDI converter. The converter
reads the time code and generates MIDI clock signals at the specified
tempo. Performer reads these clock signals and computes SMPTE
frame locations based upon the constant MIDI beat clocks it receives:
the original SMPTE frame times are regenerated by Performer.

To use Indirect time lock, you must set the converter to a constant
tempo of 60 beats per minute and pick a starting frame that is before
the point at which you want playback to start. The starting frame for
the converter should be at least 10 seconds before the start of the
sequence and no more than 45 minutes before the end of the
sequence, the exact time is not important.

The starting frame time must be entered into Performer. It is
important to set exactly the same frame time in Performer and your
converter, as all subsequent frame times are computed from this
starting time. For best results, use a round number to start from such
as 1:28:00:00. This will reduce the chances of rounding errors in the
converter. Once locked up, Performer follows the tempo map you’ve
programmed for the sequence. Also upon lockup, if Click is enabled,
Performer will click in the meter specified at 1111000 or will default
to 4/4.

Due to the limitations of the MIDI song position message, Performer
can only locate over a 45 minute range in this mode. If you try to
work on a longer piece, Performer will not be able to lock to it after
45 minutes.
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To put Performer into Indirect time lock:

1. Set the starting frame number on your converter.

Make sure that this time is at least 10 seconds before the start of
the sequence and not more than 45 minutes before the end of the
sequence.

2. Choose Receive Sync from the Basics menu.

A dialog box appears.

3. Choose the port receiving the sync information.

4. Click on the button next to “Indirect time lock”.

Type of sync:

MTC, DTL, or DTLe
....I® Indirect time lock

O Standard beat clocks
O Tap tempo

SMPTE to MIDI converter must
be set to 60 beats per minute.

Converter start frame:
| 0:00:00:001

□ Start on any clock
(no start/continue needed)

□ First clock is time 1
(not time 0)

SMPTE Frame Format:
O 24 fps O 29.97 fps
O 25 fps © 30 fps

□ Drop frame

5. Set the converter start frame time.

This must match the frame number you set in the converter.

6. Set the timing options if necessary by checking their check boxes.

If your converter outputs non-standard timing information, you
may need to check the Start on any clock and/or First clock is time
1 options. See the Standard beat clocks section above for an
explanation of these.

7. Press OK to confirm your choices or Cancel to cancel them.

8. Set the SMPTE frame format.

All standard SMPTE frame rates are provided, including 29.97
Drop and 29.97 non-drop. The Drop frame check box is available
only when the 29.97 frame rate option is selected.
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9. Set the start time for the counter, if necessary.

Click the Start Time button in the counter and enter the start time
in the dialog box provided.

The counter start time is different from the starting frame number you
entered in the converter and the Receive sync dialog box: it is the
time that Performer will display as the starting time when the
sequence begins. The time you enter should be later than the one
you set on your conversion unit or external device (a few seconds, at
least): Performer will take this amount of time to ‘'chase” the correct
frame number to lock with it.

10. Select External Sync from the Basics menu.

This puts Performer into slave mode, waiting for sync information
from an external device.

11. Click on the Play or Record button in the main transport controls.

The Play button will turn grey, meaning that Performer is waiting
for sync information to start.

12.To start Performer, start the external device.

When Performer is locked and playing, the Play button will turn
to solid black. Once locked. Performer will follow, start, stop and
rewind under control of the master. Also upon lockup, if Click is
enabled, Performer will click in the meter specified at 1111000 or
will default to 4/4.

13.To terminate the lock up with the master, click on the Stop button.

Clicking on the Stop button will both stop Performer and remove
it from the master’s control. This can be done at any time. To
return to normal operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

Don't confuse the counter’s start time with the converter starting time.
The converter starting time is an arbitrary number that is necessary for
Performer to calculate frame numbers from the MIDI clock signals it
receives. The sequence starting time, set with the Start Time button in
the Counter, is the time at which the sequence will actually begin
playing.
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Slaving to
SMPTE with
MTC, DTL, or
DTLe

Use this mode when you are slaving Performer to SMPTE time code
via a converter that supports one of these formats. The SMPTE time
code is fed from a master source such as a audio tape recorder, video
tape recorder, or SMPTE generator into a SMPTE-to-MIDI converter
such as a MIDI Time Piece II, which translates the SMPTE into MIDI
timing information. This MIDI timing information can be produced in
one three popular formats: Direct time lock (DTL), Direct time lock
enhanced (DTLe), and MIDI time code (MTC). There are only slight
differences between these three MIDI timing formats. For the most
part, they produce identical results. The differences are discussed
later in this chapter.

MTC/DTL/DTLe sync mode is the simplest and most direct way to
slave Performer to an external source generating SMPTE time code.
Performer is able to lock to the frame times of the master, insuring
precise synchronization between devices. To use this mode, you
must have a SMPTE to MIDI converter that supports at least one of
these three sync formats, such as a MIDI Time Piece or MIDI Express
SMPTE/MIDI interfaces from Mark of the Unicorn.

There are no special options to select in the Receive Sync dialog box:
when in MTC/DTL/DTLe mode, Performer simply responds to timing
data directly.

Once Performer is locked to the master, there is no need to use
Performer’s main transport controls unless you wish to record.
Performer will start, stop and locate under control of the master. Also
upon lockup, if Click is enabled. Performer will click in the meter
specified at 1111000 or will default to 4/4.

You can put Performer into play or record either before or after you
start rolling tape. In either case, Performer will lock up quickly.

To put Performer into MTC/DTL/DTLe lock up:

1. Choose Receive Sync from the Basics menu.

A dialog box will appear.

2. Specify the port to receive sync information.

3. Choose the MTC/DTL/DTLe option as the “Type of sync” by
clicking its button.
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Type of sync:

MTC, DTL, or DTL<?
<O Indirect time lock
O Standard beat clocks
O Tap tempo

SMPTE Frame Format:
O 24 fps O 29.97 fps
O 25 fps © 30 fps

□ Drop frame

4. Set the SMPTE frame format.

All standard SMPTE frame rates are provided, including 29-97
Drop and 29-97 non-drop. The Drop frame check box is available
only when the 29-97 frame rate option is selected.

5. Click OK to confirm the Receive Sync settings.

6. Set the sequence starting frame.

Click the Start Time button in the Main Counter.

7. Select Slave to External Sync from the Basics menu.

This puts Performer into slave mode, waiting for sync information
from an external device.

8. Click on the Play or Record button in the main transport controls.

The Play button will begin to blink, meaning that Performer is
waiting for sync information to start.

9. To start Performer, start the external device.

When Performer is locked and playing, the Play button will turn
to solid black. Once locked, Performer will follow, start, stop and
rewind under control of the master. Also upon lockup, if Click is
enabled, Performer will click in the meter specified at 1111000 or
will default to 4/4.
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10.To  terminate the lock up with the master, click on the Stop button.

Comparing MTC
and DTLe

Comparing DTL
and DTLe

Tap Tempo

Clicking on the Stop button will both stop Performer and remove
it from the master’s control. This can be done at any time. To
return to normal operation, turn off Slave to External Sync by
reselecting it from the Basics menu.

Like Direct Time Lock enhanced, MIDI Time Code is a simple and
direct way to slave Performer to an external source reading SMPTE
time code. In fact, the only difference between MIDI Time Code and
Direct Time Lock enhanced is that MIDI Time Code uses tiro bytes  for
each quarter-frame message, where DTLe uses only one. Performer
supports MIDI Time Code because it was added to the MIDI
specification. However, Performer, along with most SMPTE-to-MIDI
converters, provides Direct Time Lock as a more efficient alternative.

Which mode should you use? We recommend Direct Time Lock
enhanced because of its higher efficiency. If your converter does not
support Direct Time Lock enhanced, then you will need to use MIDI
Time Code.

The procedure for using MIDI Time Code is exactly the same as the
procedure for Direct Time Lock enhanced. See the previous section
in this chapter for detailed information.

Direct time lock (DTL), when it was first introduced, had only one
frame-advance message per SMPTE frame. A year or so later, Direct
time lock enhanced (DTLe) was developed. It consists of four
quarter-frame advance messages per frame, as well as a full-frame
message once per second; these enhancements produce the highest
degree of SMPTE sync accuracy currently available with MIDI.

MTC and DTLe both have a higher timing resolution than DTL. If your
converter supports DTL instead of DTLe, you may want to use MTC
instead in order to take advantage of its timing higher resolution.

Tap tempo is Performer’s real-time tempo control feature. Tap tempo
lets you slave Performer to a tap entered from any MIDI controller
before, during, or after the recording of your sequence. You can
‘conduct’ an existing sequence by tapping the tempo, complete with 
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Using Tap Tempo Mode

accelerandos, ritards, and rubato passages; Performer will follow
precisely. More importantly, yon can record your tap into the
Conductor Track for use in subsequent playback and recording.

Tap tempo can be used during virtually any stage in the creation of a
sequence. For example, if you have acoustic music on tape, two
completed tracks in Performer, and three more Performer tracks to
record, you can ‘teach’ the two existing tracks to follow the
prerecorded music. Your remaining tracks will be recorded into a
sequence that has all of the temporal nuances of the prerecorded
music.

The following are general points to consider when preparing to use
Tap tempo sync.

Establish a meter. When slaving to Tap tempo, Performer must know
how many of your taps to group as one measure. Before recording or
playing back a passage in Tap tempo mode, make sure you’ve
entered the correct meter(s) using the Change Meter command in the
Change menu.

Establish a metronome click value. Your taps correspond to the
current metronome click value, specified using the Change Meter
command from the Change menu. For example, the tempo of a 4/4
passage can be tapped and expressed in whole notes, one tap per
measure, or in sixteenth notes, sixteen taps per measure. Each tap
becomes a tempo change event, so the smaller the click value, the
higher the resolution of the resulting tempo map. However, tempo
events in very small increments will fill up your Conductor Track —
and your supply of RAM — fairly quickly. Choose a click value that
will give your tempo map high enough resolution but not generate
too much data to be recorded at one time.

Choose a tap source. You can use any standard MIDI event as your
tap source. Performer will interpret this MIDI event as a tap whenever
it occurs on the specified input channel. If you plan to record music
while slaved to Tap tempo, choose a combination of MIDI event and
channel that won’t be needed in the musical passage. For example,
let's say you’re tapping C3 on a controller keyboard, transmitting on
Modem channel 1. The result? Any other C3’s transmitted on the same 
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channel will not be recorded. Again, this is only true for C3’s
transmitted on Modem channel 1. C3’s transmitted on other channels
will be recorded normally.

Note that although pitch bend and controller events are acceptable as
tap sources, the most common controls for sending them (wheels,
joysticks) make reproduction of a single, specific value difficult. For
example, to define your tap you enter a pitch bend value of 392 using
a pitch bend wheel. To slave Performer, you’ll need to generate
values of 392 or higher — you send a 392 value by going precisely to
it, but also by going past it. That much is easy, but remember that
Performer will treat only the events with 392 values as taps. All other
values sent by your mod wheel will be recorded and interpreted as
normal pitch bend events. This makes bend and controller events less
practical tap choices than events with precise triggers or more limited
values, such as a note or a Controller #64 (sustain pedal) event.

To use Tap tempo:

1. Ensure that you’ve established the correct meter(s) and
metronome click value(s) for the sequence.

Use the Change Meter command in the Change menu. See the
chapter Change Meter for more information on establishing
meters.

2. Choose Receive Sync from the Basics menu.

The Receive Sync dialog box appears.

3. Select the port that will receive the tap.

4. Click on the radio button next to “Tap tempo”.

The right side of the box displays the Tap tempo parameters MIDI
heat input data and Sync countoffbeats.
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Type of sync:

-•-•fO MTC, DTL, or DTLe
.... IO Indirect time lock

O Standard beat clocks
® Tap tempo

MIDI beat input data:

Source: 01V r|

Event: |«fC5 i |

Sync countoff beats: |4

Sync recorded tempo to:
® Internal clock
O External time code

□ Capture start time

5. Choose the MIDI device you will be tapping from in the pop-up
menu provided.

6. Specify the MIDI event you wish to use as a tap.

Tab to the Event box or click in it, then enter a MIDI event from
any MIDI controller connected to the specified port (play a note,
tap a sustain pedal, etc.). The event appears, highlighted; click on
the highlighted event if you wish to change it. You can use any
standard MIDI event as a tap source.

7. Specify the number of times you wish to tap as a countoff.

The default number of sync countoffbeats is four, but the countoff
can be any number between 1 and 127. If you enter a number
outside this range, the Macintosh will beep (or the menu bar will
flash) when you click the OK button and the number will be
highlighted. If this happens, click on the highlighted value and
enter a new one.

8. Click OK to confirm your choices or Cancel to cancel them.

9. Choose Slave to External Sync from the Basics menu.

This puts Performer in slave mode; it is now waiting for sync
information from an external source.

10. If you wish to record the tap into your sequence, record-enable the
Conductor Track.

Activate the Tracks window by clicking once on it. then click on
the Conductor Track’s Record-Enable button. Your tap will be
stored as tempo change events in the Conductor Track and used
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in subsequent playback and recording. Existing tempo changes
will be replaced. Other Conductor track information will be
unaffected.

11. If you wish to record music into your sequence, record-enable the
desired track(s).

If you wish to record the tapped tempo and music simultaneously,
or record music onto more than one track, choose Multi-Record
from the Tracks window mini-menu. Specify the record device for
each track that is record-enabled. The Conductor Track will record
from the device specified in the Receive Sync dialog box.

12. Press the Play or Record button in the main transport controls.

The Play button will flash, meaning that Performer is waiting to
receive sync information. Overdub mode will not function on the
Conductor Track; that is, recording in either normal or overdub
mode will erase any existing tempo events.

13. If you will be tapping along with a prerecorded passage, start
playback of the recording.

Ideally, the prerecorded music will have a sufficient countoff so
that you can tap the number of countoff beats specified in the
Receive Sync dialog box.

14. Begin ‘tapping’the MIDI event that you designated in the Receive
Sync dialog box.

Performer will listen for the specified number of countoff beats to
predetermine the tempo for the beginning of playback or
recording. When Performer has received the countoff, playback or
recording will begin.

15.Tap  the desired tempo and tempo changes.

Make your tap as expressive and dynamic as you wish; Performer
will follow. The Counter display will update as you tap.
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16.To end recording or playback, press the Stop button in the main
transport controls.

Don’t be alarmed if the Macintosh wristwatch icon remains
onscreen for an extended period of time after you stop recording.
Performer is calculating precise tempo changes from the taps you
just recorded.

17.Take Performer out of slave mode by choosing Slave to External
Sync from the Basics menu.

18. If you recorded your tap, you can hear the results by rewinding the
sequence, making sure the metronome under Conductor track
tempo control, and pressing Play.

Your sequence will play back using the tempofs) that you tapped.
If you are not satisfied with the results, you can use the Undo
Record command in the Edit menu and then repeat the above
process. You can make adjustments by rerecording certain
sections and by editing individual tempo changes in one of the
Conductor Track’s Event Editing windows.

Tapping to Prerecorded
Music on Tape

You can use Tap Tempo to record a tempo map while Performer is
slaved to tape—or, more accurately, referenced to external time code.
You can record a tempo map that matches the music on tape,
allowing you to perfectly synchronize your sequence to the
prerecorded music. This process is explained in detail in the chapter
called Tap Tempo While Slaved to Tape.

Hints for Using Tap
Tempo

Recording music simultaneously. If you plan to record music simulta­
neously with your tap, choose a tap event that doesn't require use of
your hands. Controller #64, sustain, is usually triggered by a foot
pedal and is a good choice for a tap because it has only two values:
On or Off.

Further, Performer will let you use either value for your tap.

Using alternative tap values and sources. You can set the tap as an Off
value for a particular note or controller:

1. In the Receive Sync dialog box with Tap tempo chosen, Tab to the
Event box.
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2. Depress the note or controller, leaving it depressed.

For example, push a modulation wheel away from its ‘zero’
location. The controller number and its value will appear in the
box, highlighted.

3. Without releasing the note or pedal, click on the highlighted Event
value.

4. Release the note or pedal.

To continue the example, let the mod wheel spring back to its
zero location. The Event box will show Off or 0 as the tap value.

So far, our examples of using Tap tempo have involved tapping a
MIDI instrument to ‘teach’ Performer the temporal details of a
sequence. When you tap, you simply send a MIDI event and
Performer does the rest. This means you can use any MIDI sequencer
to load its own tempo map into Performer — just program the
sequencer to play a song’s worth of quarter notes while Performer is
slaved to Tap tempo sync.

Yet another way of sending Performer a tap is to use a device that
converts an audio click into a MIDI event. A click or other regular,
amplified signal (a click track on tape, a miced rim shot, etc.) can be
fed into such a device and converted into MIDI events from which
Performer can generate a tempo map.

Punching In a tempo. Auto-Record can be used with Tap tempo to
‘punch in’ tempo changes for a section while preserving the tempi
outside that section. Enter the punch In and Out times in the Auto­
Record bar, found in the Consolidated Controls panel, click on the
Auto-Record button, then follow the applicable steps above. (Don’t
be alarmed if both the Play and Record buttons go grey at first; the
Play button is waiting for sync information, and the Record button is
waiting for the Counter to reach the punch In location.)

Remember also that slaving Performer to Tap tempo disables the
sequence’s existing tempo map. So when you start playback in Auto­
Record mode, even though Performer will only record taps from the
In location to just before the Out location, you will have to tap
throughout the pass. Give yourself the most accurate temporal
‘context’ — the tempi before and after the punch-in passage — as is 
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Record While
Still-framed

Multi-track
Audio
Recording

Synchronizing with
SMPTE

possible, so that the recorded section will fit smoothly into the rest of
the sequence. As always, you can fine-tune all tempo change events
in the Conductor Track.

The Receive Sync dialog box has an option called Record while still­
framed. Without this option checked, Performer drops out of record
as soon as you stop the tape after a record pass while slaved to tape;
Performer will not record again until you press the Record button.
This prevents unintentional recording while cueing and accidental
loss of Undo Record. When this option is checked, Performer stays in
record when you stop the tape so that you can record a hit while
parked on a frame. This is particularly useful when frame-advancing
using VITC and the Video Time Piece, which provides accurate
frame-advancing. Unless you are recording while frame-advancing.
we recommend that you leave this option unchecked.

Let’s look at an example which illustrates a number of techniques you
may find useful in the recording studio.

You are recording a five minute song in the studio. You’ve
preproduced the drum and synthesizer track with Performer. Now
you want to record guitar and vocal tracks using live players. You
plan to use a synchronization code conversion box (a converter) to
translate audio synchronization code recorded on tape into MIDI
timing data. Let’s start by assuming you are using a SMPTE/MIDI
converter, then discuss what you will have to do differently if you are
using an FSK conversion box.

The first thing you should do when you get to the studio is to “stripe”
(i.e. record) one track of your multi-track tape with an audio sync
signal. For this example, let’s assume you are using SMPTE time code.
Start striping the tape at time 0:59:00:00. We recommend that you use
30 frames per second, non-drop-frame code, unless you have a
specific reason to use one of the other frame rates. Continue for at
least 7 minutes; you should always have at least a minute of time
code on the tape prior to the start of your song, and you should
record plenty of extra time code at the end in case you decide to
lengthen the song at some point. Many people stripe the whole reel
straight out of the box with one continuous time code track. Striping
may take some time; get it started first thing upon arriving at the
studio, so that it will be finished by the time you get everything else
set up for recording.
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Now, set up Performer to play in sync with the multi-track. Feed the
time code from the tape into your SMPTE to MIDI converter. Connect
the converter to the Macintosh; some converters connect directly,
others have a MIDI Out which must go to the MIDI In of an interface
connected to the Macintosh. If you have a MIDI Time Piece (ID or
MIDI Express, no additional connections are necessary beyond the
normal one to the modem (or printer) port.

If your converter supports Direct time lock, Direct time lock
enhanced, or MIDI Time Code, set the appropriate mode on the
converter (to lock to SMPTE). Select Receive Sync... from the Basics
menu. Choose the correct port {Sync to port. ) and MTC, DTL, orDTLe
{Type of sync:). OK the dialog box.

Otherwise, you should use Indirect lime lock. Set the converter to
generate a constant tempo of 60 beats per minute, and have it start at
0:59:00:00. Select Receive Sync... from the Basics menu. Choose the
correct port {Sync to port:) and Indirect time lock {Type of sync:). For
Converter start frame: enter 0:59:00:00 (the same time that you set the
converter to). You won’t need to check either of the other options
unless your converter is non-standard. See the Synchronization
section for more information on these options.

Let’s start the song at time 1:00:00:00 on the tape (this is a minute after
the start of the time code). Click the Start Time button in the Counter.
Enter 1:00:00:00 + 0 time code bits for the frame time. Set the other
values as you wish. OK the dialog box.

Set the frame rate correctly in Performer in the Receive Sync dialog
box. Choose the correct frame rate; use 30 frames per second unless
you have a specific reason to use another format.

Check the Slave to External Sync entry in the Basics menu. Press the
play button in the motion controls; it will turn grey. At this point,
Performer should be slaved to the tape. Display frame time in the
counter window, and roll the tape from before the time code. Make
sure Performer starts, stops, and follows the tape when you wind
through the tape.

For overdubbing, you need to provide your players with a reference
mix of the song. You can have Performer sync live to the tape and
send the players a cue mix. Or, you might find it easier to just place
a scratch mix on one or two of the tracks of the multi-track. That way,
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you won't have to worry' about Performer while recording. If your
session is spread out over several dates, putting a scratch mix on the
tape will save you having to set up your computer and synthesizers
every time.

When you get to the final mix, you have two choices. You can mix
from Performer playing slaved to the tape. This provides the ultimate
in sound quality, as the synthesizers are first recorded on the master
tape. On the other hand, you may wish to record each synthesizer
part on a separate track of the multi-track. This has several benefits.
Since the tracks are recorded one at a time, each track can use all of
your synths to create a sound. Blending several synthesizers together
often creates a more full-bodied sound than you could otherwise
achieve. Also, if you have limited outboard effects gear, you can
record each track with effects, allowing you to reuse what equipment
you have.

When recording a single part to tape, we recommend you turn off the
play-enable buttons in the tracks window for all tracks except the one
you are recording. When you do this, Performer completely ignores
the other tracks, letting it concentrate all of the computer’s processing
power on playing one part. If you use the Solo button instead,
Performer will scan the other parts while playing. If you have dense,
complicated music, or lots of continuous data, this may cause the
Macintosh to become bogged down during playback.

When recording each part separately, you can slide individual parts
slightly ahead or behind to compensate for delays in your
synthesizers, or the specific sounds. For example, string parts often
need to be attacked ahead of the beat in order to sound on the beat.

With sampling synthesizers, you may find that some sounds have as
much as 100 milliseconds of “dead air" at the beginning of the
sample, which results in that much delay between turning the note
on and hearing any sound.

To slide a part, just adjust the start time relative to the start time the
other parts were recorded with. For example, if you did have a
sample with 100 milliseconds of dead air at the start, you could set
the start time to 0:59:59:27 + 0 time code bits. That’s 3 frames ahead 
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of the other parts, and at 30 frames per second, 3 frames is 1/lOth of
a second, or 100 milliseconds. Your sample’s audible attack times will
now be aligned with those of the other parts.

It’s best to slide parts by ear — just keep trying different start times
until the part seems most lined up.

Synchronizing with FSK If you are using an FSK converter in the above example, you can
proceed in a very similar fashion.

When striping the tape, you must usually feed the converter with
MIDI beat clock information. This information is recorded more or
less directly onto the tape. When the tape is played back through the
converter, you should receive exactly the same MIDI beat clock
information.

When synchronizing to an FSK converter, Performer follows the
tempo recorded onto the tape; Performer’s internal tempo map is
disabled.

The FSK converter usually sends out a carrier tone when it is not
receiving MIDI beat clock information. You should record a minute
or so of this carrier tone prior to starting Performer.

When synchronizing to tape, you must use the Standard beat clocks
mode to receive synchronization. Remember that the tempo is
already recorded on the tape.

When using FSK, you must always begin playing the tape from the
beginning; FSK code does not encode any position information on
the tape.

Hints When locking to external SMPTE synchronization, you can shift parts
forward and backward in time to compensate for the numerous time
delays in a complex system (each device used in a MIDI path
introduces at least 2 milliseconds of delay) or to adjust for envelope
delays in certain synthesizer patches (such as strings or any other
slow-attack patch).

Receive Sync 621



Setting a Countoff
Before Sequence Start
While Slaved to Tape

Syncing to SMPTE with
the Studio 5™

When recording in external sync, the Record button is turned off
every' time the master device stops or rewinds. This is a safety
precaution, to prevent accidental erasure of previously recorded data.
To record in external sync, start the master device, wait for Performer
to lock up, and then press the record button.

Many' new digital effects devices, like reverbs, delays, equalizers, and
even mixers, allow MIDI control. By using Performer with a time
code converter to sync to your multi-track tape recorder, you can
automate effects changes and other aspects of mixing accurately' and
flexibly. Read cue points from Performer’s counter, or use the Record
Hits feature in the Markers window to find locations to insert patch
changes and controller information to control your MIDI devices.
Alternatively, use the sliders, switches and pedals of your controller
key'board or MIDI mixer to record y'our mix in real time, then use
Performer’s editing features to correct any problems.

If you are working in a studio situation where you need a countoff
before the beginning of the sequence while slaved to tape, here is
how you can set up the Performer’s countoff feature:

1. Choose a Click Option in the Click & Countoff Options dialog box
that will enable the click during Performer’s countoff.

For example, choose the Always Click option or the Only during
countoff option.

2. Set the number of measures you would like for the Countoff.

Do so by double-clicking the Countoff button and typing in the
number of measures.

3. Make sure that the Click is enabled.

The Click item on the Basics menu must be checked.

If you now rewind well before the sequence start time and roll the
tape, Performer, as it counts down, will begin the countoff at the
appropriate number of measures before the downbeat of the first
measure.

In general, we recommend using Direct Time Lock Enhanced (DTLe)
to lock Performer to SMPTE time code. If you are using an Opcode
Studio 5, however, use MIDI Time Code (MTC) instead. Just set up 
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the Studio 5 to generate MTC instead of DTLe. In Performer, no
change is needed because Performer uses the same settings for either
type of time code. For other hardware interfaces, including the
Opcode Studio 4, we recommend using Direct Time Lock Enhanced.
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Chapter 38 Transmit Sync

Basics

The Transmit Sync dialog box, available from the Basics menu, allows
you to configure Performer as a master time source. When being used
as a master, Performer sends synchronization signals to which other
MIDI devices can slave. Performer generates standard MIDI beat
clocks; devices which do not recognize MIDI beat clocks require a
converter to the appropriate type of synchronization information. For
more information on synchronization, see the Receive Sync chapter
and Appendix A: Synchronization Specifications.

You may use Performer as a master of some devices while Performer
itself is slaved to another device. This is especially useful when
slaving Performer to SMPTE time code; Performer (slaved to the tape)
can generate tempos for other sequencers slaved to Performer.

When Transmit Sync is selected for one or both of the serial ports.
Performer becomes a master time source: any compatible MIDI
devices connected to Performer will follow Performer’s tempo
changes, and start or stop along with the program. If the slave devices
respond to MIDI Song Position Pointer data, then they will also
follow Performer when the Counter location is changed or the
Rewind button and Position bar are used.

Performer can transmit sync information in two ways: it can simply
pass on (or echo) any sync messages it receives, or it can generate
new sync information based upon its own tempo map and controls
These options are described below:

Echo received sync: This option echoes synchronization information
which is received. No processing is performed. The reception port
must be selected in the Receive Sync dialog box, and Performer must
be in External Sync mode for sync to be echoed. Sync is echoed to
the ports selected in the Transmit Sync dialog box. There is less delay
between reception and re-transmission using this mode than if
Generate MIDI heat clocks is selected.
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Using Transmit Sync

Use this inode if you wish to slave Performer and another device to
a master which generates MIDI beat clocks. I lowever, for best results,
you should use a MIDI thru box and connect both Performer and the
other slave directly to the master. Echoing sync through Performer
results in a small delay.

Generate MIDI beat clocks: Performer generates MIDI beat clocks in
tandem with the other MIDI information being played back. Use this
mode when Performer is the master. You may also find this mode
useful when slaving Performer to SMPTE using one of the time lock
modes. Performer will generate MIDI beat clocks according to its
tempo map in sync with the SMPTE code, so you can slave a
sequencer or device that doesn’t support SMPTE through Performer.

To set Performer to transmit sync information:

1. Choose Transmit Sync from the Basics menu.

A dialog box appears.

Transmit sync via port(s):

Modem

O Echo received sync
® Generate midi beat clocks

O 24 clocks per metronome click
® 24 clocks per quarter note

C First clock is time 1
(not time 0)

2. Select the Macintosh ports that you wish Performer to send sync
information over.

If neither port is selected, Performer will not generate or echo
sync information. If you are not slaving external devices to
Performer, setting the ports option to none improves performance.

626 Transmit Sync



3. Choose between echoing and generating sync information.

24 clocks per
metronome click/24
clocks per quarter note

First clock is time 1

Click on the corresponding radio button.

4. Set any necessary options.

If you are using Generate MIDI beat clocks, set the options 24
clocks per metronome click/24 clocks per quarter note and First
dock is time I as necessary. These options have no effect when
echoing received sync.

Performer is now set to transmit sync information. If your slave
devices are set up correctly, they will start, stop, rewind, and play in
time with Performer.

Generally, you must put the slave device in an external sync mode
before it will respond to Performer’s transmissions. Consult the
owner’s manual for the device to determine the exact procedure. The
mode may be called external clock, MIDI sync, MIDI clock, etc.

Some MIDI devices expect 24 clock signals per beat (one click of the
device’s metronome) instead of the standard 24 clocks per quarter
note. This method is very useful when there are meters which do not
use the quarter note as the beat unit: 3/8, 5/16, etc. In 6/8, for
example, there might be a metronome click every three eighth notes;
in 4/1, the metronome would click once every whole note. If you
were using a less common meter such as 5/32 or 3/16 + 4/16, using
the quarter note as the timing base is not very useful. Instead, use this
option to make the metronome click value the timing base.

When this option is checked, Performer interprets the first MIDI clock
signal it sends as the second timing clock of the sequence, 1/2-ith of
a beat after the beginning. Recently manufactured devices expect to
receive the first clock signal (time 0) after the start command for the
sequence. Some earlier devices assume the start command to be the
first clock signal; the first clock signal would thus be l/24th of a beat
after the beginning. If you are using one of these older devices, you
should check this option.
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Chapter 39 Using MIDI Machine Control

MIDI Machine Control (MMC) is a recent and significant addition to
the original MIDI specification. MMC consists of an extensive set of
system exclusive commands that allow multiple recording devices to
be remotely controlled from a single source. MMC expands
Performer's ability to serve as “a recording studio at your fingertips’’
by allowing you to control the transport and recording functions of
your recording hardware entirely from within Performer.

This chapter explains how to use Performer with hardware devices
that support the MIDI Machine Control (MMC) specification, such as:

□ The Alesis ADAT™ digital multitrack recorder (with the
BRC or other MMC interface)

□ The Akai DR4d™ digital hard disk recording system (with
the additional card necessary for MMC)

Performer serves as a computer-based front end for MMC devices,
causing them to play, stop, rewind, and otherwise follow Performer’s
transport control functions. In addition, you can record-enable tracks
on a MMC device remotely from within Performer (for MMC devices
that support this capability).

As you begin working with Performer and your MMC
gear, keep the following in mind. Performer provides
features that are supported by most MMC devices.
However, not all MMC devices support every' feature
explained here. In addition, there can be slight
variations in the way each device handles MMC that
cause it to behave differently than described. Try' to
familiarize yourself as much as possible with the
features your device supports via MMC. Also, check
for “Read Me” files in your Performer folder and
update note booklets that accompany your Performer
manual; they may include further information about
specific devices.
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Setting up MMC
hardware

MIDI Machine Control requires two-way MIDI communication
between Performer and the MMC device. Performer sends control
commands (in the form of system exclusive messages) to the MMC
hardware, and the MMC hardware sends SMPTE time code back to
Performer.

Some MMC devices can generate SMPTE time code in the form of
MIDI Time Code (MTC). (Some MMC devices support other forms of
MIDI timing information as well, including standard MIDI beat
clocks, Direct Time Lock, and Direct Time Lock Enhanced.) Other
devices generate SMPTE time code in the form of longitudinal time
code (LTC), an audio signal that must be converted to MIDI Time
Code by way of a SMPTE-to-MIDI converter such as the MIDI Time
Piece II. These two hardware setups are shown below.

■OUTIN
MMC DeviceMIDI Interface

OUT" IN
MIDI cablesWllWWlfej

Serial cable

Figure 39-1: If the MMC device can generate MIDI Time Code (MTC), the MIDI connections
shown here are all that are necessary. Be sure the MIDI interface internally routes the MTC to the
Macintosh.

MIDI Interface IN

with SMPTE converter
I OUT'

SMPTE time code
MIDI cable

MMC Device
IN

SMPTE time code
IN OUT

§ Audio cable l!

Figure 39-2: If the MMC device generates SMPTE Time Code, connect its time code output to a
SMPTE-to-MIDI converter like the MIDI Time Piece II as shown here, which converts it to MTC.
Route the resulting MTC to the computer.
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Connecting multiple
MMC devices

in il.

Open-loop versus
closed-loop systems

Setting up
Performer

If you have more than one piece of MMC gear, decide which one will
be the time code master. Hook up the master device as shown in
either Figure 39-1 or Figure 39-2 (whichever is required by the
device), and then feed the time code from the master device to the
other MMC devices in your setup. Doing so establishes one time code
source, which keeps all devices (and Performer) in sync with one
another. Connect the remaining devices to your MIDI interface as
shown below.

Serial cable

The hardware setups shown in Figure 39-1 and Figure 39-2 support
open-loop MMC configurations. Performer does not currently support
closed-loop MMC communication. Closed-loop communication is not
necessary for accurate synchronization between Performer and MMC
hardware.

Setting up Performer for MMC is simple. All you need to do is create
a MMC device in your FreeMIDI setup.

1. Open the FreeMIDI Setup Application.

If you are currently running Performer, click the FreeMIDI button
in the Control Panel, or choose Edit FreeMIDI Configuration from
the Basics menu. Otherwise, double-click the FreeMIDI Setup icon
in the Macintosh Finder. The FreeMIDI Setup application launches
and your current studio configuration appears.

2. If the MMC device already exists in your FreeMIDI configuration,
double-click it. If not, add it using the Create Device command in
the Configuration menu.

The FreeMIDI Device Specification window appears.
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3. In the Device Specification window, make sure that “MIDI Machine”
Device Property is checked in the Device Properties pop-up menu
as shown below, as well as the “Receives MTC” and “Transmits
MTC” properties.

If any of these items are not checked, select them to check them.

FreeMIDI Deuice Specification

Name:
(0-126)

Properties:
Transmits MTC

BBC

Does not play notes

Controller
Receiues Clock

/Receiues MTC
Transmits Clock

'/Transmits MTC
-/MIDI Machine

General MIDI
Bank Select Ctrl 0
Bank Select Ctrl 32
Does not accept prog changes

Sampler
Drum Machine
Effects Unit
Miner

Model:
v~| | RDAT

Transmit Channels:
1 2 3 4 5

Manufacturer:
| Rlesis

Receiue Cha
12 3 4 5

I* i I in

Deuice ID: 0

4. Make sure that the Device ID setting correctly matches the setting
in the device itself.

<■ If you used FreeMIDI’s Auto Config feature to
automatically detect the MMC device, the ID setting is
already correct. The device ID setting is important
because if it is not correct, the MMC device will not
respond to Performer.

5. If you are creating the FreeMIDI device for the first time, set the rest
of the device information as needed.
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6. Click OK.

7. Make sure that both the MIDI IN and MIDI OUT ports of the MMC
device are connected to the MIDI interface.

If not, connect them by dragging a patch cord from the MIDI
interface port to the device icon. For more information, see
"Connecting Devices to Interfaces" on page 696.

The presence of a MMC device in the MIDI configuration activates the
MMC features in Performer.
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Activating MMC
in Performer

The MIDI Machine
Control window

Each MMC device that you have defined in your FreeMIDI setup
appears in Performer's MIDI Machine Control window, which can be
opened from the Windows menu.

The area at the top of the window contains several important buttons
MMC-related controls.

The MMC master button
The MMC master button activates all of Performer’s MMC features. To
activate these MMC features, click the arrow button between the
computer and tape deck icon at the top of the window. When this
button is on, MMC is activated. In addition, Performer is placed in
Slave to External Sync mode. For more information about external
sync mode, see “Setting Performer's Receive Sync options" on
page 638.
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The Record mode pop-up menu
The Record mode pop-up menu has three modes: Safe, rehearse, and
record.

b Safe: no recording can occur in any MMC device

□ Rehearse: this mode depends on the MMC device. Usually,
it causes the device to act as if it is recording, punching in,
punching out, etc. but no recording actually occurs.

■*' Make sure that your deck supports rehearse mode
before attempting to use this record feature. If it
doesn’t, rehearse mode may actually record.

□ Record: allows recording on the currently record-enabled
track(s) for any MMC device. To actually record, press the
record button in Performer’s main transport controls.

Preroll
When this option is checked, MIDI Machine Control devices get cued
to 5 seconds before the location you specify with Performer’s
transport functions. Click the preroll value in the box to change it
(1-99 seconds).

Preroll saves you the trouble of figuring out preroll time in your head.
Preroll lets you cue Performer to musically intuitive locations or hit
points while giving the hardware and Performer enough time to fully
synchronize by the time they reach the cue location you chose.

Auto Record Advance
When the Auto Record Advance button is checked, Performer will
automatically record-enable the next higher track (or set of tracks for
stereo recording) during Memory-cycle recording. As Performer loops
the same section over and over, each pass is recorded on a new track
(or set of tracks), preserving all previous takes. For example, when
you begin cycle-recording, you could record a section on track 1. The
second time around the loop, Performer releases track 1 and record­
enables track 2, and the second pass gets recorded on track 2. The
third time around, Performer record-enables track 3, and the third
pass gets recorded there. Performer will continue to record-enable
the next track until it records on the highest available track.
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Make absolutely sure that the consecutive tracks in line
for recording do not have material on them that you
wish to keep.

When this check box is unchecked, the same track (or tracks) remain
record-enabled until you change them manually by clicking the
record-enable buttons in the MIDI Machine Control window.

The Auto Record Advance option requires the following preparations
in Performer:

1. Memory-cycle must be enabled.

2. Auto-Record must be enabled.

3. The Record mode popup in the MIDI Machine Control
window must be set to Record mode. (It does not advance
in Safe or Rehearse mode.)

4. Performer must punch-in at some point before cycling
back to the beginning of the Memory-cycle loop.

Setting up each MMC
device

The MIDI Machine Control window provides a list of MMC devices in
your FreeMIDI Setup. Any connected device that has the MIDI
Machine device property assigned to it appears in this window.
Several settings are provided for each device.

Device name and icon
The name and icon of the device comes from its name in your
FreeMIDI studio configuration. You can change the name using the
FreeMIDI Setup application. To change the icon, see “Editing
FreeMIDI Icons” on page 759-

Bringing a MMC device on line
When the On line button is selected, the device is on line, which
means that it will respond to Performer’s transport control
commands. When a device is off line, it will not respond to
Performer.

Specifying the number of tracks
The Set number of tracks... mini-menu command sets the number of
tracks that the MMC device has. Keep in mind that in some situations,
a single device in Performer's MIDI Machine Control window actually
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represents several physical devices. For example, an Alesis BRC may
be connected to several ADAT’s, each with 8 tracks. In this example,
you’d want to include the tracks for all of the ADAT’s. Be sure to set
the number of tracks accordingly.

Setting a timecode track
The timecode track option in the Set number of tracks command lets
you specify one of the tracks as a timecode track. The timecode track
becomes record-protected, and it cannot be record-enabled by the
arrow keys (discussed below) or Auto Record Advance. You can
record-enable the timecode track manually by clicking it. but a
warning appears to confirm that you would like to do so.

Changing the order of the devices in the window
To change the order of the devices in the window, drag the panels
up or down.

Ejecting a tape
Th Eject mini-menu command ejects the tape from the currently
selected MIDI Machine Control device in the list. To select a device,
click its name. The device must be on line and the master MIDI
Machine Control button must be active for this to work.

Keyboard shortcuts for record-enabling tracks
Option-click a track to record-enable it and at the same time turn off
all other record-enabled tracks. Command-click a track to turn it off
and record-enable all others.

User the up and down arrow keys to record-enable the next or
previous track. This works with adjacent pairs as well.
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Setting Performer’s
Receive Sync options

Selecting a MMC device in the MMC window
To select a device, click its name.

While controlling external MMC devices, Performer actually slaves to
time code generated by the MMC hardware to remain synchronized
with the hardware during playback and recording, as explained in the
diagram below.

Performer sends play, stop, rewind,

and other transport commands to the

MMC hardware (in the form of MIDI

system exclusive messages).
MMC Device

During playback and recording, the

MMC devices sends MIDI time code

back to Performer to keep Performer

in sync with the hardware.

Figure 39-3: When Performer controls the transport functions of MMC hardware,
Performer simultaneously slaves to time code from the MMC hardware.

Performer governs the transport control functions, and the MMC
device serves as the master timing source to keep them synchronized.

As a result, when you activate MMC control in Performer, Performer
is automatically placed in Slave to external sync mode, in which
Performer slaves to external time code. To successfully slave
Performer to the time code, make sure that the settings in Performer's
Receive Sync command in the Basics menu match the time code
being generated by the MMC master device. For complete
information on the Receive Sync dialog settings, see “Slaving to
SMPTE with MTC, DTL, or DTLe” on page 609.

638 Using MIDI Machine Control



Figure 39-4: Make sure that Performer’s Receive Sync dialog box settings
(Basics menu) match the time code generated by the master MMC device.

Setting Performer’s
SMPTE start time (offset)

Using Performer’s
transports to control
MMC devices

Because MMC control involves SMPTE synchronization, be sure to set
Performer’s SMPTE start time (SMPTE offset) to a value that is
appropriate for the time code being generated by the MMC device.
To set the start time, click the start time button in the main counter,
or select Set Chunk Start from the Chunks window mini-menu. For
more information, see “Setting the start time” on page 90.

Once you activate MMC and set up each device as described in the
previous sections, Performer will shuttle the transport controls on
each on-line MMC device in sync with Performer’s own transport
controls. For example, when you press play, stop, and rewind in
Performer’s main transport control panel, each MMC device will do
the same.

All of Performer’s transport control functions are supported. For
example, if you use Memory-cycle to loop over a region, the MMC
device will follow. Keep in mind, however, that Performer’s transport
functions are virtually instantaneous, whereas MMC hardware devices
are mechanical devices that take time to cue. As a result, Performer 
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Recording into
Performer while using
MMC

will stop and wait at times when the MMC device is cueing to a new
location. The longer the cue time, the longer the wait will be. Once
the MMC device has finished cueing. Performer will resume at the
same time as the MMC device.

Transport features that are supported include:

h Play

H StOp

□ Rewind

□ Pause

□ Record

□ Auto-punch in/out

Cueing functions include the following:

q Typing a time into the Main Counter

□ Using Fast-forward and rewind cueing buttons below the
main transports

■ Clicking a marker in the Markers window’

b Double-clicking in any time ruler

a Memory bar features such as Auto-stop, Auto-rewind,
Memory-cycle

b Dragging the scrolling wiper

All of these functions behave normally, except for the waiting period
mentioned above.

Once you have set up MMC in Performer as described in this chapter,
you can record MIDI data into Performer in the usual fashion (as
described in chapter 9, “Recording"). Record-enable a MIDI track in
Performer’s track list, press record, and play your controller. All of
Performer’s MIDI recording features work normally, including Multi­
record, Auto punch-in, etc. Since Performer is slaved to the external
MMC device, there may be an occasional w’ait during cueing.
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Using Performer to
record a track on a MMC
device

To record to a track on a MMC device:

1. Make sure that the device you wish to record on is on line in the
MIDI Machine Control window.

If not, click the Off Line button to bring it on line.

2. Choose either Record or Rehearse from the pop-up menu in the
MIDI Machine Control window.

For details about Rehearse mode, see “The Record mode pop-up
menu” on page 635.

3. Record-enable one or more tracks on the device by clicking the
appropriate track button(s) in the MIDI Machine Control window.

Note: some devices do not support remote record­
enabling. If so, record-enable the track directly on the
device.

Until you actually begin recording, the record-enable button
flashes. When you begin recording, it becomes solid.

Record -enable buttons

4. If you would like to loop a section to record several passes, click
the Memory-cycle button in the Main Control Panel and set the
Start and End points in the Track Overview.

For information about using Memory-cycle, see “The Memory­
cycle button” on page 71.
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Memory-cycle button

5. If you are going to loop a section with Memory-cycle as described
in the previous step, and you would like to record each pass on a
new track to preserve each take, check the Auto Record Advance
box in the MIDI Machine Controls window.

For details, see “Auto Record Advance” on page 635. Make sure
that Auto-record and Memory-cycle are enabled. Also, make sure
that the record mode pop-up menu in the MIDI Machine Control
window is set to Record mode. Auto Record Advances doesn’t
work in Rehearse or Safe mode.

6. If you would like to set punch-in and punch-out points, click
Performer’s Auto Punch-in button below the main transports, and
set the punch-in and out times in the Memory bar

You can even set punch locations while looping a section with
Memory-cycle. In Performer the punch location can be set
independently from the loop points. If you want, you can set the
in and out times on the fly by clicking the In and Out buttons in
the Memory bar during playback. For more information, see “The
Auto-Record button” on page 76.
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7. To begin recording, cue Performer’s main counter to a point that is
at least 5 seconds before the punch-in point, or set the pre-roll time
in the MIDI Machine Control window to at least 5 seconds.

The amount of pre-roll depends on the device; some may require
longer.

8. Press Performer’s record button.

9. Record at the punch in location.

10. Press stop to end recording.
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Chapter 40 Using Performer with the MIDI
Time Piece™

About this chapter This chapter discusses how Performer and the MIDI Time Piece
(MTP) and MIDI Time Piece II (MTP ID work together. This chapter
also applies to the MIDI Express and multi-port interfaces from other
manufacturers, such as Opcode’s Studio 5.

Performer relies on FreeMIDI to identify what type of interface is
connected to the Macintosh. FreeMIDI automatically figures out what
is connected. If a MIDI Time Piece, MIDI Time Piece II, MIDI Express,
Studio 5, or other similar interface is present, several important
features are automatically enabled in Performer. The sections below
refer to features that are fully documented in other chapters of this
manual, such as the MIDI Monitor window. You may want to review
these chapters as you read this one; this will help you understand
how Performer works with the MIDI Time Piece.

The MIDI Time Piece, MIDI Time piece II, and MIDI Express can
each be thought of as four MIDI devices wrapped into a single rack­
space unit. Each one is:

■ an 8 IN/8 OUT MIDI interface (4 IN/6 OUT in the MIDI
Express)

■ a MIDI patch bay with routing, channelizing, and muting

■ a SMPTE-to-MIDI synchronizer

■ a SMPTE time code (LTC) generator

Performer has three features that support them:

■ high data transfer rate with FAST mode (not available with
the MIDI Express)

■ 128 MIDI channels through data cablization (96 channels
with the MIDI Express)

■ Improved SMPTE synchronization with Enhanced Direct
Time Lock™
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High data transfer rate
with FAST mode

128 MIDI channels via 8
independent cables

Improved SMPTE sync
with Enhanced Direct
Time Lock™

When Performer and the MIDI Time Piece are set to FAST mode, they
communicate two to four times faster than a regular interface running
at I Megahertz. As a result, they sustain greater data throughput to all
8 MIDI OUT cables on the MTP. Fast mode also alleviates irregular
timing problems that occur when too much data is being transmitted,
commonly referred to as “MIDI logjam."

The MIDI Time Piece is unique because it offers eight independent
MIDI INs and MIDI OUTs. Independent means that each cable
handles its own, separate set of 16 MIDI channels. Eight cables,
multiplied by 16 MIDI channels each, equals 128 separate MIDI
channels. Performer provides access to all 8 cables and all 128
channels. In addition, up to four MTPs can be networked together for
a total of 512 MIDI channels.

The MIDI Express provides 96 MIDI channels (6 outputs times 16
channels each).

In either case, the primary benefit is that you'll never have to worry
about overlapping MIDI channels—MIDI channels that are being
used by more than one MIDI device at a time. Each device has its
own channels, so you’ll never have a conflict.

Another benefit is that both the MIDI IN and MIDI OUT of each
device can be connected at all times, allowing easy access to and
from the instrument. This is especially useful when using a editor/
librarian software such as Mark of the Unicorn’s Unisyn™.

Enhanced Direct Time Lock (DTLe) is an improved form of the DTL
supported in earlier versions of Performer. Instead of one frame
advance message per SMPTE frame, DTLe consists of four frame
advances per frame. In addition, DTL’s tape position (full frame)
message has been expanded to include the frame rate of the SMPTE
and an identification of which device in an MTP network is sending
the DTLe.

To fully support DTLe, the MIDI Time Piece sends a tape position
message approximately once every second. This prevents even the
slightest amount of drift due to small dropouts or other inconsis­
tencies in the SMPTE time code.
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Synchronizing to
SMPTE with DTLe

Locking the MTP to
SMPTE

When used with Performer, the MIDI Time Piece provides the most
reliable SMPTE-to-MIDI lockup available. In addition, DTLe allows
Performer to establish lockup without stopping the tape transport.
While the film or video tape is rolling, you can press Performer’s Play
button and the program will jump right into sync with the tape.

Enhanced Direct Time Lock™ (DTLe) is an improved form of DTL
supported by earlier versions of Performer. The following sections
provide a brief overview of how to sync Performer to SMPTE time
code via DTLe and the MIDI Time Piece. If you are not already
familiar with the synchronizing process, please refer to the chapter in
the MIDI Time Piece user’s manual called Working with SMPTE.

The principal benefits of DTLe are: 1) you are less likely to have
problems such as dropouts, drifting, etc. and 2) lockup can be
achieved while the tape continues rolling. You no longer have to stop
the tape to reestablish lockup.

Performer still supports old DTL if you are using an original DTL
converter. The procedure for using original DTL is the same as for
DTLe.

To lock the MTP to SMPTE, connect an audio out from the tape deck
to the AUDIO IN jack on the rear panel of the MTP. In the MTP Desk
Accessory (MTP DA) MIDI Sync window, choose the DTLe option,
and make sure that DTLe is being routed to the Macintosh.

To verify lockup, open the SMPTE Reader window from the MTP
software and roll the tape. The SMPTE Reader should begin to roll.
Lockup is indicated on the MTP by the LTC/LOCK light (LED) on the
front panel, which glows steadily as long as the MTP is locked. In
addition, the POWER/TACEI (tachometer) LED flashes regularly once
per second. If the LEDs flicker erratically, the MIDI Time Piece is not
locking up consistently. Try boosting or attenuating the SMPTE
output from the tape deck.
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Using the MIDI Monitor
to check incoming DTLe

Locking Performer to
the MTP

Troubleshooting

To verify that Performer is receiving the incoming DTLe properly, use
the MIDI Monitor window. When DTLe is being received, the RT light
turns dark (due to the four F8 bytes being received each frame):

■=^3 Rt

The real-time data light (“Rt") lights up

when Performer is successfully receiv­

ing DTLe.

Once the MTP has been successfully locked to tape, and you have
verified that it is sending DTLe to Performer, lockup is easy. Choose
MTC/DTL/DTLe in the Receive Sync dialog box, set a start time in the
counter with the Start Time button, choose Slave to External Sync,
press Play (or Record), and roll the tape. You can press stop at any­
time and reestablish lockup by pressing Play again, even while the
tape is rolling.

If you have trouble establishing lockup, refer to the MIDI Time Piece
manual SMPTE chapter for detailed, step-by-step instructions. Also
refer to “Slaving to SMPTE with MTC, DTL, or DTLe" on page 609-

If you continue to have problems, check out the troubleshooting
chapter at the end of the MTP manual. It discusses solutions to
common synchronization problems.
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Chapter 41 Performer & the Video Time Piece

Setting Up
Performer

The Video Time Piece is Mark of the Unicorn's affordable SMPTE/
VITC/MIDI time code converter and character generator. VITC
{VerticalInterval Time Code') is SMPTE time code that is recorded
directly in the video signal, freeing up both audio tracks and allowing
lockup to be maintained while freeze-framing or frame-advancing the
video.

Performer supports many of the Video Time Piece’s unique features.
With the Performer/Video Time Piece combination you can:

n Lock Performer to VITC and remain in sync while frame
advancing

□ Download Markers as streamers to the video display

□ Display a Conductor Crawl Line that displays the hit point
of each downbeat in the sequence

□ Convert an audio click track into a Performer tempo map
in the Conductor track

□ Prevent dropouts during tape sync with adjustable
freewheeling

To set up Performer for the Video Time Piece, you need to add the
Video Time Piece to your FreeMIDI configuration using the FreeMIDI
setup application. If Performer is currently running, you can launch
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FreeMIDI setup by choosing Edit FreeMIDI Configuration from the
Basics menu. Choose Create Device from the Configuration menu
and set up the options as needed.

Locking
Performer to
VITC

When you have a Video Time Piece in your FreeMIDI configuration
as shown above, special features for the Video Time Piece are
automatically enabled in Performer; they are discussed in this
chapter.

Once you have installed the Video Time Piece, you can lock
Performer to video that has been recorded with VITC or LTC.

Before attempting lockup to VITC, it is a good idea to make sure that
the Video Time Piece is successfully converting the VITC into MIDI
sync and transmitting the sync data to Performer and the Macintosh.
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Verifying Incoming Time
Code with the MIDI
Monitor

To verify incoming time code from the Video Time Piece:

1. Open the Video Time Piece desk accessory and open the Convert
SMPTE window.

□ Convert SMPTE

SMPTE Source:
OLTC
© VITC
O MTC/DTL
O first available

□ Don't Convert

Freewheel | 4 [frames

SMPTE to MIDI format:
O MTC
©DTL

2. Choose the VITC option and the DTL (Direct Time Lock) option.

Alternately, you can use MTC (MIDI Time Code) option.

3. Roll the Video tape.

When the VITC LOCK light on the Video Time Piece indicates that
lockup has been achieved, the COMPUTER OUT LED should
begin to glow, indicating that the Video Time Piece is sending DTL
(or MTC) to the Macintosh and Performer.

4. Open Performer’s MIDI Monitor window.

If you are using Direct Time Lock enhanced, the “Rt” light on the
port to which the VTP is connected will turn black. In addition.
the Co light on the Video Time Piece panel will blink regularly if
DTLe is being successfully received by Performer.

The Co light will turn black if you are using MTC.

Performer & the Video Time Piece 651



Locking Up Performer

Recording Hits While
Frame Advancing

You can now lock up Performer, even while the video tape is still
rolling:

1. Choose the MTC/DTL/DTLe timecode option in Performer’s
Receive Sync dialog box.

Be sure to match the same type of sync that the Video Time Piece
is sending.

2. Enable the Record while still-framed option in the Receive Sync
dialog box.

This causes Performer to remain in record when you are frame­
advancing.

3. Choose Slave to external sync from the Basics menu.

This puts Performer into slave mode.

4. Press the Play or Record buttons.

You can do so even while the tape is rolling. Performer will
immediately lock to the tape. If necessary, you may have to stop
and adjust the start time in the Counter. (Click the Start Time
button to do so.)

To record hits while frame-advancing:

1. Freeze the video image.

Performer will also stop at the frozen video SMPTE frame.

2. Choose Add from the Markers window mini-menu or play a MIDI
event into the currently record-enabled track.

The new marker will be added to the list at the current tape
location. If the Markers window isn’t already open, press stop.
open it, and press play again.

3. Advance to the next hit using your VCR’s frame-advance button.

Performer will follow along.
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4. Repeat the above two steps as many times as necessary.

When you are through, you can rename each marker and lock it
to its SMPTE time.

Using Streamers

Performer remains in sync during freeze-frame because the VCR tape­
heads keep spinning—even when the tape is stopped. Thus, they
continually scan the video image (and the VITO. The Video Time
Piece, in turn, remains locked to the frozen image as it is being
continually scanned and sends periodic tape position messages to
Performer to let Performer know where the current tape location is.
You can see these periodic tape position messages as brief flashes on
the COMPUTER OUT LED on the Video Time Piece. To record notes,
you must have the Record while still-framed option checked in the
Receive Sync dialog box.

The Markers window has an additional capability designed for the
Video Time Piece’s character generator. The Video Time Piece can
superimpose graphic images on a video picture, including streamers.
A streamer is a solid white bar that travels across a video screen from
left to right to reach the right-hand side of the screen at an exact hit
point. Streamers help studio musicians and sound effects engineers to
anticipate hit points during video post-production.

Performer’s markers have the ability to serve as triggers for streamers
generated by the Video Time Piece. Here is how it works: while
Performer is slaved to the video via SMPTE time code and the Video
Time Piece, it sends a message to the Video Time Piece several
seconds before playback reaches the marker location. This message
tells the Video Time Piece the name of the marker and its exact
location. To warn the viewer of the approaching hit point, the Video
Time Piece immediately displays the name of the marker on screen
for several seconds before the streamer. The Video Time Piece then
displays a moving streamer for the marker such that the streamer hits
the right side of the screen at rhe exact SMPTE frame location of the
marker.
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Enabling Streamers

Streamer Hints

Displaying the
Conductor
Crawl Line

To enable streamers in Performer, cheek the "Generate VTP
Streamers" mini-menu command. Then you will see the Streamers
column next to the marker names in the Markers window:
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VTP Streamers

To enable a streamer for a marker, click in the Streamer column next
to the marker name and the streamer icon will appear. The marker
will then appear as a streamer on the Video Time Piece's video
picture. If you option-click, the marker will be assigned a streamer
and all others will not. Conversely, if you command-click, all markers
except the one you click will be assigned a streamer.

Remember that marker names are displayed onscreen for
approximately 3 seconds before the streamer. If your markers are
closer than 3 seconds to one another, they may overlap onscreen: that
is, the name of the second marker may be displayed before the first
marker’s streamer.

When the Video Time Piece displays the name of the marker, it
displays up to 20 characters. Names longer than 20 characters will be
cut off. So, you may want to keep your marker names as short as
possible.

Together, Performer and the Video Time Piece have the ability to
display a crawl line on the video screen. A crawl line is a series of
white “blips” that travel across the video screen from right to left,
striking the left-hand side of the screen in time with each beat of
music in the Performer sequence. The Conductor Crawl Line is useful
lor lining up downbeats in your Performer sequence with hit points
on the video.
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Performer triggers each beat in die Conductor Crawl line when the
Click feature in the Basics menu is enabled. To set up the click
feature:

1. Choose Click & Countoff Options from the Basics menu.

If you do not want to hear the click, uncheck both the Internal
speaker and MIDI options.

2. If you do want to hear the click, check the option you would like
and, if necessary, enter the data for the MIDI click.

Choose the Always click option.

3. Click OK to confirm your choices.

4. Select Click from the Basics menu to enable the click.

The Click menu item will become checked.

To display the Conductor Crawl line:

1. Choose Video Time Piece from the Apple menu to open the VTP
DA.

2. Choose Video Setup from the VTP menu.

The Video Setup window will appear.
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3. Check the Conductor option.

Converting a
Click Track into
a Tempo Map

Verifying Incoming MIDI
Clicks with the MIDI
Monitor

You cun choose a clear or black background for it, and you can
adjust its position on the video screen by dragging the crawl line
display up or down in the Video Setup window.

4. To turn off the Conductor Crawl Line, simply uncheck the option or
turn off Performer’s click.

With the Video Time Piece, you can convert an audio click track into
a MIDI event. This allows you to convert the click track into a tempo
map in a Performer sequence’s Conductor track. You can even record
the tempo map while Performer’s time base is referenced to SMPTE
time code, allowing you to accurately synchronize a Performer
sequence to prerecorded music.

Before attempting to convert the click track into a tempo map, make
sure that the Video Time Piece is successfully converting the audio
click into MIDI data and transmitting the data to Performer and the
Macintosh.

To verify incoming MIDI clicks from the Video Time Piece:

1. Make sure that an audio cable is plugged into the CLICK IN phone
jack on the rear panel of the Video Time Piece.

2. Choose Video Time Piece from the Apple menu to open the VTP
DA.

3. Choose Set Click to MIDI from the VTP menu.

The Click to MIDI dialog box will appear.

Convert click to: Click data:

MIDI Click is ® On
Oort
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Setting Up Tap Tempo

; 4. Choose the MIDI data type and parameters for the MIDI click.

Most of the time, any event will do, such as a note like C3.

5. Click OK to Confirm your choice.

6. Roll the tape.

When the CLICK light on the Video Time Piece indicates that the
click is being received, the COMPUTER OUT LED should begin to
blink, indicating that the Video Time Piece is sending the MIDI
click event to the Macintosh and Performer.

7. Open Performer’s MIDI Monitor window.

8. A channel light (and cable light with the MTP) will flash if the MIDI
click is being successfully received by Performer.

If none of the channel lights flash, check your connections and try
again.

The next step is to set up the Tap Tempo options in the Receive Sync
dialog box.

1. Choose Receive Sync from the Basics menu and select the Tap
Tempo option.

2. Choose Video Time Piece from the device pop-up menu.

3. Press the tab key to move to the Event parameter and play in the
MIDI click event by simply rolling the tape.

Since you have already successfully set up the MIDI click in the
previous section, as soon as you roll the tape, Performer will
receive the MIDI click event from the Video Time Piece and enter
the proper value in the Event box.

4. Type in the number of countoff beats.

Be sure to type in the same number of countoff beats as there are
on the click track on tape.

5. If you do not need to synchronize the sequence containing the
resulting tempo map to the tape with the audio click track, choose
the Internal clock option.
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6. If, later on, you will be synchronizing the sequencing containing
the resulting tempo map to the tape with the audio click track,
choose the External time code option and check the Capture start
time box.

These options tell Performer to reference your clicks to time code
while it is recording the tempo map. By doing so, Performer will
then be able to accurately synchronize the resulting tempo map
with the tape.

7. Click OK to confirm your choices.

Checking Tap Tempo Before recording anything, check to make sure Performer will follow
the MIDI clicks sent by the Video Time Piece.

1. Choose Slave to external sync from the Basics menu.

2. Press the Play button.

3. Roll the tape.

After a few bars or so of countoff click, the sequence will begin to
play back, following the clicks on tape. If not, check the MIDI
Monitor window to make sure Performer is receiving the MIDI
click. Also check the Tap Tempo options in the Receive Sync
dialog.

4. Stop the tape and rewind it to the beginning of the cue.

You are now ready to record the tempo map.

Recording the Tempo
Map

If you will be synchronizing the sequence containing the new tempo
map to the click track using SMPTE time code, make sure that you:

■ already have SMPTE time code recorded on one track and
the click recorded on another

■ already have Performer and the Video Time Piece set up
for SMPTE synchronization such that when you roll the
tape, Performer is receiving hath the MIDI click and Direct
Time Lock (or MIDI Time Code) at the same time

■ have selected the External time code and Capture start
time options in the Receive Sync dialog box
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Please note: if you want to be able to synchronize the
sequence to the click track via SMPTE, it is absolutely
necessary that Performer is receiving both the MIDI
click and either DTL or MTC when you record the
tempo map.

To record the tempo map:

1. Record-enable the Conductor track in the Tracks window.

2. Press the Record button in the main transport controls.

3. Roll the tape.

If you chose the Capture start time option and are referenced to
time code, Performer will remember the exact SMPTE frame of the
tap that is the first downbeat and automatically remember to start
the sequence at that SMPTE frame when you lock the sequence to
SMPTE afterwards.

4. When you are finished recording, stop the tape.

Performer may take a few moments to process the new tempo
data.

Locking the Recorded
Tempo Map to Tape

Preventing Dropouts
While Slaved to SMPTE

You now have a new tempo map the matches the click track on tape.

If you recorded the tempo map referenced to time code, you can
now lock the sequence to tape. Just choose the Direct Time Lock (or
MIDI Time Code) option in the Receive Sync dialog box, make sure
the Metronome is under Conductor track tempo control, and roll the
tape. The Capture start time option automatically sets the Chunk
SMPTE start time, so the first downbeat of the sequence should occur
at exactly the first click downbeat (not including countoff beats, of
course).

The Video Time Piece has an adjustable freewheeling feature. When
a SMPTE reader such as the Video Time Piece encounters a drop-out
—a series of missing or unreadable frames—in the SMPTE time code,
it “freewheels” past them, pretending that they were not missing and
briefly generating its own code to make up for the missing frames.
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Most converters will freewheel for only up to 3 or 4 frames. The
Video Time Piece can freewheel from 0 frames up to 127 frames (over
4 seconds). This allows it to maintain lockup with Performer over
even the most pernicious SMI’TE drop outs.

If you encounter a time code drop out while slaving Performer to
tape with the Video Time Piece, try7 increasing the freewheel amount
in the Convert SMPTE window. The default value is 4 frames. Try'
adding a few frames at a time when adjusting the amount.
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Chapter 42 Tap Tempo While Slaved To Tape

Tapping to Prerecorded
Music on Tape

Yem can use Tap Tempo to record a tempo map while Performer is
slaved to tape—or, more accurately, referenced to external time code.
You can record a tempo map that matches the music on tape,
allowing you to synchronize your sequence to the prerecorded
music.

This process can be performed in a more precise fashion if you have
an audio click track recorded on the tape and a click-to-MIDI
converter such as Mark of the Unicorn’s Video Time Piece™. For
more information, please refer to the chapter called Performer and
the Video Time Piece.

The following are general points to consider before tapping tempo to
prerecorded music:

Before you begin, establish SMPTE synchronization to tape. This is
necessary for two reasons: 1) Performer needs to receive a timing
reference from the tape while creating the tap tempo map. and 2)
later on, after you successfully record the tempo map, you will be
using the SMPTE to lock the sequence to the tape. To establish
SMPTE synchronization, simply sync Perlormer to the tape in the
fashion that you normally do with Direct Time Lock (DTD. Direct
Time Lock Enhanced (DTLe) or MIDI Time Code (MTC). If you have
never synchronized Performer to SMPTE, now is a good time review
the Receive Sync chapter. (Please note that you must synchronize to
tape via MIDI Time Code or Enhanced Direct Time Lock.)

Once you have set up SMPTE sync, set up Tap Tempo. To do so, simply
follow the directions in the Receive Sync chapter called Setting Ip Tap
Tempo. Test it to be sure that when you tap, Performer does indeed
follow your taps. This will ensure that you have the proper channel
and event for Tap Tempo mode. Remember, you may also need to set
up a meter map in the sequence that matches the meter map of the
music on tape.
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Tapping Tempo While
Referenced to Tape

If possible, set up two full measures of countoff on the tape before the
fust downbeat of music. This will be extremely helpful to your
accuracy when tapping the first downbeat, which is the most
important downbeat because all subsequent taps—the entire tempo
map—will be referenced to its exact location.

Once you have made these preparations, you are ready to begin. To
lap Tempo to prerecorded music on tape:

Sync to port: Modem v~|
□ Record while still-framed

F| Jambox

1. Open the Receive Sync dialog box from the Basics menu.

Type of sync:

iiiifO MTC, DTL, or DTLa
<0 Indirect time lock
O Standard beat clocks
® Tap tempo

SMPTE Frame Format:
O 24 fps O 29.97 fps
O 25 fps ® 30 fps

□ Drop frame

MIDI beat input data:

Source: 01 \t t |

Event: |^C3 i |

Sync countoff beats: |4

Sync recorded tempo to:
® Internal clock
O External time code

□ Capture start time

2. Set the Sync to port option to the port that will be receiving the
SMPTE sync data from tape.

For example, if your SMPTE-to-MIDI converter is sending
Enhanced Direct Time Lock to the modem port, select the modem
port. (If the converter does not send Direct Time Lock or Direct
Time Lock enhanced, use MIDI Time Code instead.)

3. Select the Tap Tempo option.

The tap event can be received from any controller device on either
serial port.
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4. Type in a number of countoff beats.

Be sure that the number of countoff beats you choose here
corresponds in a useful way to the number of countoff beats on
tape. For example, ideally, you should have 2 measures of
countoff on tape; if so, set the countoff beats here to 1 measure.
When you roll the tape, you can get ready during the first bar of
countoff, tap along for the second bar, and hit the downbeat right
on the money. If you don't have an countoff on the tape, you will
have to develop a system that works best for you. You might try
just one countoff beat.

5. Enter the beat input data.

6. Select the External time code option.

Performer will now reference your taps to incoming DTL. DTLe,
or MTC.

7. Select the Capture start time option.

This option makes Performer remember the exact SMPTE frame of
your first tap (excluding the countoff beats) so the sequence will
start at the correct SMPTE time.

8. Click OK to confirm your choices and close the dialog box.

9. Record-enable the Conductor Track.

10. Choose Slave to External Sync from the Basics menu.

11. Press the Record button in the main transport controls.

12. Get ready to tap, and roll the tape.

13. Listen for the countoff, and ‘tap’ along with it such that the first
downbeat of the sequence corresponds to the first downbeat of
music on tape.

Performer automatically remembers the exact SMPTE time of your
tap on the first downbeat of the sequence and saves it as the
Chunk start lime. When you later slave the sequence to tape.
Performer will automatically start the sequence at the correct
SMPTE time.
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14.Tap along with the music as accurately as you can.

Listening to What You
Have Done

Remember that synchronization later on will only be as accurate
as the accuracy with which you tap in this procedure.

15.To  end recording, press the Stop button in the main transport
controls.

Don’t be alarmed if the Macintosh wristwatch icon remains
onscreen for an extended period of time after you stop recording.
Performer is calculating precise tempo changes from the taps you
just recorded.

Now that you have recorded the tempo map, try' slaving Performer to
the tape using your usual method of synchronization, such as Direct
Time Lock or MIDI Time Code, in the Receive Sync dialog box. Also,
make sure that the Metronome is under Conductor track tempo
control. You will now be able to playback, rewind, or fast forward
anywhere in the song on tape, and your Performer sequence will
exactly reproduce your tapping performance with respect to the
music on tape. If you tapped accurately, Performer will play along
accurately. If you goofed, so will Performer. You can always try again.
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chapter 43 Printing

Checking your serial
ports before you print

This chapter explains how to:

□ Print out the contents of a Performer list window, such as
the Event List, Tracks, Markers, Chunks, and Remote
Controls windows.

□ Print one or more tracks as music notation and display the
results on the computer screen or print them on a printer

□ Customize the page layout for notation printing

□ Get best-looking results when printing notation

Before you print anything—either a list window or notation, consider
which Macintosh serial port you will be using for printing. To check
the status of the serial ports, choose Interface Settings from the Basics
menu. These settings reflect your current FreeMIDI studio configu­
ration.
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In the example above, the printer port is “Not in Use”, which means
that it is OK to print if your printer is connected to it. If your printer
is connected to modem port in this example, you’d need to change
the way the serial ports are set up for MIDI.

Using MIDI on one port and printing on the other
If you plan to do a lot of printing from Performer, your best bet is to
use one serial port for MIDI and the other for printing as shown
above. Affordable multi-port MIDI interfaces such as Mark of the
Unicorn’s MIDI Express and MIDI Time Piece II provide a convenient
connection for all of your MIDI gear through one Macintosh serial
port.

Printing when you use MIDI on both serial ports
Depending on your MIDI setup, you may require MIDI on both serial
ports. For example, you may have a large MIDI rig that requires
multi-port interfaces connected both serial ports, or you may have an
old MIDI interface that calls for using both ports. In either case, you
probably have your printer connected to a “thru” port on the
interface. When you want to print something, you press a "thru”
switch to temporarily suspend MIDI and allow printing.

In this scenario, MIDI activity must be temporarily suspended on the
serial port being used for MIDI. Use the Interface Settings command
in the Basics menu to temporarily set the port to No Interface while
printing.

Printing the
Contents of a
List Window

To print the contents of a track’s Event List window, the Tracks
Window, the Markers Window, the Chunks list window, or the
Remote Controls window:

1. Bring the window you want to print to the front to make it the active
window.

To do so, click its title bar or choose its name from the Windows
menu.

2. Open the Chooser from the Apple menu and select the desired
printer and serial port.

See “Checking your serial ports before you print” on page 665.
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Printing
Notation

3. Choose Page Setup from the File menu, make any desired changes
to the page settings, and click OK to confirm the settings.

The options that appear in this dialog box depend on the type of
printer you are using. For example, if you are printing on a laser
printer, you can choose an enlargement or reduction above or
below 100%.

4. Choose Print from the File menu.

The standard print setup dialog box appears for your printer.

5. Set up the printer options as needed, such as the number of
copies, and click OK.

The entire contents of the list is printed.

Printing notation in Performer is easy, as you’ll see in the following
sections. Performer transcribes unquantized or quantized MIDI data
in a readable fashion. You can format the music on screen exactly as
it will print, including text, page margins, staff spacing, measure
spacing, and more.

To print notation:

1. Open the Chooser from the Apple menu and select the desired
printer and serial port.

See “Checking your serial ports before you print” on page 665.

2. Choose Page Setup from the File menu, choose the desired page
size, make any desired changes to the page settings, and click OK
to confirm the settings.

The options that appear in this dialog box depend on the type of
printer you are using. For example, if you are printing on a laser
printer, you can choose an enlargement or reduction above or
below 100%.
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3. Select the data or the region of data that you would like to print
using any method of selection that you prefer.

Performer is extremely flexible because you can use any one of
Performer's many ways to select data—from a single note to the
entire piece. You can select any portion of a track, or any portion
of multiple tracks. See “Choosing what tracks to display" on
page 347 for more information.

4. Click the QuickScribe notation editing window button in the
Consolidated Controls window.

A window appears containing staves for the track or tracks you
have selected. This window displays the music on a page exactly
as it will print out. For information about editing music and
formatting it in this window, see chapter chapter 23, “QuickScribe
Notation”.

5. Use the QuickScribe window mini-menu and Page Setup
commands to format the music on the page as desired.

Summarized below, these menu commands are discussed in detail
in chapter chapter 23, “QuickScribe Notation”.

6. Add text as desired with the text tools in the Tools palette.

Formatting command: Brief description:

Score Options
(Mini-menu)

Provides control for title page, staff
names, measure numbering and
spacing, and staff spacing.

Page Margins
(Mini-menu)

Lets you adjust top, bottom, left, and
right page margins.

See “Working with text” on page 367 for more information.
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7. Choose Print from the File menu.

The standard print setup dialog box appears for your printer. For
example, if you are printing with an Apple LaserWriter in System
7, you'll see the window below:

Lasermriter "LaserWriter ng" 7.1.2 |[ Print ]|
Copies:|U Pages: @ fill O From: |_____ | To: |_____ |

[ Cancel )
CouerPage: @ No O First Page

Paper Source: © Paper Cassette

Print: @ Black & White
Destination: ©Printer

O Last Page

O Manual Feed

O Color/Gragscale
O PostScript® File

8. Set up the printer options as needed, such as the number of copies
desired, and click Print.

Performer proceeds to print the document, providing you with a
status window as it does.
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Chapter 44 Using Performer With Unisyn

What is Unisyn?

How Are Unisyn and
Performer Integrated?

Integration Happens
Automatically

Selecting
Sounds

Unisyn is Mark of the Unicorn’s state-of-the-art editor librarian
software. Unisyn provides you with a complete MIDI sound
management environment, coupled with powerful tools for creating
and editing sounds.

Unisyn and Performer are both FreeMIDI compatible applications. As
a result, they are integrated with one another through FreeMIDI in the
following ways:

■ FreeMIDI allows Performer to play back a sequence in the
background when you switch into Unisyn under System 7
(or MultiFinder in System 6) to audition patches, edit a
patch, or perform any other task in Unisyn.

□ While you are working in Unisyn, you can start, stop, and
play a Performer sequence without ever leaving Unisyn.

□ Unisyn keeps all of the FreeMIDI patch lists completely up
to date. In turn, FreeMIDI shares the patch lists with
Performer and all other FreeMIDI compatible applications.
These patch lists show up through Performer, most notably
in the Tracks window default patch and current patch
columns.

With FreeMIDI installed in your system, all of the integration features
above happen automatically as you use Performer and Unisyn. No
additional effort is required on your part.

With Performer and Unisyn working together, you have many choices
for how to select sounds in your sequences. In general, they fall into
two general approaches:

1. Using patch change events in Performer

2. Using Unisyn for general sound management
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These approaches are discussed in the following sections. Which
approach you will use depends on how you work. These consider­
ations are also discussed.

Using Patch
Change Events
in Performer

Advantages

One way to select sounds is to choose them by name from
Performer’s patch list pop-up menus. For example, you can select a
default patch for each track in the Performer's Tracks window. When
you play the sequence from the beginning, the default patch gets
transmitted to the synth to recall the patch before music begins
playing. You can also insert (or record) patch change events in the
sequence’s tracks to change sounds during playback.

The critical concept with this approach is that you are dealing with
MIDI patch change events, which are MIDI events numbered from
zero to 127. Unisyn provides names so that you can conveniently
refer to them by name, rather than by number.

When managing sounds in this fashion in Performer, Unisyn serves
two purposes:

1. To provide Performer with accurate names in the patch
lists—that is, names of patches that are currently in the
synth. For example, if you send a bank to a synth from
Unisyn, the patch names from that bank will be displayed
in Performer’s patch lists. If you then send a different
bank to the synth, Unisyn updates Performer’s patch lists
to the patches in the new bank.

2. To save the current bank in each synth in a performance
so that this same bank can be restored when you work on
the sequence at a later time.

If you don’t save the current banks as a performance in Unisyn, you
have no easy way to restore the banks if you need to work on the
sequence at a later date. If you don't restore the patch banks, the
patch lists in Performer may not be the ones you originally used, and
your default patch selections, as well as patch changes you’ve
inserted in tracks, won't recall the correct sounds.

As you can see, the integrity of this approach depends on having the
correct banks of sounds loaded in the synth. If you don't change
banks in your synths, handling sounds in this manner works very
well, and the only role Unisyn plays is to provide accurate factory
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Disadvantages

Patch Maps

preset patch lists. This is the easiest way to handle sound selection
because everything is done in Performer alone. Once Unisyn has
provided the patch lists, you don't even need to run it when using
Performer.

If you do change banks in your synths, this approach still works fine.
But be absolutely sure to save the banks to disk in Unisyn and
include them in the performance that you create for the sequence.
This technique is described further in “Using Unisyn for General
Sound Management” on page 674.

Of course, if you know you’ll never be working on the project again,
and you will never need to recall the sound setup, you certainly don’t
need to save a Unisyn performance.

When you select a patch from Performer’s patch list pop-up menu,
sometimes what you selected won’t be what you hear. This is
because many synths have more than one "mode”, e.g. "multi” and
“voice” mode, which have a dramatic effect on what happens when
you send a patch change to the synth from Performer. If the synth is
not in the right mode, you won’t get the patch you expect. You must
learn enough about your synths to choose the necessary mode, either
from its front panel controls or by selecting the appropriate module
in Unisyn’s Modules window (depending on the synth). Refer to the
synth's documentation for clues.

Another drawback to this method is that you are limited to the zero
through 127 range of patch changes allowed by MIDI, which, for
most synths, only select RAM sounds. New synths support a new
MIDI command called bank select, which provides direct access to
many more ROM sounds; however, if a synth is more than about a
year old, it won’t support bank select. As a result, you are forced to
go through considerable gymnastics in the synth to have access to all
your patches via MIDI patch change events.

In general, if a synth has many ROM sounds, you will have an easier
time selecting sounds for it with Unisyn rather than with patch lists in
Performer.

Some synths, such as the E-mu Proteus, address the 128-patch
limitation by providing a "patch map” which lets you choose from a
larger set of sounds. However, Unisyn doesn't take patch mapping
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Updating Unisyn

Using Unisyn for
General Sound
Management

into consideration when providing patch lists to Performer, so once
again yon are left with a situation where the patch you select in
Performer won’t be the one you hear from the synth.

Unisyn sets up Performer’s patch list so that the first patch in the list
always selects the first patch in Unisyn’s bank window, the second
selects the second patch, etc. If your synth has a programmable patch
map, it should be permanently set to correspond in this fashion. If
you need to access patches that are not available via the program
change table, use Unisyn to copy them into RAM locations that are
available via the program change table. If you employ this technique,
the patch list in Performer should show the correct name.

•"The E-mu Proteus 1,2, or 3 are exceptions. Patch 0 in
Performer’s patch list selects ROM preset 000. Patch 64
in Performer’s patch list selection RAM preset 064,
patch 65 selects RAM present 065, etc. (This exception
does not apply to the Proteus XR.)

In general, Unisyn keeps Performer completely updated as far as
what patches are available in your synths. Performer’s patch menus
should always reflect the sounds currently available via patch
changes sent from Performer.

On the other hand, Performer doesn’t have the same powerful
features as Unisyn, so it cannot automatically inform Unisyn if you
select a different patch from its patch list. If you make patch
selections in Performer and you want Unisyn to know about them
(such as to save them in a Unisyn performance), use the Get Group/
All Patches command in Unisyn after you make the changes to
update Unisyn. If you select patches entirely in Performer, however,
there’s no need to update Unisyn in this fashion, unless you need to
edit a patch.

Beyond its integration with Performer, Unisyn has many features of
its own that serve as a powerful compliment to Performer. By
following the general guidelines below, you can select all your
sounds and banks via Unisyn and then save them as a Unisyn
performance, which captures the entire state of your MIDI setup for
the Performer sequence you are working on. You can easily recall
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Creating a Performer/
Unisyn Project

Recalling the Project

Advantages

this setup before you begin work on the sequence al a later date.
Using this approach, you can rely on Unisyn to handle most, if not
all. of your sound selection needs.

•"The tasks below are basic Unisyn procedures that you
will become very familiar with as you learn Unisyn.
They are explained in detail in the Unisyn manual.

Use Performer to create your sequence, and use Unisyn to select the
desired banks and patches for the sequence.

After you have set up your synths with the correct banks, and you
have selected all of the appropriate sounds for the tracks in your
sequence, go into Unisyn and create a performance to save them for
the sequence. To keep things clear, you might want to give the
performance the same name as the sequence, such as "On the Road
Again/Sounds&Banks”.

If you are using patch change events in the tracks of your sequence
to change patches during playback, or if you used Performer's
“Default Patch” feature, be sure to save the necessary banks with the
performance. This ensures that the synth will have the correct bank
of sounds the next time you work on the sequence.

To recall the project, load it’s corresponding Unisyn Performance
before you begin playing the sequence. By doing so, you load all of
the correct patch banks and sounds for each module so that the
sequence plays back with the correct sounds.

Using Unisyn gives you many powerful capabilities, such as patch
editing, sound libraries, and more. In terms of sound selection, you
get the best of both worlds: you can select sounds using both
Performer's patch changes and Unisyn’s sound management features.
However, you need to decide how you are going to choose default
patches for each track: either by using Performer's default patch
feature (in the Tracks window) or by saving patches for Unisyn’s
modules in a Unisyn performance file. You may find that the decision
differs for each synth and depends on how you use the synth.

By using Unisyn’s libraries and powerful searching features, you
potentially have thousands of sounds at your fingertips, as opposed
to the restricted 0-127 range imposed by MIDI patch changes.
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Disadvantages

I Another great advantage is that yon can easily incorporate Unisyn's
patch editing capabilities into your sequencing. Does that bass patch
need more snap in the attack? Just open Unisyn’s Patch Edit window
and tweak away. You can even do so while the sequence is playing.

The only (small) price you pay for using Unisyn to its fullest potential
with Performer is that there is a bit of extra housekeeping required
on your part. You need to organize your files on the hard disk in a
way that makes it easy for you to determine which Unisyn
performance file goes with which Performer sequence file. Here’s a
suggestion: create a folder for the project and place the Performer
sequence file and the Unisyn performance file together in the folder.

Troubleshooting Here are a few common problems you might encounter.

You get a “Not enough memory” message when you try
to run both Performer and Unisyn at the same time.
Cause: There isn’t enough free RAM (random access memory) in your
computer to support the memory requirements of both applications
at the same. Solution: Make sure there no other applications running.
Try' restarting the computer and launching them again. If you still
don't have enough memory, you may need to get a memory upgrade.
Contact Mark of the Unicorn technical support.

You select a patch in Performer’s patch list, but you
don’t hear the correct sound on the synth.
Cause: There could be many causes for this. One possibility is that
the synth is in a mode that causes it to respond to your patch change
differently than by calling up a sound. In this case, try switching into
Unisyn and selecting a different module for the synth. Also, check the 
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MIDI channel of the device for the patch list. Is the device perhaps
transmitting on a channel that the synth isn't set to receive patch
changes on? Also, have you changed the patch map in the synth? If
so. read “Patch Maps” on page 673.

You hear a pause during Performer’s playback.
If Performer is playing back when you switch between Unisyn and
Performer, you will hear a brief pause in Performer s playback. Also,
if you send a bank or other data intensive operation in Unisyn while
Performer is playing in the background, this can also stop playback
momentarily.

You make a change to a patch in a bank in Unisyn, but
the change is not reflected in Performer’s patch list.
Under some circumstances, changes you make to an individual patch
in the synth’s current bank in Unisyn will not be immediately
reflected in Performer’s patch list. This includes things like changing
a patch name, moving it to a different location in the bank, adding a
new patch to the bank, etc. To bring Performer’s patch list up to date,
use the Send Bank command in Unisyn’s MIDI menu, which will
update Performer’s patch list.
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Chapter 45 MIDI Utilities

Interface
Settings

Edit FreeMIDI
Configuration

FreeMIDI Sync

Panic

The Interface Settings command in the Basics menu allows you to set
the communication speed between Performer (actually FreeMIDI)
and other MIDI hardware and software. Use the Interface Settings
command to open the Interface Settings dialog box. This dialog box
allows you to enable and disable the two serial ports for MIDI. If, for
instance, you have a printer attached to the Thru port of your MTP II
and the MTP II is connected to the Printer serial port, you will need
to disable MIDI on the printer port in order to do any printing.

The Edit FreeMIDI Configuration command in the Basics menu opens
the FreeMIDI Setup program. Doing so lets you add, remove, and
modify devices in your FreeMIDI setup. Use this command when you
would like to make changes to the device list pop-up menus that
appear throughout Performer.

Free MIDI Sync command in the Basics menu, when checked, causes
all FreeMIDI programs that are currently running to play, stop.
rewind, and locate together. When you enable it in Performer, it
automatically gets enabled in all other FreeMIDI programs, too.
Conversely, if you enable it in any other FreeMIDI program, it gets
enabled in Performer automatically. When it is checked, it is enabled;
when it is unchecked, it is disabled. For complete information about
this command, refer to “The Transport Controls” on page 710.

The Panic command in the Basics menu sends an All Notes OffMIVA
message and then a note o//'MIDI message for every MIDI note on
every possible MIDI channel on ever}' MIDI output cable on both
serial ports. It also resets MIDI buffers in FreeMIDI software. This
command can take quite a while. If you wish to stop the operation.
type command-period on your Mac keyboard.

679



Preferences The Preferences command in the File menu gives you several choices
for various features in Performer.

Startup options
Choose how you would like Performer to open when you first launch
the application. Performer can do one of three things:

■ Open a new file.

□ Present you with the Open file dialog box.

h Neither of the above. In this case, no window or dialog
box appears. Instead, Performer's menu bar appears at the
top of the screen, and the only menu available is the File
menu, from which you can choose New or Open.

Pitch Representation
Lets you choose how note octaves are numbered.
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Default Editing Window
This setting determines what you get when you double-click a track.
The other two windows can be opened by command-double-click
and option-command-double-click.

Settings in the Preferences window are stored in the Performer
Preferences file, which is automatically created in the Preferences
Folder in the System Folder. They are global settings and affect all
files.
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Chapter 46 Using FreeMIDI Setup

The Current FreeMIDI
Configuration

FreeMIDI
Preferences

This chapter explains all the major functions of the FreeMIDI Setup
application.

FreeMIDI Setup is the application that you use to edit your FreeMIDI
configuration or FreeMIDI System Preferences. It is the application
that is launched or switched to when the EditFreeMIDIConfiguration
command is chosen in FreeMIDI-compatible applications such as
Performer, Mosaic, or Unisyn. In FreeMIDI Setup, you can edit the
properties and connections of devices as well as the various settings
in the FreeMIDI System, such as Inter-application MIDI and Monitor
Patch Changes. You can view the current patch list for a device in a
pop-up menu. You can control the Transport functions of a FreeMIDI
sequencer, such as Performer. You can also use FreeMIDI Setup to
test your studio connections.

There is no need to make a FreeMIDI configuration “current”. The
configuration that is visible in the FreeMIDI Configuration window is
the current configuration that all FreeMIDI applications will use.
Whenever you launch FreeMIDI Setup to view or edit your FreeMIDI
configuration, the configuration document with which you were last
working is opened automatically. If you do not launch FreeMIDI
Setup, other FreeMIDI applications will be using the FreeMIDI
configuration that was last opened in FreeMIDI setup.

If you open a new or existing configuration, it will immediately
become the current configuration that all FreeMIDI applications will
use.

See “Working with FreeMIDI Configurations” on page 703 for
information on working with multiple FreeMIDI configurations.

The FreeMIDI Preferences dialog box is where you tell FreeMIDI
which serial ports you will be using for MIDI, whether you want to
use Inter-application MIDI, whether FreeMIDI should monitor patch
changes and whether FreeMIDI should allow non-FreeMIDI

683



Quick Setup

Auto Config

applications to use the serial ports for MIDI. See “Launching
FreeMIDI Setup” on page 46 of the Getting Started booklet for more
information on FreeMIDI Preferences.

Use the Quick Setup command to add and delete devices from your
FreeMIDI configuration. This command is especially good to use
when you need to add or delete more than one device from your
configuration. Quick Setup can also shorten the process of
connecting devices to interfaces, since the connections can be
specified before the devices appear in the FreeMIDI Configuration
window and then automatically appear when the setup is completed.

The Quick Setup dialog box contains an Auto Config push button
which opens the Auto Config dialog box. Auto Config can
automatically find many of the MIDI devices in your MIDI studio. See
“Configuring Your studio automatically” on page 51 of the Getting
Started booklet for information on using Auto Config to configure
FreeMIDI for your studio.
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Using Quick Setup to
Add FreeMIDI Devices

To use Quick Setup to add devices:

1. Choose Quick Setup from the Configuration menu.

The Quick Setup dialog box appears.

Neuu Device: Current Configuration:
Manufacturer:_________

Yamaha v |

Model:________________
| TGI 00 ▼"]

Studio Location:_______
j MIDI Time Piece I... |

Cable: | 4 |

If » Odd »

Clicking a device in the "Current
Configuration" list displays its information
above. To edit this information, first
remove the device and re-add it.

MIDI Time Piece II, Modem
K2000
TG500
Proteus/2
PC-200
TGI 00
CDH-D5

[« Remoue« ] ( Done ]

Figure 46-1: Quick Setup Dialog Box

This dialog box contains a list of all the MIDI devices that are
contained in your current FreeMIDI configuration on the right side
under the label Current Configuration.

2. Select the correct manufacturer, model, studio location and cable
(if applicable) from the pop-up menus on the left and then click
Add.

If the pop-up menus do not contain a description of a particular
device, choose Other and click Add. We will see how you can re­
name and re-define these devices later in this manual. For now
they will be called by the default name Device-1 for the first such
device, Device-2 for the next and so on. If you accidentally add a 
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device to the list that you do not want to appear in your studio
configuration, select its name from the list on the left and click
Remove.

3. When you have added all the devices to the list that you wish to
add to your studio configuration, click Done.

The FreeMIDI Configuration window will appear containing all of
the MIDI devices defined in the Quick Setup dialog box and their
connections.

Figure 46-2: FreeMIDI Configuration Window
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Using Quick Setup to
Remove FreeMIDI
Devices

To use Quick Setup to remove devices:

1. Choose Quick Setup from the Configuration menu.

The Quick Setup dialog box appears.

Neai Deuice:

» Add »

( « Remove « } [ Done )

PC-200

Clicking a device in the "Current
Configuration" list displays its information
above. To edit this information, first
remove the device and re-add it.

TG1OO
CBH-05

Current Configuration:
MIDI Time Piece II, Modem
K2000
TG500
Proteus/2

Manufacturer:_________
| Roland |

Model:________________
| PC-200
Studio Location:_______
[ MIDI Time Piece I... |

Cable: | 8 |

The FreeMIDI
Configuration
Window

2. Select the device or devices you wish to remove from the Current
Configuration list and click Remove.

The selected devices will disappear from the list.

3. When you have finished removing devices, click Done to close the
Quick Setup dialog box.

The FreeMIDI Configuration window will appear containing all of
the MIDI devices defined in the Quick Setup dialog box and their
connections, minus the devices which were removed.

This window is where you edit your FreeMIDI Configuration. It is the
window that will appear when you choose the Edit FreeMIDI
Configuration command in other FreeMIDI applications such as
Performer, Mosaic, and Unisyn.
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This window contains a graphical representation of your MIDI studio.
It contains MIDI interfaces, FreeMIDI devices, interface-to-device
connections and an Info Bar.

Use the title bar of the window to move it as with any standard
Macintosh window. Use the horizontal and vertical scroll bars to view
portions of the window not currently visible as with any standard Mac
window. Use the Zoom button to toggle the window between full
size and its current state. Use the grow handle to change the size or
shape of the window.
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Editing Device Info in the
FreeMIDI Configuration
Window

In the FreeMIDI Configuration window, you can view, edit, and
rearrange your FreeMIDI configuration in most any way that you like.

The FreeMIDI Configuration window shows your current
configuration. You can make any other previously saved
configuration the current configuration simply by opening it.

Use the Quick Setup command along with the Auto Config command
to quickly set up a configuration that matches your MIDI studio. For
more information, see “Configuring Your studio automatically” on
page 51 of the Getting Started booklet.

You can edit some of the properties of devices that appear in your
FreeMIDI configuration directly in the FreeMIDI Configuration
window. The properties that you can change are the manufacturer
name, model name, device ID, device name, and MIDI transmit and
receive channels. See “Editing FreeMIDI Devices” on page 693 in this
chapter for information on editing all the properties of FreeMIDI
devices.

To quickly change the manufacturer, model, device ID or MIDI
channel for a device:

1. Select the device you wish to edit by clicking its icon.

It’s device info appears in the info bar near the top of the window.

Figure 46-4: FreeMIDI Configuration window Info Bar

MfiNUFfiCTUP.EP. MODEL ID TRRNS.CH REC. CH

Kurzweil t K2000 ▼ 0 1-16 1-16
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Editing FreeMIDI
Configurations

2. Select a new manufacturer or model name from the appropriate
pop-up menus.

Unless you want to leave the model name blank, you will need to
change the model name for a device if you change its
manufacturer.

Eventide
Fender

Other
360 Systems
ADA Signal Processors
Adams-Smith
Akai
AKG Acoustics
Alesis
ART
Baldwin
Casio
Clarity
JL Cooper
Digitech
Digital Music Corp.
DOD Electronics

■/ E-mu Sustems
Ensonii

Other
EPS
ESQ-1
ESQ-M
Mirage
SD-1

✓ SQ-80
SQ-1
SQ-1 Plus
SQ-2
SQ-R
VFX
VFX SD
VFX SD Version II

Other
Emulator
Procussion
Proteus/1
Proteus/1 XR
Proteus/2

✓ Proteus/2 XR
Proteus/3
Proteus/3 XR
Proteus /MPS
Vintage Keys

Figure 46-5: Pop-up menus in Info Bar

3. Enter new device ID or MIDI transmit and receive channels
numbers in the appropriate text entry box(es).

If you would like to enter consecutive MIDI channel numbers,
enter the numbers like this: 1-8. If you would like to enter non-
consecutive numbers, enter the numbers like this: 1,3,5,7,10.

You can add, delete, edit, rename, duplicate, connect, disconnect,
and rearrange FreeMIDI devices in the FreeMIDI Configuration
window. Use the techniques below to add and remove devices from
your FreeMIDI configuration if you only need to add or remove one
device at a time. Otherwise, it is usually easier to use the Quick Setup
command to add or remove multiple devices. See "Using Quick Setup
to Add FreeMIDI Devices” on page 685 in this chapter for more
information on using the Quick Setup command.

See “Working with FreeMIDI Configurations” on page 703 in this
chapter for information on working with multiple FreeMIDI configu­
rations.
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Adding FreeMIDI
Devices

To add a single FreeMIDI device to your configuration:

1. Choose Create Device from the Configuration menu or type
command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears. If you do
not wish to add a device at this time, click Cancel and the
FreeMIDI Configuration window reappears.

■ FreeMIDI Deuice Specification ---- =

Transmit Channels:
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Name: QjQQH Deuice ID: 1

Manufacturer: Model: (1-16)
| Ensoniq xz I [ EPS-M __ xJ

Receiue Channels:
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Properties: [ Controller,...
Controller, Receives Clock, Transmits Clock

Studio Location:
| MIDI Time Pieces, Mod.T^

Figure 46-6: FreeMIDI Device Specification Dialog Box

2. Select a manufacturer and model from the pop-up menus.

Steps 2-7 below are optional. FreeMIDI ships with default settings
for each device in it’s model list. These default settings appear
when you select a specific model from the model pop-up menu.
If you would like to change any of the settings such as the device
name, ID, properties, MIDI channels or icon, proceed to steps 2-7
below. Otherwise, click OK and the new device will appear at the
top of FreeMIDI Configuration window.
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Removing FreeMIDI
Devices

3. Enter a name for the device by typing the name into the name text
box.

4. Set a device ID number by entering a new number in the Device ID
text box.

5. Select up to eight different Properties for the device by selecting
properties from the Properties pop-up menu.

For more information, see “Device Properties" on page 716.

6. Set transmit and receive channels for the device, by clicking the
appropriate box(es) below the MIDI channel numbers that are
displayed.

It is very important to set the MIDI channel information correctly,
since this controls the amount of channels that appear for the
device in other FreeMIDI applications such as Performer.

7. Select an icon to represent the device in the FreeMIDI
Configuration window.

Click Icons and scroll until the icon that you wish to use is
displayed in the middle, bordered field and click OK. For
information on entering your own icons into FreeMIDI, see
chapter 49, “Editing FreeMIDI Device Files”.

8. Indicate the studio location of the device by selecting the
appropriate MIDI interface and cable number from the pop-up
menus provided.

If you don’t have a multi-port MIDI interface like the MIDI Time
Piece II or MIDI Express, the cable pop-up menu will not be
available.

To remove FreeMIDI devices from your configuration:

1. Select the device you wish to remove by clicking its icon. Shift­
click device icons to select more than one device.

2. Type backspace or delete on your Mac keyboard or choose Cut or
Clear from the Edit menu or type command-X or command-B on
your Mac keyboard.

Any of these commands removes the selected devices.
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Editing FreeMIDI
Devices

3. If you remove the wrong devices, choose Undo from the Edit menu
and try again.

Once FreeMIDI devices are defined and appear in your FreeMIDI
configuration, you can change any of their properties with the
FreeMIDI Device Specification dialog box.

To edit a FreeMIDI device:

1. Double-click the device you wish to edit. Alternately, select the
device and choose Edit Device from the Configuration menu or
type command-E on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears. If you
select more than one device in the FreeMIDI Configuration
window, the Edit Device menu item becomes grayed-out
(disabled) since you can only edit the properties of one FreeMIDI
device at a time.

■ . ....^ = FreeMIDI Deuice Specification — =

Manufacturer: Model: 32>
JD-990

Figure 46-7: FreeMIDI Device Specification Dialog Box
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Naming FreeMIDI
Devices

Selecting FreeMIDI
Devices

I 2. Make the changes you desire and click OK or click Cancel to
cancel the edit operation.

See “Adding FreeMIDI Devices” on page 691 in this chapter for
information on the various properties you can edit in this dialog
box.

When devices are added to your FreeMIDI configuration using Quick
Setup and Auto Config, they are given default names that correspond
to their model names. You can easily rename these devices if you
wish. See “Editing FreeMIDI Devices" on page 693 in this chapter for
information on one method of changing the name of any existing
FreeMIDI device with the FreeMIDI Device Specification dialog box.

An even easier way to change a FreeMIDI device name follows:

1. Select the device by clicking its icon.

You can skip step 2 below by clicking the device’s name directly.
The mouse cursor will change to the text insertion I-beam to
indicate that it is in text entry mode.

2. Type the Return or Enter key on your Mac keyboard.

3. Enter a new name for the device.

4. Type the Return or Enter key on your Mac keyboard to confirm your
choice. Alternately, you can click any where in a blank part of the
FreeMIDI Configuration window to confirm the new name.

5. If you enter the wrong name, choose Undo Rename from the Edit
menu and try again.

For users familiar with System 7, FreeMIDI’s naming
convention is identical to naming icons in the Finder.

To select a FreeMIDI device in the FreeMIDI Configuration window,
click its icon. To select more than one FreeMIDI device, shift-click
each icon. To deselect a previously selected FreeMIDI device, shift­
click its icon. To deselect all selected FreeMIDI devices, click in a
blank area of the FreeMIDI Configuration window.
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Duplicating FreeMIDI
Devices

You can make copies of FreeMIDI devices in two ways. Using the
Copy or Cui command along with the Paste command, you can make
copies of devices to paste into other FreeMIDI configurations. Using
the Duplicate command, you can make copies of devices in the
current FreeMIDI configuration with one command.

To copy or cut and then paste devices:

1. Select the device you wish to copy or cut by clicking its icon. Shift­
click device icons to select more than one device.

2. Choose Copy or Cut from the Edit menu. Alternately, you can type
command-C for Copy and command-X for Cut on your Mac
keyboard.

Copy makes a copy of the selected items and places it on the
clipboard for pasting. Cut makes a copy of the selected items and
places it on the clipboard for pasting and removes the original
selection.

3. (Optional) If you wish to paste the devices into a different FreeMIDI
configuration, close the current configuration and open a new or
existing configuration.

For info on opening new and existing configurations see
“Opening Existing FreeMIDI Configurations” on page 705 and
“Creating a New FreeMIDI Configuration" on page 703 in this
chapter.

4. Choose Paste from the Edit menu. Alternately, you can type
command-V on your Mac keyboard.

The pasted devices will appear in some blank portion of the
FreeMIDI Configuration window.

To duplicate devices:

1. Select the device you wish to duplicate by clicking its icon. Shift­
click device icons to select more than one device.

2. Choose Duplicate from the Edit menu. Alternately, you can type
command-D on your Mac keyboard.

The duplicated devices will appear in some blank portion of the
FreeMIDI Configuration window.
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Connecting Devices to
Interfaces

Once you have added a FreeMIDI device to your FreeMIDI
configuration, you need to connect its inputs and outputs to an
interface in your configuration. FreeMIDI is unable to send or receive
MIDI to or from the device unless it is connected to an interface.
FreeMIDI does not require that the input and output cable of a device
be the same number, but, in most cases, setting up your studio this
way may be more organized and simpler to understand.

'•* Outputs are represented by small triangles that are
located on the right side of devices and interface ports.
Inputs are represented by small triangles that are
located on the left side of devices and interface ports.

To connect a device output to an interface:

1. Drag a “patch cord” from the output of a device to an input on an
interface.

When you release the mouse, the connection will appear. If you
have a multi-cable interface such as the MTP II or MIDI Express,
be sure to connect the device output to the input to which the
device is physically connected. If you are using both the modem
and printer serial ports, be sure to connect the device output to
the input on the interface on the serial port to which the device is
physically connected.

2. Alternately, you can drag the “patch cord” from the input of an
interface to an output on the device.

3. If you connect the wrong ports for a device, choose Undo Drag
from the Edit menu and try again.

To connect a device input to an interface:

1. Drag a “patch cord” from the input of a device to an output on an
interface.

When you release the mouse the connection will appear. If you
have a multi-cable interface such as the MTP II or MIDI Express,
be sure to connect the device output to the input to which the
device is physically connected. If you are using both the modem
and printer serial ports, be sure to connect the device output to
the input on the interface on the serial port to which the device is
physically connected.
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Making MIDI Thru
Connections

Making Multiple MIDI
Input Connections

Connecting Devices to
other Devices

Removing Device
Connections

2. Alternately, you can drag the “patch cord” from the output of an
interface to an input on the device.

3. If you connect the wrong ports for a device, choose Undo Drag
from the Edit menu and try again.

When more than one MIDI device shares a single output port from a
MIDI interface, you need to connect the MIDI Thru port of the device
to the input of the other device. This mirrors the physical connection
that you should have between the devices.

Figure 46-8:MIDI Thru Connection

FreeMIDI Setup allows you to connect more than one MIDI output
from a device to a single MIDI input on an interface. When you make
such a connection, you are telling FreeMIDI that both devices’ MIDI
outputs are connected to a single MIDI input on an interface. Without
some type of MIDI merger, this type of connection is not possible.

FreeMIDI Setup allows one connection per port (input output, or
thru) on each device. You cannot connect devices to each other
except from MIDI Thru to MIDI In of a separate device. If you would
like to make such connections, use the Cable Routing (on MIDI Time
Piece and MIDI Express interfaces) or similar features in your MIDI
interface or MIDI patch bay/merger gear.

Once you have made connections between devices and interfaces,
you can remove the connections to make different connections if you
physically change the connections in your MIDI studio.
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To remove FreeMIDI device connections:

1. Click at the intersection of the Device port and the patch cord and
drag the connection away from the device and then release the
mouse.

The connection is broken.

Figure 46-9: Breaking a Connection

An alternate way to remove FreeMIDI device connections follows:

1. Select a connection by clicking it. Shift-click connections to make
multiple selections simultaneously.

When a connection is selected, it appears as a thicker, heavier
line. To deselect a connection, click somewhere in a blank area of
the FreeMIDI Configuration window.

Figure 46-10: Selecting a Connec-

Arranging the FreeMIDI
Configuration window

2. Type backspace or delete on your Mac keyboard or choose Cut or
Copy from the Edit menu or type command-X or command-B on
your Mac keyboard.

Any of these commands will remove the selected connections.

3. If you remove the wrong connections, choose Undo from the Edit
menu and try again.

You can arrange the FreeMIDI Configuration window any way you
like. We suggest that you drag device icons so that they appear as
they do in your studio. For instance, you can arrange all the modules,
which are in a rack to the left of your Mac, to the left side of the
window and all the modules, which are in a rack to the right of your
Mac, to the right side of the window. You can drag the patch cords.
which connect the devices to the interfaces, up or down so that you
can view the connections clearly. You can drag MIDI ports in a multi-
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The Clean Up Window
Command

Updating Interfaces

cable interface, such as the MTP, MTP II or MIDI Express, up or down
to create more or less space between them. You can delete input or
output cables, which are not part of your studio setup, by clicking the
patch cord to select it and typing the backspace or delete key on your
Mac keyboard. You can also make and break connections by just
dragging the ends of the patch cords. You can use the different
options in the Views menu to change the size of the icons and to
view input and outputs separately or together.

You can use the Clean Up Window command in the Views menu to
quickly arrange all the devices in the window into uniform columns.

Interfaces are an important part of the FreeMIDI Configuration. They
appear automatically when FreeMIDI scans the serial ports for MIDI
interfaces. This happens the first time you set the FreeMIDI System
Preferences to access one or both serial ports for MIDI. You can use
the Update Interfaces command in the Configuration menu to have
FreeMIDI check for MIDI interfaces that you may have installed or
powered on after originally setting the Preferences file.

To do so:

1. Choose Update Interfaces from the Configuration menu

The Update Interfaces dialog box appears.

Serial Ports: Current Interface:
Modem [ Scan ) | MIDI Express
Printer ( Scan ) I None

i To find interfaces automatically, press the Scan button next to the desired
i port. For interfaces that are presently off-line, you may choose an option
j from the popup menus on the right, but you must then use the Interface
I Settings dialog so FreeMIDI can communicate with the interface(s). Press
: OK when the interfaces listed are correct.

[j OK j|

Figure 46-12: Update Interfaces dialog box

I
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Connecting a device to

an interface output

Dragging a

connection

vertically

Dragging a device to

change its position

Dragging a

connection
horizontally

Proteus/I

I

Dragging a MIDI port

to change its position

Figure 46-11: Arranging FreeMIDI devices and connections

i
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Adding Interfaces

2. Click the Scan button for the Serial port(s) you wish FreeMIDI to
search for interfaces and click OK.

Interfaces that FreeMIDI finds appear in the FreeMIDI
Configuration window.

You can use the Update Interfaces command in the Configuration
menu to add MIDI interfaces that may currently be off-line (powered
off or disconnected) to the current FreeMIDI configuration.

To do so:

1. Choose Update Interfaces from the Configuration menu.

The Update Interfaces dialog box appears. See Figure 46-2 above.

2. Sselect the interface you require from the pop-up menus and click
OK.

The interfaces are added to your FreeMIDI configuration.

3. Choose Interface Settings from the MIDI menu.

This step is essential to ensure that FreeMIDI can communicate
with the newly-added interface(s). The Interface Settings dialog
box appears.

OK)] ( Cancel ]

Mac interface: | Serial Ports v [

B

o o .5 MHz / 16H

® o 1 MHz / 32K

o o 2 MHz / 64H

O o Fast/ IK

I............°... ® Not in use

Figure 46-13:Interface Settings dialog box
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Moving FreeMIDI
Interfaces

Editing FreeMIDI
Interface Names

4. Select the appropriate settings for the interface(s) you have added
and click OK.

To move a FreeMIDI interface, drag its icon to the desired position.
Choose Undo Drag command from the Edit menu to return the
device icon to its original position.

You can drag the input/output ports of a MIDI interface up and down
to make more room between each port by dragging the port number
icon that you wish to move. Choose Undo Drag command from the
Edit menu to return the port number icon to its original position.

Figure 46-14: Moving interface ports vertically

After a FreeMIDI interface appears in the FreeMIDI Configuration
window, you can change its name. To do so:

1. Select the FreeMIDI interface you wish to edit by clicking its icon.

It’s info appears in the info bar. If you clicked the interface icon's
name, the mouse cursor changes to a text insertion I-beam and
you can enter a new name by just typing. If you did not click the
icon name, you can still edit the name by typing the Return key
on your Mac keyboard and the name will pop-up for editing and
the mouse cursor changes to a text insertion I-beam when it is
over the icon name. If you are familiar with System 7, this naming
convention works identically to the Finder in System 7.
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Working with
FreeMIDi
Configurations

We call the documents created by the FreeMIDi Setup application
‘FreeMIDi configurations". When FreeMIDi Setup is open, the
FreeMIDi Setup document that is currently open and whose
FreeMIDi configuration is visible in the FreeMIDi Configuration
window is the current configuration that all FreeMIDi applications
use. Whenever you launch FreeMIDi Setup to view or edit your
FreeMIDi configuration, the configuration document with which you
were last working is opened automatically. If you do not launch
FreeMIDi Setup, other FreeMIDi applications use the FreeMIDi
configuration that was last opened in FreeMIDi Setup.

If you open a new or existing configuration, it will immediately
become the current configuration that all FreeMIDi applications use.

Creating a New FreeMIDi
Configuration

Although only one FreeMIDi configuration can be current or active at
a time, you can create as many FreeMIDi configurations as you like.
Once you have created a FreeMIDi configuration for your own MIDI
studio, you might want to create a FreeMIDi configuration for another
studio that you might be working at in the future or you might want
to create several variations of your home studio for different
situations.

To create a new FreeMIDi configuration:

1. If you have not done so already, open FreeMIDi Setup by double­
clicking its icon in the Finder. Alternately, you can open FreeMIDi
setup by choosing the Edit FreeMIDi Configuration command in
any other FreeMIDi application.

The FreeMIDi Configuration window opens and displays the
current FreeMIDi configuration.

2. Choose Neivfrom the File menu or type command-N on your Mac
keyboard.

If you have made changes to the current configuration and have
not yet saved them, FreeMIDi Setup will ask if you would like to
save these changes before the new configuration opens.

3. The Update Interfaces dialog box appears.

This dialog is shown in Figure 46-12 on page 699.
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4. If you have an interface connected, click Scan on the port it is
connected to.

5. If you don’t have an interface connected at the moment, choose an
interface from the pop-up menu and click OK.

You now see a new, window with the interface you just found (or
chose by hand).

Figure 46-15: New FreeMIDI Configuration

FreeMIDI Configuration ' ' Q-

MIDI Express, Modem
II
II

II
>(3>

II

II
(§>

II

SI____________________________________ISs

6. Use Quick Setup or Auto Config to add and connect devices to the
interface in this new FreeMIDI configuration. Alternately, you can
add devices to the configuration individually by choosing Create
Device from the Configuration menu.

For more information on adding and connecting devices in this
new FreeMIDI configuration, see “Quick Setup” on page 684,
“Auto Config” on page 684, and “Editing FreeMIDI Configurations"
on page 690 in this chapter.
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Opening Existing
FreeMIDI Configurations

Saving FreeMIDI
Configurations

You now have a FreeMIDI configuration that can be used in the
studio for which it was designed. See “Saving FreeMIDI Configura­
tions” on page 705 for information on how to save this configuration
to disk so that you can open it when you start work in the studio for
which it was designed.

Once you have saved more than one FreeMIDI configuration to disk,
you can open any existing configuration for use in a situation such as
starting a project in another MIDI studio.

To open an existing configuration:

1. If you have not done so already, open FreeMIDI Setup by double­
clicking its icon in the Finder. Alternately, you can open FreeMIDI
setup by choosing the Edit FreeMIDI Configuration command in
any other FreeMIDI application.

The FreeMIDI Configuration window opens and displays the
current FreeMIDI configuration.

2. Choose Open from the File menu. Alternately, you can type
command-0 on your Mac keyboard.

If you have made changes to the current configuration and have
not yet saved them, FreeMIDI asks if you would like to save these
changes before another configuration opens. Otherwise, a
standard Macintosh File Open dialog box opens.

3. Select the FreeMIDI configuration that you would like to open and
click Open or click Cancel to leave the current FreeMIDI
configuration open.

The selected configuration opens and you can proceed to use this
configuration in your other FreeMIDI applications. Use the
directory pop-up menu to navigate to a disk and folder in which
the configuration you wish to open is located. See your Macintosh
owner’s manual for more information on saving files and
navigating to disk and folders.

You can save each FreeMIDI configuration that you create to disk so
that you can recall them at a later date.
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To save a FreeMIDI configuration:

Popup Patch
Lists

1. Choose Save from the File menu. Alternately, you can type
command-S on your Mac keyboard.

If the configuration has been saved before, it replaces the current
version of the configuration. If there are no changes since the last
time the configuration was saved, the Save menu item is disabled
(grayed-out) in the File menu. If the configuration has never been
saved before, a standard Macintosh File Save dialog box opens.

2. Use the suggested name “FreeMIDI Configuration” or enter
another name for your configuration if you like, and click Save or
click Cancel to cancel the operation.

Use the directory pop-up menu to navigate to a disk and folder in
which you wish to save this configuration. If you like, you can use
the New Folder button to create a new folder in which to save this
configuration and others that you might create in the future. See
your Macintosh owner’s manual for more information on saving
files and navigating to disk and folders.

The configuration is now safely saved and you can recall it at a later
date.

Librarian applications, such as Unisyn or PatchList Manager, which
support FreeMIDI’s patch lists, can be used to define patch lists for
your FreeMIDI devices. You can view the patch lists assigned to
FreeMIDI devices and send patch changes to their default channels
directly in the FreeMIDI Setup application. For more information on
how to define patch lists for a FreeMIDI device, consult your
Librarian software’s users manual. If you use the PatchList Manager,
this information is in chapter 48, “Using PatchList Manager”.

To view and send patch changes in the FreeMIDI Setup application:

1. Check to be sure that the Popup Patchlists menu item in the MIDI
menu is enabled.

The Popup Patchlists command should have a check next to its
name. If it does not, choose it to select it.
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Patch Thru

Audition Channels

2. Press the mouse on a device in the FreeMIDI Configuration window
and its current patch list appears in pop-up menu.

Figure 46-2 below shows a portion of an Ensoniq ESQ-M popup
patch list.

001 STEIN
002 WAY
003 QUIPNO^]
004 RHODES
005 PICT
006 PN0ST1
007 PN0ST2
008 HARPSI

033 WIND1
034 BOYS 1
035 QUANT2
036 AIRT02
037 VAINVS
038 LIFL1N
039 KRAFTY
040 QUANTA

Figure 46-16: Popup Patchlist

3. (Optional) If you want to send a patch change command to the
device whose patch list you are viewing, choose the patch you
want to send and release the mouse.

The patch change will be sent to the device on its default channel.

The PatchThru command lets you send MIDI data from one FreeMIDI
device to any selected FreeMIDI device while FreeMIDI Setup is the
current application.

Before using PatchThru, be sure to set the Audition Channels the way
you need them.
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To do so:

Using PatchThru

1. Choose Audition Channels from the MIDI menu.

The Audition Channels dialog box appears.

@ Use default channel only
O Use all channels

Figure 46-17: Audition Channels Dialog Box

( Cancel ]

MIDI Preferences are used for
PatchThru and Check Connections.

2. Select one of the two options available.

The Use default channel only option is the default setting. With
this setting PatchThru sends all incoming MIDI data to the selected
device on the first available MIDI receive channel for that device.
The Use all channels option will cause PatchThru to send all
incoming MIDI data to the selected device on all of the selected
device’s MIDI receive channels at once. This option is mostly
useful for detecting to which channels a device is currently
responding.

3. Click OK to confirm your choice or Cancel to leave the Audition
Channels settings unchanged.

PatchThru is a checkable menu item. This means that its state (on or
off) is toggled each time you choose it from the menu. When there is
a check next to the PatchThru menu item in the MIDI menu,
PatchThru is enabled.
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To use PatchThru:

MidiLocate

1. Check to be sure that the PatchThru menu item in the MIDI menu is
enabled.

The PatchThru command should have a check next to its name. If
it does not, choose it to select it. You can also use the Mac
keyboard shortcut to toggle the state of PatchThru by typing
command-T.

2. Select a device and play notes on your MIDI controller keyboard.

You should hear the notes being played coming from the device
that is selected.

"®' You can only patch thru to one device at a time. To
Patch Thru to more than one device, use Multi-record
mode in Performer or cable routing in the MTP, MTP II
or MIDI Express.

MidiLocate is a unique feature designed to make adding devices to
your FreeMIDI configuration easier. In this mode, FreeMIDI
automatically determines the proper input cable to which a device is
physically attached and then displays this connection in the FreeMIDI
Configuration window.

MidiLocate is a checkable menu item. This means that its state (on or
off) is toggled each time you choose it from the menu. When there is
a check next to the MidiLocate menu item in the MIDI menu,
MidiLocate is enabled.

To use MidiLocate:

1. Select a FreeMIDI device in the FreeMIDI Configuration window.

2. Check to be sure that MidiLocate menu item in the MIDI menu is
enabled.

The MidiLocate command should have a check next to its name.
If it does not, choose it to select it. You can also use the Mac
keyboard shortcut to toggle the state of MidiLocate by typing
command-L.
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3. Play some MIDI data from the MIDI device.

The Transport
Controls

FreeMIDI will determine from where the MIDI data is coming and
redraw the FreeMIDI Configuration window to indicate the
appropriate connection.

Here is an example of MidiLocate in action. Let's say you have a
Kurzweil K2000 that is connected to some MIDI input on your
MTP II, but you are not sure which input:

1. Add a K2000 FreeMIDI device your configuration using Quick
Setup or Create Device.

2. Enable MidiLocate.

3. Select the K2000 device.

4. Play some notes on its keyboard or send some other MIDI data
from it and the K2000 device automatically is connected to the
correct MIDI input port on your MTP II in the FreeMIDI
Configuration window.

The Transport Controls window contains buttons that can control the
transport functions (Play, Stop, Rewind, Locate) of other FreeMIDI
applications from within FreeMIDI Setup. For instance, you might
want to start a sequence playing in Performer while you are working
on some aspect of your FreeMIDI setup. You do so by opening the
Transport Controls window, enabling FreeMIDI Sync, and clicking
Play. With this feature, there is no need to switch to Performer.

** Playing MIDI in the background using the transport
controls only functions when FreeMIDI Preference’s
Software Compatibility is set to allow FreeMIDI
applications only. For more information, see
“Launching FreeMIDI Setup" on page 46.

Once FreeMIDI Sync is enabled you can also stop Performer, rewind
the sequence, or locate to up to 8 predefined positions within the
sequence directly from FreeMIDI Setup.
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FreeMIDI Sync can be enabled from any FreeMIDI application that is
currently open and that supports this feature of FreeMIDI. In
Performer, this command is in the Basics menu. When you enable
FreeMIDI Sync in any open FreeMIDI application, it is enabled for all
FreeMIDI applications on that Macintosh.

'•* The state of FreeMIDI Sync (ON or OFF) cannot be
changed while a FreeMIDI application such as
Performer is playing.

To use the Transport Controls:

1. Choose Transport Controls from the MIDI Menu or type
command- = on your Mac keyboard.

The Transport Controls window appears.

Figure 46-18: Transport Controls Window

>-locate buttons

2. Click FreeMIDI Sync to enable FreeMIDI Sync.

You can skip this step if FreeMIDI Sync has already been enabled
by some other FreeMIDI application. If it is already enabled, the
FreeMIDI sync check box appears checked.

3. Click the Transport Control function that you want to use.

Click Rewind, Play, Stop, or Pause to send those commands to the
FreeMIDI application that you are controlling. The FreeMIDI
application should respond to these commands as if you were
using its own controls.
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The Panic
Command

Check
Connections

Checking MIDI Output

4. If the FreeMIDI application that you are controlling supports their
use, you can use any of the 8 auto-locate buttons to auto-locate to
some pre-defined location in the sequence or song that is currently
playing.

In Performer, you can define these auto-locate points in the
Markers window. Assign a number from 1-8 for a marker in the
Seek column and that marker’s location in the sequence will be
defined as one of the 8 FreeMIDI auto-locate points. Click the
corresponding button in the Transport Controls window and
Performer will locate to that point. You can auto-locate at any
time, even during playback.

The Panic command found in the MIDI menu sends an All Notes Off
MIDI message and then a note q/T'MIDI message for every MIDI note
on every possible MIDI channel on every MIDI output cable on both
serial ports. It also resets MIDI software buffers in FreeMIDI software.

This command can take quite a while. If you wish to stop the
operation, type command-period on your Mac keyboard.

The Check Connections command is a utility that FreeMIDI Setup
provides for troubleshooting and testing the connections of your
MIDI studio.

Check Connections is a checkable menu item. This means that its
state (on or off) is toggled each time you choose it from the menu.
When there is a check next to the Check Connections menu item in
the MIDI menu, Check Connections mode is enabled.

To use Check Connections mode to check MIDI output connections:

1. Check to be sure that the Check Connections menu item in the MIDI
menu is enabled.

The Check Connections command should have a check next its
name. If it does not, choose it to select it. When the menu item is
checked, Check Connections mode is enabled and the mouse
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cursor will change to the Check Connections cursor when it is
within the FreeMIDI Configuration window as shown in Figure 46-
2 below.

Checking MIDI Input

Figure 46-19: Check Connections mouse cursor

2. Press a device icon and hold the mouse button down.

While you hold the mouse button down, FreeMIDI sends a C
major chord on all MIDI channels to the MIDI output port to
which the selected device is connected. If you have an MTP, MTP
II, MIDI Express or other interface which can show MIDI output
activity, the LED should light up on the selected output port.
Additionally, the device to which you are playing MIDI should
play the C major chord. If you do not see MIDI activity or do not
hear the C major chord, check the connections, cables and power
switches of all your MIDI gear.

3. Press other device icons to test the rest of your studio.

4. Uncheck the Check Connections menu item in the MIDI menu by
selecting it.

To use Check Connections mode to check MIDI input connections:

1. Check to be sure that Check Connections menu item in the MIDI
menu is enabled.

The Check Connections command should have a check next its
name. If it does not, choose it to select it. When the menu item is
checked, Check Connections mode is enabled and the mouse
cursor will change to the Check Connections cursor when it is
within the FreeMIDI Configuration window as shown in Figure 46-
2 above.

2. Send MIDI data from one of your MIDI devices.

If the device has a keyboard, play notes on it. If it is a rack-mount
unit, you will need to find a way to send some type of MIDI data
from it. Try changing patches or initiating a system exclusive
dump from its front panel.
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The View Menu

i 3. The MIDI port to which the device is connected should flash the
eighth note icon as shown below inFigure 46-2.

il

1------H-------

Figure 46-20: Incoming MIDI Data indicator

If no ports flash, this means that FreeMIDI is not receiving the
MIDI data. Check the connections, cables and power switches of
all your MIDI gear. If a port flashes, but it is not the port you
expected, you will need to re-connect the MIDI device to the
correct port or better yet, change the connection in your FreeMIDI
configuration to match the physical connection. See “MidiLocate”
on page 709. for a quick and easy way to re-connect a device in
your FreeMIDI configuration.

The View menu allows you to change the way the FreexMIDI
Configuration window displays. The Clean Up Window command
automatically aligns devices in straight columns. For more
information, see “The Clean Up Window Command” on page 699.

There are three size options, which control the display of FreeMIDI
device icons and four input/output options, which control the display
of the “patch cords" that connect devices and interfaces, as illustrated
in Figure 46-2 below.
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I The two upper sections in this menu each have mutually exclusive
options. Choosing one of the icon size options disables the other two
icon size options. Similarly, choosing one of the input/output view
options disables the other three input/output view options.

Uiew
by Small Icon
by Icon

✓ by Large Icon

Show Inputs Only
Show Outputs Only

✓ Show Inputs & Outputs
Show On Select

Clean Up Window

Figure 46-21: The View Menu

To use the View menu to change the display of your FreeMIDI
configuration:

1. Choose an icon size option from the View menu and the FreeMIDI
Configuration window will redraw (if necessary) to display your
choice.

The choices are Small Icon, Icon, and Large Icon. These three
choices represent the three icon sizes possible for each FreeMIDI
device. See “Editing FreeMIDI Devices” on page 693, for
information on changing the icons of your FreeMIDI devices.
These options are useful for displaying more or less of your
FreeMIDI Configuration, depending on what you are doing at the
time.

2. Choose an input/output view option from the View menu and the
FreeMIDI Configuration window will redraw (if necessary) to
display your choice.

These choices are useful for making the FreeMIDI configuration
window display easier to read.
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Changing
Interface
Settings

Normally, FreeMIDI finds out what your interface settings are
automatically. In this case, you should never need to change the
interface settings.

There are, however, a few situations in which you might need to
make the interface settings manually, such as the following cases:

□ You have an interface that FreeMIDI does not
automatically recognize

□ You have just changed the communication speed on your
interface (for example, you’ve changed it from FAST/1X
speed to 1 MHz).

There are other possible situations as well. In these cases, you can set
the interface speed manually using the Interface Settings command in
the MIDI menu.

To changing the interface settings:

1. Choose Interface Settings from the MIDI menu.

The Interface settings dialog box appears. See Figure 46-2 above.

2. Select the appropriate options and click OK.

Device
Properties

Device properties are descriptive words that can be assigned to any
FreeMIDI device. FreeMIDI applications can use these device
properties in any way that they require. Here are two examples of the
use of device properties:

■ A FreeMIDI application which knows about the General
MIDI specification could check FreeMIDI devices for the
General MIDI device property. If the application found this
property assigned to a certain device, it could then adjust
itself to display and send the General MIDI patch changes
only to this device, without having to know anything else
about the device (such as the device model name or patch
list).
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■ A FreeMIDI application that needs to synchronize its
timing to a certain device could check for the Transmits
Sync device property. If the property existed, the
application would know that it could successfully sync to
the device.

You can assign device properties to a device when the device is first
added to your FreeMIDI configuration or at a later time. The
FreeMIDI Device Specification dialog box is where this assignment is
made. See “Editing FreeMIDI Devices” on page 693 and “Adding
FreeMIDI Devices” on page 691, for information on assigning device
properties to devices.
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chapter 47 Quick Reference for FreeMIDI
Setup

This chapter contains brief descriptions of all the commands and
dialog boxes contained in the FreeMIDI Setup application. Use this
chapter as a reference guide for finding out how a certain feature is
used. Read the chapters that are cross-referenced for more detailed
information on these features.

The Apple Menu The Apple menu contains Desk Accessories under system 6 and what
ever is in the Apple Menu Items folder under system 7. The first
command in the Apple Menu is About FreeMIDI Setup.

About FreeMIDI Setup Choose About FreeMIDI Setup to display the FreeMIDI Setup startup
screen and version number. Click the mouse anywhere to make this
display go away and return to the FreeMIDI Configuration window.

The File Menu The File menu contains all the commands that allow you to open,
close, and save FreeMIDI configuration files.

New Use the New command to close the current configuration and open a
new empty configuration. You will be asked if you are sure that you
want to close the current configuration, since this will affect all
FreeMIDI applications that are currently being used. Before the new
configuration is created, the Update Interfaces dialog appears so that
FreeMIDI can establish what type of MIDI interface you have.

Open Use the Open to close the current configuration and open a
previously defined configuration.

Close Use the Close command to Quit FreeMIDI Setup.

Save Use the Save command to save changes you have made to the current
configuration file on disk.

Save As Use the Save As command to save the current configuration file with
a new name.

To save the current configuration file with new name:
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To save the current configuration file with new name:

1. Choose Save As from the File menu.

The Save As dialog box appears.

2. Enter a new name for the configuration file.

You can’t use a colon (:) in the name; however all other characters
are permitted, including spaces. Navigate to the disk and folder to
which you wish to save the configuration file using the directory
menu at the top of the window. If you enter a name that is already
in use, a dialog box asks you to confirm your choice.

3. Click Save.

Your configuration file is saved on the disk in its current state
under the new name.

Revert Use the Revert command to discard any changes you have made to
the current configuration file and restore it to the state it was in when
you last saved it.

Page Setup Use the Page Setup command to control the way your configuration
is printed when using the Print command. See your Macintosh user's
manual for more information on Page Setup.

Print Use the Print command to print a picture of your FreeMIDI
configuration. See your Macintosh and printer user’s manual for more
information on printing.

FreeMIDI Preferences Use the FreeMIDI Preferences command to open the FreeMIDI
Preferences dialog box. This dialog is where you control some of the
global settings of FreeMIDI such as which serial ports FreeMIDI will
use, whether Inter-application MIDI is enabled, whether non-
FreeMIDI applications will have access to the serial ports and
whether patch change monitoring is enabled.

Quit Use the Quit command to exit the FreeMIDI Setup application.
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The Edit Menu The Edit menu contains commands for copying and pasting FreeMIDI
devices in the FreeMIDI Configuration window. These commands
also work in the standard Mac way anywhere in FreeMIDI Setup
where you edit text.

Undo Use the Undo command to undo the last edit or change that you
made to your FreeMIDI Configuration. Generally, this command
displays the command that it will Undo, such as Undo Drag or Undo
MidiLocate. As a shortcut, type command-Z on your Mac keyboard to
invoke this command.

Cut Use the Cut command to place a copy of the current selection on the
Clipboard and then remove the current selection. As a shortcut, type
command-X on your Mac keyboard to invoke this command.

Copy Use the Copy command to place a copy of the current selection on
the Clipboard. As a shortcut, type command-C on your Mac keyboard
to invoke this command.

Paste Use the Paste command to insert whatever data is currently on the
Clipboard. As a shortcut, type command-V on your Mac keyboard to
invoke this command.

Clear Use the Clear command to remove the current selection. No copies
are placed on the Clipboard. As a shortcut, type command-B on your
Mac keyboard to invoke this command.

Duplicate Use the Duplicate command to make copies of the currently selected
FreeMIDI devices. This command only works on selected FreeMIDI
devices, so it is grayed-out(disabled) unless at least one FreeMIDI
device is selected. As a shortcut, type command-D on your Mac
keyboard to invoke this command.

Select All Use the Select All command to quickly select all of the current type
of data. For instance, if there is no selection in the FreeMIDI
Configuration window, Select All selects all the FreeMIDI devices,
interfaces, and connections in the window. If a text entry box is
active, such as the name field for a FreeMIDI device, Select All will
select all the text in the name field. As a shortcut, type command-A
on your Mac keyboard to invoke this command.
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The
Configuration
Menu

The Configuration menu provides access to various commands for
setting up and changing your FreeMIDI configuration.

Quick Setup Use Quick Setup to open the Quick Setup dialog box, which allows
you to quickly add and remove devices to and from your current
FreeMIDI configuration. For more information, see “Quick Setup" on
page 684.

Update Interfaces Use Update Interfaces... to inform FreeMIDI of changes you have
made to the MIDI interface(s) that you have connected to the serial
port(s) on the Macintosh. For more information, see "Updating
Interfaces” on page 699-

Create Device Use Create Device to open the FreeMIDI Device Specification dialog
box and add a new FreeMIDI device to your current FreeMIDI config­
uration. For more information, see “Adding FreeMIDI Devices" on
page 691.

Edit Device Use Edit Device to open the FreeMIDI Device Specification dialog
box and edit an existing FreeMIDI device in your current FreeMIDI
configuration. You must select a device before this command
becomes enabled. With no devices selected, it remains grayed-out
(disabled). For more information, see “Editing FreeMIDI Devices" on
page 693.

The MIDI Menu The MIDI Menu contains commands which provide control over
FreeMIDI Setup’s various MIDI settings.

Interface Settings Use the Interface Settings command to open the Interface Settings
dialog box. This dialog box allows you to enable and disable the two
serial ports for MIDI. If, for instance, you have a printer attached to
the Thru port of your MTP II and the MTP II is connected to the
Printer serial port, you will need to disable MIDI on the printer port
in order to do any printing.

Return Use the Return command to return to the FreeMIDI application that
was last active before switching to FreeMIDI Setup. This command
will only have an effect if you switch to FreeMIDI Setup with the Edit
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FreeMIDI Configuration command from any other FreeMIDI
application. As a shortcut, type command-R on your Mac keyboard to
invoke this command.

Transport Controls Use the Transport Controls command to open the Transport Controls
window. 'I'he Transport Controls window contains buttons that can
control the transport functions (Play, Stop, Rewind. Locate) of other
FreeMIDI applications from within FreeMIDI Setup. For more
information, see “The Transport Controls" on page 710.

Check Connections This command, when checked, causes the arrow cursor to change to
a small keyboard cursor.

It ffl
When you click a device in the FreeMIDI configuration window with
the keyboard cursor, FreeMIDI sends a C-major chord to the device
via MIDI. If all is well, the device plays the chord. If there is a
communication problem between FreeMIDI and the device (such as
a lose cable or something), the device does not play the chord.

Conversely, when this command is checked, and you send MIDI from
one of your MIDI devices to FreeMIDI, the port to which the device
is connected flashes a note symbol to indicate that FreeMIDI is
successfully receiving data from the device.

This command serves as a diagnostic tool for you to determine if
MIDI communication is OK.

MidiLocate Use the MidiLocate command to toggle the state of MidiLocate. When
the menu item is checked, MidiLocate is enabled. When it is
unchecked, MidiLocate is disabled. For more information, see
“MidiLocate” on page 709.

PatchThru Use the PatchThru command to toggle the state of PatchThru. When
the menu item is checked, PatchThru is enabled. When it is
unchecked, PatchThru is disabled. For more information, see “Patch
Thru” on page 707.
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Popup Patchlists

Audition Channels

Panic

The View Menu

This command, when checked, causes the arrow cursor to change to
a MIDI patch change icon cursor.

*

When you then press on a device in the MIDI configuration window
with the patch change cursor, a popup patch list appears containing
a list of the patches for the device. For more information, see "Popup
Patch Lists” on page 706.

The Audition Channels command allows you to choose how
PatchThru and Check Connections will function. For more
information, see “Audition Channels” on page 707.

Use the Panic command to send an “All Notes Off MIDI message
and then a “note off’ MIDI message for every' MIDI note on every
possible MIDI channel on every' MIDI output cable on both serial
ports. This command will also reset all MIDI buffers in all FreeMIDI
software. This command can take quite a while. If you wish to stop
the operation, type command-period, on your Mac keyboard. For
more information, see “The Panic Command” on page 712.

The View menu controls the display of the FreeMIDI Configuration
window. The three options at the top of the menu, by Small Icon, by
Icon and by Large Icon, are mutually' exclusive. Choosing one option
disables the other two. When an option is chosen from the menu, it
gets a check mark next to its menu item.

The next four options, Show Inputs only, Show Outputs only, Show
Inputs and Outputs, and Show On Select, are also mutually' exclusive.
For more information, see “The View Menu" on page 714.

Use the Clean Up Window command to quickly' arrange all the
FreeMIDI devices in the window in a neat column. For more
information, see “The Clean Up Window Command” on page 699.
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Chapter 48 Using Patch Lisi Manager

What is PatchList
Manager?

This chapter explains how to use PatchList Manager, a FreeMIDI-
compatible application included with Performer. You can find it in
the FreeMIDI Applications folder on the top level of your hard disk
(unless you have moved it since installation).

PatchList Manager helps you create and maintain accurate patch lists
for your MIDI instruments, so that the sound names in Performer
match the sounds in the instrument. In fact, the word patch refers to
a specific sound in your MIDI instrument.

0 SotoCelb 32 Epibgue 64 BellEnserrile 96 RoomOfStnr?js
1 CobVwl* 33 VindStack 65 Cyberspace 97 MaglcBells
2 Sob Viol tn 34 FrenchHcrnl 66 PUzMocgBass 98 Regtnatron
3 Quartet 35 FrenchHorn2 67 Marirrhah 99 Subltl
4 SobChamber 36 SectbnHorns 68 GrimReaper 100 Psychbtron
5 ArccBarses 37 Trumpet 1 69 TinkerBell 101 CbudChamber
6 ArccCelll 33 Trurr.pet2 70 Carousel 102 Sepulcher
7 ArcoViolas 39 TvoTrumpets 71 ExotvcHjrp 103 LurchPluck
9 ArcoVwlmj 40 HarmcrMute 72 DarnSaucers 104 Pizz /Piccolo
9 Marcatol 41 Trombone 1 73 EronzePad 105 Vampiric*)
10 Marc*to2 42 Trombcr^2 74 Vibraphone 106 String Things
11 LegatoStr 43 Tuba 75 AstralFlute 107 Galapagos
12 Concerto 44 BackEras: 76 KcolBass 103 SquareOne
13 PuxBassej 45 ChamberErass 77 Sombre'./tnds 109 SquareLink
14 PuxCelli 46 ErassStrings 78 SpaceCovboy 110 <♦>
ISPtxzVbhj 47 Timapnl 79 TheMachine 111 Sardonicus
16 PerViolins 48 Oong/Cymbal

49 Bass/Snare
£0 EarlyPerc
81 Gently Now

112 MasterTron
113 LoYmdlnst"b*Pttdcat o 2^"^

50 TempleBlock 82 Piccolodeeyo 114 Sympathetic
19 TremStrir>gs 51 Xykphon* 83 InftniteOne 115 VindChimes
20 Strgs/Flutes 52 Glockenspiel 84 ShimmerVays 116EoatHaus
21 ResttrrjPid 53 Celesta 65 TurtoBass 117 OlitterGod
22 Dwerttmento 54 TutuhrBelb 86 Requiem 118 StoryBass
23 Huh 55 Percusskoni 87 VrongRocm 119 Niceflight
24 Piccolo 56 Percussbn2 08 AnabgPad 120 ProphetLead
25 Obce 57 Harp 89 ChapelOrgan 121 PrcphetLtnk
26 EnglishHorn 53 Harpstrings 90 Electro/ocal 122 Vhtstl nJce
27 Clarinet 59 Harpsikord 91 FatBoyTuba 123 Link2Shimmer
23 BassClarmet €0 HotreOame 92 SawBass/Lead 124 Ascending
29 Bassoon 61 tf interSigns 93 ViennaDream 125 Harpscmatic
30Ccntrab*:socn 62 DeepPad 94 VertigcPad 126 Phaedra
31 ChamberVnds 63 Portamento 95 TarlujTwfn 127 Cimbabn

Patch 1 Patch 33 Patch 65 Patch 97
Patch 2 Patch 34 Patch 66 Patch 93
Patch 3 Patch 35 Patch 67 Patch 99
Patch 4 Patch 36 Patch 63 Patch 100
Patch 5 | Patch 69 Patch lOt
Patch 6 Patch 33 K Patch 70 Patch 102
Patch 7 Patch 39 Patch 71 Patch 103
Patch 8 Patch 40 Patch 72 Patch 104
Patch 9 Patch 41 Patch 73 Patch t05
Patch 10 Patch 42 Patch 74 Patch 106
Patch 11 Patch 43 Patch 75 Patch 107
Patch 12 Patch 44 Patch 76 Patch 108
Patch 13 Patch 45 Patch 77 Patch 109
Patch 14 Patch 46 Patch 78 Patch 110
Patch 15 Patch 47 Patch 79 Patch 111
Patch 16 Patch 43 Patch £0 Patch 112
Patch 17 Patch 49 Patch 81 Patch 113
Patch 18 Patch 50 Patch 82 Patch 114
Patch 19 Patch 51 Patch 83 Patch 115
Patch 20 Patch 52 Patch 84 Patch 116
Patch 21 Patch 53 Patch 85 Patch 117
Patch 22 Patch 54 Patch £6 Patch 118
Patch 23 Patch 55 Patch 87 Patch 119
Patch 24 Patch 56 PatchBS Patch 120
Patch 25 Patch 57 Patch 69 Patch 121
Patch 26 Patch 53 Patch 90 Patch 122
Patch 27 Patch 59 Patch 91 Patch 123
Patch 28 Patch 60 Patch 92 Patch 124
Patch 29 Patch 61 Patch 93 Patch 125
Patch 30 Patch 62 Patch 94 Patch 126
Patch 31 Patch 63 Patch 95 Patch 127
Patch 32 Patch 64 Patch 96 Patch 128

Figure 48-1: For many popular MIDI devices, Performer automatically displays sound names in
its pop-up patch lists. If not, you'll see generic names as shown on the right. PatchList Manager
lets you replace generic names with the actual names in the synth. In addition, it provides a host
of capabilities that allow you to maintain accurate patch Lists for all of your MIDI devices.
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Do you need to use
PatchList Manager?

Situations that call for
PatchList Manager

A brief overview of
PatchList Manager

FreeMIDI automatically provides factor}' default patch lists for ox er 70
popular synthesizers and sound modules. If your device is one of
them, the patch lists you see in Performer's Patch and Default Patch
pop-up menus will be accurate and complete, and you probably
won’t need to use PatchList Manager. To check the accuracy of a
device’s patch List in Performer, choose a sound from a track's
Default Patch pop-up menu in the Tracks window and then see if the
track plays with the sound you chose. If so, you are all set.

Here are the most common situations in which you would need to
use PatchList Manager:

□ Performer is displaying generic sound names for one of
your devices as shown in Figure 48-1 on page 725 (i.e.
“Patch 1, Patch 2, Patch 3” etc.) and you want to see actual
sound names instead.

□ The current sound names in Performer don’t match the
sounds you hear in the instrument.

□ You want to make minor changes to a patch List, such as
changing the order of the sounds in the list.

a You have loaded a new bank of sounds into the
instrument (or have otherwise changed the internal state of
the instrument) and you want to access them by name in
Performer.

□ You want to set up, reorganize, add, or remove multiple
patch Lists for an instrument that has multiple banks of
sounds.

PatchList Manager has the three main windows shown in Figure 48-2.
The FreeMIDI Devices window shows the MIDI device or devices
that you want to work with. The Patch List window shows all of the
patch lists that can be assigned to the devices. The Programs window
displays the list of sounds contained in a particular patch list.

The information shown in these three windows is saved in your
FreeMIDI Setup document, as well as a separate PatchList Manager
document, which you'll save to disk when you have finished working
with PatchList Manager.
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MagicFlute
Operators
E.Guitars
Gametan
Zap Bass
DigrtalAir
Analogist
MandoTrem
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Sunrise
Piano 16’
AltoBreath
Tiny Dancer
Spruce Gtr
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’♦ Combinations
♦ GM Sounds
♦ GM Drum Kits

The Expand
button shows

and hides the
MIDI channels

for the device.

The Close
button closes

the window.

The Patch Lists window shows patch Lists, which can be
grouped into folders. To place a patch List in a folder, drag

its diamond move handle and drag it on top of the folder

icon. Use the Add Folder command to create a new one.

Click the

sound name

to rename it.

Drag the Move

handles to
reorder the

channels. You

can also drag

patch lists and

sounds this way.

The FreeMIDI Devices window shows the MIDI instru­
ments you would like to work with, along with the MIDI

channels belonging to each device. Use the Choose
Devices command in the mini-menu to decide which
devices you want to see in this list.

Click the

patch
number to
change it.

The mini-menu
contains commands that

apply to the window.

Double-click the

move handle to open
the Programs window.

Morpheus banks
♦ RAM Presets
♦ ROM Presets
♦ HyperPresets
♦ Card Presets
♦ Card HyperPresets

vQ K2000 banks
♦ Bank 0
♦ Bank 1
♦ Bank 2
♦ Bank 3
♦ Bank 4
♦ Bank 5
♦ Bank 6
♦ Bank?
♦ Bank 8
♦ Bank 9

tzCD X5 banks___________

ixa Morpheus
fi Channel 1
fl Channel 2
fl Channel 3
fl Channel 4
/I Channel 5
/I Channel 6
fi Channel 7
f2 Channel 8
j? Channel 9
fl Channel 10
P Channel 11
P Channel 12

Channel 13
P Channel 14
jl Channel 15
fl Channel 16

24;
25 .
26;
27!
281
29 .
30 i Space Wing
31 i Gospel Org
32 i Trumpets

XFade Bass
TheStrings
Pov/erSynth
Total Kit
MachineAge
Hot Keys
Brass Band
Maxi Tine

14 Power Rock
15 i Tabla Talk
16; FingerBass
17 j LiteVoices
18 1 Color Pad

The Programs window gives
you access to the sound names
in the patch list. Use the mini­

menu commands to arrange
the list and set the numbering

scheme. I

In the Patch List column, you choose

which patch list (or patch list folder) to

display in Performer for each MIDI

channel of the device. In this example,

the patch list folder called Morpheus
Banks is assigned to all Morpheus
channels. As a shortcut to assign all

channels at once, click in this column

next to the device name instead of one
of its channels.

1 Morpheus banks Mph Whisper
2 Morpheus banks
3 Morpheus banks
4 Morpheus banks
5 Morpheus banks Cmp:HotJazz
6 Morpheus banks
7 Morpheus banks
8 Morpheus banks Cmp :ElecPno
9 Morpheus banks

10 Morpheus banks Sfx tDrumble
11 Morpheus banks
12 Morpheus banks
13 Morpheus banks
14 Morpheus banks
15 Morpheus banks
16 Morpheus banks

Figure 48-2: PatchList Manager’s main windows

Opening PatchList
Manager

To open PatchList Manager, double-click the PatchList Manager icon
on your hard disk. It is located in the FreeMIDI Applications folder on
the top level of your hard disk (unless you have moved it since instal­
lation). What you'll see at first is the Choose Devices dialog box as
shown in Figure 48-3 on page 728.
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Choosing the devices
you want to work with

The first thing you need to do is choose the device or devices you
need to work with. Only choose the devices whose patchlists you
need to edit. Remember, if their patch lists are already fine, you don’t
need to do anything with them in PatchList Manager.

1. Select each device you would like to work with by highlighting its
name; deselect devices you don’t need to work with.

2. If Performer’s pop-up menus already display sound names for the
device, and you would like to work with this default list of names in
PatchList Manager, choose the list by its manufacturer and device
name in the “PatchList template” pop-up menu to the right of the
device.

--------------------------------------- ■---------- jj1 Choose Deoices-]

Please choose from the list of available devices by highlighting the name(s) on
the left. To configure patchlists for a device automatically, press the
PatchList Template column and choose the appropriate template from the popup
menu. Click ”Auto“ and devices supported by PatchList Manager templates are
automatically selected and configured.

FreeMIDI Device Patchlist TemplateClick the devices

shown here to select

or deselect them. If a

device's lists are

showing up in

Performer and select­

ing the correct

sounds, there is no

need to select it here.

Figure 48-3: Choosing the
devices you want to work with

•If you want to work with FreeMIDI's

default patch List(s) for a device in

PatchList Manager, choose the list by

name here. Note that some devices

aren't supported and therefore will not

have a default list, as shown in this

example by the Korg DW-8000.

Under the hood: what hati'dib

The sounds in a patch list are the sounds that are evoked
when a MIDI program change message (sometimes called a
patch change) is sent to the device. MIDI patch change
events are numbered from 0 to 127 (or 1 to 128), so patch
Lists will commonly have 128 sounds in them, although
you'll frequently encounter other sizes.

Some MIDI devices have more than 128 sounds. In this case.
the instrument either organizes them into multiple banks of
sounds (usually ranging in size from 50 to 128 each), or it
allows you to "map" sounds higher than 128 to a program
change number below 128, replacing the original sound that
used that number.

If an instrument has multiple banks, a separate patch list is
set up for each bank, in this case, the term patch list is pretty
much synonymous with the word bank.

If a device has multiple banks, it often requires an additional
message, called a bank select message. To call up a sound
from the bank in this case, Performer sends several MIDI
messages; a bank select message (usually controller =0 and
or controller -32) followed by a patch change message.
Some devices use a different type of MIDI message for bank
select, such as a short system exclusive message. FreeMIDI
can handle any type of bank select message. To learn more,
see “Using multiple patch lists & bank select messages" on
page 7-17.
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3. The devices appear in the FreeMIDI Devices window with their MIDI
channels shown below them.

Devices'

The Device's MIDI channels

‘(Si '□<<-< \ FreeMIDI Deuices
PfWCfJztluVultJ

t> O DW-8000
!> rm Proteus/I
•er cm K2500R

1 |

P Channel 1 K2000 banks:
f) Channel 2 2 K2000 banks --------------- -

Channel 3 3 K2000 banks|
f} Channel 4

Channel 5
4
5

K2000 banks:
K2000 banks ‘

fi Channel 6 6 K2000 banks'
j? Channel 7

Channel 8
fl Channel 9

7
8
9

K2000 banks'
K2000 banks i
K2000 banks i

j? Channel 10 10 K2000 banks!
P Channel 11 11 K2000 banks ■ C7P Channel 12 12 K2000 banks |
p Channel 13 13 K2000 banks! a

The current patch list (or patch

list folder) assigned to each

MIDI channel. The K2000
Banks folder holds all ten
banks for the K2000, as shown

below in Figure 48-5.

Figure 48-4: A device in the FreeMIDI Devices window

4. If you imported FreeMIDI’s default patch lists along with the
devices, they appear in the Patch Lists window.

Patch Lists
12S

Patch list folder-

Patch lists in the K2000 folder
5

2
3

100
100
100
100
100
100
100
100
100
100

V

♦ Proteus Presets i
K2000 banks

Bank 0
Bank 1
Bank 2
Bank 3
Bank 4
Bank 5

♦ Bank 6
♦ Bank?
♦ Bank 8
♦ Bank 9

Figure 48-5: Imported FreeMIDI patch lists
appear in the Patch Lists window.
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Deciding what to
do next

What you do next depends on what the situation is with each MIDI
device. Here is a summary:

Situation What to do
Performer is displaying generic sound names for
one of your devices as shown in Figure 48-1 on
page 725 (i.e. “Patch 1, Patch 2, Patch 3” etc.) and
you want to see actual sound names instead.

See “Creating a new patch list” on page 731-

Most or all of the current sound names in Per­
former don’t match the sounds you hear in the
instrument.

See “Creating a new patch list” on page 731.

You have loaded a new bank of sounds into the
instalment (or have otherwise changed the inter­
nal state of the instrument) and you want to
access them by name in Performer.

See “Creating a new patch list” on page 731.

You want to set up, reorganize, add, or remove
multiple patch lists for an instrument that has
multiple banks of sounds.

“Using multiple patch lists & bank select messages” on
page 747.

You want to make minor changes to a patch list,
such as changing the order of the sounds in the
list or renaming a few sounds.

See "Making changes to a patch list” on page 741

730 Using PatchList Manager



Creating a new
patch list

If your MIDI instrument doesn't have a patch list yet, or if the current
patch list is inaccurate for some reason (i.e. more than just a few
sound names are incorrect), your next step is to create a new patch
list for the device. There are several ways to do so. They are
summarized below in the order in which you should try them.

Ways to create a patch list Explanation Where to go

Load the Device’s patch list (or lists)
from old Performer or Digital Per­
former files

If you already have patch lists for the
device in a Performer 4.2 (or earlier)
or Digital Performer 1.4 (or earlier)
file, you can import the list(s) into
PatchList Manager. Regular Per­
former files and configuration files
can be read by PatchList Manager.

“Importing patch lists” on
page 732

If PatchList Manager supports the
device, it can get a “patch dump" from
the device to automatically extract
accurate patch lists from it

PatchList Manager gets a system
exclusive bulk dump from the
device, extracts the patch names, &
generates a patch list for each bank.

“Using PatchList Manager to
load patch names" on
page 733

If PatchList Manager doesn’t support
the device, you can use Unisyn, Mark
of the Unicorn’s universal editor/
librarian software, to extract an accu­
rate patch list for each bank in the
device

Get banks using Unisyn and then
import the Unisyn-generated patch
list for the bank into PatchList Man­
ager.

“Getting patch lists witii Uni­
syn'' on page 736

If none of the above methods apply,
you can type in the patch names by
hand

You add a new, generic patch list
and type the names in by hand.

“Creating a patch list by
hand” on page 738

What is a “system exclusive bulk dump’’?

The phrase system exclusive refers to a certain kind of MIDI
message. Without getting too technical, system exclusive
messages are used to communicate information that is
unique to a specific MIDI instrument or device. System
exclusive messages have a special format that allows them to
hold a varying amount of information. They can be so small
that they are transmitted in a fraction of a second; they can
be so large that they take minutes to transmit.

The term hulk clump is used to refer to system exclusive
messages containing large amounts of information. Often, a
bulk dump represents the complete internal state of a MIDI
device. In other words, the bulk dump serves as a
“snapshot" of the current state of the instrument. PatchList
Manager usually deals with bulk dumps that consist of one
bank of sounds. For some devices, it gets the entire internal
state. Either way, you'll probably wait at least a few seconds
for the transmission to be completed.
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Importing patch
lists

You can import patch lists from Performer 4.2 (or earlier) or Digital
Performer 1.4 (or earlier) files. You can import the patch lists from
either complete sequence files or configuration files. You can also
import them from other PatchList Manager files you may have saved
on disk.

To import patch lists from a Performer or Digital Performer file:

1. Choose Import Patch Lists from the File menu.

A standard Mac open file dialog appears.

2. Select the Performer or Digital Performer file that contains the
patch list you wish to import and click Open.

Use the directory menu as needed to navigate on your hard disk
in order to find the file. You can select either configuration or
complete sequence files.

3. If the Patch Lists window isn’t already open, choose it from the
Windows menu to view the imported list(s).

4. (Optional) If several of the imported lists belong to the same MIDI
device, create a folder in the Patch Lists window and place them in
the folder.

See “Grouping patch lists in a folder” on page 744. If the MIDI
device supports some form of bank select, you will want to set up
the bank select message for each list so that you can effortlessly
choose sounds from any bank. See “Using multiple patch lists &
bank select messages" on page 747.

5. To make the imported lists appear in Performer, assign them to
their appropriate device in the PatchList Manager Devices window.

See “Getting patch lists to appear in Performer” on page 740.
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Using PatchList
Manager to load
patch names

Determining if PatchList
Manager supports your
device

Getting device help

For some MIDI devices, PatchList Manager can get a system exclusive
bulk clump — also called a patch clump — from the instrument to
extract an accurate patch list (or lists). (See the side-bar on page 731
for an explanation of this term.) The most common situation in which
you would want to do this is when you have changed the sounds or
banks in the instrument (so that it is no longer in its factory default
state), and you would like the patch lists in Performer to reflect those
changes.

For example, if you have an E-mu Proteus, and you have changed the
patch map in order to access sounds above 128, you can use
PatchList Manager to get a new patch list with names that match the
current patch map. As another example, you may have loaded a new
bank of sounds into your Korg Ml and you would like the new bank
to appear as a patch list in Performer instead of the factory bank.

PatchList Manager can only get patch dumps from devices that it
specifically supports. To see if your device is supported, look at its
icon in the Devices window as shown below:

Not supported
Supported

F re eMIDI De Dices

A
BB K2500R

-> Ein Proteus/1 ■

V
£

If your device is not supported, chances are good that you can use
Unisyn, Mark of the Unicorn's universal editor/librarian software,
instead. Unisyn currently supports 212 MIDI devices (with more on
the way). See “Getting patch lists with Unisyn" on page 736- If you
don’t have Unisyn (yet), your only recourse at this point is to type in
the patch names by hand. See “Creating a patch list by hand” on
page 738.

If your device is supported by PatchList Manager, check its Device
Help window for important information about how to use PatchList
Manager with the device. This window often contains information
about settings that you need to enable/disable in the MIDI device to
successfully get a patch dump from it. It may also contain other
important and relevant information about the device.
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To check Device Help:

1. Click the device in the FreeMIDI Devices window to select it.

2. Choose Device Help from the Devices menu.

The Device Help window appears. This is the Device Help
window for the Ensoniq ESQ-M:

Make sure the device
has both its MIDI IN and
MIDI OUT connected

Getting a patch dump
from a device

V.-XlSlX'X'X'X'X'X'X'X'N, Device Help
Korg 05R/V
Before using the Get Patch Dump command, use the
05R/V’$ front pane) to manually turn off protection for
Programs and Combis (menu pages 03A and 03B), and
enable system exclusive in the Global MIDI filter menu (it
should read ’EXtENA’ on page 02C if you set it correctly).
You only have to set these once because the 05R/W
remembers the settings unless you change the battery or
perform a Preset Data Load from page 05C.

FreeMIDI automatically sets the 05R/W to Combination
mode the first time you choose a patch from the
Combinations patch list. This combi mode MIDI message is
not sent again unless you quit all FreeMIDI applications,
open a FreeMIDI application, and then choose a patch from
the Combinations patch list again.

H
l_______________

l£>lffll

Before you go further, make sure that the device has both its MIDI IN
and MIDI OUT connected to your MIDI interface. Otherwise,
PatchList Manager won’t be able to get the patch dump successfully.
If you add a connection at this time, use the Edit FreeMIDI
Configuration command in the MIDI menu to make sure both
connections are present in your FreeMIDI configuration.

Once you have checked device help and MIDI cable connections,
you are ready to get a patch dump from the device. By doing so,
PatchList Manager will automatically extract a patch list for each bank
in the device. To get a patch dump:

1. Click the device in the FreeMIDI Devices window to select it.

2. Choose Get Patch Dump from the Devices menu.

3. The Patch Dump progress dialog appears while PatchList Manager
receives the patch dump.

'** Depending on the format of the MIDI device’s sysex
data dump, this progress bar may fill up slowly or all
at once when the dump is complete.
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Sending the dump back
after editing it

Editing the bulk dump in
its raw hex form

]

Current Deuice: 05B/U)
Click Cancel or press command-period I.) to
cancel.

1
053

1
2555

1
50*

1
7555

1
10053

( Cancel ]

Two things happen when the patch dump is complete:

□ The factory default patch list is updated, and the updated
lists will automatically appear in Performer.

□ The device’s move handle icon changes slightly to indicate
that it contains a sysex data dump.

{S]'Plx<T\ FreeMIDI Deuices

Patch dump indicator-

t> EX K2500R
> exj Froteus/1
v 05R/V

~~^P Channel 1
P Channel 2
P Channel 3
P Channel 4

1 i 05R A/ banks; Sunrise
2 i 05R A/ banks i Sunrise
3 i 05R/V banks: Sunrise
4 : 05R A/ banks 1 Sunrise

For most instruments, PatchList Manager will allow you to edit the
patch lists (change names of sounds, etc.) and then send the bulk
dump back to the instrument to update the device itself. See "Sending
a patch list back to a configured device after editing it” on page 743.

If you enjoy doing such things, PatchList Manager lets you view and
edit bulk dump in its raw hexadecimal form. To do so:

1. Click the device in the FreeMIDI Devices window to select it.

2. Choose Edit patch dump from the Devices menu.

Use this section to

transmit any sysex

message you want
to the device.

Edit the hex data

directly here.

fo 42 30 36 4C 00 00 53 D06L S
75 6E 72 69 73 65 20 20 unrise
20 20 01 00 22 00 03 7F ..
41 00 01 0C 09 06 21 ID R . . . '
59 63 62 63 1D 00 00 00 Vcbc
00 32 00 00 00 00 40 00 .2 . . .«?.
00 02 00 00 00 00 00 39 . . .9
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Getting patch
lists with Unisyn

If you have a synthesizer or sound module that is not supported by
PatchList Manager, Unisyn can save you the trouble of typing in the
patch lists by hand. Unisyn is Mark of the Unicorn’s Universal Editor/
Librarian software. Unisyn supports 212 MIDI devices (more are on
the way) with complete library and editing functions. If PatchList
Manager doesn't support one of your MIDI devices, chances are that
Unisyn does. Contact Mark of the Unicorn to see if your device is
supported.

Unisyn specializes in getting banks from synths. When it gets a bank,
it automatically publishes the patch list for the bank to all FreeMIDI-
compatible programs. If you want to work further with it in PatchList
Manager, you can load this Unisyn-generated patch list into PatchList
Manager as follows:

1. Get the bank from the device using Unisyn’s Get Bank command.

Consult the Unisyn manual if you need help with this step. As
soon as Unisyn gets (or sends) a bank, it "publishes-’ a patch list
for the current bank to all FreeMIDI programs. In some cases, you
may need to transfer the bank into RAM before getting it. Consult
Unisyn’s profile help for the device.

2. Back in PatchList Manager, select the device by clicking its name
in the FreeMIDI Devices window.

XZ-t/ESISl-PT^'tS, FreeMIDI Deuices
t> EC3 K2500R
t> EJ2D Proteus/1
t> 5? 05R/V
t-OEBEHl'X

A

V
a

3. Choose Load FreeMIDI Patch Lists from the Devices menu.

The Unisyn-generated patch list is added to the bottom of the list
in the Patch Lists window. Some devices produce several lists.

\ FreeMIDI Deuices '.TPatch Lists
> EQ K2500R
> Ena ProteusZ1
t> q? 05RAZ ‘
t> O IDW-8000 |

I

__

♦ Proteus Z1 Presets
t> D K2000 banks
h D 05R/V banks

♦ DW-8000 Programs

128

64

The imported patch list---------------------
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4. (Optional) Rename the newly loaded patch list(s) by clicking its
name in the Patch Lists window.

This step is especially recommended if you are loading multiple
lists for a single device because it helps you better identify each
bank.

5. (Optional) If Unisyn produced several separate patch lists for the
device (one for each bank), create a folder in the Patch Lists
window and place them in the folder.

See “Grouping patch lists in a folder" on page 744. If the MIDI
device supports some form of bank select, you will want to set up
the bank select message for each list so that you can effortlessly
choose sounds from any bank. See “Using multiple patch lists &
bank select messages" on page 747.

6. To make the imported list (or newly created folder) appear in
Performer, assign it to the appropriate device in the PatchList
Manager Devices window.

See “Getting patch lists to appear in Performer” on page 740.

7. If the device has other banks that you want to import, repeat this
procedure for each bank.

For example, Unisyn may be able to import data card banks for
the device. In this case, you can import a patch list for each data
card. In fact, you can import as many banks as you want into
PatchList Manager and then place them together in a folder so that
you have all the names at your fingertips in Performer. If you do,
however, you’ll need to keep track of which banks are actually
loaded into the instrument at any given moment.
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Creating a patch
list by hand

If none of the methods discussed in the previous sections for creating
a patch list apply to you, you can create a new patch list manually
and type in the patch names by hand.

To create a new patch list:

1. Choose Add Patch List from the Patch Lists menu.

A new patch list appears at the bottom of the list. It is named
“PatchList 1”.

2. Click its name and enter an appropriately descriptive name for the
patch list.

vD General MIDI Lists
❖ Strings
❖ Basses
❖ Guitars
❖ Brass
♦ Pianos

12
10
8
7
6

ElPatchlist 1 , II
* V

a
3. Double-click the new patch list’s move handle icon to open its

patch list window.

The sound names window appears. Alternately, you can choose
the patch list’s name from the Windows menu to open its window.

Patchlist 1
PATCH NAME

"u 1 Patch 1
■u 2 Patch 2 ;
% 3 Patch 3
1 4 Patch 4
1 5 Patch 5
■j 6 Patch 6
■u 7 Patch 7
■u 8 Patch 8
■j 9
n < r>

Patch 9
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4. Choose Set Numbering Formatfrom the patch list window mini­
menu to set the numbering of the patch list.

See "Setting the numbering format for a patch list" on page 743 for
more information.

5. Click the first patch name in the list, “Patch 1 ” and type in a new
name.

6. Press the Return key on your Mac keyboard to confirm the edit, or
press the Enter key to move to the next name in the list.

Similarly, you can move up and down between patch names with
the up and down arrow keys.

Patchlist 1
PATCH NAME

1 2 i Patch 2
“u 31 Patch 3
1 41 Patch 4
■j 51 Patch 5
1 61 Patch 6

Patch

7. If you’d like to list the names alphabetically, choose Sort by name
from the mini-menu.

8. (Optional) If you are creating several separate patch lists for the
device (one for each bank), create a folder in the Patch Lists
window and place them in the folder.

See “Grouping patch lists in a folder” on page 744. If the MIDI
device supports some form of bank select, you will want to set up
the bank select message for each list so that you can effortlessly
choose sounds from any bank. See "Using multiple patch lists &
bank select messages” on page 747.

9. To make the new list (or folder) appear in Performer, assign it to the
appropriate device in the PatchList Manager Devices window.

See “Getting patch lists to appear in Performer” on page 740.
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Getting patch
lists to appear in
Performer

To make a patch list or patch list folder show up in Performer's
pop-up menus, you need to assign it to the device in PatchList
Manager's Devices window. You can assign the patch list to all of the
device’s MIDI channels, or you can assign it to individual channels.
You can even assign different lists to different channels. For example,
you might assign a drum kit list to channel 10 and a list of all other
sounds to channels 1-9 and 11-16.

To assign a patch list or patch list folder to all of a device's MIDI
channels at once:

1. In the FreeMIDI Devices window, press in the Patch List column to
the right of the device name.

A pop-up menu of patch lists appears.

XZ'XtBFreeMIDI Deuices
xzQ DY/-8000

/J Channel 1
'7EC23K2500R

Jl Channel 1
Ji Channel 2
Jl Channel 3
Ji Channel 4
Ji Channel 5
Ji Channel 6
Jl Channel 7
Ji Channels
Ji Channel 9
Ji Channel 10
JI Channel 11
Ji Channel 12
Ji Channel 13
Ji Channel 14
Ji Channel 15
Jl Channel 16

t> raj Proteus/1

1

;

8
9

10
11
12
13
14
15
16

■--------------

lick here

A

V

FreeMIDI Deuices

DY/-8000 Programs
Proteus/1 Presets

tzQ DY/-8000
jl Channel 1 i

rr Q3 K2500R 1
Ji Channel 1 Hi
Jl Channel 2 z
Jl Channel 3 7
Jl Channel 4
Jl Channel 5 5
Jl Channel 6 6
Jl Channel 7 7
jl Channel 8 8
Jl Channel 9 9
Jl Channel 10 10
jl Channel 11 11
Jl Channel 12 12
Jl Channel 13 13
jl Channel 14 14
Jl Channel 15 15
jl Channel 16 16

> raj Proteus/1

K2000 banks

FreeMIDI Deuices
ov-eooo j A

Jl Channel 1 1
ran K2500R
Jl Channel 1 j 1 K2000 banks}
Jl Channel 2 2 K2000 banks i
Jl Channel 3 i 3 K2000 banks!
Jl Channel 4 4 K2000 banks;
jl Channel 5 5 K2000 banks:
jl Channel 6 I 6 K2000 banks
jl Channel 7 1 7 K2000 banks
Jl Channel 8 8 K2000 banks
Jl Channel 9 | 9 K2000 banks
Jl Channel 10 >10 K2000 banks
Jl Channel 11 11 K2000 banks
jl Channel 12 12 K2000 banks
jl Channel 13 13 K2000 banks
Jl Channel 14 14 K2000 banks
Jl Channel 15 15 K2000 banks
Jl Channel 16 16 K2000 banks Vt> ras Proteus/1

2

2. Choose the desired patch list.

To assign a patch list to an individual MID channel:

1. If the MIDI channels for a device are hidden, click the Expand
button to display them.

Expand button

FreeMIDI Deuicet
DEUICES/MODULES CH. PATCH LIST CURRENT

l> Q Vintage Keys

1
2

A
J? Channel 1

Channel 2

2. Press in the Patch List column next to the MIDI channel and choose
the desired list from the pop-up menu.
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Making
changes to a
patch list

Opening up a patch list

In a patch list, you can:

■ Edit the names of the sounds

n Change their order in the list by dragging them up and
down

b Sort them by numerically or alphabetically

b Change the numbering scheme

a Change the patch change number for any sound

To open a patch list, double-click the patch list's name or move
handle icon to open its patch list window.

Vz'BiffSfo, UJauestation SRWavestation SR

00
01
02
03
04
05
06
07
08

8
128

Layers Of Funk
Leaving the Pod
Vocal Highlands
MIDI Piano
0D Mini 2
Saw Bass
Bliss Pad
AFT Vocal Pad
Guitaro

PATCH HUME

LENGTH

199
128
128

-429-
128

16
64

NAME_____________________

♦ K2000 Programs
♦ Proteus/1
♦ Proteus/2

■Aesq-m

♦ Roland JV880 Perform
♦ Roland JV880 Patch

vD 05R/W Banks
♦ Drum Kits
♦ Bank G

The sound names window appears. Alternately, you can choose
the patch list’s name from the Windows menu to open its window.
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Editing a patch list Here is a summary of what you can do in the patch list:

To do this Do this

Change the name of a .sound Click the patch name in the list that you wish to edit, enter a new
name and press the Return key on your Mac keyboard to confirm the
edit. The new name appears. If you press the Enter key instead of
Return, the edit is confirmed and the next patch name is ready for
editing. Similarly, you can move up and down between patch names
with the up and down arrow keys.

Ulauestation SR
PATCH HflME

Lauers Of Funk
[Leaving the Pod

1 00
1 01
1 02 : Vocal Highlands
4 03 ; MIDI Piano

To move a sound up or down in the list Drag its handle

To sort the sounds alphabetically Choose Sort by name from the mini-menu

To sort the sounds numerically Choose Sort by number from the mini-menu

To change the numbering scheme Choose Set Numbering format from the mini-menu. For more infor­
mation, see “Setting the numbering fonnat for a patch list” on
page 743.

To create a custom numbering scheme Choose Show ASCII String from the mini-menu. For more informa­
tion, see “Creating a custom numbering format” on page 743-

To change the overall number of
sounds

Same as above

To make the numbering start at 0
instead of 1 or vice versa

Same as above

To set up a bank select message for the
list

See “Using multiple patch lists <Sr bank select messages" on page 747

To change a sound’s patch number Click its current patch number
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Setting the numbering
format for a patch list

Creating a custom
numbering format

Sending a patch list
back to a configured
device after editing it

Most MIDI devices number the sounds in a bank using one of several
common conventions. For your convenience. PatchList Manager lets
you choose the numbering scheme that most closely matches the
instrument. To set the numbering format, choose Set Numbering
format from the sound names window mini-menu or click in the
Length column. Choose the appropriate options and click OK.

You can always change the format, but you can't
change the number of patches in the list after it has
been assigned to a device MIDI channel. If you need
to do so, you have to temporarily de-assigned it, make
the change, and then reassign it.

DUt-8000 Program?
Sort by Name
Sort by Number

Set Numbering Format
Set Bank S-^ct...
Set MIDI Message...
Set Channel

Gbnw Bank Select
✓ Show Program Change
✓ Show ASCII String

■u 10 J 23: GuitarPiano
t 11 24 { HonkTonkPno
•i 121 25 J Clavinet

-------j-1 Numbering Format
...... . ...................

Preset A

Patches: Digits:
Q Zero-based O One

O One-based Two
■§) Roland Q Three

Number of patches:

Divide into |o | banks

Examples:
11 Patch 1
88 Patch 64

Figure 48-6: Setting the numbering format

If your device has a specialized numbering scheme, use the Show
ASCII String command in the mini-menu instead. This displays a
column in the patch list in which you can type any number or text
string next to each patch. This gives you complete flexibility in setting
up the patch numbers. Use the Show Program Change and Show
ASCII String commands to hide the program change column and
display the ASCII numbers.

If the patch list you are editing is one that you loaded from a
configured device using the Get Patch Dump command, making
changes in the patch list may also change the patch dump, depending
on the device. Check the device’s Device Help (see “Getting device
help" on page 733) to see what the patch dump actually contains (it
varies by instrument). If the patch dump only contains the patch 
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Duplicating a patch list

Grouping patch
lists in a folder

l names , then you can only change the names of the sounds when you
send it back to the instrument. If the patch dump is a complete bulk
dump of the whole instrument, you may be able to control other
aspects of the bank. Device Help will give you specific advice for
your instrument.

At times, you may need to duplicate a patch list to make a separate
copy of it. For example, you may want to place the list in more than
one folder. To duplicate a patch list:

1. Click the patch list move handle to select it.

2. Choose Duplicate from the Patch Lists menu.

A patch list folder allows you to group several patch lists together.
You can then assign the folder to a MIDI channel, which makes all of
the lists available to it. The resulting pop-up patch list for the MIDI
channel is hierarchical and shows each patch list as shown below.

A^freeMIDI PeuiceT

A11 Killer Pad
At 2 Pulse Pad
A13 Lovely Vox Pad
Al4 Tempest
Al 5 Deep Breath Pad
A16 Pure Glass
Al 7 Cherish
Al 8 GlassVoices
A21 Ac. Piano 2
A22 Ac. Piano Hybrid
A23 Crystal Rhodes 2
A24 E. Piano I
A25 E. Piano 2
A26 Agogo Rhodes
A27 Seq E. Piano
A28 Y/hispery Piano
A31 Pipe Organ

A51 12 String Guitar
A52 Clang Guitar
A53 Stratomaster PJ

| A54 That 's Funky
A55 Ghina Guitar
A56 Reso Strat
A57 Big Country
A58 Velo-Crunch
A61 Fretless Bass
A62 Voody Bass
A63 Velo-Switch Bass
A64 Slap Bass
A65 Pick Bass
A66 Fingered Bass
A67 Flubber Bass
A68 House Bass
A71 Rubber Bass

Patch 85
Patch 85
Patch 85
Patch 85

Preset B ►
Internal

t> O SoundCanvas
t> Q 05R/Y/
t> Q Proteus/1
•^O JD-990

i 'TiTF-l 1> li»<-M '■
/J Channel 2 2 JD-990 Folder
/J Channel 3 3 JD-990 Foldet 1
P Channel 4 4 JD-990 Folder?
P Channel 5 5 JD-990 Folder!
P Channel 6 6 JD-990 Folder i
p Channel 7 7 JD-990 Folder!
p Channel 10

VH-JMI
P Channel 1

10

1

JD-990 Folder i

Folders are ideal for handling devices that have multiple banks, and
therefore multiple patch lists. For more information about multiple
banks, see “Using multiple patch lists & bank select messages" on
page 747.

To group patch lists in a folder:

1. Choose Add Folder from the Patch Lists window mini-menu.

The folder appears at the bottom of the list.
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2. Click its name to rename it.

[Folder 1

❖ Wavestation SR i 128
❖ ESQ-M [ 128
❖ Drum Kits 8
❖ Bank A -100
❖ Bank G | 128
❖ Roland JV880 Patch ; 64

t> n General MIDI Lists i

3. Drag each list on top of the new folder by dragging the diamond list
icon.

Once inside the folder, the lists are indented to the right to
indicate that they are inside the folder, just like the System 7
Finder. Use the show triangle to show or hide the patch lists in the
folder. You can put as many patch lists as you like in the folder.
You can use this feature to help organize patches.

patch Lists
NAME LENGTH BAKU USED COMMENT

I Drum Kits

lQ5R7y"Banks'
100
128

128
128

8
64

K2000 Programs
Proteus/1
Proteus/2
Roland JV880 Perform
Y/avestation SR
ESQ-M

Bank A
♦ Bank G

♦ Roland JV880 Patch
> Q General MIDI Lists

199
128
128

4. Assign the folder to the device it is intended for.

See "Getting patch lists to appear in Performer” on page 740 for
information about how to do this.

5. (Optional) If you want a particular bank in the folder to appear on
only certain MIDI channels for the device, use the Set Channel
Mask command in the patch list’s mini-menu.

See the next section for more information.
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Making a patch list
appear on only certain
MIDI channels

When yon place multiple patch lists in a folder and then assign the
folder to the entire device as described in “Getting patch lists to
appear in Performer” on page 740, all of the patch lists in the folder
will appear on all the device’s MIDI channels. In some cases,
however, you may want to limit the channels on which a particular
patch list appears. For example, if your MIDI instrument only plays
drum kits on channel 10, you'd want the drum kit patch list to appear
on channel 10 only, and you’d want all of the other patch lists to
appear on channels 1-9 and 11-16. To do so, you can set the channel
mask for each patch list in a folder. The channel mask lets you
choose which channels the patch list will appear on. This can only be
done on patch lists that currently reside inside a folder.

To set the channel mask for a patch list:

1. Open the patch list by double-clicking its diamond move handle in
the Patch Lists window.

2. Choose Set Channel Mask from the mini-menu.

If this command is grayed out, the patch list is not in a folder yet.

n

2(

Set Channel J4a$k...

32
48

00
32
48
16

Sort by Name
Sort by Number

Set Numbering Format..
Set Bank Select...
Set MIDI Message...

2^ Show Bank Select
1 •'Show Program Change

Show ASCII String

GM Kit
Jazz Kit
Orch Kit
Power Kit

3. Click the channels as necessary so that the channels on which you
want the list to appear have a black dot.
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Using multiple
patch lists &
bank select
messages

Determining your
device’s bank select
implementation

Which banks can be
accessed via bank
select?

Does the device use one
controller or two for the
bank select message ?

For devices that support MIDI bank select messages, set up a folder
containing one patch list for each bank. (See the earlier sections of
this chapter to learn how to do this.)

Once you’ve arranged all the banks into a folder and assigned the
folder to the MIDI channels for the device, all that is left to do is
assign the appropriate bank select number to each patch list.

Once you’ve set up a device in FreeMIDI for bank select, you need
to find out is how your MIDI device handles bank selection. This can
get a little tricky. All MIDI devices that support bank select do so a
little differently. And often you'll have to wade through the MIDI
implementation charts in the back of the manual.

The following sections tell you what you should find out about your
synth.

The most important thing to know about a bank is: can it be called
up with a bank select message and can items within the bank be
called up with a MIDI program change event?

Try' to get a feel for what the banks are. Some banks are not actually
sounds. Instead, they consist of internal configurations for the synth,
such as multi-timbral setups (like Yamaha and Korg multis) or
multiple layers of sounds (such as combis). Some banks represent a
card slot and are therefore only available when a card is present.
Banks can be designated as General MIDI, which means that they
contain a standard set of sounds or drum kits. Some banks are drum
kits only and may only be available on certain MIDI channels (usually
channel 10).

Some devices use a single MIDI controller, either =0 or =32. Others
use both.
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What is the controller
value for each bank?

Setting up bank select
devices in FreeMIDI

i MIDI controllers have a number that identifies them (such as #32),
but they also have a value between 0 and 127. The controller number
identifies the controller as a bank select message, and its value calls
up a specific bank. Here’s an example:

Bank: Controller used to call it up:

Bank A Controller =32, value 0

Bank B Controller #32, value 1

Bank C Controller =32, value 2

If your device uses both controller #0 and #32, be sure to obtain the
value for both for each bank.

The fun part about this is that often the device’s manual gives you this
information in hexadecimal form. Don’t worry'. PatchList Manager lets
you use the hexadecimal numbers without even knowing what they
are.

Once you are armed with the information above, you are ready to
proceed.

To use bank select messages with a MIDI device, you first need to tell
FreeMIDI which MIDI controller the device uses for bank select:

1. Open FreeMIDI Setup.

If you are running Performer or PatchList Manager, choose Edit
FreeMIDI Configuration from the Basics menu or MIDI menu,
respectively. If are running neither, double-click the FreeMIDI
Setup program in the FreeMIDI applications folder on your hard
disk.

2. Double-click the icon for a MIDI device that supports bank select.

The Device Specification window appears.
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Assigning a bank select
number to a patch list

FreeMIDl Deulce Specification

3. Choose the appropriate bank select device properties from the
Properties pop-up menu.

If the synth uses both controllers for bank select, choose both
bank select properties. See “Determining your device’s bank select
implementation” on page 747 if you need help with this step.

4. Click OK to confirm your choice.

5. Repeat this procedure for each device in your FreeMIDl setup that
uses bank select.

Now you are ready to assign the bank select controllers to each patch
list:

1. Places all of the patch lists together in a folder.

See “Grouping patch lists in a folder” on page 744.

2. Click in the Bank column to the right of the Patch List name.

The Bank Select dialog box appears.

3. Choose the necessary number format, and type in the correct bank
select number or numbers.

If the bank number information you got from the device's manual
is in hexadecimal format, you'll need to choose the Hexadecimal
option. Otherwise, use decimal format.
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What to do if bank select
doesn’t work

Assigning additional
MIDI messages to a bank

------------- ----------pH Bank Select

Bank Select Format:

Q No Bank Numbers Decimal
© One Number O Hexadecimal
Q Two Numbers

Bank Select Number:

4. Click OK when you are done.

5. Repeat this procedure for each bank.

6. Assign the folder to the MIDI channels for the device.

See “Getting patch lists to appear in Performer” on page 740.

Once bank select messages are assigned as described in the previous
section, you can choose any patch from the pop-up patch lists in
Performer, PatchList Manager, and FreeMIDI setup, and doing so
should call up the correct sound from the correct bank.

If it doesn’t, check to make sure that the device has been given the
proper Bank Select device property in your FreeMIDI setup. To do
so, choose Edit FreeMIDI Configuration from the MIDI menu.

Next, check the synth. Sometimes they have a mode that makes them
ignore bank select or program changes. Still no response? Then the
controller information you have is probably incorrect, or perhaps the
instrument still isn’t in the correct mode. Or the actual MIDI
connections between FreeMIDI and the synth are somehow not
working correctly.

Some devices don’t use controller #0 or *32 for bank select and use
another type of MIDI message instead. For these devices, you can
type in any MIDI message the device calls for. This includes system
exclusive data, a MIDI program change event with certain value, or
any other type of event.
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To assign a MIDI message to a patch list:

1. Open the patch list by double-clicking its icon in the Patch Lists
window.

2. Choose Set MIDI Message from the mini-menu, or click in the
“CM?” column in the Patch Lists window next to the patch list.

Saving your
patch lists

3. Choose the desired number format (either decimal or hexadecimal)
and type in the MIDI message.

4. Click OK when you are done.

Now, the MIDI message you entered will be automatically sent
whenever necessary to call up the bank (such as at the beginning of
a session or when you change banks).

When you are clone setting up your patch lists, you need to save your
work:

1. Choose Save from the File menu.

2. Type in a name for the patch list file.

3. Click Save.

PatchList Manager then saves the entire contents of the FreeMIDI
Devices and Patch Lists windows in a file on your hard disk. In
addition, PatchList Manager tries its best to stay in sync with the
FreeMIDI devices in your current FreeMIDI Configuration. Each
PatchList Manager document is associated with a specific FreeMIDI 
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Configuration. If you change FreeMIDI Configurations, PatchList
Manager will close the current file and open the file associated with
the new, current FreeMIDI Configuration. If you change back to a
FreeMIDI Configuration, PatchList Manager will automatically use the
corresponding PatchList Manager file.

Hot tips
Splitting up a patch list
into instrument
categories

Here are some things you can do with PatchList Manager.

PatchList Manager allows you to organize the sounds in an device
into instrument categories as shown below in Figure 48-8. To do so,
you will make one copy of the patch list for each category. In the list,
you’ll move the patches that you want to appear in the category to
the top of the list, and then hide the rest. Finally, you'll group the lists
into a folder and give them an appropriate name for each category.

5

8

10

Piano 1

p Channel 3
P Channel 4
P Channel 5
P Channel 6
P Channel 7
P Channel 8
P Channel 9
P Channel 10
P Channel 11
P Channel 12
P Channel 13

Organ
Guitar
Bass
Strings/Orchestra
Ensemble
Brass
Reed
Pipe
Synth Lead
Synth Pad
Synth FX

003 Piano 3
004 HonkyTonk Piano
005 E. Piano 1
006 E. Piano 2
007 Harpsichord
008 Clavinet________

3

V.'f'tSJ l£llP FreeMIDI Deulces
SoundCanvas __ b

______________ f.ijrp______________

Ethnic ►

Sound FX
Drum Kits
SFX

Figure 48-7: Patch lists that have been
organized into instrument categories

To split up a patch list into instrument categories:

1. Duplicate the original patch list.

For information on duplicating a patch list, see “Duplicating a
patch list" on page 744.

2. Rename the duplicate list with the category name, such as Pianos
or Basses.

Click the name of the patch list in the Patch Lists window to pop­
edit the name.
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Getting back the factory
default patch Lists
provided by FreeMIDI

3. Double-click the move handle of the list to open it.

4. Drag the sounds that belong to that category to the top of the list.

A short cut for this is to type in a space at the beginning of the
name of each sound and then choose Sort by name from the mini­
menu. When you are done, you can remove the spaces.

5. Count the number of patches that are now at the top of the list that
you want to include in the category.

6. Choose Set Numbering Format from the patch list mini-menu and
type in the number of patches you just counted.

The list now displays only the patches you chose for the category.

7. Repeat this procedure, starting at step 1, for each category you
would like to create.

8. After you have created a separate patch list for each category as
described in this procedure, place them together in a folder.

See “Grouping patch lists in a folder" on page 744.

There may be times when, after assigning your own patch list (or
folder) to a device, you want to return to the factory' default patch
lists that were originally provided for the device by FreeMIDI. To
restore the factory default patch lists, choose None from the Patch List
column next to the device name in the Devices window as shown
below.

Figure 48-8: Restoring FreeMIDI's original
factory default patch lists for a device

FreeMIDI Deuices
DEUICES/MODULES CH. PATCH LIST CUF.F.EHT PATCH COMMEN

Channel 14 14 i Morpheus banks | a
fl Channel 15 15 i Morpheus banks
/J Channel 16 16 i Morpheus banks _______ n

XZSEH 05R/W ✓None. 1 ta
/J Channel 1 Il — R
fl Channel 2 21 Morpheus banks 1
fl Channel 3 3 K2000 banks 1 ®

"1 X5 banks
| 05R/W banks
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Duplicating MIDI
channels in a device

In PatchList Manager, the MIDI channels listed below a device are
called modules. Modules are added to Devices automatically by
PatchList Manager. The number of modules added and their MIDI
channel assignments are based on the number of MIDI receive
channels specified for the device in FreeMIDI Setup.

There is rarely a need to do so, but you can add, edit, and delete
modules for a device.

To add modules:

1. In the FreeMIDI Devices window, select a device to which you wish
to add a module.

2. Choose Create Module from the mini-menu.

The new module appears at the bottom of the selected devices
module list.

3. [Optional] Assign a MIDI channel for the module by selecting it
from the pop-up menu in the CH column.

4. [Optional] Enter a name for the module by clicking its name and
then typing.

To delete a single module:

1. In the FreeMIDI Devices window, select the module you wish to
delete.

Shift-click modules to select more than one.

2. Choose Delete Module from the mini-menu.

To delete all modules for a device:

1. Select the device itself (not one of its modules).

2. Choose Delete Module from the mini-menu.
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Chapter 49 Editing FreeMIDI Device Files

Working with
FreeMIDI Icons
Adding or Replacing
Icons to FreeMIDI

This chapter explains how to:

□ Edit the icons that FreeMIDI uses to display devices in the
FreeMIDI Configuration window.

□ Add devices to the FreeMIDI Devices file so that MIDI
devices that are in your studio but not already defined in
the current version of FreeMIDI will appear in the
manufacturer and model name pop-up menus in places
such as the Quick Setup dialog box and the FreeMIDI
Device Specification dialog box.

You can add, delete, and edit icons that ship with FreeMIDI so that
you can customize the look of your FreeMIDI configurations.

To add icons to FreeMIDI’s icon list:

1. Copy the icon you wish to add from your icon editor to the
Clipboard, so that it will be ready to paste.

When you create an icon, note that there are actually three sizes
for the display in FreeMIDI: small, medium, and large. If you make
an icon for each size, you’ll need to paste in the three icons one
at a time using this procedure.

2. If you have not done so already, open FreeMIDI Setup by double­
clicking its icon in the Finder. Alternately, you can open FreeMIDI
Setup by choosing the Edit FreeMIDI Configuration command in
any other FreeMIDI application.

The FreeMIDI Configuration window will open displaying the
current FreeMIDI configuration.
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3. Choose Create Device from the Configuration menu or type
command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears.

............. FreeMIDI Device Specification =

Name: EPS-M Device ID:

Manufacturer:
j Ensoniq

Model:
| EPS-M

1
(1-16)

Transmit Channels:
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16n~mrr~mrTT~nr~n-n

Receive Channels:
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Properties: | Controller,... v

1^'"

Controller,, Receives Clock, Transmits Clock

Studio Location:
| MIDI Time Pieces, Mod..?")

Cable:
I 3 I

Figure 49-1: FreeMIDI Device Specification Dialog Box
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4. Click Icons or type command-! on your Mac keyboard.

The Device Icons dialog box appears.

----- . --- Deuice Icons ..------

Deuice Name: Proteus/2

Figure 49-2: Icons Dialog Box

5. if you want to replace an existing icon, scroll to it now.

6. Click one of the three boxes shown to select the size of the icon
that you are pasting.

FreeMIDI has three possible sizes at which it can display the
device icon. Each size is shown in the boxes. Click the box into
which you want to paste.

7. Click Paste to paste the icon from the Clipboard into FreeMIDl’s
icon set.

If there is an icon currently selected, you are asked whether you
want to replace the current icon or create a new icon.

8. If you want to add a new icon, choose the create option and the
new icon options.

The icon is added to FreeMIDl’s icon set and you can assign it to
any FreeMIDI device.
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9. If you want to replace the existing icon, choose the replace option.

The icon replaces the currently selected icon. For more
information, see “Editing FreeMIDI Devices" on page 693.

10. Click OK to close the Icons dialog box.

The FreeMIDI Device Specification dialog box reappears.

11. Click Cancel to close the FreeMIDI Device Specification dialog box.

If you do not cancel the FreeMIDI Device Specification dialog
box, you are adding a FreeMIDI device to your FreeMIDI
configuration.

Deleting FreeMIDI Icons To delete icons from FreeMIDFs icon set:

1. If you have not done so already, open FreeMIDI Setup by double­
clicking its icon in the Finder. Alternately, you can open FreeMIDI
setup by choosing the Edit FreeMIDI Configuration command in
any other FreeMIDI application.

The FreeMIDI Configuration Window opens displaying the current
FreeMIDI configuration.

2. Choose Create Device from the Configuration menu or type
command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears as shown
in Figure 49-1 on page 756.

3. Click Icons or type command-1 on your Mac keyboard.

The Icons dialog box appears as shown in Figure 49-1 on
page 756.

4. Use the horizontal scroll bar and arrows to scroll the FreeMIDI icon
list until you see the icon you wish to delete in the center panel.

Alternately, you can click icons to the left or right of the center
panel and they will be scrolled to the center panel.

5. Click Cut.

Since this operation cannot be undone, you are asked to confirm
this deletion.
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Editing FreeMIDI Icons

6. Click OK to close the Icons dialog box.

The FreeMIDI Device Specification dialog box reappears.

7. Click Cancel to close the FreeMIDI Device Specification dialog box.

If you do not cancel the FreeMIDI Device Specification dialog
box, you are adding a FreeMIDI Device to your FreeMIDI
Configuration.

To edit icons in FreeMIDI's icon set:

1. If you have not done so already, open FreeMIDI Setup by double­
clicking its icon in the Finder. Alternately, you can open FreeMIDI
setup by choosing the Edit FreeMIDI Configuration command in
any other FreeMIDI application.

The FreeMIDI Configuration window opens displaying the current
FreeMIDI configuration.

2. Choose Create Device from the Configuration menu or type
command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears as shown
in Figure 49-1 on page 756.

3. Click Icons or type command-1 on your Mac keyboard.

The Icons dialog box appears as shown in Figure 49-1 on
page 756.

4. Use the horizontal scroll bar and arrows to scroll the FreeMIDI icon
list until you see the icon you wish to edit in the center panel.

Alternately, you can click icons to the left or right of the center
panel and they will be scrolled to the center panel.

5. Click Copy to copy the icon to the Clipboard.

6. Click OK to close the Icons dialog box.

7. Click Cancel to close the FreeMIDI Device Specification dialog box.

8. Launch your icon editing program and paste the icon into your
editing program.
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Preserving Your Custom
Icons

Editing Text File

9. Make the icon look the way that you want and then copy it back to
the Clipboard.

10. Choose Create Device from the Configuration menu or type
command-K on your Mac keyboard.

The FreeMIDI Device Specification dialog box appears.

11. Click Icons or type command-l on your Mac keyboard.

The Icons dialog box appears.

12. Click Paste to paste the icon from the Clipboard into FreeMIDI’s
icon set.

You are asked whether you want to replace the current icon or
create a new icon. The new icon is added to FreeMIDI’s icon set
and you can assign it to any FreeMIDI device. For more
information, see “Editing FreeMIDI Devices” on page 693-

13. Click OK to close the Icons dialog box.

The FreeMIDI Device Specification dialog box reappears.

14. Click Cancel to close the FreeMIDI Device Specification dialog box.

If you do not cancel the FreeMIDI Device Specification dialog
box, you are adding a FreeMIDI device to your FreeMIDI
configuration.

Icons are stored in a file called FreeMIDI Icons, which is located in
the FreeMIDI Folder in the System Folder. If you create your own
icons and paste them into FreeMIDI as described in this chapter.
make a copy of the FreeMIDI Icons file as a backup copy so you
don’t lose your work.

Edit the text within the FreeMIDI Devices text file so that FreeMIDI
can have more information about various MIDI devices than the
information that was shipped with your version.

760 Editing FreeMIDI Device Fites



To edit the text in the FreeMIDI Devices file:

1. Open your text editor application.

You can use any text editor which can save files in a "text only"
format. Even the TeachText application from Apple will work.

2. Open the FreeMIDI Devices file.

This file is found within the FreeMIDI Folder that is located inside
your System Folder.

3. Enter the information that you wish to add.

The file contains a description of the data format that is required
by FreeMIDI. Enter the information about devices following this
format. If you do not understand this format by reading these
descriptions, we suggest that you have someone else do this type
of editing for you.

4. Save the file in the “text only” format.

TeachText does this automatically.

5. The next time you open FreeMIDI Setup your changes appear in the
various pop-up menus.
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AppendixA Synchronization Specifications

MIDI Beat
Clocks

Technical Specification

This appendix describes the synchronization formats supported by­
Performer.

MIDI beat clocks (also called MIDI clock) are a standard form of
synchronization which may be transmitted between two MIDI
devices. Using MIDI beat clocks requires no synchronization code
conversion box; the signals are simply carried on a MIDI cable along
with other MIDI information. To synchronize MIDI beat clocks to
other forms of sync code, such as FSK or SMPTE time code, you must
use a converter which translates from the audio code to MIDI beat
clocks.

MIDI beat clock synchronization consists of five different MIDI
messages: start, timing clock, stop, continue, and songposition. These
messages are transmitted from the MIDI Out of the master to the
MIDI In of the slave.

Start signals the slave to prepare to begin playback from the
beginning of the sequence. Playback does not actually begin until a
timing clock is received.

Timing clocks are sent 24 times per quarter note. These keep the
slave locked to the master. Because the signals are based on the
quarter note, the master controls tempos.

Stop signals the slave to stop playback.

Continue resumes playback. If the last signal was a stop, the first
timing clock following the continue message is the one which follows
the last timing clock sent before the stop. Thus, it is as if the stop and
continue messages never happened, and the timing clocks had just
kept on going. However, if the last message was a song position, the
first timing clock following the continue message is the timing clock
specified by the song position message.
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Variations in MIDI
Implementation

Song position signals the slave to rewind to a specified position, and
prepare to resume playback. The position is specified in multiples of
6 timing clocks (sixteenth notes). The position value is only 14 bits
long. In 4/4 time, this limits the range to 1024 measures.

Some MIDI equipment only implements part of the MIDI clock
synchronization specification. This can cause confusion when used
with Performer, which implements the full specification.

Timing clocks only. Some equipment only sends and receives timing
clocks. When slaving such a device to Performer, you must rewind
the device manually. Since there is no positioning control, Performer
will begin at the current Counter location, and the device will begin
playing wherever it is located. You must make sure the two positions
match manually.

When slaving Performer to this type of device, you must set the Start
on any clock option in the Receive Sync dialog box. As above, you
must make sure that both the device and Performer are positioned to
the same location before starting the device.

Start/stop (and timing clocks) only. The device can only begin
playback from the beginning of its sequence. Performer will slave to
such a device without problems. If you slave the device to Performer,
it will only start playing if you start at the beginning of the Performer
sequence. Note that some devices do not send a continue command
via MIDI, even if they have an internal continue feature.

Start/stop/continue (and timing clocks) only (no song position).
Performer slaves properly to such a device. When slaving the device
to Performer, you must be careful when rewinding Performer:

If you stop Performer and then start again without rewinding, the
master and the slave will remain in sync.

If you stop Performer, cue in either direction, and start again,
Performer will begin at the location you moved to but the slave
device will begin where it had last stopped. No song position
command is passed, and the two will no longer be in sync.
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DirectTime Lock
(Enhanced)

Technical Specification

If you rewind to the beginning of the sequence and start Performer
again, Performer will send a start command. The slave will respond
to this and start correctly at the beginning of the sequence, and
master and slave will remain in proper synchronization.

Enhanced Direct Time Lock (DTLe) is a synchronization standard
which allows Performer to easily lock to SMPTE or other time code
through a converter supporting this standard, such as Mark of the
Unicorn’s MIDI Time Piece™. What follows is a detailed technical
specification of the standard and its implementation in Performer.
This specification is a revision of the original Direct Time Lock
specification released in June, 1987.

There are two messages associated with direct time lock: full frame
and frame advance. The full frame message should be sent when the
time code source (such as a tape machine) is started and the
converter first achieves lock, followed by a full frame message once
per second while the converter maintains lock. The message is
implemented as a system exclusive message. The data specifies the
full frame in hours, minutes, seconds, frames.
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<full frame>

<F0H> <00H> <33H> (Manufacturer's ID)

<7FH> (Universal real time mes­
sage)

<0CH> (DTL full frame message
ID)

<0nH> (MTP network specifier)
n = 0 specifies Box 1-8
n = 8 specifies Box 9-16

<OffhhhhhB> (ff specifies SMPTE time­
code frame rate, and hhhhh
specifies the hour from 0 to
23.)
ff = 00 specifies 24 fps
ff = 01 specifies 25 fps
ff ~ 10 specifies 30 drop
ff = 11 specifies 30 non-drop

<mmH> (Specifies minutes from
0 to 59

<ssH> ((Specifies seconds from
0 to 59

<ffH> (Specifies frames from
0 to 29

<F7H> (End of message)

The full frame message is a starting reference for the frame advance
messages; it need not be sent in synchronization with anything. A
converter may wish to send the message a few frames before the
specified frame is reached.

The frame advance message is sent four times each frame. The first
frame advance sent after a full frame message corresponds to the
beginning of the frame specified in the full frame message. Successive
frame advances correspond to successive frames.

<frame advance> :== <F8H>
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Performer’s Direct Time
Lock Implementation

The frame advance message is the same as the standard MIDI clock
message used in normal MIDI sync. This message is a real time
message as defined by MIDI, and may be inserted in the middle of a
normal MIDI message for minimum timing delay.

While the tape is running, the converter should send a tape position
message once per second. These messages should be sent between
frame advances. As with the initial full frame message, the frame
advance following the full frame message corresponds to the
beginning of the frame specified in the full frame message.

Sending periodic full frame messages allows slave devices to come
on line at any time and sync up to the master. Periodic full frame
messages also ensure that any slippage due to data loss over the MIDI
line is corrected.

If Direct lock mode and Slave to External Sync are selected and the
Play button is grey, Performer waits for a full frame message. When
one is received, the sequence is rewound to that point and playback
is readied. When frame advances are received, Performer advances in
sync with the frame messages, playing the sequence. This continues
until one of two things happens.

If more than 8 frames of time pass without a frame advance message,
Performer assumes playback has been stopped. The sequence is
stopped (notes are turned off), and Performer begins looking for a
full frame message again.

When another full frame message is received, Performer compares
the position in the message to the current playback position. If they
are the same, Performer does nothing. Otherwise, Performer makes
whatever adjustment is needed. If the full frame message is not close
to the current location, Performer immediately stops playback and
rewinds to the new location. Playback is then readied at the new
location, and frame advances are looked for.

If you are designing a converter, you should be aware of the
automatic time out. If your converter has the capability to sync to
slow tape motions (tape rocking), it should send full frame messages
only without frame advances when doing so. It is also not
recommended that you send frame advances at high speed when the
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tape is cueing rapidly. It’s better to stop sending frame advances, and
then send a new full frame command when the tape returns to
normal playback speed.

If the tape is being rewound, the converter should stop sending
messages and wait until the tape is moved forward again. At that
point the first full frame message should be sent.
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Appendix B Troubleshooting and Customer
Support

Preventing
Catastrophe

Write-protected (Hole is open)

Troubleshooting

Keep up-to-date backups of your sequences as you work, so that you
always have copies of the most recent work you have clone. Almost
any software problem is survivable as long as you have kept backups
of your work. Refer to Helpful File and Disk Hints in the chapter
Working With Files for detailed suggestions about file management.

Keep plenty of free space (20K or more) on any disk containing
sequences which you are actually working on. This will prevent the
Macintosh from attempting to save your file onto a disk that doesn't
have enough space for the whole file. Running out of disk space
while saving can result in an unreadable and irretrievable sequence.

Keep track of your RAM (Random Access Memory) usage with the
Memory Window, and save often. Recording and editing both use a
great deal of RAM. Also watch the Message Center — it will
sometimes warn you that a recording pass or a requested edit
operation requires more memoiy than is available. In this situation,
tty recording or editing the region in smaller sections; for example,
transpose a 20-track, 200-measure sequence 5 tracks at a time.

Keep your Mark of the Unicorn master disks locked (write-protected)
at all times by sliding the tab on the back of the disk open so that
light can be seen through the rectangular aperture. We recommend
that you use the master disks only as resources from which you can
make working copies, and as key disks with which to start the
program when you begin a session. Should your copies become
damaged, you will always be able to go back to the master disk for
fresh working copies.

Troubleshooting is always simplest and most effective when the exact
problem can be specified clearly and concisely. If you are surprised
by an error message or by seemingly erratic behavior in the program,
take a moment to jot down the relevant details: exactly what the error
message said (including any error ID numbers), what actions were
done on-screen just before the problem occurred, what kind of file
you were working with, how you recovered frqm the problem, and 
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any unusual conditions applying during the occurrence of the
problem. This may not enable you to solve the problem at once, but
will greatly aid in isolating the problem should it reoccur.

If the problem you are encountering seems inconsistent, try' to
determine what the necessary pattern of actions are that will cause it
to occur. Genuine bugs in application software like Performer are
almost always consistent in their manifestation: the same set of
actions under the same conditions invariably brings about the same
results. Determining the exact cause of a bug often requires
experiments which replicate the problem situation with one factor
changed: starting the program from a different disk drive, restarting
the Macintosh with a system folder containing different versions of
the System File and the Finder, working with a new sequence instead
of an existing one, etc.

If the problem is truly inconsistent, then it is likely to be a hardware
problem: improper disk drive alignment, a loose connection,
overlong cables, signal ‘aliasing’, etc. For example, if you play a
sequence several times consecutively from 1111000 without making
any changes to it, and on one pass you hear a wrong note at
3111043, and on another pass you hear a different wrong note at
6121332, and the other times it plays back without any errors, the
problem is almost certainly external to Performer. At this point you
will want to experiment with changes in your hardware configuration
(where possible) to attempt to isolate the source of the problem.

The most important tools for tracking down problems are the MIDI
Monitor window and the Event List windows. The MIDI Monitor
window indicates the type and channel assignments of all MIDI data
being sent to Performer. If there is a hardware problem, or if your
channel assignments are wrong, the problem should be apparent in
the MIDI Monitor window.

On the other hand, the Event List windows show all the MIDI data
being sent from Performer. If you’re hearing something unusual in
your sequence, the first thing to do is to bring up the Event List
windows for the tracks in question. Go to the points in the track at
which you are hearing the discrepancy and look for events that may
correspond to what you are hearing. Lise the View Filter if necessary
to clearly isolate the events you are interested in. If the problem is
visible in the event list, you can erase or edit the events in question.
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1 If an audible problem does not correspond to anything in the event
list, its cause is likely to be something external to Performer: the
Macintosh, interface, cables, instruments, or other equipment.

If the Counter, Click, or Flash move irregularly, or if playback is erratic or
seems to stall and skip: the problem may be a “MIDI logjam", in which
the Macintosh is asked to process too much MIDI information too
quickly. This is not a serious problem if the actual playback timing is
not affected; Performer gives priority to sending and receiving MIDI
data over most screen redisplay. However, with enough of an
overload you may hear delays or erratic timing in your music.

Usually the overload is caused by vast reams of aftertouch (mono or
poly key pressure), controller, or pitch bend events in one or more
synthesizer tracks. Open Event List windows for the tracks in
question and look for large amounts of data of this type.

To solve the problem, you must reduce the amount of MIDI
information being passed through the modem and/or printer port in
the following ways:

n Slow down the tempo of the sequence during the problem
passages.

□ Delete a track or tracks from the sequence.

□ Turn off the play-enable buttons for one or more tracks.
When you do this, Performer completely ignores these
tracks, letting it concentrate all of the computer’s
processing power on playing one part. Do not use the Solo
button instead; if you do, Performer will scan the other
parts while playing and the problem will remain.

■ Use the Edit Filter and the Cut or Erase commands to
remove some data from one or more of the tracks. See the
Edit Commands chapter for help with this. Remember to
set the Edit Filter back to its default setting before going on
with your work.

■ Use the Thin Continuous Data command to reduce the
amount of continuous data in one or more tracks. This
command preserves the original contour and basic effect
of the controllers you are editing, while thinning out
unnecessary information.
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□ Reassign some of the tracks to be output through the other
serial port. There is a limit on the amount of information
which can be passed through each port individually;
balancing your output through both ports can eliminate
the overload.

If Performer starts correctly, but you are unable to record (or play)
anything: double-check your cable connections and synthesizer
settings. Check the MIDI interface dialog box, and be sure you have
chosen to receive data at the correct frequency through the correct
serial port (modem and/or printer) on the back of the Macintosh.
Often only A/B tests will reveal the source of the problem. It may be
necessary to switch your MIDI cables, and if possible, to try using a
different MIDI interface or synthesizer for input/output. The easiest
way to test if MIDI data is actually getting to Performer is to open the
MIDI Monitor window. Make sure that any recording channel
assignments in the Tracks window and Input Filter correspond to the
MIDI channels set in the controlling keyboard or device.

If you cannot open a particular file: first try opening other existing files,
or a new file, to be sure Performer is working at all. Refer also to the
list of disk and file errors in the chapter Working with Files. If a file is
opened and seems damaged, will not let you save changes, etc., you
still may be able to save some or all of its musical information by
using the Clipboard to copy the tracks and paste them into another
file on another disk.

If Performer will not start up at all, or always brings up an irregular or
damaged file when the Performer icon is opened from the Finder,
your working copy may be damaged. Make a fresh working copy'
from one of your master disks. To be thorough, make this new
working copy by' dragging the Performer program icon from another
master disk (i.e. not from the key disk from which the original
working copy was made). Restart the Macintosh and try' opening
another (new or existing) file with your new working copy' to see if
you have the same problem. Check also to see if other applications
(Professional Composer, MacWrite, MacPaint, etc.) are working
properly.

Ifoneofyour key disks becomes damaged and fails to work as a key, our
Customer Support Department will be glad to replace it. See the
Customer Support section below for more information.
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Disk Repairs

Customer
Support

If you’re having problems synchronizing Performer with other equipment:
refer carefully to the chapter called Receive Sync and the section
called Variations in MIDI Implementation in Appendix A. Remember
that Performer inputs and outputs only MIDI, and that the MIDI beat
clock specification consists of only five different types of messages.
Try to deduce exactly which signal(s) are not being sent or are being
misinterpreted by which piece(s) of equipment. The MIDI Monitor
window is helpful in determining if timing information is being sent:
the RT (real time) indicator will highlight for the port(s) receiving
beat clocks or other timing data.

We are glad to replace damaged disks belonging to registered users.
Please contact Mark of the Unicorn Technical support by phone, fax,
or letter if your disk needs to be repaired or replaced. Our Technical
support phone number is: (617) 576-3066. Fax: (617) 576-3609.

We are happy to provide customer support to our registered users. If
you haven’t already done so, please take a moment to complete the
registration card in the front of the manual and send it in to us. When
we receive your card, you’ll be placed on our mailing list and sent a
free backup key disk.

Registered users who are unable, with their dealer’s help, to solve
problems they are encountering with Performer may' call our
technical support line. The number is (617) 576-3066, and is staffed
Monday through Friday 9 AM to 8 PM, Eastern Time. If you decide to
call, please have your Performer manual at hand, and be prepared to
provide the following information to help us solve your problem as
quickly as possible:

■ The serial number of the program. This is printed on the
cardboard page (at the front of the manual) which holds
the registration card. Be sure to retain this page in the
manual for your reference. You must be able to supply' this
number to receive technical support.

■ The version of Performer you are working with. This is
displayed briefly in the start-up screen when Performer is
staited; it is also available through the About Performer
command on the Apple menu from within Performer.
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□ A brief explanation of the problem, including the exact
sequence of actions which cause it, and the contents of
any error messages which appear on the screen. It is often
very helpful to have brief written notes to refer to.

n The pages in the manual which refer to the parts of the
program which you are having trouble with.

□ The version or creation date of the system software you are using
to run the Macintosh. See the Installation Guide for help in
finding version numbers for the system software.

We’re not able to solve every problem immediately, but a quick call
to us may' yield a suggestion for a problem which you might
otherwise spend hours trying to track down.

Our technical support telephone line is dedicated to helping
registered users solve their problems quickly. In the past, many'
people have also taken the time to write to us with their comments,
criticism and suggestions for improved versions of our software. We
thank them; many of those ideas have been addressed in this version
of Performer. If you have features or ideas you would like to see
implemented in our music software, we’d like to hear from you.
Please write to the Performer Development Team, Mark of the
Unicorn Inc., 1280 Massachusetts Avenue, Cambridge. MA 02138.

Although we do not announce release dates and features of new
versions of our software in advance, we will notify all registered users
immediately by mail as soon as new releases become available. If you
move from the address indicated on your registration card, please
send us a note with your change of address so that we can keep you
informed of future upgrades and releases.
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Converters 601-602, 618, 765-768
Copy 398

Chunks in the Song window 223
Tracks between Sequences 216

Copy all tracks option 220
Copy command 695, 721
Copy Conductor Tracks 219, 230
Counter 88-95

display 90
formats 88-89
screen update 94-95

Counter window 64-162
auxiliary 161, 162
editing 39
frame time 38, 90-92
Looping 197-198
measure time 38, 90-92
real time 38, 90-92
Set Chunk Start 90-92
Set Display 161-162

Countoff 74-75
beats 663
While slaved to tape 622

Countoff button 65
Countoff n measures 235
Countoff only when recording 235
Crawl line option 656
Create Chunk 167
Create Chunks

Tracks window 190-191
Create Console 507-509

Tracks window 168, 183-184
Create Continuous Data 455-457
Create Device command 691, 722
Create Groove command 497
Crescendos 430, 436
Cubase

grooves 503
Cue sheet 245, 255
Cueing 67, 70-71

Chunks 66, 78-81, 97, 107-108, 211-212
sequences 66, 78-81, 97, 107-108, 211-212
songs 66, 78-81, 97, 107-108, 211-212
using the counter 89-90

Current Configuration 683, 685
Curvature 433-435, 571-573

editing in Graphic Editing window 323-327
Curves

Change Tempo 570-573
Change Velocity 433-435
Create Continuous data 455
Graphic Editing window 323-327

Custom consoles 505-545
Custom Maps list 472
Custom Scale button 484-485
Custom transpose map 480-482
Customer support 19, 773
Customizing

key signatures 549
New file 55-57
Remote Controls 100-104, 105

Cut 223
Cut command 695, 721
Cycle-recording 130
Cycle-recording (Memory-cycle) 71

D
Data sub-option 209
Decrescendos 430, 436
Default patch 165, 176
DeFlam 418, 428-430
Delete

Chunks window 207, 211
Markers 219, 229, 251
Markers window 246
Remote Controls window 99, 103-104
Tracks window 168, 180

Denominator 554
Density Threshold 167, 185, 189
Desktop 47-49
Device

group 110, 112
Patch 165, 175

Device column 111
Device Icons window 757
Device properties 716
Dialog boxes 35
Diatonic transposition 476-477
Diminuendo 430, 436
Direct Echo 122
Direct Time Lock 646, 647-648

view with MIDI Monitor 651
Direct time lock 2-12, 602, 609-611, 765-768
Disks

damaged master disk 773
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errors 59-60
keeping enough free space 769
key disk 19
locking 769
master disk 19
saving files to 49-55

Display Resolution 336, 338-339, 349-350
DNA™ grooves 502
Dot boxes 139, 145
DR4d™ (Akai) 629
Drop frame

29.97 607, 610
Dropouts 649. 659-660
Drum machine

loop recording as 204
Patch Thru 124
short note durations 440
transposing 483-484

DTL and DTLe 611
Duplicate 99

Track Layout 206, 208
Duplicate command 695, 721
Duplicate track layout (Tracks window) 166
Duration 260, 267, 305, 313

adjusting short durations 440
Change Duration 436-441
changing individual note 274-275
drum machines 440
editing

Notation Editing window 343-344
Scale Time 465-466
Step Record 140

E
Echo

creating echo effect 405-406
Song window 228

MIDI echo 121-125
synchronization 124, 625-626

Edit Bar 164, 181-182, 250-251
Edit commands 388-390
looping 200, 203

Edit command in Tracks window 167
Edit commands

Clipboard 397, 402
Edit Conductor Track 219

Event List window 272, 391
Graphic Editing window 300, 301
Markers 251

selecting region 300, 311-312, 387-394
Song window 218, 223-224, 395

Edit Conductor Track 219
Edit Device command 693, 722
Edit Filter 395-397, 404, 771

Conductor Track 585-588
Markers 255
meter changes 560-561
MIDI controllers 397

Edit FreeMIDI Configuration 679
Edit FreeMIDI Configuration command 115, 687
Edit menu 395-407

Copy 223, 398
Copy command 721
Cut 223, 398
Cut command 721
Duplicate command 721
Erase 399
Merge 400
Paste 399, 402-404
Paste command 721
Repeat 399-400

Conductor track 589
Event List window 272
Graphic Editing window 300
versus looping 197, 406

Select All 402
Select All command 721
Shift 401-402

attack times 406-407
Show/Hide Clipboard 402
Snip 401

Graphic Editing window 300
Song window 218, 223-224, 395
Splice 401
Undo command 721
Undo/Redo 397-398

Edit resolution box 282, 292-293, 300
Editing

Chunks 207-209, 209-211, 213-215, 216
Counter 39, 64
during playback 40-41, 60, 67, 115-116, 395,

409, 451
Edit Conductor Track 219
Key change events 580-581
Markers 248-249, 251, 252, 584
Meter change events 581-582
MIDI events 272-275, 391-392
selecting 366
System Exclusive 269, 274, 377-381
Tempo events 583-584
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tracks 181-183, 187, 216, 387, 402-404
Eject command 637
Emphasis 470

Humanize 427
quantizing 418
tempos 575
velocities 435

End time 220
Auto/Manual 79, 214-215, 231
Chunks window 206, 211, 214-215

Enhanced Direct Time Lock 646, 647-648, 765-768
Erase 399

Song window 224
Error messages 59-60, 769, 772
Errors

disk 59-60, 769, 772, 773
file 59-60, 770, 772
fonts 371
system 769, 774

Escape key 101
Event

Chasing 116-117
Editing windows 181, 257
information box 282, 291-292

Event List window 21, 257-280
Audible Mode 258, 276-278
Conductor track 271, 579
editing 272-275, 391-392
Goto 259, 265-266
Goto Counter 259, 265
Graphic Editing window 266, 281, 288
Insert 212-TI\
key changes 271
Legend 259, 266
loops 201-203, 271
Markers 251, 271
meters 271
mini-menu 259
note events 267
opening from Tracks Window 181
patch change 267-268
printing 666
Reinsert 259, 266
selecting a region 263, 272, 391
System Exclusive 269, 380-381
tempo changes 271
View Filter 259, 263-265

Events
Event List window 257, 267-271
Graphic Editing window 281
Tap Tempo 612-613, 614

Events List window button 65

Extend releases to closest attack 439-440
External sync

Tap Tempo 661-664
External time code option 663
Extracting parts 446-447

Fast mode 645
Fast-forwarding 70-71
Fewer Choices button 494
File

Help 27-29
icon 43

File menu
Close 44, 57
Close command 719
FreeMIDI Preferences command 683
Load 46-49, 104-105, 209
New 44, 56-57
New command 719
Open 44-45
Open command 719
Preferences 58, 680
Quit 57
Quit command 720
Revert command 720
Revert to Saved 55
Save 49-50
Save As 50-54
Save As ‘New’ Template 55-57
Save As Composer 54-55, 229
Save command 719

Files 43-60
errors 59-60, 770, 772
loading

Chunks 46-49, 209
Remote Controls 104-105

opening existing file 44-45
opening MIDI files 45
opening new file 43
opening Performer files 45
opening Performer Version 1 files 45
opening Professional Composer files 45
Revert to Saved 55
Save As 50-54
Save As ‘New’ Template 55-57
Save As Composer 54-55, 229
Save As MIDI File 51-54
Save As Performer 2.41 54
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saving files 49-55
saving sequences 49-55

Film/video 25
hit points 245, 251, 253-254, 255
Markers 245-256
partial measures 588-589
Song window 229-230
synchronization 229-230, 252-254, 602,

606-611, 618-621
tempo maps 229-230, 566-567

Filters
Edit Filter 560-561

Conductor Track 585-588
Markers 255
meter changes 560-561
MIDI controllers 397

Input Filter 134
Patch Thru 124
System Exclusive 376

Quick-Filter 292, 316, 319, 320, 328
View Filter 259, 263-265, 287, 301, 307,

316-317
Conductor Track 585-588

Flash 238
Fonts

installing in text menu 371
Frame advance messages 766-767
Frame advancing 652-653
Frame click metronome values 87, 569
Frame time 38-39, 90-92
FreeMID

Devices
duplicating 695

FreeMIDI
Configuration file 703, 705
Configuration Window 688
Configuration window 686, 687, 698
current configuration 683
Devices

connecting 696
editing 693
naming 694
removing 692
selecting 694

Devices file 760
Edit FreeMIDI Configuration command 679
FreeMIDI Sync command 679
how it provides playback devices 114
playback devices 110, 174

Preferences 683
Remote control devices 99
seek points 246

FreeMIDI Setup
Device properties 631

FreeMIDI Sync 711
Freewheeling 659
Freeze-frame 653
FSK 22, 602, 603-606

standard MIDI beat clocks 602, 603-606
Full frame message 765-767

G
Gate

Click & Countoff Options 235
Generate VTP Streamers option 246
Goto

Event List window 259, 265-266
Graphic Editing window 288
Tracks window 167

Goto Counter
Event List window 259, 265
Graphic Editing window 287
Tracks window 167

Grand staff
bracket 354

Graphic Editing window 281-334
Audible Mode 314
Auxiliary Time rulers 283, 288, 293-295
Conductor Track 332-334
Continuous data

grid 315-329
icons 316, 328-329
Ruler 315, 317-318

editing 298-301
Event List window 288
example of 591
Goto 288
Goto Counter 287
Information bar 282, 289-293

Edit resolution box 283, 292-293
Event information box 283, 291-292
Pointer coordinates box 282, 290-291

Insert button 282, 289
Legend 288
Loops 303
Main ruler selector 283, 295
Marker strip 283, 302-304
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Median strip 284, 329-331
Conductor Track 332-333
Move handles 305, 330

MIDI Edit 288, 309-310, 313, 322
mini-menu 287-289
note events 284, 305-307, 308-314
Note grid 283, 304-314
opening from Tracks Window 181
opening from Tracks window 285
overview 21
Pitch ruler 284, 296-297, 307-308

listening to 307-308
selecting all notes of one pitch 312

Quick-Filter 292, 316, 319, 320, 328
Reinsert 288
scaling 326-327
selecting events

Continuous Data grid 319-321
Note grid 299, 311-312

Set Pointer Coordinates 288, 290-291
Set Rulers 288, 294-295
shift key 298-299
Time ruler 283, 293-295, 300
View Filter 287, 301
viewing 285
zooming 295-297, 308, 318-319

Graphic Editing window button 65
Greyed menu items 30
Grid

Chunk Grid 217
Continuous data 315-329
Graphic Editing window Note Grid 283,

304-307
offset 413
Quantize 409, 412-413
Step Record 154-158

Groove Editor 500
Groove Quantize 487-503

applying a groove 488
creating a groove 497
deleting,moving,duplicating 491
Groove folder 492
grooves defined 487
renaming a groove 491

Grouping Sliders 533-538
Grow box 34

H
Half solo mode 178-179
Handshake 384-385
Hardware requirements 19
Harmonic transposition 478
Harmonies

creating 476
Harmonizing 472
Help 27-30

cursor 27
File 27-29
loading file 28-29
Menu 29

Hexadecimal 375, 377-378
Hide Balloons 30
Hide Clipboard 402
High-density track segment 165, 185, 189
Hit points 245, 253-254, 255
Hits

recording 652-653
Humanize 423-428

existing tempos 470
tempos 573-576

I
Icons 755
Indirect time lock 602, 606-608, 619
Information bar 282, 289-293

Edit resolution box 282, 292-293, 300
Event information box 282, 291-292
Pointer coordinates box 282, 290-291

Input Filter 134
Patch Thru 124, 124
System Exclusive 376

Input Quantize 422-423
Insert

Conductor Track 580-581, 581-582, 583
Event List window 258, 272-274
Insert button 218, 219, 220-221
inserting multiple events

Event List window 266, 279-280
Graphic Editing window 323-324

Notation Editing 341-342
Song window 220-221

Insert button
Chunks window 218, 219, 220, 228

Insert column 218, 219, 220-221
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Inserting measures 401-402, 561-562
Instant 490
Instant Preview 490
Interface

echo options with Patch Thru 124-125
Interface Settings command 679, 716, 722
Interfaces

moving 702
naming 702

Interval transposition 475-476
Invert Pitch 461-463

K
Key changes 547-551, 580-581

Conductor track 550-551, 580-581
custom key signatures 549
editing 550-551
Event List window 271, 550-551
Graphic Editing window 303, 332-333, 550-551

Key disk 19
Key/scale transposing 478-480
Keyboard commands 37-38, 99, 101, 107
Keyboard controller 101, 107, 121

changing values from 275, 313, 322
Keyboard durations diagram 158
Keyboard parts, splitting into right/left hand 442,

449
Keypad 90

controls 158
Keypad controls 83

Lead line
enhancing 447-448
extracting 446-447

Legato 438-440
Legend

Events List window 259, 266
Graphic Editing window 288

Level Meter Setup 167
Level meters 173
Link sub-option 209
Linking 47-49, 209

Link sub-option 209
Live performance

cueing Chunks 78-81, 97, 107-108, 211-212
linking Chunks 209

Load 209
Chunks 46-49
Consoles 544
Help file 28-29
Remote Controls 104-105

Local control 270
Lock 245, 246, 252
Locking

disks 769
Markers 245, 252

locking
Markers 246

Loop Indicator 164
Loop recording (Memory-cycle) 71
Loops 197-204

Clear Loops 203
compared to Memory-cycle 197
Conductor Track 589
conflicting 199-200
editing

Event List window 202-203
Graphic Editing window 303

end time 198-201
Event Chasing 117
indicator 180, 198
inserting 201-202, 303-304
meter changes 589
nested 198-199
recording (See Cycle-recording)
recording while looping 204
repetitions 197, 201
Set Loop 200-201

Graphic Editing window 300
start time 198-201
Tracks window 189-190
Tracks window indicators 173
versus Repeat 406
viewing

Event List window 202-203
Low-density track segment 185, 189

M
MacDraw 367
Macintosh

68020-based 238
Classic 30
color monitors 31
II 19, 238
Ilex 19
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IIx 19
keyboard equivalents 83, 99, 101-102, 107
mouse 35
Plus 30
SE 30
SE/30 19
user interface 31-38

Macintosh Keyboard Controls 83
Macros 107
Manual button 84-85
Manual end time 79, 206, 214-215, 231
Manual tempo mode 563
Margins 359
Marker strip

Graphic Editing window 283, 302-304
Song window 218, 229-230

Markers 245-256
Add 246, 248
changing font in notation window 354
changing location 249, 252-253, 333
Conductor Track 252, 332-333, 584
Delete Markers 219, 229
Deleting 246, 251
displaying in notation window 354
Event List window 251, 271
Graphic Editing window 251, 302, 332-333
hit points 245, 253-254
locating with 249
Lock 245, 246, 252
Merge Markers 229
mini-menu 246
naming 246, 248
Notation Editing window 251
opening Markers window 247
position indicator 246, 249
printing 666
Record hits 246, 253-254
selecting 250
setting Counter location 249
Shift locked markers 246, 252-253
Song window 218, 219, 229-230
streamers 653-654
time display 245
Unlock 246, 252

Markers window
Generate VTP Streamers 246

Markers window button 66
Master Control 99, 100-101
Master disk 19
Master sliders 533-538
Matching sliders 533-534
Measure button 140, 152

Measure numbers
display options 355

Measure range
Change Key 547, 549
Change Meter 553, 557
selecting 181-183, 272

Measure spacing 356
Measure time 38

Events List window 259
Graphic Editing window 289, 294-295

Median strip 284, 329-331
Conductor Track 332-333

Melody
enhancing 447-448
extracting 446-447

Memory
Message Center 769
RAM 239
running out of 59, 239
saving with the Link feature 209

Memory Bar 66, 71-72, 81-82
Memory' window 239-240
Memory-cycle

compared to loops 197
loop points 164
repeat barlines 72
selecing the region 74, 394
setting end points 73
when applying a groove 488

Memory-shuttle 71-72, 81-82
Memory-shuttle button 66
Merge 400
Merge Chunks to Sequence 47, 220, 229
Merge Markers 219, 229
Merge Tracks with identical names option 220
Message Center 212

RAM available 769
Meter

display 86
Meter changes 553-562, 581-582

Conductor Track 581-582
Edit Filter 560-561
Event List window 271, 559-560, 581-582
Graphic Editing window 303, 332-333
inserting measures 561-562
looping 589
partial measures 588-589

Meter maps 555, 589
Metronome 84-86

beat value 86
button 66
marking 355
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slider 86. 87-88
remote control 85-86

Metronome window
Automatic tempo mode 563
Click 233
Click value 233, 554, 557, 581

Tap Tempo 612
Manual tempo mode 563

Mid-beat 573
MIDI

Activity meters 173
beat clocks 242, 601-602, 603-606, 763-765

converted from SMPTE 603, 763
implementation 763-765
start/stop clocks 601-602, 604, 627, 764
timing clocks only 764
transmitting 625-627

channels 166, 168, 173
activity 242
playback 110-111, 129, 166, 168, 174
recording 132-134, 168, 173
Tap tempo 612-613

controller
instruments 19

controllers 451-453
Audible Mode 278
controlling volume 436
Edit Filter 397
Event List window 268-269, 269, 275, 279
Input Filter 135
Tap tempo 613, 616
View Filter 264-265

data stream 116
delay 771-772

Patch Thru 124-125
echo 121-125
echo options with Patch Thru 124-125
Edit 288, 309-310, 313, 322
events

Event List window 267-271
Graphic Editing window 291-292

interface 645-648
logjam 771-772
mapper 124
merger 124
Monitor window 241-243
rechannelizer 124

Song Position pointer 242, 601-602, 606
Song Select 107-108, 205-206, 212
System Reset 242
thru 121-125
Thru connections 697
Time Code 602, 611
Time Piece 645-648
timing clocks 601-602, 603-606, 763

transmitting 625-627
transmission rate 453, T11-T12
variations in implementation 764-765

MIDI Activity Meters 166
MIDI Configuration

window
button 66

MIDI Express
SMPTE sync with 609

MIDI files
opening 45

MIDI Machine Control
Auto Record Advance option 636

MIDI machine control 629-643
MIDI menu

Audition Channels command 724
Check Connections command 712, 723
Interface Settings command 716, 722
MidiLocate command 709, 723
Panic command 712, 724
PatchThru command 707, 723
Popup Patchlists command 706, 724
Return command 722
Transport Controls 723
Transport Controls command 710

MIDI Monitor window 241-243, 651, 770
MIDI Sequencer

description 19
MIDI Time Code

view with MIDI Monitor 651
MIDI Time Piece 598, 645-648, 765

SMPTE sync with 609
MIDILocate command 709
MidiLocate command 723
Mini-menu 32

Chunks window 206-207
Event List 259
Graphic Editing 287-289
Markers 246
MIDI Monitor 242
Notation Editing 336-338
Remote Controls window 99
Song window 219-220

Index 785



Step Record window 140
Tracks 166-168

Mode changes
Event List window 270
Graphic Editing window 330

Modem port 241
Modes

transposing 478
Module 121, 124
Monitor Patch Changes FreeMIDI option 175
Mono key pressure 452
Mono mode 270
More Choices button 490
Mosaic 139

Edit FreeMIDI Configuration command 687
Mouse techniques 35-37, 298-299, 327-328

dragging in Song window 224
Move handle

Chunks window 205, 213, 215
Median strip 305, 330
Track Window 166, 172-173

Move releases to closest attack 438-439
MultiRecord 132-134, 167

Tap Tempo 615
Multi-track audio recording 618-621

N
Naming

Chunks 206
Files 49-51
Markers 246, 248
Song window 218
Tracks 164, 174-175

New 44, 56-57
New command 719
New device group command 110
No accent option 235
Notation (see QuickScribe notation window)
Notation Editing Window 335-344

inserting notes 341-342
Notation Editing window

overview 22
Notation Editing window button 65
Note events

doubling 448-449
Event List window 267
Graphic Editing window 284, 305-307, 308-314
mapping to single pilch 482-483
randomizing 423-427

setting preference for the display of 680
Note grid

Graphic Editing window 283, 304-314
Step Record 154-158

Null points 535-536, 538
Numerator 554

o
Octave range

transposing 481-482
Octave Up/Down buttons 336, 339-340
Odd Meters 596
Off velocities 432, 445

Event List window 267
Graphic Editing window 306-307, 318

Offset
grouped sliders 534
SMPTE

bit 92
Chunk start time 90-92, 222, 608, 610, 619
converter start frame 606, 619

Offset grid option 413
Offset option (Step Record) 140
OK is first beat option 594
Omni mode 270
On velocities 432, 445

Event List window 267
Graphic Editing window 306-307, 318

One new track option 443
One track option 443
On-line Help 27-30
Only during countoff option 235
Only move barlines 559
Only when recording option 235
Opcode

Studio 5™ 622
Opcode Studio 5

syncing to SMPTE with 622
Open 44-45
Open Chunks 206, 212
Open command 719
Open-loop (MIDI Machine Control) 631
Options 565, 576
Overdub 69-70

looping 204
Overdub record

button 65
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Page numbers 369
starting number 352

Page size 359
Palette 360
Panic command 679, 712, 724
Partial measures 588-589
Partial solo mode 178-179
Parts per quarter note 38
Paste 399, 402-404

Conductor track 584-585
Event List window 272
Song window 224

Paste command 695, 721
Patch change

Event List window 267-268
Patch chasing 116-117
Patch List

window 175
Patch list

printing 666
Patch Lists 175
Patch lists 706
Patch Thru 121-125

Audition Channels setup 707
Auto Channelize 122
Direct Echo 122
Input Filter 124, 124
MIDI delay 124-125
MIDI interfaces 124-125
MIDI merge 124
MultiRecord mode 123-124
Song Window 124
timing information 124

Patch Thru command 707
PatchList Manager 706, 725

add Patch List command 739
bank select 747
configure device command 733
create module command 754
creating a new patchlist 732
creating patchlists by hand 739
delete module command 754
device help command 734
editing a patchlist 742
grouping patchlists into a folder 746
importing patchlists 737
importing Performer/Digital Performer patch

lists 737
loading patch names 732

loading Unisyn patchlists 738
multiple patchlists 747
overview 726
re-initializing 752
saving patchlists 752
set numbering format command 740

PatchThru command 723
Patterns

see Memory-cycle
see the Song window

Pause button 68
Performer

as master sync device 625-627
as MIDI merger 124
Cycle-record 132
Edit FreeMIDI Configuration command 687
files

opening 45
Hardware requirements 19
MIDI Time Piece 645-648
overview 19-25
user interface 31-41
Version 1 files

opening 45
version number 773

phrases
playing 277-278

Piano parts
splitting into right/left hand 442, 449

piano roll 20
Pick-up

beats 596
measure(s) 596

Pick-up measure(s) 93-94
Pitch

Click & Countoff Options 235
Pitch bend 452

determining value range 279
Event List window 267
Graphic Editing window 315, 316, 317-318

Pitch ruler 284, 296-297, 307-308
listening to 307-308

Play button 67
Playback 109-120, 174

channels 110-111, 129, 166, 174
chasing during 116-117
Chunk 211-212
controller chasing 116-117
Event List window 276-278
features active during 67, 115-116
locating with mouse 186, 294
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selecting a device 111
sequence 211-212
song 211-212, 223
System Exclusive 376
track play assignment 111

Play-Enable button 109, 110, 166, 174, 177,
184-185

Chunks window 205, 211-212
Play-enabling chunks 66
player piano 19
Play-Select button 109-110, 166, 174, 177, 184-185

Chunks window 205, 211-212
Pointer coordinates box 282, 290-291

Set Pointer Coordinates 288, 290-291
Polarity 534-535
Poly key pressure 452

Event List window 269
Popup Patchlists 706
Popup Patchlists command 706, 724
Preferences

Startup options 58
Preferences command 680
Preroll option 635
Printer port 241
Printing 345-373, 665-669

instrument parts 371
keyboard part 372
list windows 666
margins 359
page size 359
score 372
title page 352

Professional Composer 229
files

opening 45
opening files from 45
Saving As 54-55
separating keyboard part for 446-447, 449

Properties 716
Punch-In

recording with sliders 530-531
Pushdown box 33

Q
Quantize 409-419

Attacks 410-411
Don't change duration option 411
Durations 410-411
for notation 349

freely played music 592
grid 409, 412-413
Input 422-423
Offset grid option 413
Releases 410-411
Sensitivity option 415-416
Strength 416-417
Swing 414
tuplets 412, 412-413

Quick Setup command 684, 722
Quick-Filter 292, 316, 319, 320, 328
QuickScribe notation window 345-373

date 369
displaying markers 354
inserting notes 361
margins 359
measure numbers 355
page numbers 369
page size 359
Score Options 352
Text 367
Tool palette 360
track splitting 357

Quit command 720
Quitting Performer 57

R
Radio buttons 35
RAM 239, 769
Random Pitch Map 425-427
Randomize

quantizing 417
tempos 470, 573-576
velocities 435

Real time 38
building a song 221
editing 40-41, 60, 67, 115-116, 395, 409, 451

Realign music automatically 557-558
Reassign Continuous Data 460-461
Receive Sync 601-622

MIDI Machine Control 638
Recent Files pop-up menu 490
Record Beats 591-599
Record hits 246, 253-254
Record while still framed 136
Record while still-framed 618, 652, 653
Record-enable Conductor 219, 226-228
Recording 69-70, 76-77, 81-83, 127-136

Auto-Record 65, 69, 76-77, 81-83, 136, 182
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Bar 69, 76-77, 81-83
button 69, 76-77, 81-83
Tap Tempo 617

Chunk 211
Conductor Track 614-615
hits 246, 253-254, 652-653
in a sequence 211, 218, 219, 224-226
in a song 224-226
in external sync 136
Input Filter 124, 134
memory allocation 769
MultiRecord 123-124, 127-134

Tap Tempo 615
quantizing on input 422-423
real-time 127-134
Record channels 132-134, 134
Record-Enable button 129, 133, 166, 173
Set Record sequence 219, 224-226
Sliders 529-531
step recording 134, 139-159
System Exclusive 376, 381-384
Tap tempo 614-615, 616
Undoing 70
while looping 204

Recording on option (Step Record window) 139
Redo/Undo 397-398

Graphic Editing window 301
Song window 224

Region menu 409-449, 451-485
Change Continuous Data 458-460
Change Duration 436-441
Change Velocity 430-436

limiting velocities 432
Create Continuous Data 455-457
DeFlam 418, 428-430
Groove Quantize 489
Invert Pitch 461-463
Quantize 409-419
Reassign Continuous Data 460-461
Retrograde 463-465

Graphic Editing window 300
Reverse Time 463-465
Scale Time 465-467
Split Notes 441-449
Thin Continuous Data 453-455
Transpose 409, 471-485

Region selection
Event List window 263, 391
Graphic Editing window 300, 311-312
Tracks window 387
using Markers 250-251

with the Edit Bar 181-182
with the Tracks window 182-183, 187

Registration
card 19, 773
number 773

Rehearse mode 635
Reinsert

Event List window 259, 266
Graphic Editing window 288

Releases
Extend Releases to Closest Attack 439-440
Move Releases to Closest Attack 438-439
Quantize 410-411

Remember Times 74, 82, 83, 182, 250-251,
275-276, 389-390

Remote Controls 97-108
Add Defaults 99, 104
Add Master 99, 103
cueing with 97, 107-108, 212
customizing 100-104
Cycle-record control 132
Delete 99, 103-104
Duplicate 99
Loading 48, 104-105
Macros 107
Master 98-99, 100-101
Master Control Status icon 99
opening Remote Controls window 98
Play-enabling chunks 79
Play-enabling with 97, 107-108, 212
printing 666
Saving 100, 104, 105

Remote Master 98, 100-101
Repaginate command 359
Repeat 399-400

Conductor track 589
Event List window 272
Graphic Editing window 300
versus looping 197, 406

Repeat barlines 72
Resolution 38
Restoring

deleted Remote Controls 104
Retrograde 463-465

Event List window 272
Graphic Editing window 300

Return command 722
Reverse Time 463-465
Revert command 720
Revert to Saved 55
Rewinding 68, 70-71, 71-72, 81-82

Markers 246, 249
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Rita rd 611
Rt light 651
Rubato 611
Rulers 167
Running update option 162

s
Safe option in MMC window 635
Save 49-50
Save As 50-54
Save As ‘New’ Template 55-57
Save As command 719
Save As Composer 54-55, 229
Save As MIDI File 51-54
Save As Performer 2.41 54
Save command 719
Saving

files 49-55
Remote Controls setup 100, 104
sequences 49-55
Transpose maps 474

Scale Tempo command 467-470
Scale Time 465-467
Scale/key transposing 478-480
Scaling

Sliders 534
Score Options 352
Screen updating 94-95
Scroll bar 32

Tracks window 176
Seamless chaining 79, 80, 81, 217-231
Seek (Markers window) 246
Segments 185, 187, 189

selecting 390-391
Select All 402
Select All command 721
Select Notes 445
Selecting 366

all notes of a single pitch 312
Chunks 208, 218, 223
events

Continuous Data grid 319-321
Event List window 263
Notation Editing window 342-343, 366
Note grid 284, 299, 311-312

Markers 250
Notation window 366
Song window 394
Tracks 180, 182-183, 187

Selecting a region 387-394
all notes of a single pitch 312
Edit Bar 181-182
Event Editing window 391
Event List Window 263. 391
Graphic Editing window 300, 311-312
Markers 250-251
Song window 218, 223
Tracks Overview 390-391
Tracks window 182-183, 187, 391

Sensitivity 415-416
Separate tracks by pitch option 443
Sequence controls 78-81
Serial number 773
Set Chunk Start 90-92, 93-162, 230, 596, 608, 610,

619
Chunks window 207

Set Countoff 74-75
Set Density Threshold 165, 167, 185, 189
Set Display 94, 161
Set Loop 200-201

Graphic Editing window 300
Set Loop button 65
Set number of tracks command 636
Set Pointer Coordinates 288, 290-291
Set Record sequence 219, 224-226
Set Rulers 167, 288, 294-295
Set Score Length command 359
Set View Filter 115, 167
Shift 401-402

attack times 406-407
Shift data to option 594
Shift locked markers 246, 252-253
Shortcut commands 37
Show all input devices command 242
Show controllers only command 243
Show/Hide

Balloons 29
Clipboard 402

Skip buttons 64, 78-79, 81
Slave sliders 533-537
Slave to External Sync 605, 608, 610, 619, 767
Slave to external sync

Record Beats 597-599
Tap Tempo 661-664

Slave to External Sync 614
Sliders 183-184, 505-545

loading from another file 544
Smart Quantize 419-422
SMPTE 38-39, 602, 618-621

29.97 drop & non-drop 607, 610
bit offset 92
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bits per frame 92
converter start frame 606, 619
converters 601-602, 618, 645-647, 765-768
Direct time lock 242, 602, 609-611, 646,

647-648, 765-768
Drop frame 607, 610
Enhanced Direct time lock 646, 647-648
frame time display 38-39. 94, 289, 290, 294-295
Indirect time lock 602, 606-608
multi-track audio recording 618-621
offset 95
overview 22
Set Chunk Start 90-92, 230, 608, 610
Slave to External Sync 608, 610, 619, 767
sliding synchronized parts 620-621
standard MIDI beat clocks 603, 763
start time 230
syncing with the Studio 5 622
tape striping 618

SMTPE
start time 639

Snip 401
Event List window 272
Graphic Editing window 300

Solo Button 164
Solo Playback option (Step Record) 140
Solo Setup 167
Soloing tracks 116, 166, 177-178, 184-185

partial solo mode 178-179
Song Change 242, 268
Song Position pointer 22, 242, 601-602, 606
Song Select 107-108, 205-206, 212
Song window 217-231

Add Song 206, 208
Chunk Grid 217
Chunk size 218
Columns 218, 219, 220-221
Copy all tracks option 220
Copy Conductor Tracks 219, 230
creating a song 221-223
Delete Markers 219, 229, 251
dragging in 224
echo effect with 228
Edit commands 218, 223-224
Edit Conductor Track 219
End times 220, 231
Insert column 218, 219, 220-221
Markers 218, 219, 220, 229-230
matching chunk times 230
Merge Chunks to Sequence 47, 220, 229
Merge Markers 219, 229
Merge Tracks with identical Names 220

mini-menu 219-220
name 218
names 218
opening 206, 212, 221
Patch Thru 124
playing a song 223
Record-enable Conductor 219, 226-228
recording into a sequence 218, 219, 224-226
selecting 223
Set Record sequence 219, 224-226
song description 208

Song window button 66
Sound module 124
Speaker volume 236, 237
Splice 401
Split Notes 441-449
Spot-erase 105, 132
Staccato 441
Staff names

changing font in notation view 353
Staff system

bracket 354
spacing 353

Standard beat clocks 242, 601-602. 603-606,
763-765

converted from SMPTE 603
implementation 763-765
start/ stop clocks 601-602, 604, 627, 764-765
timing clocks only 764
transmitting 625-627

Standard MIDI beat clocks 22
Startup options 58
Step button 140, 149-150
Step Duration buttons 139
Step Record 134, 139-159

Audible button 140, 150
Auto Step 140, 149
Backstep button 140, 149, 152
Beat button 140, 152
dot boxes 139, 145
duration 140
keyboard diagram 158
manual stepping 150, 159
Measure button 140, 152
Mini-menu 140
Offset Option 140
remote controls 100
selecting durations 144-146, 154-158
Solo Playback option 140
Step button 140, 149-150
Step Duration buttons 139
Tick box 140
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tick box 146
Transport Lock button 140
triplet box 140, 145-146

Stop button 68. 71
Streamers 653-654
Strength 416-417
Striping SMPTE 618
Studio 5

syncing to SMPTE with 622
Studio 5™

Syncing to SMPTE with 622
SuperPaint 367
Sustain pedal 269

Tap Tempo 616-617
Swing Quantize 414
Synchronization

basic types 601-603
Chunks in Song window 229-230
Direct time lock 242, 602, 609-611, 646,

647-648, 765-768
Enhanced Direct Time Lock 765-768
Enhanced Direct time lock 646, 647-648
FSK 602, 603-606
Indirect time lock 602, 606-608, 619
MIDI Monitor window 241-243
MIDI Time Piece 646, 647-648, 765
multi-track audio recording 618-621
overview 22
Record Beats 597-599
recording in external sync 136
Slave to External Sync 605, 608, 610, 614, 619,

767
SMPTE 38-39, 602, 618-621
Song window 229-230
specifications 763-768
Standard beat clocks 242, 601-602, 763-765

converted from SMPTE 603
implementation 763-765
start/ stop clocks 601-602, 604, 627, 764
timing clocks only 764
transmitting 625-627

Tap tempo slaved to tape 661-664
Tempo Slider 87-88
VITC 650-653

System
compatibility with Performer 234
troubleshooting 770

System common MIDI data 242
System errors 769, 774
System Exclusive 375-385

Audible Mode 278

editing
Event List window 269, 274, 380-381
Graphic Editing window 330
sysex editing window 378-380

generating with slider 539-542
handshake 384-385
Input Filter 376
inserting in Event Editing windows 380-381
insertion mode 378, 381
playback 376
recording 376, 381-384
replacement mode 378-380
viewing

Event List window 269
System real time MIDI data 242
System Reset 242

Tap first beat 595
Tap Tempo

slaved to tape 661-664
Tap tempo 602-603, 611-618

channel 612-613
click value 612
Conductor Track 614-615, 617-618
countoff 614
event 612-613, 614
overview 22
recording 226-228, 614-615
recording music 615
tap source 614
tempo maps 226-228, 563, 616

Tape position message 767
Target track 515-516
Techical support 19
Template files 55-57
Tempo

Anchor indicators 564, 569-570
automatic mode 563
basics 86
Change Tempo 563-577
curves 570-573
density 565, 569
humanize 470
in a Song 226-228
manual mode 563
maps 563, 566-567, 616
mid-beat 573
randomize 470
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randomizing 573-576
recording 614-615
resolution 87, 569
scaling 467-470
setting 86-87
synchronization 611-618

Tempo changes 563-577, 582-584
Anchoring tempos 564, 569-570
beat value 564, 568-569
Change Tempo 563-577, 582-584
editing 576-577
Event List window 271, 582-584
Graphic Editing window 333-334
recording into a song 226-228
resolution 87, 569

Tempo Slider 86, 87-88
remote control 85-86
resoluion 87, 569

Tempo slider 63
Tempo Slider Remote Control 64
Text 367

box
defined 367

typing and editing 370
The 163
The Page Setup command 720
The Print command 720
Thin Continuous Data 453-455, 771

MIDI logjam 453, 771-772
Thru connections 697
Tick box 140, 146
Ticks 38-39
Time

display 90
Event List window 259, 262
formats 88-89
frame time 38, 90-92, 218, 259, 262
Graphic Editing window 283, 293-295
measure I beat I tick time 38, 218, 259, 262
real time 38, 218, 259, 262
specification 38-39
step time 127, 134, 139-159

Time Ruler 164
Time ruler

Graphic Editing window 283, 293-295, 300
locating playback 294

Song window 218, 220
Tracks window 186

locating playback 186
Timecode bits 92
Timecode track option 637

Timing clocks 242, 601-602, 603-606, 763
transmitting 625-627

Timing resolution
beats per minute 87, 569
frames 92
ticks 38

Title page 352
Tool palette 360
Tracks

splitting in notation window 357
Tracks Overview 164, 185-191

segments
selecting 390-391

Tracks window 163-191
adding tracks 166, 179
Auto-Scroll 185-186
comments 165, 176
Conductor Track 165, 579-589
copying Tracks between Sequences 216
Create Chunk 167, 190-191
customizing 192
deleting 168, 180
Device Patch 165, 175
Edit 167
Edit Bar 164, 181-182, 187
editing multiple tracks 402-404
ellipsis in play assignment 115
Goto 167
Goto Counter 167
hiding columns 171
Loop Indicator 164
loop indicator 180, 198
Loops 189-190
Move handle 166, 172-173
MultiRecord 167
naming 164, 174-175
opening a Graphic Editing window 285
opening a new Tracks window 168-169, 206,

212
opening an Event List window 259
opening in Song window 218
partial soloing 178-179
pasting 216
playback channels 110-111, 129, 166. 168
playback devices 174
Play-Enable button 166, 174, 177, 184-185
Play-Select button 166, 174, 177, 184-185
printing track list 666
Record-Enable button 129, 133, 166, 173
recording channels 132-134, 134, 168
re-ordering columns 172
selecting 180, 182-183, 187
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selecting a region 181-183, 391
Set Density Threshold 165. 167
Set Rulers 167
Set View Filter 167
soloing 116, 166, 177-178, 181-185
Time Ruler 161, 186
View Filter 188-189
Zoom buttons 165

Tracks window button 65
Transcription 592
Transmit Sync 625-627

echoing sync 625-626
generate sync 626

Transport Controls 710
Transport Controls command 723
Transport Lock button 1-40
Transpose 471-485

key/scale transposing 478-480
Map 473-475
saving maps 474

Triplets
notating 350
Quantize 412, 412-413
Step Record 145-146

Troubleshooting 769-774
checking MIDI input/output 712
disk errors 59-60, 769, 772, 773
error messages 59-60, 769, 774
file errors 59-60, 770, 772
fonts 371
Help feature 27-30
MIDI Monitor window 241-243
system errors 769, 774

Tune request 242, 269
Triplet box 140, 145-146
Tuplets

notating 350
Quantize 412, 412-413
Step Record 140, 145-146

Type icon 205, 213

u
Undo command 721
Undo/Redo 397-398, 398, 471

Graphic Editing window 301
Record 70
Song window 224

Unisyn 671-677
Edit FreeMIDI Configuration command 687

Unlock 246, 252
Unlocking markers 246. 252
Update Interfaces command 699, 701. 722
Use all channels 708
Use default channel only option 708
User Interface 31-41
Utilities disk 27

V
Velocities

Change Velocity 430-436
Click & Countoff Options 235
limiting 432
Off Velocities 267, 306-307, 318, 432, 445
On Velocities 267, 306-307, 318, 432, 445
randomizing 435

Version numbers
Performer 774

Vertical Interval time code 650-653
Video Time Piece 598, 649-660, 661

Generate VTP Streamers option 246
View Filter 167, 259, 263-265, 287, 301. 307,

316-317, 770
Conductor Track 585-588
Tracks window 188-189

View menu 714, 724
VITC 650-653
Volume

Click 236, 237
creating volume changes 436

l/K
Wait button 65
WC Research, Inc. 502
Window mini-menu 32
Windows 31-34

Zoom box 34
Zoom buttons

Tracks window 165
Zooming

Continuous Data Grid 318-319
Graphic Editing window 295-297
Pitch ruler 308
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shortcuts 298, 344
Time Ruler 295
Tracks window 186-187
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